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 Úvodní slovo autora překladu: 

Není jednoduché překládat do češtiny anglické texty pojednávající o 3D grafice. Mnoho odborných 
výrazŧ nemá přímý český ekvivalent, nebo jejich doslovný překlad mŧţe být zavádějící (například 
render, morph target, raytracing, apod.). Většina těchto výrazŧ prostupně zdomácněla na rŧzných 
českých diskuzních fórech v jejich anglické formě, coţ je dáno skutečností, ţe většina grafikŧ pouţívá 
3D aplikace v anglické lokalizaci. Nejvíce diskuzních fór o 3D grafice a rŧzných návodŧ (tutoriálŧ) se 
také na webu nachází v angličtině, a proto by pouţívání aplikací lokalizovaných do češtiny mohlo 
zpŧsobovat problémy v orientaci při pouţití takových návodŧ. 

Z tohoto dŧvodu jsem v příručce nepřeloţil některé názvy, které jsou u nás zauţívány v originálním 
anglickém znění a často v ní uvádím dŧleţité výrazy v obou jazycích. Pŧvodní anglické výrazy jsou 
psány tučným písmem. U nadpisŧ témat jsou také uvedeny jejich pŧvodní anglické názvy včetně 
odkazu na číslo stránky v anglickém originálu příručky. 

Během překladu jsem narazil na několik nepřesností originální příručky, které jsem opravil. Není 
vyloučeno, ţe příručka vzhledem k rozsahu obsahuje také další nepřesnosti, na které jsem nepřišel. 
S postupnými upgrady aplikace bývají obvykle provedeny odpovídající úpravy příručky, takţe časem 
mohou některé nesrovnalosti přibýt. 

Vzhledem k tomu, ţe se nejedná o beletrii, ale o účelovou příručku, dovolil jsem si pouţít slovosled 
podobný pŧvodnímu anglickému textu, který není zcela dokonalý. Navíc je tato příručka napsána 
američany, a ti vţdy předpokládají, ţe snad jejich dílo budou studovat i méně chápaví jedinci. Proto je 
příručka zbytečně rozsáhlá, obsahuje mnoho zbytečných řečí okolo a vysvětluje i úplně triviální, 
obecně známé věci. Snaţil jsem se vytvořit ponejvíce doslovný překlad, takţe jsem obsah příručky 
nijak neredukoval. 

Pokud budete chtít spouštět přeloţenou příručku přímo z aplikace Poseru z menu Help, mŧţete tento 
soubor přejmenovat podle pŧvodního názvu anglické příručky v instalačním adresáři Poseru  
a nahradit jej (anglický soubor si také předem přejmenujte, abyste o něj nepřišli). 

Připomínky a náměty případných úprav je moţné podávat na mŧj email: pet5@ccc.la 
 
PET5 
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Část 1 - ÚVOD 

Kapitola 1: Vítejte v Poseru! WELCOME TO POSER 7! (orig.2) 

Děkujeme Vám za koupi programu Poser 7 ® od e frontier. Pokud jste Poser ještě nikdy nepouţívali, 
tak vítejte! Upgradovali jste z dřívější verze Poseru? Vítejte zpět!  

Poser je program na designování 3D charakterŧ a animační nástroj.  Umělci a animátoři mohou 
vytvořit 3D scény z rozmanité sbírky vytvořených 3D lidských a zvířecích modelŧ rychle a snadno za 
pouţití intuitivního rozhraní Poseru 7. Mŧţete také upravovat Vaše figury a scény mapováním snímkŧ 
tváří k vytvoření realistických 3D portrétŧ, přidáním a stylingem vlasŧ ze skutečných pramínkŧ 
a vytvořením dynamických šatŧ. S Poserem 7 mŧţete vytvořit snímky a animace, rychle sestavit filmy 
a obrázky pro pouţití na Webu, pro tisk a video projekce. Také mŧţete exportovat pózující figury jako 
3D objekty pro přidání ţivota do scén, vytvořených v jiných 3D aplikacích. 3D začátečníci, digitální 
umělci a nadšenci mohou stejnou měrou pouţít Poser 7 k rychlému dosaţení úţasných výsledkŧ! 
 

CO JE NOVÉHO V POSERU 7 WHAT’S NEW IN POSER 7 (orig.2) 

Poser 7 obsahuje následující novinky: 

o Morph Target Creation Controls: Nová poloţka Create v paletě Morphing Tool přináší výkonné 
interaktivní nástroje pro vytváření uţivatelských morph targetŧ. Vyuţijte uţivatelské morph targety 
pro dosaţení ještě dynamičtějších výrazŧ tváře; pro vytvoření nové úrovně detailŧ, jako jsou 
mateřská znaménka, dŧlky a vrásky na površích objektŧ; k úpravě šatŧ pro vystupující části těla; 
pro zlepšení výsledku simulace šatŧ; a také pro široké moţnosti dalšího vyuţití. Nemusíte být 
expert pro dotaţení Vašich scén na zcela novou úroveņ při pouţití intuitivních morph target 
tvořících nástrojŧ Poseru 7. 

o Intel Mac Universal Binary Support: Poser 7 nyní běţí nativně na platformě Intel Mac skrze 
Universal Binary příkazy, umoţņující obrovské zvýšení výkonu na Intel Macintosh systémech. 

o HDRI Support for IBL: Poser 7 nyní podporuje High Dynamic Range Images (HDRI) pro Image 
Based Lighting, dodávající renderovanému osvětlení kvalitu srovnatelnou s analogovým 
fotofilmem.  

o Import/Export Format Expansion: Poser 7 nyní podporuje moderní formáty pro import a export 
bitmapových obrázkŧ, jako HDR a EXR, stejně jako mnoho dalších formátŧ. 

o Quick Start / Project Guide: Quick Start dialog a Project Guide paleta nabízí snadný přístup ke 
krok-za-krokem interaktivním tutoriálŧm uvnitř Poseru 7, coţ značně usnadņuje novým uţivatelŧm 
začátky s Poserem 7 a nabízí detailní vysvětlení pro pokročilé dotazy zkušených uţivatelŧ. 

Zlepšení průběhu práce  WORKFLOW IMPROVEMENTS (orig.3) 

o Multiple Undo/Redo: Poser 7 nyní poskytuje mnohonásobné Undo a Redo, pro krokování zpět 
nebo vpřed skrze aţ 100 posledních změn Vaší scény. Bez obav zkoušejte pózy, změny morph 
targetŧ a transformace postav s ubezpečením, ţe  se v případě nutnosti mŧţete jednoduše vrátit 
tam, kde jste začínali! 

o Python Scripts Menu: Nové Scripts menu umoţņuje jednoduše rozšiřovat kolekci Python skriptŧ. 
Jednoduše vloţte uţivatelské skripty do sloţky Scripts Menu ve Vaší instalaci Poseru 7 a ty budou 
zpřístupněny přímo uvnitř Poseru 7 ze Scripts menu! (Viz “Menu skriptů” na straně 215 pro více 
informací.) 

o Recent Files Menu: Nové menu Recent Files umoţņuje procházet aţ deseti naposledy spuštěnými 
soubory, vybírat a spouštět je bez nutnosti jejich hledání ve Vašem systému. 

o Direct Creation of All Light Types: Pouţijte Light Types pop-up menu pro výběr a vloţení jednoho 
ze čtyř typŧ osvětlení Poseru 7 přímo do scény. Přidání světla je jednoduché jako kliknutí myší. 
(Viz “Vytvoření světla” na straně 62 pro více informací.) 

o Direct Creation of Cameras: Pouţijte Create Camera menu pro rychlé vytvoření nové otočné 
anebo pevné kamery. 
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o Duplicate Selected Object: Vytvořte klony objektŧ uvnitř scény pouţitím nové volby Duplicate. 
Nyní mŧţete jednoduše rozšiřovat scénu identickými, přesto nezávislými figurami, bez únavného 
procesu jejich individuální konfigurace! 

Posing  POSING (orig.3) 

o Universal Poses: Nyní mŧţete aplikovat jakoukoliv pózu na libovolnou dvounohou figuru uvnitř 
Poseru 7 bez ohledu na klouby, výbavu, apod. a kdykoliv dosáhnete vysoce kvalitní výsledky! 
Mŧţete také uloţené pózy z předchozích verzí Poseru znovu uloţit do knihovny Library v Poseru 
7 současně s jejich automatickou konverzí do Universal Poses. 

o Z-buffer Actor Selection: Proces pózování mŧţe být nyní prováděn jednodušeji! Z-buffer Actor 
Selection umoţņuje výběr zakrytých částí těla dokonce bez pohybu myši. Toto je obzvláště 
uţitečné při pózování rukou nebo v jiných případech, kdy části těla jsou těsně vedle sebe. (Viz 
“Kontextové menu záložky Preview” na straně 45 pro více informací.) 

o Dependent Parameters: Závislé parametry umoţņují modifikaci hromadných morph targetŧ  
a parametrŧ pomocí jednoho otočného ovladače, přiřazování hodnot rŧzných morphŧ nebo 
parametrŧ na rŧzná místa otočného ovladače. (Viz “Závislé parametry” na straně 281 pro více 
informací.) 

Animace  ANIMATION (orig.4) 

o Talk Designer: Chŧze a řeč jsou dva nejčastěji pouţívané a nejvíce náročné úkoly při animaci 
osob. Stejně jako Walk Designer, nový Talk Designer Poseru 7 nabízí intuitivní, jednoduše 
pouţitelné ovladače pro vytvoření neuvěřitelně realistických animací. Poser 7 automatizuje animaci 
výrazŧ obličeje a její synchronizaci se zvukovými soubory. Jednoduše nastavíte ovladače pro 
emoce, artikulaci a pohyb hlavy a očí pro úplné přizpŧsobení animací. (Viz “Použití designeru řeči” 
na straně 101 pro více informací.) 

o Animation Layers: Poser 7 nyní nabízí nelineární animaci, umoţņující oddělení rŧzných částí 
animace do samostatných dílŧ, které mohou být individuálně přesouvány, editovány, skrývány 
nebo postupně prolínány - potom při renderu Poser 7 hladce spojí všechny samostatné vrstvy do 
jedné společné animace! Animační vrstvy jsou podporovány dalšími animačními nástroji Poseru 7, 
jako je Walk Designer a Talk Designer, stejně jako knihovna Library umoţņuje jejich 
jednoduchou organizaci a opětovné pouţití rŧzných částí animací. (Viz “Záložka vrstev” na straně 
92 pro více informací.) 

o Visibility Channel: Nyní mŧţete animovat viditelnost individuálních objektŧ uvnitř scény, zobrazovat 
je nebo skrývat je postupně anebo okamţitě, vše pomocí jednoduchého nastavení otočného 
ovladače. (Viz “Paleta vlastností” na straně 75 pro více informací.) 

FireFly  FIREFLY (orig.4) 

Optimalizace pouţití prostředků (pro více informací o této funkci, viz “Techologie FireFly” na 
straně 249.) 

o Tiled Texture Loading: FireFly renderovací engine nyní pouţívá Tiled Texture Loading 
k ukládání textur do paměti a dočasných souborŧ na hard disk, pro okamţitý přístup během 
renderingu. Výsledkem je velká úspora poţadavkŧ paměti všeobecně a pro specifické funkce 
jako je Texture Filtering, která přebírá výhody dlaţdicovitě kladedých textur FireFly. 

o Improved Texture Filtering: Texture Filtering proces Poseru 7 byl nesmírně vylepšen, aby 
pouţíval významně méně paměti při udrţování optimalní kvality. Texture Filtering mŧţe být 
nyní konfigurován na per-texture bázi. 

o Multi-threaded Rendering: FireFly vyuţívá výhody výpočetní síly dostupné na více-jádrových 
a více-procesorových systémech dostupných na trhu pomocí renderingu aţ čtyř separátních 
threadŧ simultánně pro značné urychlení renderovacích časŧ v mnoha scénách. Mŧţete 
nastavovat počet threadŧ pro optimální výkon Vašeho systému, nebo na per-render bázi 
nastavovat odlišnou komplexnost vrstev specifických scén. 

o Render in Separate Process: FireFly renderer nyní obsahuje volbu pro běh v samostatném 
porcesu mimo aplikaci, coţ mŧţe přinášet výkonnostní výhody, pokud renderujete velmi 
komplexní scény. To také umoţņuje systému efektivněji vyuţívat pamět a přináší lepší stabilitu 
systému během rozdělování částí úlohy. 
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Zlepšená rychlost FireFly renderu  IMPROVED FIREFLY RENDER SPEED (orig.5) 

o Kd-tree Ray Accelerator: FireFly nyní vyuţívá výhody kd-tree Ray Acceleratoru, který zlepšuje 
výkon raytracingu ve členitých scénách.  

o Irradiance Caching: Funkce Irradiance Caching značně urychluje rychlost výpočtu Ambient 
Occlusion s prakticky ţádnými kompromisy ve kvalitě. Mŧţete konfigurovat Irradiance 
Caching pro koncept i finální rendery. (Viz “ Záložka FireFly: Nastavení kvality” na straně 
244 pro více informací.) 

o Occlusion Culling: Occlusion Culling technologie umoţņuje FireFly zvýšení výkonu renderu 
ignorováním neviditelných prvkŧ scény během renderu. (Viz “Technologie FireFly” na straně 
249 pro více informací.) 

o Depth of Field Acceleration: Poser 7 obsahuje vylepšené Depth of Field kalkulace výkonu 
FireFly renderovacího enginu, poskytující skvělé výsledky v kratším čase. 

Náhled dokumentu  DOCUMENT PREVIEW (orig.5) 

o Procedural Shader Preview: Poser 7 nyní mŧţe zobrazit výsledky většiny stínových efektŧ jiţ 
v okně náhledu, a to u systémŧ s výkonným hardwarem. Máte přehled o tom, jak Váš produkt bude 
ve výsledku vypadat, bez nutnosti renderování scény! (Viz “Záložka Náhled” na straně 246 pro více 
informací.) 

o Improved Texture Resolution: Poser 7 nyní podporuje textury v rozlišení aţ 4096 pixelŧ na 4096 
pixelŧ v okně náhledu, coţ přináší mnohem realističtější náhled scény. Mŧţete specifikovat 
optimální rozlišení textur s ohledem na Váš systém, přičemţ vyšší rozlišení vyţaduje více paměti. 
(Viz “Záložka Náhled” na straně 246 pro více informací.) 

Knihovny  LIBRARY (orig.5) 

o Content Collections: Poser 7 nyní přináší kolekce Collections, které jsou jednoduchou metodou 
organizování obsahu Poseru 7. Kolekce mohou obsahovat materiál z libovolné Runtime knihovny 
a poskytují okamţitý přístup k materiálu bez nutnosti změny knihoven. Kolekce vytvoříte jednoduše 
uvnitř Poseru 7, bez nutnosti nastavení nebo změny struktury souborŧ materiálŧ. (Viz “Kolekce 
obsahu” na straně 39 pro více informací.) 

o Body Transformations Saved in Poses: Poser 7 nyní nabízí volbu pro uloţení informací 
o transformacích postavy (jako jsou modifikace ovladačŧ parametrŧ) během ukládání póz do 
Library. Proto mŧţete pouţít tyto tranformace opětovně, kdyţ aplikujete pózu na další figuru bez 
nutnosti jejího přenastavení. 

o Add or Replace Light Sets: Nyní kdyţ vyberete světelný set z Library, mŧţete volitelně nový set 
přidat, nebo jej zaměnit za stávající set uvnitř scény, a to jednoduchým kliknutím na odpovídající 
Library ikonu. 

o Direct Access Runtime Switching: Nové Runtime pop-up menu umoţņuje přímý výběr a přepnutí 
odlišných knihoven Runtime, bez nutnosti prŧchodu skrze hierarchii sloţek v Library. (Viz 
“Zpřístupnění různých obsahových knihoven” na straně 29 pro více informací.) 

 

PŘILOŢENÁ DOKUMENTACE  INCLUDED DOCUMENTATION (orig.6) 

Poser 7 obsahuje následující dokumentaci: 

o Poser 7 Reference Manual: Tato uţivatelská příručka byla přepsána a byly přidány funkce Poseru 
7. Je obsaţena v instalaci na disku a v elektronickém PDF formátu na Vašem Poser 7 CD. Tento 
manuál je také moţné spustit Volbou Help>Poser 7 Reference Manual z programu Poser. 

 POZNÁMKA 
ORIGINÁLNÍ VERZE MANUÁLU, PŘÍSTUPNÁ Z HELP MENU, JE OPTIMALIZOVÁNA PRO 
PROHLÍŢENÍ NA OBRAZOVCE. POKUD SI MANUÁL PŘEJETE VYTISKNOUT, VAŠE POSER 7 
DVD OBSAHUJE VE SLOŢCE DOCUMENTATION VERZI, KTERÁ JE OPTIMALIZOVÁNA PRO 
TISK. 

o Quick Reference Card (QRC): QRC je rozkládací příručka, která stručně popisuje klíčové funkce 
Poseru 7 a obsahuje úplný seznam klávesových zkratek Poseru 7. 

o PoserPython Methods Manual: Tento manuál obsahuje uspořádaný seznam kaţdé PoserPython 
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metody, pouţité v Poseru 7. Je přiloţen v PDF formátu na Poser 7 DVD a je také dostupný přímo  
z Poseru 7 volbou Help>PoserPython Manual. 

o Poser 7 Tutorial Manual: Tento manuál poskytuje cvičení krok za krokem pro zvládnutí hlavních 
stránek Poseru 7 včetně Face Room, Cloth Room, Hair Room, a dalšího. Tento manuál je 
dostupný v PDF formátu volbou Help>Poser 7 Tutorial Manual a také na Poser 7 CD ve sloţce 
Documentation. 

o Quick Start Guide: Tento Quick Start guide je obrazovkový interaktivni prŧvodce, který uţivatele 
provádí krok za krokem úkony pro rychlou tvorbu scén v Poseru 7. 

 

SYSTÉMOVÉ POŢADAVKY  SYSTEM REQUIREMENTS (orig.6) 

Systémové poţadavky pro instalaci Poseru 7 jsou následující: 

WINDOWS 

o Windows 2000 nebo XP 
o 700 MHz Pentium nebo kompatibilní (je doporučen 1GHz nebo rychlejší) 
o 512 MB systémové RAM (je doporučeno 768 MB nebo více) 
o OpenGL grafická karta nebo čipset je doporučen (doporučena NVIDIA GeForce a ATI Radeon) 
o 24-bit barevný display, 1024 x 768 rozlišení  
o 1 GB volného místa na hard disku (4 GB jsou doporučeny) 
o Internet konektivita poţadovaná pro Content Paradise 
o DVD-ROM mechanika 

MACINTOSH 

o Mac OS X 10.3.9 nebo 10.4700 MHz G4 procesor (doporučeno Intel Core Duo nebo 1GHz G4 
a rychlejší) 

o 512 MB systémové RAM (768 MB a více je doporučeno) 
o OpenGL grafická karta nebo čipset je doporučen (doporučena NVIDIA GeForce a ATI Radeon) 
o 24-bit barevný display, 1024 x 768 rozlišení  
o 1 GB volného místa na hard disku (4 GB jsou doporučeny) 
o Internet konektivita poţadovaná pro Content Paradise 
o DVD-ROM mechanika 
 

POSER 7 MATERIÁL ONLINE  POSER 7 CONTENT ONLINE (orig.7) 

Content room Poseru 7 umoţņuje přímé online propojení na Content Paradise  
( http://www.contentparadise.com ), které přináší stovky figur, rekvizit, textur a dalšího materiálu 
dostupného pro pouţití v Poseru 7. Navíc Download Manager Poseru 7 plně automatizuje proces 
staţení materiálu a jeho instalaci do odpovídající kategorie knihovny Library, takţe přístup k vysoce 
kvalitnímu materiálu jiţ nemŧţebýt jednodušší! Viz kapitola 21:“Místnost obsahu” na straně 180 pro 
více informací o Content room a Content Paradise. 
 

DALŠÍ E FRONTIER PRODUKTY  OTHER E FRONTIER PRODUCTS (orig.7) 

Vyzkoušejte tyto produkty od e frontier: 

o Poser Figure Artist: Poser Figure Artist je online studio s modely, které jsou dostupné denně 
dvacetčtyři hodin, neunaví se a jsou daleko realističtější neţ dřevění manekýni. Poser Figure 
Artist přichází s bohatou knihovnou modelŧ muţŧ, ţen a dětí, se stovkami póz, výrazŧ, typŧ vlasŧ 
a částí oděvŧ, stejně jako s mnoha rekvizitami a pozadími pro vytváření kompletních scén. 

o Shade: Shade je 3D grafický nástroj pro designéry, illustrátory a architekty. Vytvářejte a podrobně 
navrhujte objekty s nejbohatší sestavou nástrojŧ dostupných za nízkou cenu. Přineste Vaše 
nápady do ţivota rychle s intuitivním modelingem pomocí Bezierových křivek. S  výkonným 
renderovacím enginem programu Shade se schopností Global Illumination, pouţijte Photon 
Mapping, Path Tracing, Raytracing a Radiosity pro render fotorealistických obrazŧ s úţasným 
osvětlením, reflexy a měkkými stínovými efekty. 

o Manga Studio: Manga Studio, dominantní software pro manga a umělecké komixy přináší všechny 
nezbytné nástroje, které potřebujete ke tvorbě profesionálních stránek od počátku do konce, 
připravených pro publikování! Manga Studio nabízí intuitivní rozhraní a přináší nejlepší soubory 

http://www.contentparadise.com/
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připravených tónŧ obrazovky, materiálŧ, speciálních manga a comixových efektŧ pro nadšence, 
zkušené umělce a profesionály. 

o Anime Studio: Anime Studio je komplexní animační program pro vytváření 2D animací, karikatur, 
videoklipŧ a střihŧ animací. Upravte si desktop animacemi ve stylu SouthParkStudios.com 
a JibJab.com, nebo pouţijte Anime Studio k výrobě plnohodnotné animace do filmu, videa nebo 
pro prezentaci na webu. Anime Studio dovolí domácím digitálním nadšencŧm a profesionálŧm ve 
studiu přinést jejich představivost do ţivota! 

o MotionArtist: MotionArtist umoţņuje vytváření Flash animací jednoduše a rychle. Bez skriptŧ  
a cenově dostupný, se skvělou knihovnou hotových Flash materiálŧ, MotionArtist je řešení Flash 
animací pro kaţdého, od úplných Flash začátečníkŧ po prokročilé Flash designéry. MotionArtist 
Vás povede po přímé dráze k výjimečné, rychle se načítající flashové animaci. 

 

KDYŢ MÁTE DOTAZY  WHEN YOU HAVE QUESTIONS (orig.8) 

Kdyţ začínáte s pouţíváním Poseru 7 ke svým 3D projektŧm, budete mít bezpochyby dotazy nebo se 
budete chtít spojit po síti s ostatními Poser umělci. Nejste sami! Je tam mnoho zdrojŧ dostupných pro 
Poser umělce. Zde je jen několik: 

POTŘEBUJETE POMOC?  NEED HELP? (orig.8) 

Poser 7 obsahuje menu Help, které přináší odpověď na většinu Vašich otázek, vznikajících během 
pouţívání aplikace: 

o Poser 7 Help: Volbou Help>Poser Reference Manual otevřete Poser 7 uţivatelskou příručku 
v PDF formátu. 

o PoserPython Help: Volbou Help>PoserPython Manual otevřete PoserPython Methods příručku 
v PDF formátu. 

o Tutorials: Volbou Help>Poser Tutorial Manual otevřete Poser 7 Tutorial příručku v PDF formátu. 

o About: Uţivatelé Windows mohou volbou Help>About Poser zobrazit údaje o verzi Poseru 7 
a copyright informace. Macintosh uţivatelé se mohou podívat do Poser Application menu a volbou 
About Poser zobrazit tytéţ informace. Tato funkce mŧţe být uţitečná pokud budete muset 
kontaktovat technickou podporu, neboť technická podpora bude vyţadovat znalost těchto údajŧ. 

E FRONTIER ZDROJE  E FRONTIER RESOURCES (orig.9) 

o Online Support: Pro technickou podporu, zákaznický servis, downloady a pro návštěvu e frontier 
Poser komunity a galerie nás navštivte na http://www.e-frontier.com . 

o To Learn More: Jestliţe se chcete dozvědět víc o e frontier, navštivte nás na http://www.e-
frontier.com/go/aboutus/  . 

o Contacting Technical Support: Pokud naše webová vědomostní databáze nevyřeší Vaši situaci, 
prosím zašlete nám email skrz http://www.e-frontier.com/go/emailtech . Prosím podívejte se 
do Dodatku A: “Technická podpora” na straně 274 pro představu o naší technické podpoře. 

o Sales: Mŧţete kontaktovat naše prodejní oddělení pomocí návštěvy stránky 
http://www.e-frontier.com/go/contact/ a volbou “Sales: General”, následně poloţku Contact. 

o Content Paradise Forums: Mŧţete najít oznámení a další uţitečné informace, stejně jako zúčastnit 
se diskuzí a získat odpovědi k Vašim specifickým otázkám, a to na Content Paradise fórech na 
http://www.contentparadise.com/forums/contentparadise  . 

o Other Links: Volbou Help>e frontier Web Links nebo Help>Other Web Links uvnitř Poseru 7 
zobrazíte další hodnotné online zdroje. 

OSTATNÍ FÓRA  THIRD-PARTY FORUMS (orig.9) 

Mŧţete také navštívit ostatní Poser fóra, jako jsou: 

o Renderosity: http://www.renderosity.com  

o 3D Commune: http://www.3dcommune.com  

o RuntimeDNA: http://www.runtimedna.com  

http://www.e-frontier.com/
http://www.e-frontier.com/go/aboutus/
http://www.e-frontier.com/go/aboutus/
http://www.e-frontier.com/go/emailtech
http://www.e-frontier.com/go/contact/
http://www.contentparadise.com/forums/contentparadise
http://www.renderosity.com/
http://www.3dcommune.com/
http://www.runtimedna.com/
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o Bbay: http://www.bbay.com  

o Animotions: http://www.animotions.com  

o Poser Pros: http://www.poserpros.com  

 POZNÁMKA 
E FRONTIER NEUSMĚRŅUJE OBSAH OSTATNÍCH FÓR A JEJICH SOUPIS A POŘADÍ 
ZOBRAZENÍ V TÉTO PŘÍRUČCE NENÍ  PODPOROVÁNO. 

DALŠÍ DŮLEŢITÉ ZDROJE  OTHER IMPORTANT RESOURCES (orig.10) 

Navštivte následující stránky k tomu, aby jste se dozvěděli něco o aplikacích a technologiích, které 
jsou podporovány Poserem 7: 

o Python resources: Následuje malý vzorek stále rostoucí skupiny online  tiskových informací, které 
se vztahují ke skriptovacímu jazyku Python: 

o Základní překladač Pythonu (který Vám dovolí psát vlastní Python skripty pro libovolný 
poţadovaný účel) stejně jako četné podrobné dokumenty a linky na další online zdroje jsou 
k dispozici pro bezplatné staţení na http://www.python.org . 

o Pro začínající Python programátory, zvláště ty s malými nebo ţádnými dřívějšími znalostmi 
programování, je určena publikace Teach Yourself Python in 24 hours od Ivana Van 
Laninghama. Tato kniha byla publikována SAMS, divizi Macmillan USA, 201 West 103rd Street, 
Indianapolis, IN 46290 USA; ISBN # 0-672-31735-4; Library of Congress Catalog Card Number 
99-65588. 

o Learning Python (Help for Programmers) od Marka Lutze, Davida Aschera, a Franka 
Willisona (editor); O‟Reilly & Associates; ISBN # 1-565-92464-9. 

o Python: Pocket Reference od Marka Lutze, Gigi Estabrook (editor); O‟Reilly & Associates; 
ISBN # 1-565-92500-9. 

o Python Reference Manual Release 1.5.2 od Guido Van Rossuma (pŧvodní autor Pythonu)  
a Freda L. Drakea, Jr. (editor); ISBN: 1583483748. 

 

O UŢIVATELSKÉ PŘÍRUČCE  ABOUT YOUR REFERENCE MANUAL (orig.10) 

e frontier se snaţí poskytovat dokumentaci, která je kompletní, přesná, informativní a přátelsky 
nakloněná. Vaše zpětná vazba je vţdy vítána. Prosím pošlete e-mailem Vaše komentáře na: 
docs@efrontier.com . 

Poser 7 uţivatelská příručka je pro Macintosh a Windows. Na základě dohody, Macintosh příkazy 
předcházejí v textu Windows příkazy. Poser 7 příkazy pro platformy Macintosh a Windows jsou 
identické, pokud není specifikováno jinak. 

Pro srozumitelnost tato příručka uţívá několik konvencí záznamu k tomu, aby prezentovala informace 
zvláštního významu. Seznamy poloţek, body pro uváţení nebo procedury které nemusí být vykonané 
ve specifickém pořadí jsou zobrazeny s odráţkou v textu ve formátu krouţku: 

o Poloţka 1 

o Poloţka 2 

Procedury, které musí následovat ve specifickém pořadí jsou zobrazeny v číslovaných krocích: 

1. Vykonat tento krok nejprve 

2. Vykonat tento krok jako druhý 

Specifikace tlačítek klávesnice jsou zobrazeny v hranatých závorkách a jsou psány velkým písmem. 
Například: [ESC]. Jestliţe více neţ jedna klávesa by měla být zmáčknuta současně, zápis vypadá 
takto: [KLÁVESA1]+[KLÁVESA2], například [ALT]+[F4]. Kdyţ se modifikační klávesa mezi Macintosh 
a Windows platformami liší, Macintosh modifikace je zobrazena nejdříve, následovaná lomítkem je 
potom modifikace pro Windows. Například [COMMAND]/[CTRL]+[I] je rovnocenný pro Macintosh 
[COMMAND]+[I] a pro Windows [CTRL]+[I]. 

Obrazovkové výzvy, menu a názvy oken, pole, tlačítka, boxy, atd. jsou zobrazeny tučným písmem. 
Tam, kde je zapotřebí výběr palety, příkazu nebo submenu, syntaxe je Menu>Submenu. Například 

http://www.bbay.com/
http://www.animotions.com/
http://www.poserpros.com/
http://www.python.org/
mailto:docs@efrontier.com
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File>Save As znamená, ţe byste měli otevřít File rozbalovací menu a potom zvolit Save As pro 
otevření dialogového okna Save As. 

Program a zápis kódu je zobrazen v standardním Courier fontu, například: 

cd\letters\business\legal [ENTER] 

 POZNÁMKA 
POZNÁMKY, PODROBNÉ TIPY, TRIKY A DALŠÍ DŦLEŢITÉ INFORMACE. 

 VAROVÁNÍ 
UPOZORNĚNÍ, KTERÉ VÁS VARUJÍ PŘED POTENCIÁLNĚ ŠKODLIVÝMI NÁSLEDKY JAKO JE 
ZTRÁTA DAT. 
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Kapitola 2: Instalace Poseru 7  INSTALLING POSER 7 (orig.12) 

LICENČNÍ UJEDNÁNÍ POSERU 7 (EULA)   
POSER 7 END USER LICENSE AGREEMENT (orig.12) 

Viz originál uţivatelské příručky v angličtině (POSER 7 END USER LICENSE AGREEMENT). 
 

INSTALACE POSERU 7  INSTALLING POSER 7 (orig.19) 

Instalace Poseru 7 je přímočarý proces. Před vloţením Vašeho DVD se ujistěte, ţe máte uloţenu 
veškerou rozdělanou práci a uzavřete všechny běţící aplikace včetně antivirových programŧ a dalších 
programŧ běţících na pozadí. Takto vyčištěné systémové prostředí pomŧţe k hladkému prŧběhu  
instalačního procesu a předejde jakékoliv velmi nepříjemné ztrátě dat. Pro instalaci Poseru 7 
postupujte následujícími kroky: 

WINDOWS 

1. Přečtěte, seznamte se a odsouhlaste Poser 7 EULA ujednání (uvedeno v textu anglického 
originálu příručky). 

2. Výjměte Vaše Poser 7 DVD z obalu a vloţte Application DVD do DVD mechaniky. Poser 7 
installer se spustí automaticky. Pokud se tak nestane, zvolte Tento počítač, pravým tlačítkem myši 
označte DVD mechaniku a zvolte Prozkoumat, potom poklikejte na Setup.exe ikonu v otevřeném 
okně. 

3. Zobrazí se uvítací obrazovka s doplņkovými informacemi, souvisejícími s instalačním procesem. 
Přečtěte si tyto informace a následně klikněte na tlačítko Next pro pokračování. 

4. V následujícím okně se zobrazí soubor Poser 7 Readme.txt. Soubor obsahuje informace, které 
byly uveřejněny po vydání této uţivatelské příručky. Prosím věnujte chvíli k přečtení tohoto 
souboru pro zjištění, jak by mohly poslední změny ovlivnit instalaci a pouţívání programu Poser 7. 
K pokračování klikněte na tlačítko Next. 

5. Zobrazí se Poser 7 EULA  ujednání. Jedná se o identický text s textem z anglického originálu 
příručky. K pokračování klikněte nak Yes. 

6. Zvolte adresář, do kterého chcete Poser 7 instalovat. Pokud nesouhlasíte s navrţenou základní 
nabídkou adresáře, vepište poţadovanou cestu do pole Destination Directory, nebo pouţijte 
tlačítko Browse k nalezení vyhlédnuté instalační sloţky. Jakmile máte zvoleno, klikněte na tlačítko 
Next pro pokračování. 

7. Zvolte poţadované nastavení instalace. Většina uţivatelŧ pravděpodobně zvolí kompletní instalaci 
volbou Full Installation. Volbou Minimal Installation budou nainstalovány pouze základní 
soubory Poseru 7 a minimální část nového materiálu, coţ je uţitečné v případě omezeného místa 
na pevném disku. Volba Custom Installation Vám umoţní výběr částí Poseru 7, které budou 
instalovány společně se základními soubory. Klikněte na tlačítko Next pro pokračování. 

8. Pokud v předchozím kroku zadáte volbu Custom Installation, zobrazí se dialog poţadující výběr 
nastavení obsahu instalace: Current Content, Legacy Content a General Audience. Následujte 
instrukce na obrazovce. 

9. Nyní se zobrazí přehled vybraných poloţek instalace. Prohlédněte si tyto informace a ujistěte se, 
ţe nastavení odpovídá Vašim poţadavkŧm. Potom klikněte na Next pro pokračování, nebo na 
Back pro návrat do předchozí nabídky. 

10. V tomto bodě jsou soubory Poseru 7 kopírovány na pevný disk. 

MACINTOSH 

1. Přečtěte, seznamte se a odsouhlaste Poser 7 EULA ujednání (uvedeno v textu anglického 
originálu příručky). 

2. Výjměte Vaše Poser 7 DVD z obalu a vloţte Application DVD do DVD mechaniky. Na Vaší 
pracovní ploše se objeví ikona DVD; pro otevření okna Poser 7 DVD poklikejte na tuto ikonu. 

3. Poklikejte na ikonu “Install Poser 7”. 
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4. Zobrazí se okno Authentication a budete poţádáni o zadání uţivatelského hesla nebo o zadání 
přístupového jména a hesla s administrátorským přístupem za účelem pokračování v instalaci. 

5. V následujícím okně se zobrazí soubor Poser 7 Readme. Soubor obsahuje informace, které byly 
uveřejněny po vydání této uţivatelské příručky. Prosím věnujte chvíli k přečtení tohoto souboru pro 
zjištění, jak by mohly poslední změny ovlivnit instalaci a pouţívání programu Poser 7. 
K pokračování klikněte na tlačítko Continue. 

6. Zobrazí se Poser 7 EULA  ujednání. Jedná se o identický text s textem z anglického originálu 
příručky. K pokračování klikněte nak Accept. 

7. Zobrazí se okno Poser 7 instalátoru. 

8. Zvolte adresář, do kterého chcete Poser 7 instalovat. Pokud nesouhlasíte s navrţenou základní 
nabídkou adresáře, pouţijte tlačítko Select Folder... pro vyhledání poţadované instalační sloţky. 
Jakmile máte zvoleno, klikněte na tlačítko Continue pro pokračování. 

9. Zvolte poţadované nastavení instalace. Většina uţivatelŧ pravděpodobně zvolí kompletní instalaci 
volbou Easy Install. Volbou Minimum Install budou nainstalovány pouze základní soubory 
Poseru 7 a minimální část nového materiálu, coţ je uţitečné v případě omezeného místa na 
pevném disku. Volba Custom Install Vám umoţní výběr částí Poseru 7, které budou instalovány 
společně se základními soubory. Pokud potřebujete informace o předvolbách Custom Install, 
jednoduše klikněte na informační tlačítko [I] vpravo vedle názvu předvolby. Jakmile máte vybránu 
volbu instalace, klikněte na tlačítko Install pro pokračování instalačního procesu. 

10. V tomto bodě jsou soubory Poseru 7 kopírovány na pevný disk. 
 

UPGRADE Z PŘEDCHOZÍ VERZE POSERU   
UPGRADING FROM AN EARLIER VERSION OF POSER (orig.21) 

Pokud upgradujete z předchozí verze Poseru, ujistěte se, ţe instalujete Poser 7 do samostatné 
prázdné sloţky tak, aby nedošlo ke kolizi s existující instalací Poseru. Pokud máte velké mnoţství 
materiálu z předchozí verze Poseru, ideální cestou pro jeho přidání do Poseru 7 je pomocí funkce 
Add Runtime. (Viz “Zpřístupnění různých obsahových knihoven” na straně 29 pro více informací  
o funkci Add Runtime). Nedoporučujeme pokoušet se kopírovat nebo reinstalovat obsah jiným 
zpŧsobem, protoţe nemŧţeme takto garantovat řádnou transformaci do Poseru 7. 
 

REGISTRACE POSERU 7  REGISTERING POSER 7 (orig.21) 

Po instalaci mŧţete zvolit registraci Vaší kopie Poseru 7 pomocí Webu. Registrace Poseru u e frontier 
je doporučena z dŧvodu dostupnosti technické podpory, bezplatného updatu produktu a jiných výhod. 

1. Pokud si přejete registrovat Vaši kopii Poseru 7, jednoduše označte políčko v authentikačním okně, 
které se zobrazí při prvním spuštění Poseru 7 a Poser automaticky registruje Váš produkt 
u e frontier. Pokud pouţijete tuto metodu, je to vše co musíte udělat ručně, ostatní se jiţ dokončí 
automaticky. 

2. Alternativně mŧţete otevřít Váš browser a navštívit adresu http://www.e-frontier.com/go/register. 
V případě chybového hlášení chvíli vyčkejte a poté zadejte adresu znovu. Pokud se chyby 
vyskytují opakovaně nebo pokud nemáte připojení k Internetu (nebo preferujete registraci pomocí 
emailu), mŧţete ke kompletní registraci pouţít telefonní číslo nebo email e frontier. 

3. Vyberte verzi Poseru, kterou si přejete registrovat a klikněte na tlačítko Next pro pokračování. 

4. Zadejte informace o uţivateli do formuláře, který se zobrazí v prohlíţeči. Políčka označená červeně 
jsou nezbytná pro registraci Vaší kopie Poseru 7. Zadejte informace a poté klikněte na tlačítko 
Register pro dokončení registrace. 

5. Pokud v jednom nebo více políčcích chybějí informace, zobrazí se zpráva, která označí 
nekompletní políčka. Budete vyzváni k doplnění poţadovaných údajŧ a k znovuodeslání 
uţivatelských dat. Pokud je regitrace v pořádku, zobrazí se závěrečná obrazovka. Děkujeme Vám 
za pouţití Poseru 7 od e frontier! 

 
 
 

http://www.e-frontier.com/go/register
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AKTUALIZACE POSERU  UPDATING POSER 7 (orig.22) 

e frontier podporují všechny své produkty vydáváním servisních balíčkŧ a dalších aktualizací, které 
řeší sporné otázky předchozích verzí nebo zvyšují pouţitelnost a funkcionalitu produktu. Poser 7 mŧţe 
automaticky po spuštění vyhledat aktualizace produktu a mŧţe oznámit, kdyţ aktualizace je dostupná. 
Prosím navštivte http://www.efrontier.com ke staţení poslední aktualizace. Pokud si přejete 
automatické upozornění na dostupnost aktualizace vypnout, mŧţete to udělat odznačením políčka 
Check for Updates on Launch v okně General Preferences. Pokud nemáte zvolenou funkci 
automatického vyhledávání aktualizací, navštěvujte prosím pravidelně http://www.efrontier.com pro 
zjistění vydání aktualizací produktu. Alternativně mŧţete kliknout na tlačítko Check Now v okně 
General Preferences  k provedení okamţitého vyhledání aktualizace. (Podívejte se na téma 
“Nastavení předvoleb aplikace” na straně 19 pro více informací o okně General Preferences.) 

http://www.efrontier.com/
http://www.efrontier.com/
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Kapitola 3: Nastavení pracovní plochy Poseru 7   
SETTING UP THE POSER 7 WORKSPACE (orig.23) 

Tato kapitola popisuje zpŧsoby, kterými si mŧţete Poser 7 individuálně uţivatelsky přizpŧsobit. 
Nastavení předvoleb bude uloţeno pod Vašim uţivatelským jménem v domovském adresáři. Toto 
umoţņuje rŧzným uţivatelŧm téhoţ systému pouţití jejich individuálního nastavení předvoleb. Pro 
konkrétní informace o umístění souborŧ předvoleb ve Vašem systému si prosím prohlédněte téma 
“Základní umístění souborů Poseru 7” na straně 278. 
 

NASTAVENÍ PŘEDVOLEB APLIKACE   
SETTING APPLICATION PREFERENCES (orig.23)

Okno hlavních předvoleb Poseru 7 Vám umoţní 
ovládání určitých komplexních nastavení.  
Otevřete odpovídající dialog volbou 
Edit>Preferences jak je popsáno v části “Hlavní 
předvolby” na straně 194. Zobrazí se okno 
hlavních předvoleb General Preferences. Pro 
uloţení Vámi nastavených předvoleb a uzavření 
dialogu, klikněte na tlačítko OK. Následující 
odstavce popisují dostupné předvolby. 

 
PŘEDVOLBY OKNA DOKUMENTU 
DOCUMENT PREFERENCES (orig.23) 

Tabulka předvoleb okna dokumentu obsahuje 
nastavení specifikovaná v záloţce nazvané 
Document. Předvolby okna dokumentu jsou 
následující:  

 
o Launch Behavior: Volba Launch Behavior (Reţim spuštění) umoţņuje specifikovat, jaké okno 

Document bude otevřeno při spuštění programu Poser 7, zda uţivatelsky přizpŧsobené nebo 
v továrním nastavení. Pokud si přizpŧsobíte okno dokumentu změnou jeho velikosti anebo jeho 
posunutím, označte poloţku Launch to preferred state (Spustit v upřednostņovaném nastavení). 
Tlačítko předvolby umoţní uloţit změny nastavení pro případ ţe ukončíte a později znovu spustíte 
Poser 7. Pokud si přejete nastavit okno dokumentu do základního továrního rozmístění a velikosti 
při kaţdém spuštění Poseru 7, označte poloţku Launch to factory state (Spustit v továrním 
nastavení). Kliknutím na tlačítko Set Preferred State (Volba upřednostņovaného nastavení) 
potvrdíte Vaši volbu. Prosím navštivte kapitolu 6: “Pracovní okno Document” na straně 41 pro více 
informací o okně Document. 

o Smoothing Preferences: Nastavení poloţky Default Crease Angle Vám umoţní specifikovat 
základní úhel deformace, který má být pouţit při výpočtech vyhlazení polygonu. Prosím navštivte 
kapitolu 15: “Vyhlazování povrchu” na straně 137 pro více informací o nastavení úhlu deformace. 

o Undo/Redo: Poloţka Undo/Redo umoţņuje specifikovat maximální počet uloţených úrovní 
Zpět/Znovu. V základu je nastaveno uloţení aţ 100 úrovní Undo (Zpět). Pokud máte dostupné 
systémové prostředky, mŧţete ponechat nastavení na hodnotě 100, nebo mŧţete hodnotu sníţit 
za účelem úspory paměti. Kliknutím na tlačítko Clear cache now... dojde k vymazání paměti 
úrovní Zpět/Znovu. 

 

PŘEDVOLBY UŢIVATELSKÉHO ROZHRANÍ  INTERFACE PREFERENCES (orig.24) 

Záloţka Interface obsahuje nastavení hlavního uţivatelského rozhraní Poseru 7. Předvolby 
uţivatelského rozhraní jsou následující: 

o Launch Behavior: Pokud přizpŧsobujete uţivatelské rozhraní Poseru 7 přidáním, odstraněním, 
otočením, změnou velikosti anebo skrytím rŧzných prvkŧ, uloţte změny nastavení před ukončením 
a novým spuštěním Poseru 7 pomocí tlačítka Launch to previous state. Pokud si budete přát 
navrátit uţivatelské rozhraní Poseru 7 do základního rozloţení a velikosti, pro následující spouštění 
vyberte tlačítko Launch to factory state. 

o Display Units: Poser 7 umoţņuje pracovat s reálnými světovými jednotkami, coţ zvyšuje Vaše 
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schopnosti na vytvoření precizního výsledku. Pouţijte rozbalovací menu Display units pro výběr 
poţadovaného typu měrných jednotek. Dostupné volby jsou: 

o Poser native units (nativní jednotky Poseru) 
o Inches (palce) 
o Feet (stopy) 
o Millimeters (milimetry) 
o Centimeters (centimetry) 
o Meters (metry) 

 POZNÁMKA 
JEDNA NATIVNÍ JEDNOTKA POSERU JE EKVIVALENTEM 8.6 STOPY, NEBO 262.128 
CENTIMETRU. 

 

PŘEDVOBY KNIHOVNY  LIBRARY PREFERENCES (orig.24) 

Předvolby knihovny obsahují nastavení, specifická pro knihovnu Poseru 7. Nastavení předvoleb 
knihovny (pod záloţkou Library) jsou následující: 

o Double-click Behavior: Nastavení Double-click Behavior (Chování dvojkliku) specifikuje výsledek 
dvojkliku na poloţku v knihovně Library. Výběrem mezi předvolbami volíte mezi přidáním nové 
poloţky do scény, nebo mezi nahrazením poloţky ve scéně. Všimněte si, ţe pokud poprvé 
dvojkliknete (poklikáte) na poloţku knihovny, objeví se okno dialogu, které Vám dovolí specifikovat 
toto nastavení. Vámi zvolené nastavení bude aplikováno na všechny následující výběry pomocí 
dvojkliku aţ do té doby, kdy provedete případné změny nastavení v tabulce předvolby knihovny 
(pod záloţkou Library). 

o File Search: Pokud je nějaká objekt nahráván z knihovny Library, Poser 7 vyhledává všechny 
asociované soubory uloţené s tímto objektem. Volba File Search umoţņuje konfiguraci rozsahu 
tohoto hledání. Moţnosti jsou následující: 

o None: Volba None vypne hledání souborŧ; tato moţnost je uţitečná pro testování správnosti 
nově vyvinutého obsahu. 

o Shallow: Volba Shallow bude redukovat mnoţství času stráveného hledáním chybějících 
souborŧ, ale zvýší se ţádosti o lokalizaci souborŧ nenalezených. 

o Deep: Toto je základní nastavení File Search. Doporučujeme Vám nastavit vyhledávání 
souborŧ Deep, protoţe tato volba spustí nejrozsáhlejší pátrání po obsahových souborových 
součástech objektu. Z tohoto dŧvodu dojde ke zvýšení pravděpodobnosti nalezení chybějících 
souborŧ. 

o Thumbnail Display: Poser 7 mŧţe převést náhledy poloţek do textového seznamu, pokud počet 
poloţek v konkrétní sloţce knihovny překračuje specifikovanou mez. Poloţka Thumbnail Display 
umoţņuje specifikovat mez, po jejíţ překročení budou náhledy poloţek převedeny na textové 
popisy, případně moţnost předevení zcela zablokovat. Klikněte na odpovídající tlačítko pro 
specifikaci chování náhledŧ poloţek. Pokud si přejete změnit prahovou hodnotu zobrazení 
náhledŧ, zadejte poţadovanou hodnotu do textového pole. 

 

PŘEDVOLBY RENDERU  RENDER PREFERENCES (orig.25) 

Záloţka Render obsahuje nastavení specifická pro FireFly renderovací engine. Nastavení předvoleb 
redneru jsou následující: 

o Memory Settings (nastavení paměti): 

o Adaptive Bucket Size: Označením políčka Adaptive Bucket Size je aktivováno automatické 
nastavení velikosti sektoru FireFly rendereru.  

o Adaption Threshold: definuje jaká část zbývající paměti bude poskytnuta k dalšímu členění na 
sektory renderem. Zbývající paměť je měřena při startu renderu a při kaţdé změně velikosti 
sektoru. Zvyšování této hodnoty přináší menší velikosti sektoru, sniţování bude znamenat 
uţívání více virutální paměti.  

o Memory limit buffer: definuje bezpečnou velikost vyrovnávací paměti v megabajtech. Jestliţe 
bude k dispozici méně paměti, render se ukončí. Sniţování této hodnoty mŧţe zabránit 
předčasné ukončení renderu, ale mŧţe také ovlivnit stabilitu systému. 
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o Render Process Settings (nastavení procesu renderu): 

o Separate Process: Označením políčka Separate Process je aktivován běh FireFly renderŧ 
pomocí separátního procesu v procesoru a naopak. Tato vlastnost je standardně zablokovaná. 
Pro více informací o renderingu pomocí separátního procesu navštivte téma  “Technologie 
FireFly” na straně 249. 

o Number of Threads: Pokud vlastníte víceprocesorový anebo vícejádrový výpočetní systém, 
mŧţete vyuţít výhody multi-threadového (vícevláknového) renderingu pomocí nastavení 
posuvného ovladače Number of Threads na hodnotu větší neţ jedna. I kdyţ Váš systém je 
dvouprocesorový nebo dvoujádrový, mŧţete pozorovat zvýšený uţitek při nastavení počtu 
vláken na čtyři, spíše neţ jen na dvě. Avšak jestli naopak máte jednojádrový processor,  
doporučujeme nastavit počet vláken na jedno, protoţe zvětšené paměťové poţadavky běţících 
paralelních vláken moţná vykompenzují výkonnostní výhody. Pro více informací 
o vícevláknovém renderingu navštivte téma “Technologie FireFly” na straně 249. 

 POZNÁMKA 
I PŘES POUŢITÍ VÍCE-PROCESOROVÉHO NEBO VÍCE-JÁDROVÉHO SYSTEMU, POKUD 
RENDERUJETE VYSOCE DETAILNÍ SCÉNU NÁROČNOU NA PAMĚŤ, MŦŢETE ZJISTIT, ŢE 
LEPŠÍCH VÝSLEDKŦ DOSÁHNETE PŘI SNÍŢENÍ POČTU RENDEROVACÍCH VLÁKEN ZA 
ÚČELEM SNÍŢENÍ PAMĚŤOVÝCH NÁROKŦ. DOPORUČUJEME RENDEROVAT VAŠI 
SCÉNU POMOCÍ ČTYŘ VLÁKEN A POKUD BUDETE NESPOKOJENI S VÝSLEDNÝM 
VÝKONEM, NEBO JESTLI RENDER KOMPLETNĚ SELŢE, POTOM SNIŢTE POČET 
RENDEROVACÍCH VLÁKEN (THREADŦ). 

o Rendered Image Cache: Nastavení Max Cached Renders Vám umoţņuje stanovit počet 
posledních renderŧ, které budou dočasně uloţeny pro přístup pomocí funkce Render Compare 
v okně Document v záloţce Render. Prosím navštivte téma “Porovnání renderu” na straně 49 
pro více informací o funkci Render Compare. 

 

RŮZNÉ PŘEDVOLBY  MISCELLANEOUS PREFERENCES (orig.26) 

o Save Files: Poser 7 přináší v záloţce Misc nasledující moţnosti nastavení uloţení souboru: 

o Use File Compression: Poser 7 podporuje pouţití komprimace souborŧ, která umoţņuje ušetřit 
významné mnoţství diskového prostoru. Pro pouţití komprimace souborŧ označte poloţku Use 
file compression. Neoznačením poloţky je podpora komprimace souborŧ zablokována. 

 POZNÁMKA 
POSER 7 POUŢÍVÁ STANDARTNÍ  Z-LIB KOMPRIMACI, KTERÁ UMOŢŅUJE POUŢITÍ 
LIBOVOLNÉ KOMPATIBILNÍ APLIKACE PRO KOMPRIMACI A DEKOMPRIMACI 
ULOŢENÝCH SOUBORŦ. 

Všechny soubory Poseru 7 (scény, figury, pózy, výrazy, vlasy, ruce, rekvizity, světla, kamery, 
materiály) mohou být komprimovány. Komprimované soubory Poseru mají koncovku *.**Z 
(*.PZZ, *.CRZ, *.FCZ, atd.). Soubory rekvizit Poseru 7 jsou uloţeny s koncovkou P2Z pro 
zamezení zmatku při moţné záměně s komprimovanými soubory scény. Pokud plánujete 
distribuovat soubory pro pouţití ostatními umělci s předchozími verzemi Poseru, ukládejte je 
prosím bez komprimace. Poser podporuje komprimaci souborŧ aţ od verze s add-onem Pro 
Pack pro Poser 4. 

 POZNÁMKA 
NĚKTEŘÍ POKROČILÍ UMĚLCI POUŢÍVAJÍ EDITACI TEXTU APLIKACE PRO PŘÍMOU 
EDITACI SOUBORŦ POSERU. PŘED EDITACÍ KOMPRIMOVANÝCH SOUBORŦ MUSÍ BÝT 
TYTO DEKOMPRIMOVÁNY. K PROVEDENÍ DEKOMPRIKACE MŦŢETE NAPŘÍKLAD 
SOUBOR NAHRÁT DO POSERU 7, ZABLOKOVAT PODPORU KOMPRIMACE SOUBORŦ  
A NÁSLEDNĚ SOUBOR ULOŢIT POD NOVÝM JMÉNEM, NEBO POUŢÍT APLIKACI TŘETÍ 
STRANY JAKO JE WINZIP NEBO STUFFIT PRO DEKOMPRIMACI SOUBORU. POKUD 
POUŢIJETE DRUHOU METODU, MUSÍTE PO DOKONČENÍ EDITACE SOUBORU TENTO 
ZNOVU KOMPRIMOVAT. 

o Use External Binary Morph Targets: Označením této poloţky umoţníte pouţití External Binary 
Morph Targets (EBMTs) pokud ukládáte nový obsah, nebo opětovně ukládáte základní 
poloţky Poseru 7. Uloţením základních figur do knihovny Poseru 7 Library s touto poloţkou 
aktivovanou, budou pro tyto figury generovány nové .pmd EBMT soubory. To přináší výhodu 
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sdílení morph targetŧ, redukci velikosti souborŧ a rychlejší práci se základními figurami. 

o Set Python Editor: Kliknutím na poloţku Set Python Editor se otevře standardní Browse dialog, 
který Vám umoţní výběr aplikace, kterou si přejete pouţít pro editaci PoserPython skriptŧ 
(například Poznámkový blok pro Windows). 

o Software Updates: Označením políčka Check for Updates on Launch bude aktivována funkce 
automatického zjišťování aktualizací (viz “Aktualizace Poseru” na straně 18 pro více informací  
o této funkci). Ponecháním prázdného políčka bude automatická aktualizace zablokována. 
Kliknutím na tlačítko Check Now lze spustit okamţité zjištění dostupnosti aktualizace. 

 

NASTAVENÍ PRACOVNÍ PLOCHY  SETTING UP YOUR WORKSPACE (orig.27) 

Pracovní plocha Poseru 7 se skládá z kompletní obrazovky s ovladači, okna Document a elementŧ 
rozhraní specifických místností (Rooms). Většinu těchto prvkŧ si mŧţete uţivatelsky přizpŧsobit tak, 
aby odpovídaly zpŧsobu Vaší práce a tuto volbu uloţit pro pozdější pouţití. 
 

UŢIVATELSKÉ PŘIZPŮSOBENÍ PRVKŮ PRACOVNÍ PLOCHY 
CUSTOMIZING WORKSPACE ELEMENTS (orig.27) 

Jednotlivé části pracovní plochy si mŧţete přizpŧsobit následovně: 

o Pro změnu umístění prvkŧ pracovní plochy (jako jsou například Editing tools), klikněte na 
odpovídající nadpis poţadovaného elementu a táhnutím jej přesuņte do nové polohy. Element 
mŧţete také skrýt tak, ţe je zobrazen pouze jeho nadpis, který se zvýrazní při pohybu kurzoru nad 
ním. Pro skrytí elementu poklikejte na jeho nadpis. 

o Mŧţete také měnit mezi horizontálním nebo vertikálním zobrazení Editing tools a Display 
controls pomocí stisku klávesy [OPT]/[ALT] během kliknutí na element, který si přejete otočit. 

o Mŧţete také změnit polohu obrázku podkladu pracovní plochy stejným zpŧsobem, jako ostatní 
elementy pracovní plochy (kliknutím a taţením). 

o Mŧţete si vybrat mezi několika dostupnými obrázky podkladu pracovní plochy (dekorativním 
pozadím pracovního prostoru Poseru 7) pomocí stisku klávesy [OPT]/[ALT] během kliknutí na 
obrázek. Jednou z moţností je volba bez obrázku; v tomto případě stiskem [OPT]/[ALT] při kliknutí 
na kteroukoliv prázdnou část pracovní plochy dojde k zobrazení prvního dostupného obrázku. 

 
PAMĚŤOVÁ TLAČÍTKA UŢIVATELSKÉHO ROZHRANÍ  UI MEMORY DOTS (orig.28) 

Pouţitím paměťových tlačítek uţivatelského rozhraní UI Memory Dots mŧţete uloţit aţ devět 
nastavení pracovní plochy (popsáno v části “Paměťová tlačítka” na straně 26). Kaţdé paměťové 
tlačítko uchová odlišnou variantu nastavení uţivatelského rozhraní. Tato funkce je globálně 
aplikovatelná, to znamená, ţe paměťová tlačítka mohou být aplikovaná bez ohledu na specifickou 
scénu nebo rozlišení. Alternativní metodou uloţení uţivatelského rozhraní pro přístup do kterékoliv 
scény Poseru 7 je modifikace hlavních předvoleb Poseru 7, jak je popsáno v části “Nastavení 
předvoleb aplikace” na straně 19. Nicméně, jelikoţ převolby uloţené tímto zpŧsobem jsou uloţeny 
samostatně pro kaţdé rozlišení obrazovky, mŧţete pouţitím hlavních předvoleb Poseru 7 ušetřit jedno 
UI nastavení pro konkrétní rozlišení. 
 

NASTAVENÍ PRACOVNÍHO OKNA  SETTING UP THE DOCUMENT WINDOW (orig.28) 

Prosím navštivte kapitolu 6: “Pracovní okno Document” na straně 54 pro více informací o přizpŧsobení 
pracovního okna Document a pouţití zde se nacházejících ovladačŧ. 
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Část 2 – PRACOVNÍ PLOCHA 

POSERU 7 

POSER 7 WORKSPACE REFERENCE (orig.29) 

Kapitola 4: Místnost pózy  THE POSE ROOM (orig.30) 

Místnost pózy Pose bude hlavním předmětem Vaší aktivity v Poseru 7. Toto je místo, kde vkládáte 
figury nebo rekvizity do scény a kde vytvoříte Vámi poţadovanou pózu/animaci figury a rekvizity  
(k sestavení a oţivení těchto poloţek budete pouţívat následně místnosti Hair, Cloth, Material,  
a Face a z libovolné místnosti mŧţete také zpřístupnit paletu knihoven Library). Tato kapitola Vás 
seznámí se základním uţivatelským rozhraním Poseru 7. Pozdější části této příručky pak zajdou do 
detailu kaţdého prvku uţivatelského rozhraní. Místnost pózy Pose vypadá následovně: 

 

Jako doplněk k místnostem pouţívá Poser 7 plovoucí palety a okna. Většina funkcí je dostupných  
z plovoucích palet a oken uvniř místnosti samé. Většina místností Poseru 7 (včetně místnosti Pose) 
Vám dovolí přizpŧsobit pracovní plochu Poseru 7 pomocí skrývání/zobrazení a přemísťování 
ovládacích prvkŧ podle libosti. Mŧţete dokonce uloţit aţ devět odlišných konfigurací obrazovky 
pracovní plichy Poseru 7. 

Čísla na obrázku nahoře identifikují ovládací prvky dostupné v místnosti pózy Pose: 

o Lišta Menu - Menu bar (1) 
o Ovladače osvětlení - Light controls (2) 
o Ovladače kamery - Camera controls (3) 
o Záloţky místností - Room tabs (4) 
o Editační nástroje - Editing tools (5) 
o Pracovní okno - Document window (6) 
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o Ovladače zobrazení - Display controls (7) 
o Palety parametrŧ a vlastností - Properties & Parameters palettes (8) 
o Paleta knihoven - Library palette (9) 
o Paměťová tlačítka - UI dots (10) 
o Ovladače animace - Animation controls (11) 

Prosím navštivte téma “Nastavení pracovní plochy” na straně 22 pro více informací o vytvoření  
a uloţení uţivatelského vzhledu pracovní plochy. Následující část poskytne stručný popis označených 
prvkŧ rozhraní s odkazy na detailnější informace. 
 

LIŠTA MENU  MENU BAR (orig.31) 

Lišta Menu obsahuje sérii rozbalovacích nabídek, umoţņujících přístup k funkcím Poseru 7. Některé 
nabídky a podnabídky duplikují ostatní ovládací prvky na obrazovce. Lišta Menu vypadá následovně  
a je dostupná z kaţdé místnosti Poseru 7: 

 

Prosím navštivte Část 3: “Lišta Menu Poseru 7” na straně 185 pro kompletní popis všech 
rozbalovacích nabídek a podnabídek Lišty Menu. 
 

OVLADAČE OSVĚTLENÍ   
LIGHT CONTROLS (orig.31) 

Ovladače osvětlení Light controls Vám umoţní nastavení 
předvoleb osvětlení. Pouţíjte je za účelem přidání nebo 
odstranění světel, pro specifikaci barev světel a dalších 
světelných vlastností. Ovladače osvětlení vypadají 
následovně: 

Prosím navštivte Kapitolu 9: “Osvětlení” na straně 61 pro více 
informací o ovladačích osvětlení. 
 

OVLADAČE KAMERY   
CAMERA CONTROLS (orig.32) 

Ovladače kamery Camera controls Vám umoţní výběr a pohyb jedné 
nebo více kamer. Jsou zde dva typy kamerových ovladačŧ - pohled  
a pozice: 

Nejvrchnější ovladače jsou ovladače pohledu. Kliknutím na jeden  
z těchto ovladačŧ aktivujete odpovídající kamery obličeje Face, levé 
ruky Left Hand nebo pravé ruky Right Hand. Také mŧţete procházet 
rozbalovacím seznamem dostupných kamer.  

Ovladače pozice níţe se pouţívají k pohybu nebo rotaci aktuálně 
vybrané kamery. Ovladače polohy roviny pohybují kamerou podél X, 
Y, nebo Z osy, pohybem trackballu se aktuálně vybraná kamera otáčí 
beze změny umístění v 3D prostoru. Pro pouţití ovladačŧ kamery 
jednoduše klikněte a táhněte odpovídajícím ovladačem. Pohyb 
kamery nezmění umístění nebo pózu figur, rekvizit a jiných elementŧ 
Vaší scény. 

Sestava ovladačŧ kamery se nachází v pravém horním rohu 
pracovního okna Document. Prosím navštivte Kapitolu 8: “Kamery” 
na straně 53 pro kompletní informace o ovladačích kamery.  
 

ZÁLOŢKY MÍSTNOSTÍ  ROOM TABS (orig.32) 

Záloţky místností Room Tabs Vám umoţní přepínat mezi jednotlivými místnostmi v Poseru 7. Pro 
vstup do poţadované místnosti jednoduše klikněte na záloţku. 
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EDITAČNÍ NÁSTROJE  EDITING TOOLS (orig.32) 

Paleta editačních nástrojŧ Editing Tools obsahuje nástroje, které budete nejčastěji pouţívat pro 
nastavení pózy figur nebo rekvizit: 

Výběrem části těla nebo rekvizity a následně poţadovaného editačního nástroje mŧţete nastavovat 
objekty rŧznými zpŧsoby jako je posun (pohyb ze strany na stranu nebo tam a zpět), rotace, kroucení, 
atd. Mŧţete také pouţít další funkce jako je editace inverzní kinematiky (IK) nebo práce se skupinami 
materiálŧ/prvkŧ. Kaţdý editační nástroj je trochu odlišný, ale jejich základní pouţití je následující: 

 

1. Vyberte Vámi poţadovanou část těla nebo rekvizity ve scéně (označovanou jako prvek nebo 
činitel) kliknutím na ni. 

2. Vyberte poţadovaný editační nástroj. Najednu mŧţete mít vybrán pouze jeden editační nástroj. 
Vybraný nástroj je v rozhraní Poseru 7 vyznačen ţlutou barvou. 

3. Klikněte a táhněte myší pro vykonání vybrané funkce. 

Pro vytvoření stacionární nebo animované pózy mŧţete kombinací editačních nástrojŧ vytvořit 
nekonečné mnoţství virtuálních poloh. Prosím navštivte téma “Editační nástroje” na straně 71 pro více 
informací o editačních nástrojích Editing Tools. Navíc je o kaţdém nástroji podle potřeby diskutováno 
uvnitř této příručky. 
 

PRACOVNÍ OKNO DOCUMENT  DOCUMENT WINDOW (orig.33) 

Pracovní okno Document je pohledem do pracovní oblasti, ve které nastavujete Vaší figuru a přímo 
ovlivņujete scénu. Kaţdý pohled pracovního okna se uskutečņuje pomocí virtuální kamery, coţ 
znamená, ţe na kaţdou scénu se mŧţete dívat z mnoha úhlŧ, buď jeden po druhém nebo aţ ze čtyř 
úhlŧ najednou: 

Kamery pro pohled na scénu mŧţete umístit z jakéhokoliv úhlu nebo vzdálenosti a velikost pracovního 
okna mŧţete měnit podle potřeby. Pracovní okno má navíc okolo okrajŧ ovládací prvky pro změnu 
zobrazení prvkŧ scény. Objekty uvnitř scény mŧţete vybírat kliknutím přímo na ně v pracovním okně 
nebo pomocí menu ve spodní části okna. Prosím navštivte kapitolu 6: “Pracovní okno Document” na 
straně 41 pro více informací o pracovním okně. 
 

OVLADAČE ZOBRAZENÍ  DISPLAY CONTROLS (orig.33) 

Ovladače zobrazení Display Controls Vám umoţní výběr poţadovaného módu náhledu vytvářené 
scény, figury nebo rekvizity, anebo aktuálně vybrané části figury/rekvizity: 

 

Prosím navštivte kapitolu 7: “Ovladače zobrazení” na straně 50 pro více informací o ovladačích 
zobrazení. 
 

PALETY PARAMETRŮ A VLASTNOSTÍ   
PARAMETERS/PROPERTIES PALETTE (orig.34) 

Poser 7 nabízí snadno pouţitelné palety parametrŧ Parameters a vlastností Properties, které Vám 
umoţní přístup k parametrŧm a vlastnostem kaţdého objektu scény z jednoho pohodlného místa: 
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K přepnutí mezi paletami parametrŧ a vlastností jednoduše 
klikněte na odpovídající záloţku v horní části palety. Prosím 
navštivte téma “Paleta parametrů/vlastností” na straně 75 pro 
více informací o paletách parametrŧ a vlastností. 

 POZNÁMKA 
AČKOLI SE OVLADAČE PARAMETRŦ A VLASTNOSTÍ 
OBJEVUJÍ NA STEJNÝCH PALETÁCH, PRO 
SROZUMITELNOST O NICH V TÉTO PŘÍRUČCE 
POJEDNÁME ODDĚLENĚ.  

 

PALETA PARAMETRŮ   
PARAMETERS PALETTE (orig.34) 

Paleta parametrŧ Parameters obsahuje všechny parametry 
objektu (jejich nastavení je popsáno v části “Paleta parametrů” 
na straně 77) a morph targety. Kaţdý objekt obsahuje 
specializované parametry, které jsou podle potřeby popsány  
v této příručce. Jednotlivé objekty mohou mít jedinečné 
vlastnosti. Například rŧzné figury mají k dispozici rozdílné morph 
targety. 

 

PALETA VLASTNOSTÍ   
PROPERTIES PALETTE (orig.34) 

Paleta vlastností Properties obsahuje všechny vlastnosti objektu. Vedle určitých univerzálních 
vlastností (které jsou popsány v části “Paleta vlastností” na straně 75), kaţdý objekt obsahuje 
specializované vlastnosti, které jsou podle potřeby popsány v této příručce. 
 

PALETA KNIHOVEN LIBRARY   
LIBRARY PALETTE (orig.35)

ZÁLOŢKA KATEGORIÍ  CATEGORIES TAB (orig. 35) 

Záloţka kategorií Categories palety knihoven Library umoţņuje přístup  
k veškerému dostupnému obsahu Vaší instalace Poseru 7, včetně 
doplņkového obsahu, který jste získali zvlášť. Paleta obsahuje kategorie 
(Figures, Props, atd.) a podkategorie (People, New Figures, atd.) pro 
organizaci obsahu Poseru 7: 

Pouţívejte paletu knihoven Library k přidávání a odebírání jednotlivých 
částí scény. Prosím navštivte kapitolu 5: “Knihovny Poseru 7” na straně 28 
pro více informací o paletě knihovny. Poser 7 je dodáván s rozsáhlou 
sadou obsahu knihovny, kterou mŧţete pouţít k vytvoření tisícŧ 
stacionárních nebo animovaných scén.  

Také mŧţete pouţít místnost obsahu Content room k nalezení a získání 
velkého mnoţství volného nebo komerčního obsahu z nejvýznamnějších 
3D obchodŧ! Prosím navštivte kapitolu 21 “Místnost obsahu” na straně 182 
pro více informací o místnosti obsahu. 
 

ZÁLOŢKA KOLEKCÍ  COLLECTIONS TAB (orig.35) 

Záloţka kolekcí Collections palety knihoven Library uchovává Vaše osobní sbírky obsahu pro Poser 
7. Pro více informací o kolekcích obsahu navštivte téma “Kolekce obsahu” na straně 39. 
 

PAMĚŤOVÁ TLAČÍTKA  MEMORY DOTS (orig.35) 

Schopnost přizpŧsobení pracovní plochy by nebyla uţitečná, pokud by neexistoval 
ţádný zpŧsob uloţení poţadovaného nastavení. Poser 7 předkládá paměťová 
tlačítka Memory dots, která umoţņují uloţení póz, nastavení kamer, předvoleb 
uţivatelského rozhraní (UI) a přepínání mez uloţenými pozicemi jednoduchým 
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kliknutím myší. 

Kliknutím na šipku na levé straně nadpisu nad paměťovými tlačítky mŧţete vybrat poţadovanou 
sestavu tlačítek.  

Prosím prostudujte následující části příručky pro více informací o jednotlivých typech paměťových 
tlačítek: 

o Pose Dots: Tlačítka póz Pose dots jsou dále detailně popsány v části 
“Paměťová tlačítka póz” na straně 82. 

o Camera Dots: Tlačítka kamer Camera dots jsou dále detailně 
popsány v části “Kamerová tlačítka” na straně 60. 

o UI Dots: Tlačítka uţivatelského rozhraní UI Dots jsou dále detailně 
popsány v části “Nastavení pracovní plochy” na straně 22.  

 

POUŢITÍ PAMĚŤOVÝCH TLAČÍTEK  USING MEMORY DOTS (orig.36) 

Pro pouţití paměťových tlačítek Memory dots: 

1. Nastavte poţadovanou pózu, kameru anebo uţivatelské 
rozhraní (UI), které chcete uchovat. 

2. Pouţijte rozbalovací menu pro výběr odpovídajícího typu 
tlačítek podle nadpisu umístěného nad nimi. 

3. Klikněte na prázdné paměťové tlačítko. Toto tlačítko se 
vyplní tak, jak je znázorněno na obrázku napravo: 

Tlačítka se pouţívají jednoduchým kliknutím na ně. Uloţené nastavení se zobrazí ve Vaší scéně. Pro 
vymazání obsahu paměťového tlačítka (vymazání informací a vytvoření prázdného tlačítka), stiskněte 
a podrţte [OPT] / [ALT] a klikněte na paměťové tlačítko, které si přejete vymazat.  
 

OVLADAČE ANIMACE  ANIMATION CONTROLS (orig.36) 

Ovladače animace Animation controls zpřístupņují náhled animace a nastavení jednotlivých snímkŧ. 
Mŧţete umístit figuru do poţadované pózy, posunout se na nový snímek a pózu změnit. Kliknutím na 
tlačítko Play dojde k přehrání animace za pouţití vytvořených snímkŧ. Ovladače animace vypadají 
následovně: 

 

Prosím navštivte téma “Použití ovladačů animace” na straně 85 pro více informací o ovladačích 
animace a kapitolu 11: “Animace pomocí Poseru 7” na straně 83 pro více informací o vytváření  
a renderingu animací za pouţití Poseru 7. 
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Kapitola 5: Knihovny Poseru 7  THE POSER 7 LIBRARY (orig.37) 

Hierarchická paleta knihoven Library Poseru 7 poskytuje přístup k veškerému obsahu, který je 
dodáván k Poseru 7, jako například k fugurám, rekvizitám, světlŧm, kamerám, apod. Paleta knihoven 
má dvě záloţky, záloţka kategorií Categories tab umoţņuje přístup ke kategoriím obsahu Poseru 7  
a záloţka kolekcí Collections tab uchovává Vaše osobní obsahové kolekce. Záloţka kategorií 
Categories tab obsahuje devět kategorií, popsaných dále. Kaţdá kategorie se dále dělí na 
podkategorie. Mŧţete vytvářet a odstraņovat kategorie a subkategorie a také přidávat a odstraņovat 
jejich obsah (viz “Údržba Vaší palety knihoven” na straně 33 pro informace o údrţbě Vaší palety 
knihoven Library). Poser 7 mŧţe automaticky instalovat zakoupený nebo získaný obsah za pouţití 
místnosti obsahu Content room jak je popsáno v kapitole 21: “Místnost obsahu” na straně 182. 
Paleta knihoven Library v rozbaleném stavu je zobrazena níţe a následující část příručky probere 
paletu knihoven Library detailně. 

 
 

ZOBRAZENÍ PALETY KNIHOVEN  DISPLAYING THE LIBRARY PALETTE (orig.37) 

Pro zobrazení palety knihoven Library jednoduše klikněte na madlo na pravé straně obrazovky 
Poseru 7 nebo zvolte Window>Libraries. Paleta knihoven Library bude otevřena do jednoho sloupce 
zakotveného na pravé straně pracovního okna Poseru 7. Pro skrytí palety knihoven jednoduše 
opětovně zvolte Window>Libraries, nebo klikněte na ikonu Close Palette v pravém horním rohu 
palety Library. Paletu knihoven Library mŧţete rozšířit za účelem zobrazení více obsahu najednou 
pomocí kliknutí na madlo palety a taţením napříč obrazovkou do poţadované šířky. Kliknutím na 
ikonu Dock/Undock v pravém horním rohu palety knihoven Library dojde k odpoutání palety od 
okraje pracovní plochy Poseru 7. Jakmile je paleta odpoutána, chová se jako standardní plovoucí 
paleta, která mŧţe být přesouvána pro trvalou dostupnost do jiné části obrazovky nebo na druhý 
monitor. Pokud ja paleta v plovoucím stavu, mŧţete měnit její velikost stejně jako ostatní okna, coţ 
přináší výhodu moţnosti zobrazení více sloupcŧ obsahu najednou. Opětovným kliknutím na ikonu 
Dock/Undock dojde k automatickému návratu palety knihoven Library do zakotvené pozice  
v základní velikosti na pravé straně pracovního okna Poseru 7. 
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ZPŘÍSTUPNĚNÍ RŮZNÝCH OBSAHOVÝCH KNIHOVEN 
ACCESSING DIFFERENT CONTENT LIBRARIES (orig.38) 

Poser 7 obsahuje dvě základní knihovny: Runtime (obsahuje materiál, který je dodáván s distribucí 
Poseru 7) a Download (základní sloţka pro přidávání materiálu třetích stran). Mŧţete navíc přidávat 
tolik dalších knihoven, kolik si přejete. Tato funkce Vám umoţņuje ukládat materiál Poseru 7 v rŧzných 
sloţkách anebo na rŧzných discích. Kromě toho, pokud byste potřebovali z nějakého dŧvodu Poser 7 
přeinstalovat, mŧţete toto provést bez poškození uţivatelských knihoven. Kterákoliv z knihoven je 
přístupná z palety knihoven Library. 
 

PŘEPÍNÁNÍ KNIHOVEN  SWITCHING LIBRARIES (orig.38) 

Při přepínání knihoven klikněte na aktuální název knihovny, který je umístěný 
podél vrcholu záloţky kategorií palety knihoven Library, vlevo od názvu 
aktuální podkategorie. Následně dojde k otevření rozbalovacího menu 
dostupných knihoven Available Libraries, ze kterého mŧţete přímo vybrat 
jakoukoliv knihovnu. 

Alternativně otevřete kteroukoliv kategorii palety knihoven Library a klikněte 
na ikonu Up One Level. Jakmile dosáhnete vrchní úrovně palety knihoven 
Library, zŧstanou zobrazeny následující základní ikony plus ostatní 
doplņkové knihovny, které máte přidány: 

Pro přepnutí mezi knihovnami, jednoduše klikněte na poţadovanou ikonu v knihovně Library, potom 
klikněte na tlačítko Make current (zátrţítko), nebo poklikejte na poţadovanou ikonu knihovny Library. 
Nad aktivní knihovnou se zobrazí červený bod. V základním nastavení je aktivní knihovna Poser 7 
Runtime. 

Vaše paleta knihoven Library zobrazuje pouze materiál, který se nachází v aktuálně vybrané 
knihovně. Například pokud přidáte figuru do knihovny Downloads, tato figura bude dostupná ve Vaší 
paletě knihoven Library pouze tehdy, pokud je knihovna Downloads aktivní. Samozřejmě ţe mŧţete 
přidávat objekty z jedné knihovny do scény a poté uprostřed práce přepnout jinou knihovnu bez 
nepříznivých účinkŧ na scénu.  
 

PŘIDÁVÁNÍ KNIHOVEN  ADDING LIBRARIES (orig.38) 

Pro přidání knihovny: 

1. Otevřete paletu knihoven Library na záloţce kategorií Categories a klikněte na ikonu Up One 
Level jak je popsáno výše tolikrát, aţ budou zobrazeny ikony knihoven. Pokud je paleta knihoven 
Library v rozšířeném nebo plovoucím stavu, ikony knihoven budou zobrazeny v levé horní části 
palety. 

2. Klikněte na tlačítko Add Runtime (+), nebo vyberte poloţku Add New Runtime z menu Option 
pro otevření standardního dialogového okna Browse for Folder,  umoţņujícího výběr sloţky na 
kterémkoliv lokálním nebo síťovém disku, kterou si přejete pouţít jako novou knihovnu. Kliknutím 
na OK vytvoříte novou knihovnu a přidáte podsloţky pro kaţdou kategorii palety knihoven Library 
(figury, rekvizity, atd.). Následně mŧţete novou sloţku podle přání zaplnit. 

 POZNÁMKA 
POKUD PŘIDÁVÁTE EXISTUJÍCÍ KNIHOVNU POSERU DO VAŠÍ PALETY KNIHOVEN POSERU 
7, MUSÍTE ZACHOVAT NÁZEV A STRUKTŦRU SLOŢKY (<DRIVE>:\<FOLDER>\ 
<SUBFOLDER>\RUNTIME\<FOLDERS>). SMĚRUJTE PROTO BROWSE DIALOG  
K POŢADOVANÉ SLOŢCE S NÁZVEM RUNTIME. PŘIDANÁ KNIHOVNA BUDE POJMENOVÁNA 
PO SLOŢCE, KTERÁ OBSAHUJE SLOŢKU RUNTIME. 

 

ODSTRANĚNÍ KNIHOVEN  REMOVING LIBRARIES (orig.39) 

Pro odstranění knihovny: 

1. Otevřete paletu knihoven Library a klikněte na ikonu Up One Level jak je popsáno výše tolikrát, aţ 
budou zobrazeny ikony knihoven. Pokud je paleta knihoven Library v rozšířeném nebo plovoucím 
stavu, ikony knihoven budou zobrazeny v levé horní části palety. 

2. Vyberte knihovnu, kterou si přejete odstranit. 
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3. 3Klikněte na tlačítko Remove from Library (-) pro odstranění vybrané knihovny z palety knihoven 
Library. Vymazání knihovny pouze přeruší spojení mezi sloţkou knihovny a paletou knihoven 
Library. Nedojde k odstranění ţádné sloţky nebo obsahu z disku. Pokud si přejete kompletně 
vymazat obsah knihovny z disku, musíte to udělat ručně. Tato funkce ochraņuje Vaše data od 
nechtěného vymazání a umoţņuje Vám podle potřeby opětovné pouţití knihovny (například  
z výměnného disku, apod.). 

 POZOR 
BUĎTE EXTRÉMNĚ OPATRNÍ PŘI VYMAZÁVÁMÍ SLOŢEK KNIHOVEN Z VAŠEHO DISKU. 
JEJICH OBSAH BUDE NENÁVRATNĚ ZTRACEN. 

 

VÝBĚR KATEGORIE  CHOOSING A CATEGORY (orig.39) 

Pro výběr kategorie klikněte na tlačítko k otevření vybrané kategorie. Pokud poţadovaná kategorie 
není viditelná, mŧţete: 

o Posouvat se v paletě Library nahoru a dolŧ za pouţití posuvníku 
vpravo. 

o Pokud máte některou kategorii otevřenou, přesuņte ukazatel myši nad 
malá tlačítka nalevo od názvu aktuální kategorie, pro výběr ze seznamu 
dostupných kategorií. 

o Klikněte na název aktuální kategorie pro její uzavření a zobrazení nejvyšší úrovně palety Library. 
Jakmile se poţadovaná kategorie zobrazí, klikněte na ní pro přepnutí. 

o Klikněte na název aktuální subkategorie nebo na dolŧ směřující šipku pro otevření menu Options. 
Vyberte poţadovanou kategorii a subkategorii ze seznamu pro otevření odpovídající sloţky. Viz 
téma “Volby menu” na straně 30 pro informace o menu Options palety Library. 

Kategorie palety knihoven Library jsou dále detailně popsány v části “O kategoriích palety knihoven” 
na straně 31. Prosím navštivte téma “Použití položek z palety knihoven” na straně 36 pro informaci  
o práci s obsahem palety knihoven Library.  
 

VÝBĚR SUBKATEGORIE  CHOOSING A SUBCATEGORY (orig.40) 

Pokud otevřete určitou kategorii v paletě knihoven, objeví se tam seznam subkategorií: 

Přesuņte kurzor na poţadovanou subkategorii a klikněte na ni pro otevření. Otevření vybrané 
subkategorie mŧţe trvat několik sekund v závislosti na mnoţství obsahu uvnitř. Pro návrat do úrovně 
kategorií, klikněte na ikonu Up One Level. Prosím navštivte téma “Použití položek z palety knihoven” 
na straně 36 pro více informací o práci s obsahem palety knihoven Library. 
 

VOLBY MENU  OPTIONS MENU (orig.40) 

Menu Options palety knihoven Library mŧţe být zobrazeno po kliknutí na dolŧ směřující šipku 
napravo od jména aktuální kategorie /subkategorie těsně nad zobrazenou sloţkou palety Library. 
Menu Options obsahuje kompletní seznam kategorií knihovny a všech sloţek subkategorií kaţdé 
kategorie. Výběrem sloţky subkategorie z tohoto menu je moţné otevření této sloţky bez nutnosti 
procházení skrze hierarchii palety knihoven Library. Ve spodní části menu Options mŧţete vidět 
jednu z následujících voleb závisející na tom, co máte aktuálně vybráno v paletě Library: 
 

PŘIDÁNÍ NOVÉ KNIHOVNY RUNTIME  ADD NEW RUNTIME (orig.40) 

Volba pro přidání nové knihovny Add New Runtime je zpřístupněna pokud je paleta kategorií 
knihoven zobrazena na nejvyšší úrovni v hierarchii sloţek knihoven Library. Výběr této volby 
umoţņuje přidání nové knihovny do palety knihoven Library. Pro více informací o přidání nové 
knihovny navštivte prosím téma “Přidávání knihoven” na straně 29. 
 

PŘIDÁNÍ NOVÉ KATEGORIE  ADD NEW CATEGORY (orig.40) 

Volba pro přidání nové kategorie Add New Category je dostupná z jakékoliv sloţky kategorie nebo 
subkategorie uvnitř palety knihoven Library. Tato volba Vám umoţņuje přidání nové sloţky 
subkategorie pro kaţdou existující kategorii knihovny Library. Pro více informací o přidání nové 
subkategorie navštivte prosím téma “Vytvoření nové subkategorie” na straně 33. 
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O KATEGORIÍCH PALETY KNIHOVEN   
ABOUT LIBRARY PALETTE CATEGORIES (orig.41) 

Základní kategorie jsou vytvořeny podle typŧ souborŧ Poseru 7. Prosím navštivte část “Typy souborů 
Poseru 7” na straně 277 pro krátký popis typŧ souborŧ Poseru 7 a jejich správného pouţívání. 
 

FIGURY  FIGURES (orig.41) 

Tato kategorie palety knihoven obsahuje Vaše Poser figury Figures (*.cr2). Pamatujte si, ţe prvky 
oblečení jsou vytvořeny jako figury s vyjímkou dynamického oblečení vytvořeného v místnosti 
oblečení Cloth room, které je vytvořeno jako rekvizita. Tato kategorie nabízi k vyuţití mnoho figur 
zahrnujících rŧzné typy muţŧ a ţen, dětí, kostlivcŧ, figurín, loutek a zviřat. Některé modely jsou 
dostupné ve verzích s vysokým nebo nízkým rozlišením. Pouţívejte modely s vysokým rozlišením pro 
vytvoření realismu scény a modely s nízkým rozlišením (tyto mají velmi malý počet polygonŧ) kdyţ 
záleţí především na výkonu. Novější figury Poseru obsahují plně pohyblivé ruce a nohy s pohyblivými 
prsty. 
 

PÓZY  POSES (orig.41) 

Tato kategorie palety knihoven obsahuje pózy Poses (*.pz2), které mohou být aplikovány na aktuálně 
vybranou figuru. Pro vloţení pózy vyberte figuru a potom aplikujte pózu. Soubory pózy obsahují 
pozice pro kaţdý kloub figury (jako například levý loket ohnutý o  45 stupņŧ). Soubory neobsahují data 
morphingu nebo parametrŧ, myšleno jen ty, které nemohou, například neuchovávají výraz tváře. 
Všechny pózy uloţené v knihovně jsou univerzální pózy Universal Poses, to znamená, ţe mohou být 
aplikovány na jakoukoliv lidskou postavu Poseru 7. Soubory póz uchovávají informace o celé figuře, 
včetně rukou (viz dále pro více informací). 

 POZNÁMKA 
PÓZY, KTERÉ BYLY VYTVOŘENY V POSERU 6 NEBO V PŘEDCHOZÍCH VERZÍCH BYLO 
MOŢNÉ APLIKOVAT POUZE NA KONKRÉTNÍ POSTAVU. NAPŘÍKLAD PÓZA, KTERÁ BYLA 
STVOŘENA PRO POSTAVU JAMESE NEBUDE KOREKTNĚ FUNGOVAT PŘI APLIKACI NA 
POSTAVU KATE Z DŦVODU ODLIŠNÉHO NASTAVENÍ KLOUBŦ TĚCHTO DVOU POSTAV. 
NICMÉNĚ, POKUD APLIKUJETE ODPOVÍDAJÍCÍ PÓZU NA POSTAVU, PRO KTEROU BYLA 
VYTVOŘENA A NÁSLEDNĚ JI ULOŢÍTE DO KNIHOVNY, MŦŢE BÝT KONVERTOVÁNA NA 
UNIVERZÁLNÍ PÓZU VHODNOU PRO POUŢITÍ NA OSTATNÍCH POSTAVÁCH. 

Poser 7 nabízi dvě metody uchování 
materiálových definic celé figury v jednom 
souboru. Obě tyto metody mohou významně 
šetřet čas, protoţe mohou aplikovat barvy  
a mapy na figuru jednoduše pomocí instalace  
z palety knihoven Library místo přidávání jedné 
po druhé. Mŧţete uloţit skupiny některých nebo 
všech materiálŧ figury do palety knihoven 
Library jako kolekce materiálŧ Material 
Collections při pouţití stejného procesu jako při 
uloţení jednoho materiálu. Prosím navštivte 
téma “Přidání položek do knihovny” na straně 33 
pro detaily o zpŧsobu uloţení definic materiálu 
do palety knihoven Library. 

Pokročilí uţivatelé Poseru alternativně vytvářejí Material Poses, nebo ve zkratce MAT soubory. 
Uţivatelé Poseru vymysleli MAT soubory, které jsou pokročilými funkcemi, jeţ nebyly vytvořeny ani 
testovány v e frontier. Pokud potřebujete pomoc s MAT soubory, prosím kontaktujte autora souboru 
(pokud například zakoupíte nebo získáte MAT soubor pomocí místnosti obsahu Content room), nebo 
jeden z mnoha online zdrojŧ, některé z nich jsou vypsány v části “Ostatní fóra“ na straně 13. Soubory 
formátu Material Collection (MC6/MCZ) jsou sestaveny jako plně komplexní náhrada pro soubory 
póz MAT. Poser 7 navíc obsahuje zabudovanou funkci pro kompatibilitu, která umoţņuje měnit 
příponu Vašich MAT souborŧ na MC6 nebo MCZ, Poser 7 je následně identifikuje jako Material 
Collections. Nicméně e frontier podporuje soubory MAT dodávané současně s instalací Poseru 7. 
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 POZNÁMKA 
POKUD APLIKUJETE PÓZU NA POSTAVU, VÝRAZY TVÁŘE NEBUDOU APLIKOVÁNY, I KDYŢ 
JSOU SOUČÁSTÍ SOUBORU PÓZY. TO OCHRAŅUJE VEŠKEROU PRÁCI, KTEROU JSTE 
UČINILI NA POSTAVĚ PŘED APLIKACÍ PÓZY.  PRO APLIKACI VÝRAZU TVÁŘE POUŢIJTE 
KATEGORII VÝRAZY TVÁŘE (EXPRESSIONS) V PALETĚ KNIHOVEN LIBRARY.  

 

VÝRAZY TVÁŘE  EXPRESSIONS (orig.42) 

Tato kategorie palety knihoven Library obsahuje soubory výrazŧ tváře Expression (*.fc2), které 
mohou být aplikovány na aktuálně vybranou figuru. Pro vloţení výrazu tváře vyberte figuru a potom 
aplikujte výraz. Soubory výrazŧ tváře obsahují parametry nastavení aktivních morph targetŧ tváře (viz 
téma “Tvorba a použití morph targetů” na straně 117 pro více informací o morph targetech) pro 
vytvoření výrazu tváře. Tyto soubory provedou totéţ, co mŧţete provést manuálně pomocí nastavení 
kaţdého otočného ovladače tváře dostupného pro aktuální figuru, navíc nastavení hodnot proběhne 
najednou, coţ šetří čas. Výrazy tváře jsou většinou vytvořeny pro konkrétní fuguru, jelikoţ kaţdá 
figura má dostupné odlišné parametry obličeje. Například soubor výrazu tváře, vytvořený pro figuru 
Poser 2 Default Guy, nebude fungovat u figury Poser 6 Male, protoţe tato figura má mnohem více 
dostupných parametrŧ tváře. 
 

VLASY  HAIR (orig.43) 

Tato kategorie palety knihoven Library obsahuje soubory vlasŧ Hair (*.hr2), které mohou být 
aplikovány na aktuálně vybranou figuru. Vlasy vytvořené pro určitou figuru mohou nebo nemusí 
fungovat u jiných figur. Pramínkové vlasy vytvořené v místnosti vlasŧ Hair room nemohou být uloţeny 
do palety knihoven Library, neboť jsou vytvořeny na bázi figury. Prosím navštivte téma “Přidání vlasů” 
na straně 38 pro více informací. 
 

RUCE  HANDS (orig.43) 

Tato kategorie palety Library obsahuje soubory rukou Hands (*.hd2), které mohou být aplikovány na 
vybranou figuru. Soubory rukou jsou podsestavami souborŧ póz, které obsahují informace pouze  
o pozicích rukou a jejich součástí (prstŧ). Pokud aplikujete soubor pózy na figuru a potom aplikujete 
soubor rukou, jen pozice rukou bude změněna. Pokud však aplikujete soubor rukou na figuru  
a následně aplikujete soubor pózy, aplikace pózy nahradí pozice, specifikované souborem rukou. 
 

REKVIZITY  PROPS (orig.43) 

Tato kategorie palety knihoven Library obsahuje rekvizity Props (*.pp2), které jsou volně definovány 
jako statické nebo polohovatelné objekty, které nejsou figurami. Poloţky jako meče, balóny, hole, 
nábytek, zdi, apod., patří do této kategorie. Dynamické oděvy sem patří také. 
 

SVĚTLA  LIGHTS (orig.43) 

Tato kategorie palety knihoven Library obsahuje soubory světel Lights (*.lt2), které obsahují počet, 
barvu, pozici a další světelné atributy. Prosím navštivte kapitolu 9: “Osvětlení” na straně 61 pro popis 
osvětlení Poseru 7. 
 

KAMERY  CAMERAS (orig.43) 

Tato kategorie palety knihoven Library obsahuje soubory kamer Cameras (*.cm2), které obsahují 
všechny kamery Poseru 7, jejich pozice a další atributy. Prosím navštivte kapitolu 8: “Kamery” na 
straně 53 pro více informací o kamerách Poseru 7. 
 

MATERIÁLY  MATERIAL (orig.43) 

Tato kategorie palety knihoven Library obsahuje soubory materiálŧ Materials (*.mt5), které obsahují 
všechny materiály Poseru 7 a ostatní asociované stínované materiály vytvořené nebo uloţené do 
místnosti materiálu Material room. Poser 7 také umoţņuje uloţení některých nebo všech materiálŧ 
pro jednu figuru společně do kolekce materiálŧ Material Collection, nebo uloţení jednoho materiálu 
individuálně. Jednoduše zvolte poloţku Material Collection v dialogu Add to Library, jak je popsáno 
dále a vyberte materiály, které chcete vloţit do kolekce. Jako soubory MAT, kolekce materiálŧ 
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poskytují výhodu sdruţování do skupin materiálŧ v jednom souboru a také přináší další výhodu hladké 
integrace do pracovního postupu v Poseru 7. Prosím navštivte kapitolu 16: “Místnost materiálu” na 
straně 139 pro více informací o místnosti materiálu Material room. 
 

ÚDRŢBA VAŠÍ PALETY KNIHOVEN   
MAINTAINING YOUR LIBRARY PALETTE (orig.44) 

Paletu knihoven Library mŧţete udrţovat pomocí vytváření kategorií a subkategorií pro organizaci 
uloţených poloţek a přidávat nebo odebírat poloţky z palety knihoven Library, jak je popsáno dále. 

Přidání obsahu palety Library tvoří tři základní kroky: 

1. Vyberte kategorii palety Library. 

2. Vyberte/vytvořte subkategorii. 

3. Uloţte poloţku do vybrané kategorie/subkategorie palety Library. 
 

VYTVOŘENÍ NOVÉ SUBKATEGORIE  CREATING A NEW SUBCATEGORY (orig.44) 

Pro vytvoření subkategorie v paletě knihoven Library: 

1. Klikněte na kategorii v paletě Library, ke které chcete vytvořit subkategorii. Například pokud 
chcete vytvořit subkategorii pro pózu, vyberte kategorii póz Pose. 

2. Otevřete rozbalovací menu v horní části palety Library a vyberte poloţku Add New Category na 
konci nabídky. 

3. V následně zobrazeném dialogu zadejte poţadovaný název subkategorie a klikněte na OK. Vaše 
nová subkategorie bude zobrazena ve vybrané kategorii palety knihoven Library. 

 

PŘIDÁNÍ POLOŢEK DO KNIHOVNY  ADDING ITEMS TO THE LIBRARY (orig.44) 

Uloţením poloţky do palety Library přidáte libovolnou poloţku do aktuálně vybrané kategorie/ 
subkategorie. 

Pro přidání poloţky do palety knihoven Library: 

1. Vyberte poţadovanou kategorii/subkategorii. 

2. Klikněte na ikonu Add to Library (+) ve spodní části palety Library. 

3. Dokončete dialog, který následuje (viz následující odstavce pro informace o dialozích 
specifikujících kategorie). 

4. Zadejte název nové poloţky v paletě Library a klikněte na OK. Mŧţete být vyzváni k výběru 
podmnoţiny prvkŧ pro zahrnutí do ukládané poloţky v závislosti na typu ukládané poloţky (pózy, 
výrazu tváře, rekvizity, osvětlení, kamery a kolekce materiálŧ). Prosím prostudujte následující body 
pro informace o výběru prvkŧ. 

5. V závislosti na typu kategorie palety 
Library, do které ukládáte, mŧţete být 
dotázáni, zda si přejete uloţit kanály 
morphingu (jako jsou výrazy tváře, 
zvýrazněné svaly, apod.). Při uloţení 
kanálŧ morphingu budou uchovány 
všechny nastavení, která jste udělali 
pomocí ovladačŧ parametrŧ morph 
targetŧ. Mŧţete být také dotázáni, zda 
si přejete uloţit celopostavové 
transformace Body transformations; 
tato volba uchová všechna nastavení ovladačŧ parametrŧ v paletě “Body”. 

6. Některé kategorie umoţņují uloţení animovaných dat (například animovanou pózu skoku). Pro 
výběr pouze aktuálního snímku zvolte Single Frame. Pro uloţení více neţ jednoho snímku 
animace zvolte Multiple Frames a zadejte čísla poţadovaného počátečního a koncového snímku. 
Pokud přidáváte animovanou pózu, která obsahuje animované vrstvy, bude zpřístupněno tlačítko 
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pro výběr vrstev Select Layers. Kliknutím na toto tlačítko dojde k otevření dialogu pro výběr vrstev 
Select Layers dialog, který umoţņuje specifikaci vrstev, jeţ si 
přejete uloţit současně s pózou. 

7. Klikněte na OK, pokud máte výběr dokončen.   

8. Vaše nová poloţka byla přidána do palety Library a bude 
dostupná kdykoliv při práci v Poseru 7. Poser 7 také ukládá 
obraz aktuální scény pořízený pomocí aktuálně vybrané 
kamery jako náhled (preview). Nastavte proto kameru do 
vhodné pozice ještě před uloţením poloţky do knihovny. 

 POZNÁMKA 
PRO PŘIDÁNÍ DYNAMICKÉHO OBLEČENÍ DO PALETY 
KNIHOVEN, POSTUPUJTE STEJNĚ JAKO U JAKÉKOLIV 
JINÉ REKVIZITY. PRO OBJEKTY PRAMÉNKOVÝCH VLASŦ 
MUSÍTE NEJDŘÍVE ULOŢIT SOUBOR SCÉNY POSERU 
(PZ3) S VAŠÍM OBJEKTEM S VLASY, NEBO ZE KTERÉHO VLASY VYRŦSTAJÍ JAKO 
REKVIZITU A NÁSLEDNĚ TUTO REKVIZITU ULOŢIT DO PALETY KNIHOVEN LIBRARY. 

 

PŘIDÁNÍ PRVKŮ DO ZÁZNAMU V PALETĚ KNIHOVEN 
ADDING ACTORS TO A LIBRARY PALETTE ENTRY (orig.46) 

Pokud se rozhodnete vybrat podskupinu prvkŧ Váší scény pro 
uloţení do palety knihoven Library, zobrazí se dialog Hierarchy 
Selection, umoţņující Vám specifikovat prvky, které si přejete 
vloţit jako nový vstup do palety knihovny Library: 

Seznam prvkŧ je zobrazen hierarchicky, stejně jako v okně 
editoru hierarchie Hierarchy Editor (viz téma “Pouţití editoru 
hierarchie” na straně 178). Uzavřené poloţky mŧţete rozbalit 
kliknutím na znaménko + a rozbalené větve mŧţete uzavřít 
pomocí kliknutí na znaménko –. 

Pro vloţení prvku do nového záznamu v paletě knihoven Library, 
označte políčko nalevo od poţadovaného prvku. Odznačením 
políčka bude prvek vyjmut ze záznamu palety Library. Výjmutím 
prvku, který je mateřským prvkem jednoho nebo více dalších 
prvkŧ dojde k výjmutí také těchto prvkŧ.  
 

PŘIDÁNÍ DYNAMICKÉHO OBLEČENÍ DO PALETY KNIHOVEN 
ADDING DYNAMIC CLOTH TO THE LIBRARY PALETTE (orig.46) 

Přidání dynamického oblečení Dynamic cloth do palety Library je zvláštní případ, který si zaslouţí 
vlastní téma. Pro přidání dynamického oblečení: 

1. Pokud ještě nemáte, tak nahrajte poţadovanou figuru a ujistěte se, ţe máte vypnutou inverzní 
kinematiku Inverse Kinematics (viz téma “Inverzní kinematika (IK)” na straně 69). Dále otevřete 
paletu editoru kloubŧ Joint Editor (viz téma “Editor kloubů” na straně 132) a klikněte na tlačítko 
Zero Figure. 

2. Nahrejte nebo importujte poţadovaný objekt oblečení a postarejte se, aby figuře padnulo bez 
viditelných prŧnikŧ. Pokud importujete statickou rekvizitu, konvertujte ji na dynamickou pomocí 
místnosti Cloth room, jako je to popsáno v Kapitole 19: “Místnost oblečení” na straně 227. 

3. Označte oblečení, otevřete paletu Properties a klikněte na tlačítko Set Parent (nebo zvolte 
Object>Set Parent). 

4. Zobrazí se okno Choose Parent. Vyberte boky figury (Hip), ujistěte se, ţe nemáte označenu 
poloţku Inherit bends of parent. 

5. Otevřete paletu Library, kategorii Props a vyberte poţadovanou subkategorii jak je popsáno výše. 
Uloţte objekt oblečení. 

6. Budete dotázáni na uloţení objektu jako “ţivou” rekvizitu smart prop. Klikněte na Yes. 
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 POZNÁMKA 
POKUD TEXTILNÍ OBJEKT NESOUVISÍ PŘÍMO S FIGUROU (NAPŘÍKLAD UBRUS), 
JEDNODUŠE JEJ ULOŢTE JAKO REKVIZITU. 

 

PŘIDÁNÍ PRAMÉNKOVÝCH VLASŮ DO PALETY KNIHOVEN 
ADDING STRAND-BASED HAIR TO THE LIBRARY PALETTE (orig.47) 

Praménkové vlasy Strand-based hair nemohou být uloţeny do palety Library jako samostatné 
objekty, to znamená, ţe je nemŧţete přidat k figuře stejným zpŧsobem jako vlasy na bázi rekvizity 
Prop-based hair. Jsou tři zpŧsoby pro uloţení praménkových vlasŧ pro další pouţití: 

o Uloţení souboru PZ3 s objektem vlasŧ (později mŧţete objekt sloučit, jak je vysvětleno v části 
“Import dokumentů nebo rekvizit Poseru 7” na straně 187). 

o Uloţení části těla včetně vlasŧ. V tomto případě jednoduše přidáte rekvizitu s vlasy do scény. 
Například mŧţete vytvořit rekvizitu z hlavy osoby s vlasy a tuto rekvizitu uloţit do palety knihoven 
Library. 

o Paleta Library obsahuje “vlasové pokrývky” hlavy Skullcaps vytvořené pro figury Don, Judy, 
James a Jessi. Tyto pokrývky jsou dostupné v kategorii Hair u odpovídajících figur. Pro pouţití 
pokrývky ji přidejte do scény vytvořte a upravte vlasy a následně uloţte pokrývku  
s novým stylem vlasŧ zpět do palety Library pro pouţití na dalších figurách. Vlasové pokrývky 
hlavy přidáte k figuře stejně jako vlasy na bázi rekvizity. Toto je doporučená metoda pro uloţení 
praménkových vlasŧ. 

 POZNÁMKA 
VLASOVÉ POKRÝVKY JSOU TAKÉ UŢITEČNÉ PROTO, ŢE MAJÍ VĚTŠÍ MNOŢSTVÍ 
POLYGONŦ NEŢ NÍŢE UMÍSTĚNÁ HLAVA, COŢ PŘINÁŠÍ DETAILNĚJŠÍ KONTROLU 
VLASOVÝCH POVRCHŦ.  MŦŢETE VYTVÁŘET REKVIZITY Z JAKÉKOLIV FIGURY NEBO 
REKVIZITY,  ROZDĚLIT JE V OBLÍBENÉ 3D APLIKACI A NÁSLEDNĚ APLIKOVAT PODLE 
PŘÁNÍ PRO DOSAŢENÍ DETAILNĚJŠÍCH VÝSLEDKŦ. 

Pro uloţení praménkových vlasŧ do palety Library: 

1. Vyberte skupinu vlasŧ a otevřete kategorii Hair>Strand-Based Hair v paletě knihoven Library. 

2. Klikněte na tlačítko Add to Library. 

3. Budete vyzváni k výběru poţadované podsestavy vlasŧ. 

4. Po kliknutí na tlačítko Select Subset dojde k otevření dialogu pro zadání názvu Set Name  
a k zobrazení hierarchie umoţņující výběr pro uloţení vlasové skupiny. Vţdy uloţte mateřský 
objekt! 

 POZNÁMKA 
PRAMÉNKOVÉ VLASY JSOU V KAŢDÉ SCÉNE VYTVOŘENY NA BÁZI PODOBJEKTU. 

 

PŘIDÁNÍ MATERIÁLŮ DO PALETY KNIHOVEN 
ADDING MATERIALS TO THE LIBRARY PALETTE (orig.47) 

Poser 7 umoţņuje uloţení jakéhokoliv jednoho materiálu nebo skupinové kolekce materiálŧ jedné 
figury do palety Library. Pro uloţení materiálové kolekce do palety Library: 

1. Vyberte poţadovanou kategorii/subkategorii. 

2. Klikněte na ikonu Add to Library (+) na spodu palety Library. 

3. V dialogu New Material Set zvolte poloţku Material Collection a klikněte na tlačítko Select 
Materials. Vyberte materiály, které si přejete vloţit do Vaší kolekce ze seznamu zobrazeného  
v dialogu Select Materials a klikněte na OK. 

4. Zadejte jméno materiálové kolekce a klikněte na OK. 
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PŘIDÁNÍ POLOŢEK DO PALETY KNIHOVEN (MANUÁLNÍ METODA) 
ADDING ITEMS TO THE LIBRARY PALETTE (MANUAL METHOD) (orig.48)  

Mŧţete také přidávat poloţky do palety Library pomocí vytvoření sloţek a podsloţek v hierarchii 
Poseru 7 a následným přidáním poloţek přímo do těchto sloţek. Prosím navštivte Dodatek B: 
“Struktura souborů Poseru 7” na straně 276 pro více informací o struktuře souborŧ Poseru 7. 

 POZNÁMKA 
TOTO JE POKROČILÁ FUNKCE, KTEROU MOHOU POUŢÍVAT POUZE POKROČILÍ 
UŢIVATELÉ POSERU 7, KTEŘÍ JSOU OBEZNÁMENI S VYTVÁŘENÍM UŢIVATELSKÉHO 
OBSAHU. MANUÁNÍ PŘIDÁNÍ POLOŢEK MŦŢE ZPŦSOBIT CHYBNÉ UMÍSTĚNÍ SOUBORŦ, 
KTERÉ MŦŢE VYTVOŘIT NEVIDITELNÉ ANEBO NEPOUŢITELNÉ POLOŢKY. E FRONTIER 
NEPOSKYTUJE TECHNICKOU PODPORU PRO OSOBY, KTERÉ MANUÁLNĚ VYTVÁŘEJÍ 
OBSAH SLOŢEK. POKUD ZÍSKÁTE  MATERIÁL, KTERÝ NEJSTE SCHOPNI UMÍSTIT 
VIDITELNĚ DO KNIHOVNY, NEBO TENTO VYKAZUJE JINÉ CHYBY, KONTAKTUJTE PROSÍM 
AUTORA MATERIÁLU. 

 

PŘIDÁNÍ POLOŢEK DO PALETY KNIHOVEN (POSER 7 DOWNLOAD MANAGER) 
ADDING ITEMS TO THE LIBRARY PALETTE (POSER 7 DOWNLOAD MANAGER) (orig.48) 

Download Manager Poseru 7 mŧţe detekovat a instalovat materiál staţený pomocí místnosti obsahu 
Content room. Prosím navštivte kapitolu 21: “Místnost obsahu” na straně 182 pro více informací  
o místnosti obsahu Content room. 
 

VYMAZÁNÍ POLOŢEK Z PALETY KNIHOVEN 
DELETING ITEMS FROM THE LIBRARY PALETTE (orig.48) 

Pro vymazání poloţky z palety knihoven Library, vyberte tuto kliknutím na obrázek náhledu, potom 
klikněte na ikonu Delete from Library (-) ve spodní části palety (viz obrázek ikon palety Library dále). 

 POZNÁMKA 
VYMAZÁNÍ JE TRVALÉ! BUĎTE UJIŠTĚNI, ŢE OPRAVDU CHCETE VYMAZAT VYBRANOU 
POLOŢKU. POKUD NEMÁTE POLOŢKU JINDE ULOŢENOU (NAPŘÍKLAD V ARCHÍVU 
ZDROJOVÝCH SOUBORŦ), SMAZANÝ OBSAH MŦŢE BÝT TRVALE ZTRACEN. SMAZANÝ 
OBSAH NEJDE OBNOVIT POMOCÍ PŘÍKAZU UNDO. 

 

POUŢITÍ POLOŢEK Z PALETY KNIHOVEN 
USING OBJECTS FROM THE LIBRARY PALETTE (orig.49) 

Ikony palety knihoven Library jsou zobrazeny na obrázku vedle. Některé ikony palety knihoven jsou 
dostupné pouze pro specifické kategorie. Pokud je paleta knihoven v ukotveném stavu, tyto ikony se 
nacházejí ve spodní části palety. Pokud je paleta v rozšířeném nebo plovoucím stavu, tyto ikony se 
nacházejí v horní části palety. 

Zleva doprava se jedná o následující ikony: 

o Změna položky (Change Item): Kliknutím na tlačítko Change Item (jednoduché zátrţítko) dojde  
k přepsání aktuálně vybrané poloţky ze scény (figury, pózy, apod.) označenou poloţkou z palety 
knihoven Library. 

o Přidání nové položky (Add New Item): Kliknutím na tlačítko Add New Item (dvojité zátrţítko) dojde 
k přidání aktuálně označené poloţky z palety Library do pracovního prostoru Poseru 7 bez 
vymazání jakékoliv poloţky ze scény. 

o Přidání do knihovny  (Add to Library): Kliknutím na tlačítko Add to Library (+) dojde k přidání 
vybrané poloţky z pracovního prostoru do palety knihoven Library. 

o Odstranění z knihovny (Remove from Library): Kliknutím na tlačítko Remove from Library (-) 
dojde k vymazání vybrané poloţky z palety Library. 
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UMÍSTĚNÍ / PŘIDÁNÍ POLOŢKY DO PRACOVNÍHO OKNA POSERU 7 
PLACING/ADDING ITEMS TO THE POSER 7 WORKSPACE (orig.49) 

Pro přidání poloţky do pracovního okna Poseru 7 vyberte poţadovanou kategorii a subkategorii palety 
knihoven Library a následně klikněte na ikonu Add New Item (dvojité zátrţítko) na paletě Library. 
Toto funguje ve všech kategoriích palety knihoven Library. 

Pokud chcete nahradit figuru ve Vaší scéně jinou figurou z palety Library:  

1. Vyberte figuru nebo osvětlení, kterým chcete nahradit aktuální prvek (figuru nebo osvětlení) ve 
scéně a klikněte na tlačítko Change Item (jednoduché zátrţítko). 

2. Pokud nahrazujete figuru, mŧţe se zobrazit dialogové okno pro volbu přizpŧsobení geometrie 
figury Keep Modified Geometries. Tento dialog umoţņuje specifikovat zda si přejete aplikovat 
všechny modifikace geometrie, připojené rekvizity nebo připojené deformátory z pŧvodní figury na 
figuru novou. 

3. Jakmile kliknete na tlačítko OK 
v dialogovém okně Keep Modified 
Geometries, zobrazí se dialog Keep 
Scales:  

K zachování proporcí pŧvodní figury 
pro aplikování na figuru novou označte 
políčko Keep current proportions. 
Ponecháním nezatrţeného políčka 
dojde k nahrazení novou figurou včetně 
jejích vlastních proporcí. 

4. Klikněte na tlačítko OK k provedení příkazu anebo volbu zrušte tlačítkem Cancel. 
 

ODSTRANĚNÍ POLOŢKY Z PRACOVNÍHO OKNA POSERU 7 
REMOVING AN ITEM FROM THE POSER 7 WORKSPACE (orig.50) 

Pro odstranění poloţky z pracovního okna Poseru 7 nejprve vyberte poloţku, kterou chcete odstranit, 
například označením v pracovním okně Document nebo pouţitím rozbalovacího menu Current Actor 
(viz téma “Menu výběr figury/aktuálního prvku” na straně 43), následně stiskněte klávesu [DEL]. 
 

PŘÍDÁNÍ PÓZ S ANIMAČNÍMI VRSTVAMI 
ADDING POSES WITH ANIMATION LAYERS 
(orig.50) 

Pokud do scény přidáváte pózy obsahující 
animační vrstvy Animation Layers, zobrazí se 
dialogové okno s dotazem, zda si přejete přidat 
nové vrstvy do scény Add layers to scene, 
nebo sloučit všechny vrstvy pózy do jedné vrstvy 
Merge all layers, kterou mŧţete vybrat pomocí 
rozbalovacího menu.  

Dialog také nabízí volbu, jak naloţit s moţnými 
duplicitními názvy vrstev během přidávání 
nových vrstev do scény (přejmenování nových 
vrstev nebo přepsání vrstev stávajících).  

Pro více informací o animačních vrstvách 
Animation Layers, viz téma “Záložka vrstev” na 
straně 92.  
 

PŘIDÁNÍ OBLEČENÍ  ADDING CLOTHING (orig.50) 

Přizpůsobivé oblečení  CONFORMING CLOTHING (orig.50) 

Nejjednodušším zpŧsobem, jak obléci figuru je pouţití přizpŧsobivého oblečení Conforming clothing. 
Poloţky přizpŧsobivého oblečení byly vytvořeny pro pouţití na konkrétní figuře, proto se při výběru 
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přizpŧsobivého oblečení ujistěte, zda bylo vytvořeno pro figuru, kterou si přejete obléci. Pro přidání 
přizpŧsobivého oblečení do Vaší scény: 

1. Vyberte figuru, kterou si přejete obléct. 

2. Přidejte poţadovanou poloţku oblečení do scény pouţitím palety knihoven Library. 
Oblečení bude zobrazeno v základní pozici. 

3. Vyberte figuru, pro kterou si přejete oblečení přizpŧsobit, pomocí rozbalovacího 
menu Select Figure (popsáno v části “Menu výběr figury/aktuálního prvku” na 
straně 43) a zvolte příkaz Figure>Conform To. Pomocí rozbalovacího menu v 
následně zobrazeném dialogovém okně je moţné vybírat mezi všemi figurami ve 
Vaší scéně. Výběr figury pro přizpŧsobení oblečení je tedy moţný i z tohoto 
zobrazeného dialogu. Klikněte na tlačítko OK jakmile jste hotovi. Oblečení se 
přizpŧsobí figuře: 

 

Dynamické oblečení  DYNAMIC CLOTHING (orig.50) 

Dynamické oblečení Dynamic clothing nabízí velmi silné prostředky pro oblečení figur, dovolující 
vytvoření realistického splývání a vrásnění. Nakonec vytvoření částí oblečení pro pouţití jako 
dynamické oblečení je velmi jednoduché. Dynamické oblečení si udrţuje svoji dynamiku i kdyţ je 
uloţeno do palety knihoven Library, avšak budete muset vytvořit novou simulaci kdykoliv, kdyţ 
uloţené objekty oblečení přidáte do scény. Pro přidání dynamického oblečení na Vaši aktuální figuru: 

1. Vyberte poloţku z palety knihoven Library a vloţte ji do scény, potom přepněte na místnost 
oblečení Cloth room. 

2. Vytvořte novou skupinu pro simulaci (new simulation group), a zvolte Body jako poţadovaný objekt 
ke kolizi. 

3. Přepočítejte simulaci (Recalculate the simulation). 

Prosím navštivte kapitolu 19: “Místnost oblečení” na straně 165 pro detailní informace o místnosti 
oblečení Cloth room a jejich ovladačích. 
 

POUŢITÍ OBLEČENÍ MIMO FIGURU  USING CLOTHING WITHOUT A FIGURE (orig.51) 

Přizpůsobivé oblečení  CONFORMING CLOTHING (orig.51) 

S přizpŧsobivým oblečením se zachází stejně jako s jinými figurami Poseru 7 a stejným zpŧsobem 
mohou být přidávány do pracovního okna Poseru 7, pózovány / animovány. Prosím podívejte se výše 
pro více informací. 

Dynamické oblečení  DYNAMIC CLOTHING (orig.51) 

Dynamické oblečení si udrţuje svoji dynamiku i kdyţ je uloţeno do palety knihoven Library, avšak 
budete muset vytvořit novou simulaci kdykoliv, kdyţ uloţené objekty oblečení přidáte do scény. Pro 
přidání dynamického oblečení mimo figuru: 

1. Vyberte poloţku z palety knihoven Library a vloţte ji do scény, potom přepněte na místnost 
oblečení Cloth room. 

2. Vytvořte novou skupinu pro simulaci (new simulation group), a zvolte poţadovaný objekt(y) ke 
kolizi, pokud se ve scéně nejaké nacházejí. 

3. Přepočítejte simulaci (Recalculate the simulation). 

Prosím navštivte kapitolu 19: “Místnost oblečení” na straně 165 pro detailní informace o místnosti 
oblečení Cloth room a jejich ovladačích. 
 

PŘIDÁNÍ VLASŮ  ADDING HAIR (orig.51) 

Pro přidání vlasŧ na bázi praménkŧ (strand-based) nebo na bázi rekvizity (prop-based): 

1. Vyberte figuru, které chcete vlasy přidat. 

2. Zvolte poţadovaný typ vlasŧ z palety knihoven Library a klikněte na ikonu pro přidání Add. Vlasy 
budou aplikovány na figuru.  
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Moţná budete muset změnit pozici vlasŧ tak, aby precizně dosedly na hlavu figury. K tomu pouţijte 
rozbalovací menu Current Actor pro výběr vlasŧ, potom pouţijte otočný ovladač vlasŧ Trans v paletě 
parametrŧ Parameters. 

 POZNÁMKA 
POKUD VAŠE FIGURA JIŢ MÁ APLIKOVÁNY VLASY NA BÁZI REKVIZITY, PŘIDÁNÍM NOVÝCH 
VLASŦ DOJDE K NAHRAZENÍ TĚCH STARÝCH. 

 

PŘIDÁNÍ REKVIZITY  ADDING PROPS (orig.52) 

Pro přidání rekvizity do Vaší scény vyberte poţadovanou rekvizitu z palety knihoven Library a klikněte 
na tlačítko pro přidání Add. 

Pokud si přejete, aby se rekvizita pohybovala současně s jiným prvkem scény (například dirigentova 
taktovka pohybující se na koncertě společně s rukou figury), musíte specifikovat mateřské vazby 
Parent pro tuto rekvizitu. Prosím navštivte téma “Změna mateřských vazeb” na straně 279 pro pokyny 
k nastavení mateřských vazeb objektu. 
 

KOLEKCE OBSAHU  CONTENT COLLECTIONS (orig.52) 

Záloţka kolekcí Collections palety knihoven Library obsahuje 
uţivatelsky definované kolekce obsahu.  

Kolekce obsahu jsou podmnoţinou Vašich oblíbených poloţek 
z palety kategorií knihovny Library a mohou obsahovat poloţky 
z rŧzných kategorií obsahu, subkategorií nebo dokonce z rŧzných 
Runtime knihoven.  

Kolekce obsahu Vám proto zjednodušují setřídění všech figur, póz, 
rekvizit, materiálŧ, apod. z jedné scény na jedno místo, bez nutnosti 
reorganizace sloţek kategorií aktuální knihovny Library.  

Počet kolekcí, které mŧţete vytvořit není nijak limitován a kaţdá 
kolekce mŧţe obsahovat jakýkoliv počet poloţek.  
 

PŘIDÁNÍ POLOŢEK DO KOLEKCE   
ADDING ITEMS TO A COLLECTION (orig.52) 

Pro přidání nové poloţky do kolekce obsahu: 

1. Vyberte poloţku ze sloţky kategorie / subkategorie uvnitř palety 
knihoven Library. 

2. Klikněte pravým tlačítkem myši (nebo [CTRL]-klikněte 
pokud Vaše myš nemá pravé tlačítko) na vybranou 
poloţku. Toto otevře rozbalovací menu se seznamem 
existujících kolekcí Collections a s volbou pro 
přidání poloţky do nové kolekce New Collection. 

3. Z tohoto rozbalovacího menu vyberte kolekci, do které si přejete Vaši poloţku přidat. Pokud dosud 
ţádná kolekce neexistuje, pouţijte volbu pro vloţení do nové kolekce Add to New Collection. 

4. Pokud vytvoříte novou kolekci, zobrazí se dialog pro zadání názvu nové kolekce. Zadejte vhodný 
název a klikněte na OK. 

5. Poloţka, kterou jste vybrali z palety knihoven Library bude přidána k obsahu Vámi specifikované 
kolekce. Pro zobrazení této kolekce klikněte na záloţku kolekcí Collections v horní části palety 
knihoven Library.  

 POZNÁMKA 
POKUD PŘESUNETE POLOŢKU Z KATEGORIE OBSAHU KNIHOVNY LIBRARY, KTERÁ BYLA 
DŘÍVE VLOŢENA DO KOLEKCE OBSAHU, KDYŢ PŘÍŠTĚ OTEVŘETE TUTO KOLEKCI, 
MŦŢETE BÝT ŢÁDÁNÍ O ZADÁNÍ CESTY K SOUBORŦM PŘESUNUTÉ POLOŢKY. 
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ODSTRANĚNÍ POLOŢEK Z KOLEKCE 
REMOVING ITEMS FROM A COLLECTION (orig.53) 

Pro odstranění poloţky z obsahu kolekce vyberte tuto poloţku kliknutím na obrázek náhledu a potom 
klikněte na ikonu pro vymazání poloţky Delete from Library (-) ve spodní části záloţky kolekcí 
Collections. 

 POZNÁMKA 
POKUD POUŢÍVÁTE ZÁLOŢKU KATEGORIÍ (CATEGORIES), VYMAZÁNÍ POMOCÍ IKONY  
V PALETĚ KNIHOVNY TRVALE ODSTRANÍ VYBRANOU POLOŢKU Z PALETY KNIHOVEN 
LIBRARY; NAOPAK VYMAZÁNÍ POLOŢKY V PALETĚ KOLEKCÍ (COLLECTIONS) OSTRANÍ 
VYBRANOU POLOŢKU Z KOLEKCE, ALE TATO NEBUDE VYMAZÁNA Z PALETY KNIHOVEN 
LIBRARY. 

 

POUŢITÍ POLOŢKY Z KOLEKCE  USING ITEMS FROM A COLLECTION (orig.53) 

Přidání poloţky z obsahu kolekce Collection do scény Poseru 7 funguje stejným zpŧsobem jako 
přidání poloţky z kategorie knihovny Library; jednoduše vyberte poloţku, kterou si přejete přidat do 
scény a klikněte na tlačítko Add New Item (dvojité zátrţítko) ve spodní části palety knihoven Library. 
Prosím navštivte téma “Použití položek z palety knihoven” na straně 36 pro více informací o vloţení 
konkrétní poloţky z palety knihoven Library do Vaší scény. 
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Kapitola 6: Pracovní okno Document  
THE DOCUMENT WINDOW (orig.54) 

Pracovní okno Document je Vašim portálem do pracovního prostoru Poseru 7, ve kterém mŧţete 
prohlíţet a přímo manipulovat se scénou a prvky uvnitř ní. Pracovní okno Document obsahuje dvě 
záloţky: záloţku náhledu scény Preview, ve které provádíte práce při sestavování scény Poseru 7;  
a záloţku Render, ve které mŧţete vidět výsledky Vašich renderŧ. Následující témata pojednávají  
o ovladačích pracovního okna Document a o jejich pouţití: 
 

NÁZEV  TITLE (orig.54) 

Názen Title se zobrazuje podél horního okraje pracovního okna Document a zobrazuje název 
aktuální scény Poseru 7 (jako například My_Scene.pz3). 
 

PŘÍKAZOVÉ MENU  OPTIONS MENU (orig.54) 

Kliknutím na šipku na horní nástrojové liště pracovního okna Document dojde k otevření příkazového 
menu pracovního okna Options menu. Toto menu obsahuje následující nastavení a příkazy: 
 

RENDER  RENDER (orig.54) 

Výběrem poloţky Render z příkazového menu dojde k vyrenderování aktuální scény Poseru 7 při 
pouţití nastavení renderu specifikovaného v dialogovém okně Render Settings a za pouţití 
renderovacího enginu specifokovaného v menu Render Engine Selection v záloţce Render. Pro 
více informací o nastavení renderu Poseru 7 navštivte část 5: “Rendering” na straně 243. Výsledek 
renderu bude zobrazen v záloţce Render pracovního okna Document. 
 

EXPORT OBRAZU  EXPORT IMAGE (orig.54) 

Poloţka Export Image otevře standardní Save As dialog, který umoţņuje uloţení scény, tak jak je 
zobrazena v okně náhledu, v souboru obrazového formátu. Toto mŧţe být také provedeno z hlavního 
menu volbou File>Export>Image. 
 

OPĚTOVNÉ NAČTENÍ TEXTUR  RELOAD TEXTURES (orig.54) 

Kliknutím na poloţku Reload Textures dojde k opětovnému načtení do paměti všech textur v okně 
náhledu scény. Toto umoţņuje jednoduché zobrazení všech změn, které jste provedli s aktuálně 
načtenými texturami scény za souběţného pouţití externích aplikací. 
 

OPĚTOVNÉ POUŢITÍ ROZVRŢENÍ STÍNŮ  REUSE SHADOW MAPS (orig.55) 

Pokud neprovádíte změny osvětlení nebo umístění objektŧ scény, není nutné přepočítávat rozvrţení 
stínŧ Vaší scény, neboť toto se nezměnilo. Poloţka Reuse Shadow Maps umoţņuje uloţení 
rozvrţení stínŧ vypočtené z předchozího renderu scény a jeho opětovné pouţití, coţ šetří čas 
dokončení kaţdého následujícího renderu. 
 

SMAZÁNÍ ROZVRŢENÍ STÍNŮ  CLEAR SHADOW MAPS (orig.55) 

Kliknutí na poloţku Clear Shadow Maps zpŧsobí, ţe Poser 7 bude během následujícího renderu 
scény přepočítávat rozvrţení stínŧ. Tuto volbu pouţijte v případě, ţe jste provedli změny osvětlení 
nebo umístění objektŧ scény, které mělo vliv na stíny Vaší scény. 
 

NASTAVENÍ RENDERU  RENDER SETTINGS (orig.55) 

Volbou poloţky Render Settings dojde k otevření dialogu pro nastavení renderu Render Settings. 
Viz téma “Dialogové okno nastavení renderu” na straně 243 pro více informací o dialogu pro 
nastavení renderu Render Settings. 
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ROZMĚRY RENDERU  RENDER DIMENSIONS (orig.55) 

Volba Render Dimensions přináší dialog pro nastavení rozměrŧ renderu Render Dimensions, který 
umoţņuje specifikovat rozměry plochy renderu. Viz téma “Rozměry renderu” na straně 47 pro více 
informací o nastavení dialogu Render Dimensions. 
 

ROZMĚRY NÁHLEDU  PREVIEW DIMENSIONS (orig.55) 

Volba Preview Dimensions přináší dialog pro nastavení rozměrŧ náhledu Preview Dimensions. Zde 
mŧţete zadat poţadovanou výšku a šířku okna náhledu scény (v pixelech). Kliknutím na tlačítko 
Match Background dojde k upravení pracovního okna Document podle rozměrŧ importovaného 
obrazu pozadí nebo videa pozadí. Kliknutím na tlačítko Match Production Aspect dojde k nastavení 
velikosti okna náhledu scény podle rozměrŧ aktuálně vybraného pracovního snímku Production 
Frame. Toto tlačítko je aktivní pouze v případě, ţe funkce pracovního snímku Production Frame je 
aktivována (viz téma “Pracovní snímek” na straně 205). Odznačením zatrhávacího políčka dojde 
k deaktivaci specifikovaného nastavení. 
 

KOLIZE  COLLISIONS (orig.55) 

Kolize nastane, kdyţ dva objekty scény se částečně nebo kompletně nacházejí na stejném místě ve 
3D prostoru. Volbou poloţky Collisions dojde k otevření rozbalovacího menu, které Vám umoţņuje 
nastavení následujících kolizních předvoleb aktuální scény Poseru 7: 

o Collisions On: Označení předvolby Collisions on zabrání vzájemné kolizi / prolnutí objektŧ Vaší 
scény. 

o Collisions Off: Označení předvolby Collisions off umoţní vzájemnou kolizi / prolnutí objektŧ Vaší 
scény. 

o Show Intersections: Označení předvolby Show intersections označí kolidující polygony červeně, 
pokud některé objekty scény vzájemně kolidují / prolínají se, avšak kolizi nezabrání. 

Jakmile máte nastaveny předvolby kolizí pro Vaši scénu, musíte dále aktivovat detekci kolize pro 
kaţdý objekt scény, pro který chcete tuto funkci pouţít. Toto provedete jednorázovým výběrem 
poţadovaného objektu a označením zatrhávacího políčka Collision Detection v paletě vlastností 
objektu Properties. Tato funkce pracuje pouze mezi objekty, které mají detekci kolizí aktivovánu. 
Pokud je u jednoho objektu detekce aktivována a u druhého deaktivována, detekce vzájemné kolize 
nefunguje. 

 POZNÁMKA 
OBJEKTY ZTRATÍ SVÉ NASTAVENÍ KOLIZÍ, POKUD JSOU SKRYTY (ZNEVIDITELNĚNY). 

 

VELIKOST PRACOVNÍHO OKNA DOCUMENT   
DOCUMENT WINDOW SIZE (orig.56) 

Velikost pracovního okna Document mŧţete měnit dvěmi zpŧsoby: 

o Kliknutím a taţením ovladače velikosti okna Window Size Handle na pravém spodním rohu 
pracovního okna Document do poţadované velikosti. 

o Dvojitým kliknutím na ovladač velikosti okna Window Size Handle dojde k otevření dialogu 
Preview Dimensions. Zadejte poţadovanou výšku a šířku okna náhledu (v pixelech) do 
odpovídajících políček a klikněte na OK pro změnu velikosti pracovního okna Document. 
Kliknutím na tlačítko Match Background dojde k upravení pracovního okna Document podle 
rozměrŧ importovaného obrazu pozadí nebo videa pozadí. Kliknutím na tlačítko Match 
Production Aspect dojde k nastavení velikosti okna náhledu scény podle rozměrŧ aktuálně 
vybraného pracovního snímku Production Frame. Toto tlačítko je aktivní pouze v případě, ţe 
funkce pracovního snímku Production Frame je aktivována (viz téma “Pracovní snímek” na 
straně 205). Odznačením zatrhávacího políčka dojde k deaktivaci specifikovaného nastavení. 

Velikost pracovního okna Document je uloţena stejným zpŧsobem, jak je popsáno dále v části 
“Jednoduché/Vícenásobné okno pohledu”. 
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ZÁLOŢKA NÁHLEDU PREVIEW  PREVIEW TAB (orig.56) 

Kliknutím na záloţku náhledu Preview na levém horním okraji pracovního okna Document dojde 
k zobrazení okna náhledu scény, ve kterém mŧţete manipulovat s figurami, rekvizitami, atd. při 
sestavování scény Poseru 7. Navštivte téma “Záložka Náhled” na straně 246 pro detaily  
o nastavení prvkŧ záloţky náhledu scény Preview. Záloţka náhledu Preview obsahuje následující 
ovladače: 

 
 

OPENGL HARDWAROVÁ AKCELERACE  OPENGL HARDWARE ACCELERATION (orig.57) 

Poser 7 nabízí OpenGL hardwarovou akceleraci renderingu stejně jako moţnost SreeD softwarového 
renderingu zobrazení náhledu scény. Jednoduše klikněte pravým tlačítkem myši do okna náhledu pro 
výběr hardwarového nebo softwarového renderingu při zobrazení náhledu scény. Ve většině případŧ 
bývá hardwarově renderovaný náhled scény rychlejší neţ náhled renderovaný softwarově. Nakonec 
výkon hardwarové akcelerace není závislý na velikosti okna náhledu scény, zatímco softwarový 
rendering bude přinášet niţší obrazovou frekvenci u oken náhledu větších velikostí. Bohuţel kvŧli 
obrovské rozmanitosti dostupného grafického hardwaru, hardwarová akcelerace nemusí být 
podporována všemi systémy. V tomto případě prosím pouţijte moţnost SreeD softwarového 
renderingu. Poser 7 by měl automaticky detekovat zda je OpenGL hardwarový rendering systémem 
podporován a pokud není, měl by nastavit základní předvolbu na SreeD softwarový rendering. 
 

MENU VÝBĚR FIGURY/AKTUÁLNÍHO PRVKU   
SELECT FIGURE/CURRENT ACTOR MENUS (orig.57) 

Levý horní okraj záloţky Preview obsahuje rozbalovací menu Select Figure (vlevo) a Current Actor 
(vpravo). Aktuálně vybraná figura a prvek jsou zde zobrazeny svým názvem a jejich ovladače 
vlastností a parametrŧ jsou dostupné v paletě Parameters & Properties. Dvojitým kliknutím kdekoliv 
v prostoru náhledu scény dojde k otevření palety Parameters & Properties se zobrazeným 
nastavením pro aktuálně vybranou figuru nebo prvek. Figury, rekvizity a další prvky scény mŧţete 
také přímo vybírat kliknutím na ně v prostoru náhledu scény. 
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o Select Figure Menu: Pouţijte rozbalovací menu Select Figure pro výběr poţadované figury. Toto 
mŧţe bý uţitečné, pokud máte ve scéně velké mnoţství figur (zejména pokud pouţíváte 
přizpŧsobivé oblečení, kaţdý jeho prvek je figurou Poseru 7). 

o Current Actor Menu: Rozbalovací menu Current Actor umoţņuje výběr následujících prvkŧ scény: 

o Body Parts: Volbou Current Actor>Body Parts se zobrazí seznam prvkŧ těla aktuálně vybrané 
figury. Pouţitím této poloţky je moţný výběr pouze specifikované části těla aktuálně zvolené 
figury. 

o Body: Volbou Current Actor>Body dojde k výběru celého těla a všech částí těla aktuálně 
zvolené figury. 

o Props: Volbou Current Actor>Props se zobrazí seznam všech rekvizit scény (včetně vlasŧ  
a objektŧ oblečení), který umoţņuje výběr poţadované rekvizity. 

o Cameras: Volbou Current Actor>Cameras se zobrazí seznam všech kamer scény. Z tohoto 
seznamu mŧţete vybrat libovolnou kameru. Prosím navštivte kapitolu 8: “Kamery” na straně 53 
pro více informací o kamerách Poseru 7. 

o Lights: Volbou Current Actor>Lights se zobrazí seznam všech světel scény. Z tohoto 
seznamu mŧţete vybrat libovolné světlo. Prosím navštivte kapitolu 9: “Osvětlení” na straně 61 
pro více informací o osvětlení Poseru 7. 

 

RENDER VYBRANÉ PLOCHY  AREA RENDER (orig.58) 

Funkce Area Render umoţņuje výběr specifikované části scény pro vytvoření renderu, čímţ je 
umoţněn rychlý pohled na výsledky změn provedených v této části scény bez nutnosti pokaţdé 
renderovat scénu celou. Area Renders se zobrazí v záloţce Render přes pŧvodní obraz, takţe 
během renderingu mŧţete vidět vyrenderovavou plochu v konextu s celou scénou. 

Pro pouţití funkce Area Render jednoduše klikněte na symbol Area Render (fotoaparát s rámečkem) 
v horní části záloţky Preview. Symbol se zbarví červeně, coţ indikuje, ţe fukce Area Render byla 
aktivována. Poté klikněte a táhněte uvnitř náhledu scény pro označení části scény, kterou si přejete 
renderovat. Výsledek bude zobrazen v záloţce Render pracovního okna Document, za pouţití 
nastavení renderu specifikovaného v dialogu Render Settings a za pouţití renderovacího enginu 
specifikovaného v menu Render Engine Selection v záloţce Render. Poser 7 bude ukládat 
naposledy renderované obrazy v záloţce Render, umoţņující Vám přepínat zpět a dopředu mezi 
záloţkami Preview a Render beze ztráty renderovaného obrazu. 
 

RENDER  RENDER (orig.59) 

Symbol Render (fotoaparát) v horní části záloţky Preview je zkratkou příkazu Render. Kliknutím na 
tento symbol bude vyrenderována celá scéna Poseru 7 za pouţití nastavení renderu specifikovaného 
v dialogu Render Settings a za pouţití renderovacího enginu specifikovaného v menu Render 
Engine Selection v záloţce Render. Pro více informací o nastavení renderu Poseru 7 navštivte část 
5: “Rendering” na straně 243. Výsledek renderu bude zobrazen v záloţce Render pracovního okna 
Document. 
 

MINI OVLADAČE KAMERY  MINI CAMERA CONTROLS (orig.59) 

Mini ovladače kamery jsou umístěny vpravo nahoře v záloţce Preview. Obsahují podskupinu všech 
dostupných ovladačŧ kamery Camera controls. Zleva doprava to jsou: 

o Rotation trackball: Otočný trackball Rotation trackball umoţņuje náklon a rotaci aktuálně vybrané 
kamery okolo všech tří os. 

o Move XZ: Kliknutím a taţením ovladače Move XZ dojde k posunu aktuálně vybrané kamery podél 
osy X anebo Z. 

o Move XY: Kliknutím a taţením ovladače Move XY dojde k posunu aktuálně vybrané kamery podél 
osy X anebo Y. 

Prosím navštivte kapitolu 8: “Kamery” na straně 53 pro detailní informace o ovladačích kamery 
Camera controls. 
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ZMĚNA KAMER UVNITŘ OKNA  CHANGING CAMERAS WITHIN A PANE (orig.59) 

Název kamery v levém horním rohu okna náhledu scény zobrazuje 
aktuálně vybranou kameru, která přináší pohled na scénu. Mŧţete 
měnit výběr kamery pro kaţdé okno záloţky Preview (v případě 
rozdělení náhledu na více oken najednou). Toto lze provést kliknutím 
na rozbalovací menu Current Actor, nebo kliknutím pravým 
tlačítkem kamkoliv uvnitř poţadovaného okna náhledu pro otevření 
kontextového menu a kliknutím na volbu Camera View: 

Pro změnu kamery klikněte na poţadovanou poloţku. Pohled ve vybraném okně náhledu bude 
přepnut na nově zvolenou kameru.  
 

KONTEXTOVÉ MENU ZÁLOŢKY PREVIEW  PREVIEW TAB CONTEXT MENU (orig.59) 

Kliknutím pravým tlačítkem uvnitř okna náhledu scény dojde k otevření rozbalovacího kontextového 
menu. Toto menu obsahuje následující poloţky: 

o Select: Pouţitím poloţky Select dojde k otevření rozbalovacího menu se seznamem všech prvkŧ, 
které jsou přímo pod aktuální pozicí ukazatele myši postupně podél z osy relativně vŧči obrazovce. 
Toto menu mŧţete pouţít k výběru specifického prvku (případně jednoho jeho segmentu) bez 
nutnosti přerušení pracovního toku kvŧli změně pohledu kamery v pracovním okně Document, 
nebo bez nutnosti výběru prvku z menu Current Actor nebo z palety Parameters/ Properties. 

o Camera View: Poloţka Camera View přináší seznam všech dostupných kamer Vaší scény. 
Kliknutím na libovolnou kameru v seznamu přepnete na pohled této kamery pro aktuální okno 
náhledu. 

o OpenGL/SreeD: Prosím podívejte se výše pro objasnění funkce OpenGL hardvérového renderingu 
versus SreeD softvérovému renderingu. 

o Cartoon Shading: Menu Cartoon Shading nabízi volbu mezi pěti odlišnými styly karikaturního 
tónování pro pouţití uvnitř okna náhledu scény. Tyto styly tónování výslovně ovlivņují zobrazení 
Cartoon Display Style a jsou viditelné pouze tehdy, kdyţ Cartoon je zvolen v Document Style, 
Figure Style nebo Element Style z menu Display. Všiměte si, ţe tyto styly jsou určeny pouze pro 
náhled scény a nebudou kombinovány se styly tónování finálního renderu. 

 

JEDNODUCHÝ/VÍCENÁSOBNÝ POHLED  SINGLE/MULTIPLE-VIEW PANES (orig.60) 

V základu obsahuje záloţka Preview jedno okno, tím je míněno, ţe najednou se mŧţete na scénu 
dívat pomocí jedné kamery. Nicméně mŧţete vloţit aţ čtyři současná okna pohledu (kamery) do 
pracovního okna Document za pouţití osmi přizpŧsobitelných rozvrţení, coţ pomáhá vizualizovat 
Vaši scénu ve všech rozměrech. Pro výběr rozvrţení klikněte na tlačítko Layout menu v pracovním 
okně Document v levém spodním rohu záloţky Preview a zvolte poţadované rozvrţení 
z rozbalovacího menu. Pro přepnutí mezi jedním oknem a v poslední době vybraným vícenásobným 
rozvrţením stiskněte [D]. Stiskněte [F] pro cyklické přepínání mezi všemi dostupnými vícenásobnými 
rozvrţeními. 

Velikost oken mŧţete změnit pomocí kliknutí a taţení jejich okrajŧ. Poser 7 si pamatuje velikosti oken 
a výběr kamer při přepínání rozvrţení během práce na dané scéně a tyto předvolby jsou také 
ukládány během uloţení scény Poseru 7. Pro pouţití stejného rozvrţení při kaţdém spuštění Poseru 7 
zvolte poloţku Previous State z dialogového okna General Preferences, jak je popsáno v části 
“Nastavení předvoleb aplikace” na straně 19. Mŧţete také uloţit aţ devět rozvrţení oken/kamer 
pomocí paměťových tlačítek UI Memory dots (viz “Paměťová tlačítka” na straně 26). 

Kliknutí kdekoliv uvnitř okna aktivuje toto okno. Aktivní okno je orámováno červenými okraji. 
 

MÓD SLEDOVÁNÍ CÍLE  TRACKING MODE (orig.60) 

Mód sledování cíle definuje zpŧsob zobrazení objektu během změny polohy kterékoliv jeho části nebo 
kamery. Rozbalovací menu Tracking Mode ve spodním levém rohu záloţky Preview nabízí tři 
předvolby módu sledování cíle. Shora dolŧ se jedná o: 

o Box: Box Tracking mode zobrazuje prvky scény (figury a rekvizity) jako krabice vţdy, kdyţ se 
zrovna pohybují. Toto je nejrychlejší cesta k náhledu scény a je uţitečná při výrazném blokování 
práce. 
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o Fast: Fast Tracking mode zobrazuje figury a rekvizity v aktuálně vybraném stylu zobrazení pokud 
kamera stojí a jako krabice, kdyţ je kamera v pohybu. Toto umoţņuje přesný pohled na scénu, 
který  mŧţete vidět před a po obrázcích bez nutnosti čekání na kompletní render kaţdého snímku. 
Fast tracking pomáhá šetřit čas při hrubém sestavování scén a při vytváření animací. 

o Full: Full Tracking mode zobrazuje elementy scény v aktuálně vybraném stylu zobrazení 
pracovního okna Document po celý čas, při stojícím prvku i pohybu. Tento mód je pouţitelný pro 
uţivatele s vysoce výkonnými počítači a k provádění jemného doladění dříve hrubě sestavených 
scén. 

 

BLEDNUTÍ A STÍNY  DEPTH CUEING AND SHADOWS (orig.61) 

Dvě tlačítka napravo od menu Tracking Mode podél levého spodního okraje záloţky Preview jsou 
ovladače hloubky prostoru depth cueing a stínŧ shadows, podle 
pořadí: 

o Depth Cueing: Depth Cueing přidává scéně objem pomocí 
viditelnosti prvkŧ v pracovním okně Document. Pokud je Depth 
Cueing aktivována, prvky dále od kamery blednou v závislosti 
na vzdálenosti. Toto umoţņuje rychlou vizuální indikaci hloubky 
Vaší scény, coţ mŧţe být uţitečné pokud pro pohled pouţíváte 
pouze jedno okno pohledu. Pro spuštění nebo vypnutí funkce 
blednutí kliněte na tlačítko Depth Cueing.  

Blednutí závisí na celkové hloubce scény. Například pokud Vaše scéna obsahuje jednu figuru, 
části této figury nejdále od kamery se budou jevit jako vybledlé. Přidání dalšího prvku (například 
rekvizity) dále od kamery neţ uvedená figura zapříčiní, ţe nový prvek se bude jevit vybledle, 
zatímco figura bude více viditelnější. Toto je uţitečné, pokud si přejete kontrolovat velikost blednutí 
ve scéně. 

o Shadows: Poloţky ve scéně mohou vytvářet stíny na podkladní rovině, coţ 
mŧţe pomáhat v orientaci ve 3D prostoru. Vypnutí stínŧ pomŧţe urychlit 
vykreslování scény. Kliknutím na tlačítko Shadows se zapíná a vypíná 
vrhání stínŧ ve Vaší scéně. Tyto stíny však nejsou stíny v tradičním 
významu, protoţe tyto nezávisí na osvětlení scény. Jedná se o obecné 
stíny určené výhradně pro pomoc při vytváření scény. 

o Blednutí Depth cueing a stíny Shadows nemají ţádný vliv na výsledný render.  
 

BARVY  COLORS (orig.62) 

Pohled na Vaši scénu mŧţete vylepšovat pomocí změny barevného vzhledu popředí, pozadí, stínŧ  
a podkladu v pracovních oknech Document v záloţce Preview. Čtyři body umístěné podél pravého 
spodního rohu záloţky Preview umoţņují měnit následující barvy, podle pořadí: 

o Foreground: Kliknutím na tlačítko Foreground (popředí) dojde k otevření vzorníku barev Poseru 7 
a zobrazí se ikona kapátka. Stiskem klávesy [OPT]/[ALT] současně s kliknutím na toto tlačítko se 
zobrazí standardní vzorník barev operačního systému. Umístěte kapátko nad barevný odstín, který 
si přejete vybrat a klikněte. Pokud pouţíváte standardní vzorník barev operačního systému, 
mŧţete barevný odstín zadat také pomocí číselných hodnot. Barva popředí Foreground ovlivņuje 
barvu módŧ zobrazení - siluety Silhouette, obrysu Outline, drátového modelu Wireframe,  
a neviditelných čar Hidden Line (viz kapitola 7: “Ovladače zobrazení” na straně 50). 

o Background: Barvu pozadí Background mŧţete měnit tak, jak je popsáno výše. Tato barva má vliv 
na pozadí pracovního okna Poseru 7. 

 POZNÁMKA 
FINÁLNÍ RENDER TAKÉ ZOBRAZÍ COKOLIV, CO JE NAPOJENO NA BAREVNÝ KANÁL 
ZÁKLADNÍHO UZLU POZADÍ. NICMÉNĚ, POKUD SI PŘEJETE ZOBRAZIT STEJNÝ OBRAZ  
V NÁHLEDU RENDERU, MUSÍTE TO TAKÉ PŘIPOJIT K BG PICTURE NEBO BG MOVIE UZLU. 
PRO VÍCE INFORMACÍ O UZLECH PROSÍM NAVŠTIVTE kapitolu 34: “Uzly místnosti materiálu” 
na straně 307. 

o Shadow: Barvu stínu Shadow mŧţete měnit tak, jak je popsáno výše. Tato barva má vliv na 
zobrazení náhledu stínŧ v záloţce Preview (pokud je jejich zobrazení aktivováno). 



 

Strana 47 (celkem 289) 

o Ground: Barvu podkladu Ground mŧţete měnit tak, jak je popsáno výše. Tato barva má vliv na 
zobrazení podkladní plochy v záloţce Preview (pokud je její zobrazení aktivováno). 

 

ZÁLOŢKA RENDER  RENDER TAB (orig.63) 

Kliknutím na záloţku Render v levé horní části pracovního okna Document dojde k zobrazení 
hlavního okna renderu, ve kterém mŧţete vidět renderované výsledky Vaší scény Poseru 7. Záloţka 
Render obsahuje následující ovladače: 

 
 

ROZMĚRY RENDERU  RENDER DIMENSIONS (orig.63) 

Velikost hlavního renderovacího okna je zobrazena v levém horním rohu záloţky Render. Kliknutím 
na toto zobrazení otevřete dialog Render Dimensions, který obsahuje následující poloţky: 

o Match Preview Window: Kliknutím na tlačítkovou předvolbu Match Preview Window dojde 
k nastavení velikosti výsledného renderu podle velikosti stávajícího okna náhledu renderu. 

o Fit in Preview Window: Alternativně, kliknutím na tlačítkovou předvolbu Fit in Preview Window 
bude výsledný render vytvořen z části okna náhledu renderu, při zachování specifikovaného 
poměru. 

o Render to Exact Resolution: Kliknutím na tlačítkovou předvolbu Render to Exact Resolution bude 
výsledný render vygenerován podle specifického rozlišení stanoveného v následujících políčcích. 

o Width: Śířku okna renderu zadejte v pixelech do políčka Width. Větší rozměry prodluţují čas pro 
vytvoření renderu a vyţadují více diskového prostoru. 

o Height: Výšku okna renderu zadejte v pixelech do políčka Height. Větší rozměry prodluţují čas pro 
vytvoření renderu a vyţadují více diskového prostoru. 

o Resolution: Rozlišení renderu v pixelech na palec (DPI) zadejte do políčka Resolution. 72DPI je 
základní obrazovkové rozlišení obrázkŧ a je vhodné pro obrázky, které zamýšlíte distribuovat 
online. 300DPI je vhodné pro většinu tiskových funkcí a 1200DPI pouţijete, pokud poţadujete 
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extrémní detaily. Vysoké rozlišení obrázkŧ 
vyţaduje více diskového prostoru a prodluţují 
čas pro vytvoření renderu. 

o o Constrain Aspect Ratio: Označením 
zatrhávacího políčka Constrain Aspect 
Ratio nastavíte dodrţování stávajícího 
poměru rozměrŧ renderovacího okna (šířka 
v poměru k výšce). Například, pokud začínáte 
na 640x480 a 640 změníte na 1280, výška se 
automaticky změní na 960. Odznačením 
tohoto zatrhávacího políčka se funkce 
deaktivuje. 

o Match Document Window: Kliknutím na 
tlačítko Match Document Window dojde 
k okamţitému nastavení šířky a výšky 
v políčcích Width a Height podle aktuálních 
rozměrŧ pracovního okna Document. 

Výsledný rámec snímku Production Frame je 
určený výsledným poměrem šířky a výšky. 
Mŧţete nastavit, aby výsledný rámec byl 
zobrazen v prostoru náhledu pracovního okna Document, pomocí volby Display>Production Frame 
z lišty menu.   
 

RYCHLÁ ZMĚNA VELIKOSTI  QUICK-SCALE (orig.64) 

Rozbalovací menu pro rychlou změnu velikosti Quick-Scale se nachází v levé horní části záloţky 
Render. Nabízí přístup ke třem odlišným poměrným rozlišením renderu: Full Size (plná velikost), Half 
Size (poloviční velikost) a Quarter Size (čtvrtinová velikost). Všimněte si, ţe tato funkce není určena  
k tomu, aby nahradila menu Render Dimensions, ale spíše je to nástroj pro usnadnění rychlého 
náhledu renderu, protoţe render s menším rozlišením vyţaduje ke svému výpočtu kratší čas. 
 

VÝBĚR RENDEROVACÍHO NÁSTROJE  RENDER ENGINE SELECTION (orig.64) 

Kliknutím na název aktuálně vybraného renderovacího nástroje v horní části záloţky Render dojde 
k zobrazení rozbalovacího menu Render Engine. Toto menu umoţņuje snadné přepínání mezi 
rŧznými renderovacíi nástroji dodávanými s Poserem 7. Pro úpravu nastavení jakéhokoliv 
renderovacího nástroje otevřete dialog Render Settings kliknutím na Render>Render Settings... 
v liště menu (viz kapitola 35: “Dialogové okno nastavení renderu” na straně 243 pro popis okna). 
 

RENDER VYBRANÉ PLOCHY  AREA RENDER (orig.65) 

Kliknutím na symbol Area Render v pravé horní části záloţky Render se aktivuje funkce renderu 
vybrané plochy Area Render, která umoţņuje výběr konkrétní části scény k jejímu renderu, čímţ 
dochází k úspoře výpočetního času. Area Render pouţívá nastavení renderu specifikovaného  
v dialogu Render Settings a renderovací nástroj specifikovaný v menu Render Engine Selection 
(jak je popsáno výše). Area Render je dostupná jen pro FireFly a Poser 4 renderery. Prosím 
navštivte téma “Render vybrané plochy” na straně 44 pro kompletní popis této funkce. 
 

RENDER  RENDER (orig.65) 

Pro vyrenderování aktuálního obrazu scény klikněte na symbol Render v horní části záloţky Render. 
Výsledek bude zobrazen v prostoru hlavního okna renderu, za pouţití nastavení renderu 
specifikovaného v dialogu Render Settings a renderovacího nástroje specifikovaného v menu 
Render Engine Selection (jak je popsáno výše). 
 

NOVÉ OKNO RENDERU  NEW RENDER WINDOW (orig.65) 

Kliknutím na symbol obrázku se šipkou vedle symbolŧ pro render dojde k odeslání aktuálního obrazu 
z hlavního okna renderu do nově otevřeného okna. Mŧţete vybrat dříve vyrenderovaný obraz nebo 
v hlavním oknně renderu vygenerovat nový a následně vedle sebe porovnat oba obrazy. 
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POSUN OBRAZU  PAN (orig.65) 

Pokud jste vyrenderovali obraz, který je větší neţ renderovací okno, mŧţete obraz v hlavním 
renderovacím okně posouvat pomocí kliknutí a taţení. Tuto moţnost aktivuje symbol Pan (ruka) 
v pravé horní části záloţky Render. Posun obrazu je uţitečný tím, ţe umoţņuje podle potřeby 
zmenšení pracovního okna Document, například při pouţití místnosti materiálu Material room,  
a přitom poskytuje přístup k jakékoliv části renderovaného obrazu. 
 

POROVNÁNÍ RENDERU  RENDER COMPARISON (orig.65) 

Poser 7 nabízí pohodlnou funkci k porovnání renderu, která umoţņuje porovnat rozdíly dvou rŧzných 
renderovaných obrazŧ uvnitř hlavního renderovacího okna. Kliknutím na kteroukoliv ze dvou ikon 
čtvercŧ v levém spodním rohu záloţky Render se zobrazí rozbalovací menu se seznamem 
nejposlednějších renderŧ seřazených podle data a času. Standardně jsou nejposlednější rendery 
nastaveny jako hlavní render Main render a jejich seznam se nachází pod černým čtvercem. Další 
nejposlednější rendery jsou nastaveny jako srovnávací render Compare render a nachází se pod 
bílým čtverečkem. Mŧţete nicméně zvolit jakýkoli render ze seznamu jako hlavní Main a srovnávací 
Compare. Pro porovnání hlavního a srovnávacího renderu pouţijte posuvník Render Wipe ve spodní 
části hlavního renderovacího okna. Posunutím jezdce napravo dojde k zobrazení hlavního Main 
renderu, posunutím nalevo se zobrazí srovnávací Compare render. Základní počet renderŧ 
v seznamu je deset. Jejich počet však mŧţete změnit v dialogovém okně hlavních předvoleb General 
Preferences. (viz “Nastavení předvoleb aplikace” na straně 19 pro více informací o dialogu General 
Preferences.) 
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Kapitola 7: Ovladače zobrazení  THE DISPLAY CONTROLS (orig.67) 

Poser 7 nabízí výběr ze 12 stylŧ zobrazení. Volba rŧzných stylŧ zobrazení mŧţe pomoci s lepší 
vizualizací scény anebo umoţní přidání umělecky zajímavého vzhledu renderovaného výstupu. 
Mŧţete vybírat styly zobrazení scény, figury/rekvizity nebo prvku (části postavy). V základním 
nastavení vypadají ovladače zobrazení Display controls při aktivovaném okně Document 
následovně: 

 

Kliknutím na šipku nalevo od nadpisu dojde k otevření rozbalovacího menu s následující volbou: 

o Document Style: Volba Document Style zpřístupņuje ovladače zobrazení Document Display 
style. Změna této předvolby určí, jak budou všechny prvky scény (figury a rekvizity) zobrazeny. 

o Figure Style: Volba Figure Style zpřístupņuje ovladače zobrazení Figure Display Style, které 
zpŧsobují změnu zobrazení pouze vybrané figury nebo rekvizity podle zvoleného stylu bez vlivu na 
ostaní elementy scény. 

o Element Style: Volba Element Style zpřístupņuje ovladače zobrazení Element Display Style, 
které zpŧsobují změnu zobrazení pouze vybraného prvku (části postavy nebo části rekvizity) podle 
zvoleného stylu bez vlivu na ostaní elementy scény. 

Pro přepínání rŧzných stylŧ zobrazení klikněte na odpovídající tlačítko. Zleva doprava jsou to tyto 
tlačítka: 

o Silhouette: zobrazí figuru/prvek jen jako vystřiţenou z papíru, jak je 
ukázáno vpravo. 

 
o Outline: zobrazí figuru/prvek jen jako skicu. Pokud buď kompletní 

scéna nebo kompletní figura jsou zobrazeny v tomto módu, obrysy se 
objeví kolem kaţdého prvku (části postavy), jak je ukázáno vpravo. 

o Wireframe: zobrazí figuru/prvek jako polygonovou síť. Tento mód 
zobrazuje aktuální polygony zahrnující figuru/prvek včetně polygonŧ, 
které by za normálních okolností byly skryty pohledu (například zadní 
část figury při pohledu zepředu), jak je ukázáno vpravo. 

 

o Hidden Line: zobrazí jen polygony figury/prvku, které jsou viditelné 
aktuální kamerou. Například pokud se díváte na figuru zepředu, 
polygony tvořící záda figury nebudou viditelné, jak je ukázáno vpravo. 

 

  



 

Strana 51 (celkem 289) 

o Lit Wireframe: zobrazí to samé jako styl Wireframe, aţ na to, ţe barva 
polygonŧ odpovídá barvě materiálu povrchu, jak je ukázáno vpravo. 

 

o Flat Shaded: zobrazí figuru/prvek za pouţití barev materiálu povrchu, 
které vyplņují políčka polygonové sítě, jak je ukázáno vpravo. 

 

o Flat Lined: jedná se o stejné zobrazení jako Flat Shaded, doplněné o 
černé linky zvýrazņující polygonovou síť, jak je ukázáno vpravo. 

 

o Cartoon: zobrazí figuru/prvek za pouţití simulovaného stylu ruční 
kresby, jak je ukázáno vpravo. Navštivte téma “Odstíny karikatury” na 
straně 208 províce informací o tomto stylu tónování. Poser 7 nabízí 
zlepšené efekty zobrazení karikatury ve spojení s OpenGL 
hardvérovou akcelerací (viz “OpenGL hardwarová akcelerace” na 
straně 43). 

 

o Cartoon With Line: jedná se o stejné zobrazení jako Cartoon, 
doplněné o černé obrysy figur/prvkŧ, jak je ukázáno vpravo. Navštivte 
téma “Odstíny karikatury” na straně 208 pro více informací. 

 

o Smooth Shaded: zobrazí figuru/prvek s hladkým souvislým povrchem 
s barvami materiálu, jak je ukázáno vpravo. 

 

o Smooth Lined: kombinuje styly zobrazení Flat Lined a Smooth 
Shaded zobrazením černé polygonové sítě přes hladký povrch, jak je 
ukázáno vpravo. 
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o Texture Shaded: zobrazí figuru/prvek za pouţití textur, jak je ukázáno 
vpravo. 

 

Styly zobrazení je moţné měnit také volbou Display>Document Style, Display>Figure Style  
a Display>Element Style. 

Poser 7 v základním nastavení renderuje za pouţití módu Texture Shaded. Pokud renderujete 
s vysokým rozlišením za pouţití aktuálně zvoleného stylu zobrazení anebo při pouţití efektu blednutí, 
atd., mŧţete dosáhnout excelentních výsledkŧ pouţitím tipŧ pro rendering popisovaných v kapitole 40: 
“Tipy & Triky” na straně 266. 
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Kapitola 8: Kamery  CAMERAS (orig.70) 

Tato část popisuje, jak pracují kamery Poseru 7. Ja bylo naznačeno výše, kamery v pracovním 
prostoru Poseru 7 jsou namířeny z rŧzných výhodných postavení. Přepínání kamer umoţņuje pohled 
na scénu aţ ze čtyřech těchto výhodných postavení najednou. 
 

OVLADAČE KAMERY  THE CAMERA CONTROLS (orig.70) 

Ovladače kamery Camera controls 
umoţņují rychlý výběr a umístění 
kamer. Při pouţití ve spojení se 
vhodným rozvrţením pracovního okna 
Document, umoţņují rychlou orientaci 
ve scéně anebo nastavení finálního 
záběru pro stacionární nebo animovaný 
výstup. Pamatujte si, ţe kaţdý pohled, 
který vidíte uvnitř pracovního okna 
Document je vytvořen pomocí jedné 
nebo více kamer. Mŧţete pohybovat 
kamerami v libovolném směru, nicméně 
jejich nastavení mŧţe být dlouho trvající 
proces. Při pouţití více kamer je moţné 
nastavit jejich pozice tak, aby 
umoţņovaly rychlou orientaci ve scéně, 
zatímco vhodné umístění kamer umoţní 
vytvoření uţivatelských stacionárních 
nebo pohyblivých záběrŧ pouţitelných 
kdykoliv při práci na scéně nebo během 
renderu. 

Ovladače kamery Camera controls 
pracovního prostoru Poseru 7 vypadají 
následovně:  

Kromě toho jsou v horní části pracovního okna Document zobrazeny 
miniovladače kamery Mini Camera controls, které umoţņují procházení 
scénou bez nutnosti zobrazení plných ovladačŧ kamery Camera controls 
(například pokud pouţíváte místnost materiálu Material room).  

Miniovladače kamery Mini Camera controls se skládají (zleva doprava) z kulového ovladače 
Trackball, posuvníku podle os X a Y Move XY a posuvníku podle os X a Z Move XZ. Jejich funkce je 
totoţná s protějšky v podobě hlavních ovladačŧ kamery Camera controls a je detailně popsána v této 
kapitole. 
 

KAMERY HLAVNÍ, POMOCNÁ A KAMERA PÓZY   
THE MAIN, AUXILIARY, AND POSING CAMERAS (orig.71)  

Hlavní Main, pomocná Auxiliary kamera a kamera pózy Posing jsou otočné kamery, čímţ se myslí, 
ţe rotují okolo středu pracovního prostoru Poseru 7. V základu jsou figury a rekvizity umístěny do 
středu pracovního prostoru. Pohybem figur/rekvizit se pozice těchto kamer nemění. Pomocná kamera 
Auxiliary camera se nabízí k pouţití jako sekundární kamera, například pokud potřebujete posoudit, 
který ze dvou rŧzných záběrŧ kamer je vhodnější k provedení renderu Vaší scény.  
Kamera pózy Posing camera je podobná kamerám hlavní a pomocné aţ na to, ţe rotuje okolo 
aktuálně vybrané fugury/rekvizity a ne okolo středu pracovního prostoru. Pokud vyberete jinou figuru, 
kamera pózy přesune svŧj střed rotace na tuto figuru/rekvizitu. 
 

KAMERA TVÁŘE  THE FACE CAMERA (orig.71) 

Kamera tváře Face camera přináší blízký pohled na tvář aktuálně vybrané figury, umoţņující precizní 
nastavení výrazu tváře a zobrazení jeho výsledku v detailu. Tato kamera rotuje okolo tváře aktuálně 
vybrané figury a přesouvá se na jinou figuru, kterou následně vyberete. Tato kamera také pracuje 
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s postavami zvířat. Pro zobrazení kamery tváře vyberte poţadovanou figuru a klikněte na ovladač 
Face Camera. 

 POZNÁMKA 
PRO ŘÁDNOU FUNKCI KAMERY TVÁŘE SE UJISTĚTE, ŢE HLAVY VŠECH FIGUR JSOU 
POJMENOVÁNY JAKO “HEAD”. TOTO NENÍ PROBLÉM U FIGUR DODÁVANÝCH S POSEREM 
7, ALE MŦŢE BÝT PROBLÉMEM U JINÉHO MATERIÁLU A UŢIVATELSKÝCH FIGUR, KTERÉ SI 
VYTVÁŘÍTE SAMI. 

 

KAMERY LEVÉ A PRAVÉ RUKY  LEFT AND RIGHT HAND CAMERAS (orig.71) 

Stejně jako u kamery tváře si mŧţete přiblíţit levou nebo pravou ruku aktuálně vybrané figury za 
účelem jemného doladění gest a dalších pozic rukou. Kamery rukou Hand cameras jsou také 
zaměřeny na aktuálně vybranou figuru. Pokud je figurou zvíře, kamery rukou se zaměří na příslušné 
nohy/tlapy/drápy. Pro zobrazení kamery rukou klikněte na odpovídající ikonu Left hand nebo Right 
Hand. 

 POZNÁMKA 
PRO ŘÁDNOU FUNKCI KAMER RUKOU SE UJISTĚTE, ŢE RUCE VŠECH FIGUR JSOU 
POJMENOVÁNY JAKO “LEFT HAND” A “RIGHT HAND”. TOTO NENÍ PROBLÉM U FIGUR 
DODÁVANÝCH S POSEREM 7, ALE MŦŢE BÝT PROBLÉMEM U JINÉHO MATERIÁLU  
A UŢIVATELSKÝCH FIGUR, KTERÉ SI VYTVÁŘÍTE SAMI. 

 

POJÍZDNÁ KAMERA  THE DOLLY CAMERA (orig.72) 

Pojízdná kamery Dolly camera rotuje okolo vlastního centra nezávisle na obsahu scény, mŧţe jí být 
pohybováno okolo i mezi prvky scény. Pokud budete imitovat pohyblivou kameru, pojízdná kamera 
Dolly camera je nejlepší volbou. 
 

ORTOGRAFICKÉ KAMERY  ORTHOGRAPHIC CAMERAS (orig.72) 

Levá Left, pravá Right, horní Top, spodní Bottom, přední Front a zadní Back kamery jsou 
ortografické kamery Orthographic cameras. To znamená, ţe zobrazují ortografické (pravoúhlé) 
projekce. Ortografické projekce utvářejí pohled na objekt jako na plochu (2D) bez perspektivních 3D 
pohledŧ. Ortografické kamery nemohou být otáčeny, protoţe jsou trvale srovnány podle os X, Y  
a Z v pracovním prostoru Poseru 7. Kvŧli tomu vytváří excelentně přesný pohled na Vaši scénu. 
Prosím prostudujte Poser 7 Tutorial Manual, “3D Basics: About 3D Space” pro základní seznámení se 
3D pohledy. 
 

KAMERY STÍNU SVĚTLA  SHADOW LIGHT CAMERAS (orig.72) 

Kaţdé světlo ve Vaší scéně obsahuje jednu kameru stínu světla Shadow Light camera. Kaţdá 
kamera stínu sdílí stejnou XYZ lokaci a zaměření s přiděleným světlem. Poser 7 pouţívá tyto kamery 
pro kalkulaci stínŧ, které vrhají objekty umístěné ve světelném kuţelu. Změnou umístění těchto kamer 
anebo nastavením jejich parametrŧ/vlastností změníte vzhled stínŧ v renderované scéně. Tyto kamery 
mŧřete vybírat pomocí rozbalovacího menu pro výběr prvku Select Actor. Kamery stínu světla 
Shadow cameras mají redukován počet parametrŧ/vlastností (viz “Zpřístupnění vlastností  
a parametrů kamery” na straně 56 pro více informací). 
 

ZMĚNA KAMER  CHANGING CAMERAS (orig.72) 

Pro změnu kamery: 

1. Klikněte na šipku nalevo od nadpisu a pouţijte rozbalovací menu Cameras, jak je popsáno dále. 

2. Klikněte na pojmenování kamery v libovolném pracovním okně Document. 

3. Klikněte na ikonu Face, Left Hand nebo Right Hand v ovladačích kamery (viz výše). 

4. Klikněte na ovladač Select Camera v ovladačích kamery (viz výše). 

5. Zvolte poloţku Display>Camera View za pouţití lišty Menu, potom vyberte poţadovanou kameru 
z rozbalovacího menu Cameras. 
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Dostupné 3D kamery jsou: hlavní Main, pomocná Auxiliary, kamera pózy Posing, tváře Face, levé 
ruky Left Hand, pravé ruky Right Hand a pojízdná kamera Dolly. Dostupné ortografické (2D) kamery 
jsou: Levá Left, pravá Right, horní Top, spodní Bottom, přední Front a zadní Back. Pokud 
renderujete stacionární nebo animovanou scénu, rendering bude proveden pomocí aktuálně vybrané 
kamery. Prosím navštivte část 5: “Rendering” na straně 243 pro více informací o renderingu. Kaţdá 
kamera je popsána dále. 
 

OVLADAČ VÝBĚRU KAMERY  SELECT CAMERA CONTROL (orig.73) 

Kliknutím a taţením kurzoru přes ovladač Select Camera dojde k cyklickému zobrazení dostupných 
kamer se současnou změnou pohledu v aktivním pracovním okně Document podle nově zvolené 
kamery. 

Těsně nad hlavním ovladačem Select Camera se nacházeji tři tlačítka pro rychlý výběr specifických 
kamer. Mŧţete změnit odkaz těchto tlačítek za aktuálně vybranou kameru kliknutím na jedno z nich při 
současném stisku klávesy [OPT]/[ALT]. Odkaz na aktuálně vybranou kameru nahradí pŧvodní odkaz. 
 

ZAPNUTÍ/VYPNUTÍ ANIMACE  ANIMATING ON/OFF (orig.73) 

Kliknutím na ovladač Camera Animation se zapíná a vypíná moţnost animace kamery. Totéţ mŧţete 
udělat pomocí palety vlastností Properties jak je popsáno v části “Paleta vlastností” na straně 75. 
 

POHLED OBLETEM  FLYAROUND VIEW (orig.73) 

Pohled obletem Flyaround view umístí aktuálně vybranou kameru na virtuální trasu v dané výšce  
a vzdálenosti od centra pracovního prostoru Poseru 7 s kruhovou dráhou kolem scény, zobrazující 
všechny elementy uvnitř pohledu. Toto je jedinečný zpŧsob pro rychlé prohlédnutí scény ve 3D 
prostoru. Jakmile je funkce aktivována, pohled obletem je aktivní aţ do jeho vypnutí. Pro zapnutí  
a vypnutí pohledu obletem klikněte na ovladač Flyaround view nebo pouţijte rozbalovací menu 
Cameras. 
 

UMÍSTĚNÍ KAMER  POSITIONING CAMERAS (orig.73) 

Kromě výběru kamer umoţņují ovladače kamer Camera controls nastavení pozice aktuálně vybrané 
kamery za pouţití jednoho nebo více následujících ovladačŧ. Pokud máte aktivních více kamer 
(pracovní okno Document rozdělené na více oken), tyto ovladače budou mít efekt pouze na aktuálně 
vybranou kameru. 
 

OVLADAČE ROVINY KAMERY  CAMERA PLANE CONTROLS (orig.74) 

Ovladače roviny kamery umoţņují pohyb kamery po specifických 3D plochách (osách) a pomáhaji 
přesnému pohybu kamery: 

o Move YZ: Ovladač Move YZ pohybuje kamerou nahoru/dolŧ (osa Y) a dopředu/dozadu ( osa Z). 

o Move XY: Ovladač Move XY pohybuje kamerou ze strany na stranu (osa X) a nahoru/dolŧ (osa Y). 

o Move XZ: Ovladač Move XZ pohybuje kamerou ze strany na stranu (osa X) a dopředu/dozadu  
(osa Z). 

 

ROTAČNÍ KULOVÝ OVLÁDAČ  ROTATION TRACKBALL (orig.74) 

Rotační kulový ovladač Rotation trackball naklání a otáčí aktuálně vybranou kameru okolo tří os. 
Kamery Main, Auxiliary, Posing a Dolly se otáčejí okolo centra pracovního prostoru Poseru 7. 
Posing kamera se otáčí okolo aktuálně vybrané figury. Kamery Face a Hand se otáčejí okolo 
odpovídajících částí postavy vybrané figury. Rotační kulový ovladač Rotation trackball mŧţete také 
pouţít pomocí stisku klávesy [OPT]/[ALT] a táhnutí kurzoru přes pracovní prostor v okně Document. 
 

OVLADAČ MĚŘÍTKA  SCALE CONTROL (orig.74) 

Ovladač měřítka Scale pracuje jako transfokátor. Klikněte na ovladač a táhněte doprava pro přiblíţení 
k bodu zaměření kamery (pracovnímu prostoru, figuře nebo k prvku v závislosti na kameře). Kliknutím 
a taţením doleva se zoom kamery vzdálí. 
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OVLADAČ OHNISKOVÉ VZDÁLENOSTI  FOCAL LENGTH CONTROL (orig.74) 

Ovladač ohniskové vzdálenosti Focal Length zvyšuje a sniţuje ohniskovou vzdálenost vybrané 
kamery. Kliknutím na ovladač a taţením doprava se ohnisková vzdálenost zvyšuje, klinutím a taţením 
doleva se ohnisková vzdálenost sniţuje. Velikost ohniskové vzdálenosti mŧţete také nastavit v paletě 
parametrŧ Parameters. 
 

OVLADAČ HOUPÁNÍ  ROLL CONTROL (orig.74) 

Ovladač houpání Roll Camera naklání pohled na pracovní prostor Poseru 7 doleva a doprava. 
Klikněte na ovladač a táhněte doleva nebo doprava pro naklonění kamery odpovídajícím směrem. 
 

NÁZEV KAMERY  CAMERA NAME (orig.74) 

Kamery mŧţete přejmenovávat podle potřeby. Vyberte kameru, kterou si přejete přejmenovat  
a zadejte její nové jméno v paletě Properties. 
 

VYTVÁŘENÍ KAMER  CREATING CAMERAS (orig.75) 

Novou otočnou nebo pojízdnou kameru mŧţete vyrvořit pomocí menu Object>Create Camera. Viz 
“Vytvoření kamery” na straně 204 pro více informací o vytváření kamer. 
 

ZAPNUTÍ/VYPNUTÍ KAMEROVÉ ANIMACE  ANIMATION ON/OFF (orig.75) 

Kamerová animace umoţņuje snímání pohybu kamery tak, aby tvořila část renderovaného filmu. 
Umoţņuje takové techniky, jako je sledování střely, pohledy prŧletem kamery, apod. Prosím navštivte 
kapitolu 11: “Animace pomocí Poseru 7” na straně 83 pro více informací o tvorbě animací. Pro 
zapnutí/vypnutí kamerové animace oteveřete paletu Properties. Označte políčko Animating pro 
nahrávání pohybu vybrané kamery do klíčových snímkŧ Keyframes Vaší animace, nebo ponechte 
políčko neoznačené pro zakázání této funkce. Při zakázané funkci kamerové animace mŧţete klidně 
kamerou pohybovat, ale její pohyb nebude do klíčových snímkŧ animace zaznamenáván. 

Pokud je kamera animována, pohled na scénu se v prŧběhu času mění, coţ přidává Vaší animaci na 
realizmu a zajímavosti. Sledujte film a všimněte si, jak často se kamera pohybuje. Kamery Poseru 7 
mŧţete animovat stejně jako ostatní 3D objekty pouţitím klíčových snímkŧ keyframes a tween 
frames. Rŧzné kamery jsou animovány rŧzně, v závislosti na odlišných středech pohybu. 

Pro animaci mŧţete pouţít pouze jednu kameru; uprostřed animace nemŧţete kamery přepínat. 
K tomuto účelu vytvořte samostatné klipy, které následně vzájemně propojte za pouţití video 
editačního software jako je Adobe® Premiere®. 
 

ZPŘÍSTUPNĚNÍ VLASTNOSTÍ A PARAMETRŮ KAMERY 
ACCESSING CAMERA PROPERTIES & PARAMETERS (orig.75) 

Pokud si vyberete kameru, její vlastnosti a parametry budou zobrazeny v samostatných paletách 
vlastností Properties a parametrŧ Parameters. Pro přístup k vlastnostem a parametrŧm kamery na 
příslušných paletách tehdy, kdyţ nemáte aktuálně ţádnou kameru vybránu, mŧţete: 

o Kliknout na poţadovaný objekt kamery, pokud je viditelný v pracovním okně Document. 

o Pouţít rozbalovací menu Current Actor. 
 

VLASTNOSTI KAMERY  CAMERA PROPERTIES (orig.75) 

Kamery mají následující vlastnosti, dostupné v paletě Properties: 

o Name: Políčko Name zobrazuje název kamery. Pokud si přejete, zadejte do tohoto políčka jméno 
nové. 

o Visible: Označením zatrhávacího rámečku Visible dojde ke zviditelnění kamery v pracovním okně 
Document a naopak. Neviditelné objekty nejsou zahrnuty do výpočtu renderu a nejsou zobrazeny 
v renderované scéně. Viz “Vlastnosti figur” na straně 75  pro informace o vlastnostech viditelnosti 
během animace. 

o Animating: Označením zatrhávacího rámečku Animating umoţníte, aby byl pohyb kamery uloţen 



 

Strana 57 (celkem 289) 

do Vašich animací. Prosím navštivte téma “Zapnutí/vypnutí animace” na straně 55 pro více 
informací o animaci kamer. 

o Remember changes for Undo: Označením zatrhávacího rámečku Remember changes for Undo 
specifikujete, ţe všechny změny kamery budou ukládány do paměti pro příkaz Undo/Redo. 
Neoznačené políčko znamená, ţe funkce Undo nebude aplikována na změny kamery. 

 

PARAMETRY KAMERY  CAMERA PARAMETERS (orig.76) 

Jako u všech otočných ovladačŧ parametrŧ, kliknutím a taţením ovladače doprava se hodnota 
parametru zvyšuje a taţením doleva se hodnota sniţuje. Mŧţete také kliknout na číselnou hodnotu 
parametru pro otevření textového pole, umoţņujícího přímé zapsání poţadované hodnoty. 
 

OSTATNÍ PARAMETRY  OTHER PARAMETERS (orig.76) 

Sekce Other Parameters obsahuje rŧzné parametry pro ovládání chování vybrané kamery. Tyto 
parametry jsou následující: 

o Focal: Otočný ovladač parametru Focal nastavuje ohniskovou vzdálenost kamery. 

o Perspective: Parametr Perspective posouvá perspektivu aktuální kamery beze změny pozice 
kamery. To navozuje dojem, ţe kamera je dále nebo blíţe od objektŧ Vaší scény. 

o Depth of Field: Rozšíření světelnosti objektivu kamery Vám dovolí dosaţení efektu hloubky záběru 
Depth of Field. Vzdálenější poloţky od ohniskové roviny vypadají více rozmazané. Depth of Field 
mŧţe být individuálně konfigurována pro kaţdou kameru. 

o Focus Distance: Ohnisková vzdálenost Focus Distance je největší vzdálenost, ve které se 
objekty zobrazují zaostřené. V Poseru 7 je ohnisková vzdálenost pro kaţdou kameru určena 
kontrolním objektem umístěným uvnitř scény. Kontrolní objekt mŧţete animovat stejně jako 
jakékoliv další figury Poseru 7 pouţitím klíčových snímkŧ pro specifikaci změn umístění; Poser 
7 doplní pohyb mezi klíčovými snímky za Vás. (Pro více informací o animacích pomocí 
klíčových snímkŧ navštivte prosím kapitolu 11: “Animace pomocí Poseru 7” na straně 83.) 
Zadejte poţadovanou hodnotu do políčka Focus Distance. 

o F-Stop: Hodnota F-Stop reprezentuje světelnost objektivu. Menší číslo zvětšuje světelnost 
objektivu. Kaţdé číslo je přibliţným násobkem hodnoty 1.4, jak stupnice stoupá, byly vytvořeny 
standardní hodnoty 1.0, 1.4, 2, 2.8, 4, 5.6, 8, 11, 16, 22, 32, atd. Kaţdá změna zpŧsobí 
zdvojnásobení nebo poloviční sníţení mnoţství světla přeneseného z objektivu na filmovou 
plochu. V základu je světelnost objektivu kalkulována z ohniskové vzdálenosti objektivu kamery 
dělené prŧměrem svazku světelných paprskŧ procházejících objektivem a štěrbinou clony. 
Zadejte poţadovanou hodnotu do políčka F-Stop. 

Následující obrázky ilustrují efekt hloubky záběru Depth of Field: 

 
Obrázek 1: Bez efektu Depth of Field 

 
Obrázek 2: S efektem Depth of Field 

Poser 7 umoţņuje zapnout nebo vypnout hloubku záběru Depth of Field pro jednotlivé rendery. 
Prosím navštivte téma “Použití renderovacího nástroje FireFly” na straně 249 pro detailní informace 
jak to udělat při pouţití FireFly rendereru. 

 POZNÁMKA 
POKUD JE VÝSLEDEK VAŠEHO NASTAVENÍ DEPTH OF FIELD V ROZMAZANÉ OBLASTI 
MOC ZRNITÝ, ZKUSTE ZVÝŠIT POČET OBRAZOVÝCH BODŦ. TÍMTO LZE DOSÁHNOUT 
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DOBRÝCH VÝSLEDKŦ EFEKTU ROZMAZÁNÍ, DOJDE VŠAK K PRODLOUŢENÍ DOBY 
RENDERU SCÉNY. 

o Shutter Open: Hodnota otevření uzávěrky Shutter Open reprezentuje čas otevření uzávěrky ve 
zlomcích snímku, kde 0.0 je počátek snímku a 1.0 je konec snímku. Oproti uzávěrce reálné kamery 
se tato otevírá a zavírá s nulovým spoţděním. Normální kamerová uzávěrka, i kdyţ je extrémně 
rychlá, vyţaduje krátký časový interval pro přesun mezi pozicemi zavřeno a otevřeno. 

o Shutter Close: Hodnota uzavření uzávěrky Shutter Close reprezentuje čas uzavření uzávěrky ve 
zlomcích snímku, kde 0.0 je počátek snímku a 1.0 je konec snímku. Například nastavením 
počátečního času Shutter Open na 0.0 a koncového času Shutter Close na 0.5 bude uzávěrka 
otevřena během první poloviny snímku. 

 POZNÁMKA 
NASTAVENÍ SHUTTER OPEN A SHUTTER CLOSE PŘINÁŠÍ VIDITELNÉ VÝSLEDKY POUZE 
KDYŢ JE AKTIVOVÁNO ROZMAZÁNÍ POHYBU (3D MOTION BLUR) V DIALOGU NASTAVENÍ 
RENDERU. 

o Hither: Parametr Hither nastavuje vzdálenost objektivu od plochy záběru. Objekty (nebo jejich 
části) blíţe kameře neţ je vzdálenost Hither nebudou v záběru zobrazeny. 

o Yon: Parametr Yon nastavuje vzdálenost viditelného pásma záběru. Objekty (nebo jejich části) 
dále kameře neţ je vzdálenost Yon nebudou v záběru zobrazeny. Parametr Yon je pouţitelný 
pouze s OpenGL hardware renderingem. 

 

PARAMETRY TRANSFORMACE  TRANSFORM PARAMETERS (orig.78) 

Pokud máte kameru vybránu, mŧţete pouţít otočné ovladače v paletě Parameters pro precizní  
nastavení pozice kamery. Kamery Dolly, Posing, Face a Hand mají standardní parametry 3D Pitch, 
Yaw a Roll, zatímco kamery Main a Auxiliary mají parametry xOrbit, yOrbit a zOrbit. Tyto 
parametry jsou měřeny ve stupních. 
 

XYZ Dolly  XYZ DOLLY (orig.78) 

Otočné ovladače parametrŧ Dolly pohybují vybranou kamerou podél odpovídající osy beze změny 
orientace, stejně jako pohyblivá kamera umístěná na pojízdném vozíku, jak je popsáno dále: 

o DollyX: Parametr DollyX pohybuje kamerou do stran. Zvyšováním hodnoty parametru se kamera 
pohybuje doprava. 

o DollyY: Parametr DollyY pohybuje kamerou vertikálně. Zvyšováním hodnoty parametru se kamera 
pohybuje nahoru. 

o DollyZ: Parametr DollyZ pohybuje kamerou dopředu a dozadu. Zvyšováním hodnoty parametru se 
kamera pohybuje dozadu. 

 

XYZ Scale  XYZ SCALE (orig.78) 

Jak je uvedeno výše, parametr Scale funguje jako transfokátor. Ovladač Scale nastavuje zoom 
kamery rovnoměrně ve všech třech osách. Tento otočný ovladač pouţijte tehdy, kdyţ nechcete 
kombinací rŧzných hodnot pro jednotlivé osy vytvořit deformované efekty. Zatímco stejného efektu je 
moţné dosáhnout přímou deformací figury/rekvizity ve scéně, Scale vytváří efekt pouze kamerou  
a prvky ve scéně tak zŧstanou nedotčeny. Sniţováním hodnoty Scale dojde k přiblíţení obrazu podél 
vybrané osy a naopak. 

o xScale: Parametr xScale mění horizontální měřítko (zoom) kamery. 

o yScale: Parametr yScale mění vertikální měřítko (zoom) kamery. 

o zScale: Parametr zScale mění hloubkové měřítko (zoom) kamery. 

o Scale: Parametr Scale mění měřítko (zoom) kamery rovnoměrně podél všech tří os a funguje 
stejným zpŧsobem jako ovladač měřítka Scale v hlavních ovladačích kamery. Pokud jiţ máte 
zvoleny nestejnoměrné hodnoty měřítka u jednolivých os, ovladač Scale zachová dříve nastavený 
poměr jednotlivých měřítek. 
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XYZ Orbit  XYZ ORBIT (orig.79) 

Parametr Orbit nastavuje velikost kruţnice, po které zvolená kamera obíhá v pracovním prostoru 
Poseru 7 kolem zvolené osy. Pro zjednodušení si zvolenou osu si představte jako střed kola 
s kamerou umístěnou na jeho okraji. Kamera si udrţuje svoji vzdálenost od osy a zŧstává zaměřena 
ve stejném směru vztaţenému k počátečnímu bodu. Nastavením kladných stupņŧ parametru Orbit 
obíhá zvolená kamera v směru proti otáčení hodinových ručiček okolo zvolené osy a naopak. 

o xOrbit: Parametr xOrbit nastavuje rotaci vyrané kamery okolo osy X pracovního prostoru Poseru 7 
jako středu rotace. 

o yOrbit: Parametr yOrbit nastavuje rotaci vyrané kamery okolo osy Y pracovního prostoru Poseru 7 
jako středu rotace. 

o zOrbit: Parametr zOrbit nastavuje rotaci vyrané kamery okolo osy Z pracovního prostoru Poseru 7 
jako středu rotace. 

 

Pitch, Roll, Yaw  PITCH, ROLL, YAW (orig.79) 

Tyto paramery otáčejí kamery 
Dolly, Posing, Face a Hand 
okolo jejich vlastních os. Pro 
ilustraci pouţijeme příklad 
s malým letadlem 
s vyznačenými osami X, Y a Z: 

o Pitch: Parametr Pitch otáčí 
vybranou kamerou okolo 
vlastní osy X (nahoru/dolŧ). 
Kladná hodnota parametru 
zvedá kameru nahoru 
(scéna klesá dolŧ)  
a naopak. 

o Roll: Parametr Roll otáčí 
vybranou kamerou okolo 
vlastní osy Z (úklon 
doleva/úklon doprava). 
Kladná hodnota parametru naklání kameru doleva (scéna se naklání doprava) a naopak. 

o Yaw: Parametr Yaw otáčí vybranou kamerou okolo vlastní osy Y (otáčení doleva/otáčení doprava). 
Kladná hodnota parametru otáčí kameru doleva (scéna se otáčí doprava) a naopak.  

 

ZAMĚŘOVÁNÍ & UZAMČENÍ KAMER  POINTING & LOCKING CAMERAS (orig.80) 

Stejně jako u ostatních objektŧ Vaší scény mŧţete pouţít editor hierarchie Hierarchy Editor (viz 
“Editor hierarchie” na straně 129) pro zaměření kamer na určité objekty. 
 

ZAMĚŘENÍ KAMER NA OBJEKTY SCÉNY   
POINTING CAMERAS AT SCENE OBJECTS (orig.80) 

Pro zaměření kamery na vybraný objekt scény: 

1. Vyberte poţadovanou kameru pouţitím rozbalovacího menu Current Actor. 

2. Zvolte Object>Point At pro otevření dialogu pro výběr objektu scény Choose Actor. 

3. Vyberte poţadovaný objekt scény ze seznamu prvkŧ (kamera mŧţe být zaměřena na cokoliv)  
a klikněte na OK. 

Kamera bude zaměřena na vybraný objekt scény a v paletě Parameters této kamery se zobrazí 
otočný ovladač parametru Point At. Nastavením tohoto parametru na hodnotu 1 se kamera zaměří na 
zvolený cíl a nastavením parametru na 0 se zaměřování kompletně deaktivuje. Při nastavení středních 
hodnot od 0 do 1 bude kamera za cílovým objektem zaostávat. Tento parametr umoţņuje při tvorbě 
animace docílení zajímavých efektŧ. 
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ZRUŠENÍ ZAMĚŘENÍ KAMERY  DISABLING CAMERA POINTING (orig.80) 

Pro zrušení zaměření kamery: 

1. Vyberte poţadovanou kameru pouţitím rozbalovacího menu Current Actor. 

2. Zvolte Object>Point At pro otevření dialogu pro výběr objektu scény Choose Actor. 

3. Vyberte None ze seznamu prvkŧ a klikněte na OK. 
 

UZAMČENÍ KAMERY  LOCKING CAMERAS (orig.80) 

Jakmile máte kameru nastavenou podle Vašich představ, mŧţete ji uzamknout z dŧvodu ochrany proti 
jejímu neţádoucímu posunu. Pro uzamčení kamery ji vyberte (jak je popsáno nahoře) a potom zvolte 
Object>Lock Actor. Opětovným zvolením této poloţky je moţné kameru odemknout. 
 

KAMEROVÁ TLAČÍTKA  CAMERA DOTS (orig.81) 

Mŧţete uloţit aţ devět konfigurací kamery za pouţití paměťových tlačítek Memory dots (popsáno  
v části “Paměťová tlačítka” na straně 26). Kaţdé paměťové tlačítko mŧţe obsahovat nastavení všech 
kamer ve scéně. Obsah všech paměťových tlačítek je ukládán společně s aplikací, takţe uloţené 
konfigurace jsou dostupné v kterémkoliv otevřeném dokumentu Poseru 7. Nastavení kamer mŧţete 
také uloţit do palety knihoven Library jak je popsáno výše, coţ Vám umoţní pouţití rŧzných 
nastavení paměťových tlačítek Memory dots. 
 

ULOŢENÍ NASTAVENÍ KAMERY  SAVING CAMERA SETS (orig.81) 

Kategorie Cameras v paletě knihoven Library umoţņuje uloţení nastavení kamery a její zpřístupnění 
pro opakované pouţití za pomoci několika kliknutí myší. Nastavení kamer jsou uloţeny relativně 
vzhledem k pracovnímu prostoru Poseru 7, ne vŧči figurám nebo jiným objektŧm scény. Uloţením 
nastavení kamery dojde k uloţení všech kamer společně; pouze jednu z kamer samostatně uloţit 
nemŧţete. Stejně jako u ostatních kategorií palety knihoven Library mŧţete přidávat ke kategorii 
Cameras subkategorie. Prosím navštivte kapitolu 5: “Knihovny Poseru 7” na straně 28 pro popis 
palety knihoven Library a “Údržba Vaší palety knihoven” na straně 33 pro informace o přidávání 
poloţek do knihoven. 
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Kapitola 9: Osvětlení  LIGHTING (orig.82) 

Světlo přidá barvu Vaší scéně, vytvoří náladu, zvýrazní obrysy svalŧ, vytvoří stíny, atd. Dobré 
osvětlení je klíčovým prvkem správného vzhledu renderované scény. Světla se uplatņují při 
renderingu a během náhledu scény v módech Lit Wireframe a Flat Shaded (navštivte kapitolu 7: 
“Ovladače zobrazení” na straně 50 pro informace o stylech zobrazení scény). Ve scéně mŧţete pouţít 
tolik světel, kolik si jen přejete, přičemţ limitováni budete pouze výkonem Vašeho systému. 

Světla Vám také pomohou vytvořit rŧzné efekty. Například mŧţete k objektu scény přidat reflexní 
mapu, která bude odráţet přímé paprsky světla zpět ke zdroji. Prosím nastudujte Poser 7 Tutorial 
Manual, “Groups” pro vysvětlení skupin materiálu a část 4: “Materiály” na straně 217  této příručky 
pro informace o tvorbě materiálŧ pro elementy Vaší scény. 

Ovladače osvětlení vypadají následovně: 

Kaţdé světlo má přizpŧsobitelné charakteristiky, 
jako jsou rotace a krouţení, barva a intenzita 
(jas). Světla mŧţete zapínat a vypínat, 
nastavovat pokles jasu na okrajích světelného 
kuţele (falloff) a specifikovat, zda světlo bude 
vrhat stíny, nebo ne. Světla mŧţete také 
animovat za účelem vytvoření efektŧ jako je 
blesk nebo blikající uliční lampy. Stejně jako u 
ostatních objektŧ Poseru 7 mŧţete ke světlŧm 
vytvořit vazbu s jinými elementy scény, se 
kterými se budou světla pohybovat. V základu 
scény Poseru 7 obsahují tři nekonečná světla. 

Pokud světla přidáváte, odstraņujete, přesouváte nebo je nastavujete, dojde k automatickému 
současnému přenastavení pozice/vlastnosti světla v pracovním okně Document, ovladačích osvětlení 
a v ovladačích parametrŧ zvoleného světla, umoţņujícího sledování změn v reálném čase.  
 

TYPY OSVĚTLENÍ  LIGHT TYPES (orig.83) 

Poser 7 umoţņuje vytvoření čtyř typŧ světel: nekonečná infinite, všesměrová point, bodová spot  
a zaloţená na obrazu image based. 
 

NEKONEČNÁ SVĚTLA 
INFINITE LIGHTS (orig.83) 

Nekonečná světla jsou přirovnatelná ke svitu slunce nebo 
měsíce na Zemi. Paprsky nekonečného světla jsou během 
jejich prŧchodu pracovním prostorem Poseru 7 paralelní. 
Pokud máte ve scéně více figur nebo rekvizit, nekonečné 
světlo osvětluje kaţdou poloţku rovnoměrně. Ţádný 
z prvkŧ scény nemŧţete umístit z dosahu nekonečného 
světla a ţádná figura/rekvizita nemŧţe být osvětlena 
odlišně od jiné.  

VŠESMĚROVÁ SVĚTLA  POINT LIGHTS (orig.83) 

Všesměrová světla jsou jako ţárovka, která emituje světlo 
z jednoho zdrojového bodu do všech směrŧ v rozsahu 360 
stupņŧ. Tyto světla jsou ideální v případech, kdy poţadujete všesměrový světelný zdroj, který mŧţe 
pŧsobit společně s objekty a vrhat stíny zpŧsoby, které nekonečné světlo nedokáţe. Z dŧvodu 
vysokých výkonnostních poţadavkŧ nejsou pro všesměrová světla dostupné hluboce mapované stíny; 
stíny všesměrových světel musí být kalkulovány pomocí raytracingu. 
 

BODOVÁ SVĚTLA  SPOTLIGHTS (orig.83) 

Bodová světla svítí ve specifickém směru pomocí světelného kuţele vytvářejícího klasický bodový 
efekt. Tyto světla jsou uţitečná pro nasvícení jednotlivých objektŧ nebo pro vytvoření světelných 
efektŧ. Bodová světla mohou prodlouţit dobu renderingu scény. 
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ROZPTÝLENÁ SVĚTLA ZALOŢENÁ NA OBRAZU   
DIFFUSE IMAGE BASED LIGHTS (IBL) (orig.83) 

Rozptýlená světla zaloţená na obrazu (Diffuse IBL) pouţívají světelnou sondu, která zachycuje 
ideálně 360 stupņové světlo za jednoduchou mapou a pomoci této mapy osvětluje scénu. V Poseru 7 
jsou světelnou sondou definovány jen rozptýlené sloţky světla. Jelikoţ tato technika je zaloţena na 
kompletních světelných datech daného prostoru, světelné výsledky jsou velmi realistické. Za účelem 
získání realistických stínŧ při pouţití světel zaloţených na obrazu, doporučujeme pouţití Ambient 
Occlusion (viz “Vlastnosti světla” na straně 65). Pro renderování Ambient Occlusion efektŧ musíte 
v dialogu nastavení renderu Render Settings aktivovat raytracing. 

Pro připojení světelné sondy pro světlo zaloţené na obrazu stiskněte tlačítko Advanced Material 
Properties v paletě vlastností Properties (viz “Vlastnosti světla” na straně 65). V místnosti materiálu 
Material room máte poloţku pro jednoduché připojení obrazové mapy světelné sondy nebo stromové 
struktury stínŧ libovolné komplexnosti do barevného kanálu Diffuse IBL. 

 POZNÁMKA 
POSER 7 MÁ SCHOPNOST APLIKACE SVÉHO PLNĚ FUNKČNÍHO SYSTÉMU STÍNOVÁNÍ DO 
OBRAZOVÉ MAPY POUŢITÉ JAKO SVĚTLO ZALOŢENÉ NA OBRAZU. VIZ část 4: “Materiály” na 
straně 217 PRO VÍCE INFORMACÍ O MANIPULACI S OBRAZOVÝMI UZLY (IMAGE NODE) 
DOSTUPNÝMI SYSTÉMU STÍNOVÁNÍ V MÍSTNOSTI MATERIÁLU MATERIAL ROOM. 

 

VÝBĚR SVĚTLA  SELECTING LIGHTS (orig.84) 

Světla mŧţete vybírat následujícím zpŧsobem: 

o Kliknutím na jedno ze světel na indikátoru pozice světla Light Position. 

o Pouţitím rozbalovacího menu Current Actor. 
 

VYTVOŘENÍ SVĚTLA  CREATING LIGHTS (orig.84) 

Pro vytvoření světla klikněte na okonu Create Light na ovladačích osvětlení Light controls nebo 
klikněte na poloţku Create Light v rozbalovacím menu Light Options. Nové světlo bude zobrazeno 
na indikátoru pozice světla Light Position. V základním nastavení Poser 7 vytvoří bodové světlo 
Spotlight. Pro vytvoření jiného typu světla jednoduše klikněte na ikonu Create Light nebo zvolte 
Object>Create Light a vyberte poţedovaný typ světla z rozbalovacího menu, které se zobrazí. Pro 
změnu typu existujícího světla jej vyberte a následně klikněte na ikonu vlastností osvětlení Light 
Properties (viz dále pro informace o vlastnostech osvětlení). 

Pokud vyberete typ světla zaloţeného na obrazu v záloţce vlastností Properties, budete muset jít 
následně do místnosti materiálu Material room, vybrat toto světlo jako aktuální prvek a aplikovat 
obrazovou mapu k pouţití pro světelnou sondu. V záloţce Simple mŧţete obrazovou mapu 
jednoduše vybrat pomocí manaţeru Texture Manager. V záloţce Advanced mŧţete připojit obrazový 
uzel Image Node nebo kompletní stromovou strukturu barevného kanálu. 
 

NASTAVENÍ INTENZITY OSVĚTLENÍ  ADJUSTING LIGHT INTENSITY (orig.84) 

Intenzitu osvětlení mŧţete nastavit pomocí ovladače Brightness jako stmívače. Klikněte a táhněte 
ovladačem doleva pro ztlumení vybraného světla, nebo doprava pro jeho rozjasnění. Intenzitu 
osvětlení mŧţete také nastavit pomocí otočného ovladače v paletě parametrŧ Parameters. 

U světel zaloţených na obrazu musíte intenzitu osvětlení nastavovat v záloţce Advanced v místnosti 
materiálu Material room. Buďte opatrní při tomto nastavování, protoţe výsledný realismus bude 
záviset na kvalitě osvětlení vybrané obrazové mapy. 

 POZNÁMKA 
INTENZITU OSVĚTLENÍ MŦŢETE NASTAVIT I DO NEGATIVNÍCH HODNOT, ČÍMŢ VYTVOŘÍTE 
“TEMNOTU” KTERÁ AKTUÁLNĚ ZTMAVÍ ZASAŢENOU PLOCHU(Y) VAŠÍ SCÉNY. TUTO 
FUNKCI MŦŢETE POUŢÍT PRO VYTVOŘENÍ ZAJÍMAVÝCH EFEKTŦ. 
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BARVA SVĚTLA  LIGHT COLOR (orig.85) 

Barvy osvětlení přispívají k celkovému vzhledu a náladě scény. Stejně jako u malby, barvy světel se 
násobí místo jejich míchání a přidávání jedné do druhé. Například červená figura bude pod modrým 
osvětlením vypadat černá, ne však purpurová. Pokud si nepřejete, aby osvětlení měnílo barvu prvkŧ 
scény, nastavte barvu světel na bílou nebo šedou. Protoţe existuje tento vzájemný vztah mezi 
poloţkami scény a světly, měli byste barvy poloţek scény nastavit ještě před nastavením barev 
osvětlení. Všimněte si, ţe u světla zaloţeného na obrazu musíte zpravidla pouţít bílou barvu, aby 
nedošlo ke střetu s barvami světel jiţ obsaţených uvnitř obrazové mapy. 

Pro změnu barvy světla klikněte na ikonu Color v ovladačích Light controls pro otevření 
standardního dialogu Color Picker. Vyberte barevný odstín a barva zvoleného světla bude zaměněna 
za barvu novou. Barvu světla mŧţete také nastavit pomocí otočných ovladačŧ v paletě parametrŧ 
Parameters. U světel zaloţených na obrazu mŧţete pouţít záloţku Advanced v místnosti materiálu 
Material room pro připojení obrazového uzlu Image Node do barevného kanálu tohoto světla. Toto 
Vám umoţní shlédnout efekty světel zaloţených na obrazu na libovolném povrchu v místnosti 
materiálu Material room, jeţ Vám poskytnou přesnou představu jak budou tyto povrchy vykresleny ve 
finálním renderu. 
 

VYMAZÁNÍ SVĚTLA  DELETE LIGHT (orig.85) 

Vyberte světlo, které si přejete vymazat a klikněte na ikonu Delete Light v ovladačích Light controls, 
nebo klikněte na volbu Delete Light v rozbalovacím menu Light Options. 
 

ZAMĚŘENÍ SVĚTLA  AIMING LIGHTS (orig.85) 

Bodová a nekonečná světla jsou světelnými směrovými zdroji a proto mohou být ve scéně 
zaměřovány. Před zaměřováním světel byste měli dokončit nastavení póz figur a umístění rekvizit. 
Pokud to uděláte naopak, dojde při posunu elementŧ scény k změně jejich vzhledu. Například při 
otočení figury o 180 stupņŧ se osvětlení přesune z přední části figury na její zádní část. Pro 
pokračování práce tak budete muset světla nově zaměřit. Někteří tradiční umělci umísťují jasné světlo 
dopředu a nalevo od figury. Pouţitím jednoho silného světelného zdroje docílíte vytvoření stínŧ na 
vzdálených površích, vytvářejících hloubku scény. Mŧţete si přečíst knihy o osvětlení a pouţití světel 
ve fotografických studiích, pro vytvoření představy o pouţití světel k obohacení scén Poseru 7. 

Pokud importujete obrázek pozadí scény nebo videoklip, měli byste světla nastavit tak, aby imitovaly 
osvětlení přicházející z pozadí. Pokud například obraz pozadí zobrazuje silný světelný zdroj napravo 
od figury, neosvětlujte figuru zleva. Toto Vám pomŧţe uchovat konzistenci mezi scénou a pozadím  
a pomŧţe sjednotit oba elementy dohromady. V ideálním případě, pokud pracujete s pozadím, mělo 
by mít obdobný vzhled jako ostatní prvky scény. Pokud je Vaší scénou například pokoj, pouţijte jasně 
osvícenný obrázek pozadí viditelný skrz okna. Většinu světelných paprskŧ byste měli směrovat skrz 
okna k prolnutí pokoje a jeho obsahu s okolním světem, vytvářejícímu realismus scény. 

Zaměření světel mŧţete učinit následujícími zpŧsoby: 

o Pouţitím ovladačepozice světel Light Position (viz dále). 

o Přesunutím indikátoru světla v pracovním okně Document (viz dále). 

o Pouţitím editačních nástrojŧ Editing tools (Rotate a Twist pro nekonečná světla a Rotate, Twist, 
Translate/Pull a Translate In/Out pro světla bodová. Prosím navštivte téma “Editační nástroje” na 
straně 71 pro informace o pouţití editačních nástrojŧ Editing tools). 

o Pouţitím otočných ovladačŧ parametrŧ zvoleného světla v paletě parametrŧ Parameters. 

o Pouţitím menu a příkazŧ Object>Point At (viz “Zaměřit na” na straně 202) nebo Object>Set 
Parent (viz “Změna mateřských vazeb” na straně 201). 

o Pouţitím odpovídající kamery stínu světla Shadow Light Camera, jak je popsáno v části “Kamery 
stínu světla” na straně 54. 

Jak je uvedeno výše, nekonečná světla svítí vţdy skrz scénu. Zaměření nekonečného světla spočívá 
v nastavení směru, ze kterého světlo svítí (například jako nastavení pozice slunce na obloze). Pokud 
zaměřujete světlo bodové, musíte nastavit oba úhly, pod kterými světlo svítí a pozici světla ve 3D 
prostoru. 
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POUŢITÍ OVLADAČE POZICE SVĚTEL   
USING THE LIGHT POSITION CONTROL (orig.86) 

Koule uprostřed indikátoru pozice světel Light Position reprezentuje Vaši Poser 7 scénu ve 3D 
prostoru a světelné body reprezentují pozice kaţdého světla uvnitř scény.Tyto body mohou být 
posouvány dvěmi zpŧsoby vzhledem k prostoru: rotací Rotation a oběhem Revolution. Rotace 
ponechává světlo ve stejné fyzické pozici vzhledem ke scéně, ale mění směr paprskŧ okolo vlastních 
os. Oběh přesouvá světlo okolo 3D prostoru scény do nové pozice vzhledem ke scéně, přičemţ 
zŧstává zachováno zaměření světla na přiřazeného pŧvodce (parent), jak je znázorněno na figuře 
dále. Metodu nastavení, kterou si přejete pouţít (Rotate nebo Revolve), mŧţete vybrat pomocí 
rozbalovacího menu přdvoleb osvětlení Light Options. Zátrţítko indikuje, která metoda je aktuálně 
vybrána. Potom klikněte a táhněte vybraným bodem světla pro změnu jeho pozice nebo směru. 
Otáčením těchto bodŧ na rŧzná místa okolo koule znázorņující 3D prostor scény dojde k přenastavení 
úhlu osvětlení, jak je znázorněno dále: 

 

 POZNÁMKA 
KLIKNUTÍM KAMKOLIV NA OVLADAČ POZICE SVĚTEL DOJDE K VÝBĚRU NEJBLIŢŠÍHO 
SVĚTLA. 

 

POUŢITÍ INDIKÁTORU SVĚTLA  USING LIGHT INDICATORS (orig.87) 

Pokud máte vybráno světlo, Poser 7 zobrazí v pracovním okně Document indikátor světla, zobrazující 
pozici zvoleného světla. V některých případech Vám pohled na indikátor pod rŧznými úhly pomŧţe 
vizualizovat pozici světla ve scéně. Mŧţete přepínat pohledy kamer nebo přibliţovat pohled 
k prozkoumání indikátoru světla z rŧzných úhlŧ. Nakonec mŧţete nastavovat pozice světel pomocí 
kliknutí a taţením indikátorem světla uvnitř aktuální scény. Ovladače světel Light controls akceptují 
jakékoliv změny, které učiníte pomocí přemístění indikátoru světla. Všimněte si, ţe světla zaloţená na 
obrazu nemají indikátory světla, protoţe tato světla obklopují celou scénu. 
 

INDIKÁTOR NEKONEČNÉHO SVĚTLA  INFINITE LIGHT INDICATORS (orig.87) 

Indikátor nekonečného světla vypadá jako kruh obklopující 
aktuálně vybranou figuru/rekvizitu. Tento kruh tvoří rovníkovou 
čáru neviditelné koule, u které světlo svítí dolŧ na scénu 
z daného bodu na rovníku, indikovaného šipkami, jak je 
zobrazeno zde: 

Při pohledu ze šikmého úhlu vypadá kruh jako elipsa, šipky 
pomáhají zobrazit, zda světlo přichází zepředu figury, nebo 
zezadu. Světlo se aktuálně nenachází na okraji indikátoru. 
Indikátor jednoduše reprezentuje větší kouli, zahrnující veškerý pracovní 
prostor Poseru 7. Pro změnu pozice zvoleného světla mŧţete kliknout a 
táhnout jeho indikátorem.  
 

INDIKÁTOR VŠESMĚROVÉHO SVĚTLA   
POINT LIGHT INDICATORS (orig.88) 

Indikátor všesměrového světla vypadá jako malý krouţek, zobrazující 
pozici světla ve 3D prostoru (zapamatujte si, ţe pozici světla mŧţete 
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stanovovat u všesměrových a bodových světel, ne však u světel nekonečných), jak je zobrazeno níţe. 
Jelikoţ všesměrové světlo emituje paprsky do všech stran, není u indikátoru označen ţádný symbol 
směru. 
 

INDIKÁTOR BODOVÉHO SVĚTLA 
SPOTLIGHT INDICATORS (orig.88) 

Indikátor bodového světla vypadá jako obrys reflektoru, zobrazujicího 
pozici světla a jeho směr ve 3D prostoru Poseru 7, jak ukazuje tento 
obrázek. Kliknutím a taţením indikátoru bodového světla lze světelný 
zdroj přesouvat scénou.  

 POZNÁMKA 
MŦŢETE K POSUNU INDIKÁTORU BODOVÉHO SVĚTLA 
POUŢÍT ORTOGRAFICKÉ POHLEDY (LEVÝ, PRAVÝ, HORNÍ, 
SPODNÍ, PŘEDNÍ NEBO ZADNÍ), PROTOŢE TOTO UMOŢŅUJE 
POHYBOVAT BODOVÝM SVĚTLEM JEDNOZNAČNĚ DO DVOU SMĚRŦ (YZ POKUD 
POUŢIJETE LEVÝ NEBO PRAVÝ POHLED, XZ POKUD POUŢIJETE HORNÍ NEBO SPODNÍ 
POHLED A XY POKUD POUŢIJETE PŘEDNÍ NEBO ZADNÍ POHLED). PŘI POUŢITÍ 
PERSPEKTIVNÍHO POHLEDU MŦŢETE POHYBOVAT BODOVÝM SVĚTLEM LIBOVOLNÝM 
SMĚREM, COŢ VŠAK ZPŦSOBUJE NEPŘEDVÍDATELNÉ SVĚTELNÉ EFEKTY. 

 

VLASTNOSTI SVĚTLA  LIGHT PROPERTIES (orig.89) 

Vlastnosti světla Vám umoţņují jemné doladění světelných efektŧ. Pro přístup k nastavení světelných 
vlastností vyberte poţadované světlo a následně klikněte na ikonu Light Properties v ovladačích 
osvětlení Light controls, nebo zvolte z menu poloţku Object>Properties. Přístup k vlastnostem 
světla je moţný také přímo přes paletu vlastností Properties. V závislosti na vybraném typu světla 
mŧţete ovládat některé z následujících vlastností: 

o Visible: Označením políčka Visible bude 
zvolené světlo zviditelněno v pracovním okně 
Document  a naopak. Neviditelné objekty 
nebudou zahrnuty do výpočtu renderu, 
nebudou tedy zobrazeny v renderované scéně. 
Viz téma “Vlastnosti figur” na straně 75 pro 
informace o animaci za pouţití vlastnosti 
Visible. 

o Animating: Označením políčka Animating 
umoţníte pouţití animace světla stejným 
zpŧsobem jako u jiných objektŧ scény Poseru 
7. Animovaná světla mohou mít také odlišná 
nastavení pro rŧzné klíčové snímky 
(keyframes). Napřiklad si vytvoříte červené 
bodové světlo z levé strany figury, které se 
bude následně pohybovat nad hlavou figury, 
přičemţ jeho barva se přitom změní do modra. 
Pokud budete renderovat tuto animaci, spatříte, 
ţe barva figury se mění a stíny se pohybují 
společně se světlem. Světla, která jsou vypnuta 
nemŧţete animovat (viz výše). 

o On/Off: Označením políčka On se světlo 
zapíná, obdobně jako u reálného vypínače. 
Ponecháním neoznačeného políčka bude 
světlo vypnuto. K vypnutí a zapnutí světla 
mŧţete také pouţít klávesovou zkratku, pokud 
stisknete [OPT]/[ALT] a současně kliknete na 
bod označující světlo v ovladači osvětlení Light 
controls. 
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o Spot/Infinite/Point/Diffuse Image (IBL): Zaškrtněte odpovídající tlačítko předvolby (Spot, Infinite, 
Point nebo Diffuse Image (IBL)) pro výběr poţadovaného typu světla. Jednotlivé typy světel byly 
popsány výše. 

o Shadows: Označením políčka Shadows bude umoţněn výběr jedné ze dvou následujících funkcí:  

o Ray Trace Shadows: Volbou Ray Trace Shadows se aktivuje raytracing stínŧ. Tradičním 
výsledkem raytracingu jsou čisté stíny s ostrými okraji. Nicméně Poser 7 nabízí metodu pro 
zjemnění okrajŧ stínŧ, coţ přidává na realismu raytracingovaných stínŧ. Tento efekt mŧţete 
ovládat pomocí otočného ovladače Shadow Blur Radius (viz dále). 

o Depth Map Shadows: Volbou Depth Map Shadows se aktivuje pouţití hlubokých stínŧ. Pokud 
pouţíváte rozlehlé prostory, doporučujeme volit raději tuto metodu stínování neţ raytracing, pro její 
větší přesnost. Výběr této metody aktivuje následující otočné ovladače: 

o Shadow Blur Radius: Všechna stíny mají okolo okrajŧ rozmazanou oblast. Parametr Shadow 
Blur Radius specifikuje dosah této rozmazané oblasti. V základu je tento ovladač nastaven na 
nízkou hodnotu. Zvedáním hodnoty dosahu rozmazání se zvyšuje efekt měkkých okrajŧ stínu.  

o Shadow Min Bias: Parametr Shadow Min Bias specifikuje, jak daleko od nasvíceného objektu 
bude začátek stínu, coţ v případě posunutí počátku stínu umoţņuje zamezit zastínění objektu 
některou z jeho částí. 

o Ambient Occlusion: Označením políčka Ambient Occlusion se u vybraného světla aktivuje funkce 
Ambient Occlusion (pohlcování světla uzavřeným povrchem prvkŧ). Tato poloţka přináší výhodu 
kalkulace efektu Ambient Occlusion na všech površích uvnitř scény bez nutnosti připojení uzlŧ 
Ambient Occlusion pro kaţdý materiál zvlášť. Zvolením této poloţky se aktivují následující 
ovladače: 

o Strength: Otočný ovladač Strength specifikuje stupeņ, jakým bude efekt Ambient Occlusion 
ztmavovat uzavřené povrchy uvniř scény. 

o Scene Options: Tlačítko Scene Ambient 
Occlusion Options zpřístupņuje globální 
nastavení parametrŧ Ambient Occlusion. 
Tyto parametry jsou popsány v sekci 
Ambient Occlusion  části “Uzly raytracingu” 
na straně 230. 

o Atmosphere Strength: Otočný ovladač 
Atmosphere Strength umoţņuje specifikovat 
sílu atmosférického (objemového) efektu. Tento 
atribut je pouţit ve spojení s Root Atmosphere 
uzly, který jsou popsány v části “Kořenový uzel 
atmosféry” na straně 223. 

o Color: Kliknutím na tlačítko Color dojde k otevření vzorníku barev Poseru 7, umoţņujícího 
nastavení barvy světla. 

o Set Parent: Kliknutím na tlačítko Set Parent umoţníte přiřazení jiného elementu scény jako 
mateřského objektu k aktuálnímu světlu (dojde k vytvoření Parent vazby mezi těmito elementy).  

o Advanced Material Properties: Kliknutím na tlačítko Advanced Material Properties se automaticky 
přenesete do místnosti materiálu Material room aktivovaným s aktuálním světlem v záloţce 
Advanced okna Shader. Prosím navštivte téma “Pokročilý mód zobrazení shaderu” na straně 143 
pro více informací o záloţce Advanced okna Shader a téma “Kořenový uzel světla” na straně 223 
pro více informací o atributech světelných uzlŧ Light Node. 

 

PARAMETRY SVĚTLA  LIGHT PARAMETERS (orig.91) 

Před pouţitím otočných ovladačŧ parametrŧ se ujistěte, ţe máte vybráno světlo, se kterým chcete 
pracovat, aby jste se vyhnuli nechtěné změně nastavení nesprávného světla. Jakmile budete mít 
světlo nastaveno do pozice dle Vašeho přání, mŧţete pouţít příkaz pro uzamčení prvku Lock Actor 
(viz téma “Uzamčení prvku” na straně 201) pro zabránění neţádoucím změnám. Světla mají 
následující parametry, dostupné v paletě parametrŧ Parameters: 
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ÚHEL START/END (JEN PRO BODOVÉ SVĚTLO)  ANGLE START/END (orig.91) 

Hodnoty Angle Start a Angle End stanovují, jak klesá intenzita bodového světla, kdyţ se přibliţujete 
k okraji světelného kuţele emitovaného bodovým světlem. Parametr Angle Start specifikuje mnoţství 
světla (v procentech) dostupného ve středu světelného kuţele bodového světla a parametr Angle 
End specifikuje intenzitu světla v procentech na vnějším okraji světelného kuţele. 
 

VZDÁLENOST START/END (JEN PRO BODOVÉ SVĚTLO)  DISTANCE START/END (orig.91) 

Jak jistě víte, světlo pohasíná současně se vzdáleností od jeho zdroje. Parametry Distance Start  
a Distance End specifikují podle pořadí vzdálenost od světelného zdroje (v jednotkách mříţky), od 
které začíná intenzita bodového světla poklesat (fall off) a vzdálenost v jednotkách mříţky, od které 
dále jiţ bodové světlo nevrhá ţádné paprsky. 
 

STÍN  SHADOW (orig.91) 

Světla Poseru 7 mohou vrhat stíny v případě, ţe aktivujete tuto funkci u vybraného světla pomocí 
příkazu Cast Shadow v paletě vlastností Properties, jako je popsáno výše. Stíny přidávají hloubku, 
realismus a dramatické efekty do stacionárních nebo animovaných scén. Pro změnu vrţeného stínu 
pohněte světlem. 

Bodová světla vrhají stíny zaloţené na úhlovém akčním rádiu, to znamená, ţe uţší bodová světla 
vytvoří ve scéně méně stínŧ (pouze od objektŧ v dosahu světelného kuţele). V kontrastu na to, 
nekonečná světla vyplní scénu stíny vrţenými všemi přítomnými objekty. Kvŧli tomu, pokud 
renderujete detailní záběr scény s mnoha figurami nebo rekvizitami (speciálně u do široka rozloţených 
poloţek), mapa stínŧ nemusí při pouţití bodového světla obsahovat mnoho informací. 

 POZNÁMKA 
KAŢDÉ SVĚTLO OBSAHUJE KAMERU STÍNU DOSTUPNOU POMOCÍ ROZBALOVACÍHO 
MENU CURRENT ACTOR. POKROČILÍ UŢIVATELÉ MOHOU TYTO KAMERY ZAMĚŘOVAT 
PODLE SVÝCH POŢADAVKŦ. KAŢDÁ MAPA SVĚTELNÉHO STÍNU OBSAHUJE INFORMACE  
O SCÉNĚ, KTERÁ JE VIDITELNÁ SKRZE KAMERU STÍNU SVĚTLA. 

Otočné ovladače související se stíny jsou: 

o Shadow: Ovladač parametru Shadow pouţijte pro specifikaci intenzity stínu vybraného světla. 
Nastavení hodnoty na 0 zabrání vrţení stínu zvoleného světla, zatímco nastavení parametru na 
100% zpŧsobí vrţení tmavého stínu. Změnu intenzity stínu v prŧběhu času mŧţete animovat. 

o Map Size: Ovladač parametru Map Size nastavuje velikost map stínu zvoleného světla v pixelech 
(mapy stínu jsou čtverce). Poser 7 pouţívá obrazové mapy pro aplikaci stínŧ na objekty ve scéně a 
pro aplikaci těchto stínŧ během renderingu. Větší velikosti map zvyšují přesnost a detaily stínu, ale 
vyţadují více operační paměti a prodluţují čas renderu. Například kaţdá mapa velikosti 1024x1024 
vyţaduje okolo 4MB paměti, zatímco mapa velikosti 2048x2048 vyţaduje 16MB. Velikost map 
stínu není moţné animovat. 

 

XYZ ROTACE  XYZ ROTATION (orig.92) 

Otáčením těchto ovladačŧ se nastavuje směr, do kterého je světlo zaměřeno. Představte si například 
cestu slunce napříč oblohou v prŧběhu dne a jak se mění jeho vzdálenost mezi severem a jihem 
během rŧzných ročních období. Tuto iluzi mohou vytvořit ovladače rotace. Pokud jsou ovladače 
xRotate a yRotate nastaveny na 0 stupņŧ, světlo je do pracovního prostoru Poseru 7 zaměřeno 
zepředu. ZRotate má význam pouze v případech, kdy xRotate a yRotate nejsou nastaveny na 0,0 
nebo 180, 180. Ve všech případech je figura v základní pozici: 

o xRotate: Parametr xRotate otáčí vybraným světlem okolo osy X. 

o yRotate: Parametr yRotate otáčí vybraným světlem okolo osy Y. 

o zRotate: Parametr zRotate otáčí vybraným světlem okolo osy Z. 
 

MĚŘÍTKO  SCALE (orig.92) 

Parametr Scale umoţņuje změnu velikosti indikátoru světla. To nemá ţádný vliv na světlo samé. 
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ČERVENÁ, ZELENÁ, MODRÁ  RED, GREEN, BLUE (orig.92) 

Ovladače Red, Green a Blue specifikují mnoţství kaţdé ze tří základních barev, ze kterých je 
konečná barva sloţena. Hodnota 1 značí, ţe vybraná barva je přidána zcela, hodnota 0 značí, ţe tato 
barva není přidána vŧbec. Pouţití těchto tří základních barev pro vytvoření konečného barevného 
odstínu je nazýváno RGB osvětlení (Red, Green, Blue). Kaţdá ze tří barev mŧţe mít 256 hodnot 
v rozsahu od 0 do 255. To dává dohromady 256 červených, 256 zelených a 256 modrých odstínŧ 
navzájem mísitelných, tedy 256^3 (16,777,216) celkově dostuných barev. Hodnoty otočných ovladačŧ 
korespondují s RBG hodnotami následovně: 

o Otočný ovladač 0 = RGB barevná hodnota 0 pro vybranou barvu. 

o Otočný ovladač 1 = RGB barevná hodnota 255 pro vybranou barvu. 
 

INTENZITA  INTENSITY (orig.93) 

Intenzitu světla mŧţete ovládat pomocí ovladače Brightness nebo pomocí otočného ovladače 
Intensity. Nastavení na 0% značí, ţe světlo je zcela vypnuto a nastavení na 100% značí, ţe světlo je 
spuštěno naplno (plným jasem/intenzitou). 
 

XYZ POSUN (JEN PRO BODOVÉ SVĚTLO)  XYZ TRANSLATION (orig.93) 

Otočný ovladač Translation umoţņuje specifikovat precizní umístění bodového světla ve 3D prostoru 
pomocí souřadnic. Jak jiţ bylo popsáno, bodová světla emitují paprsky směrem od pozice světla ve 
3D prostoru a objekty vzadu za světlem nejsou proto nasvíceny. 
 

ULOŢENÍ & NAČTENÍ SVĚTELNÝCH SESTAV   
SAVING & LOADING LIGHT SETS (orig.93) 

Světelnou sestavu mŧţete uloţit do palety knihoven Library, coţ Vám umoţní její opětovné pouţití 
v pozdějších scénách. Sestavy světel mají koncovku souboru *.LT2 a mohou být uloţeny do knihovny 
světel Lights Library. Prosím navštivte téma “Údržba Vaší palety knihoven” na straně 33 pro 
informace o přidávání poloţek do palety knihoven Library. 
 

ANIMACE SVĚTEL  ANIMATING LIGHTS (orig.93) 

Světla mohou být animována stejně jako ostatní objekty Poseru 7 za pouţití klíčových snímkŧ 
keyframes a tween frames. Prosím navštivte kapitolu 11: “Animace pomocí Poseru 7” na straně 83 
pro informace o animacích uvnitř Poseru 7. 
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Kapitola 10: Pózování figur  POSING FIGURES (orig.94) 

Tato kapitola vysvětlí jak se nastavuje póza figur a popíše nástroje, které se k tomu pouţívají. 
Pózování je proces zaloţen na ohýbání (bending), kroucení (twisting) a taţení (pulling) do nových 
fantastických pozic. Mŧţete dokonce vytvářet filmy. 
 

HLAVNÍ PRINCIPY PÓZOVÁNÍ  GENERAL POSING PRINCIPLES (orig.94) 

Pózy mají dvě hlediska: jak se části postavy pohybují vzhledem ke zbytku těla (například pokud 
zvedáte ruce, Vaše ramena, nadloktí, předloktí, dlaně a prsty se pohybují ve vztahu ke zbytku Vašeho 
těla) a jak figura mění pozici vzhledem k pracovnímu prostoru Poseru 7 (například kdyţ se procházíte 
okolo místnosti). Editační nástroje Poseru 7 umoţnují pohybovat částí postavy, figurami a rekvizitami 
jednoduše kliknutím a taţením. Toto jiţ nemŧţe být jednodušší! 

Pokud nastavujete pózu v Poseru 7, pracujete ve všech třech rozměrech. Jste limitováni pouze 
specifickými pohybovými limity, vloţenými do kloubŧ za účelem zachování reality póz. Aktivivání limitŧ 
například zabrání tomu, aby se kolena figury ohýbaly dozadu nebo hlava se otáčela o 360 stupņŧ. 
Nicméně limity mŧţete deaktivovat a figuru upravit do jakékoliv pozice, která Vás napadne. 
 

PÓZOVÁNÍ A POHLEDY KAMER  POSING AND CAMERA VIEWS (orig.94) 

Novější figury Poseru (verze 3 a pozdější) umoţņují pózování tváří a rukou (výrazy tváře, gesta, atd.). 
Poser 7 obsahuje kamery tváře a rukou Face and Hand Cameras, které přibliţují tyto části postavy 
pro práci zblízka. 

Pokud upravujete pózu, mŧţete přepínat kamery pro pohled na práci z mnoha rŧzných úhlŧ a také si 
mŧţete zvolit současné zobrazení aţ čtyř pohledŧ kamer v pracovním okně Document window (viz 
kapitola 6: “Pracovní okno Document” na straně 41). Je doporučeno během práce pouţívat kameru 
pózy Posing a kamery hlavní Main a pomocnou Auxiliary tak šetřit pro vytvoření finálních snímkŧ, 
obzvláště pokud renderujete animace. 
 

KNIHOVNA PÓZ  THE POSE LIBRARY (orig.94) 

Vytvořené pózy mŧţete uloţit do knihovny póz Pose Library, jak je popsáno v části “Údržba Vaší 
palety knihoven” na straně 33, nebo mŧţete uloţené stacionární či animované pózy aplikovat na 
aktuálně vybranou figuru, jak je popsáno v části “Použití položek z palety knihoven” na straně 36. 
 

POSUN  TRANSLATION (orig.95) 

Posun Translation pohybuje současně několika částmi 
postavy pomocí jejich táhnutí v závěsu. Pro představu 
tohoto efektu, se představte osobu leţící na zádech 
s rukama po stranách. Pokud uchopíte jednu ruku  
a táhnete za ni, bude se nejprve pohybovat pouze 
dotčená ruka. Pokud potáhnete dále, zvednete ramena, 
hrudník, boky a eventuálně celou postavu nad zem. 
Editační nástroje Poseru 7 pracují tímto zpŧsobem. 
Táhněte některou částí postavy a připojené části 
postavy budou následovat. Ćásti se posouvají, ohýbají  
a kroutí tak, jak je od nich očekáváno.  
 

INVERZNÍ KINEMATIKA (IK)  INVERSE KINEMATICS (orig.95) 

Inverzní kinematika Poseru 7 Inverse Kinematics (IK) pomáhá k dosaţení realistických póz  
a přirozeného pohybu ve Vašich animacích. IK efekty jsou nejvíce zřejmé při pouţití editačních 
nástrojŧ Editing tools. Posunete boky figury a nohy se ohnutím přizpŧsobí nové pozici bokŧ bez 
změny pozice chodidla. Ruce se chovají podobně: Umístěte dlaně figury proti imaginární zdi  
a pohněte boky figury dopředu. Dojde k ohnutí rukou, přičemţ dlaně zŧstanou zafixovány ve své 
pŧvodní pozici. 
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 POZNÁMKA 
AKTIVOVÁNÍ IK NA FIGURU, JEJÍŢ PÓZA BYLA NASTAVENA PŘI VYPNUTÉ IK, MŦŢE ZMĚNIT 
VAŠI PÓZU. 

Porozumění IK  UNDERSTANDING IK (orig.95) 

Kinematika je studium o rychlosti pohybu, rotaci a poloze. V rámci prvkŧ struktury postavy, jako jsou 
například ruce a nohy, je kinematika pouţita pro výpočet akce, kterou vyvolá posun nebo rotace 
počátku prvku struktury na konec prvku navazujícího. Například podrţte Vaši ruku přímo a točte 
ramenním kloubem. Kinematika bude počítat změnu pozice ramene, ruky a prstŧ. Pokud znáte úhel,  
o který otočíte Vaším ramenem, mŧţete vypočítat novou pozici ruky. 

Z toho vyplývá, ţe inverzní kinematika IK řeší stejný problém z druhého konce: Končetina se pohybuje 
a IK určuje, jak na ni napojené objekty musí reagovat, aby se přizpŧsobily novému umístění. Jestli 
zvednete ruku, rameno se musí pohnout, aby vyhovělo nové pozici ruky. Pokud Vás někdo chytí za 
ruku a zatlačí, loket se ohne a Vaše tělo zŧstane stát. 

Poser 7 podporuje IK pro ruce a nohy. Pokud IK aktivována, mŧţete posouvat dlaněmi a chodidly, 
příčemţ odpovídající pozice zbývajících částí rukou a nohou se nastaví automaticky. IK vytváří targety 
(pozice nastavení kloubu) k tomu, aby označovaly mezní pozici ohybu kloubu. Pokud se dlaņ nebo 
chodidlo posune, target je nastaven do nové pozice. Přesunem jakékoliv další části postavy zŧstává 
target ve své pŧvodní pozici relativně ke zbytku postavy. Jakmile je dosaţena meze targetu, kloub je 
zafixován a dále se musí ohýbat následující část postavy tak, aby se postava přizpŧsobila pozici dlaně 
nebo chodidla. Například kotník dosáhne meze targetu a ohnout se musí koleno. 

Pro efektivní práci s IK musíte uchovávat na mysli následující věci: 

o IK ja aktivována, pokud pracujete s editačními nástroji Editing tools. 

o Nástroje Rotate, Translate a Twist se nemusí vţdy chovat tak, jak byste mohli očekávat  
u některých částí těla. Například nemŧţete jednoduše otáčet nebo posouvat stehnem nebo holení, 
pokud je u této nohy IK aktivována, protoţe pozice chodidla se nemŧţe změnit (pozice chodidla je 
upřednostněna). Toto chování odpovídá skutečnému ţivotu: Pokud stojíte, chodidla a nohy 
podpírají Vaše tělo, takţe s nimi nemŧţete libovolně pohybovat nebo otáčet. Tato vlastnost platí 
pro editační nástroje Editing tools a také pro otočné ovladače parametrŧ. 

o Nemŧţete pouţít na stejné končetině současně IK a nástroj Chain Break (viz “Přerušení vazby” na 
straně 74). 

 

Aktivace/Deaktivace IK  ENABLING/DISABLING IK (orig.96) 

IK mŧţete pouţít na ruce a nohy figury. Figury načtené do scény Poseru 7 mají standardně IK 
aktivovánu pro nohy, ale ne pro ruce, protoţe toto nastavení upřednostņuje většina umělcŧ. Pro 
aktivaci a deaktivaci IK, zvolte Figure>Use Inverse Kinematics a vyberte poţadovanou končetinu 
(pravou ruku Right Arm, levou ruku Left Arm, pravou nohu Right Leg nebo levou nohu Left Leg). 
Následně zobrazené zátrţítko označuje, která končetina má IK aktivovánu, a naopak. 
 

OMEZENÝ POHYB  LIMITING MOTION (orig.96) 

Pouţití poloţky Use Limits zamezuje pohybu částí postavy mimo přirozený rozsah pohyblivosti. 
Figury, které jsou dodávány s Poserem 7 obsahují realistické limity, které mohou být vyuţity. Materiály 
ostatních autorŧ realistické limity kloubŧ obsahovat nemusí. Pokud máte dotazy ke specifickým 
částem materiálu, kontaktujte prosím jeho autora nebo obchod, kde jste materiál koupili. “Přirozený” je 
subjektivní definice. Limity figur Poseru 7 jsou nastaveny zevrubně a mohou nebo nemusí se Vám 
líbit. Maximální a minimální hodnoty limitŧ si mŧţete uţivatelsky přizpŧsobit pomocí metody popsané 
v části “Editace otočných ovladačů parametrů” na straně 78. 

Zvolte poloţku Figure>Use Limits pro zapnutí nebo vypnutí limitŧ. Zobrazené zátrţítko vedle názvu 
funkce indikuje, ţe limity jsou aktivovány, a naopak. 
 

PÓZOVÁNÍ ČÁSTÍ TĚLA  POSING BODY PARTS (orig.96) 

Stejně jako jejich protějšky z reálného světa, figury Poseru jsou vytvořeny z částí postavy spojených 
pomocí kloubŧ. Pózování figury znamená manipulaci samostatnými částmi těla za účelem vytvoření 
nové pozice nebo pózy. Části postavy jsou nezávislé a promyšlené elementy (nebo prvky) se svými 
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pravidly. Tento koncept platí bez ohledu na to, jak figura vypadá (had, 2-nohá, 8-nohá, atd.). Tady 
jsou některé zvláštní případy póz: 

o Ruce (viz “Pózování rukou” na straně 111) 

o Tváře (viz “Pózování tváří” na straně 110) 

o Oči (viz “Pózování očí” na straně 111) 

o Zvířata (viz “Pózování zvířat” na straně 112) 
 

PÓZOVÁNÍ FIGURY  POSING A FIGURE (orig.97) 

Nejjednodušší cestou pro nastevní pózy figury je pouţití editačních nástrojŧ Editing tools, jak je 
popsáno v části “Editační nástroje” na straně 71. Výsledný pohyb závisí na tom, jakou část postavy 
máte vybránu, na aktuálně vybraném editačním nástroji, na úhlu kamery a zda máte aktivovánu IK 
nebo ne. K preciznímu nastavení zvolených částí mŧţete také pouţít otočné ovladače v paletě 
parametrŧ Parameters. Většiny póz jsou vytvořeny pomocí editačních nástrojŧ Editing tools  
a následně jemně doladěny pomocí otočných ovladačŧ parametrŧ. 
 

VÝBĚR ČÁSTÍ POSTAVY  SELECTING BODY PARTS (orig.97) 

Před začátkem pózování figury musíte znát, jak vybrat část(i) postavy, 
kterou si přejete nastavit tak, aby jste vytvořili stacionární nebo 
animovanou pózu. Části postavy mŧţete vybírat pomocí editačních 
nástrojŧ Editing tools, rozbalovacího menu Current Actor nebo 
kliknutím na poţadovanou část postavy v pracovním okně Document. 
Kaţdá z částí postavy figury je polohovatelným elementem. 

 POZNÁMKA 
KLIKNUTÍM PRAVÝM TLAČÍTKEM MYŠI DOVNITŘ PRACOVNÍHO OKNA DOCUMENT  
A ZVOLENÍM POLOŢKY SELECT Z ROZBALOVACÍHO KONTEXTOVÉHO MENU OTEVŘETE 
MENU SE SEZNAMEM VŠECH ČÁSTÍ POSTAVY, KTERÉ SE NACHÁZEJI V POZICI POD 
KURZOREM PODÉL OSY Z. POŢADOVANOU ČÁST POSTAVY MŦŢETE POTOM VYBRAT 
PŘÍMO Z TOHOTO SEZNAMU BEZ NUTNOST PŘERUŠENÍ POSTUPU PRÁCE NEBO ZMĚNY 
POHLEDU KAMERY.  

 

POUŢITÍ EDITAČNÍCH NÁSTROJŮ  USING THE EDITING TOOLS (orig.97) 

Pro výběr části postavy pomocí editačních nástrojŧ Editing tools klikněte na poţadovaný nástroj  
a poté klikněte na část postavy, kterou si přejete pózovat. Aktuálně vybraná část postavy je 
zvýrazněna v pracovním okně Document a její název je zobrazen v menu Select Figure a Current 
Actor v levém horním rohu pracovního okna Document. 
 

POUŢITÍ ROZBALOVACÍHO MENU CURRENT ACTOR   
USING THE CURRENT ACTOR PULL-DOWN MENU (orig.97) 

Pro výběr poţadované části postavy pomocí rozbalovacího menu: 

1. Vyberte poţadovanou figuru pomocí rozbalovacího menu Select Figure. 

2. Vyberte poţadovanou část postavy pomocí rozbalovacího menu Current Actor. 

Tato metoda mŧţe být preferována u scén s velkým mnoţstvím figur anebo s detainími částmi postav 
(jako jsou ohebné články prstŧ na rukou a nohou). 
 

EDITAČNÍ NÁSTROJE  THE EDITING TOOLS (orig.98) 

Editační nástroje Editing tools v pracovním prostoru Poseru 7 vypadají následovně: 
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 POZNÁMKA 
NÁSTROJE ZOBRAZENÉ NA HORNÍM OBRÁZKU JSOU DOSTUPNÉ UVNITŘ MÍSTNOSTI PÓZ 
POSE ROOM. DOSTUPNOST INDIVIDUÁLNÍCH EDITAČNÍCH NÁSTROJŦ JE V RŦZNÝCH 
MÍSTNOSTECH POSER 7 ODLIŠNÁ. DODATEČNÉ EDITAČNÍ NÁSTROJE DOSTUPNÉ  
V RŦZNÝCH MÍSTNOSTECH BUDOU POPSÁNY V ODPOVÍDAJÍCÍCCH KAPITOLÁCH TÉTO 
PŘÍRUČKY. 

Jak je popsáno v části “Nastavení pracovní plochy” na straně 22, mŧţete editační nástroje Editing 
tools na obrazovce Poseru 7 umístit kamkoliv si přejete a zobrazit nebo skrýt jejich název. Mŧţete 
také přepínat mezi horizontálním (základním) nebo vertikálním zobrazením editačních nástrojŧ. Pro 
přepnutí zobrazení umístěte kurzor myši nad jakýkoliv editační nástroj a klikněte levým tlačítkem myši 
při současném stisku klávesy [OPT]/[ALT]. 

Editační nástroje Editing tools umoţņují pohybovat částmi postavy mnoha rŧznými zpŧsoby. Efekt 
nástrojŧ se mŧţe měnit v závislosti na aktivaci inverzní kinamatiky Inverse Kinematics (IK). Prosím 
navštivte téma “Inverzní kinematika (IK)” na straně 69 pro informace o IK. Editační nástroje mŧţou 
pózovat individuální části postavy nebo kompletní figuru. 

Pro nastavení pózy části postavy na ni klikněte a táhněte. Pro nastavení pózy celé figury pouţijte 
jeden z následujících zpŧsobŧ: 

o Klikněte a táhněte poţadovaným editačním nástrojem Editing tool. 

o Zvolte poţadovaný editační nástroj Editing tool, potom vyberte kruh zobrazený okolo poţadované 
figury Figure Ring a táhněte. Kruh Figure Ring je zvýrazněn pokud je vybrán, coţ značí, ţe 
pracujete s celou figuriu najednou. 

Pro posunutí celé figury mŧţete: 

o Kliknout a táhnout editačním nástrojem Editing tool. 

o Vybrat a táhnout kruhem Figure Ring. 

o Vybrat celou postavu Body pouţitím rozbalovacího menu Select Actor a táhnout. 

o Vybrat boky figury hip a táhnout jimi (při deaktivované IK).  

Pokud pouţíváte editační nástroje Editing tool v pracovním okně Document, kurzor se změní tak, 
aby vizuálně reprezentoval vybraný nástroj. To Vám pomáhá rozpoznat, jakým zpŧsobem pohybujete 
vybranou figurou nebo prvkem. 

Pokud pouţíváte editační nástroje Editing tool na součást figury, nepotřebujete kliknout a táhnout 
kurzorem umístěným nad dotčenou poloţkou; mŧţete kliknout a táhnout kdekoliv v pracovním okně 
Document. Také si uvědomte, jak vzhled figury ovlivņuje nastavení pohledu kamery. V závislosti na 
póze, kterou vytváříte, budete muset přepínat mezi rŧznými kamerami. Pokud například pohybujete 
rukou figury dopředu, boční pohled kamery Vám umoţní nejlepší pohled na ruku pohybující se 
dopředu relativně k figuře. Pohledy kamer Camera views mŧţete měnit tak, jak je popsáno v části 
“Menu výběru figury/aktuálního prvku” na straně 43, a dokonce se mŧţete dívat na scénu Poseru 7 
pomocí více kamer najednou, jak je popsáno v části “Změna kamer uvnitř okna” na straně 45. 

Editační nástroje Editing tools zleva doprava jsou: 
 

OTÁČENÍ  ROTATE (orig.99)  

Nástroj otáčení Rotate ohýbá části těla v jejich kloubech. Otáčení pracuje ve třech rozměrech, coţ 
umoţņuje postupovat v práci velmi rychle. Pro otočení částí postavy vyberte část, kterou si přejete 
otáčet a táhněte kolmo k této části pro otočení nahoru nebo dolŧ (relativně vzhledem k pohledu). 
Táhnutím rovnoběţně vzhledem k předmětné části postavy se tato otáčí dopředu a dozadu, opět 
relativně vzhledem k Vašemu pohledu. 

Pro otáčení celou figurou ji vyberte. Taţení myší nahoru/dolŧ a vlevo/vpravo funguje stejně jako 
kulový ovladač (trackball) a o otáčí figurou podle jejích os vzhledem k pozici kamery. Pro nastavení 
rotace prvku mŧţete také pouţít otočné ovladače parametrŧ, jak je popsáno v části “Paleta 
parametrů” na straně 77. 
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KROUCENÍ  TWIST (orig.99)  

Nástroj kroucení Twist otáčí figurou/částí/rekvizitou kolem její vlastní osy. Mŧţete kroutit celou figurou 
po jejím výběru taţením. Některé klouby postavy kroucení moc neumoţņují. Například Vaše předloktí 
je moţné kroutit v rozsahu skoro 180 stupņŧ, zatímco Vaše zápěstí se prakticky kroutit nemŧţe. Osy 
kroucení hlavy, krku a torza postavy jsou podél páteře. Pro předloktí leţí osa kroucení podél délky 
ruky. Při kroucení celou postavou se tato otáčí podle své vlastní osy. Pokud je postava stojící, otáčí se 
dokola. Pokud leţí, převaluje se. Pro nastavení kroucení prvku mŧţete také pouţít otočné ovladače 
parametrŧ, jak je popsáno v části “Paleta parametrů” na straně 77. 
 

POSUNUTÍ/TAŢENÍ  TRANSLATE/PULL (orig.100)  

Nástroj posunutí/taţení Translate/Pull posouvá vybranou figurou/částí/rekvizitou vertikálně podél 
nebo postranně os kamery X a Y v závislosti na tom, jak táhnete kurzorem. Posunutí se mŧţe projevit 
podle os figury X, Y nebo Z v závislosti na pozici kamery vzhledem k figuře. Posouvat mŧţete části 
postavy nebo celou figurou. Pro nastavení posunutí prvku mŧţete také pouţít otočné ovladače 
parametrŧ, jak je popsáno v části “Paleta parametrů” na straně 77. 
 

POSUNUTÍ DOPŘEDU/DOZADU  TRANSLATE IN/OUT (orig.100)  

Nástroj posunutí dopředu/dozadu Translate In/Out tool posouvá vybranou figurou/částí/rekvizitou 
podél Z osy kamery (dopředu a dozadu). Posunutí se mŧţe projevit podle os figury X, Y nebo 
Z v závislosti na pozici kamery vzhledem k figuře. Taţením kurzoru směrem dolŧ se prvek posouvá 
směrem k Vám, a naopak. Posunem poloţek dopředu se tyto zdají být větší, a naopak. Pro nastavení 
posunutí prvku mŧţete také pouţít otočné ovladače parametrŧ, jak je popsáno v části “Paleta 
parametrů” na straně 77. 
 

ZMĚNA VELIKOSTI  SCALE (orig.100)  

Nástroj změny velikosti Scale umoţņuje změnit velikost vybrané figury/části/rekvizity podél os kamery 
X a Y. Dotčené osy prvku se budou lišit v závislosti na pozici kamery vzhledem k prvku. Taţením 
kurzoru směrem k prvku se bude jeho velikost zmenšovat a taţením směrem od prvku se jeho velikost 
bude zvětšovat. Pro změnu velikosti prvku pouze ve dvou dimenzích táhněte kurzorem postranně 
(horizontálně nebo vertikálně). Během pouţití tohoto nástroje mŧţete také stisknout a drţet klávesu 
[SHIFT] pro rovnoměrnou změnu velikosti prvku ve všech třech osách najednou. Udělali jste chybu? 
Ţádný problém. Zvolte poloţku Edit>Undo nebo stiskněte kombinaci kláves [COMMAND]/[CTRL]+[Z]. 
Pro nastavení změny velikosti prvku mŧţete také pouţít otočné ovladače parametrŧ, jak je popsáno  
v části “Paleta parametrů” na straně 77. 

Pro změnu velikosti celé figury vyberte poţadovanou figuru pouţitím rozbalovacího menu Select 
Figure v pracovním okně Document, nebo kliknutím na kruh figury Figure Ring. Velikost figury má 
význam pouze ve vztahu k ostatním figurám a rekvizitám scény. Měnit pózu pouze jedné figury 
změnou její velikosti není nutné: mŧţete jednoduše pouţít přiblíţení (zoom) kamery. Pokud pracujete 
se dvěmi a více figurami a u jedné chcete navodit dojem, ţe je v pozadí, je lepší jednoduše posunout 
figuru do pozadí pomocí nástroje posunutí Translate (viz výše). 
 

ZÚŢENÍ  TAPER (orig.100)  

Nástroj zúţení Taper umoţņuje zúţit vybranou figuru/část/rekvizitu podél os kamery X a Y. Dotčené 
osy prvku se budou lišit v závislosti na pozici kamery vzhledem k prvku. Tato funkce má vliv pouze na 
konec vybraného prvku, který je nejvíce vzdálený od středu postavy. Taţením kurzoru doprava se 
efekt zúţení zvyšuje, taţením doleva se vybraný prvek opět rozšiřuje. Zúţení prvku mŧţete také 
nastavit pomocí otočných ovladačŧ parametrŧ, jak je popsáno v části “Paleta parametrů” na straně 77. 
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PŘERUŠENÍ VAZBY  CHAIN BREAK (orig.101)  

Nástroj Chain Break umoţņuje přerušení vazby nazájem 
ovlivņovaných prvkŧ při pouţití Translate tools. 

Přerušením vazby rŧzných prvkŧ postavy je moţné vytvořit zajímavé 
efekty. Například pro zabránění pohybu hrudníku aplikujte přerušení 
vazby na něj. Následně mŧţete volně pohybovat rukou postavy, aniţ 
by se hrudník jakkoliv pohyboval. Pohybovat se bude pouze dlaņ, 
předloktí, loket a rameno. Pro pouţití této funkce musíte mít  
u dotčené končetiny deaktivovánu IK. Prosím navštivte téma 
“Inverzní kinematika (IK)” na straně 69 pro informaci o inverzní 
kinematice Inverse Kinematics. 

Pro přidání nového přerušení vazby zvolte nástroj Chain Break  
a klikněte na prvek, jehoţ vazbu chcete přerušit. Jakmile vloţíte 
přerušení, zobrazí se na tomto místě ikona Chain Break. Přerušení 
prvkŧ scény mŧţete vloţit tolik, kolik chcete. Pro odstranění 
přerušení vazby prvkŧ klikněte na odpovídající ikonu přerušení. 

 POZNÁMKA 
VŠECHNY FIGURY MAJÍ TRVALE NASTAVENO PŘERUŠENÍ VAZBY VE SVÝCH BOCÍCH. 
TOTO PŘERUŠENÍ NENÍ MOŢNÉ ODSTRANIT.  

 

BARVA  COLOR (orig.101)  

Nástroj Color umoţņuje měnit barvu materiálových skupin povrchu (diffuse). Prosím navštivte téma 
“Kořenové uzly” na straně 221 pro informace o nastavení barev a ostatních hodnot materiálu. 
 

SESKUPOVÁNÍ  GROUPING (orig.101)  

Nástroj Grouping otevírá paletu editoru skupin Group Editor, který je popisován v části “Editor 
skupin” na straně 125. 

POHLED PŘES LUPU  VIEW MAGNIFIER (orig.101)  

Nástroj View Magnifier umoţņuje přiblíţení a oddálení pohledu na poţadovanou plochu pracovního 
okna Document  bez nutnosti změny pozice aktuálně vybrané kamery. Toto mŧţe být velmi uţitečné 
při práci se scénou. 

Pro pouţití nástroje pohledu přes lupu View Magnifier jej zvolte: 

o Klikněte kamkoliv do pracovního okna Document a následně dojde k přiblíţení pohledu směrem 
k pozici kurzoru. Opakováním akce dojde k dalšímu přiblíţení vţdy o jeden krok na jedno kliknutí. 

o Pro okamţité přiblíţení specifického výřezu pracovního okna Document klikněte a táhněte 
kurzorem pro vymezení poţadovaného výřezu, který si přejete přiblíţit. Velikost zoomu se nastaví 
podle nejbliţšího bodu, který vymezuje vybraný výřez. 

o Pro oddálení pohledu stiskněte během kliknutí do pracovního okna Document klávesu 
[COMMAND]/[CTRL]. 

NÁSTROJ MORPHINGU  MORPHING TOOL (orig.102)  

Nástroj Morphing Tool otevírá paletu editoru morphingu Morph Editor. Morphing Tool má dva 
funkčí módy: Combine a Create, které jsou přístupné a ovládané pomocí editoru morphingu Morph 
Editor. Mód Combine umoţņuje úpravy jakéhokoliv povrchu figury pouţitím morph targetŧ. Mód 
Create umoţņuje manipulaci s polygony síťového modelu postavy a vytváření nových morph targetŧ. 
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Viz téma “Tvorba a použití morph targetů” na straně 117 pro více informací o morph targetech  
a paletě editoru morphingu. 

PŘÍMÁ MANIPULACE  DIRECT MANIPULATION (orig.102)  

Nástroj přímé manipulace Direct Manipulation umoţņuje přímé nastavení parametrŧ prvku Translate, 
Scale a Rotation: 

Pro nastavení prvku nejprve zvolte nástroj Direct Manipulation  
a následně zvolte poţadovaný prvek: 

Kliknutím a taţením jedné ze zobrazených ţlutých krychlí okolo 
zvoleného prvku se prvek zvětšuje nebo zmenšuje podle osy X, Y nebo 
Z. Jedná se v podstatě o stejnou funkci jako je nastavování parametrŧ 
xScale, yScale a zScale. 

Mŧţete také kliknout a táhnout barevnými kruhy okolo zvoleného prvku 
za účelem otáčení tohoto prvku kolem jeho os. Taţením červeného kruhu 
se prvek otáčí kolem své osy X. Zelený kruh otáčí prvek kolem jeho osy Y a modrý kruh kolem jeho 
osy Z. Změna vzhledu kurzoru indikuje, která tranformace bude provedena. Pokud napřílad přesunete 
kurzor nad kruhy, bude kurzor zobrazen pomocí ikony rotace. Prvky se otáčejí okolo svých 
počátečných bodŧ (kloubŧ). 

Kliknutím do blízkosti počátku zvoleného prvku dojde k posunutí tohoto prvku stejným zpŧsobem, jako 
byste pouţili nástroj Translate. Klinutím dále od počátku prvku, os a kruhŧ dojde k otočení tohoto 
prvku stejným zpŧsobem, jako byste pouţili nástroj Rotate.  
 

PALETA PARAMETRŮ/VLASTNOSTÍ   
THE PARAMETERS/PROPERTIES PALETTE (orig.103) 

Poser 7 přináší kombinovanou paletu parametrŧ/vlastností 
Parameters/Properties, která umoţņuje rychlé přepínání mezi ovladači 
vlastností a parametrŧ vybraného prvku. 

Kvŧli srozumitelnosti bude kaţdá záloţka této kombinované palety popsána jako 
samostatná paleta, a to paleta vlastností Properties a paleta parametrŧ 
Parameters. Pro přepnutí mezi těmito dvěma paletami klikněte na odpovídající 
záloţku. Přístup do palety vlastností Properties objektu je moţný také pomocí 
dvojkliku na poţadovaný objekt. Jakmile toto provedete, klikněte na záloţku 
Parameters pro otevření paltey parametrŧ Parameters objektu. Přístup do 
obou palet je moţný pomocí volby Window> Parameter Dials.  
 

PALETA VLASTNOSTÍ  PROPERTIES (orig.103) 

Paleta vlastností Properties obsahuje vlastnosti dostupné pro 
aktuálně vybraný prvek scény. Vlastnosti osvětlení, kamer, rekvizit, 
atd. jsou popsány v odpovídajících částech příručky. Tato část 
popisuje vlastnosti dostupné pro figury a jejich části. 
 

VLASTNOSTI FIGUR  FIGURE PROPERTIES (orig.103) 

Figury mají následující vlastnosti: 

o Name: Políčko Name zobrazuje pojmenování figury. Podle 
potřeby mŧţete do tohoto políčka zadat jméno nové. 

o Visible: Označením políčka Visible učiníte figuru viditelnou  
a naopak. Neviditelné objekty nejsou zahrnuty do výpočtu 
renderu a nebudou tedy zobrazeny v renderované scéně. 

Viditelnost mŧţete animovat pomocí kliknutí na přepínač 
animace Animation Toggle (ikona klíče) vedle zaškrtávacího 
políčka Visible. Pokud je animace aktivována, ikona klíče je zbarvena zeleně. Pokud je animace 
deaktivována, ikona je nevybarvená. Při aktivované animaci přibude v paletě parametrŧ 
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Parameters otočný ovladač s názvem Visible. Tento ovladač mŧţete pouţít pro nastavení stupně 
viditelnosti vybraného prvku scény.  

o Visible in Raytracing: Označením políčka Visible in Raytracing učiníte figuru viditelnou 
v odlescích, jako například figura v zrcadle. Při neoznačeném políčku se figura v odlescích 
nezobrazí. Tato funkce je pouţitelná v případě, ţe raytracing je aktivován v předvolbách renderu. 

o Collision detection: Označením políčka Collision Detection se aktivuje detekce kolize aktuálně 
vybrané figury. 

o Displacement Bounds: Vlastnost Displacement Bounds určuje hodnotu hranice vytlačení povrchu 
figury (zvýraznění plasticity povrchu). Prosím navštivte kapitolu 36: “Použití renderovacího nástroje 
FireFly” na straně 249 pro více informací o hranici vytlačení. 

 

VLASTNOSTI ČÁSTÍ POSTAVY  BODY PART PROPERTIES (orig.104) 

Části postavy obsahují následujícíc vlastnosti: 

o Internal Name: Políčko Internal Name zobrazuje interní (skrytý) název zvolené části postavy, který 
Poser 7 pouţívá pro své vnitřní potřeby a výpočty. Interní název části postavy nemŧţete uvnitř 
Poseru 7 změnit. 

o Name: Políčko Name zobrazuje pojmenování zvolené části postavy. Podle potřeby mŧţete do 
tohoto políčka zadat jméno nové. 

o Visible: Označením políčka Visible učiníte zvolenou část postavy viditelnou a naopak. Neviditelné 
objekty nejsou zahrnuty do výpočtu renderu a nebudou tedy zobrazeny v renderované scéně. Viz 
téma “Vlastnosti figur” na straně 75 pro informace o animaci viditelnosti Visible. 

o Visible in Raytracing: Označením políčka Visible in Raytracing učiníte zvolenou část postavy 
viditelnou v odlescích, jako například část postavy v zrcadle. Při neoznačeném políčku se zvolená 
část postavy v odlescích nezobrazí. Tato funkce je pouţitelná v případě, ţe raytracing je aktivován 
v předvolbách renderu. 

o Bend: Označením políčka Bend umoţníte ohýbání vybrané části postavy a naopak. Ohýbání je 
popisováno v části “Ohýbání částí těla” na straně 206. Pamatujte si, ţe volbou Display>Bend 
Body Parts je aktivováno ohýbání všech částí postavy a tato vlastnost se tedy uplatní pouze na 
aktuálně vybranou část postavy. 

o Casts Shadows: Označením políčka Casts Shadows bude vybraná část postavy vrhat stín, který 
bude ve scéně viditelný. Při neoznačeném políčku nebude vybraná část postavy vrhat ţádný stín. 

o Collision detection: Označením políčka Collision Detection se aktivuje detekce kolize aktuálně 
vybrané části postavy. 

o Apply Collision Setting to Children: Kliknutím na tlačítko Apply Collision Setting to Children bude 
detekce kolize aktuálně vybrané části postavy aplikována také na podřízené („dětské“ v rámci 
hierarchie Poseru 7) prvky vybrané části postavy (pokud nějaké existují). 

o Load Morph Target: Kliknutím na tlačítko Load Morph Target se zobrazí dialogové okno Load 
Morph Target, umoţņující pro vybranou část postavy přidat uţivatelský morph target (který je pak 
editovatelný za pouţití nástroje morphingu Morphing Tool, jak je popsáno v části „Nástroj 
Morphingu“ na straně 74). Prosím navštivte téma “Tvorba a použití morph targetů” na straně 117 
pro více informací o morph targetech. 

o Displacement Bounds: Vlastnost Displacement Bounds určuje hodnotu hranice vytlačení povrchu 
zvolené části postavy (zvýraznění plasticity povrchu). Prosím navštivte kapitolu 36: “Použití 
renderovacího nástroje FireFly” na straně 249 pro více informací o hranici vytlačení. 

o Shading Rate: Vlastnost Shading Rate umoţņuje specifikovat velikost mikropolygonŧ v pixelech, 
které vznikají dělením polygonŧ povrchu aktuálně vybrané části postavy během renderu. Prosím 
navštivte kapitolu 36: “Použití renderovacího nástroje FireFly” na straně 249 pro více informací  
o vlastnosti Shading Rate. 

o Smooth Polygons: Označením políčka Smooth Polygons bude Poser 7 vyhlazovat polygony 
vybrané části postavy během renderu kvŧli eliminaci a potlačení hranatého vzhledu prvku 
zpŧsobeného pouţitím plochých polygonŧ. Tato funkce mŧţe u ostrých hran vytvořit dojem 
zakulacení. Jestli dotčená část postavy obsahuje ostré hrany, které si přejete zachovat i při pouţití 



 

Strana 77 (celkem 289) 

funkce vyhlazování polygonŧ, mŧţete tyto ostré hrany specifikovat pomocí skupin vyhlazování 
(smoothing groups) a u nich sníţit citlivost pro vyhlazování, přičemţ funkce vyhlazování polygonŧ 
nastavenou hodnotu nepřekročí. Viz kapitola 15: “Vyhlazování povrchu” na straně 137 pro více 
informací o ostrých versus hladkých hranách. 

o Crease Angle: Nastavení Crease Angle stanovuje mez citlivosti (velikost úhlu mezi stěnami 
polygonu), po jejímţ překročení budou teprve hrany mezi vedlejšími polygony vyhlazovány. 
Polygony, jejichţ vzájemné úhly překračují mez citlivosti budou renderovány jako ostré hrany. Viz 
kapitola 15: “Vyhlazování povrchu” na straně 137 pro více informací o pouţití nastavení Crease 
Angle při aplikaci vyhlazování povrchŧ. 

 

PALETA PARAMETRŮ 
PARAMETERS PALETTE (orig.105) 

Paleta parametrŧ Parameters obsahuje 
všechny parametry aktuálně vybraného 
prvku scény: 

Následující témata detailně popisují paletu 
paramerŧ Parameters.  
 

MENU AKTUÁLNÍ PRVEK   
CURRENT ACTOR MENU (orig.105) 

Rozbalovací menu palety parametrŧ Current Actor (1) funguje stejným zpŧsobem jako rozbalovací 
menu Current Actor v levé horní části pracovního okna Document. Prosím navštivte téma “ Menu 
výběr figury/aktuálního prvku” na straně 43 pro více informací o menu Current Actor (aktuální prvek). 
 

VOLBY MENU PALETY PARAMETRŮ  PARAMETERS PALETTE OPTIONS MENU (orig.106) 

Volby menu palety parametrŧ Parameters (2) obsahují následující poloţky: 

o Create New Group: Zvolení poloţky Create New Group vytvoříte novou podskupinu pro aktuálně 
vybranou skupinu parametrŧ. Následně zobrazené dialogové okno Create New Group Vás 
vybídne k zadání názvu podskupiny. Zadejte poţadované jméno do políčka. Pro přejmenování 
existující skupiny parametrŧ (nebo při chybě během vytváření nové skupiny), poklikejte na jméno 
skupiny v paletě parametrŧ, coţ otevře okno pro specifikování nového jména skupiny. 

o Delete Selected Groups: Volbou poloţky Delete Selected Group vymaţete aktuálně vybranou 
skupinu parametrŧ. Otočné ovladače parametrŧ z vymazané skupiny se přesunou do nejbliţší 
vyšší skupiny nebo podskupiny parametrŧ. 

o Display as ordered list: Poloţka Display as ordered list přepíná mezi zobrazením otočných 
ovladačŧ parametrŧ ve členění podle skupin nebo zobrazením bez rozdělení do skupin. Zátrţítko 
indikuje, ţe je aktivováno zobrazení otočných ovladačŧ parametrŧ bez rozdělení do skupin  
a podskupin, a naopak. 

o Memorize: Zvolením poloţky Memorize dojde k uchování aktuálních hodnot otočných ovladačŧ 
parametrŧ jako základních hodnot. Prosím navštivte téma “Zapamatování” na straně 193 pro více 
informací o uloţení hodnot otočných ovladačŧ parametrŧ. 

o Restore: Zvolením poloţky Restore dojde k obnovení hodnot otočných ovladačŧ parametrŧ podle 
uloţených základních hodnot. Prosím navštivte téma “Obnovení ” na straně 193 pro více informací 
o obnovení hodnot otočných ovladačŧ parametrŧ. 

o Delete Object: Zvolením poloţky Delete Object dojde k vymazání aktuálního objektu. 
 

SKUPINY OTOČNÝCH OVLADAČŮ PARAMETRŮ  PARAMETER DIAL GROUPS (orig.106) 

Poser 7 přináší skupiny otočných ovladačŧ parametrŧ (3), které organizují parametry do jednoduše 
přístupných kategorií. 

 POZNÁMKA 
RŦZNÉ FIGURY MOHOU MÍT RŦZNÉ SKUPINY OTOČNÝCH OVLADAČŦ PARAMETRŦ. 

o Skupiny otočných ovladačŧ parametrŧ Parameter dial groups fungují následovně: 
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o Kliknutím na znaménko + dojde k rozbalení struktury skupina/podskupina. 

o Kliknutím na znaménko – dojde ke sbalení struktury skupina/podskupina. 

o Dvojitým kliknutím na název skupiny je moţné skupinu přejmenovat. 

o Skupiny mŧţete myší přetáhnout na jiné místo v hierarchickém pořadí. Například skupina se mŧţe 
stát podskupinou pod jinou skupinou a naopak. 

o Otočné ovladače parametrŧ mŧţete myší přetáhnout na jiné místo ve stejné skupině nebo mezi 
skupinami a podskupinami, coţ umoţņuje organizovat poloţky tak, jak je chcete mít zobrazeny. 

 POZNÁMKA 
SKUPINY OTOČNÝCH OVLADAČŦ PARAMETRŦ SKUPIN A PODSKUPIN JSOU ULOŢENY 
SOUČASNĚ SE SOUBORY SCÉNY POSERU 7. 

 

OTOČNÉ OVLADAČE PARAMETRŮ  PARAMETER DIALS (orig.107) 

Otočné ovladače parametrŧ (4) v paletě parametrŧ Parameter Vám umoţņují nastavovat pózu figury 
a nastavovat další atributy figur, rekvizit, světel, kamer, atd. za pomoci přesných numerických hodnot. 
Kaţdá část postavy a mnoho dalších prvkŧ má své vlastní otočné ovladače parametrŧ. Pokud je 
vybrána celá figura, zobrazené parametry ovlivņují figuru celou. Pro pouţití otočného ovladače 
parametrŧ na něj mŧţete kliknout a táhnout, doprava pro zvýšení hodnoty vybraného parametru, nebo 
doleva pro sníţení jeho hodnoty. Také mŧţete kliknout na zobrazenou numerickou hodnotu  
a manuálně zadat novou poţadovanou hodnotu do zobrazeného textového políčka. 

Pro obnovení základní hodnoty otočného ovladače parametrŧ (nebo hodnoty naposledy uloţené), 
stiskněte a drţte klávesu [OPT]/[ALT] během kliknutí na poţadovaný otočný ovladač parametrŧ. Pro 
změnu základní hodnoty otočného ovladače parametrŧ nastavte ovladačem poţadovanou hodnotu  
a následně zvolte Edit>Memorize>element, jak je popsáno v části “Zapamatování” na straně 193, 
nebo pouţijte menu palety parametrŧ jak je popsáno v části “ Volby menu palety parametrů ” na 
straně 77. 

Kaţdý otočný ovladač parametrŧ obsahuje vlastní menu Parameter Dial (5), které je dostupné po 
kliknutí na šipku napravo od ovladače. Menu Parameter Dial má následující poloţky: 

o Reset: Volbou Reset dojde k resetování hodnoty otočného ovladače parametrŧ na jeho základní 
nebo naposledy uloţenou hodnotu. 

o Settings: Volbou Settings dojde k otevření editačního dialogu Edit Parameter Dial, popsaného 
v následujícím tématu. 

o Graph: Volbou Graph dojde k otevření palety Graph zvoleného prvku. Prosím navštivte téma 
“Použití grafů” na straně 96 pro více informací o paletě Graph. 

o Recalculate Dynamics: Pokud máte vybrán prvek s dynamikou (pramínkové vlasy nebo dynamické 
oblečení), volbou poloţky Recalculate Dynamics dojde k přepočítání dynamiky tohoto objektu. 
Prosím navštivte téma “Krok 4: Nastavení dynamiky vlasů” na straně 162 a “Krok 4: Ovladače 
dynamiky oblečení” na straně 171 pro informace o pramínkových vlasech a dynamice oblečení. 

o Split Morph: Pokud je funkce aktivována, volbou Split Morph dojde k rozdělení aktuálně 
vybraného morphu mezi levou a pravou stranu figury, coţ umoţņuje aplikaci vybraného morph 
targetu asymetricky. Toto mŧţete vyuţít například pro vytvoření  odlišností na hlavě figury, které 
zvyšují realitu, protoţe ţádná hlava osoby není perfektně symetrická. 

 

EDITACE OTOČNÝCH OVLADAČŮ PARAMETRŮ  EDITING PARAMETER DIALS (orig. 108) 

Otočné ovladače parametrŧ mŧţete editovat po poklikání na vybraný ovladač, coţ otevře dialog Edit 
Parameter Dial, který umoţņuje nastavení následujících limitŧ: 

o Value: Poloţka Value nastavuje číselnou hodnotu aktuálního otočného ovladače parametrŧ. 

o Min/Max Limit: Hodnoty poloţek Min Limit a Max Limit definují mimimální a maximální limity 
aktuálního parametru. Čísla mohou symbolizovat rŧzné druhy hodnot v závislosti na parametru, 
který editujete. Jestli se jedná o parametr kloubu, hodnota bude vyjádřena ve stupních nad nebo 
pod 0 (neutrální hodnotou). Pokud nastavujete parametr měřítka, hodnota bude vyjádřena 
v procentech, kdy základní velikostí je 100%. 
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o Name: Parametr mŧţete přejmenovat zadáním 
nového jména do políčka Name. 

o Sensitivity: Hodnota Sensitivity modifikuje 
sensitivitu (citlivost) otočných ovladačŧ 
parametrŧ při pouţití kliknutí a taţení. Niţší 
číselná hodnota sensitivitu sniţuje a naopak. 

o Graph: Kliknutím na tlačítko Graph dojde 
k otevření palety Graph zvoleného prvku. 
Prosím navštivte téma “Použití grafů” na straně 
96 pro více informací o paletě Graph. 

Jakmile budete hotovi se změnami nastavení, 
klikněte na tlačítko OK.  
 

PARAMETRY VŠEOBECNÉ/FIGURY  UNIVERSAL/FIGURE PARAMETERS (orig.108) 

Toto téma popisuje všeobecné parametry otočných ovladačŧ a parametry pouţité u figur. Parametry 
kamer, osvětlení a dalších prvkŧ jsou popsány v jejich samostatných sekcích. 
 

Parametry měřítka  SCALE PARAMETERS (orig.108) 

o Taper: Otočný ovladač parametru Taper (zúţení) zúţí vybranou část/prvek postavy. Tato funkce je 
stejná, jako pouţití nástroje Taper, popsaného v části “Zúžení” na straně 73. 

o Scale: Otočný ovladač parametru Scale zvětšuje nebo zmenšuje vybranou část/prvek postavy ve 
všech třech osách rovnoměrně. Tato funkce je stejná, jako pouţití nástroje Scale, popsaného 
v části“ Změna velikosti” na straně 73. Základní velikost je 100%. 

o XYZScale: Otočné ovladače parametrŧ xScale, yScale a zScale zvětšují nebo zmenšují vybranou 
část/prvek postavy jen podél zvolené osy. Toto umoţņuje zmáčknutí nebo roztaţení poloţek. Tato 
funkce je stejná, jako pouţití nástroje Scale. Základní velikost je 100%. 

o Breast Size: Ţenské model hrudníku obsahují otočné ovladače parametrŧ BRLarge a BRSmall 
pro změnu velikosti ņader. Taţením ovladače BRLarge doprava se ņadra zvětšují, zatímco 
taţením ovladače BRSmall doprava se zmenšují. 

 

Parametry póz  POSING PARAMETERS (orig.109) 

Následující parametry jsou dostupné pro pózování: 

o Twist: Otočný ovladač parametru Twist otáčí část postavy okolo vlastní osy. Například pouţitím 
parametru Twist na hlavu a krk otáčí hlavou. Tato funkce je stejná, jako pouţití nástroje Twist, 
popsaného v části “Kroucení” na straně 73. 

o Bend: Otočný ovladač parametru Bend ohýbá část postavy okolo její hlavní osy. Většina částí 
postavy se ohýbá dopředu a dozadu, kromě ramen a rukou, které se ohýbají nahoru a dolŧ. 

o Side-to-Side: Otočný ovladač parametru Side-to-Side ohýbá část postavy kolmo k její hlavní ose. 
Například stehno umoţņuje ohyb ze strany na stranu ve velkém rozsahu, koleno naopak disponuje 
velmi malým rozsahem tohoto pohybu. 

o Turn: Otočný ovladač parametru Turn je k dispozici pouze pro chodidlo a otáčí jím dovnitř nebo 
ven. 

o Front-Back: Otočný ovladač parametru Front-Back je pouţit u vnitřní části ramen a u krku, slouţí 
k jejich ohybu dopředu a dozadu kolmo na jejich hlavní osu. 

 

Otočné ovladače parametrů postavy  BODY PARAMETER DIALS (orig.109) 

Následující parametry jsou dostupné pro kompletní figury. Nezapoměņte vybrat správnou figuru vţdy, 
kdyţ pracujete s více figurami ve scéně: 

o XYZRotate: Otočné ovladače parametrŧ xRotate, yRotate a zRotate otáčejí celou figurou okolo 
příslušných os X, Y, nebo Z. 
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o XYZTran: Otočné ovladače parametrŧ xTran, yTran a zTran posouvají celou figurou podél 
příslušných os. 

 POZNÁMKA 
XYZTRAN A OSTATNÍ OTOČNÉ OVLADAČE PARAMERŦ ZOBRAZUJÍ HODNOTY  
V AKTUÁLNĚ VYBRANÝCH MĚRNÝCH JEDNOTKÁCH, JEJICHŢ NASTAVENÍ JE DOSTUPNÉ  
V DIALOGOVÉM OKNĚ HLAVNÍCH PŘEDVOLEB GENERAL PREFERENCES. POKUD JE 
NAPŘÍKLAD OVLADAČ NASTAVEN NA 12 PALCŦ INCHES A JEDNOTKY ZMĚNÍTE NA STOPY 
FEET, NA OVLADAČI BUDE NYNÍ ZOBRAZENA 1 STOPA FOOT. 

 

Morphingy postavy – Hlava  CHARACTER MORPHS-HEAD (orig.109) 

Prosím sledujte dále informace o nastavení póz hlavy a pararametrech tváře. 

 POZNÁMKA 
RŦZNÉ FIGURY POSERU A OSTATNÍCH TVŦRCŦ MOHOU MÍT ODLIŠNÉ MORPHINGY 
POSTAVY. E FRONTIER NEPOSKYTUJE PODPORU PRO FIGURY OSTATNÍCH TVŦRCŦ. 
PRO TECHNICKOU PODPORU PROSÍM KONTAKTUJTE VYDAVATELE, KTERÝ OSTATNÍ 
MATERIÁL POSKYTNUL. 

 

Morphingy postavy – Ruce  CHARACTER MORPHS-HAND (orig.110) 

Prosím navštivte část “Pózování rukou” na straně 81 pro informace o pózování rukou a otočných 
ovladačích parametrŧ rukou. 
 

PÓZOVÁNÍ TVÁŘÍ  POSING FACES (orig.110) 

Lidské figury Poseru 7 a mnoho figur ostatních autorŧ mají plně pohyblivé tváře, to znamená, ţe 
mŧţete měnit pozice obličejových částí jako jsou ústa, obočí, líce a oči za účelem vytvoření rŧzných 
výrazŧ tváře a za pomoci otočných ovladačŧ parametrŧ anebo nástroje morphingu Morphing Tool 
(jak je popsáno v části “Nástroj morphingu” na straně 74). 

 POZNÁMKA 
NĚKTERÉ STARŠÍ FIGURY NEMAJÍ POHYBLIVÉ TVÁŘE. 

Pokud zvolíte hlavu, v paletě parametrŧ Parameters se zobrazí série specifických otočných ovladačŧ 
pro hlavu, kaţdý ovladač nastavuje rŧzné prvky tváře. Pokud pouţíváte otočné ovladače tváře, 
myslete na to, jakou manipulací obličejového svalstva mŧţete dosáhnout konečných výsledkŧ. 

Kamera tváře Face camera pouţívá tvář vybrané figury jako centrum své rotace, coţ Vám umoţņuje 
prohlíţení póz tváře zblízka. 
 

PARAMETRY TVÁŘE  FACE PARAMETERS (orig.110) 

Parametry tváře Face parameters normálně fungují v rozsahu od 0 do 1, kde 0 znamená zcela 
vypnuto a 1 znamená zcela zapnuto. Negativní hodnoty (<0) vytvářejí invertní pózy a hodnoty větší 
neţ +/- 1 poskytují přehnané pózy. Napřiklad negativní hodnota parametru zamračení Frown vytvoří 
nepatrný úsměv. Parametry tváře Face parameters jsou morph targety, které mohou být pouţity ve 
shodě k tomu, aby tvořily výrazy tváře postavy. Prosím navštivte téma “Tvorba a použití Morph 
Targetů” na straně 117 pro informace o morph targetech a jak tyto fungují uvnitř Poseru 7. 

Figury Poseru obsahují sadu obličejových morphingŧ a parametrŧ, které Vám umoţņují vytvoření 
nekonečně mnoho variant tváří a výrazŧ. Seznam parametrŧ tváře se liší podle figury a všechny 
parametry jsou intuitivní. Pro zobrazení dostupných parametrŧ tváře zvolte hlavu poţadované figury  
a otevřete paletu parametrŧ Parameters. 

Kromě pózování tváří mŧţete také modifikovat obličejovou strukturu pomocí parametrŧ Ethnicity 
(etnika), Age (věk) a Gender (pohlaví), které jsou součástí nástrojŧ na formování obličeje Face 
Shaping tool v místnosti tváře Face room. Viz “Nástroje na formování tváře” na straně 153 pro více 
informací o nástrojích na formování obličeje. 
 

TVÁŘE & ARTIKULACE  FACES & PHONEMES (orig.110) 

Artikulace je termín pro pozici jazyku, rtŧ a zubŧ při vytváření hlasu. Vytvoření určitého zvuku si 
vyţádá určitou pozici úst a jazyku. Spojování artikulací dohromady je to, co vytváří řeč. 
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Poser 7 umoţņuje tvorbu vizuálních artikulací pro přesnou simulaci řeči. Toto je uţitečná funkce 
v případě, kdy přidáváte zvuk do scény (jako je řeč). Simulaci řeči vytvoříte za pomoci kombinace 
rŧzných artikulací a kličových snímkŧ keyframes, pro synchronizaci pohybŧ úst figury se zvukem. 
Talk Designer Poseru 7 generuje synchronizované animace úst v souladu s Vašim nastavením 
v paletě Talk Designer. Pro informace o Talk Designeru navštivte téma “Použití designeru řeči” na 
straně 101. 
 

PÓZOVÁNÍ OČÍ  POSING EYES (orig.111) 

Pro nastavení pózy očí je vyberte buď pomocí editačních nástrojŧ Editing tools, nebo rozbalovacího 
menu Current Actor a nastavte jejich pozici pomocí kliknutí a taţení, nebo za pouţití otočných 
ovladačŧ parametrŧ. 
 

PÓZOVÁNÍ RUKOU  POSING HANDS (orig.111) 

Mnoho figur Poseru mají plně pohyblivé ruce. Pokud pohnete prstem, odpovídající kloub(y) se ohne. 
Pro většinu těchto figur a pro starší figury Poseru mŧţete nastavovat pózu rukou bez nutnosti 
postupného nastavování kloubŧ ruky, a to aplikací připravených póz rukou z palety knihoven Library. 

Kamery levé ruky Left Hand camera a pravé ruky Right Hand camera pouţívají ruce vybrané figury 
jako centrum své rotace, coţ Vám umoţņuje vytváření precizních póz rukou. 

Pouţijte editační nástroje Editing tools pro nastavení pózy rukou stejně jako u ostatních částí 
postavy. Prosím navštivte téma “Editační nástroje” na straně 71 pro informace o pouţití editačních 
nástrojŧ Editing tools. Také mŧţete aplikovat uloţené pózy rukou pro kaţdou figuru Poseru 7 za 
pouţití kategorie Hands v paletě knihoven Library, stejně jako u jiných póz. 

Pokud vyberete hlavní část ruky (označená jako Left Hand a Right Hand v menu Item Select), 
zobrazí se speciální sada otočných ovladačŧ ruky v paletě parametrŧ Parameters. Tyto ovladače jsou 
následující: 

o Grasp: Otočný ovladač parametru Grasp nastavuje, jak pevně je ruka/pěst sevřena. 

o Thumb: Otočný ovladač parametru Thumb pohybuje palcem ruky. Vyšší hodnoty pohybují palcem 
směrem k ruce, a naopak. 

o Spread: Otočný ovladač parametru Spread nastavuje velikost roztaţení ruky. Vyšší hodnoty 
roztahují ruku, a naopak. 

 

POUŢITÍ MODELU RUKY  USING THE HAND MODEL (orig.111) 

Poser 7 obsahuje modely levé a pravé ruky, které umoţņují vytvoření pózy rukou bez nutnosti pouţití 
figury. Tyto vypadají jako ruce bez těla plovoucí v pracovním prostoru Poseru 7. Tyto modely rukou 
mŧţete pouţít pro vytvoření póz rukou, které mŧţete následně vloţit do palety knihoven Library. 
 

POUŢITÍ ULOŢENÝCH PÓZ RUKOU  USING PRESET HANDS (orig.112) 

Jakmile vytvoříte pózu ruky, mŧţete ji uloţit do kategorie Hands v paletě knihoven Library. Pózy 
rukou jsou podskupinami póz figur, to znamená, ţe pózy figur obsahují také nastavení rukou, ale pózy 
rukou nemohou obsahovat nastavení celých figur. 

 POZNÁMKA 
SLOŢKA HANDS KNIHOVNY LIBRARY OBSAHUJE RŦZNÉ SUBKATEGORIE. POKUD 
VYBÍRÁTE PÓZY RUKOU PRO VAŠI FIGURU(Y), VYBÍREJTE OPATRNĚ SUBKATEGORII, ZE 
KTERÉ POLOŢKU VYBÍRÁTE, PROTOŢE PRO ODPOVÍDAJÍCÍ FIGURU MŦŢETE APLIKOVAT 
POUZE SPECIFICKÉ PÓZY RUKOU. NAPŘÍKLAD PRO FIGURY POSERU 2 MŦŢETE 
APLIKOVAT POUZE PÓZY RUKOU POSERU 2. 

Pro pouţití uloţených póz rukou: 

1. Klikněte na figuru pro její výběr. 

2. Otevřete paletu knihoven Library a následně otevřete kategorii Hands a poţadovanou 
subkategorii. 
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3. Poklikejte na pózu, kterou si přejete pouţít. Následně zobrazený dialog se Vás zeptá, zda si 
přejete pózu aplikovat na levou nebo pravou ruku. Vyberte poţadovanou volbu a klikněte na OK. 

 

PÓZOVÁNÍ ZVÍŘAT  POSING ANIMALS (orig.112) 

Zvířata mŧţete pózovat stejným zpŧsobem jako osoby. Zvířata 
mají své vlastní nastavení IK, zón ohybu a limitŧ. Například pokud 
u modelu koně posunete boky (hip) směrem dolŧ k zemi, 
nevytvoříte sed zvířete tak, jako u lidské figury. Editační nástroje, 
otočné ovladače parametrŧ, menu, atd. Všechno funfuje stejným 
zpŧsobem jako u lidských figur. Technicky řečeno, zvířata a lidské 
figury jsou identické a Poser 7 nedělá ţádné rozdíly mezi nimi.  

 POZNÁMKA 
SKUPINA ZVÍŘECÍCH FIGUR DODÁVANÝCH S POSEREM 7 
POUŢÍVÁ STEJNÉ OZNAČENÍ KONČETIN JAKO LIDSKÉ 
FIGURY, TAKŢE PŘEDNÍ NOHY A TLAPY JSOU 
OZNAČENY JAKO RAMENA, RUCE, DLANĚ, APOD. TO 
NEZNAMENÁ, ŢE FIGURY ZVÍŘAT BUDOU FUNGOVAT VE WALK DESIGNERU, KTERÝ BYL 
VYTVOŘEN PRO POUŢITÍ SE DVOUNOHÝMI FIGURAMI. PRO ANIMACI CHŦZE NEBO BĚHU 
ZVÍŘETE MUSÍTE KLIČOVÉ SNÍMKY KEYFRAMES VYTVOŘIT RUČNĚ. 

 

PÓZOVÁNÍ HLAV ZVÍŘAT  POSING ANIMAL HEADS (orig.112) 

Mnohé modely zvířat mají plnně pohyblivé hlavy. Například mŧţete nastavovat pózy tlamy psa a jeho 
uší. K tomu pouţijte otočné ovladače parametrŧ stejně jako u lidských figur. Dostupné ovladače 
parametrŧ u zvířecí hlavy jsou obvykle závislé na druhu zvířete. 
 

PAMĚŤOVÁ TLAČÍTKA PÓZ  POSE DOTS (orig.113) 

Mŧţete uloţit aţ devět konfigurací póz za pouţití paměťových tlačítek Memory dots (popsaných  
v části “Paměťová tlačítka” na straně 26). Kaţdé paměťové tlačítko mŧţe obsahovat jakoukoliv pózu 
zvolené figury. Tato funkce je specifická pro aktuální scénu, to znamená, ţe paměťová tlačítka póz 
nemohou být přenášena mezi rŧznými scénami. Pro uchování nastavení pózy a její dostupnost 
v jakékoliv scéně Poseru 7 musíte pózu uloţit do palety knihoven Library. 
 

ULOŢENÍ PÓZ DO PALETY KNIHOVEN LIBRARY   
SAVING POSES IN THE LIBRARY (orig.113) 

Všechny parametry jsou uloţeny společně s pozicemi částí postavy během uloţení pózy do palety 
knihoven Library. Pro uloţení pózy do palety Library: 

1. Otevřete paletu knihoven Library. 

2. Vyberte kategorii Pose a poţadovanou subkategorii. 

3. Následujte instrukce z části “Přidání položek do knihovny” na straně 33. 
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Kapitola 11: Animace pomocí Poseru 7 
ANIMATING WITH POSER 7 (orig.114) 

Poser umoţņuje animovat figury a rekvizity, coţ dodává ţivot Vašim scénám. Váš výtvor mŧţete 
pouţít v multimediálních projektech, na webu a ve videofilmech pomocí exportu renderovaných 
výstupŧ do formátŧ Windows AVI, Macintosh QuickTime nebo Flash movie. AVI videa jsou 
renderována ve 32-bitových barvách, které jsou v základu obsaţeny v alfa kanálu kaţdého snímku. 
Toto mŧţe pomoci při kompozici animace s ostatními filmy s rŧznou stopáţí. QuickTime videa také 
mohou obsahovat alfa kanál, pokud vytvoříte render v miliónech barev. 

Exportované animace mohou být otevírány a editovány v post-produkčních nástrojích jako je Adobe 
Premiere a Adobe After Effects, ve kterých mŧţete editovat sekvence a přidávat speciální efekty. 
Pokud chcete vytvářet dlouhé animace, doporučujeme vytvoření sérií kratších animací a následné 
spojení dohromady pomocí editační aplikace. Reálné filmy pouţívají toto pravidlo také: Kdykoliv se 
změní pohled kamery, budete sledovat připojený nový záběr scény nebo jinou scénu. Toto je 
pouţíváno v případech konverzace, kdy kamera přepíná sem a tam mezi diskutujícími účastníky. 
Poser 7 obsahuje mnoho výkonných nástrojŧ vytvořených pro pomoc při vytváření úţasně 
realistických animací. Animace se dá jednoduše naučit, avšak její tvorba je pracná. Začínejte 
s krátkými jednoduchými animacemi a náročnější práce vytvářejte aţ po zvýšení Vašich zkušeností. 
Výsledky Vás mohou překvapit! 
 

O ANIMACÍCH  ABOUT ANIMATIONS (org.114) 

Nejjednodušší zpŧsob vytvoření animace je následující: 

1. Rozhodněte se, kolik snímkŧ bude Vaše animace obsahovat. Jednou cestou pro zvolení celkového 
počtu snímkŧ je stanovení délky animace v sekundách a následný výpočet podle poţadovaného 
počtu snímkŧ za sekundu (obnovovací kmitočet). 

2. Vytvořte počáteční pózu. 

3. Vyberte následující kličový snímek keyframe. 

4. Vytvořte novou pózu. 

5. Opakujte kroky 3 a 4 aţ do kompletního dokončení animace. 

Poser 7 pouţívá techniku nazývanou jako animace pomocí klíčových snímkŧ pro simulaci pohybu 
zaloţenou na sériích stacionárních póz. Vytvoříte série póz v rŧzných bodech časové osy budoucí 
animace. Takto vytvořené pózy jsou klíčovými snímky keyframes. Poser 7 doplní mezery mezi 
klíčovými snímky, coţ vytvoří iluzi pohybu. Díky tomu nemusíte pohybovat postavou pokaţdé (pro 
kaţdý snímek), kdyţ potřebujete vytvořit pohyb tak, jak je to nutné u stopframe animace, kde je kaţdý 
snímek individuálně nastavován. 
 

CO MŮŢETE ANIMOVAT  WHAT YOU CAN ANIMATE (orig.115) 

Co mŧţete animovat pomocí Poseru 7? Přibliţně všechno! Zde jsou nějaké příklady: 

o Figury (osoby, zvířata, oblečení, atd.): Pokud si představíte jakýkoliv pohyb, mŧţete jej vytvořit za 
pouţití Poseru 7! Prosím navštivte kapitolu 10: “Pózování figur” na straně 69 pro informace  
o nastavování póz lidských figur a téma “Pózování zvířat” na straně 82 pro několik informací  
o nastavování póz zvířat. 

o Ruce: Gesta a drobné pohyby zvyšují realizmus videa. Mnoho amatérských animací ignoruje 
pohyby rukou (prstŧ) při animaci, které jemně ubírají z realizmu scény. Prosím navštivte téma 
“Pózování rukou” na straně 81 pro informace o nastavování póz rukou. 

o Tváře: Animace tváří přidá emoce a sílu do scény a mŧţe také napodobovat řeč. Prosím navštivte 
téma “Pózování tváří” na straně 80 pro více informací o nastavování póz tváří. 

o Rekvizity: Rekvizity mŧţete animovat pomocí jejich přesouvání v pracovním prostoru Poseru 7, 
nebo také společně s jinými prvky scény, atd. Prosím navštivte téma “O rekvizitách” na straně 105 
pro více informací o rekvizitách. 

o Deformátory: Mŧţete animovat magnety, vlny, morph targety a parametry. Prosím navštivte téma 
“Použití deformátorů” na straně 110 pro více informací o deformátorech. 
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o Silová pole: Mŧţete animovat silová pole Force Fields pro vytvoření realistických efektŧ větru  
u praménkových vlasŧ a u dynamického oblečení. Prosím navštivte téma “Silová pole větru” na 
straně 113 pro více informací o silových polích. 

o Materiály: Mŧţete animovat materiály povrchŧ prvkŧ, jak je popsáno v části 4: “Materiály” na straně 
217. 

o Trajektorie chůze: Mŧţete vytvářet trajektorie, podél kterých budou figury procházet, jak je popsáno 
v části “Vytvoření dráhy chůze” na straně 199. 

o Pozadí: Pozadí scény mŧţete animovat za pomoci místnosti materiálu Material room. Prosím 
navštivte část 4: “Materiály” na straně 217 pro více informací o mistnosti materiálu Material room. 

o Movie nodes: Mŧţete přehrávat video na povrchu libovolného objektu za pouţití video uzlŧ movie 
nodes v místnosti materiálu Material room. 

 

ANIMAČNÍ NÁSTROJE  ANIMATION TOOLS (orig.115) 

Poser 7 obsahuje pět animačních nástrojŧ: 

o Ovladače animace: Ovladače animace Animation controls se nacházejí ve spodní části 
pracovního prostoru Poseru 7, jak je popsáno v části “Použití ovladačů animace” na straně 85  
a umoţņují vytváření rychlých animací pomocí kliknutí a taţení, stejně jako prohlíţení Vaší práce. 
Zpřístupnění ovladačŧ animace Animation controls je moţné pomocí kliknutí na madlo ve spodní 
části pracovního prostoru Poseru 7. 

o Paleta animace: Paleta animace Animation palette obsahuje většinu funkcí pro editaci animace 
Poseru 7, se kterými mŧţete vytvářet více komplexní animace. Kromě jiného mŧţete editovat 
klíčové snímky keyframes, animační vrstvy, individuální prvky a vytvářet sestavy Animation Sets. 
Přístup k paletě animace je pomocí volby Window>Animation Palette. Prosím navštivte téma 
“Použití palety animace” na straně 87 pro více informací o paletě animace Animation palette. 

o Graf: Kaţdý prvek Vaší scény má graf Graph pro kaţdý z jeho moţných pohybŧ, dovolující Vám 
přesné ovládání animace. Zpřístupnění grafu pro kaţdý parametr je moţné pouţitím menu 
poţadovaného ovladače parametrŧ, jak je popsáno v části “Paleta parametrů” na straně 77. 
Prosím navštivte téma “Použití grafů” na straně 96 pro více informací o grafu Graph. 

o Walk Designer: Vytvoření realistického pohybu při chŧzi je jedna z nejtěţších otázek animace. 
Walk Designer Poseru 7 přebírá námahu z tohoto procesu a umoţņuje rychlé vytvoření realistické 
chŧze (jen pro lidské figury). Přístup do Walk Designeru je moţný volbou Window>Walk 
Designer. Prosím navštivte téma “Použití designeru chůze” na straně 98 pro více informací  
o Walk Designeru. 

o Talk Designer: Řeč je jedním z nejzajímavějších aspektŧ mnoha animací; v závislosti na 
komplexnosti lidské tváře je také jednou z největších výzev realistických animací. Talk Designer 
Poseru 7 animuje výrazy tváře, očí a pohyby hlavy pro vytvoření realistických pohybŧ rtŧ, 
synchronizovaných s importovanými zvukovými soubory řeči. Přístup do Talk Designeru je moţný 
pomocí volby Window>Talk Designer. Prosím navštivte téma “Použití designeru řeči” na straně 
101 pro více informací o Talk Designeru. 

 

INTERPOLACE  INTERPOLATION (orig.116) 

Proces vyplnění prázdných snímkŧ mezi klíčovými snímky keyframes je nazýván interpolace  
a snímky mezi keyframes jsou nazývány tweens. Interpolace určuje, kolik přechodných póz je 
vytvořeno. Prosím navštivte Poser 7 Tutorial Manual, “Basic 3D Elements: Splines” pro hlavní diskusi 
o interpolaci. Poser 7 podporuje čtyři typy interpolace. Nastavení interpolace je aplikováno na určitý 
rozsah snímkŧ, to znamená, ţe pro rŧzné intervaly animace mŧţete pouţít rŧzné interpolační metody. 
Čtyři typy dostupných interpolací animací Poseru 7 jsou: 

o Spline: Umístí tween pózy a nastavení na časovou křivku. Pohyb začíná jedním klíčovým snímkem 
keyframe, akceleruje do plné rychlosti a postupně se zpomalí, jak se blíţí k dalšímu keyframe. 
Pokud například první keyframe obsahuje figuru s rukama podél těla a další obsahuje figuru se 
zvednutýma rukama, ruce se začnou pohybovat pomalu nahoru, akcelerují aţ dosáhnou konstatní 
rychlosti a opět zpomalí před dosaţením druhého keyframe. To neznamená, ţe tento pohyb musí 
být rychlý; aktuální rychlost pohybu závisí na velikosti změny pozice pohybujícího se prvku mezi 
klíčovými snímky keyframes a na počtu přechodových snímkŧ tween frames.  
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Pokud ve výše uvedeném příkladě bude vzdálenost 
druhého klíčového snímku 5 snímkŧ od prvního, bude 
vytvořen velmi rychlý pohyb. Pokud bude vzdálenost 
mezi klíčovými snímky 100 snímkŧ, vytvořený pohyb 
bude velmi pomalý. Klíčovou věcí pro zapamatování  
u tohoto typu animace je, ţe pohyb po hladké časové 
křivce je více realistický.  

 
o Linear: Pouţije dva klíčové snímky keyframes  

a rozdělí pohyb mezi ně rovnoměrně bez zrychlení  
a zpomalení pohybujícího se prvku. Ve výše 
uvedeném případě se za pouţití této interpolace 
budou ruce postavy pohybovat konstantní rychlostí od 
keyframe do keyframe. Pokud vytvoříte třetí 
keyframe s rukama figury opět dole, změna pohybu 
rukou ve druhém keyframe bude prudká. 

 
o Constant: Tato interpolace nevytváří ţádné přechodné 

pózy. Pokud sestavíte sérii póz s rŧznými klíčovými 
snímky keyframes, první póza bude udrţována beze 
změny aţ do doby dosaţení druhého keyframe, ve 
kterém se okamţitě změní do druhé pózy, která bude 
opět udrţována do doby dosaţení třetího keyframe,  
a tak dále. 

 
 

o Break Spline: Zastaví interpolaci ve zvoleném bodě 
tak, aby jste mohli zahájit novou interpolaci v jiném 
stylu. Toto je uţitečné při směšování rŧzných stylŧ 
interpolací. Například poskakující míč se pohybuje po 
hladkém oblouku aţ narazí na podlahu. V tomto bodě 
dochází k náhlé změně směru pohybu a rychlosti 
míče. Toto je jeden příklad, kdy změna stylu 
interpolace mŧţe pomáhat Vaší animační práci. 

V základním nastavení se Vaše animace pohybuje před pozadím pracovního okna Document. Pozadí 
scény mŧţe být stacionární nebo animované. Prosím navštivte téma “Import obrázků na pozadí” na 
straně 186 a téma “Import videosouborů” na straně 186 pro více informací o pozadích scén Poseru 7. 
 

INVERZNÍ KINEMATIKA  INVERSE KINEMATICS (orig.117) 

IK mŧţete nebo nemusíte pouţít ve Vašich animacích, ať tak nebo onak je to globální nastavení. 
Pokud je IK aktivována, je funkční po celou dobu animace, a naopak. Během práce ji mŧţete zapínat 
a vypínat, ale jen poslední nastavení bude pouţito ve finální animaci. Přepínání IK mŧţe ovlivnit Vaši 
animaci; nejlepší je nastavení pouze jedné volby tak, aby jste předešli neočekávaným změnám 
pohybu během animace. Prosím navštivte téma “Inverzní kinematika (IK)” na straně 69 pro více 
informací o inverzní kinematice Inverse Kinematics. 
 

POUŢITÍ OVLADAČŮ ANIMACE  USING THE ANIMATION CONTROLS (orig.118) 

Ovladače animace Animation controls se nacházeji ve spodním okraji pracovního prostoru Poseru 7 
a obsahují nejvíce pouţívané nástroje při tvorbě animací. Umoţņují přidávání a editaci klíčových 
snímkŧ keyframes a náhled animace. Ovladače animace vypadají následovně: 

 
 

INDIKÁTOR ČASOVÉ OSY/SNÍMKU  TIMELINE/FRAME INDICATOR (orig.118) 
Střední část ovladačŧ animace zobrazuje časovou osu Timeline, která reprezentuje celkový čas Vaší 
animace v Poseru 7. Tato časová osa obsahuje ukazatel (jezdec) reprezentující pozici aktuálního 
snímku, který je zobrazen v pracovním okně Document, relativně vzhledem k celé animaci. Ukazatel 
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je velmi často pouţíván pro rychlé nalezení poţadovaného bodu uvnitř animace. Klikněte a táhněte 
ukazatelem pro rychlé procházení animací. 

Těsně nad indikátorem časové osy je indikátor snímku Frame Indicator, který zobrazuje celkový 
počet snímkŧ animace a číslo aktuálně zobrazeného snímku animace, přičemţ levé políčko zobrazuje 
pozici a pravé políčko zobrazuje délku animace. Kdyţ například na indikátoru přečtete čísla 60 a 120, 
znamená to, ţe máte zobrazen šedesátý snímek animace o délce 120 snímkŧ. 

Na poţadovaný snímek mŧţete přímo přeskočit pomocí kliknutí na levé číselné políčko a zadání 
odpovídajícího čísla snímku, na který si přejete přeskočit. Mŧţete také přidávat a odstraņovat snímky 
pomocí kliknutí na pravé číselné políčko a zadání poţadovaného celkového počtu snímkŧ animace. 
Zadáním většího počtu snímkŧ se animace prodluţuje, a naopak. Zkrácením animace dojde 
k odstřihnutí přebytečných snímkŧ z konce animace. Pokud například redukujete animaci ze 120 na 
90 snímkŧ, dojde ke ztrátě posledních 30 snímkŧ. 
 

OVLADAČE PŘEHRÁVÁNÍ  PLAY CONTROLS (orig.119) 

Ovladače přehrávání Play controls se nacházejí na levé straně ovladačŧ animace a umoţņují 
prohlíţení animace za pouţití obdobných ovladačŧ jako u videorekordéru. Ovladače přehrávání zleva 
doprava jsou následující: 

o First Frame: Kliknutím na tlačítko First Frame se přesunete na první snímek animace. 

o End Frame: Kliknutím na tlačítko End Frame se přesunete na poslední snímek animace. 

o Stop: Kliknutím na tlačítko Stop dojde k zastavení přehrávání animace na aktuálním snímku. 

o Play/Pause: Kliknutím na tlačítko Play dojde ke spuštění přehrávání animace normální rychlostí 
včetně videa na pozadí a zvukŧ (pokud je animace obsahuje). Pokud probíhá přehrávání animace, 
tlačítko se změní na tlačítko Pause. Kliknutím na něj dojde ke zmrazení animace na aktuálním 
snímku. 

o Step Backward: Kliknutím na tlačítko Step Backward se animace přesune zpět na předchozí 
snímek (snímek před aktuálním snímkem). 

o Step Forward: Kliknutím na tlačítko Step Forward se animace přesune dopředu na následující 
snímek (snímek za aktuálním snímkem). 

o Loop: Označením tlačítka předvolby Loop umoţníte plynulé opakované přehrávání animace aţ do 
kliknutí na tlačítko Stop. 

Náhled animace probíhá v pracovním okně Document. Ujistěte se, ţe máte nastavený odpovídající 
mód sledování cíle (viz “Mód sledování cíle” na straně 45). 
 

ZAZNAMENÁVÁNÍ KLÍČOVÝCH SNÍMKŮ KEYFRAMES   
RECORDING KEYFRAMES (orig.119) 

Poser 7 zaznamenává změny vytvořené na figurách, rekvizitách, materiálech, atd. do klíčových 
snímkŧ keyframes. Klíčové snímky vytvoříte přesunutím ukazatele časové osy do nového bodu  
a provedením poţadované změny scény. Zaznamenané keyframes obsahují nové pozice částí 
postavy, nové pozice rekvizit, materiálové nastavení, atd. pro kaţdou figuru a rekvizitu uvnitř scény. 
Pro kaţdý daný keyframe mŧţete zaznamenat pouze jedno nastavení pozic parametrŧ prvkŧ. Pokud 
například vyberete snímek a posunete rukou figury nahoru, pak změníte názor a posunete rukou opět 
dolŧ, pouze spodní pozice ruky bude zaznamenána a bude ovlivņovat animaci. Pro vytvoření 
plynulého pohybu ruky figury nahoru a dolŧ: 

1. Vytvořte startovní pózu. 

2. Přesuņte posuvník na časový bod/snímek, který si přejete editovat. 

3. Zvedněte ruku postavy za pouţití editačních nástrojŧ Editing tools. 

4. Přesuņte posuvník na další časový bod/snímek. 

5. Dejte ruku postavy opět dolŧ za pouţití editačních nástrojŧ. 

6. Pokračujte v tvorbě keyframes dokud pohybová sekvence nebude kompletní. 
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 POZNÁMKA 
U VYBRANÉ KAMERY MUSÍ BÝT AKTIVOVÁNA FUNKCE ANIMACE KAMERY ZA ÚČELEM 
AUTOMATICKÉHO ZAZNAMENÁNÍ KLÍČOVÝCH SNÍMKŦ KEYFRAMES. POKUD JE ANIMACE 
KAMERY ZAKÁZÁNA, MŦŢETE KEYFRAMES PRIDAT MANUÁLNĚ (VIZ NÁSLEDUJÍCÍ 
PODSEKCE). 

 

OVLADAČE KLÍČOVÝCH SNÍMKŮ  KEYFRAME CONTROLS (orig.120) 

Ve většině případech Poser 7 automaticky zaznamenává klíčové snímky keyframes při vytváření 
animace. Někdy však budete nuceni keyframes přidat manuálně, například v případě, kdy je 
zakázána animace kamery. Moţná budete také potřebovat animaci jemně doladit, coţ je moţné učinit 
vloţením dodatečných keyframes. Pozici levé nohy figury mŧţete například nastavit ve snímcích 10  
a 20, mezi kterými pozice nohy dopočítá Poser 7 a vytvoří odpovídající tween frames. Pokud 
potřebujete vypočtený pohyb zdokonalit, mŧţete přidat keyframe do snímku 15. 

Ovladače klíčových snímkŧ Keyframe controls umoţņují rychle a jednoduše přidávat, prohlíţet  
a odstraņovat keyframes uvnitř Vaší animace. Ovladače klíčových snímkŧ zleva doprava jsou: 

o Previous Keyframe: Tlačítko Previous Keyframe vrací zobrazení na předcházející klíčový snímek 
keyframe. 

o Next Keyframe: Tlačítko Next Keyframe přesouvá pohled na následující klíčový snímek keyframe. 

o Edit Keyframes: Kliknutím na tlačítko Edit Keyframes se zobrazí paleta animace Animation 
palette, která je podrobně popsána dále. 

o Add Keyframe: Kliknutím na tlačítko Add Keyframe dojde k přidání klíčového snímku keyframe 
pod aktuální číslo snímku. Pokud například máte existující keyframes ve snímcích 15 a 30, 
mŧţete táhnout ukazatelem časové osy na snímek 22 a keyframe vloţit pomocí kliknutí na tlačítko 
Add Keyframes. Klíčový snímek mŧţete také vloţit pomocí přesunu na libovolný snímek animace 
a provedením změny ve scéně. Tato změna bude automaticky zaznamenána jako nový klíčový 
snímek keyframe. 

o Remove Keyframe: Kliknutím na tlačítko Remove Keyframe dojde k odstranění aktuálně 
vybraného klíčového snímku. Pokud například má Vaše postava ruce nad hlavou ve snímku 1, 
dole ve snímku 15 a rozpaţené ve snímku 30 a Vy odstraníte keyframe ve snímku 15, ruce 
postavy se budou pohybovat do boku do pozice specifikované ve snímku 30 bez předchozího 
spuštění rukou do spodní pozice. Pro vymazání konkrétního klíčového snímku pouţijte tlačítka 
Next Keyframe nebo Previous Keyframe pro lokalizaci poţadovaného keyframe a následně 
klikněte na tlačítko Remove Keyframe. 

 

POUŢITÍ PALETY ANIMACE  USING THE ANIMATION PALETTE (orig.121) 

Paleta animace Animation palette obsahuje tři záloţky: záloţku Keyframes, záloţku Layers  
a záloţku Animation Sets. Kaţdá z těchto záloţek bude detailně popsána v následujících částech. 
Pro zobrazení palety animace mŧţete například pouţít volbu Window>Animation Palette, nebo 
klikněte na tlačítko Edit Keyframes v ovladačích animace Animation controls jak je popsáno výše. 
Pro uzavření palety opětovně zvolte Window>Animation Palette, nebo klikněte na malý čtvereček 
v pravém horním rohu palety. 

Horní část palety animace Animation palette obsahuje několik ovladačŧ, které jsou zobrazeny ve 
všech třech záloţkách palety. Jedná se o následující ovladače: 
 

Aktuální vrstva  CURRENT LAYER (orig.121) 

Rozbalovací menu aktuální vrstvy Current Layer je zobrazeno v nejvyšší části palety animace 
Animation palette. Toto menu umoţņuje výběr specifické vrstvy animace uvnitř aktuální animace. 
Prosím navštivte téma “Záložka vrstev” na straně 92 pro více informací o vrstvách animace. 
 

Obnovovací kmitočet  FRAME RATE (orig.121) 

Obnovovací kmitočet Frame Rate specifikuje počet snímkŧ přehrávaných za sekundu. Pro změnu 
obnovovacího kmitočtu klikněte na políčko zobrazující aktuální kmitočet a zadejte poţadovanou 
hodnotu do následně zobrazeného textového pole, nebo klikněte na šipku nalevo od ovladače 
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obnovovací frekvence a vyberte poţadovanou hodnotu z rozbalovacího menu Frame Rate. Některé 
často pouţívané obnovovací kmitočty jsou: 

o NTSC: 30 

o PAL: 25 

o Film: 24 

o Flash: 12 (doporučeno) nebo 15 

Výstupní obnovovací kmitočet mŧţete také nastavit pomocí okna nastavení videa Movie Settings 
(Kapitola 39: “Rendering animací” na straně 262). Toto nastavení je závislé na obnovovacím kmitočtu 
scény specifikovaném v paletě animace Animation palette (viz výše). Také mŧţete generovat rychlý 
náhled renderu pomocí specifikace nastavení Every N-th Frame v okně nastavení videa Movie 
Settings. 
 

Čas  TIME (orig.121) 

Ovladač času Time zobrazuje časový úsek Vaší animace mezi prvním snímkem a aktuálně 
zobrazeným snímkem. Čas je zobrazen ve formátu SMTPE (Hodiny:Minuty:Sekundy:Snímek). Mŧţete 
přímo přeskočit do specifického časového bodu zadáním poţadované číselné hodnoty do 
odpovídajících políček. Pokud například přeskočíte do času 1 minuta v animaci pouţívající 24 snímkŧ 
za sekundu, obdrţíte snímek 1440 (24 snímkŧ/sec násobeno 60 sekundami). 
 

Snímek  FRAME (orig.122) 

Indikátor snímku Frame Indicator je identický se svým protějškem v ovladačích animace. Mŧţete 
přeskočit na specifický snímek a přidávat nebo odstraņovat snímky z Vaší animace tak, jak je to 
popsáno v části “Indikátor časové osy/snímku” na straně 85. 
 

Ovladače přehrávání  PLAY CONTROLS (orig.122) 

Ovladače přehrávání Play Controls jsou identické se svými protějšky v ovladačích animace. Viz téma 
“Ovladače přehrávání” na straně 86 pro více informací. 
 

VÝBĚR PŘEHRÁVANÉHO ÚSEKU  SELECTING THE PLAY RANGE (orig.122) 

V základním nastavení je při prohlíţení přehrávána celá animace za pomoci ovladačŧ přehrávání Play 
controls (viz “Ovladače přehrávání” na straně 86). Navíc však mŧţete při náhledu animace přehrávat 
jen určitý vybraný úsek animace. Tato moţnost je uţitečná v případě dlouhé animace  
a umoţņuje zobrazení malého časového úseku animace. Indikátor přehrávaného úseku Play Range 
se nachází ve spodní části všech tří záloţek palety animace Animation palette. Pro nastavení 
přehrávaného úseku táhněte počátečním anebo koncovým bodem indikátoru na pozici počátečního  
a koncového snímku. 
 

ZÁLOŢKA KLÍČOVÝCH SNÍMKŮ  KEYFRAMES TAB (orig.123) 

Záloţka klíčových snímkŧ Keyframes je určena k editaci kličových snímkŧ ve Vaší animaci. Ukazuje 
rozvrţení klíčových snímkŧ a umoţņuje jejich nastavování a přesouvání. Přímo z této palety mŧţete 
animace také přehrávat. Záloţka Keyframes vypadá následovně: 
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Pokud tuto záloţku zobrazíte poprvé, bude zobrazovat všechny klíčové snímky, které jste předtím 
vytvořili pomocí ovladačŧ animace Animation controls pro aktuálně vybranou vrstvu animace. 
Prosím navštivte téma “Záložka vrstev” na straně 92 pro více informací o vrstvách animace. Pokud si 
přejete zobrazit klíčové snímky obsaţené uvnitř jiné animační vrstvy, vyberte jmeno nové vrstvy 
z rozbalovacího menu Current Layer. Kromě ovládacích prvkŧ popsaných výše, záloţka Keyframes 
obsahuje následující prvky: 
 

Předvolby palety animace  ANIMATION PALETTE OPTIONS (orig.123) 

Kliknutím na šipku předvoleb v pravém horním rohu záloţky Keyframes dojde k otevření menu 
předvoleb palety animace Animation palette Options menu, které obsahuje následující předvolby: 

o Display Frames: Výběrem předvolby Display Frames se zapíná zobrazení snímkŧ animace ve 
sloupcích časové osy Timeline. 

o Display Time Code: Výběrem předvolby Display Time Code zobrazíte ve sloupcích časové osy 
Timeline časové hodnoty běhu animace. 

o Loop Interpolation: Výběrem předvolby Loop Interpolation se zapíná a vypíná opakovaná 
interpolace v nepřetrţité smyčce. Prosím navštivte téma “Interpolace smyčky” na straně 211 pro 
více informací. 

o Quaternion Interpolation: Výběrem předvolby Quaternion Interpolation se zapíná a vypíná 
„čtyřková interpolace“. Prosím navštivte téma “Čtyřková interpolace” na straně 211 pro více 
informací. 

 
Ovladače klíčových snímků  KEYFRAME CONTROLS (orig.124) 

Ovladače klíčových snímkŧ Keyframe controls jsou identické se svými protějšky v ovladačích 
animace Animation controls. Viz “Ovladače klíčových snímků” na straně 87 pro více informací. 
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Ovladače interpolace  INTERPOLATION CONTROLS (orig.124) 

Ovladače interpolace Interpolation controls umoţņují specifikovat metodu interpolace (viz Poser 7 
Tutorial Manual, “Basic 3D Elements: Splines” pro informaci o typech interpolace Poseru 7): 

Tlačítka zleva doprava jsou následující: 

o Spline Section: Kliknutím na tlačítko Spline Section bude aktivován 
mód interpolace po křivce Spline. 

o Linear Section: Kliknutím na tlačítko Linear Section bude aktivován mód konstantní interpolace 
Linear. 

o Constant Section: Kliknutím na tlačítko Constant Section bude aktivován mód interpolace 
Constant. 

o Break Spline: Kliknutím na tlačítko Break Spline přerušíte aktuální interpolaci po křivce ve 
vybraném snímku, coţ umoţņuje v tomto bodě změnit metodu interpolace. 

 
Přeskočení snímků  SKIP FRAMES (orig.124) 

Kliknutím na tlačítko předvolby Skip Frames aktivujete funkci pro vynechání zvolených snímkŧ při 
přehrávání náhledu animace, coţ urychluje přehrávání. Opětovným kliknutím na tlačítko se funkce 
vypne. 
 

Smyčka  LOOP (orig.124) 

Kliknutím na tlačítko předvolby Loop bude aktivováno kontinuální přehrávání animace do té doby, neţ 
kliknete na tlačítko Stop. Opětovným kliknutím a tlačítko předvolby se funkce smyčky vypíná. 
 

Tento prvek/Všechny prvky  THIS ELEMENT/ALL ELEMENTS (orig.125) 

Tato poloţka definuje, zda změny provedené pomocí záloţky Keyframes (módy interpolace, změny 
keyframe, atd.) budou aplikovány na celou scénu nebo jen na vybraný prvek.  

Odpovídající volbu provedete kliknutím na tlačítko předvolby 
This Element (tento prvek) nebo All Elements (všechny prvky). 
 

Seznam prvků/Časová osa  ELEMENTS LIST/TIMELINE (orig.125) 

Seznam prvkŧ Elements List zobrazuje seznam všech prvkŧ scény. Prostor časové osy Timeline 
Area zobrazuje snímky animace a všechny klíčové snímky uloţené pro všechny části postavy, 
rekvizity, materiály, apod. Klíčové snímky jsou zobrazeny červeně, interpolované snímky tween 
frames jsou zobrazeny rŧznými barvami v závislosti na typu interpolace (viz Poser 7 Tutorial Manual, 
“Basic 3D Elements: Splines”). Prvky seznamu mŧţete rozbalovat nebo sbalovat kliknutím na 
trojŧhelník před prvkem v seznamu. Kaţdý prvek mŧţe být dále rozbalován pro zobrazení vlastností  
a parametrŧ, které mohou být animovány. U předloktí figury mŧţete například vidět prvky Scale  
a Transition. Následující obrázek zobrazuje část seznamu prvkŧ Elements List scény: 

 
 
Pro výběr prvku klikněte na seznam prvkŧ Element List. Tímto vyberete poţadovaný prvek, stejně 
jako pomocí kliknutí na něj v pracovním okně Document, pouţitím menu aktuálního prvku Current 
Actor nebo výběrem za pouţití jakékoliv další dostupné metody výběru. Poser 7 zvýrazní aktuálně 
vybraný prvek v seznamu prvkŧ Elements List, stejně jako řádek prvku na časové ose Timeline. Pro 
zobrazení všech prvkŧ scény pouţíjte vertikální posuvník na pravé straně seznamu prvkŧ Elements 
List. Moţnost sbalení stromové struktury seznamu prvkŧ šetří prostor pro zobrazení. 

 POZNÁMKA 
POKUD SBALÍTE STRUKTURU PRVKU FIGURY V SEZNAMU PRVKŦ, BUDOU ZOBRAZENY 
KLÍČOVÉ SNÍMKY PATŘÍCÍ POUZE K UMÍSTĚNÍ FIGURY  V PRACOVNÍM PROSTORU 
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POSERU 7. PRO ZOBRAZENÍ ZMĚN PÓZY/PARAMETRU MUSÍTE STRUKTURU PRVKU 
ROZBALIT. 

Dvojitým kliknutím na prvek v seznamu nebo výběrem prvku a kliknutím na tlačítko Show Graph, 
dojde k otevření grafu Graph pro vybraný prvek. Prosím navštivte téma “Použití grafů” na straně 96. 
 

EDITACE KLÍČOVÝCH SNÍMKŮ POMOCÍ ČASOVÉ OSY  
EDITING KEYFRAMES ON THE TIMELINE (orig.126) 

Časovou osu Timeline mŧţete pouţít pro výběr, přidání, editaci, nebo pro odstranění klíčových 
snímkŧ keyframes. Časová osa vypadá jako mříţka, které zobrazuje klíčové snímky pro kaţdý prvek 
scény. Sloupce indikují čas, kde kaţdý sloupec odpovídá jednomu snímku animace nebo časovému 
bodu (Viz “Seznam prvků/Časová osa” na straně 90). Pravítko v horní části plochy časové osy 
zobrazuje, zda sloupce indikují snímky, nebo časové body. Kaţdý řádek odpovídá jednomu prvku 
scény. Jak je popsáno výše, časová osa prezentuje informace za pouţití barevných kódŧ. Podle 
potřeby pouţijte horizintální anebo vertikální posuvníky pro přesun v časové ose Timeline. 
 

VÝBĚR KLÍČOVÝCH SNÍMKŮ  SELECTING KEYFRAMES (orig.126) 

Při základním nastavení Poser 7 vybírá první snímek animace (Frame 1) 
během otevření palety animace Animation palette. Libovolný snímek pak 
mŧţete vybrat pomocí kliknutí nad nebo do odpovídajícího sloupce. Také 
mŧţete přímo zadat odpovídající číslo snímku do políčka Frame. Pokud 
vyberete klíčový snímek keyframe, Poser 7 jej zobrazí jako prŧsečík řádky 
aktuálního prvku a časového sloupce.  

Výběrem dalšího klíčového snímku se prŧsečík přesune do nově vybraného bodu. Pro výběr 
klíčového snímku klikněte na jeden z tmavě červených čtverečkŧ mříţky časové osy Timeline. 
 

PŘIDÁVÁNÍ A ODSTRAŇOVÁNÍ KLÍČOVÝCH SNÍMKŮ  
ADDING & REMOVING KEYFRAMES (orig.126) 

Přidáním klíčového snímku uchováte specifickou pózu, anebo uloţíte Poserem 7 vytvořený, 
interpolovaný (tween) snímek. Klíčové snímky keyframes mŧţete přidávat pro celou scénu nebo pro 
vybraný prvek za pomoci označení tlačítka předvolby This Element (tento prvek), nebo All Elements 
(všechny prvky), jak je popsáno v části “Tento prvek/Všechny prvky” na straně 90. Pokud je vybrán 
This Element, klíčové snímky jsou zaznamenány pouze pro aktuálně vybraný prvek. Pokud je 
vybráno All Elements, klíčové snímky jsou zaznamenány pro kaţdý prvek scény. Pro přidání 
klíčového snímku: 

1. Podle potřeby označte předvolbu This Element, nebo All Elements. 

2. Zvolte snímek, nebo časový bod, ve kterém si přejete vytvořit klíčový snímek keyframe. 

3. Klikněte na tlačítko Add Keyframes. 
 

Odstranění individuálních klíčových snímků   
REMOVING INDIVIDUAL KEYFRAMES (orig.126) 

Odstraněním klíčových snímkŧ mŧţete měnit vzhled animace. Mŧţete vymazat klíčový snímek 
specifického prvku nebo celé scény odpovídajícím označením tlačítka předvolby This Element (tento 
prvek), nebo All Elements (všechny prvky). Odstraněním klíčového snímku keyframe nedojde ke 
smazání snímku frame, ale pouze k odstranění uloţených informací. Pro odstranění klíčového 
snímku: 

1. Podle potřeby označte předvolbu This Element, nebo All Elements. 

2. Zvolte snímek, nebo časový bod, ve kterém si přejete vymazat klíčový snímek keyframe. 

3. Klikněte na tlačítko Delete Keyframes. 
 

Odstranění více klíčových snímků najednou  REMOVING MULTIPLE KEYFRAMES (orig.127) 

Pro odstranění více klíčových snímkŧ v určitém rozpětí, klikněte a táhněte časovou osou přes klíčové 
snímky, které chcete vymazat a stiskněte klávesu [DEL]. Pro odstranění většího počtu rŧzně 
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rozmístěných klíčových snímkŧ během jejich výběru stiskněte a drţte klávesu [SHIFT] a následně 
stiskněte klávesu [DEL]. 
 

PŘESOUVÁNÍ KLÍČOVÝCH SNÍMKŮ  MOVING KEYFRAMES (orig.127) 

Během vytváření animace se mŧţete rozhodnout pro dřívější nebo pozdější zobrazení jednoho nebo 
více klíčových snímkŧ oproti pŧvodnímu nastavení. Také si mŧţete přát aplikaci nastavení některých 
klíčových snímkŧ do dalších. Poser 7 umoţņuje přesouvání jednoho nebo více klíčových snímkŧ 
najednou. Toho docílíte kliknutím na klíčový snímek, který si přejete přesunout a přetaţením 
barevného políčka horizontálně do nové pozice. Pro přesunutí většího počtu klíčových snímkŧ je 
vyberte a výběr táhněte do nové pozice na časové ose. 
 

KOPÍROVÁNÍ KLÍČOVÝCH SNÍMKŮ  COPYING KEYFRAMES (orig.127) 

Mŧţete kopírovat klíčová snímky keyframes, části figury a parametry obsaţené v seznamu prvkŧ 
Element List. Toto vyuţijete, pokud máte například několik figur Poseru pochodujících stejným 
krokem. Přestoţe Poser 7 neomezuje zpŧsob kopírování a vkládání klíčových snímkŧ, měli byste se 
vyvarovat míchání dat (například kopírování parametru Scale do parametru Rotation). Neočekávané 
výsledky mŧţete také získat kopírováním pohybŧ z jedné strany postavy na druhou. Pokud kopírujete 
parametry ze strany na stranu, budete muset na kopírované straně změnit parametry na negativní 
hodnoty. 
Pro kopírování klíčového snímku klikněte na poţadovaný keyframe a stiskněte a drţte klávesu 
[OPT]/[ALT] během taţení klíčového snímku do nové pozice. Kopírovat mŧţete také větší počet 
klíových snímkŧ najednou pomocí jejich výběru a jejich přesunu do nové pozice při drţení klávesy 
[OPT]/[ALT]. Jakmile dosáhnete místa určení, zvolte Edit>Paste, nebo stiskněte 
[COMMAND]/[CTRL]+[V]. 
 

ZMĚNA ČASOVÁNÍ KLÍČOVÝCH SNÍMKŮ  RETIMING KEYFRAMES (orig.127) 

Volbou Animation>Retime Animation otevřete dilaogové okno Retime Keys, které umoţņuje 
nastavení časování klíčových 
snímkŧ Vaší animace: 

Pomocí specifikace zdrojového 
source a cílového destination 
rozsahu snímkŧ, mŧţete měnit 
délku pohybu nebo jeho vzhled. 
Tento příkaz nemá destrukční 
účinky na ţádné klíčové snímky, to 
znamená, ţe jej mŧţete pouţít pro 
opakování pohybu pomocí 
kopírování z jednoho časového 
úseku do druhého. Výběrem pohybu v určitém rozsahu a následným výběrem cíle o stejné velikosti 
dojde ke přemapování pohybu do jiného času bez vymazání originálního pohybu.  

Pro změnu časování snímkŧ: 

1. Otevřete dialogové okno Retime Keys. 

2. Zadejte počáteční a koncový snímek z části animace, u které budete měnit časování, do políček 
Source Frames. 

3. Zadejte rozsah snímkŧ pro poţadovanou změnu časování animace do políček Destination 
Frames. Pokud je cílový rozsah snímkŧ větší neţ rozsah zdrojový, animace se roztáhne a zpomalí, 
a naopak. 

4. Klikněte na OK jakmile budete hotovi. 

 POZNÁMKA 
POKUD POUŢIJETE TENTO PŘÍKAZ, VŠECHNY EXISTUJÍCÍ KLÍČOVÉ SNÍMKY V CÍLOVÉM 
ROZSAHU BUDOU VYMAZÁNY. 
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ZÁLOŢKA VRSTEV  LAYERS TAB (orig.128) 

Animační vrstvy, také známé jako nelineární animace, poskytují moţnost oddělení rŧzných částí 
animace do nezávislých dílŧ, které mohou být individuálně editovány, přesouvány, nebo skrývány 
s ohledem na celkovou animaci. Během renderu budou rŧzné vrstvy spojeny dohromady do jedné 
animace podle Vaší specifikace. Záloţka vrstev Layers tab v paletě animace Animation palette 
obsahuje ovladače, které umoţņují vytváření, konfiguraci, přesun a mazání animačních vrstev. 

 
 

 POZNÁMKA 
POKUD SE PŘEPÍNÁTE ZE ZÁLOŢKY VRSTEV LAYERS DO ZÁLOŢKY KLÍČOVÝCH SNÍMKŦ 
KEYFRAMES, BUDETE VIDĚT VŠECHNY KLÍČOVÉ SNÍMKY, KTERÉ EXISTUJÍ V AKTUÁLNĚ 
VYBRANÉ ANIMAČNÍ VRSTVĚ. POKUD SI PŘEJETE VIDĚT KLÍČOVÉ SNÍMKY Z JINÉ 
VRSTVY, POUŢIJTE ROZBALOVACÍ MENU CURRENT LAYER V HORNÍ ČÁSTI PALETY 
ANIMACE PRO VÝBĚR NOVÉ VRSTVY, BEZ NUTNOSTI VRÁCENÍ SE DO ZÁLOŢKY VRSTEV 
LAYERS. 

 

ZÁKLADNÍ VRSTVA  BASE LAYER (orig.129) 

Pokud začnete poprvé tvorbu animace, bude existovat jen jedna vrstva; tato je známa jako základní 
vrstva Base layer. Základní vrstva je přítomna vţdy a pokud si přejete, mŧţete celou animaci vytvořit 
jen v této jedné vrstvě. Počet snímkŧ základní vrstvy je ekvivalentní délce celé animace. Počáteční 
snímek základní vrstvy je vţdy snímek 1 (Frame 1) a koncový snímek je posledním snímkem celé 
animace. Takţe změna koncového snímku základní vrstvy změní délku animace, coţ ovlivní všechny 
další vrstvy, jejichţ koncový snímek odpovídá koncovému snímku základní vrstvy Base layer. 
 

VYTVÁŘENÍ, MAZÁNÍ A PROHLÍŢENÍ ANIMAČNÍCH VRSTEV   
CREATING, DELETING & PREVIEWING ANIMATION LAYERS (orig.130) 

Kromě společných ovladačŧ, dostupných ve všech třech záloţkách palety animace Animation palette 
(viz “Použití palety animace” na straně 87 pro popis těchto ovladačŧ), obsahuje horní sekce záloţky 
vrstev Layers tato tři tlačítka: 
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o New: Kliknutím na tlačítko New vytvoříte novou animační vrstvu. 

o Delete: Kliknutím na tlačítko Delete vymaţete aktuálně vybranou animační vrstvu. Tato funkce je 
zablokována, pokud je vybrána záklaní vrstva Base layer. 

o Current Layer Only: Kliknutím na tlačítko předvolby Current Layer Only dočasně vyloučíte 
všechny další animační vrstvy z přehrávání. Toto umoţņuje izolovat specifickou animaci 
obsaţenou uvnitř aktuální vrstvy, coţ mŧţe být uţitečné při tvorbě animace s více vrstvami. 

 

OVLADAČE ANIMAČNÍ VRSTVY  ANIMATION LAYER CONTROLS (orig.130) 

Spodní část záloţky vrstev Layers obsahuje doplņkové ovladače, které umoţņují konfiguraci vybrané 
vrstvy a plochu časové osy Timeline Area, která zobrazuje rŧzné vrstvy v editovatelných segmentech, 
umoţņující prohlíţení hierarchie vrstev, stejně jako pozice kaţdé vrstvy na časové ose celé animace. 
Ovladače vrstev jsou následující: 
 

Název vrstvy  LAYER NAME (orig.130) 

Jakmile vytvoříte novou vrstvu, mŧţete její základní název změnit na jakýkoliv jiný podle Vašeho 
přání. Jednoduše vyberte vrstvu zobrazenou na časové ose a zapište nový název do textového pole. 
 

Počáteční/Koncový snímek  START/END FRAME (orig.130) 

Ovladače Start frame a End frame umoţņují specifikaci počátečního Start a koncového End snímku 
vybrané vrstvy. Zatímco základní vrstva Base layer vţdy odpovídá délce celé animace, ostatní vrstvy 
mohou mít rŧzné délky aţ do velikosti celé animace a mohou začínat a končit v libovolných bodech 
uvnitř rozsahu animace. Změnu počátečního a koncového snímku mŧţete zadat kliknutím na číslo 
snímku a zapsáním nové hodnoty do políčka. Alternativně mŧţete kliknout na segment vrstvy v ploše 
časové osy Timeline Area a táhnout jím do nové pozice; délka segmentu zŧstane konstantní, ale 
počáteční a koncový snímek se změní. 

Kliknutím a taţením začátku nebo konce segmentu vrstvy dojde ke změně počátečního nebo 
koncového snímku beze změny pozice segmentu vrstvy unitř časové osy animace. Délka segmentu 
vrstvy se upraví podle čísla počátečního a koncového snímku. 
 

Prolínání snímků dovnitř/ven  BLEND IN/OUT FRAMES (orig.130) 

Funkce prolínání Blend In/Out umoţņuje pozvolné prolínání animačních vrstev dovnitř nebo ven 
z celkové animace. Tato funkce mŧţe být například pouţita pro vytvoření efektu postupně sílícího  
a následně utichajícího větru. Nastavení hodnoty Blend in frames a Blend out frames umoţņuje 
specifikaci počtu snímkŧ, které budou pro lineární prolínání pouţity. Počet prolínaných snímkŧ Blend 
In/Out frame je indikován v zobrazeném segmentu vrstvy jako doplņující segment napojený na 
začátek a konec segmentu vrstvy. 

 POZNÁMKA 
POKUD ANIMACE UVNITŘ SPECIFIKOVANÉ VRSTVY OBSAHUJE GRADUJÍCÍ POHYB, 
FUNKCE PROLÍNÁNÍ NEMUSÍ BÝT EFEKTIVNÍ, ZVLÁŠTĚ POKUD POČET SMÍMKŦ 
URČENÝCH K PROLÍNÁNÍ JE NÍZKÝ. 

 

Metoda kompozice  COMPOSITE METHOD (orig.131) 

Pokud sestavujete celkovou animaci, Poser 7 záčíná základní vrstvou Base layer a dále pokračuje 
podle hierarchie vrstev zařazováním jedné vrstvy za druhou. Nastavení metody kompozice 
Composite method umoţņuje specifikovat zpŧsob, jakým zpŧsobem bude kaţdá z vrstev zapojena 
do celkové animace. Dvě moţnosti zapojení animačních vrstev jsou: nahrazení Replace a přidání 
Add. 
o Replace: Toto je základní metoda kompozice animačních vrstev. Volbou Replace dojde k tomu, ţe 

kaţdá akce daného parametru specifického prvku scény bude nahrazena stejným parametrem ze 
všech vrstev v podřízeném postavení vŧči zvolené vrstvě. Předpokládejme například, ţe vrstva 
Layer1 je podřízená vrstvě Layer2 v hierarchii vrstev animace. Předpokládejme také, ţe ve vrstvě  
Layer1 je hrudník Jamese otočen dvacet stupņŧ doleva, ale ve vrstvě Layer2 je jeho hrudník 
otočen jen deset stupņŧ doleva. Při pouţití volby Replace nastavení z vrstvy Layer2 nahradí 
nastavení z vrstvy Layer1. 
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o Add: Volbou Add dojde k tomu, ţe hodnoty všech parametrŧ rotace a posunutí budou přidány 
k ostatní hodnotám odpovídajících parametrŧ při kompozici kaţdé vrstvy do celkové animace. 
Pokud pouţijeme výše uvedený příklad, dvacet stupņŧ otočení hrudníku z vrstvy Layer1 bude 
přidáno k deseti stupņŧm z vrstvy Layer2. Ve výsledku dojde k otočení hrudníku o třicet stupņŧ. 
Nicméně, pokud by vrstva Layer1 obsahovala negativní hodnotu otočení ve výši dvaceti stupņŧ, 
zatímco vrstva Layer2 by obsahovala pozitivní hodnotu deseti stupņŧ, volba Add by ve výsledku 
znamenala finální otočení o deset negativních stupņŧ. 

 

Přesun nahoru/dolů  MOVE UP/DOWN (orig.131) 

Pokud si vyberete metodu kompozice nahrazení Replace, bude specifické pořadí vrstev uvnitř 
hierarchie vrstev velmi dŧleţité, protoţe nastavení parametrŧ výše umístěných vrstev budou přepsána 
nastavením parametrŧ z niţších vrstev (viz podrobné vysvětlení výše). Pořadí vrstev v jejich hierarchii 
mŧţete měnit pomocí kliknutí na tlačítko pro přesun nahoru Move up nebo pro přesun dolŧ Move 
down, čímţ dojde k přesunu zvolené vrstvy o jednu úroveņ nahoru nebo dolŧ. Opakovaným kliknutím 
na stejné tlačítko se akce zopakuje. 
 

ZÁLOŢKA  ANIMAČNÍCH SESTAV  ANIMATION SETS TAB (orig.131) 

Animační sestavy Animation sets jsou tím, co název naznačuje: Pojmenované skupiny animací 
vybraných prvkŧ figur/rekvizit a parametrŧ v daném rozsahu snímkŧ animace. Mŧţete například 
animovat zvedání ruky figury nad hlavu a pohyb končetiny uloţit do pojmenované animační sestavy. 
 

VYTVOŘENÍ A EDITACE ANIMAČNÍCH SESTAV    
CREATING & EDITING ANIMATION SETS (orig.132) 

Pro práci s animačními sestavami otevřete paletu animace pomocí volby Window>Animation 
Palette. Pro otevření palety animačních sestav kliněte na záloţku Animation Sets, jak je zobrazeno: 

 

Tlačítka Frame Rate, Time control, Frame Indicator, Play controls a Skip Frames fungují tak, jak 
bylo popsáno v předchozích částech této kapitoly. 
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o Pro vytvoření nové animační sestavy klikněte na tlačítko New a novu sestavu pojmenujte. 
Následně dojde k rozšíření záloţky Animation Sets o doplņkové editační ovladače. 

o Pro vymazání animační sestavy vyberte poţadovanou sestavu pomocí rozbalovacího menu 
napravo od tlačítka Attributes, a klikněte na tlačítko Delete. 

o Pro vloţení vybraných poloţek nebo snímkŧ do Vaší animační sestavy proveďte výběr kliknutím  
a taţením a následně klikněte na tlačítko +. Mŧţete vybírat jakékoliv kombinace poloţek/snímkŧ. 
Počáteční a koncové snímky budou vytvořeny identické pro včechny prvky animační sestavy. 

o Pro odstranění zvolené poloţky(ek) nebo snímku(ŧ) proveďte výběr a klikněte na tlačítko –. 
 

NASTAVENÍ ATRIBUTŮ ANIMAČNÍ SESTAVY   
SETTING ANIMATION SET ATTRIBUTES (orig.133) 

Tlačítko Attributes se pouţívá pro skripty Pythonu. Mŧţete přidat jakýkoliv libovolně pojmenovaný 
atribut s asociovanou hodnotou. Při pouţití skriptŧ Pythonu mŧţete tyto atributy pouţít jakýmkoliv 
zpŧsobem podle Vašeho přání. Pro více informací o pouţití skriptŧ Pythonu v Poseru 7 navštivte 
prosím část 6: “PoserPython” na straně 267, nebo PoserPython Methods Manual, který je součástí 
instalace Poseru 7. 
 

APLIKACE ANIMAČNÍ SESTAVY NA FIGURU   
APPLYING ANIMATION SETS TO FIGURES (orig.133) 

Animační sestavy mŧţete také aplikovat na figury. Pokud například vytvoříte animační sestavu 
zvedající se ruky, aplikací této sestavy na vybranou figuru bude docíleno to, ţe ruka figury se bude 
pohybovat přesně podle zpŧsobu, specifikovaného v animační sestavě. Tato funkce umoţņuje úsporu 
času při dalším a dalším opětovném pouţívání komplexních animací. 
 

POUŢITÍ GRAFŮ  USING GRAPHS (orig.133) 

Paleta Graph kaţdého prvku 
umoţņuje provední precizní 
editace klíčových snímkŧ a 
modifikaci interpolační metody 
pouţité  
v animaci. Paleta Graph obsahuje 
následující funkce: 

o Animatable Properties: 
Rozbalovací menu Animatable 
Properties umoţņuje výběr 
všech animovatelných vlastností 
aktuálně vybraného prvku. 

o Interpolation Methods: Viz “Výběr typu interpolace” na straně 97. 

o Keyframe Controls: Viz “Ovladače klíčových snímků” na straně 87. 

o Work Area: Viz dále. 

Následující podsekce popisují funkci grafŧ v podrobnějším detailu.  
 

O PALETĚ GRAFU  ABOUT THE GRAPH PALETTE (orig.133) 

Pracovní plocha grafu Graph Work Area obsahuje dvě osy a graf. Horizontální osa reprezentuje čas 
v počtu snímkŧ. Vertikální osa mění hodnoty v závislosti na zvoleném atributu. Pokud zvolíte pozici 
atributu xTrans, hodnota na vertikální ose reprezentuje pozici prvku ve 3D prostoru (Cartesiánské 
souřadnice). Pokud zvolíte a editujete vlastnost jako je Bend, osa reprezentuje stupně. Hodnoty 
parametrŧ morphingu jsou uvedeny v procentech. 

Samotný graf Graph zobrazuje aktuální změnu atributu v prŧběhu animace. Jeho tvar indikuje také 
typ interpolace, která byla pouţita. Paletu grafu mŧţete také pouţít pro synchronizaci zvuku 
s pohybem, jak je popsáno v části “Synchronizace zvuku a pohybu” na straně 101. 
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VÝBĚR TYPU INTERPOLACE  SELECTING INTERPOLATION TYPES (orig.134) 

Graf Graph obsahuje ovladače, které umoţņují specifikaci metod interpolace, které mohou být 
specifikovány na úrovni prvku a snímku. Ovladače interpolace Interpolation 
controls vypadají následovně:  
Pro změnu metody interpolace vyberte prvek a rozsah snímkŧ pro modifikaci, poté klikněte na tlačítko 
poţadované metody interpolace. Paleta animace Animation palette pouţívá barevné kódy pro 
rozlišení rŧzných metod interpolace: 

o Spline: Zelená 

o Linear: Červená 

o Constant: Šedá 

o Break Spline: V místě aplikace Break Spline se objeví značka. 
 

EDITACE GRAFU  EDITING THE GRAPH (orig.134) 

Graf mŧţete editovat za účelem dosaţení rŧzných stupņŧ interpolace. Například pro zmenšení 
velikosti interpolace podle křivky Spline interpolation narovnáte křivku. Tvar křivky mŧţete nastavit 
pouţitím metody předvolby interpolace, nebo taţením body křivky do poţadovaného tvaru křivky. 
Mŧţete také aplikovat rŧzné interpolační metody pro rŧzné části grafu za pouţití funkce Break Spline. 

Uvědomte si, ţe změna tvaru grafu ovlivní pohyb zvoleného prvku. Pro editaci grafu pouţijte 
rozbalovací menu Animation Properties, nebo vyberte Graph z palety parametrŧ Parameters (viz 
“Použití grafů” na straně 96) pro výběr atributu, který budete editovat. Nyní táhněte jakýmkoliv bodem 
na grafu ve směru, kterým chcete posunout křivku. Křivka změní svŧj tvar v závislosti na zvolené 
metodě interpolace. Pro zobrazení částí grafu, které nejsou aktuálně zobrazeny pouţijte posuvník. 

Pro změnu typu interpolace aplikované v určité části grafu vyberte poţadovaný rozsah snímkŧ, které 
chcete měnit, kliknutím a taţením. Vámi vybraný úsek bude zvýrazněn. Následně klikněte na jedno 
z interpolačních tlačítek ve spodní části palety. Toto mŧţe přidat klíčové snímky do animace. 

Vertikální čáry na grafu označují klíčové snímky keyframes. Tyto body mŧţete přesouvat za účelem 
změny umístění klíčových snímkŧ a také mŧţete klíčové snímky přidávat pomocí kliknutí na bod čáry 
v místě, kde chcete klíčový snímek vloţit. 

Indikátor aktuálního snímku Current Frame je ukazatel snímku, se kterým 
aktuálně pracujete. Pro výběr klíčového snímku klikněte podle potřeby na 
tlačítko Next Keyframe nebo Previous Keyframe, klikněte na indikátor 
klíčového snímku, nebo táhněte indikátorem Current Frame na snímek, 
který si přejete editovat. Klikněte a táhněte obdélník pro výběr 
poţadovaného rozsahu snímkŧ. 

Pouţitím grafu Graph mŧţete také provést následující funkce: 

o Pro přesunutí klíčového snímku(ŧ) klikněte a táhněte vybraný klíčový 
snímek(y) do nové pozice. 

o Pro vloţení klíčového snímku přesuņte indikátor aktuálního snímku Current Frame do 
poţadovaného místa a klikněte na tlačítko Add Keyframe. 

o Pro vymazání klíčového snímku přesuņte indikátor aktuálního snímku Current Frame na 
poţadovaný klíčový snímek a klikněte na tlačítko Delete Keyframe. 

o Pro výjmutí, kopírování a vloţení pouţijte příslušné klávesové zkratky ([COMMAND]/[CTRL]+[X], 
[COMMAND]/[CTRL]+[C] a [COMMAND]/[CTRL]+[V], nebo menu Edit. 

o Pro uzavření palety Graph klikněte na malý čtvereček v levém horním rohu.  
 

POUŢITÍ GRAFU Z PALETY ANIMACE   
USING THE GRAPH WITH THE ANIMATION PALETTE(orig.135) 

Pokud otevřete paltu animace Animation palette, mŧţete vstoupit do palety grafu Graph palette 
aktuálně zvoleného prvku scény pomocí kliknutí na tlačítko Display Graph Palette. S oběma 
otevřenými paletami máte následující moţnosti: 
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o Dvojitým kliknutím na libovolný prvek v seznamu prvkŧ palety animace dojde k přepnutí palety 
grafu na vybraný prvek. 

o Stisknutím klávesy [OPT]/[ALT] během dvojitého kliknutí na libovolný prvek v seznamu prvkŧ palety 
animace dojde k otevření nové palety grafu pro vybraný prvek, bez vlivu na ostatní otevřené palety 
grafu. Tuto funkci mŧţete pouţít pro otevření více palet grafu najednou, coţ mŧţe velmi urychlit 
Vaši práci na animaci. Také mŧţete otevřít více neţ jednu paletu grafu pro jeden prvek scény, coţ 
umoţní například nastavení kroucení a ohýbání předloktí postavy najednou pro dosaţení hladkého 
realistického pohybu. 

 POZNÁMKA 
POKUD MÁTE OTEVŘENO NAJEDNOU VÍCE PALET GRAFU, ZMĚNA PRVKU, KTERÝ 
VYBERETE POMOCÍ DVOJKLIKU, VYVOLÁ ZMĚNU POUZE NAPOSLEDY OTEVŘENÉ PALETY 
GRAFU. VŠECHNY OSTATNÍ PALETY GRAFU ZŦSTANOU VE STÁVAJÍCÍM NASTAVENÍ. 
POKUD CHCETE ZMĚNIT VÍCE NEŢ JEDNU PALETU GRAFU, UZAVŘETE VŠECHNY 
NEPOTŘEBNÉ PALETY A POTÉ JE ZNOVU OTEVŘETE VÝBĚREM AKTUÁLNĚ POTŘEBNÝCH 
PRVKŦ. 

 

POUŢITÍ DESIGNERU CHŮZE  USING THE WALK DESIGNER (orig.136) 

Ze širokého mnoţství pohybŧ lidských postav je chŧze nejtěţší pro animaci a vyţaduje vysoký stupeņ 
přesnosti práce. Chŧze vypadá jednoduše: pouze umístíte jednu nohu dopředu před druhou. Avšak 
v reálu se jedná o neuvěřitelně komplexní pohyb umocněný rŧznorodostí svalŧ v nohách, trupu  
a rukách – prakticky v celém těle. Proto vytvoření přesné simulace chŧze vyţaduje mnoho usilí při 
precizním pózování. Designer chŧze Walk Designer umoţņuje obejít mnoho úkonŧ a vytvořit 
realistickou chŧzi jen za pomoci několika jednoduchých krokŧ. 

Vytvoření kráčející figury je proces o dvou krocích. První krok spočívá ve vytvoření dráhy chŧze 
vybrané figury Walk Path, která definuje, kudy se bude postava ve scéně procházet. Prosím navštivte 
téma “Vytvoření dráhy chůze” na straně 199 pro více informací o tvorbě dráhy chŧze. 

Pro otevření designeru chŧze Walk 
Designer vyberte poţadovanou 
figuru a poté zvolte Window>Walk 
Designer. 

Pokud nebudete chtít, aby figura 
kráčela na místě (pochodování na 
místě), vytvořte chŧzi následovně: 

1. Vytvořte dráhu chŧze (Vaše figura 
bude tuto dráhu následovat 
během chŧze). 

2. Vytvořte chŧzi za pouţití 
designeru chŧze Walk Designer. 

Walk Designer má dvě části. Horní 
sestava ovadačŧ vytváří hlavní 
pohyby chŧze, zatímco spodní 
sestava ovladačŧ nastavuje sekundární pohyby chŧze. Pro zobrazení náhledu chŧze klikněte na 
tlačítko Walk kdykoliv během pouţití designeru chŧze. Během náhledu je pohyb neustále opakován  
a spouštěcí tlačítko se změní na tlačítko pro zastavení Stop.  
 

POHLEDY  VIEWS (orig.137) 

Jak mŧţete vidět na předchozím obrázku, Walk Designer obsahuje náhled vytvářené chŧze 
v reálném čase. Pokud změníte parametry, chŧze se odpovídajícím zpŧsobem změní. Úhel, ze 
kterého budete pozorovat náhled chŧze mŧţete specifikovat označením odpovídajícího tlačítka 
předvolby pod oknem náhledu: 

o (default): Označením tohoto tlačítka předvolby bude zvolen pohled na figuru z úhlu. 

o Side: Označením tlačítka předvolby Side bude zvolen pohled na figuru z boku. 

o Front: Označením tlačítka předvolby Front bude zvolen pohled na figuru zepředu. 
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o Top: Označením tlačítka předvolby Top bude zvolen pohled na figuru shora. 

 POZNÁMKA 
WALK DESIGNER ZOBRAZUJE AKTUÁLNÍ PODKLAD PRACOVNÍHO PROSTORU POSERU 7, 
POZADÍ A BARVY STÍNŦ, STEJNĚ JAKO MÓD SLEDOVÁNÍ CÍLE KAMERY. 
 

NAČTENÍ TYPU FIGURY  LOADING FIGURE TYPES (orig.137) 

Tento krok je volitelný, nicméně se mŧţe projevovat moţnými problémy týkající se neregulérních  
a trhavých pohybŧ generované chŧze. Pro načtení figury určitého typu klikněte na tlačítko Load ve 
Walk Designeru a pouţijte standardní dialog Open pro lokalizaci poţadovaného souboru charakteru 
(*.CR2). Prosím navštivte dodatek B: “Struktura souborů Poseru 7” na straně 276 pro více informací  
o typech souborŧ Poseru 7, včetně CR2 souborŧ. 

 POZNÁMKA 
SNAŢTE SE PŘI TVORBĚ PRACOVAT SE STEJNÝMI FIGURAMI, KTERÉ BUDETE DÁLE 
POUŢÍVAT. POKUD NAPŘÍKLAD VYTVÁŘÍTE CHŦZI PRO FIGURU DON, NAČTĚTE JEJ DO 
WALK DESIGNERU PRO DOSAŢENÍ NEJLEPŠÍCH VÝSLEDKŦ. 

 

STYLY BLEND & TWEAK  BLEND & TWEAK STYLES (orig.137) 

Jakmile máte načten poţadovaný typ figury, mŧţete začít vytvářet chŧzi. V základním nastavení jsou 
všechny posuvníky nastaveny do středu rozsahu. Tato kombinace vytváří pouţitelnou základní chŧzi. 
Taţením posuvníku doprava se hodnota efektu zvyšuje, a naopak. Pro vytvoření chŧze: 

1. Taţením posuvníkŧ ze skupiny Blend se vytvářejí rozsáhlé pohyby. K prohlédnutí všech 
dostupných nastavení pouţijte moţnost náhledu. Vyzkoušejte pouţití kombinací rŧzných nastavení 
a pamatujte si, ţe malé změny mohou vytvořit dramatické výsledky. 

2. Nastavením posuvníkŧ ze skupiny Tweak chŧzi jemně doladíte. 

3. Jakmile Vaše chŧze vypadá tak, jak si přejete, klikněte na tlačítko Done pro otevření dialogu Apply 
Walk (viz dále). 

 POZNÁMKA 
KLIKNUTÍM NA TLAČÍTKO DEFAULTS DOJDE K OPĚTOVNÉMU NASTAVENÍ VŠECH 
POSUVNÍKŦ DO JEJICH ZÁKLADNÍCH POZIC. 

 

NAČTENÍ & ULOŢENÍ CHŮZE  LOADING & SAVING WALKS (orig.137) 

Soubory chŧze mŧţete načítat a ukládat pomocí Walk Designeru. Nejedná se o totéţ, co uloţení 
animovaných póz do palety knihoven Library. Pro uloţení vytvořené chŧze klikněte na tlačítko Save 
pro otevření standardního dialogového okna, které umoţņuje zadání názvu a umístění ukládané 
chŧze. Zvolte cestu k poţadované sloţce, zadejte jméno souboru ukládané chŧze a klikněte na 
tlačítko OK. 

Pro načtení chŧze klikněte na tlačítko Load pro otevření standardního Open dialogu, umoţņujícího 
zadání cesty k poţadovanému souboru uloţené chŧze k načtení. 

 POZNÁMKA 
PRO MAXIMÁLNÍ REALISMUS NAČÍTEJTE CHŦZI VYTVOŘENOU PRO STEJNÝ TYP FIGURY. 

 

POUŢITÍ CHŮZE  APPLYING WALKS (orig.138) 

Jakmile máte chŧzi vytvořenu, mŧţete ji pouţít k chŧzi figury po stanovené dráze (viz “Vytvoření dráhy 
chůze” na straně 199 pro instrukce k vytváření dráhy chŧze). Dialogové okno Walk Apply umoţņuje 
specifikaci rŧzných předvoleb pro pouţití nově vytvořené chŧze. Pokud si přejete, aby figura 
pochodovala na místě, mŧţete tento dialog pouţít i bez vytvoření dráhy chŧze. 

Pro pouţití chŧze jsou k dispozici následující volby: 

o Figure: Pokud Vaše scéna obsahuje více neţ jednu figuru, rozbalovací menu Figure umoţņuje 
výběr figury, pro kterou bude chŧze aplikována. 

o Walk in Place/Follow Path: Kliknutím na tlačítko předvolby Walk in Place určíte, ţe zvolená figura 
bude kráčet na místě. Tuto volbu mŧţete pouţít pro vytvoření chŧze bez stanovené dráhy. 
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Naopak, pokud si přejete, aby figura kráčela po stanovené dráze, klikněte na tlačítko předvolby 
Follow Path. 

o Path: Pokud Vaše scéna obsahuje více neţ 
jednu stanovenou dráhu chŧze, mŧţete pouţít 
rozbalovací menu Path pro výběr dráhy chŧze 
k pouţití. 

o Align Head to: Označením políčka Align Head 
to umoţníte ovládání hlavy figury během jejího 
pohybu po dráze chŧze. One Step Ahead 
udrţuje hlavu v rovině s postavou a umoţņuje 
vytváření největších pohybŧ hlavy. End of 
Path zaměřuje pohled hlavy figury na konec 
stanovené dráhy chŧze bez ohledu na pozici 
figury na dráze. Next Sharp Turn zaměřuje 
hlavu figury na zatáčky v dráze chŧze, 
v zatáčkách dráhy se pohybuje pouze hlava 
figury. 

o Always Complete Last Step: Označením 
políčka Always complete last step donutíte 
animaci chŧze, aby se dokončila na konci 
cyklu kroku. Toto je uţitečné v případě, kdy 
chŧze na konci dráhy skončí uprostřed kroku. 

o Transition From/To Pose at Start/End Frames: 
Poloţky Transition from pose at start  
a Transition from pose at end umoţņují, aby 
figura plynule přešla do chŧze na začátku 
cyklu  
a na konci cyklu plynule chŧzi ukončila. Pokud 
jsou aktivovány, Poser 7 interpoluje snímky 
mezi pózou figury před startem chŧze  
a nastavením specifikovaným ve Walk 
Designeru, a opačně na konci dráhy chŧze. Tuto funkci mŧţete například pouţít pro rychlé 
nastavení figury běţce na startu, sehnutého do startovní pozice, a to zadáním realistického času 
přechodu z této pózy do vytvořeného pohybu běhu. Pokud následně animaci přehrajete, běţec se 
nejprve zvedne ze startovních blokŧ a pak teprve začne běţet. Označením jednoho nebo obou 
políček se odpovídající funkce aktivují. Jakmile je funkce aktivována, zadejte počet snímkŧ, které 
budou pouţity pro vytvoření přechodového pohybu. Delší časové úseky (více snímkŧ) umoţņují 
vytvoření realističtějších pohybŧ, a naopak. 

o Start Frame: Číslo snímku Vaší animace, ve kterém chŧze začíná, zadejte do políčka Start Frame. 

o End Frame: Číslo snímku Vaší animace, ve kterém chŧze končí, zadejte do políčka End Frame. 
Poser 7 navrhne hodnotu, u které očekává dosaţení přirozené rychlosti chŧze. Zadáním většího 
počtu snímkŧ prodlouţíte čas, který bude figura potřebovat pro dokončení chŧze po specifikované 
trase. 

o Create Keyframes in: Předvolba Create Keyframes in umoţņuje výběr nové nebo existující vrstvy 
animace pro vytvoření klíčových snímkŧ chŧze. Animační vrstvy umoţņují organizaci animací, 
uloţení a opětovné pouţití specifických částí velké animace. Doporučujeme vytvářet klíčové 
snímky v nové animační vrstvě. Pro tuto volbu klikněte na tlačítko předvolby New animation layer. 
Alternativně mŧţete zvolit pouţití existující animační vrstvy kliknutím na tlačítko předvolby Layer  
a zvolením názvu poţadované vrstvy z rozbalovacího menu. Pokud si pouţití animačních vrstev 
nepřejete, mŧţete jednoduše klíčové snímky zapsat přímo do základní vrstvy Base Layer. Pro více 
informací o animačních vrstvách navštivte prosím téma “Záložka vrstev” na straně 93.  

 

ZVUK  SOUND (orig.139) 

Poser 7 umoţņuje import zvuku, který mŧţe být přehráván současně s animací. Toto umoţņuje do 
animací přidávat hudební doprovod, řeč, apod. Pro import zvukového klipu zvolte File>Import>Sound  
a pouţijte standardní Open dialog, který umoţņuje nalezení poţadovaného zvukového souboru. 
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Pokud si přejete importovat zvukový klip řeči pro pouţití v Talk Designeru, zvolte File>Import>Lip 
Sync Audio (pro informace o Talk Designeru viz dále). Importovaný zvuk bude připojen k prvnímu 
snímku Vaší animace a bude přehráván současně s animací. Do animace mŧţete importovat pouze 
jeden zvukový soubor. Pokud animace vyţaduje více neţ jeden zvukový soubor, musíte zvukové 
soubory předem editovat v odpovídající aplikaci a spojit je dohromady v jeden soubor, který následně 
importujete do Poseru 7. 
 

EDITACE ZVUKU  EDITING SOUND (orig.140) 
Trvání zvuku zobrazuje ukazatel Sound Range ve spodní části palety animace Animation Palette. 
Zvukový klip mŧţete ustřihnout pomocí zkrácení ukazatele zvuku. Nicméně, pokud začátek 
přehrávání zvuku nastavíte zkrácením ukazatele na jiný snímek neţ 1, začátek zvukového souboru 
bude ustřiţen. Pro specifikaci počátečního a koncového snímku se zvukem táhněte šipkama po 
stranách ukazatele zvuku. 
 

SYNCHRONIZACE ZVUKU A POHYBU  SYNCING SOUND & MOTION (orig.140) 

Paleta Graph zobrazuje graficky přítomnost zvuku pomocí 
křivky, coţ umoţņuje sledovat změny intenzity zvuku. Tyto 
informace mŧţete pouţít pro umístění klíčových snímkŧ do 
animace. Simulace řeči probíhá pomocí změn pozice úst, které 
závisí na špičkách zvukové křivky, jak je zobrazeno vedle. Pro 
zobrazení zvukové křivky v paletě Graph, otevřete tuto paletu 
jak je popsáno v části “Použití grafů” na straně 96 a klikněte na 
tlačítko Toggle Sound Display pro zapnutí nebo vypnutí 
zobrazení zvukové křivky.  
 

POUŢITÍ DESIGNERU ŘEČI  USING THE TALK DESIGNER (orig.140) 

Designer řeči Poseru 7 Talk Designer automatizuje úlohu animace artikulace tváře během řeči. 
Řekněme sbohem nudnému manuálnímu nastavování; Talk Designer pouţívá morph targety, 
ovladače emocí Emotional Tweak a výkonné modelovací algoritmy pohybu očí a hlavy pro intuitivní  
a jednoduché animace realistických výrazŧ tváře při řeči. 

Designer řeči je konfigurován pomocí palety Talk Designeru. Tato paleta mŧţe být zpřístupněna 
následujícími zpŧsoby: 

Zvolte File>Import>Lip Sync Audio pro import zvukového souboru, jak je popsáno výše. Na konci 
procesu importu se paleta Talk Designeru automaticky otevře současně s importovaným zvukovým 
souborem. 

Zvolte Window>Talk Designer pro otevření palety Talk Designeru kdykoliv. 
 

KONFIGURACE DESIGNERU ŘEČI   
CONFIGURING THE TALK DESIGNER (orig.140) 

Nastavení palety Talk Designeru je popsáno v následujících částech. Jakmile máte designer řeči 
konfigurován podle svých představ, klikněte na tlačítko Apply ve spodní části palety pro vygenerování 
synchronizované animace rtŧ podle specifikovaného nastavení. 
 

Vstupní soubory  INPUT FILES (orig.141) 

o Sound file: Kliknutím na tlačítko “...” vedle poloţky Sound file je moţné vyhledat umístění 
zvukového souboru, který si přejete pouţít pro animaci řeči. Poser 7 podporuje soubory WAV, 
stejně jako soubory AIFF pro Macintosh. 

o Supplemental text: Pro dosaţení lepších výsledkŧ doporučujeme vloţení textu zvukového souboru 
do políčka Supplemental text. Mŧţete kliknout na tlačítko “...” pro vyhledání textového souboru  
a poté kliknout na tlačítko “+” pro otevření textového pole pro přímé vloţení textu. 

o Viseme map file: Soubor viseme map poskytuje informace o tom, které zvukové výrazy 
phonemes (zvuky řeči) jsou přiřazeny ke specifickým artikulacím visemes, nebo výrazŧm tváře. 
Tyto soubory viseme map jsou přímo spojeny s nastavením morph targetu individuální figury. 
Pokud budete pracovat s jakoukoliv novou figurou Poseru 7, mŧţete jednoduše pouţít základní 
soubor viseme map této figury. Pokud si přejete pouţít figuru z předchozí verze Poseru, ujistěte se 
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prosím, ţe soubor viseme map je k dispozici v asociovaném rozbalovacím menu. Pokud pouţíváte 
figuru z ostatních zdrojŧ, která byla vytvořena s odlišným nastavením morph targetu, budete si 
muset opatřit soubor viseme map 
odpovídající této figuře. Doporučujeme 
uloţení souboru viseme map do sloţky 
\Runtime\LipSync\, která byla vytvořena 
současně s instalací Poseru 7. Jen v takovém 
případě bude uloţený soubor k dispozici 
v rozbalovacím menu palety Talk Designeru. 
Alternativně mŧţete kliknout na tlačítko “...” 
pro vyhledání lokace souboru viseme map 
v případě, kdyţ si přejete pouţít soubor z jiné 
lokace. 

 POZNÁMKA 
POKUD SI NEJSTE JISTI, ZDA VAŠE 
FIGURA BYLA VYTVOŘENA PODLE 
STANDARDŦ MORPH TARGETŦ FIGUR 
POSERU, MŦŢETE VYZKOUŠET ANIMACI 
ZA POUŢITÍ ZÁKLADNÍHO SOUBORU 
VISEME MAP. POKUD NEBUDETE S 
VÝSLEDKEM SPOKOJENI, BUDETE 
MUSET KONTAKTOVAT AUTORA FIGURY 
A POŢADOVAT SOUBOR VISEME MAP 
PRO POUŢITÍ V TALK DESIGNERU. 

 

Konfigurace  CONFIGURATION (orig.141) 

o Figure: Specifikuje, která figura scény bude 
pouţita pro vytvoření animace řeči, pomocí 
výběru jména figury z rozbalovacího menu. 

o Start frame: Specifikuje číslo počátečního 
snímku Start Frame aktuální animace řeči. 
V základu je počáteční snímek nastaven na 
počáteční snímek celé animace scény 
(snímek 1). 

o End frame: Specifikuje číslo koncového 
snímku End Frame aktuální animace řeči. 
V základu je koncový snímek nastaven na 
koncový snímek celé animace scény (obecně 
snímek 30, pokud nemáte specifikován jiný 
koncový snímek animace scény). Jakmile 
bude vloţen zvukový soubor, koncový 
snímek End Frame bude upraven podle délky zvukového souboru. 

 POZNÁMKA 
POKUD JE SPECIFIKOVANÝ KONCOVÝ SNÍMEK V TALK DESIGNERU VĚTŠÍ NEŢ KONCOVÝ 
SNÍMEK ANIMACE CELÉ SCÉNY (SPECIFIKOVANÝ V ZÁKLADNÍ VRSTVĚ BASE LAYER), NA 
KONEC SCÉNY BUDOU PŘIPOJENY DODATEČNÉ SNÍMKY ODPOVÍDAJÍCÍ ROZDÍLU. 

o Create Keyframes in: Poloţka Create Keyframes in umoţņuje výběr, zda klíčové snímky animace 
řeči budou vytvořeny v nové nebo existující animační vrstvě. Animační vrstvy umoţņují organizaci 
animací, uloţení a opětovné pouţití specifických částí velké animace. 

Doporučujeme vytvářet klíčové snímky v nové animační vrstvě; pro pouţití této volby klikněte na 
tlačítko předvolby “New animation layer”. Budete dotázáni na zadání názvu nové vrstvy. 
Alternativně mŧţete zvolit pouţití existující animační vrstvy pomocí kliknutí na tlačitko předvolby 
“Layer” a vybrat název poţadované vrstvy z rozbalovacího menu. Pokud si pouţití animačních 
vrstev nepřejete, mŧţete jednoduše klíčové snímky zapsat přímo do základní vrstvy Base Layer. 
Pro více informací o animačních vrstvách navštivte prosím téma “Záložka vrstev” na straně 93. 
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o Enunciation: Posuvník Enunciation umoţņuje nastavení míry, se kterou bude Talk Designer 
pouţívat artikulaci figury nebo výrazy tváře, v závislosti na změně energie zvukového souboru. 
Poser 7 automaticky nastavuje artikulaci úměrně energii vybraného zvukového souboru. Nicméně 
mŧţete pouţít posuvník Enunciation pro zvýšení nebo sníţení stupně reakce, pro omezení nebo 
zintenzivnění automatického nastavení artikulace. Přesuņte posuvník doprava pro zvýšení účinku, 
nebo doleva pro jeho sníţení.  

 

Pohyby hlavy  HEAD MOTIONS (orig.142) 

o Eye Blink Rate: Talk Designer mŧţe přidat občasné mrknutí očí, které bylo vytvořeno podle studia 
aktuální rychlosti mrkání lidské postavy, za účelem oţivení animace řeči mrkáním v realistické 
frekvenci. Posuvník Eye Blink Rate umoţņuje specifikovat frekvenci mrkání, měřenou v počtu 
mrknutí za minutu (BPM). Pro změnu rychlosti mrkání jednoduše klikněte a táhněte posuvníkem, 
nebo na klikněte číselnou hodnotu v textovém poli a přímo zadejte poţadovanou hodnotu. Základní 
hodnota je 12.5 BPM. Nastavením nulové hodnoty (0 BPM) se funkce automatického nastavení 
mrkání deaktivuje, čoţ znamená, ţe s tímto nastavením musíte mrkání animovat manuálně. 

o Create eye motion: Pokud lidé mluví, jejich oči se většinou dívají do rŧzných směrŧ v závislosti na 
posluchači a okolí. Přidáním pohybŧ očí je moţné dosáhnout realističtější animace. Označte 
zaškrtávací políčko Create eye motion a Poser 7 přidá k animaci řeči pohyby očí. 

o Create head motion: Lidé během řeči přirozeně pohybují hlavou, to znamená, ţe přidáním těchto 
pohybŧ hlavy k animaci řeči bude dosaţeno realističtějších výsledkŧ. Označte zaškrtávací políčko 
Create head motion a Poser 7 přidá k animaci řeči pohyby hlavy za Vás. 

 

Výrazy emocí  EMOTIONAL TWEAKS (orig.143) 

Designer řeči Talk Designer obsahuje šest výrazŧ emocí Emotional Tweaks, které jsou morph 
targety a mohou být pouţity ve spojeni s řečí. Tyto morph targety jsou zaloţeny na výrazech tváře 
asociovaných s následujícími emocemi: 

o Zlost Anger 
o Odpor Disgust 
o Strach Fear 
o Radost Joy 
o Smutek Sadness 
o Údiv Surprise 

Kaţdý z těchto emočních výrazŧ Emotional Tweaks je moţno nastavovat pomocí posuvníku  
v rozsahu -100% and 100%. Hodnota uprostřed daného rozsahu reprezentuje stupeņ, kterým se bude 
konkrétní emoce projevovat ve výrazu tváře figury během animace řeči. Hodnoty posuvníkŧ 
jednotlivých emočních výrazŧ mŧţete libovolně kombinovat podle konkrétních potřeb. Pro nastavení 
poţadované hodnoty mŧţete posouvat posuvníkem vpravo a vlevo, nebo mŧţete kliknout na číselnou 
hodnotu napravo od posuvníku a přímo zadat poţadovanou hodnotu. 
 

POKROČILÉ ANIMAČNÍ TECHNIKY   
ADVANCED ANIMATION TECHNIQUES (orig.143) 

V této sekci přestaneme na chvíli mluvit o technických detailech a zaměříme se na několik 
uměleckých úvah. Editace animací je sama o sobě jednoduchá a pěkná práce. Dokončení Vaší 
animace tak, jak aby vypadala jak si přejete a přidání realismu jsou však těţkými úkoly. Trhavé 
pohyby mohou být vyhlazeny a prudké nebo nerealistické pohyby mohou být upraveny na realistické, 
pokud budete brát na vědomí několik jednoduchých technik. 
 

KLÍČOVÉ SNÍMKY A ČASOVÁNÍ  KEYFRAMES AND TIMING (orig.143) 

Jak byste měli klíčové snímky keyframes rozmístit? Začněte promyšlením času a obnovovacího 
kmitočtu. Klíčové snímky pak rozmístěte tak, aby pohyb vzhledem ke zvolenému obnovovacímu 
kmitočtu frame rate vypadal reálně. Pokud máte například pohyb, který trvá 4/5 sekundy, budete 
potřebovat 24 frames při 30fps, 20 frames při 24fps, 9 frames při 12fps, apod. Zakladní vzorec je, ţe 
obnovovací kmitočet frame rate (ve snímcích za sekundu) dělený délkou pohybu v sekundách = 
počet poţadovaných snímkŧ. 
 



 

Strana 104 (celkem 289) 

VYTVOŘENÍ REALISTICKÉHO POHYBU  CREATING REALISTIC MOTION (orig.144) 

Nyní máme zadán počet snímkŧ, které animace vyţaduje pro dokončení, co bude následovat teď? 
Rozloţení pohybu do jednotlivých částí. Podívejme se například na hráče baseballu na odpalu. Na 
první pohled to vypadá, ţe jen jeho ruce se posouvají. Při bliţším pohledu mŧţeme vidět, ţe se 
pohybuje celé tělo. Některé pohyby, jako rukou a nohou, jsou výraznější neţ pohyby ostatních částí 
postavy. Takţe začínejte vţdy nastavením výraznějších pohybŧ a potom se vraťte zpět a dokončete 
jemné nastavení. V případě hráče baseballu mŧţete začít dvěma snímky: první bude začátek úderu  
a druhý bude konec úderu. 

Náhled takové animace s pouze dvěma klíčovými snímky pravděpodobně poskytne i tak dobrý 
výsledek, nicměně to, co přidává animaci na lesku jsou detaily. Nyní, kdyţ máme hlavní pohyby 
zhruba nastaveny, pojďme přidat některé detaily. Mŧţeme přidat například rotaci bokŧ, náklon ramen, 
apod. Jemné detaily nemusí být moc nápadné, ale Vaši diváci budou jejich existenci nebo neexistenci 
vnímat, i kdyţ nebudou přímo schopni říci, co je na animaci špatné, pokud detaily budou chybět. 
Paleta animace Animation palette a graf graph Poseru 7 (popsáno v předchozích částech) jsou 
ideálními nástroji pro jemné ladění animace. 

Při práci pomocí tohoto zpŧsobu mŧţete vytvořit jakoukoliv akci a animace mŧţe vypadat maximálně 
realisticky. 
 

DLOUHÉ/KOMPLEXNÍ ANIMACE  LONG/COMPLEX ANIMATIONS (orig.144) 

Pokud se pokoušíte vytvořit dlouhý film nebo film s častými změnami kamer, mŧţete vytvořit malé 
klipy, které později spojíte dohromady pomocí video editační aplikace, jako je Adobe Premiere. 
 

ULOŢENÍ ANIMACÍ DO KNIHOVNY   
SAVING ANIMATIONS TO THE LIBRARY (orig.144) 

Animace mŧţete do knihovny Library uloţit jako stacionární pózy (jeden snímek), nebo animované 
pózy (více snímkŧ), pro pouţití s jinými figurami/rekvizitami. Viz téma “Přidání položek do knihovny” 
na straně 33 pro více informací o ukládání stacionárních nebo animovaných póz do knihovny Library. 
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Kapitola 12: Práce s rekvizitami  WORKING WITH PROPS (orig.145) 
Poser umoţņuje přidávání rekvizit do scény. Rekvizity jsou tříprostorové objekty, které mohou 
spolupŧsobit s figurami a dodávají na zajímavosti scény. Rekvizity mohou být doplņky figury, jako jsou 
vlasy, vousy, brýle, cigareta nebo kufřík. Také samotná póza figury mŧţe být zaloţena na rekvizitě, 
jako například opírání o hŧl, lezení po ţebříku nebo házení míčem. Tato kapitola zahrnuje také vlasy, 
přizpŧsobivé oděvy (zaloţené na figuře) a rŧzné rekvizity nezapadající do těchto kategorií. Poser 7 
zachází s prvky přizpŧsobivých oděvŧ jako s figurami, nicméně v této kapitole je vhodné o pouţití 
přizpŧsobivých oděvŧ pojednat společně s ostatními rekvizitami. 
 

O REKVIZITÁCH  ABOUT PROPS (orig.145) 

S rekvizitami mŧţete manipulovat stejně jako s ostatními elementy, proto také v této příručce mŧţete 
vidět pojem „část postavy/rekvizita“. Mŧţete měnit barvy rekvizity, tvar, deformace, materiály a textury 
(pokud mají UV souřadnice – navštivte Poser 7 Tutorial Manual, “Multi/Sub-Object Materials: About 
Maps & Templates” pro více informací). Rekvizity mohou dokonce vrhat stíny. 

Funkce Poseru 7 pro nahrazení geometrie 
(viz téma “Nahrazení části těla rekvizitou” na 
straně 202) umoţņuje nahrazení části 
postavy rekvizitou, aktuální rekvizita se stane 
součástí figury. Mŧţete také přiřadit 
mateřskou vazbu mezi rekvizitou  
a postavou nebo mezi jiným prvkem scény, 
například mezi kufříkem a rukou. Prosím 
navštivte Poser 7 Tutorial Manual, “More 3D 
Elements: Hierarchy” pro základní informace 
o hierarchii a téma “Editor hierarchie” na 
straně 129 pro informace o tvorbě hierarchií 
uvnitř Poseru 7. Rekvizity také obecně přidají 
na zajímavosti a na významu scény, viz 
například muchomŧrka pro ţábu na ní sedící. 

Rekvizity mŧţete vybírat z kategorie Props palety knihoven Library, z místnosti obsahu Content 
room, nebo rekvizity importovat z mnoţství oblíbených 3D formatŧ. Mŧţete si také vytvořit vlastní 
rekvizity ve své oblíbené 3D modelovací aplikaci (za předpokladu, ţe aplikace umoţņuje export do 
jednoho nebo více formátŧ, podporovaných funkcí importu do Poseru 7). 

Rekvizity fungují jako ostatní prvky scény, mŧţete u nich pouţít editační nástroje Editing tools, 
otočné ovladače parametrŧ a mohou mít specifikované vlastnosti v paletě vlastností Properties. 
Mŧţete také vytvořit skupiny pomocí palety editoru skupin Group Editor (viz téma “Editor skupin” na 
straně 125).  
 

VLASY  HAIR (orig.146) 

Místnost vlasŧ Hair room Poseru 7 (viz kapitola 18: “Místnost vlasů” na straně 158) umoţņuje během 
sestavování figur vytvoření reálných vlasŧ zaloţených na jednotlivých praméncích, nebo pouţití vlasŧ 
zaloţených na rekvizitě. V této části budeme diskutovat o obou formách vlasŧ. 
 

PRAMÉNKOVÉ VLASY  STRAND-BASED HAIR (orig.146) 

Místnost vlasŧ Hair room Poseru 7 umoţņuje přidání dynamických praménkových vlasŧ pro prvky 
scény za účelem dosaţení maximálního realismu. Mŧţete vytvořit dlouhé nebo krátké vlasy tak, jak si 
přejete pro jakýkoliv prvek scény a tuto funkci mŧţete dokonce pouţít pro vytvoření srsti, lišejníkŧ, 
trávy a mnoha dalších efektŧ. Prosím navštivte kapitolu 18: “Místnost vlasů” na straně 158 pro více 
informací o praménkových vlasech a místnosti vlasŧ Hair room. 

 POZNÁMKA 
PRAMÉNKOVÉ VLASY V ZÁKLADU VYŢADUJÍ VÝZNAMOU ČÁST VÝPOČETNÍHO VÝKONU, 
PROTO BUĎTE OPATRNÍ, ABY JSTE SYSTÉM NEPŘETÍŢILI. PROSÍM PROSTUDUJTE 
DETAILNÍ INFORMACE O MÍSTNOSTI VLASŦ PRO VÍCE INFORMACÍ. 
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VLASY ZALOŢENÉ NA REKVIZITĚ  PROP-BASED HAIR (orig.146) 

Vlasy zaloţené na rekvizitě jsou speciálním druhem rekvizity, která se 
automaticky připojí ke hlavě figury. Mŧţete je vybírat z několika stylŧ z palety 
knihoven Library (viz téma “Vlasy” na straně 32). Jakmile jsou vlasy připojeny, 
pohybují se společně s hlavou figury. Některé novější modely vlasŧ, které 
přecházejí s Poserem 7, jsou polohovatelné, zejména mnoho rekvizit vlasŧ od 
ostatních dodavatelŧ. Běţně jsou pouţívány transparentní textury 
Transparency Maps pro zlepšení vzhledu vlasŧ zaloţených na rekvizitě. 

Pro přidání vlasŧ do palety knihoven Library navštivte prosím téma “Přidání 
položek do knihovny” na straně 33. Vlasy obsahují otočné ovladače parametrŧ v paletě Parameters 
(viz téma “Parametry rekvizit” na straně 109), umoţņující specifikaci jejich měřítka a pozice. Některé 
vlasy také obsahují otočné ovladače parametrŧ morph targetŧ, které například umoţņují vytvoření 
pohybu vlasŧ při chŧzi figury. Paleta Library obsahuje také nastavitelné modely vlasŧ, který obsahují 
prvky stejně jako figura. Tyto prvky mŧţete editovat a nastavovat stejně jako u jiné figury Poseru 7: 

Pro pouţití nastavitelného modelu vlasŧ: 

1. Načtěte figuru Jamese z kategorie Figures palety knihoven Library. 

2. Vyberte a načtěte model vlasŧ Messy Hair z kategorie Hair>Kozaburo palety Library. 

3. Nastavte hlavu jako mateřský objekt parent pro vlasy, jak je popsáno v části “Změna mateřských 
vazeb” na straně 201. 

 

OBLEČENÍ  CLOTHING (orig.147) 

Místnost oblečení Poseru 7 Cloth room (viz kapitola 19: “Místnost oblečení” na straně 165) dodává 
celkově nový rozměr pro tvorbu realistického oblečení Vašich figur a prvkŧ oblečení Vašich scén. 
Mŧţete kdykoliv přidat realistický pohyb oblečení, reagující na pohyby postavy (jako například sukně 
na procházející se ţeně) a také mohou být simulovány účinky větru na oblečení pomocí silových polí 
(popsáno v části “Silová pole větru” na straně 113). Poser 7 samozřejmě podporuje oblečení zaloţené 
na rekvizitě prop-based clothing a pracuje s dynamickým i přizpŧsobivým (na bázi figury) oblečením. 
V této části budeme diskutovat o obou formách oblečení. 
 

DYNAMICKÉ OBLEČENÍ  DYNAMIC CLOTHING (orig.147) 

Prosím navštivte téma “Přidání oblečení” na straně 37 pro informace o přidání dynamického oblečení 
na figuru nebo do scény. 
 

PŘIZPŮSOBIVÉ OBLEČENÍ  CONFORMING CLOTHING (orig.147) 

Kromě prkŧ oblečení Poser 7 obsahuje knihovny s oblečením zaloţeným na figuře 
figure-based clothing které mŧţete pouţít na nahé figury. Toto oblečení se nachází v 
kategorii Figures patety knihovny Library a obsahuje košile, kalhoty, boty, kostýmy, 
sukně, apod. 

Jak jsme se zmínili dříve, přizpŧsobivé oblečení se chová stejným zpŧsobem jako 
běţné figury Poseru a z technického hlediska jsou totoţné. Proto například košile 
obsahuje hrudník, krk, břicho a elementy ruky. Oblečení disponuje všemi parametry 
jako mají odpovídající části postavy figury. 

Přizpŧsobivé oblečení mŧţete vloţit do scény a definovat figuru, pro kterou bude přizpŧsobeno. To 
znamená, ţe oblečení se samo připojí k základní figuře a přizpŧsobí se podle stejně pojmenovaných 
částí postavy. Oblečení se bude dále pohybovat společně se základní figurou.  
 

Aplikace přizpůsobivého oblečení na figuru   
ADDING CONFORMING CLOTHING TO A FIGURE (orig.147) 

Pro aplikaci přizpŧsobivého oblečení na figuru: 

Vyberte oblečení z palety knihoven Library a klikněte na ikonu Add New Figure pro vloţení tohoto 
oblečení do scény. Ujistěte se, ţe zvolená poloţka oblečení byla vytvořena pro figuru, kterou chcete 
obléci. Oblečení se zobrazí ve scéně tak, jak je znázorněno na předchozím obrázku. 
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1. Pouţijte rozbalovací menu Choose Figure a vyberte poloţku 
oblečení. 

2. Zvolte příkaz Figure>Conform to a vyberte poţadovanou 
základní figuru z rozbalovacího menu, které bude zobrazeno. 
Oblečení se přizpŧsobí figuře, zaujme její pózu a nadále se bude 
pohybovat současně s pohyby figury. 

 POZNÁMKA 
NĚKTERÉ TĚSNÉ PŘIZPŦSOBIVÉ OBLEČENÍ NEMUSÍ 
KOMPLETNĚ POKRÝT CELÝ POVRCH ZÁKLADNÍ POSTAVY. 
OBZVLÁŠTĚ POKUD JE FIGURA ANIMOVÁNA. TOTO JE 
MOŢNÉ NAPRAVIT VÝBĚREM ODPOVÍDAJÍCÍCH ČÁSTÍ 
POSTAVY ZAKRYTÝCH OBLEČENÍM A NASTAVENÍM JEJICH NEVIDITELNOSTI POMOCÍ 
PALETY VLASTNOSTÍ.  

 

PŘIDÁNÍ A IMPORT REKVIZIT  ADDING & IMPORTING, PROPS (orig.148) 

Je několik zpŧsobŧ pro vloţení rekvizit do Poseru 7: 
 

KNIHOVNA REKVIZIT  THE PROPS LIBRARY (orig.148) 

Rekvizity mŧţete do scény přidávat z palet knihoven Library, kategorie Props, jak je popsáno v části 
“Přidání vlasů” na straně 38. 
 

IMPORT REKVIZIT  IMPORTING PROPS (orig.148) 

Rekvizity vytvořené v jiných 3D aplikacích mŧţete importovat pomocí funkce importu Poseru 7, jak je 
popsáno v části “Import” na straně 186. 

Poser 7 umístí rekvizitu v pracovním prostoru do Vámi specifikovaného originálního bodu. Pokud tento 
bod nespecifikujete, rekvizita se zobrazí v centru pracovního prostoru. Pokud importujete rekvizitu  
a nevidíte ji, mŧţe to být tím, ţe rekvizita je příliš veliká, nebo aktuálně zvolená kamera je příliš blízko, 
aby rekvizitu zobrazila. Zkuste sníţit přiblíţení, anebo přepněte mezi kamerami. Následně budete 
muset změnit měřítko rekvizity a posunout ji na místo, kde ji ve scéně chcete mít. K tomu pouţijte 
editační nástroje Editing tools, nebo otočné ovladače parametrŧ Parameter dials. 
 

POSUN, ZMĚNA VELIKOSTI A DEFORMACE REKVIZIT 
MOVING, RESIZING, AND DEFORMING PROPS (orig.148) 

Posun, změnu velikosti a deformaci rekvizit mŧţete provést pomocí editačních nástrojŧ Editing tools, 
palety vlastností Properties, anebo palety parametrŧ Parameters. 
 

VYMAZÁNÍ REKVIZIT  DELETING PROPS (orig.148) 

Pro vymazání rekvizity ze scény ji nejprve vyberte a následně zvolte příkaz Object>Delete Object, 
nebo stiskněte klávesu [DEL]. 
 

VYTVÁŘENÍ NOVÝCH REKVIZIT  CREATING NEW PROPS (orig.149) 

Pro výběr poţadovaných polygonŧ na figuře nebo rekvizitě 
pouţijte nástroj pro vytvoření skupiny Grouping tool, jak je 
popsáno v části “Editor skupin” na straně 125. Tato funkce 
umoţņuje vytváření nových rekvizit. Obrázek ukazuje například 
obličejovou masku, vytvořenou podle vybraných polygonŧ tváře 
figury, která byla následně exportována do 3D modelovací 
aplikace pro dokončení finálních úprav. 
Pro vytvoření rekvizity: 

Vyberte rekvizitu nebo část postavy, kterou si přejete pouţít jako 
základ pro novou rekvizitu. 

1. Pouţijte nástroj Grouping tool pro otevření palety editoru 
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skupiny Group Editor. 

2. Vyberte polygony do nové skupiny, vytvořte a pojmenujte rekvizitu. 

3. Nová rekvizita bude nyní zobrazena v rozbalovacím menu aktuálního prvku Current Actor a mŧţe 
být přesouvána, tvarována a editována stejně jako ostatní rekvizity.  

Svoji novou rekvizitu mŧţete uloţit do palety Library, jak je popsáno v části “Přidání položek do 
knihovny” na straně 33. 
 

VYTVOŘENÍ PARAMETRŮ REKVIZITY  CREATING PROP PARAMETERS (orig.149) 

Pro vytvoření nových parametrŧ Vaší rekvizity mŧţete pouţít morph targety. Navštivte prosím téma 
“Tvorba a použití morph targetů” na straně 117 pro více informací o morph targetech. 
 

NULOVÝ BOD REKVIZITY  THE PROP ORIGIN (orig.149) 

Nulový bod rekvizity je v pracovním okně Document zobrazen jako 3D nitkový kříţ. Jedná se o bod, 
okolo kterého se rekvizita otáčí nebo mění svou velikost. Pokud rekvizitou otáčíte, tato rotuje okolo 
svého nulového bodu. Při změně velikosti se rekvizita zvětšuje nebo zmenšuje podle nulového bodu. 
Nulový bod rekvizity mŧţete zobrazit pomocí výběru poţadované rekvizity a následným označením 
políčka Display Origin v paletě vlastností Properties. 

Nulový bod rekvizity mŧţete přesouvat pomocí otočných ovladačŧ parametrŧ originXYZ. Přesunutím 
nulového bodu změníte centrum rotace a změny velikosti rekvizity. Pokud nastavujete parametry 
nulového bodu, pamatujte na to, ţe provádíte změny originální pozice nulového bodu rekvizity, ne 
aktuální pozice rekvizity. 
 

VLASTNOSTI REKVIZIT  PROP PROPERTIES (orig.149) 

Rekvizity mají následující vlastnosti: 

o Internal Name: Políčko Internal Name zobrazuje interní (skryté) jméno rekvizity, které Poser 7 
pouţívá při identifikaci rekvizity. Vnitřní jmeno rekvizity nemŧţete pomocí Poseru 7 změnit. 

o Name: Políčko Name zobrazuje jméno rekvizity (viditelné). Do tohoto políčka mŧţete zapsat 
jakékoliv pojmenování podle potřeby. 

o Visible: Označením políčka Visible bude nastavena viditelnost rekvizity ve scéně, a naopak. 
Neviditelné rekvizity nejsou zahrnuty do výpočtu renderu a nebudou zobrazeny v renderované 
scéně. Viz “Vlastnosti figur” na straně 75 pro informace o animaci a vlastnosti Visible. 

o Visible in Raytracing: Označením políčka Visible in Raytracing učiníte rekvizitu viditelnou 
v odlescích, stejně jako například figuru v zrcadle. Při neoznačeném políčku se rekvizita 
v odlescích nezobrazí. 

o Casts Shadows: Označením políčka Casts Shadows bude vybraná rekvizita vrhat stín, který bude 
ve scéně viditelný. Při neoznačeném políčku nebude vybraná rekvizita vrhat ţádný stín. 

o Display Origin: Označením políčka Display Origin bude zobrazen nulový bod rekvizity. Prosím 
navštivte téma “Nulový bod rekvizity” na straně 108 pro více informací o nulovém bodu. 

o Collision detection: Označením políčka Collision Detection se aktivuje detekce kolize aktuálně 
vybrané rekvizity. Prosím navštivte téma “Kolize” na straně 42 pro více informací o detekci kolize. 

o Apply Collision Setting to Children: Kliknutím na tlačítko Apply Collision Setting to Children bude 
detekce kolize aktuálně vybrané rekvizity aplikována také na podřízené („dětské“ v rámci hierarchie 
Poseru 7) prvky rekvizity (pokud nějaké existují). 

o Load Morph Target: Kliknutím na tlačítko Load Morph Target se zobrazí dialogové okno Load 
Morph Target, umoţņující pro vybranou rekvizitu přidat uţivatelský morph target (který je pak 
editovatelný za pouţití nástroje morphingu Morphing Tool, jak je popsáno v části „Nástroj 
Morphingu“ na straně 74). Prosím navštivte téma “Tvorba a použití morph targetů” na straně 117 
pro více informací o morph targetech. 

o Set Parent: Kliknutím na tlačítko Set Parent bude rekvizita přiřazena mateřskou vazbou k jinému 
prvku scény (rekvizita bude „dítětem“ tohoto prvku). Prosím navštivte téma “Změna mateřských 
vazeb” na straně 201 pro informace o nastavení mateřských vazeb rekvizity. 
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o Displacement Bounds: Vlastnost Displacement Bounds určuje hodnotu hranice vytlačení povrchu 
zvolené rekvizity (zvýraznění plasticity povrchu). Prosím navštivte kapitolu 36: “Použití 
renderovacího nástroje FireFly” na straně 249 pro více informací o hranici vytlačení. 

o Shading Rate: Vlastnost Shading Rate umoţņuje specifikovat velikost mikropolygonŧ v pixelech, 
které vznikají dělením polygonŧ povrchu aktuálně vybrané rekvizity během renderu. Sniţováním 
hodnoty Shading Rate se zvyšuje kvalita renderu, ale zvyšují se také nároky na výpočetní výkon. 
Prosím navštivte kapitolu 36: “Použití renderovacího nástroje FireFly” na straně 249 pro více 
informací o vlastnosti Shading Rate. 

o Smooth Polygons: Označením políčka Smooth Polygons bude Poser 7 vyhlazovat polygony 
vybrané rekvizity během renderu kvŧli eliminaci a potlačení hranatého vzhledu prvku zpŧsobeného 
pouţitím plochých polygonŧ. Tato funkce mŧţe u ostrých hran vytvořit dojem zakulacení. Jestli 
dotčená rekvizita obsahuje ostré hrany, mŧţete experimentovat se zakázáním této funkce pro 
dosaţení optimálního výsledku. 

 

PARAMETRY REKVIZIT  PROP PARAMETERS (orig.151) 

Rekvizity mají následující parametry: 

o Scale: Otočný ovladač parametru Scale zvětšuje nebo zmenšuje vybranou rekvizitu ve všech třech 
osách rovnoměrně.  

o XYZScale: Otočné ovladače parametrŧ xScale, yScale a zScale zvětšují nebo zmenšují vybranou 
rekvizitu jen podél zvolené osy. 

o XYZRotate: Otočné ovladače parametrŧ xRotate, yRotate a zRotate otáčejí celou rekvizitou okolo 
příslušných os X, Y, nebo Z. 

o XYZTran: Otočné ovladače parametrŧ xTran, yTran a zTran posouvají celou rekvizitou podél 
příslušných os. 
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Kapitola 13: Modifikace figur a rekvizit 
MODIFYING FIGURES & PROPS (orig. 152) 

Tato kapitola vysvětluje, jak je moţné vytvořit kompletně uţivatelsky 
modifikovaný vzhled figury a rekvizity. Lidská postava například 
dostane zcela nový tvar a rozměry. Proporce mŧţete modifikovat 
pomocí rŧzných nástrojŧ k dosaţení zajímavých efektŧ.  
 

O EDITACI FIGUR A REKVIZIT   
ABOUT EDITING FIGURES AND PROPS (orig.152) 

Poser 7 obsahuje širokou škálu nástrojŧ pro úpravu tvaru figury/rekvizity. Zde jsou některé tipy, triky  
a zajímavosti související s editací figur anebo rekvizit: 

o Všechny figury Poseru jsou dodávány s morph targety, umoţņujícími změnu tvaru jedné nebo více 
částí postavy. 

o Mŧţete pouţít nástroj pro seskupování Grouping tool (viz “Editor skupin” na straně 125) pro 
tvorbu oblečení, vlasŧ a dalších skupin. Mŧţete také deformovat celé skupiny polygonŧ. Nástroj 
Grouping tool se nachází mezi editačními nástroji Editing tools. 

o Nástroje Scale (změna velikosti) a Taper (zúţení) (viz “Změna velikosti” na straně 73 a “Zúžení” na 
straně 73) mohou změnit tvary částí postavy. Nástroje Scale a Taper se nacházejí mezi editačními 
nástroji Editing tools. 

o Deformátory (magnety, silová pole a křivky) mohou také změnit tvary postavy. 

o Části postavy mŧţete nahradit rekvizitami (viz “Nahrazení části těla rekvizitou” na straně 202). 

o Vytvořené dílo mŧţete uloţit pro opakované pouţití do palety knihoven Library. 

o Modifikovat mŧţete celé figury, nebo jen individuální části postavy. Například zvětšením břicha 
postavy mŧţete vytvořit „pivní břicho“. Rozšířením hlavy se vytvoří také široká tvář. Úpravy tvarŧ 
figury jsou jednodušší, pokud je figura nastavena v základní póze, u které mŧţete lépe vidět 
výsledek Vaší veškeré činnosti. 

o Bude vhodné, kdyţ si při modifikaci postavy z dŧvodu nerušeného pohledu skryjete další figury  
a rekvizity ve scéně (viz “Skrytí figury” na straně 198). 

o Jakmile dokončíte modifikaci tvarŧ a póz kaţdé části postavy, mŧţete je uzamknout, jak je 
popsáno v části “Skrytí figury” na straně 198. Jakmile máte dokončené nastavení pózy celé figury, 
mŧţete ji zabezpečit proti nechtěným změnám pomocí uzamčení celé figury, jak je popsáno v části 
“Uzamčení figury” na straně 197. 

o Symetrie Symmetry mŧţe být velkou úsporou času, umoţņující nastavení pózy pouze jedné 
poloviny figury a aplikaci této pózy na druhou polovinu. Prosím navštivte téma “Symetrie” na straně 
197 pro informace o pouţití symetrie. Mŧţete také pouţít funkce pro výjmutí a vloţení (viz kapitola 
24: “Menu editace” na straně 192) pro aplikaci póz mez rŧznými figurami. 

o Pokud to Váš počítač zvládne, doporučujeme aktivovat mód zobrazení Full Tracking (viz téma 
“Mód sledování cíle” na straně 45), při kterém mŧţete Vaší práci sledovat v reálném čase. Toto 
vyţaduje extra výpočetní sílu, která ovlivņuje celkový výkon aplikace v závislosti na specifikaci 
počítače a na komplexnosti scény. 

 

POUŢITÍ DEFORMÁTORŮ  USING DEFORMERS (orig.153) 

Deformátory Poseru 7 (magnety, silová pole, vlny, morphy) tvarují části postav, rekvizity a figury do 
nových zajímavých podob. Mŧţete například protáhnout nos, vytvořit pohyby břicha při chŧzi, vytvořit 
vlasy a oblečení vlající ve větru a vytvořit jakýkoliv tvar těla, který si jen dovedete představit. 
Nastavení a umístění deformátoru mŧţete animovat, coţ umoţņuje například vytvoření nárazu větru 
(silové pole), vyboulení svalstva (morph targety), apod. Vlny, silová pole a magnety mohou také tvořit 
uţivatelské morph targety. Prosím navštivte téma “Tvorba a použití morph targetů” na straně 117 pro 
více informací o morph targetech. 
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MAGNETY  MAGNETS (orig.153) 

Magnety deformují objekty jejich protahováním. Na magnety mŧţete pouţít 
nástroje Rotate, Twist, Translate a Scale. Prosím navštivte téma “Editační 
nástroje” na straně 71 pro informace o pouţití editačních nástrojŧ Editing 
tools. Zde máte příklad koule deformované magnetem:  
 

VYTVOŘENÍ DEFORMÁTORU MAGNET   
CREATING MAGNET DEFORMERS (orig.153) 

Pro vytvoření magnetu vyberte objekt, který si přejete deformovat a zvolte 
Object>Create Magnet. Dojde k vytvoření tří objektŧ magnetu, které společně 
tvoří deformátor. 

Tyto tři části jsou: 

o Magnet Object: Objekt magnetu Magnet Object definuje chování aktuálního 
magnetu. 

o Magnet Base: Základna magnetu Magnet Base definuje nulový bod oblasti, která bude 
deformována. Posunutím základny magnetu Magnet Base dojde také k posunutí objektu magnetu 
Magnet Object. 

o Magnet Zone: Zóna magnetu Magnet Zone definuje oblast, která bude deformována. Zónu 
magnetu mŧţete posouvat a tvarovat podle Vašich potřeb. 

Magnety deformují oblast uvnitř zóny magnetu Magnet Zone podél osy, definované základnou 
magnetu Magnet Base a objektem magnetu Magnet Object, v míře závislé na vzdálenosti mezi 
objektem magnetu Magnet Object a základnou magnetu Magnet Base. 
 

POUŢITÍ EDITAČNÍCH NÁSTROJŮ S OBJEKTEM MAGNETU   
USING EDITING TOOLS WITH MAGNET OBJECTS (orig.154) 

Pro pouţití editačních nástrojŧ Editing tools na objekt magnetu Magnet Object, vyberte magnet 
pomocí rozbalovacího menu Current Actor a potom zvolte poţadovaný editační nástroj: 

o Rotate: Nástroj Rotate otáčí objektem magnetu okolo jeho tří os. 

o Twist: Nástroj Twist kroutí objektem magnetu podél jeho vlastní osy. 

o Translate/Pull: Nástroj Translate/Pull posouvá objekt magnetu horizontálně nebo vertikálně. 

o Translate In/Out: Nástroj Translate In/Out posouvá objekt magnetu dále nebo blíţe od středu 
pracovního prostoru Poseru 7. 

o Scale: Nástroj Scale zvětšuje nebo zmenšuje velikost objektu magnetu. 

 
VLASTNOSTI DEFORMÁTORU MAGNET  MAGNET DEFORMER PROPERTIES (orig.154) 

Objekty magnetu, základny magnetu a zóny magnetu obsahují vlastnosti, které mŧţete editovat 
pomocí palety vlastností Properties palette. 
 

Vlastnosti objektu magnetu  MAGNET OBJECT PROPERTIES (orig.154) 

Objekty magnetu Magnet Objects obsahují následující vlastnosti: 

o Name: Vlastnost Name umoţņuje přejmenování objektu magnetu pomocí zadání poţadovaného 
jména do tohoto políčka. 

o Visible: Zaškrtávací políčko Visible zapíná a vypíná viditelnost. Označením políčka bude objekt 
viditelný a naopak. Neviditelné objekty nejsou zahrnuty do výpočtu renderu a nejsou zobrazeny 
v renderované scéně. Viz téma “Vlastnosti figur” na straně 75 pro informaci o animaci vlastnosti 
Visible. 

o Add element to deform: Stiskem tlačítka Add element to deform dojde k otevření seznamu 
hierarchie, který umoţņuje přidání prvkŧ, které budou také magnetem deformovány. Toto funguje 
pouze tehdy, kdyţ se vybrané prvky nacházejí uvnitř zóny magnetu Magnet Zone. 
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Vlastnosti základny magnetu  MAGNET BASE PROPERTIES (orig.154) 

Základny magnetu Magnet Bases obsahují následující vlastnosti: 

o Name: Vlastnost Name umoţņuje přejmenování základny magnetu pomocí zadání poţadovaného 
jména do tohoto políčka. 

o Visible: Zaškrtávací políčko Visible zapíná a vypíná viditelnost. Označením políčka bude objekt 
viditelný a naopak. Neviditelné objekty nejsou zahrnuty do výpočtu renderu a nejsou zobrazeny 
v renderované scéně. Viz téma “Vlastnosti figur” na straně 75 pro informaci o animaci vlastnosti 
Visible. 

o Display Origin: Zaškrtávací políčko Display Origin zobrazuje osy základny magnetu. Toto je 
uţitečné proto, ţe posuny, otáčení, apod. jsou zaloţeny na osách základny magnetu a ne na 
pracovním prostoru Poseru 7. Viz Poser 7 Tutorial Manual, “3D Basics: Global Vs. Local 
Coordinates” pro vysvětlení lokálních a globálních souřadnic. 

o Casts Shadows: Označením zaškrtávacího políčka Casts Shadows bude zvolená část postavy 
vrhat stíny v případě, ţe bude viditelná ve scéně. Při neoznačeném políčku nebude vybraná část 
postavy vrhat ţádný stín. 

o Load Morph Target: Kliknutím na tlačítko Load Morph Target se zobrazí dialog Load Morph 
Target, který umoţņuje načtení uţivatelského morph targetu pro zvolenou základnu magnetu 
(který je dále editovatelný ze pouţití nástroje morphingu Morphing Tool, jak je popsáno v části 
“Nástroj morphingu” na straně 74). Prosím navštivte téma “Tvorba a použití morph targetů” na 
straně 117 pro více informací o morph targetech. 

o Set Parent: Kliknutím na tlačítko Set Parent bude základna magnetu přiřazena mateřskou vazbou 
k jinému prvku scény (základna magnetu bude „dítětem“ tohoto prvku). Prosím navštivte Poser 7 
Tutorial Manual, “More 3D Elements: Hierarchy” pro popis hierarchie vazeb a téma “Změna 
mateřských vazeb” na straně 201 pro informace o nastavení mateřských vazeb rekvizity. 

 

Vlastnosti zóny magnetu  MAGNET ZONE PROPERTIES (orig.155) 

Zóny magnetu Magnet Zones obsahují následující vlastnosti: 

o Name: Vlastnost Name umoţņuje přejmenování zóny magnetu pomocí zadání poţadovaného 
jména do tohoto políčka. 

o Visible: Zaškrtávací políčko Visible zapíná a vypíná viditelnost. Označením políčka bude objekt 
viditelný a naopak. 

o Group: Označením zaškrtávacího políčka Group se aktivuje seskupování, umoţņující deformaci 
skupiny vybraných prvkŧ. Mŧţete vytvářet skupiny pro deformace a tyto skupiny se mohou skládat 
z částí jedné nebo více prvkŧ postavy, rekvizit, atd. Prosím navštivte téma “Editor skupin” na straně 
124 pro informace o pouţití nástroje Grouping tool. Skupina je vybrána, pokud je v seznamu 
skupin zaškrtnuto její políčko. 

o Edit Falloff Graph: Kliknutím na tlačítko Edit Falloff Graph umoţníte editaci grafu pŧsobení zóny 
magnetu, který určuje, kde oblast deformace končí a uvadá. Prosím sledujte následující informace 
o pouţití tohoto grafu. 

o Set Parent: Kliknutím na tlačítko Set Parent bude zóna magnetu přiřazena mateřskou vazbou 
k jinému prvku scény (zóna magnetu bude „dítětem“ tohoto prvku). Prosím navštivte Poser 7 
Tutorial Manual, “More 3D Elements: Hierarchy” pro popis hierarchie vazeb a téma “Změna 
mateřských vazeb” na straně 201 pro informace o nastavení mateřských vazeb rekvizity. 

 POZNÁMKA 
NASTAVENÍ STYLU ZOBRAZENÍ ZÓNY MAGNETU NA 
WIREFRAME MŦŢE POMOCI ZVIDITELNIT MAGNET  
V OKNĚ DOKUMENTU. 

 

Falloff graf zóny magnetu   
MAGNET ZONE FALLOFF GRAPH (orig.156) 

Volbou poloţky Edit Falloff Graph v paletě vlastností zóny 
magnetu otevřete okno Magnet Zone Falloff:  
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Levá strana tohoto grafu zobrazuje střed zóny magnetu a pravá 
strana její okraj. V základním nastavení je zobrazena hladká 
křivka, to znamená, ţe účinek magnetu se postupně sniţuje 
směrem od středu k okraji zóny. Nastavením této křivky mŧţete 
měnit vlastnosti uvadání účinku magnetu: 

Pro posunutí kontrolních bodŧ klikněte na některý z nich a 
posuņte jej nahoru nebo dolŧ. Zvýšením kontrolního bodu se 
účinek zóny magnetu v daném místě zvyšuje. Pro přidání 
kontrolního bodu klikněte na jakékoliv místo podél křivky. Přidané 
kontrolní body nemŧţete odstranit.  
 

PARAMETRY OBJEKTU MAGNETU  MAGNET OBJECT PARAMETERS (orig.156) 

Objekty magnetŧ mají následující otočné ovladače parametrŧ v paletě parametrŧ Parameters: 

o Scale: Otočný ovladač parametru Scale zvětšuje a zmenšuje velikost objektu magnetu ve všech 
osách. 

o XYZScale: Otočné ovladače parametrŧ xScale, yScale a zScale zvětšují a zmenšují velikost 
objektu magnetu ve vybraných osách. 

o XYZRotate: Otočné ovladače parametrŧ xRotate, yRotate a zRotate otáčejí objektem magnetu 
okolo vybrané osy. 

o XYZTran: Otočné ovladače parametrŧ xTran, yTran a zTran posouvají objektem magnetu okolo 
vybrané osy. 

 

UZAMČENÍ MAGNETU  LOCKING MAGNETS (orig.156) 

Magnety mŧţete uzamknout kvŧli ochraně proti nechtěným změnám. Prosím navštivte téma 
“Uzamčení prvku” na straně 201. 
 

SILOVÁ POLE VĚTRU  WIND FORCE FIELDS (orig.157) 

Volbou poloţky Object>Create Wind Force vytvoříte silové pole větru, které 
přidá realistický efekt větru do Vaší scény. Silová pole ovlivņují praménkové 
vlasy a dynamické oblečení. 

Pozici silového pole mŧţete nastavovat pomocí editačních nástrojŧ Editing 
tools stejným zpŧsobem, jako ostatní rekvizity.  
 

VLASTNOSTI SILOVÉHO POLE  FORCE FIELD PROPERTIES (orig.157) 

Silová pole obsahují následující vlastnosti, dostupné v paletě vlastností Properties: 

o Internal Name: Políčko Internal Name zobrazuje interní (skrytý) název silového pole, který Poser 7 
pouţívá pro své vnitřní potřeby a výpočty. Interní název silového pole nemŧţete uvnitř Poseru 7 
změnit. 

o Name: Políčko Name zobrazuje pojmenování silového pole. Podle potřeby mŧţete do tohoto 
políčka zadat jméno nové. 

o Visible: Zaškrtávací políčko Visible zapíná a vypíná viditelnost. Označením políčka bude silové 
pole viditelné a naopak. Neviditelné objekty nejsou zahrnuty do výpočtu renderu a nejsou 
zobrazeny v renderované scéně. Viz téma “Vlastnosti figur” na straně 75 pro informaci o animaci 
vlastnosti Visible. 

o Visible in Raytracing: Označením políčka Visible in Raytracing učiníte silové pole viditelné 
v odlescích, jako například figura v zrcadle. Při neoznačeném políčku se silové pole v odlescích 
nezobrazí. 

o Casts Shadows: Označením zaškrtávacího políčka Casts Shadows bude silové pole vrhat stíny 
v případě, ţe bude viditelné ve scéně. Při neoznačeném políčku nebude silové pole vrhat ţádný 
stín. 
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o Display Origin: Zaškrtávací políčko Display Origin zobrazuje osy silového pole. Prosím navštivte 
téma “Nulový bod rekvizity” na straně 108 pro více informací o nulovém bodu silového pole. 

o Collision detection: Označením políčka Collision Detection se aktivuje detekce kolize silového 
pole. Prosím navštivte téma “Kolize” na straně 42 pro více informací o detekci kolize. 

o Apply Collision Setting to Children: Kliknutím na tlačítko Apply Collision Setting to Children bude 
detekce kolize silového pole aplikována také na podřízené („dětské“ v rámci hierarchie Poseru 7) 
části silového pole (pokud nějaké existují). 

o Load Morph Target: Kliknutím na tlačítko Load Morph Target se zobrazí dialog Load Morph 
Target, který umoţņuje načtení uţivatelského morph targetu pro zvolené silové pole (který je dále 
editovatelný ze pouţití nástroje morphingu Morphing Tool). Prosím navštivte téma “Tvorba  
a použití morph targetů” na straně 117 pro více informací o morph targetech. 

o Set Parent: Kliknutím na tlačítko Set Parent bude silové pole přiřazeno mateřskou vazbou k jinému 
prvku scény (silové pole bude „dítětem“ tohoto prvku). Prosím navštivte Poser 7 Tutorial Manual, 
“More 3D Elements: Hierarchy” pro popis hierarchie vazeb a téma “Změna mateřských vazeb” na 
straně 201 pro informace o nastavení mateřských vazeb rekvizity. 

o Displacement Bounds: Vlastnost Displacement Bounds určuje hodnotu hranice vytlačení povrchu 
silové pole (zvýraznění plasticity povrchu). Prosím navštivte kapitolu 36: “Použití renderovacího 
nástroje FireFly” na straně 249 pro více informací o hranici vytlačení. 

o Shading Rate: Vlastnost Shading Rate umoţņuje specifikovat velikost mikropolygonŧ v pixelech, 
které vznikají dělením polygonŧ povrchu silového pole během renderu. Prosím navštivte kapitolu 
36: “Použití renderovacího nástroje FireFly” na straně 249 pro více informací o vlastnosti Shading 
Rate. 

 

PARAMETRY SILOVÉHO POLE  FORCE FIELD PARAMETERS (orig.158) 

Silová pole obsahují následující parametry, dostupné v paletě parametrŧ Parameters: 

o Scale: Otočný ovladač parametru Scale zvětšuje a zmenšuje velikost silového pole ve všech 
osách. 

o XYZScale: Otočné ovladače parametrŧ xScale, yScale a zScale zvětšují a zmenšují velikost 
silového pole ve vybraných osách. 

o XYZRotate: Otočné ovladače parametrŧ xRotate, yRotate a zRotate otáčejí silovým polem okolo 
vybrané osy. 

o XYZTran: Otočné ovladače parametrŧ xTran, yTran a zTran posouvají silovým polem okolo 
vybrané osy. 

o Amplitude: Parametr Amplitude nastavuje účinek silového pole. Zvýšení této hodnoty zvyšuje 
rychlost větru, a naopak. 

o Spread Angle: Parametr Spread Angle specifikuje úhel efektu silového pole ve stupních. 

o Range: Parametr Range specifikuje dosah efektu silového pole v aktuálně zvolených jednotkách 
(stopy, millimetry, atd.). 

o Turbulence: Parametr Turbulence specifikuje míru nerovnoměrnosti efektu proudu větru silového 
pole a mŧţe být pouţit pro simulaci prudkého závanu větru. 

 

VLNOVÉ DEFORMÁTORY   
WAVE DEFORMERS (orig.159) 

Vlnové deformátory deformují objekty vytvořením zvlněného 
povrchu. U vlnových deformátorŧ mŧţete pouţít nástroje Rotate, 
Twist, Translate a Scale. Prosím navštivte téma “Editační 
nástroje” na straně 71 pro informace o pouţití editačních 
nástrojŧ. Zde je příklad koule deformované pomocí vln:  
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VYTVOŘENÍ VLNOVÉHO DEFORMÁTORU  CREATING WAVE DEFORMERS (orig.159) 

Pro vytvoření vlnového deformátoru vyberte objekt, který si přejete deformovat a poté zvolte příkaz 
Object>Create Wave. Dojde k vytvoření dvou objektŧ vln Wave, které společně tvoří deformátor. Tyto 
dvě části jsou: 

o Wave Object: Objekt vlny Wave Object definuje chování aktuální vlny. 

o Wave Zone: Zóna vlny Wave Zone definuje oblast, která bude deformována. Podle potřeby 
mŧţete zónu vlny posouvat a tvarovat. 

 

POUŢITÍ EDITAČNÍCH NÁSTROJŮ U VLNOVÝCH DEFORMÁTORŮ  
USING EDITING TOOLS WITH WAVE DEFORMERS (orig.159) 

Pro pouţití editačních nástrojŧ Editing tools na objekt vlny Wave Object zvolte vlnu v rozbalovacím 
menu Current Actor a následně vyberte poţadovaný editační nástroj: 

o Rotate: Nástroj Rotate otáčí objektem/zónou vlny okolo jejich tří os. 

o Twist: Nástroj Twist kroutí objektem/zónou vlny podél její vlastní osy. 

o Translate/Pull: Nástroj Translate/Pull posouvá objektem/zónou vlny horizontálně nebo vertikálně. 
Toto nefunguje u radiální vlny Radial wave. 

o Translate In/Out: Nástroj Translate In/Out posouvá objektem/zónou vlny dále nebo blíţe od středu 
pracovního prostoru Poseru 7. 

o Scale: Nástroj Scale zvětšuje nebo zmenšuje velikost objektu/zóny vlny. 
 

VLASTNOSTI VLNOVÉHO DEFORMÁTORU  WAVE DEFORMER PROPERTIES (orig.159) 

Objekty a zóny vlny obsahují následující vlastnosti, které mŧţete editovat v paletě vlastností 
Properties: 
 

Vlastnosti objektu vlny  WAVE OBJECT PROPERTIES (orig.159) 

Objekty vlny obsahují následující vlastnosti: 

o Name: Políčko Name zobrazuje pojmenování objektu vlny. Podle potřeby mŧţete do tohoto políčka 
zadat jméno nové. 

o Visible: Zaškrtávací políčko Visible zapíná a vypíná viditelnost. Označením políčka bude objekt 
viditelný a naopak. Neviditelné objekty nejsou zahrnuty do výpočtu renderu a nejsou zobrazeny 
v renderované scéně. Viz téma “Vlastnosti figur” na straně 75 pro informaci o animaci vlastnosti 
Visible. 

o Radial Wave: Označením tlačítka předvolby radiální vlny Radial Wave bude vlna vycházet 
z nulového bodu obdobně jako kola na vodní hladině. 

o Directional Wave: Označením tlačítka předvolby směrové vlny Directional Wave se vlna bude šířit 
v lineárním tvaru. Následující dvě vlastnosti určují směr šíření vlny. 

o Deformer Aligned: Označením tlačítka předvolby Deformer Aligned nastavíte vlny, aby se šířily 
podél směru objektu vlny Wave Object. 

o Object Normals: Označením tlačítka předvolby Object Normals nastavíte vlny, aby se šířily podél 
kolmic objektu. 

o Add element to deform: Kliknutím na tlačítko Add element to deform dojde k otevření seznamu 
hierarchie, který umoţņuje výběr prvkŧ, které budou přidány k deformaci vlnou. Toto funguje jen 
tehdy, kdyţ se vybrané prvky nacházejí uvnitř zóny vlny Wave Zone. 

 

Vlastnosti zóny vlny  WAVE ZONE PROPERTIES (orig.160) 

Zóny vlny obsahují následující vlastnosti: 

o Name: Vlastnost Name umoţņuje přejmenování zóny vlny pomocí zadání poţadovaného jména do 
tohoto políčka. 
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o Visible: Zaškrtávací políčko Visible zapíná a vypíná viditelnost. Označením políčka bude objekt 
viditelný a naopak. Neviditelné objekty nejsou zahrnuty do výpočtu renderu a nejsou zobrazeny 
v renderované scéně. Viz téma “Vlastnosti figur” na straně 75 pro informaci o animaci vlastnosti 
Visible. 

o Group: Označením zaškrtávacího políčka Group se aktivuje seskupování, umoţņující deformaci 
skupiny vybraných prvkŧ. Mŧţete vytvářet skupiny pro deformace a tyto skupiny se mohou skládat 
z částí jedné nebo více prvkŧ postavy, rekvizit, atd. Prosím navštivte téma “Editor skupin” na straně 
125 pro informace o pouţití nástroje Grouping tool. Skupina je vybrána, pokud je v seznamu 
skupin zaškrtnuto její políčko. 

o Edit Falloff Graph: Kliknutím na tlačítko Edit Falloff Graph umoţníte editaci grafu pŧsobení zóny 
vlny, který určuje, kde oblast deformace končí a uvadá. Prosím sledujte následující informace  
o pouţití tohoto grafu. 

o Set Parent: Kliknutím na tlačítko Set Parent bude zóna vlny přiřazena mateřskou vazbou k jinému 
prvku scény (zóna vlny bude „dítětem“ tohoto prvku). Prosím navštivte Poser 7 Tutorial Manual, 
“More 3D Elements: Hierarchy” pro popis hierarchie vazeb a téma “Změna mateřských vazeb” na 
straně 201 pro informace o nastavení mateřských vazeb rekvizity. 

 POZNÁMKA 
NASTAVENÍ STYLU ZOBRAZENÍ ZÓNY VLNY NA WIREFRAME MŦŢE POMOCI ZVIDITELNIT 
VLNU V OKNĚ DOKUMENTU. 
 

Falloff graf zóny vlny  WAVE ZONE FALLOFF GRAPH (orig.161) 

Kliknutím na tlačítko Edit Falloff Graph v paletě vlastností zóny vlny dojde k otevření okna Wave 
Zone Falloff window, které vypadá a funguje stejně jako Magnet Falloff Graph, popsaný v části 
“Falloff graf zóny magnetu” na straně 112. 
 

PARAMETRY VLNOVÉHO DEFORMÁTORU  WAVE DEFORMER PARAMETERS (orig.161) 

Vlnové deformátory mohou pouţít následující otočné ovladače parametrŧ z palety parametrŧ 
Parameters: 

o Scale: Otočný ovladač parametru Scale zvětšuje a zmenšuje velikost objektu vlny ve všech osách. 

o XYZScale: Otočné ovladače parametrŧ xScale, yScale a zScale zvětšují a zmenšují velikost zóny 
vlny ve vybraných osách. Tento parametr je dostupný pouze pro zónu vlny. 

o XYZRotate: Otočné ovladače parametrŧ xRotate, yRotate a zRotate otáčejí objektem vlny okolo 
vybrané osy. 

o XYZTran: Otočné ovladače parametrŧ xTran, yTran a zTran posouvají objektem vlny okolo 
vybrané osy. 

Kromě toho jsou zde určité ovladače parametrŧ, které jsou dostupné pouze pro vlny: 

o Phase: Otočný ovladač parametru Phase definuje pozici vlny v nekonečném čase. Tento parametr 
se pouţívá při animaci vln. 

o Amplitude: Otočný ovladač parametru Amplitude definuje výšku vlny. 

o Wavelength: Otočný ovladač parametru Wavelength definuje vzdálenost mezi vrcholky vln 
(frekvenci). 

o Stretch: Otočný ovladač parametru Stretch nastavuje ostrost kaţdé vlny. 

o Amp Noise: Otočný ovladač parametru Amp Noise definuje náhodnost nebo poruchy amplitudy 
vln. 

o Freq Noise: Otočný ovladač parametru Freq Noise definuje náhodnost nebo poruchy typické 
frekvence vln. 

o Sinusoidal: Otočný ovladač parametru Sinusoidal definuje velikost sinusového tvaru vlny. 

o Square: Otočný ovladač parametru Square definuje tvar vlny. Zvyšováním této hodnoty se vytváří 
vlny čtvercového tvaru. 
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o Triangular: Otočný ovladač parametru Triangular definuje tvar vlny. Zvyšováním této hodnoty se 
vytváří vlny trojúhelníkového tvaru. 

o Turbulence: Otočný ovladač parametru Turbulence definuje rozeklanost tvaru vlny. Zvyšováním 
této hodnoty se vytváří rozeklané, turbulentní vlny, a naopak. 

o Offset: Otočný ovladač parametru Offset definuje, zda se tvar vlny nachází nad nebo pod nulovým 
bodem vlny. Zvyšováním této hodnoty se vytváří vlny daného tvaru nad nulovým bodem. Toto je 
uţitečné v případě, kdyţ chcete deformaci vlnou pouţít na šaty pod leţící postavou. 

 

POUŢITÍ DEFORMÁTORŮ PRO SKUPINU OBJEKTŮ   
USING DEFORMERS WITH GROUPED OBJECTS (orig.162) 

Uţivatelské skupiny objektŧ mŧţete vytvářet pomocí palety editoru skupin Group Editor, jak je 
popsáno v části “Editor skupin” na straně 125 a na tyto skupiny mŧţete aplikovat deformátory. 
Skupiny mohou obsahovat prvky jedné nebo více částí postavy/rekvizity. Tyto skupiny mŧţete vybírat 
pomocí jejich názvu za pouţití palety vlastností Properties pro vybrané magnety nebo vlny. Pro 
aplikaci deformátoru na skupinu: 

Vyberte část postavy/rekvizity obsahující skupinu. 

1 Vytvořte deformátor, jak bylo popsáno výše. 

2 Vyberte zónu deformátoru a vstupte do palety vlastností zóny, jak bylo popsáno výše. Označte 
políčko Group, následně vyberte jednu nebo více skupin z rozbalovacího menu, které se zobrazí. 
Skupiny bude vybrána, pokud se u ní zobrazí odpovídající označení. 

Tímto dojde k vykonání procedury deformace na seskupenou část postavy/rekvizity. 
 

POUŢITÍ OTOČNÝCH OVLADAČŮ PARAMETRŮ POSTAVY 
USING BODY PARAMETER DIALS (orig.162) 

Otočné ovladače parametrŧ postavy jsou dostupné při pouţití palety parametrŧ Parameters. Prosím 
navštivte téma “Otočné ovladače parametrů postavy” na straně 79 pro informace o pouţití otočných 
ovladačŧ parametrŧ postavy. 
 

TVORBA A POUŢITÍ MORPH TARGETŮ   
CREATING AND USING MORPH TARGETS (orig.162) 

Morph targety jsou uţivatelské parametry přidané k částím postavy nebo rekvizity, které umoţņují 
měnit tvar dotčených prvkŧ. Poser 7 obsahuje některé zabudované morph targety společně 
s dodanými figurami a další mŧţete vytvářet sami. Morph targety umoţņují jednoduše měnit velikost  
a tvar prvkŧ a jsou plnně animovatelné. 

 

Jakmile jsou morph targety zobrazeny jako otočné ovladače parametrŧ v paletě parametrŧ 
Parameters, obsahují uţivatelskou geometrii obsahující deformaci, která mŧţe být aplikována pomocí 
otočných ovladačŧ parametrŧ. 

Zdá se to matoucí? Jakmile tomu přijdete na kloub, je to ve skutečnosti celkem jednoduché. Pojďme 
tedy funkčnost zkoumat dále. Svŧj uţivatelský morph target mŧţete vytvořit pomocí Poseru 7 anebo 
jiné aplikace. Tato příručka primárně vysvětluje tvorbu morph targetŧ v Poseru 7, avšak zevrubně 
bude vysvětleno i pouţití ostatních aplikací. Uvnitř Poseru 7 mŧţete pouţít kombinace deformátorŧ  
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a existujících morph kanálŧ (jako je například parametr Worry) pro vytvoření morph targetŧ. Kaţdému 
morph targetu bude přidělen vlastní otočný ovladač parametrŧ, jakmile bude vybrán dotčený prvek  
a morph target bude načten. Pokud například budete vytvářet morph nazvaný Bulging Bicep pro 
nadloktí, uvidíte otočný ovladač parametrŧ Bulging Bicep v paletě parametrŧ Parameters vţdy, 
jakmile morph target načtete a vyberete nadloktí. 
 

NÁSTROJ MORPHINGU  THE MORPHING TOOL (orig.163) 

Klinutím na poloţku Morphing Tool v paletě editačních nástrojŧ Editing Tools dojde k otevření palety 
editoru morphingu Morph Editor. Nástroj morphingu Morphing Tool obsahuje dva operační módy: 
Combine (kombinování) a Create (tvorba). Klikněte na odpovídající záloţku editoru morphingu pro 
přepnutí mezi těmito dvěma módy. 
 

Záloţka Combine  THE COMBINE TAB (orig.163) 

Záloţka Combine editoru morphingu umoţņuje vizuální úpravu 
morph targetŧ figur pomocí výběru a přesunu polygonŧ. Toto 
mŧţete provést u jakéhokoliv objektu scény, který obsahuje 
morph targety. Prosím navštivte téma “Tvorba a použití morph 
targetů” na straně 117 pro více informací o morph targetech. 

Pro pouţití záloţky Combine: 

1. Vyberte část postavy, kterou chcete přetvářet, následně 
zvolte nástroj morphingu Morphing Tool. Zobrazí se paleta 
editoru morphingu Morph Editor. Záloţka Combine 
zobrazuje všechny dostupné morph targety pro vybranou 
část postavy:  

2. Seznam morph targetŧ obsahuje hierarchii a zobrazuje větve 
s dostupnými morph targety. Kliknutím na – ikonu dojde 
k uzavření rozbalené větve a klinutím na + ikonu dojde 
k rozbalení větve v hierarchii. K procházení seznamem mŧţete pouţít posuvník. Editor morphingu 
Morph Editor umoţņuje manipulaci se všemi vybranými morph targety. Označením políčka vedle 
morph targetu bude vybraný morph target aktivovám pro pouţití nástroje morphingu a naopak 
neoznačené morph targety nebudou nástrojem morphingu dotčeny. Jen tehdy, kdyţ je morph 
target aktivován, mŧţe nebo nemusí být ovlivněn pouţitím nástroje morphingu. Pokud například 
vyberete polygony na čele, nástroj bude mít efekt na obočí, ale nebude mít efekt na ústa. Vyberte 
poţadované morph targety a poté klikněte a táhněte libovolným polygonem vybrané části postavy. 

 

3. Jakmile máte určitou oblast části postavy v pozici, kterou jste poţadovali, mŧţete kliknout na 
tlačitko Pin a následně kliknout na jeden nebo více polygonŧ pro jejich „přišpendlení“, coţ tuto 
oblast ochrání proti další manupulaci při práci na jiných oblastech objektu. Přišpendlené polygony 
jsou označeny červenou tečkou na aktuálním objektu a mohou se pohybovat během nastavování 
dalších oblastí části postavy (v závislosti na mnoţství morph targetŧ, které ovlivńují přišpendlené 
polygony), nicméně tyto polygony si udrţují svoje nastavení. Polygony zŧstávají přišpendleny  
i tehdy, kdyţ ukončíte práci s nástrojem morphingu Morphing Tool a později jej opět spustíte. Pro 
ukončení přišpendlení polygonŧ klikněte na tlačítlo Morphing (viz dále). Při nastavování 
morphingu přišpendlených polygonŧ si mŧţete všimnout určitého chvění. 
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Paleta editoru morphingu Morph Editor obsahuje následující funkce: 

o Morphing: Kliknutím na tlačítko Morphing dojde k reaktivaci nástroje morphingu Morphing Tool. 
Kliknutím na toto tlačítko po přišpendlení polygonŧ dojde k uvolnění těchto polygonŧ pro 
pokračování v nastavování morphingu. 

o Pin: Kliknutím na tlačítko Pin se deaktivuje nástroj morphingu Morphing Tool a umoţņuje se 
přišpendlení jednoho nebo více polygonŧ, jak bylo popsáno výše. 

o Clear Morphs: Kliknutím na tlačítko Clear Morphs dojde k resetování všech morphingŧ. Pouţívejte 
tuto funkci opatrně, protoţe vrátí zpět všechny Vaše změny, dokonce i kdyţ ukončíte nástroj 
morphingu Morphing Tool a poté jej opět spustíte. 

o Clear Pins: Kliknutím na tlačítko Clear Pins dojde k odstranění všech přišpendlení, které byly dříve 
aplikovány na aktuální objekt. 

o Exaggeration min/max: Zdŧraznění Exaggeration určuje míru, kterou bude morph target pŧsobit 
na polygony. Hodnoty Exaggeration Min a Exaggeration Max určují limity moţného rozsahu 
efektu morph targetu při pouţití nástroje morphingu Morphing Tool. Ţádný morph target nemŧţe 
být modifikován mimo tyto hranice (viz téma “Editace otočných ovladačů parametrů” na straně 78 
pro více informací o limitech otočných ovladačŧ parametrŧ). Zvýšením těchto limitŧ se 
odpovídajícím zpŧsobem zvýší efekt zdŧraznění všech morph targetŧ. Pro technický popis funkce 
Exaggeration Min/Max si přečtěte následující poznámku. 

 POZNÁMKA 
Z MATEMATICKÉHO HLEDISKA KAŢDÝ MORPH TARGET DEFINUJE POSUNUTÍ VECTORU (V) 
KAŢDÉHO POLYGONU OBJEKTU A JEHO HODNOTU ZDŦRAZNĚNÍ DEFINUJE MULTIPLIKÁTOR 
(W). PROTO EFEKT MORPH TARGETU JE P + WV, KDE P JE ORIGINÁLNÍ POZICE POLYGONU. 
POKUD W=1, DOSTANEME V+P. W MŦŢE BÝT JAKÁKOLIV HODNOTA. VĚTŠÍ W ZNAMENÁ 
VĚTŠÍ ZDŦRAZNĚNÍ EFEKTU MORPH TARGETU. HODNOTY LIMITŦ EXAGGERATION MIN  
A EXAGGERATION MAX GLOBÁLNĚ DEFINUJÍ LIMITY HODNOTY W VŠECH MORPH TARGETŦ 
PŦSOBÍCÍHO NÁSTROJE MORPHINGU MORPHING TOOL. 

o Lock All: Kliknutím na tlačítko Lock All dojde k uzamčení všechl morph targetŧ, coţ deaktivuje 
další změny pomocí morphingu. Toto je uţitečné v případě, kdyţ jste spokojeni s hrubou úpravou  
a přejete si pouze provést jemné doladění několika specifických morphingŧ. V tom případě mŧţete 
pouţít tuto funkci a následně odemknout pouze ty morphingy, které si přejete ještě doladit. 

 POZNÁMKA 
PRO POSUNUTÍ PODÉL OSY Z, STISKNĚTE A PODRŢTE BĚHEM TÁHNUTÍ KLÁVESU 
[COMMAND]/[CTRL]. 
 

Záloţka Create  THE CREATE TAB (orig.165) 

Záloţka Create editoru morphingu Morph Editor umoţņuje výběr a modifikaci polygonové sítě za 
účelem vytvoření nového morph targetu. Stejně jako u záloţky Combine mŧţete funkci záloţky 
Create aplikovat na jakýkoliv objekt scény, který obsahuje síťový model. 

Při pouţití záloţky Create jsou deformace vytvářeny na polygonové síti aktuálně vybraného prvku. 
Kromě tvorby morph targetŧ pro individuální prvky, Poser 7 umoţņuje také tvorbu morphingŧ celé 
postavy Full-Body Morphs (FBMs). Pro více informací o Full-Body Morphs navštivte téma “Tvorba 
Full-Figure Morph Targetů” na straně 122. 

Pro pouţití záloţky Create: 

1. V horní části záloţky Create klikněte na tlačítko předvolby pro nástroj, kterým si přejete polygony 
modifikovat: Push (tlačit), Pull (táhnout), Smooth (vyhladit) nebo Restore (obnovit). 

o Push: Výběrem nástroje Push umoţníte stlačení polygonŧ ve vymezeném rozsahu směrem 
dovnitř originálního povrchu polygonové sítě, pro vytvoření vyhloubení, jako je dŧlek nebo 
zářez. 

o Pull: Výběrem nástroje Pull umoţníte vytaţení polygonŧ ve vymezeném rozsahu směrem vně 
originálního povrchu polygonové sítě. Tento nástroj je velmi uţitečný při opravě neţádoucích 
prŧnikŧ mezi figurou a přizpŧsobivým nebo dynamickým oblečením; mŧţete vybrat odpovídající 
plochu oblečení a jednoduše ji vytáhnout mimo body prŧniku s figurou. 
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o Smooth: Pomocí nástroje Smooth mŧţete postupně 
redukovat velikost nerovností povrchu polygonové sítě 
pro vytvoření hladšího povrchu. Toto je obzvlášť uţitečné 
pro povrchy s velkým mnoţstvím variací nerovností. 
Mějte na paměti, ţe tato volba obecně redukuje rozlišení. 

o Restore: Poloţka Restore postupně vrací Vaše 
předchozí provedené změny zpět směrem k originální 
geometrii bez morphingu. Tato funkce mŧţe být extrémně 
uţitečná při provádění jemného doladění modifikací 
polygonové sítě, protoţe umoţņuje vracet zpět 
provedené změny v pozvolných stupních.  

 POZNÁMKA 
NÁSTROJ RESTORE NENÍ TOTÉŢ CO NÁSTROJ UNDO. 
POKUD VYTVOŘÍTE NĚJAKÉ ZMĚNY A POTOM POUŢIJETE 
POLOŢKU EDIT>UNDO, CELÁ VAŠE ZMĚNA BUDE 
VYMAZÁNA A POLYGONOVÁ SÍŤ BUDE NAVRÁCENA DO 
STAVU PŘED PROVEDENÍM ZMĚNY. PŘI POUŢITÍ 
NÁSTROJE RESTORE MŦŢETE NAVRÁTIT EFEKTY 
PROVEDENÉ ZMĚNY POSTUPNĚ. TOTO UMOŢŅUJE 
EDITACI PROVEDENÉ ZMĚNY BEZ JEJÍHO ÚPLNÉHO 
ZTRACENÍ.  

2. Vyberte mód, ve kterém si přejete pracovat: Relative to 
Surface nebo Screen. 

o Surface: Pokud zvolíte mód Surface, všechny 
modifikace, které provedete na polygonové síti budou 
provedeny ve směru kolmice k povrchu. Toto je základní 
mód, protoţe ve většině případŧ budete chtít provádět 
právě úpravy ve směru kolmo k povrchu. 

o Screen: Mód Screen umoţņuje deformaci polygonové 
sítě v libovolném směru. Tato volba je uţitečná 
v situacích, kdyţ si přejete polygonovou síť deformovat 
ve vodorovném nebo svislém směru. Prosím všimněte si, 
ţe směr modifikace v obrazovkovém módu Screen je určen aktuálním pohledem na figuru 
vztaţeným k obrazovce. Pokud si například přejete deformovat polygonovou síť směrem ke 
kameře, musíte figuru otočit o devadesát stupņŧ a následně provést deformaci posunem myši 
do strany. 

3. Vyberte poţadovaný styl štětce z pěti kruhových ikon stylŧ štětce. Funkce pro tvorbu morph targetŧ 
v Poseru 7 pouţívá štětcové vzory, které počítají s měnící se mírou přesnosti při pouţití modifikace 
polygonové sítě. Styl štětcŧ nalevo ovlivņuje pouze nejbliţší jeden polygon v místě kurzoru myši, 
takţe dovoluje velmi precizní ovládání. Ostatní styly štětcŧ ovlivņují určitou oblast polygonové sítě. 
Tyto plošné styly štětcŧ obsahují rŧzné stupně vytrácení efektu; modifikace ovlivņuje polygony 
uvnitř vymezené oblasti rŧznou intenzitou, která je dána tímto vytrácením. Například druhý styl 
štětce zleva má zadán velkou část s vytrácením efektu, coţ znamená, ţe zatímco polygony ve 
středu ovlivņované oblasti budou ovlivněny silně, účinek ovlivnění polygonŧ bude postupně od 
středu oblasti klesat. U dalších dvou stylŧ štětce je oblast s vytrácením efektu zmenšena a styl 
štětce zcela vpravo je úplně bez tohoto efektu. 

 POZNÁMKA 
AKTIVOVÁNÍM PŘEDVOLBY ZOBRAZENÍ ŠTĚTCŦ DISPLAY BRUSH VE SPODNÍ ČÁSTI 
ZÁLOŢKY CREATE SE ZOBRAZÍ VIZUÁLNÍ NÁHLED OVLIVŅOVANÉ OBLASTI. TENTO NÁHLED 
JE BAREVNĚ ROZLIŠEN Z DŦVODU ZOBRAZENÍ EFEKTU VYTRÁCENÍ: ČERVENÁ OZNAČUJE 
OBLAST SILNĚ OVLIVŃOVANOU, ŢLUTÁ OZNAČUJE SNÍŢENÍ EFEKTU A OBLAST OZNAČENÁ 
ZELENĚ JE UVNITŘ OBLASTI OVLIVŅOVÁNA NEJMÉNĚ. 

4. Nastavením otočného ovladače Radius zvětšíte nebo zmenšíte velikost ovlivņované oblasti. Pokud 
máte aktivovánu předvolbu zobrazení štětcŧ Display Brush, vizuální náhled ovlivņované oblasti se 
automaticky přizpŧsobí změněné velikosti. 
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5. Nastavením otočného ovladače Magnitude mŧţete specifikovat, jak velký účinek bude mít nástroj 
Morphing Tool uvnitř ovlivņované oblasti. Nastavení vysoké hodnoty Magnitude umoţní 
provedení výrazných změn velkého rozsahu pro urychlení postupu práce. Nastavení nízké hodnoty 
Magnitude umoţní provedení precizních, úzce zaměřených změn. 

 POZNÁMKA 
DOPORUČUJEME ZAČÍNAT PRÁCI S RELATIVNĚ NÍZKOU HODNOTOU NASTAVENÍ 
MAGNITUDE, KTERÁ VÁM UMOŢNÍ PŘIVYKNOUT SI K NÁSTROJI MORPHING TOOL A POTOM 
PODLE POTŘEBY HODNOTU MAGNITUDE POSTUPNĚ ZVYŠOVAT. 

6. Podle potřeby aktivujte nebo deaktivujte následující předvolby: 

o Accumulate: Pokud je předvolba Accumulate aktivována (označena), Vaše změna bude stále 
narŧstat pokud kliknete a následně budete neustále pokračovat v pohybu táhnutím myší. Tato 
předvolba umoţņuje vytvoření změn většího rozsahu pomocí jednoho pohybu, avšak s menší 
přesností. Pokud je předvolba Accumulate deaktivována (neoznačena), bude kaţdá změna 
vyţadovat samostatné kliknutí a taţení myší. Toto nastavení pouţijte při poţadavku vyšší 
kontroly prováděných změn. 

o Stroke: Pokud je předvolba Stroke aktivována (označena), bude nástroj Morphing Tool 
provádět změny podél trajektorie pohybu myši. Toto Vám umoţņuje “malování” deformací na 
povrch polygonové sítě pohybem myší nad ní. Pokud je předvolba Stroke deaktivována 
(neoznačena), pohybem myši nastavíte stupeņ deformace, přičemţ změna bude aplikována jen 
uvnitř originální ovlivņované oblasti. 

o Group: Předvolba Group umoţņuje specifikovat, které konkrétní polygony budou nástrojem 
Morphing Tool ovlivněny. Pokud je předvolba Group aktivována (označena), rozbalovací 
menu Group bude zobrazovat seznam všech skupin polygonŧ, které jsou dostupné v aktuálně 
vybraném prvku. Z tohoto seznamu mŧţete vybrat skupinu pro omezení efektu nástroje 
Morphing Tool na polygony, které jsou obsaţeny pouze v této skupině. Pro speciální pouţití 
mŧţete také vytvořit další skupinu pomocí editoru skupin Group Editor (viz kapitola 14: “Editory 
figur a rekvizit” na straně 125 pro více informací o editoru skupin Group Editor). 

7. Jakmile pomocí záloţky Create nakonfigurujete nástroj Morphing Tool podle konkrétních potřeb, 
klikněte a táhněte přímo nad aktuálním prvkem k provedení deformace jeho sítě. 

8. Jakmile modifikaci dokončíte, klikněte na tlačítko Save Copy As pro převedení Vaší práce do 
nového morph targetu.  

Záloţka Create obsahuje také následující předvolby zobrazení: 

o Display Mesh: Předvolba Display Mesh zobrazí polygonovou síť bez ohledu na to, jaký styl 
zobrazení je aktuálně vybrán. (Viz kapitola 7: “Ovladače zobrazení” na straně 50 pro více informací 
o rŧzných stylech zobrazení.) Tato funkce je velmi uţitečná, protoţe mŧţete vidět, jak Vaše 
deformace ovlivņují polygony podkladu. 

o Display Brush: Předvolba Display Brush zobrazí vizuální náhled oblasti, která bude deformací 
ovlivněna. Tento náhled pouţívá rŧzné barvy pro rozlišení intenzity, kterou bude oblast zvolenou 
akcí ovlivněna. Červenou barvou je konkrétně označena plocha oblasti s velmi silným efektem 
deformačního nástroje, ţlutá indikuje oblast ovlivņovanou menší silou a zelená indikuje oblast 
s nejmenším účinkem deformace. V základním nastavení je předvolba Display Brush aktivována. 

o Work With Current Morphs: Pokud je předvolba Work With Current Morphs aktivována, bude 
během deformace síť (mesh) zobrazena včetně aktuálního nastavení všech dalších morph targetŧ. 
Tato funkce je uţitečná pro tvorbu morph targetŧ, které budou spolupŧsobit s jiným morph 
targetem. 

 POZNÁMKA 
TOTO NASTAVENÍ JE UŢITEČNÉ PRO POROZUMĚNÍ, JAK VÁŠ NOVÝ MORPH TARGET BUDE 
SPOLUPŦSOBIT S OSTATNÍMI EXISTUJÍCÍMI MORPH TARGETY. 

Pokud je předvolba Work With Current Morphs deaktivována, umoţņuje pří práci se záloţkou 
Create dočasně skrýt účinky všech ostatních morph targetŧ. Pouţití tohoto nastavení umoţņuje 
praci s geometrií sítě mesh v neutrálním stavu, beze ztracení nastavení ostatních morph targetŧ. 
Jakmile uzavřete záloţku Create, všechny morph targety se atomaticky nastaví do předem 
definovaného stavu. 
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Následující funkce mŧţete pouţít pro uloţení nebo resetování Vašich morph targetŧ: 

o Mirror: Tlačítko Mirror ve spodní části záloţky Create přináší rozbalovací menu nabízející šest 
předvoleb pro zrcadlovou deformaci aktuálně vybraného objektu podle rŧzných os a směrŧ, 
například “-x do x” nebo “z do -z”. Zapamatujte si, ţe tyto osy se vztahují jen ke vnitřní soustavě 
souřadnic aktuálně vybraného objektu a neodpovídají souřadnicím pracovního prostoru scény 
Poseru 7. Výběrem některé z těchto předvoleb budou změny vytvořené morph targetem zrcadlově 
aplikovány z jedné poloviny aktuálně vybraného objektu na druhou polovinu téhoţ objektu podle 
definnované osy a směru z rozbalovacího menu. 

 POZNÁMKA 
POKUD TOPOLOGIE SÍŤOVÉHO MODELU PRVKU, U KTERÉHO CHCETE POUŢÍT FUNKCI 
MIRROR NEOBSAHUJE ODPOVÍDAJÍCÍ POLYGONY NA OBOU STRANÁCH PODLE ZVOLENÉ 
OSY, FUNKCE MIRROR NEBUDE SCHOPNA ZMĚNY VYTVOŘENÉ MORPH TARGETEM 
SPRÁVNĚ PŘEVÉST. 

o Zero Morph: Tlačítko Zero Morph resetuje síťový model mesh do stavu bez deformací. Toto 
tlačítko resetuje efekt pouze Vašeho nového morph targetu; všechny ostatní morph targety 
zŧstanou nastaveny beze změn. Ujistěte se, ţe jste si uloţili kopii Vašich modifikací ještě před 
kliknutím na toto tlačítko, pokud si nepřejete vytvořené změny ztratit. 

o Save Copy As: Kdykoliv pouţijete záloţku Create, všechny vytvořené modifikace budou uloţeny 
automaticky do skupiny morph targetŧ “Custom Morph”. Tlačítko Save Copy As umoţņuje 
uloţení aktuálního stavu Custom Morph targetu do nového samostatného morph targetu. Funkci 
Save Copy As mŧţete pouţít pro přírŧstkové modifikace během práce na síťovém modelu, nebo 
pro aplikaci finální modifikace na figuru při budoucím pouţití. 

 VAROVÁNÍ 
UŢIVATELSKÝ CUSTOM MORPH TARGET JE KUMULATIVNÍ, VŠECNY MODIFIKACE POMOCÍ 
NĚJ BUDOU VYTVOŘENY PŘÍRUSTKOVĚ K PŘEDCHOZÍMU STAVU MORPH TARGETU. Z TOHO 
DŦVODU, POKUD SI ZMĚNY NEULOŢÍTE DO SAMOSTATNÉHO MORPH TARGETU POUŢITÍM 
TLAČÍTKA SAVE COPY AS, TYTO BUDOU PŘIČLENĚNY K OSTATNÍM ZMĚNÁM FIGURY  
A TĚŢKO POTOM BUDETE OBNOVOVAT PŘEDCHOZÍ STAV. 
 

TVORBA MORPH TARGETŮ  CREATING MORPH TARGETS (orig.169) 

Kromě záloţky Create v paletě editoru morphingu Morph Editor, mŧţete vytvářet morph targety  
v Poseru 7 přímo z palety vlastností Properties: 

1. Vytvarujte prvek pouţitím libovolné kombinace deformátorŧ do poţadovaného výsledného stavu. 
Změny tvaru více prvkŧ části postavy budou uloţeny do morph targetu. 

2. Zvolte vlastnosti části postavy/rekvizity v paletě vlastností Properties, poté zvolte poloţku Spawn 
Morph Target. Zobrazí se dialogové okno s dotazem na zadání názvu nového morph targetu. 

3. Zadejte poţadované jméno a klikněte na OK. V paletě parametrŧ Parameters se zobrazí nový 
otočný ovladač parametrŧ s názvem nového morph targetu. V tomto bodě mŧţete smazat všechny 
deformátory, pouţité k vytvoření morph targetu. 

Nastavení hodnoty ovladače větší neţ 0 aplikuje morph target na vybraný prvek(y) a naopak. Hodnota 
1 znamená, ţe morph target je plnně aplikován, hodnota -1 znamená, ţe morph target je aplikován 
zcela inverzně a hodnota vetší neţ +/-1 vytvoří přehnané efekty. Například při pouţití vybouleného 
svalu znamená hodnota 1 plnou aplikaci vyboulení, hodnota -1 vytvoří naopak prohlubeņ (opak 
originálního morph targetu), a podobně. 
 

TVORBA FULL-FIGURE MORPH TARGETŮ   
CREATING FULL-FIGURE MORPH TARGETS (orig.169) 

Více částí postavy mŧţete uloţit včetně nastavení jejich póz jako „celopostavové“ full-figure morph 
targety, známé také pod označením Full-Body Morph (FBM). Takto vytvořený nový morph target 
zahrnuje parametry těchto póz, to znamená všechny morphy najednou. Jen kanály morph targetŧ lze 
spojovat do full-body morph targetu. Deformátory nejsou automaticky zahrnuty do full-figure morph 
targetu, stejně tak měřítka, rotace a posuvy. 
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Pro vytvoření full-body morph targetu: 

1. Vytvořte morph targety u všech částí postavy podle přání. V případě potřeby si na pomoc vezměte 
tuto kapitolu. 

2. Upravte tvar kaţdé části postavy za pouţití nových otočných ovladačŧ parametrŧ Parameter dials, 
jak je popsáno v části “Paleta parametrů” na straně 77. Nastavte je na hodnoty, které budou 
pouţity ve full-body morph targetu. Například při nastavení parametru vyboulení svalu na hodnotu 
0.5 bude při aplikaci full-body morph targetu s nastavením na hodnotu 1 aplikováno vyboulení 
svalu v míře odpovídající nastavení hodnoty 0.5 originálního morph targetu. 

3. Vyberte celou figuru a následně zvolte Figure>Create Full Body Morph. Do dialogu Set Name, 
který se poté zobrazí, zadejte název nového morph targetu. 

Pokud figuru opětovně vyberete, v paletě parametrŧ jiţ bude zobrazen nový otočný ovladač parametru 
vytvořeného full-body morph targetu. Tento morph funguje stejně jako ostatní morphy: Hodnota větší 
neţ 0 aplikuje morph na vybraný prvek(y), a naopak. Hodnota 1 znamená, ţe morph target je zcela 
aplikován, hodnota -1 znamená, ţe morph target je aplikován zcela inverzně a hodnota vetší neţ +/-1 
vytvoří přehnané efekty. 
 

ULOŢENÍ MORPH TARGETŮ  SAVING MORPH TARGETS (orig.170) 

Morphované figury mŧţete uloţit do palety knihoven Library. Uloţené figury si uchovají uţivatelské 
nastavení otočných ovladačŧ parametrŧ, proto je mŧţete pouţít při budoucím načtením figury. Pro 
uloţení figury do palety Library prosím navštivte téma “Přidání položek do knihovny” na straně 33. 

Poser 7 ukládá morph targety do externího binárního souboru formátu (.pmd), který obsahuje jen 
morph targety pro specifické figury scény. Tento formát umoţņuje rychlejší načítání a vyšší flexibilitu, 
protoţe morph targety jiţ nejsou zakomponovány do ostatních dat souboru scény .pz3. Tato metoda 
uchování dat také vyţaduje menší prostor na disku, protoţe stejné figury v uloţených scénách 
vyuţívají data morph targetu ze stejného souboru .pmd. Pokud změníte morph targety jedné nebo 
více figur z palety Library a poté scénu uloţíte, modifikace morph targetŧ budou uloţeny do nového 
souboru.pmd společně se souborem scény. Pokud si přejete uloţit modifikované morph targety pro 
určitou figuru samostatně, musíte v paletě základního nastavení programu General Preferences 
vybrat předvolbu Use External Binary Morph Targets (viz téma “Nastavení předvoleb aplikace” na 
straně 19) a následně modifikovanou figuru uloţit do palety knihoven Library jako novou figuru. Pro 
tuto figuru bude vytvořen nový soubor .pmd, obsahující modifikované morph targety. Nyní mŧţete 
takovou figuru pouţít v dalších scénách. Navíc mŧţete morph targety jednoduše distribuovat 
nezávisle na specifické figuře, čímţ se nabízí moţnost větší flexibility a efektivity. 

 POZNÁMKA 
JE NA ZODPOVĚDNOSTI KAŢDÉHO UŢIVATELE, ABY SE PODROBIL LICENČNÍMU UJEDNÁNÍ 
SPOLEČNOSTI E FRONTIER AMERICA, INC., STEJNĚ JAKO LICENČNÍMU UJEDNÁNÍ 
OSTATNÍCH VYDAVATELŦ, PŘED DISTRIBUCÍ OBSAHU POSERU 7. 

Pokud otevřete a opětovně uloţíte soubor předchozí verze scény Poseru 7 (.pz3), Poser 7 vytvoří 
nový externí soubor .pmd, obsahující morph targety pro tuto scénu. Pokud si přejete uloţit morph 
targety pro figury z této scény samostatně, jednoduše tyto figury uloţte do palety knihoven Library, 
jak je popsáno výše a potom je opětovně vloţte do scény. Poser 7 vygeneruje samostatné soubory 
.pmd pro kaţdou z těchto figur. 
 

NAČTENÍ UŢIVATELSKÝCH MORPH TARGETŮ   
ADDING CUSTOM MORPH TARGETS (orig.171) 

Mŧţete načíst morph targety, které byly vytvořeny v jiných aplikacích, a pouţít je na Vaše figury  
a rekvizity. Mŧţete také načíst jiné morph targety získané z 
online zdrojŧ, jako je místnost obsahu Poseru 7 Content 
room, která obsahuje odkazy na několik významných 
obchodních míst s materiálem pro Poser. Prosím navštivte 
kapitolu 21: “Místnost obsahu” na straně 182 pro více 
informací o místnosti obsahu Poseru 7 Content room. Pro 
načtení uţivatelského morph targetu: 

1. Vyberte část postavy/rekvizity na kterou si přejete 
aplikovat morph target a otevřete její vlastnosti v paletě 
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vlastností Properties. 

2. Klikněte na poloţku Load Morph Target pro otevření dialogu Load Morph Target. 

3. Zadejte kompletní cestu a název souboru poţadovaného morph targetu, nebo pouţijte tlačítko 
Locate pro otevření standardního vyhledávacího dialogu Browse, umoţņujícího lokalizaci 
správného souboru. Vybraný soubor musí být ve formátu OBJ, obsahující stejný počet vertexŧ jako 
originální část postavy/rekvizity a musí obsahovat pouze část postavy/rekvizity, která má být 
morphována.  

4. Zadejte pojmenování načteného souboru a klikněte na OK pro přechod do palety parametrŧ 
Parameters. Nový otočný ovladač parametrŧ bude zobrazen se zadaným pojmenováním. 

Aby morph targety pracovaly správně, musí mít stejné rozvrţení vertexŧ jako geometrický model, na 
který mají být aplikovány. Některé aplikace při editaci nebo tvorbě morph targetŧ uchovávají vertexy 
v jiném pořadí. Pokud shledáte, ţe importované morph targety se chovají neočekávaně, mŧţete se 
pokusit chybu opravit označením políčka Attempt Vertex Order Correction před jejich načtením. 
Toto políčko se nachází v dialogovém okně Load Morph Target, které mŧţe být zpřístupněno volbou 
Object>Load Morph Target, nebo kliknutím na tlačítko Load Morph Target v paletě vlastností 
Properties. Poznamenejte si prosím, ţe významné změny pořadí vertexŧ nebude moţné automaticky 
opravit. 
 

VYMAZÁNÍ MORPH TARGETŮ  DELETING MORPH TARGETS (orig.172) 

Pro vymazání morph targetu mŧţete pouţít paletu editoru hierarchie Hierarchy Editor, jak je 
vysvětleno v části “Práce s větvemi hierarchie” na straně 130. 
 

TVORBA UŢIVATELSKÝCH MORPH TARGETŮ   
CREATING CUSTOM MORPH TARGETS (orig.172) 

Morph targety mŧţete vytvářet ve své oblíbené 3D modelovací aplikaci tehdy, pokud tato aplikace 
umoţņuje import a export souborŧ formátu Wavefront OBJ (*.OBJ). To uděláte následovně: 

1. Exportujte část postavy, pro kterou si přejete morph target vytvořit tak, jak je popsáno v části 
“Export” na straně 190. 

2. Importujte část postavy do Vaší oblíbené 3D modelovací aplikace. 

3. Editujte geometrii, dejte pozor aby jste vertexy pouze posouvali. Nepřidávejte a neodstraņujte 
vertexy, neboť morph target by nefungoval. 

4. Exportujte editovanou geometrii ze 3D modelovací aplikace ve formátu Wavefront OBJ (*.OBJ). 

5. Načtěte morph target do Poseru 7. 
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Kapitola 14: Editory figur a rekvizit 
FIGURE AND PROP EDITORS (orig. 173) 

EDITOR SKUPIN  THE GROUP EDITOR (orig.173) 

Výběrem nástroje Grouping z editačních nástrojŧ Editing tools se otevírá paleta editoru skupin 
Group Editor. Editor skupin umoţņuje výběr a seskupení individuálních polygonŧ (Viz elektronický 
(PDF formát) Poser 7 Tutorial Manual ve složce Tutorials v instalační složce Poseru 7 pro informace  
o skupinách). Toto je uţitečné pro rŧzné úkoly v Poseru 7 jako je: 

o Tvorba skupin materiálŧ v místnosti materiálu Material room. Prosím navštivte kapitolu 16: 
“Místnost materiálu” na straně 139 pro informace o místnosti materiálu Material room. 

o Tvorba skupin vlasŧ v místnosti vlasŧ Hair room. Prosím navštivte kapitolu 18: “Místnost vlasů” na 
straně 158 pro informaci o místnosti vlasŧ Hair room. 

o Tvorba skupin oblečení v místnosti oblečení Cloth room. Prosím navštivte kapitolu 19: “Místnost 
oblečení” na straně 165 pro informace o místnosti oblečení Cloth room. 

o Tvorba částí postavy v místnosti nastavení Setup room. Prosím navštivte kapitolu 20: “Místnost 
nastavení” na straně 174 pro více informací o místnosti nastavení Setup room. 

o Tvorba rekvizit. 

Výběrem části prvku mŧţete také vytvářet nové rekvizity, deformace a morph targety. 
 

MÓDY POLYGONŮ & VERTEXŮ  POLYGON & VERTEX MODES (orig.173) 

Nástroj pro tvorbu skupin Grouping pracuje v módech polygonŧ nebo vertexŧ. V módu polygonŧ 
mŧţete přídávat/odstraņovat aktuálně vybrané polygony do aktuální skupiny polygonŧ. V módu 
vertexŧ mŧţete přídávat/odstraņovat aktuálně vybrané vertexy do aktuální skupiny vertexŧ. 

V módu polygonŧ mŧţete vytvářet/editovat/mazat pouze skupiny polygonŧ. Obdobně v módu vertexŧ 
mŧţete vytvářet/editovat/mazat pouze skupiny vertexŧ. Nicméně skupiny polygonŧ jsou přístupné 
z palety editoru skupin Group Editor za pouţití určitých příkazŧ (jako je Add Group). Skupiny 
polygonŧ jsou v rozbalovacím menu (#4 na obrázku) zobrazeny s indexem P. Poser 7 automaticky 
vybírá odpovídající mód v závislosti na místnosti, ve které se se skupinou aktuálně pracuje. Například 
v místnosti póz Pose room pracuje nástroj pro tvorbu skupin Grouping pouze v módu polygonŧ; 
v místnosti oblečení Cloth room pracuje v módu vertexŧ. 

Poser 7 pouţívá skupiny vertexŧ u objektŧ dynamického oblečení v místnosti oblečení Cloth room  
a pro styling vlasŧ v místnosti vlasŧ Hair room. U oblečení se vertexy pouţívají pro výběr okrajŧ 
objektŧ oblečení (jako je jedna strana plátna visícího na prádelní šņŧře a vlající ve větru). Tento efekt 
nemŧţe být vytvořen pomocí skupiny polygonŧ. 
 

POUŢITÍ EDITORU SKUPIN  USING THE GROUP EDITOR (orig.174) 

Pro vytvoření/editaci skupiny zvolte nástroj pro tvorbu skupin Grouping, který otevře paletu editoru 
skupin Group Editor. Pokud je editor otevřen, všechny figury a objekty v pracovním prostoru Poseru 
7 budou zobrazeny šedě. Paleta editoru skupin Group Editor obsahuje následující funkce: 

o Select tlačítko (1): Klikněte na tlačítko Select pro aktivaci výběru polygonŧ a následně klikněte na 
odpovídající místo aktuálního objektu scény pro přidání polygonŧ/vertexŧ do aktuální skupiny. 

o Deselect tlačítko (2): Klikněte na tlačítko Deselect pro aktivaci odstranění polygonŧ z výběru  
a následně klikněte na odpovídající místo aktuálního objektu scény pro odstranění 
polygonŧ/vertexŧ z aktuální skupiny. 

o Previous a Next tlačítka (3): Kliknutím na tlačítka Previous (<<) a Next (>>) je moţné cyklicky 
přepínat mezi aktuálně existujícími skupinami. Alternativně mŧţete pouţít rozbalovací menu mezi 
těmito dvěmi tlačítky pro přeskočení přímo na poţadovanou skupinu. Tato tlačítka jsou primárně 
pouţita v místnostech vlasŧ a oblečení. 

o Current Group rozbalovací menu (4): Rozbalovací menu Current Group pouţijte pro přímé 
přeskočení na poţadovanou skupinu. Toto menu je primárně pouţito v místnostech vlasŧ  
a oblečení. 
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o New Group tlačítko (5): Kliknutím na tlačítko New Group dojde k vytvoření nové skupiny s aktuálně 
vybranými polygony. Do dialogového okna, 
které se zobrazí, zadejte jméno skupiny. Tato 
funkce není aktivní v místnostech vlasŧ  
a oblečení. 

o Delete Group tlačítko (6): Kliknutím na 
tlačítko Delete Group dojde k vymazání 
aktuálně vybrané skupiny. 

o Add All tlačítko (7): Kliknutím na tlačítko Add 
All dojde ke vloţení všech polygonŧ, které 
jsou v aktuálním objektu obsaţeny, do 
aktuálně vybrané skupiny. 

o Add Group tlačítko (8): Kliknutím na tlačítko 
Add Group dojde ke vloţení všech polygonŧ 
nebo vertexŧ ze skupiny, kterou vyberete 
pomocí dialogového okna Add Group, do 
aktuální (aktuálně vybrané) skupiny. 

o Remove All tlačitko (9): Kliknutím na tlačítko 
Remove All dojde k odstranění všech 
polygonŧ z aktuálně vybrané skupiny. 

o Remove Group tlačítko (10): Kliknutím na 
tlačítko Remove Group dojde k odstranění 
polygonŧ nebo vertexŧ ze zvolené 
podskupiny aktuální (aktuálně vybrané) 
skupiny. 

o Invert tlačítko (11): Kliknutím na tlačítko 
Invert dojde k inverzi aktuálního výběru, tj. ţe 
všechny vybrané polygony budou odstraněny 
a naopak. 

o Add Material tlačítko (12): Kliknutím na 
tlačítko Add Material dojde k vytvoření nové 
skupiny materiálu, obsahující aktuálně 
vybrané polygony. 

o Hide Other Objects políčko (13): Označením políčka Hide Other Objects dojde ke skrytí všech 
objektŧ scény mimo aktuálně vybraného objektu, coţ pomáhá v případech komplexních scén, kdy 
mŧţete vidět pouze objekt, na kterém pracujete. 

o Show Multigrouped Faces políčko (14): Označením políčka Show multigrouped faces dojde 
k zobrazení všech polygonŧ, které jsou obsaţeny ve více neţ jedné skupině. Toto nastává tehdy, 
kdyţ vytváříte skupiny geometrie ve 3D modelovací aplikaci a náhodně přiřadíte některé polygony 
do více neţ jedné skupiny. 

o Show Nongrouped Faces políčko (15): Označením políčka Show nongrouped faces dojde 
k zobrazení všech polygonŧ, které nepatří do ţádné skupiny. Pokud opustíte místnost nastavení 
Setup room s jedním nebo více polygony, které nejsou přiřazeny ke kosti, mohou být udrţovány 
jako rekvizity přiřazené k figuře a mohou být dostupné pro opětovné seskupení po návratu do 
místnosti nastavení Setup room.  

 POZNÁMKA 

VÝŠE UVEDENÉ PŘÍKAZY JSOU POTŘEBNÉ PRO TVORBU FIGUR ZA POUŢITÍ GEOMETRIE  
A STRUKTURY NA BÁZI KOSTÍ. NÁSLEDUJÍCÍ PŘÍKAZY JSOU ÚČELOVÉ A MOHOU BÝT 
POUŢITY V MÍSTNOSTI NASTAVENÍ SETUP ROOM; NICMÉNĚ NEJSOU POTŘEBNÉ KE TVORBĚ 
FIGUR. TYTO PŘÍKAZY MOHOU BÝT UŢITEČNÉ PRO RENDERING A DOKONČOVÁNÍ SCÉN PŘI 
POUŢITÍ NOVĚ VYTVOŘENÉ FIGURY. 

o Create Prop tlačítko (16): Kliknutím na tlačítko Create Prop dojde k vytvoření nové rekvizity 
z vybrané skupiny nebo polygonŧ. V dilalogu, který se zobrazí, zadejte jméno nové rekvizity. 
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o Spawn Props tlačítko (17): Kliknutím na tlačítko Spawn Prop dojde k vytvoření rekvizity ze všech 
skupin, které byly vytvořeny. Dva příklady pouţití tohoto příkazu jsou vytvoření příléhavého brnění 
nebo základu pro rekvizitu oblečení. 

o Assign Material tlačítko (18): Kliknutím na tlačítko Assign Material dojde k vytvoření nové třídy 
materiálu material class pro vybrané polygony. V dilalogu, který se zobrazí, zadejte jméno nové 
třídy materiálu. Třída materiálu je parametr, který definuje polygony, na které bude materiál 
aplikován. Pokud například vytváříte figuru s rukavicemi, mŧţete vybrat polygony pod rukavicemi 
jako třídu materiálu material class. Později mŧţete příkazem Material rukavicím přiřadit materiál, 
texturu, bump mapu, apod. Na třídy materiálu mŧţete pohlíţet jako na skupiny, které definují  
oblasti, kde jsou materiály aplikovány. 

o Assign Smoothing ID tlačítko (19): Kliknutím na tlačítko Assign Smoothing ID dojde k vymezení 
vyhlazovací skupiny pro aplikaci vyhlazování povrchŧ hran sousedících polygonŧ. Následně 
zobrazený dialog bude se bude ptát na přiřazení nové nebo existující Smoothing ID k aktuální 
skupině. Do nabídnutého políčka zadejte nové ID. Pro více informací o vyhlazovacích skupinách 
navštivte kapitolu 15: “Vyhlazování povrchu” na straně 137. 

o Create Perspective UVs tlačítko (20): Kliknutím na tlačítko Create Perspective UVs vytvoříte 
souřadnice textury pro skupinu. Příkladem pouţití tohoto příkazu mŧţe být zmapování 
importovaného podkladního obrázku tváře pro skupinu Poseru 7, která odpovídá tváři figury. 
Souřadnice textury tváře budou budou přiřazeny k obrázku. 

o Reverse Group Normals tlačítko (21): Kliknutím na tlačítko Reverse Group Normals obrátíte 
normály vybrané skupiny. To umoţņuje otočení okolních objektŧ nebo ostatních importŧ podle 
poţadavku naruby pro interaktivní rendering. 

o Auto Group tlačítko (22): Viz dále. 

o Weld Group tlačítko (23): Viz dále. 
 

PŘÍKAZ AUTO GROUP  THE AUTO GROUP COMMAND (orig.176) 

Pokud vytváříte skupiny pro nově importovanou geometrii (místnost nastavení Setup room), mŧţete 
ušetřit čas a námahu kliknutím na tlačítko Auto Group ve spodní části palety editoru skupin Group 
Editor. Tento příkaz je obzvlášť uţitečný pokud vytváříte uţivatelské figury Poseru v místnosti 
nastavení Setup room. Pokud si přejete pouţít funkci Auto Group, ujistěte se, ţe ji pouţijete aţ po 
vytvoření, nastavení pozice a pojmenování struktury kostí! To je nutné proto, ţe funkce Auto Group 
umístí polygony do skupin v závislosti na jejich umístění ve 3D prostoru relativně k dostupným kostím. 
Předem nevytvořená, nenastavená a nepojmenovaná struktura kostí mŧţe zpŧsobit velmi 
nepředvídatelné a zmatené výsledky. 

 POZNÁMKA 
POUŢITÍ FUNKCE AUTO GROUP PŘED VYTVOŘENÍM, NASTAVENÍM A POJMENOVÁNÍM 
STRUKTURY KOSTÍ MŦŢE VYÚSTIT DO NEPŘEDVÍDATELNÝCH SKUPIN, KTERÉ BUDOU 
VYŢADOVAT ROZSÁHLÉ DLOUHODOBÉ OPRAVY. 

Funkce Auto Group je navrţena pro jednorázové pouţití při prvotní tvorbě figury. Mŧţete ji pouţít tak 
často, jak si přejete; nicméně tato kompletně přeskupí kaţdý polygon geometrie figury, coţ zpŧsobí, 
ţe figura ztratí všechny předcházející přiřazení skupin k názvŧm kostí. Pokud musíte funkci Auto 
Group opětovně pouţít po vytvoření figury, postupujte opatrně. 

Funkce Auto Group nutí Poser 7 přijmout "nejlepší odhad“ během seskupování polygonŧ a kostí. 
Moţná zjistíte, ţe musíte automatické skupiny jemně doladit manuálně, pomocí výběru polygonŧ  
a jejich přesunutí do jiných skupin. Udělejte to výběrem cílové skupiny a následným výběrem 
polygonŧ, které si přejete do cílové skupiny přesunout. 

 POZNÁMKA 
NÁSTROJ NA VYTVÁŘENÍ SKUPIN AUTOMATICKY ODSTRAŅUJE POLYGONY Z JINÝCH 
POJMENOVANÝCH SKUPIN (KTERÉ NEOBSAHUJÍ KOSTI) A PŘIDÁVÁ JE DO VYBRANÉ CÍLOVÉ 
SKUPINY, ABY SE VYNUL TOMU, ŢE BY NĚKTERÉ POLYGONY BYLY SOUČASNĚ PŘIŘAZENY 
K VÍCE SKUPINÁM. PŘÍKAZY Z PALETY EDITORU SKUPIN TUTO FUNKČNOST NEMAJÍ. 
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PŘÍKAZ WELD GROUP  THE WELD GROUP COMMAND (orig.177) 

Funkce Weld Group (spojení skupin) mŧţe být uţitečná pokud například potřebujete vytvořit obměny 
Vašich skupin po opuštění místnosti nastavení Setup room, nebo kdyţ importujete rekvizitu se 
skupinami, které chcete změnit. Jakmile je figura jednou vytvořena v místnosti nastavení Setup room, 
Poser 7 rozdělí jednu geometrii na části odpovídajících vytvořeným skupinám. Pokud polygony 
přeřadíte do jiných skupin, originální rozdělení geometrie zŧstává zachováno, coţ mŧţe zpŧsobit, ţe 
se figura bude jevit jako roztrţená v místech hranic pŧvodních skupin. 

Nejlepším zpŧsobem ilustrace tohoto problému je pouţití příkladu. Řekněme, ţe vytváříte figuru mimo 
jiné se skupinami pro hlavu a krk. Po opuštění místnosti nastavení Setup room, Poser 7 rozdělí 
jednodílnou geometrii na části, jejichţ okraje odpovídají hranicím vytvořených skupin. Toto je 
nezbytné k tomu, aby bylo moţné figuru ohýbat. Později si budete přát posunout místo ohybu hlavy  
a krku blíţe ke hlavě. Proto přesunete některé polygony ze skupiny hlavy do skupiny krku. To mŧţete 
jednoduše provést pomocí nástroje Grouping. 

Poser 7 vytvoří nové přerušení geometrie v hranicích nových skupin; nicméně staré přerušení ve 
starých hranicích stále existuje. To zpŧsobí, ţe Vaše figura se bude při nastavování pózy a renderu 
jevit jako roztrţená. Nápravu problému učiníte následovně: 

1. Zvolte nástroj pro tvorbu skupin Grouping. 

2. Vyberte skupinu pro krk. 

3. Klikněte na tlačítko Weld Group. 

 POZNÁMKA 
FUNKCE WELD GROUP MĚNÍ A KOMBINUJE VERTEXY NA OBOU STRANÁCH PŘERUŠENÍ, AŢ 
VYTVOŘÍ HLADKÉ PŘEMOSTĚNÍ TRHLINY. DOBRÝM PŘÍKLADEM PRO PŘEDSTAVENÍ SI TÉTO 
FUNKCE JE ZÁLÉVÁNÍ TRHLINY. VÝPLŅ VYTVOŘÍ SPOJENÍ DVOU POVRCHŦ A POVRCH  
V MÍSTĚ PŘERUŠENÍ JE NEUSTÁLE SROVNÁVÁN. FUNKCE WELD GROUP ELIMINUJE 
PŘETRŢENÍ STEJNĚ DOBŘE JAKO MODIFIKACE GEOMETRIE. VE VĚTŠINĚ PŘÍPADŦ BY 
PROBLÉM JIŢ MĚL BÝT NEPOSTŘEHNUTELNÝ. 
 

TVORBA/EDITACE SKUPIN  CREATING/EDITING GROUPS (orig.177) 

Pro vytvoření skupiny zvolte nástroj na tvorbu skupin Grouping. Nyní mŧţete kliknout na individuální 
polygony, nebo kliknout a táhnout přes několik polygonŧ. Pokud náhodně vyberete jeden nebo více 
špatných polygonŧ, mŧţete je odstranit z výběru pomocí nástroje Deselect (viz výše) nebo kliknutím 
či taţením při současném stisku klávesy [CTRL]. Pokud se nacházíte v místnosti nastavení Setup 
room, polygony, které byly z výběru odstraněny se automaticky přiřadí ke skupině nazvané 
NO_BONE (bez kosti), ve které mŧţete vidět všechny nepřiřazené polygony a tento problém mŧţete 
ještě před opuštěním místnosti nastavení Setup room opravit. 

Pro výběr polygonŧ, které jsou aktuálně mimo pohled, mŧţete pouţít styl zobrazení Wireframe, 
případně trackballem kamery změņte pohled na figuru, anebo pouţijte pracovní plochu s více panely, 
které Vám poţadované polygony zobrazí. 

 POZNÁMKA 
POKUD PRACUJETE S NÁSTROJEM PRO TVORBU SKUPIN GROUPING, STISK KLÁVESY 
[OPT]/[ALT] UMOŢŅUJE RYCHLÝ PŘÍSTUP K TRACKBALLU KAMERY. 

Při výběru polygonŧ je moţné, ţe vyberete také polygony, které byly dříve přiřazeny k jiné skupině, 
buď náhodou, nebo plánovaně. Pokud se to stane, nástroj Grouping odstraní tyto polygony 
z předchozí skupiny a přiřadí je do skupiny nové proto, aby zajistil, ţe ţádné polygony nebudou 
současně ve více skupinách. 

 POZNÁMKA 
PŘÍKAZY Z PALETY EDITORU SKUPIN GROUP EDITOR TUTO FUNKCI NEMAJÍ. 

Pokud vytváříte skupiny pro figury (Setup room), je dŧleţité mít na paměti, ţe k ohybu kloubu dochází 
pouze mezi objektem a jeho nadřazeným objektem parent v hierarchii. Ohyb nepřechází do dalších 
podřízených objektŧ children nebo do vyšších nadřazených objektŧ parent v hierarchii. Na to 
pamatujte při tvorbě skupin a později při jemném dolaďování kloubŧ. 
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 POZNÁMKA 
PALETA EDITORU SKUPIN GROUP EDITOR SE ZOBRAZÍ VŢDY, KDYŢ JE NÁSTROJ GROUPING 
AKTIVOVÁN. 
 

EDITOR HIERARCHIE  THE HIERARCHY EDITOR (orig.178) 

Pro správné zobrazení figury v pracovním okně Document musí Poser 7 přeloţit informace  
o geometrii a parametrech částí postavy figury. Tyto informace umoţņují Poseru 7 vytvoření ohebných 
kloubŧ mezi nadřazenými parent (rodičovskými) a podřízenými child (dětskými) objekty. 

Hierarchie scény popisuje parent-child vztahy všech objektŧ scény. Prosím prostudujte elektronický 
(PDF formát) Poser 7 Tutorial Manual ve sloţce Tutorials v instalační sloţce Poseru 7 pro více 
informací o hierarchii. Části postavy, které jsou fyzicky propojeny, obvykle obsahují nadřazené parent 
nebo podřízené child objekty. Hierarchie scény taktéţ definuje data, jako jsou charakter rotace kloubŧ  
a vztahy inverzní kinematiky IK. Dokumenty hierarchie Poseru 7 obsahují: 

o Kompletní seznam všech objektŧ scény včetně figur, rekvizit, částí postav, osvětlení a kamer. 

o Hierarchii propojení (parent/child vztahŧ) mezi objekty scény. 

o Parametry rotace, posunŧ, morph targetŧ a Point At (viz “Zaměřít na” na straně 202). 

o IK svazky chains. 
 

POUŢITÍ EDITORU HIERARCHIE  USING THE HIERARCHY EDITOR (orig.179) 

Paleta editoru hierarchie Hierarchy Editor umoţņuje: 

o Výběr prvkŧ scény. Výběrem prvku v paletě editoru hierarchie Hierarchy Editor bude tato poloţka 
vybrána také v pracovním okně Document, rozbalovacím menu Current Actor a paletě grafu 
Graph. 

o Přístup k vlastnostem objektu. Dvojitým kliknutím na seznam objektŧ v paletě editoru hierarchie 
Hierarchy Editor dojde k otevření palety vlastností Properties vybrané poloţky. 

o Rychlé skrytí, nebo zobrazení prvkŧ scény. 

o Přejmenování, nebo vymazání prvkŧ a parametrŧ, jako jsou morph targety nebo parametry Point 
At. 

o Nastavení nebo změna mateřských vztahŧ parent-child u rekvizit. 

o Nastavení svazkŧ inverzní kinematiky Inverse Kinematics (IK) chains. 

o Změnu charakteru rotace rekvizit nebo částí postavy. 

o Tvorbu nových figur. Současně s grafickou místností nastavení Setup room (viz kapitola 20: 
“Místnost nastavení” na straně 174) umoţņuje pouţití palety editoru hierarchie Hierarchy Editor 
ke tvorbě figur. 

o Rozvinutí, nebo uzavření seznamu hierarchie pro zobrazení nadřazených parents a podřízených 
children prvkŧ, nebo jen prvkŧ nadřazených. 

 

ZOBRAZENÍ EDITORU HIERARCHIE   
DISPLAYING THE HIERARCHY EDITOR (orig.179) 

Pro zobrazení palety editoru hierarchie Hierarchy Editor zvolte příkaz 
Window>Hierarchy Editor. 
 

OVLADAČE ZOBRAZENÍ  CONTROLLING THE DISPLAY (orig.179) 

Zobrazení palety editoru hierarchie Hierarchy Editor mŧţete ovládat 
pomocí předvoleb poţadovaného zobrazení v horní části palety. 
Označením políčka se aktivuje vybraná předvolba a jeho odznačením se 
předvolba deaktivuje. Předvolby jsou následující: 

o Show Figures: Označením políčka Show Figures dojde k zobrazení 
všech figur aktuálního dokumentu Poseru 7. 
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o Show Cameras: Označením políčka Show Cameras dojde k zobrazení všech kamer aktuálního 
dokumentu Poseru 7. 

o Show Parameters: Označením políčka Show Parameters dojde k zobrazení parametrŧ všech 
objektŧ aktuálního dokumentu Poseru 7. 

o Show All Parameters: Označením políčka Show All Parameters dojde k zobrazení všech 
parametrŧ aktuálního dokumentu Poseru 7. 

o Show Props: Označením políčka Show Props dojde k zobrazení všech rekvizit aktuálního 
dokumentu Poseru 7. 

o Show Deformers: Označením políčka Show Deformers dojde k zobrazení všech magnetŧ, vln, 
morph targetŧ a silových polí aktuálního dokumentu Poseru 7 (scény). 

o Show Lights: Označením políčka Show Lights dojde k zobrazení všech objektŧ osvětlení 
aktuálního dokumentu Poseru 7.  

 

PRÁCE S VĚTVEMI HIERARCHIE  WORKING WITH HIERARCHY BRANCHES (orig.180) 

Při pouţívání seznamu hierarchie mŧţete vykonávat následující akce: 

o Pro rozbalení větve hierarchie klikněte na vpravo směřující šipku před větví, kterou si přejete 
rozbalit. 

o Pro sbalení větve hierarchie klikněte na dolŧ směřující šipku před větví, kterou si přejete sbalit. 

o Pro výběr objektu klikněte na jeho název v seznamu. 

o Pro zviditelnění nebo zneviditelnění objektu klikněte na ikonu oka vedle objektu v seznamu. Oko je 
zobrazeno bíle, kdyţ je objekt viditelný a šedě, kdyţ je objekt neviditelný. 

o Pro zobrazení palety vlastností Properties objektu, dvojitě klikněte na vybraný objekt v seznamu. 

o Pro smazání figury, rekvizity nebo osvětlení ze scény, vyberte poţadovanou poloţku a stiskněte 
klávesu [DEL]. Tímto zpŧsobem nejdou smazat části postavy, kamery nebo podkladní roviny. 

o Pro přejmenování objektu na něj jednou klikněte v seznamu pro jeho výběr a podruhé pro otevření 
textového pole. (Nepouţívejte přímo dvojité kliknutí na poloţku v seznamu, které otevírá paletu 
vlastností Properties tohoto objektu.) Nové jméno objektu zadejte do textového pole. 

 

PŘESKUPENÍ PRVKŮ SCÉNY  REORDERING SCENE ELEMENTS (orig.180) 

Prvky scény včetně rekvizit a deformátorŧ mŧţete přeskupovat. Přeskupení deformátorŧ mŧţe být 
uţitečné zejména v případě, kdy pouţíváte dlouhý seznam hierarchie. Přeskupovat mŧţete také 
morph targety a parametry, jako je charakter rotace (stejně jako při pouţití palety editoru kloubŧ Joint 
Editor). Přeskupovat mŧţete také osvětlení, kamery a parametry Point At. 

 POZNÁMKA 
PŘI ZMĚNĚ CHARAKTERU ROTACE POSTUPUJTE OPATRNĚ, PROTOŢE MŦŢE DOJÍT  
K NEOČEKÁVANÝM REAKCÍM. 
 

USTANOVENÍ HIERARCHICKÝCH VZTAHŮ   
ESTABLISHING HIERARCHAL RELATIONSHIPS (orig.181) 

Toto je moţné uskutečnit také pomocí příkazového menu Set Parent (viz téma “Změna mateřských 
vazeb” na straně 201). Pro nastvení hierarchických vztahŧ za pouţití editoru hierarchie Hierarchy 
Editor: 

1. Vloţte poţadovanou rekvizitu(y) do scény. 

2. Otevřete paletu editoru hierarchie Hierarchy Editor a najděte rekvizitu. 

3. Přetáhněte podřízený child objekt do horní části větve nadřazeného parent objektu. Jakmile je 
podřízený objekt nad objektem, který mŧţe být pouţit jako nadřazený, zobrazí se zelený obdélník  
a kurzor se změní v zátrţítko. 

4. Pusťte objekt. 

Pro přeskupení podřízeného objektu child ve stejné úrovni hierarchie: 
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1. Klikněte na podřízený objekt a přetáhněte jej na jinou pozici. Pod moţným cílovým místem se 
zobrazí zelená linka, která indikuje, kde mŧţe být objekt umístěn po upuštění. 

2. Pusťte objekt. 

Mŧţete také vytvářet hierarchie sloţených figur (jako například ţeny na hřbetu koně): 

1. Zvolte podřízenou child figuru. 

2. Přetáhněte podřízenou figuru za poţadovanou figuru nadřazenou parent. 

3. Pusťte podřízenou figuru. 

Následujícím zpŧsobem mŧţete nastavovat hierarchii mezi figurami mimo paletu editoru hierarchie 
Hierarchy Editor: 

1. Pouţijte rozbalovací menu pro výběr podřízené child figury. 

2. Zvolte příkaz Figure>Set Figure Parent (viz téma “Nastavení mateřských vazeb figury” na straně 
195) pro otevření dialogového okna Parent. 

3. Vyberte nadřazenou postavu/část postavy z dialogu a klikněte na OK. 
 

APLIKACE STANDARDNÍHO POŘADÍ ROTACE   
APPLYING STANDARD ROTATION ORDER (orig.181) 

Prosím navštivte elektronický (PDF formát) Poser 7 Tutorial Manual ve sloţce Tutorials v instalační 
sloţce Poseru 7 pro více informací o této funkci. 
 

APLIKACE STANDARDNÍ HIERARCHIE  APPLYING THE STANDARD HIERARCHY (orig.181) 

Prosím navštivte elektronický (PDF formát) Poser 7 Tutorial Manual ve sloţce Tutorials v instalační 
sloţce Poseru 7 pro více informací o této funkci. 
 

TVORBA SVAZKŮ IK  CREATING IK CHAINS (orig.182) 

Pro vytvoření svazku IK: 

1. Přesuņte se do spodní části seznamu hierarchie ze pouţití posuvníku a klikněte na odkaz IK 
Chains pro zpřístupnění tlačítka Create IK Chain a klikněte na něj. 

2. Zadejte název nově tvořeného svazku do dialogového okna, které se zobrazí a klikněte na OK. 
V seznamu se objeví čistý IK svazek. 

3. Naplánujte všechny elementy svazku IK od počátku do konce. Například svazek IK pravého 
ramene má za koncový objekt pravou dlaņ. 

4. Ze seznamu hierarchie klikněte a přetáhněte odpovídající části postavy do nového svazku IK. Do 
svazku IK budou zadány v pořadí, v jakém je budete přetahovat, od počátku root do konce goal. 
Proto při přetahování částí do svazku postupujte vţdy od počátečního objektu po objekt cílový. 

 POZNÁMKA 
PŘI TVORBĚ SVAZKŦ IK BUĎTE OPATRNÍ, NEBOŤ PO PŘIDÁNÍ NOVÉHO SVAZKU SE VAŠE 
POSTAVA MŦŢE POHYBOVAT NEOČEKÁVANÝM ZPŦSOBEM. 
 

POUŢITÍ IK  USING IK (orig.182) 

Pro aktivování inverzní kinematiky IK u Vaší figury vyberte příkaz Figure>Use Inverse Kinematics  
a zvolte svazek, který si přejete aktivovat. V nabídce budou zobrazeny svazky, které jste vytvořili  
a také standardní svazky Poseru 7 (pokud jste nějaké svazky ke standardní figuře Poseru 7 přidali). 
Jakmile je svazek aktivován, zobrazí se vedle něj zátrţítko. Pro deaktivování inverzní kinematiky IK 
vyberte příkaz Figure>Use Inverse Kinematics a zvolte svazek, který si přejete deaktivovat. Mŧţete 
také otevřít editor hierarchie Hierarchy Editor a označit nebo odznačit políčka vedle svazkŧ IK 
v seznamu pro aktivování nebo deaktivování inverzní kinematiky IK. 
  

TVORBA NOVÉ FIGURY  CREATING A NEW FIGURE (orig.182) 

Prosím navštivte elektronický (PDF formát) Poser 7 Tutorial Manual ve sloţce Tutorials v instalační 
sloţce Poseru 7 pro více informací o této legální metodě tvorby figury. 
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EDITOR KLOUBŮ  THE JOINT EDITOR (orig.183) 

V této sekci bude vysvětleno, jak lze pouţít paletu editoru kloubŧ Joint 
Editor pro nastavení pozice a k jemnému doladění kloubŧ. Pro 
otevření této palety zvolte Window>Joint Editor. 

Editor kloubŧ Joint Editor umoţņuje nastavení aktuálně vybraného 
kloubu joint (místnost póz Pose room) nebo kosti bone (místnost 
nastavení Setup room) ovládáním kloubŧ joints a zón prolnutí blend 
zones. Transformátory kloubŧ a prolnutí mŧţete manipulovat přímo, 
čímţ měníte zpŧsob práce kloubu nebo kosti. Tuto funkci mŧţete 
pouţít pro: 

o Jemné doladění prolínání u existujících figur podle Vašich potřeb. 

o Vytvoření nových typŧ efektŧ. 

o Uţivatelské přizpŧsobení kloubŧ a transformátorŧ při tvorbě 
vlastních figur (například při pouţití místnosti nastavení Setup 
room, jak je popsáno v kapitole 20: “Místnost nastavení“ na straně 
174). 

Klouby figury definují, jakým zpŧsobem se její části ohýbají, kroutí  
a nadouvají. Realistický pohyb figury je ovládán nastavením kloubŧ. 
Například koleno stojící figury nemŧţe být ohýbáno dopředu. 

Pohyby figur jako ohyb a kroucení jsou tvořeny pomocí transformátorŧ, 
které natáčejí, roztahují nebo mění velikost polygonŧ v transformační 
zóně za účelem vytvoření poţadovaného pohybu. Tímto zpŧsobem se 
z jednolitého statického modelu v Poseru 7 stane zcela pohyblivá 
figura. Transformační zóny jsou definovány přiřazením úhlŧ inkluze  
a exkluze pro kaţdou zónu. Polygony v úhlu exkluze nejsou ohybem 
kloubu dotčeny, zatímco polygony v úhlu inkluze dotčeny jsou. Prostor 
mezi úhly inkluze a exkluze je nazýván zónou prolnutí blend zone, ve 
které jsou polygony nastaveny pro vytvoření plynulého přechodu mezi 
sousedními polygony.  
 

O ATRIBUTECH KLOUBU  ABOUT JOINT ATTRIBUTES (orig.183) 

Kaţdý kloub kostěné struktury figury obsahuje některý z následujících atributŧ. Dostupné atributy 
závisejí na aktuálně vybraném kloubu. Pamatujte na to, ţe pokud v paletě editoru kloubŧ Joint Editor 
pracujete s částmi postavy, nebo s kostmi, vţdy bude výsledek stejný. V zájmu diskuze nutno dodat, 
ţe paleta editoru kloubŧ pracuje s částmi postavy v místnosti póz Pose room a s kostmi v místnosti 
nastavení Setup room. 

o Center: Atribut Center nastavuje střed otáčení vybrané kosti. Je dostupný pro všechny kosti, části 
postavy a rekvizity. Natáhněte například ruku dlaní nahoru, ohněte ji v lokti a všimněte si, ţe střed 
otáčení je uprostřed mezi vnitřním a vnějším loktem. Také si všimněte, jak se kŧţe nad středem 
otáčení stahuje a pod ním natahuje. Představte si, jak by byl ovlivněn ohyb Vaší ruky v případě, ţe 
by byl střed otáčení v jiné pozici. Pohybujte také některými dalšími klouby a představte si, jak by 
byl pohyb končetim ovlivněn přesunem jejich středu otáčení. Atribut Center ovládá vzhled pohybu 
kloubu. 

o Twist: Atribut Twist mění umístění deformátoru kroucení vybrané kosti. Atribut Twist neobsahuje 
kost bokŧ hip nebo její ekvivalent, protoţe boky jsou nadřazenou částí parent celé figury  
a kroucením bokŧ dochází ke kroucení celé figury. Pokud zvednete ruku s dlaní směrem dolŧ, 
pomocí kroucení otočíte dlaņ směrem nahoru. Všimněte si, ţe část ruky se při tomto pohybu 
nemění, s výjimkou předloktí, u kterého se kŧţe a svalstvo při pohybu kroutí. Představte si, jak by 
vypadala změna pohybu po přesunu počátečního a koncového bodu kroucení do jiné pozice. 
Atribut Twist ovládá vzhled pohybu kloubu. 

o Bend: Nastavení atributu Bend ovládá úhel transformátoru ohybu a definuje tvorbu rozpínání 
svalŧ. Ohýbejte rŧzné klouby a všímejte si, jaké jsou limity ohybu kloubŧ a jak se při pohybu 
napíná kŧţe a roztahují svaly. Atribut Bend umoţņuje toto ovládat na Vaší figuře. 
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o Side to Side/Front to Back: Stejně jako atribut Bend, atributy Side-Side a Front-Back ovládají úhly 
deformátorŧ posunu ze strany na stranu a zepředu dozadu a definují tvorbu rozpínání svalŧ. Tyto 
atributy byly vytvořeny pro všesměrové klouby, jako jsou zápěstí, ramena, kyčle, kotníky, atd. 

o Inclusion/Exclusion Angles: Úhly inkluze Inclusion a exkluze Exclusion definují, které polygony se 
budou pohybovat v závislosti na ohybu kloubŧ a jakým zpŧsobem se části postavy na obou 
stranách kloubu při pohybu prolínají. Pokud posunete jakoukoliv částí Vaší postavy (například 
ohnete loket), mŧţete sledovat, ţe kŧţe horního a spodního loktu se přitom nemění, s výjimkou 
oblasti v blízkosti loketního kloubu. V blízkosti loketního kloubu se kŧţe napíná nebo stahuje 
v závislosti na rozsahu a směru pohybu. Při mírném překročení aktuálního rozsahu pohybu se 
kŧţe a svaly tomuto pohybu přizpŧsobí a zajistí plynulý přechod. Pokud editujete úhly inkluze  
a exkluze, červená čára reprezentuje úhel exkluze a zelená čára reprezentuje úhel inkluze. 

o End Zone: Pokud je ke kloubu napojen jeden podřízený kloub, koncovým bodem je vţdy počáteční 
bod podřízeného prvku. Pokud je více podřízených prvkŧ (například u ruky), koncový bod mŧţe být 
zadán manuálně. Tato funkce se pouţívá u některých společně pŧsobících nástrojŧ, jako je nástroj 
otočení Rotate, pro orientaci z počátečního bodu. Pokud ke kloubu není napojen další podřízený 
prvek (typicky u hlavy), koncový bod je také editovatelný. 

 

POUŢITÍ EDITORU KLOUBŮ  USING THE JOINT EDITOR (orig.184) 

V této části obecně popíšeme pouţití palety editoru kloubŧ Joint Editor a včetně společných 
předvoleb všech parametrŧ kloubŧ. Pro editaci parametrŧ kloubŧ začněte výběrem poţadovaného 
kloubu a otevřením palety editoru kloubŧ pomocí volby Window>Joint Editor. Obecně dostupné 
předvolby jsou následující: 

o Selecting a Joint: Pro výběr kloubu klikněte na poţadovanou kost nebo kloub. 

o Selecting a Joint Parameter: Pouţijte rozbalovací menu v horní části palety editoru kloubŧ Joint 
Editor pro výběr dostupných atributŧ vybraného kloubu, které si přejete editovat. Dostupné 
parametry vybraných atributŧ budou zobrazeny v paletě. 

o Display Deformer: Předvolba Display Deformer zapíná a vypíná zobrazení aktuálního kloubu 
(který mŧţe být nepotřebný, pokud se nacházíte v místnosti nastavení Setup room). 

o Use Spherical Falloff Zones: Předvolba Use Spherical Falloff Zones zapíná a vypíná sférické 
zóny prolnutí. Prosím navštivte téma “Sférické zóny prolnutí” na straně 135 pro více informací  
o zónách prolnutí. 

o Zero Figure: Výběrem poloţky Zero Figure dojde k nastavení všech parametrŧ rotace kloubŧ na 
nulovou hodnotu. 

Následující část obsahuje detailní informace o kaţdém atributu kloubŧ. 
 

EDITACE ATRIBUTŮ KLOUBŮ  EDITING JOINT ATTRIBUTES (orig.185) 

V této části vysvětlíme, jak nastavit kaţdý dostupný parametr kloubŧ. Nicméně ne všechny parametry 
mohou být aplikovány u kaţdého kloubu. V editoru kloubŧ budou zobrazeny jen ty parametry, které 
mohou být u vybraného kloubu aplikovány. 
 

Střed  CENTER (orig.185) 

Následující předvolby jsou dostupné při nastavování parametru Center kloubu: 

o Center Point: Atribut Center Point definuje XYZ pozici kloubu (střed části postavy). 0,0,0 se 
nachází ve středu struktury kostí na podlaze. 

o Orientation: Atribut Orientation definuje XYZ rotaci kloubu okolo jeho osy. Klikněte a táhněte 
otočným ovladačem pro nastavení poţadované hodnoty. Stisknutím a drţením klávesy [OPT]/[ALT] 
současně s kliknutím na otočný ovladač nastavíte hodnotu 0. 

o Align: Kliknutím na tlačítko Align dojde k srovnání kloubu s jeho základní částí postavy nebo 
skupinou. Tato funkce je uţitečná, kdyţ máte vytvořeny skupiny a připojené kosti ke geometrii. 
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Kroucení  TWIST (orig.185) 

Pokud je inverzní kinematika IK aktivována, podřízené kosti se otáčejí, pokud je krouceno s kostí 
nadřazenou. Kroucením bokŧ hip dochází k pohybu celé figury, protoţe boky jsou obvykle 
nadřazeným prvkem parent celé figury, proto boky tento parametr neobsahují. Obvykle osa kroucení 
Twist prochází podélně směrem ke středu kaţdé části postavy. Například osa kroucení ruky je X, 
zatímco osa kroucení nohy je Y. 

Hodnoty Twist Start a Twist End definují počáteční a koncové body 
rozsahu kroucení kosti. Zadejte pořadované hodnoty do odpovídajících 
políček. Všimněte, ţe mŧţete oblast kroucení vytvořit větší, neţ je vybraná 
kost, coţ mŧţe zpŧsobit, ţe pohyb kroucení vypadá více realistický.  
V mnoha případech by nadřazený prvek kosti měl být uvnitř oblasti 
kroucení. 

Pokud je tento parametr vybrán, na figuře se zobrazí čára se dvěma úchyty. 
Červený úchyt reprezentuje počáteční bod oblasti transformace kroucení  
a zelený úchyt reprezentuje bod koncový. Taţením pomocí těchto úchytŧ 
zvětšíte nebo zmenšíte oblast kroucení Twist. 

Pro nastavení tohoto parametru mŧţete pouţít editační nástroje Editing 
tools. Tento parametr existuje ve třech rozměrech, coţ znamená, ţe 
mŧţete otáčet figurou pro zobrazení kloubu z libovolného úhlu. Také 
mŧţete figuru ponechat v základním postavení a pouţít ortografické kamery 
(horní Top, spodní Bottom, levou Left, pravou Right, přední Front, zadní 
Back) k přehlednému nastavení pohybu dvou os.  
 

Úhly inkluze & exkluze  INCLUSION & EXCLUSION ANGLES (orig.186) 

Parametry Bend, Side-Side a Front to Back umoţņují definovat úhly inkluze a exkluze vybraného 
kloubu. Úhel inkluze je zobrazen dvěmi zelenými čarami tvořících úhel a úhel exkluze je tvořen dvojicí 
červených čar tvořících úhel. 

Úhel inkluze definuje polygony, které budou pohybem vybraného kloubu ovlivněny. Při pouţití 
předchozího příkladu ohybu ruky v lokti, celá ruka dále od lokte se pohybuje. Naopak úhel exkluze 
definuje polygony, které pohybem aktuálního kloubu ovlivněny nebudou. Všimněte si, ţe horní část 
ruky se při jednoduchém ohnutí lokte nepohybuje. 

Prostor mezi úhly inkluze a exkluze se nazývá zóna prolnutí 
blend zone, ve které Poser 7 roztahuje, ohýbá a smršťuje 
polygony pro vytvoření hladkého přechodu mezi prvky 
figury. Je to totéţ, jako kdyţ ohýbáte nohu a kŧţe v místě 
napojení nohy na boky se natahuje a smršťuje tak, aby se 
přizpŧsobila tomuto pohybu. 

Obrázek vedle ukazuje úhel exkluze v horní části bokŧ, úhel 
inkluze dole a zónu prolnutí v okolí samotného kloubu. Pro 
editaci úhlŧ inkluze a exkluze: 

1. Přesuņte kurzor ke koncovému bodu úhlu exkluze nebo 
inkluze, kurzor se změní na symbol cíle. 

2. Táhněte úhlem. Je doporučeno pouţití módu zobrazení Full Tracking pro přímé zobrazení efektu 
změny při taţení. Mŧţete také poţadovanou hodnotu úhlu zadat přímo do textového pole.  

Pro nastavení tohoto parametru mŧţete pouţít editační nástroje Editing tools. Tento parametr 
existuje ve třech rozměrech, coţ znamená, ţe mŧţete otáčet figurou pro zobrazení kloubu 
z libovolného úhlu. Také mŧţete figuru ponechat v základním postavení a pouţít ortografické kamery 
(horní Top, spodní Bottom, levou Left, pravou Right, přední Front, zadní Back) k přehlednému 
nastavení pohybu dvou os. 
 

Ohyb, ze strany na stranu, zepředu dozadu   
BEND, SIDE TO SIDE, AND FRONT TO BACK (orig.187) 

Tyto parametry mění úhly transformátorŧ ohybu bend, posunu ze strany na stranu side-to-side  
a zepředu dozadu front-to-back. Dále mŧţe Poser 7 vytvářet vyboulení, které emuluje zvětšování 
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objemu svalŧ při pohybu. Kaţdý z těchto tří parametrŧ je funkčně identický při editaci atributŧ kloubŧ 
v paletě editoru kloubŧ Joint Editor. Tyto obsahují následující nastavení: 

o Center Point: Atribut Center Point definuje střed kloubu ve 3D prostoru. 0,0,0 se nachází ve středu 
struktury kostí na podlaze. Pohyb (ohyb, ze strany na stranu nebo zepředu dozadu) začíná ve 
středovém bodu. 

o Joint Angles: Hodnoty Static A a Static D určují úhel exkluze. Hodnoty Dynamic B a Dynamic C 
určují úhel inkluze. 

o Bulge Settings: Označením políčka Apply Bulge určíte, ţe polygony se budou při pohybu ohýbat  
a vzdouvat za účelem emulace zvětšování objemu svalŧ, jako při pohybu reálné postavy. Pokud je 
políčko označeno, polygony v zóně prolnutí mohou být pro vytvoření boule nebo vrásky nataţeny 
nebo smrštěny. Left a Right odpovídají levé a pravé straně kostěného modelu. Kladná hodnota 
otočného ovladače stanovuje, jak velké vyboulení svalu bude při pohybu kloubu vygenerováno  
a záporná hodnota stanovuje míru zvrásnění svalu. 

Pro nastavení těchto parametrŧ mŧţete pouţít editační nástroje Editing tools. Tyto parametry existují 
ve třech rozměrech, coţ znamená, ţe mŧţete otáčet figurou pro zobrazení kloubu z libovolného úhlu. 
Také mŧţete figuru ponechat v základním postavení a pouţít ortografické kamery (horní Top, spodní 
Bottom, levou Left, pravou Right, přední Front, zadní Back) k přehlednému nastavení pohybu dvou 
os. 
 

Změna měřítka  SCALING (orig.187) 

Kaţdá část postavy obsahuje parametry, které umoţņují měnit měřítko 
nadřazených a podřízených částí postavy. Tato nastavení jsou podobná 
parametru kroucení Twist a následují osu kroucení nadřazené nebo 
podřízené části postavy. Kupříkladu pravá krční část Right Collar figury 
Poser 4 Business Man obsahuje ovladače pro hrudník Chest 
(nadřazený) podél osy Y a pravé rameno Right Shoulder (podřízený) 
podél osy X.  

Parametry High End/Start a Low Start/End definují zónu prolnutí. Pokud například měníte měřítko 
hlavy, měli byste také změnit měřítko horní části krku pro dosaţení hladkého přechodu. Pokud 
nastavujete tyto parametry, pouze jedno nastavení (high nebo low) je platné. Nepouţité parametry 
obdrţí automaticky nějakou nereálnou hodnotu (jako je 99,000 nebo 100,000), která indikuje 
neplatnou hodnotu pro oblast, ve které pracujete. Tato nastavení mimo limit neopravujte. Kaţdá zóna 
prolnutí je reprezentována červeně s počátkem v barvě zelené. Účinek mŧţe být jednotný, nebo 
mohou být pouţity sférické zóny prolnutí, popisované dále. 
 

SFÉRICKÉ ZÓNY PROLNUTÍ  SPHERICAL FALLOFF ZONES (orig.188) 

Sférické zóny prolnutí Spherical Falloff Zones jsou pokročilou metodou ovládání prolnutí mezi dvěmi 
kostmi nebo částmi postavy. Dvě koule, vnitřní zelená a vnější červená, reprezentují zónu prolnutí. 

Zelená koule definuje oblast, která je transformací (pohybem) ovlivněna na 100% a červená koule 
definuje okraj efektu transformace. Oblast mezi koulemi je zóna prolnutí, ve které efekt transformace 
sniţuje postupně svŧj účinek ze 100% na hranici vniřní koule do 0% na hranici vnější koule. 

Sférické zóny prolnutí mŧţete zobrazit pomocí několika dostupných módŧ. Pro změnu zobrazení 
koulí: 

1. Vyberte kouli. 

2. Zvolte Display>Element Styles. 

3. Vyberte poţadovaný mód zobrazení. 

Mód Wireframe umoţņuje zobrazení kulových oblastí efektu při současném zobrazení uvnitř 
umístěných kostí/geometrie. 

Sférické zóny prolnutí mŧţete editovat stejně jako kosti nebo části postavy za pouţití editačního 
nástroje Editing tools. Pokud přidáte novou zónu prolnutí, její základní pozice je 0,0,0. 
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POŘADÍ ROTACE  ROTATION ORDERS (orig.188) 

Paleta editoru kloubŧ Joint Editor obsahuje rozbalovací menu pořadí kloubu Joint Order, které 
definuje osu rotace kloubu. Pořadí kloubu je definováno třemi písmeny odpovídajícími osám X, Y a Z. 

 POZNÁMKA 
PŘI POUŢITÍ POZICE PŘEDNÍ KAMERY, OSA X PROBÍHÁ ZLEVA DOPRAVA, OSA Y PROBÍHÁ 
ZESPODU NAHORU A OSA Z PROBÍHÁ ZEZADU DOPŘEDU. TOTO JE NAZÝVÁNO 
PRAVOÚHLÝM SOUŘADNICOVÝM SYSTÉMEM. 

Správné nastavení pořadí rotace kaţdého kloubu určuje, zda se bude Vaše postava pohybovat 
správně, jak si jistě přejete. Pokud vytváříte nové kosti pomocí nástroje kostí, Poser 7 pouţije nejlepší 
odhad pro nastavení nejlepšího pořadí rotace této kosti. Pořadí rotace mŧţete vybrat pomocí palety 
editoru kloubŧ Joint Editor po otevření rozbalovacího menu Joint Order. 

 POZNÁMKA 
POKUD MĚNÍTE POŘADÍ KLOUBU, BUDETE PRAVDĚPODOBNĚ MUSET PŘENASTAVIT ZÓNY 
KLOUBU AKTUÁLNĚ VYBRANÉ KOSTI. 

Kaţdý kloub obsahuje obsahuje tři separátní prvky kloubu, jeden twist a dva joints. Prvek twist je 
umístěn vţdy na prvním místě v pořadí kloubu. Z dŧvodu moţných problémŧ s rotací je vhodné umístit 
osu rotace procházející kloubem na poslední místo v pořadí a zbývající osu rotace umístit do středu 
pořadí. Například holeņ je vertikální a otáčí se okolo osy Y. Pokud se holeņ ohýbá, s největší 
pravděpodobností se ohýbá okolo osy X. Proto je nejlepším pořadím kloubu holeně YZX. 

 POZNÁMKA 
ZPOČÁTKU SE TO ZDÁ PONĚKUD MATOUCÍ. DOBRÝM ZPŦSOBEM VIZUALIZACE SPRÁVNÉHO 
POŘADÍ ROTACE JE OBRÁZEK POSTAVY STOJÍCÍ V PRACOVNÍM PROSTORU POSERU 7 
ČELEM DOPŘEDU. PRO KAŢDÝ MOŢNÝ POHYB DANÉHO KLOUBU SI PŘEDSTAVTE ČÁRU 
PROCHÁZEJÍCÍ STŘEDEM KLOUBU. NAPŘÍKLAD HOLEŅ SE KROUTÍ PODÉL ČÁRY, KTERÁ 
PROCHÁZÍ PŘÍMO ZESPODU NAHORU (ODPOVÍDÁ OSE Y) A OTÁČÍ SE PODÉL ČÁRY, KTERÁ 
PROCHÁZÍ ZLEVA DOPRAVA (ODPOVÍDÁ OSE X). NYNÍ JE JIŢ NA ZÁKLADĚ TÉTO 
VIZUALIZACE A DLE VÝŠE UVEDENÝCH POŢADAVKŦ JEDNODUCHÉ STANOVIT SPRÁVNÉ 
POŘADÍ KLOUBU JAKO YZX. 

Místo přímek ohybu twist/joint/joint mŧţete také pouţít křivku ohybu. Pokud nastavíte kloub pomocí 
křivky, kloub obsahuje jeden prvek twist a jeden prvek curve (křivku). Prvek curve automaticky ohýbá 
částí postavy tak, jako by byla řetězcem ohebných objektŧ. Tato funkce je velmi vhodná pro části 
postavy jako je ocas nebo pro anténu. 
 

KOPÍROVÁNÍ A ULOŢENÍ NASTAVENÍ KLOUBU 
COPYING AND SAVING JOINT SETTINGS (orig.189) 

Pro kopírování nastavení kloubu z jedné strany figury na stranu druhou pouţijte symetrii, jak je 
popsáno v částin “Symetrie” na straně 197. 

Pro uloţení Vašeho nastavení palety editoru kloubŧ Joint Editor musíte buď uloţit scénu, nebo 
dotčenou figuru uloţit do palety knihoven Library. Prosím navštivte téma “Uložit” na straně 185 pro 
informace o uloţení scén Poseru 7 a kapitolu 5: “Knihovny Poseru 7” na straně 28 pro informace  
o pouţití palety knihoven Library. 
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Kapitola 15: Vyhlazování povrchu  SMOOTH SHADING (orig. 190) 

Funkce vyhlazování povrchu smooth shading srovnává povrch objektu beze změny geometrie jeho 
hran. Vyhlazování smooth shading vyrenderuje zaoblené hrany mezi polygony a souvislé povrchy 
bez ostrých hran. Tímto zpŧsobem smooth shading umoţņuje dosaţení konzistentního 
vyhlazovacího efektu bez nutnosti změny geometrie pomocí dělení polygonŧ pro zmenšení viditelné 
struktury povrchu. 

V základním nastavení, pokud nejsou specifikovány vyhlazovací skupiny smoothing groups, 
vyhlazování smooth shading bude aplikováno na všechny figury a objekty unitř scény, podle úhlu 
vyhlazení Crease Angle, specifikovaného v paletě vlastností Properties pro kaţdý aktuální prvek. 
Dodatečně mŧţete vyhlazování přizpŧsobit jedním ze dvou zpŧsobŧ, které jsou popsány 
v následujících částích: 
 

ÚHEL VYHLAZENÍ  CREASE ANGLE (orig.190) 

Úhel vyhlazení Crease Angle reprezentuje úklon mezi rovnoběţkami sousedních polygonŧ. Vlastnosti 
úhlu vyhlazení nastavují prahovou hodnotu, nad kterou nebude vyhlazování aplikováno. Jinými slovy, 
pokud je úhel vyhlazení nastaven na 70, vyhlazování bude aplikováno na všechny polygony, které 
navazují v úhlu menším neţ 70 stupņŧ. Polygony, které na sebe navazují v úhlu větším neţ 70 stupņŧ 
vyhlazovány nebudou. Velikost úhlu vyhlazení Crease Angle mŧţete v paletě vlastností Properties 
nastavit pro kaţdý individuální prvek figury nebo objektu. V základu je úhel vyhlazení, Crease Angle 
nastaven na 80 stupņŧ pro všechny prvky. Pro změnu základního nastavení úhlu vyhlazení zvolte 
Edit>General Preferences a klikněte na záloţku Document. 

Následující obrázek uvádí přiklad koule s úhlem vyhlazení 10 stupņŧ a vedle s úhlem vyhlazení 
nastaveným na 80 stupņŧ: 

 
 

VYHLAZOVACÍ SKUPINY  SMOOTHING GROUPS (orig.191) 

Paletu editoru skupin Group Editor mŧţete pouţít pro stanovení vyhlazovacích skupin smoothing 
groups, které definují specifické polygony, u kterých by mělo být vyhlazování smooth shading 
aplikováno. Tento postup mŧţe být uţitečný, protoţe umoţņuje uţivatelsky přizpŧsobit vyhlazování 
povrchu na úrovni polygonŧ a umoţņuje vytvoření povrchu s ostrými hranami společně s vyhlazenými 
plochami. Natavení vyhlazovacích skupin převáţí nastavení úhlu vyhlazení, definovaného pro tyto 
specifické polygony. 

V paletě editačních nástrojŧ Editing Tools vyberte nástroj pro vytvoření skupin Grouping, který 
zpřístupní paletu editoru skupin Group Editor. Mŧţete také přiřadit všechny polygony z jedné nebo 
více jiţ existujících skupin figury do vyhlazovací skupiny, nebo vytvoříte úplně nové specifické 
vyhlazovací skupiny, které Vám umoţní uţivatelské přizpŧsobení vyhlazování povrchu na úrovni 
polygonŧ. Prosím navštivte téma “Editor skupin” na straně 125 pro více informací o tvorbě nových 
skupin. 
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Jakmile máte skupiny vytvořeny, jednoduše klikněte na tlačítko Assign Smoothing ID pro označení 
vybrané skupiny za vyhlazovací skupinu. Během renderu budou všechny hrany mezi sousedními 
polygony náleţícími do stejné vyhlazovací skupiny vyhlazeny. Hrany polygonŧ mezi sousedními 
polygony náleţícími do jiné vyhlazovací skupiny nemusí být vyhlazovány, a proto tyto hrany zŧstanou 
ostré. Tudíţ byste měli dát pozor, k jakému Smoothing ID přiřadíte kaţdou ze specifických skupin 
polygonŧ. 

 POZNÁMKA 

KE STEJNÉMU SMOOTHING ID MOHOU BÝT PŘEŘAZENY RŦZNÉ SKUPINY POLYGONŦ, 
KTERÉ ZAJISTÍ VYHLAZOVÁNÍ POVRCHU PŘES GEOMETRICKÉ HRANICE MEZI SKUPINAMI. 
JEDNODUŠE VYTVOŘTE SMOOTHING ID PRO POČÁTEČNÍ SKUPINU A NÁSLEDNĚ VYBERTE 
STEJNÉ ID Z ROZBALOVACÍHO SEZNAMU BĚHEM PŘIŘAZOVÁNÍ SMOOTHING ID PRO DALŠÍ 
SKUPINY. 

Poser 7 mŧţe rozpoznat a podporovat existující vyhlazovací skupiny v importované geometrii. Proto 
pokud importujete figury nebo objekty z jiné 3D aplikace, Poser 7 mŧţe aplikovat vyhlazování povrchu 
podle definicí importovaných vyhlazovacích skupin stejným zpŧsobem, jako by byly vytvořeny pomocí 
Poseru 7. 
 

VYHLAZOVÁNÍ POLYGONŮ  SMOOTH POLYGONS (orig.191) 

Nastavení vyhlazování polygonŧ v nastavení renderu aktivuje dělení polygonŧ za účelem vyhlazení 
ostrých přechodŧ během renderu. Pokud Váš obraz obsahuje viditelné ostré hrany z dŧvodu, ţe 
polygonová síť je řídká, mŧţe funkce vyhlazování polygonŧ během renderu  tyto hrany vyhladit. Viz 
kapitola 36: “Použití renderovacího nástroje FireFly” na straně 249 pro více informací o aplikaci této 
funkci. 

Všimněte si, ţe vyhlazování polygonŧ během renderu se nedotkne ostrých hran specifikovaných buď 
úhlem vyhlazení, nebo vyhlazovací skupinou. Tudíţ musíte ostré hrany specifikovat definitivně 
pouţitím jedné z těchto metod a poté mŧţete během renderu aplikovat vyhlazování polygonŧ na 
všechny ostatní hrany. 

Následující obrázek ilustruje efekt vyhlazování polygonŧ během renderu. Nalevo je zobrazena koule 
s vyhlazovacím úhlem nastaveným na 80 stupņŧ bez funkce vyhlazování polygonŧ. Napravo je stejná 
koule s aktivivanou funkcí vyhlazování polygonŧ. 
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Kapitola 16: Místnost materiálu  THE MATERIAL ROOM (orig. 193) 

Místnost materiál Material room Poseru 7 je jedním z nejmocnějších nástrojŧ dostupných pro tvorbu 
a editaci procedur zobrazení povrchŧ. Místnost materiálu byla od počátku navrhována pro poskytování 
maximálního výkonu, flexibility a jednoduchého pouţití umělci a animátory. Nemusíte být programátor! 
Místnost materiálu Material room poskytuje maximální moţnost ovládání vzhledu scén v Poseru 7. 

Místnost materiálu Material room umoţņuje popis vlasností materiálu povrchŧ Vašich objektŧ  
a poskytuje plnou kontrolu kaţdého aspektu vzhedu povrchu, od barvy povrchu po komplexní světelné 
interakce. Tato kapitola vysvětlí základní stavební bloky místnosti materiálu. Pro detailnější 
seznámení se shadery a uzly v místnosti materiálu Material room, navštivte prosím část 4: “Materiály” 
na straně 217. Místnost materiálu je dostupná kliknutím na záloţku Material room v horní části 
pracovního prostoru Poseru 7. Místnost materiálu vypadá následovně: 

 

Místnost materiálu Material room nabízí dva módy práce s materiály povrchu: záloţku jednoduchého 
módu Simple a záloţku pokročilého módu Advanced. Záloţka Simple je méně komplexní neţ 
záloţka Advanced a umoţņuje uţivatelŧm aplikovat a modifikovat materiály pomocí několika 
základních ovladačŧ. Pro pokročilejší uţivatele nabízí záloţka Advanced silné nástroje pro definici 
vlastností materiálu za pouţití shaderŧ a uzlŧ. V základním nastavení obsahuje místnost materiálu 
Poseru 7 následující poloţky: 

o Eyedropper Tool (1): Nástroj Eyedropper tool (kapátko) vypadá jako editační nástroje Editing 
tools. Jeho aktivací a kliknutím na objekt ve scéně otevřete stromovou strukturu shaderu objektu 
pro editaci v okně Shader. 

o Document Window (2): Prosím navštivte kapitolu 6: “Pracovní okno Document” na straně 41 pro 
informaci o okně Document. 

o Camera Controls (3): Prosím navštivte kapitolu 8: “Kamery” na straně 53 pro informace  
o ovladačích kamer Camera controls. 



 

Strana 140 (celkem 289) 

o Light Controls (4): Prosím navštivte kapitolu 9: “Osvětlení” na straně 61 pro informace o ovladačích 
osvětlení Light controls. 

o Object List (5): Poloţka Object List funguje podobně jako menu Current Actor a obsahuje 
následující předvolby: rekvizity Props (obsahuje vlasy na bázi rekvizity a dynamické oblečení), 
osvětlení Lights, figury Figures a pozadí Background. 

o Current Material List (6): Seznam Current Materials List zobrazuje všechny materiálové skupiny 
aktuálně vybrané figury/rekvizity. Poser 7 organizuje materiály pro figury/rekvizity, čímţ zabraņuje 
zmatku při přidělování materiálŧ a dovoluje Vám například přířazení několika rŧzných ostínŧ barvy 
očí nebo pleti u kaţdé figury. Tato metoda  zacházení s materiály je označena jako multi/sub-object 
materials a je detailněji popsána v Poser 7 Tutorial Manual, “Multi/Sub-Object Materials”. 

o Material Room Help (7): Ikona (?) v pravém horním rohu okna Shader otevírá soubor nápovědy 
místnosti materiálu Material room. Tento HTML dokument obsahuje informace o pouţití uzlŧ  
a shaderŧ ke stanovení atributŧ povrchu materiálu. 

o Options pop-up menu (8): Rozbalovací menu Options je dostupné ze záloţky Advanced okna 
Shader a umoţņuje přidávání, odstraņování, kopírování, vkládání a výběr uzlŧ. Příleţitostně mŧţe 
být toto menu zpřístupněno pomocí kliknutí pravým tlačítkem uvnitř záloţky Advanced. 

o Shader Window (9): Okno Shader obsahuje dvě záloţky pro definici jednoduchého Simple nebo 
pokročilého Advanced módu materiálových technik. Záloţka Simple umoţņuje jednoduchou 
modifikaci rŧzných atributŧ vybraného materiálu, včetně Diffuse Color, Highlight, Ambient, 
Reflection, Bump a Transparency. Záloţka Advanced umoţņuje tvorbu shaderŧ, které se 
skládají ze kmenové struktury uzlŧ, umoţņující připojení libovolného mnoţství uzlŧ podle Vašeho 
přání. Uzly mohou modifikovat jiné uzly nebo stromovou strukturu uzlŧ. Prosím navštivte část 4: 
“Materiály” na straně 217 pro více informací o práci se shadery a uzly. 

o Wacro Drawer (10): Zásuvkový systém Wacro Drawer umoţņuje výběr z předdefinovaných 
zkratek, které obsahují rŧzné varianty nastavení materiálu. Pro více informací o zásuvkách Wacro 
Drawer nastudujte prosím popis Advanced Shader View dále v této kapitole. 

o Library Palette (11): Prosím navštivte kapitolu 5: “Knihovny Poseru 7” na straně 28 pro informace  
o práci s paletou knihoven Library. 

 

PRŮVODCE OKNEM SHADER  NAVIGATING THE SHADER WINDOW (orig.195) 

Značka otazníku v pravém horním rohu okna Shader otevírá stránky nápovědy pracovního postupu 
v okně materiálu Material Room. Tento dokument přináší informace o tvorbě a propojování uzlŧ 
shaderu, o nejčastějším pouţitím uzlŧ a o pokročilých atributech materiálu. 
 

JEDNODUCHÝ MÓD ZOBRAZENÍ SHADERU  SIMPLE SHADER VIEW (orig.195) 

Jednoduchý mód zobrazení okna Shader umoţņuje jednoduché pouţití ovladačŧ pro nastavení 
rŧzných atributŧ materiálu. Zpŧsob, jakým mŧţe být kaţdý z těchto atributŧ modifikován, bude 
v následující části detailně popsán. U všech atributŧ v záloţce Simple, kliknutím na náhled textury 
zobrazíte dialogové okno manaţéru textury Texture Manager. Zde mŧţete prohlíţet a vybírat dříve 
pouţité obrazové mapy z rozbalovacího seznamu, nebo vyhledávat mapy nové. Mimo to, pokud 
zpřístupníte Texture Manager ze záloţky Simple, máte moţnost výběru mezi obrázky a animacemi. 
V pokročilém módu v záloţce Advanced jsou obrázky a animace odděleně, takţe Texture Manager 
umoţņuje výběr jen jednoho typu souboru v závislosti na typu uzlu, který je pouţit. Pro načtení 
obrazové mapy klikněte na tlačítko OK. V odpovídajícím políčku náhledu textury v záloţce Simple 
bude zobrazen náhled vybrané obrazové mapy. Otočným ovladačem Map Strength nastavíte stupeņ, 
kterým obrazová mapa ovlivņuje povrch materiálu. Všimněte si, ţe ovladač Map Strength přímo 
nastavuje parametr intenzity textury Texture Strength u uzlŧ obrazové mapy (textury), které jsou 
k vidění v záloţce Advanced. Pro více informací o pouţití a tvorbě rŧzných typŧ obrazových map, 
prostudujte prosím Poser 7 Tutorial Manual ve sloţce Documentation na instalačním CD Poseru 7. 

 POZNÁMKA 
ROZBALOVACÍ SEZNAM OBRAZOVÝCH MAP V MANAŢÉRU TEXTUR NABÍZÍ HISTORICKÝ 
SEZNAM DŘÍVE POUŢITÝCH OBRAZOVÝCH MAP A ANIMACÍ. TENTO SEZNAM USNADŅUJE 
RYCHLÝ VÝBĚR OBRÁZKU; TO NEZNAMENÁ, ŢE UVEDENÉ SOUBORY JSOU AKTUÁLNĚ 
NAČTENY V PAMĚTI. 
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Symbol varování Caution (vykřičník v trojúhelníku) bude zobrazen vţdy, kdyţ atributy povrchu, se 
kterými pracujete, jsou moc sloţité na to, aby mohly být editovány v jednoduchém módu záloţky 
Simple. Mŧţe k tomu dojít v případě, kdyţ procedurální uzel shaderu je připojen na vstup difuzní 
barvy. Jakmile se zobrazí symbol varování Caution, znamená to, ţe pro plný přístup k nastavení 
parametrŧ tohoto atributu budete muset pouţít pokročilý mód záloţky Advanced. Klikněte na symbol 
Caution pro přepnutí do záloţky Advanced. 
 

Difuzní barva  DIFFUSE COLOR (orig.196) 

Difuzní (rozptýlená) barva je základní barvou povrchu aktuální figury nebo rekvizity. Pokud není  
u figury aplikována ţádná mapa textury, difuzní barva bude jedinou barvou figury (bez ohledu na 
efekty barevného osvětlení). Při renderingu ve vysoké kvalitě, kdyţ je načtena mapa textury, bude 
difuzní barva tuto texturu podbarvovat. Pokud si nepřejete, aby mapa textury byla difuzní barvou 
ovlivněna, nastavte difuzní barvu na bílou (základní barva). 

Pro změnu difuzní barvy klikněte na barevný slot v horní části plochy komponenty Diffuse. Toto 
zpřístupní vzorník barev Poseru 7 Color Picker, ve kterém mŧţete poţadovanou barvu vybrat. Pokud 
si přejete zpřístupnit systém vzorníku barev, jednoduše klikněte na prouţek RGB v pravém horním 
rohu vzorníku barev Poseru 7. 

Pokud si přejete, aby povrch textury obsahoval rŧzné úrovně jasu, uvaţujte o pouţití stejné mapy 
textury u komponenty Highlights jako u komponenty Diffuse. Jakmile máte mapu textury aplikovánu 
u komponenty Diffuse, stiskem tlačítka Apply texture to highlight bude stejná mapa textury 
aplikována i u komponenty Highlight. Pokud jiţ máte u komponenty Highlight aplikovánu jinou mapu 
textury, pouţití tohoto tlačítka pŧvodní mapu nahradí mapou z komponenty Diffuse. 
 

Odlesky  HIGHLIGHTS (orig.196) 

Komponenta Highlight odpovídá nodŧm Specular v záloţce Advanced a nastavuje odlesky 
nasvícených částí objektu. Highlights jsou jasné plochy, vznikající nasvícením objektu světlem 
směrem přímo na kameru. Mŧţete vybrat barvu odlesku highlight color, aplikovat mapu textury  
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a nastavit intenzitu mapy textury map strength, jak je popsáno výše. Za deního osvětlení nebo při 
běţném osvětlení místnosti jsou odlesky bílé. Pro doplnění světelného prostředí mŧţete vybrat barvu 
podobnou Vašemu hlavnímu světlu. 

Otočný ovladač Highlight Size umoţņuje stanovení velikosti a intenzity odleskŧ Vašich materiálŧ. 
Hladké povrchy vytvářejí ostřejší odlesky, zatímco hrubé materiály mohou vytvářet odlesky měkčí. 
Větší hodnoty u otočného ovladače zpŧsobí větší, měkčí odlesky jednotného dojmu a menší hodnoty 
zpŧsobí menší, ostřejší odlesky s blýskavým efektem. 
 

Obklopující barva  AMBIENT (orig.197) 

V Poseru 7 mŧţete obklopující barvu Ambient color individuálně nastavit pro kaţdou figuru nebo 
objekt. Obklopující barva objektu je emitována rovnoměrně do všech směrŧ. To napodobuje 
obklopující (celoprostorové) šíření světla. Na rozdíl od dalších vlastností barev, toto funguje bez 
ohledu na pozici a barvu osvětlení. Jinými slovy, dokonce kdyţ všechny další světelné zdroje budou 
vypnuty, materiál bude dále emitovat obklopující barvu Ambient color. Pouţívání obklopující barvy na 
povrchu objektu tudíţ mŧţe redukovat efekt stínŧ na témţe povrchu. 

Obklopující barva Ambient color se mísí s ostatními vlastnostmi osvětlení. Příliš mnoho obklopující 
barvy potlačuje detaily objektu, protoţe ten pak vypadá stejně, bez ohledu na interakci povrchu 
objektu s osvětlením scény. Pokud si přejete obklopující osvětlení ztlumit nebo vypnout, nastavte 
obklopujicí barvu Ambient color do šedého nebo černého odstínu. Pokud si přejete intenzivní 
obklopující osvětlení, nastavte obklopující barvu Ambient color do bílého nebo jiného jasného 
odstínu. Načtením obrazové mapy do komponenty Ambient zpŧsobí, ţe obraz bude pŧsobit stejným 
zpŧsobem jako obklopující barva Ambient color. Výběr odstínu obklopující barvy, výběr mapy textury 
a pouţití ovladače Map Strength bylo popsáno výše. 
 

Zrcadlení  REFLECTION (orig.197) 

Zrcadlení umoţņuje figuře nebo objektu odráţet přímé světlo zpět k jeho zdroji, coţ vytváří zrcadlový 
efekt. Poser 7 nabízí dvě metody aplikace zrcadlení ve scéně. První metodou je pouţití map zrcadlení 
Reflection map, které jsou 2D texturami aplikovanými na virtuální kouli pozadí pracovního prostoru 
Poseru 7. Textura z pracovního prostoru se pak zrcadlí na Vašem objektu. Tato metoda je nejlepší pro 
scény, které vyţadují jemné zrcadlové odlesky a  tyto jsou renderovány mnohem rychleji neţ při 
pouţití raytracingu, avšak výsledkem jsou někdy méně přesné výpočty zrcadlení. Další metodou je 
pouţítí raytracingu zrcadlení Raytraced Reflection, které je kalkulováno za pouţití techniky 
raytracingu renderu. Tato metoda je ideální pro scény obsahující objekty s vysoce kvalitními 
zrcadlovými povrchy, jako je chrom nebo zrcadlo, které vytváří extrémně přesné zrcadlové odrazy. 
Nicméně pouţití této metody prodluţuje čas na vytvoření renderu scény. 

Barva zrcadlení Reflective Color je zbarvení, které bude přidáno pouze tehdy, pokud je aplikována 
mapa zrcadlení Reflection map. Pouţijte předvolbu Reflective Color k vytvoření dramatických efektŧ 
Vašich renderŧ. Pro vytvoření ţivějšího vysoce reflexivního objektu pouţijte variace odstínu barvy 
objektu. Pokud je barva objektu mimořádně jasná, měli by jste pouţít tmavší odstín stejné barvy. Pro 
zvláštní kolorování pouţijte barevný odstín, který je zřetelně odlišný od barvy objektu. Otočný ovladač 
Map Strength nastavuje parametr Texture Strength uzlu Reflection map v záloţce Advanced  
a stanovuje stupeņ účinku mapy zrcadlení Reflection map na materiál. 

Označovací políčka Multiply with Lights / Object color přímo ovládají označovací políčka 
Reflection Lite Mult a Reflection Kd Mult v záloţce Advanced. Pro více informací o těchto 
poloţkách navštivte téma “Kořenový uzel materiálu/vlasů” na straně 221. 
 

Struktura povrchu  BUMP (orig.198) 

Mapa struktury povrchu Bump map je speciální obrázek ovinutý okolo objektu, který spolupracuje 
s osvětlením scény za účelem vytvoření dojmu prostorové 3D textury na jinak hladkém objektu. Mapy 
struktury povrchu Bump maps mohou být pouţity na individuálních objektech nebo částech figury pro 
napodobení jakéhokoliv stylu textur, od vrásek a pórŧ pokoţky, přes zvýrazněné plochy oblečení nebo 
rekvizit, po praskliny a boule na kameni. 

Mapu struktury povrchu Bump map mŧţete načíst pomocí okna náhledu textury a manaţeru textury 
Texture Manager, dále nastavením intenzity mapy struktury povrchu pomocí otočného ovladače Map 
Strength, jak je popsáno výše. Otočný ovladač Amount specifikuje velikost vyboulení Bump  
v jednotkách, které byly specifikovány v dialogu hlavního nastavení programu General Preferences. 
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Vyšší hodnoty zvyšují efekt vyboulení povrchu Bump a vytvářejí hrubší povrchy, zatímco niţší 
hodnoty znamenají malé vyboulení Bump a hladší povrchy. Hodnota otočného ovladače Amount 
přímo odpovídá atributu Bump v záloţce Advanced. 

Všimněte si, ţe mapy struktury povrchu Bump maps minimálně narušují normály objektu. Tudíţ, 
pokud aplikujete mapu struktury povrchu na kouli, povrch bude vypadat hrubý zatímco okraje zŧstávají 
hladké. Místnost materiálu Poseru 7 Material room obsahuje kanál přesahu Displacement channel, 
který umoţņuje pouţití mapy struktury povrchu, která aktuálně změní geometrii povrchu. Například při 
aplikaci mapy přesahu Displacement map na kouli, dojde k vytvoření hrubých okrajŧ koule, stejně 
jako hrubého povrchu koule. Označovací políčko Displacement atributu Bump aktivuje atribut 
Displacement v záloţce Advanced, který nahradí Bump efekt aktuálním efektem Displacement. 
Pokud je Displacement aktivován, otočný ovladač Amount specifikuje velikost efektu Displacement 
místo velikosti efektu Bump. 
 

Průhlednost  TRANSPARENCY (orig.198) 

Prŧhlednost umoţņuje prŧchod světla skrz figuru nebo objekt, takţe mŧţete vidět skrze ně. Při vyšší 
hodnotě prŧhlednosti bude více vidět prostor v pozadí skrze povrch objektu. Pokud není nastaveno 
zrcadlení objektu, nastavení hodnoty prŧhlednosti na 100% učiní objekt neviditelným. 

Pokud je u objektu aplikována mapa prŧhlednosti Transparency map, její textura narušuje 
prŧhlednost objektu. Například šachovnicová mapa vytvoří povrch objektu střídavě prŧhledný  
a neprŧhledný. Textury tedy mŧţete pouţívat jako mapy prŧhlednosti Transparency maps. 

Otočné ovladače Transparency, Edge a Falloff společně stanovují, jak se bude prŧhlednost objektu 
chovat. 

Otočný ovladač Transparency ovlivņuje prŧhlednost části objektu v pohledu kamery, zejména 
směrem ke středu objektu. Vyšší hodnota Transparency zpŧsobí větší prŧhlednost. 

Otočný ovladač Edge ovlivņuje speciálně prŧhlednost okrajŧ objektu. Vyšší hodnota Edge učiní okraje 
objektu velmi prŧhledné. U většiny renderŧ budete pouţívat hodnotu Transparency vyšší, neţ 
hodnotu Edge. 

Otočný ovladač Falloff stanovuje míru, kterou se prŧhlednost sniţuje při přibliţování se k okrajŧm 
objektu. Pro příklad z reálného světa se podívejte na prŧhledný objekt, kterým je sklenice na pití. 
Okraje sklenice jsou méně prŧhledné neţ zbytek povrchu. K tomu dochází tam, kde prŧhlednost skla 
„pohasíná“. V Poseru mŧţete chování tohoto pohasínání měnit. Malé hodnoty Falloff vytvoří render 
se vzhledem ostrých okrajŧ, zatímco vysoké hodnoty vytvoří render s postupným sniţováním 
prŧhlednosti povrchu objektu u okrajŧ. Pokud jsou hodnoty Transparency a Edge stejné, v renderu 
se sniţování prŧhlednosti neprojeví. 
 

POKROČILÝ MÓD ZOBRAZENÍ SHADERU  ADVANCED SHADER VIEW (orig.199) 

Záloţka Advanced okna Shader slouţí k vytváření shaderŧ pomocí práce s uzly. Prosím navštivte 
Část 4: “Materiály” na straně 217 pro více informací o uzlech shaderŧ a jak tyto fungují uvnitř Poseru 
7. 

Záloţka Advanced okna Shader obsahuje následující poloţky: 

o Object menu (1): Object menu funguje podobně jako menu Current Actor a má následující 
nabídky: Props (obsahuje praménkové vlasy strand-based hair a dynamické oblečení dynamic 
cloth), Lights, Figures a Background. 

o Material menu (2): Rozbalovací menu Material obsahuje seznam všech dostupných materiálŧ pro 
aktuálně vybraný prvek. Poser 7 pouţívá Multi/Sub-object materiály, coţ znamená, ţe v tomto 
menu mŧţete vidět pouze materiály, přiřazené aktuálně vybrané figuře/rekvizitě. Prosím 
prostudujte Poser 7 Tutorial Manual, “Multi/Sub-Object Materials” pro informace o Multi/Sub-object 
materiálech. 

o Options Menu (3): Kliknutím na šipku na pravé straně menu Shader otevřete menu Options pro 
místnost materiálu Material room, které je popsáno v Části 4: “Materiály” na straně 217. Toto 
menu mŧţete také otevřít pomocí kliknutí pravým tlačítkem myši na jakoukoliv prázdnou část uvnitř 
okna Shader nebo kliknutím na jakýkoliv přívod uzlu (viz Část 4: “Materiály” na straně 217). 

o Title Bar (4): Pozici okna Shader mŧţete měnit pomocí pruhu nadpisu okna. 
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o Wacro Drawer (5): Zásuvky Wacro Drawer umoţņují výběr z předdefinovaných zkratek, které 
obsahují rŧzné úlohy nastavení materiálu. Prostudujte sekci “Wakra” dále pro konkrétní informace 
o těchto zkratkách. 

o Resizing Handle (6): Změnu velikosti okna Shader do jakéhokoliv rozměru mŧţete učinit pomocí 
kliknutí a taţení ovladače pro změnu velikosti. 

o Root Node (7): Kořenový uzel root node aktuálně vybraného objektu nebo materiálové skupiny je 
zobrazen na levé straně okna Shader. 

o Nodes (8): Doplņkové uzly additional nodes jsou také zobrazeny v okně Shader. 

 
 

SHADERY  SHADERS (orig.200) 

Shader je kombinací spolupracujících uzlŧ za účelem vytvoření poţadované finální barvy, vzoru  
a textury – zkrátka vzhled Vašeho 3D objektu. Kaţdý shader obsahuje kořenový uzel root node 
s rŧzným počtem atributŧ v závislosti na pouţitém typu kořenového uzlu (Background, Material/Hair, 
Light nebo Atmosphere). Kaţdý z těchto atributŧ mŧţe mít jeden nebo více připojených uzlŧ linked 
nodes, které dynamicky ovládají hodnotu nebo barvu atributŧ. Materiály mŧţete vytvářet buď od píky 
nebo načíst připravené. Uloţením materiálu dojde k uloţení stromové struktury materiálového shaderu 
a načtením materilálu dojde k načtení stromové struktury shaderu. Pokud načtete připravený materiál, 
mŧţete jej také modifikovat a vytvořit tak zcela nový vzhled. Prosím navštivte téma “Kořenové uzly” na 
straně 221 pro detailní popis kořenových uzlŧ root nodes. 

 POZNÁMKA 
KOŘENOVÝ UZEL VLASŦ JE DOSTUPNÝ POUZE TEHDY, KDYŢ JE VYBRÁN OBJEKT VLASŦ 
POSERU 7 A KOŘENOVÝ UZEL OSVĚTLENÍ JE DOSTUPNÝ POUZE TEHDY, KDYŢ JE 
SVĚTELNÝ OBJEKT VYBRÁN. 
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WAKRA  WACROS (orig.201) 

Wakra Wacros jsou skripty, vytvořené k provedení určitého úkonu uvnitř místnosti materiálu Material 
room. Zásuvky Wacro Drawer přicházejí s předdefinovanými wakry, z nichţ kaţdé vykonává určitou 
úlohu nastavení základního materiálu nebo často pouţívaný proces kliknutím na jediné tlačítko. 
Pouţitím waker mŧţete ušetřit čas u některých nejběţnějších úkolŧ, které si přejete v místnosti 
materiálu provést. Všechna wakra pŧsobí na kořenový uzel vybraného objektu nebo materiálu. Pro 
více informací o rŧzných atributech kořenových uzlŧ root nodes navštivte prosím téma “Kořenové 
uzly” na straně 221. 

Poser 7 také podporuje uţivatelem definivaná wakra Wacros, které mŧţete napsat pomocí skriptu 
Python a následně umístit do sloţky Runtime\Python\poserScripts\Wacros\UserDefined uvnitř 
instalační sloţky Poseru 7. Vaše wakra budou pak zobrazena v rozbalovacím menu User Defined. 
Prosím navštivte Část 6: “PoserPython” na straně 267 pro více informací o zápisu Python skriptŧ  
v Poseru 7. 

Následující wakra Wacros jsou obsaţeny v instalaci Poseru 7: 

o Add Reflection: Před kliknutím na tlačítko wakra Add Reflection se ujistěte, ţe máte vybrán 
materiál, kterému chcete přidat atributy zrcadlení. Pokud kliknete na tlačítko Add Reflection, 
Poser 7 připojí následující uzly: 

o Raytracingový uzel Reflect bude připojen na vstup atributu Reflection_Color v kořenovém uzlu 
Material. Uzel Reflect specifikuje barvu zrcadlení při raytracingu. Viz “Uzly raytracingu” na 
straně 230 pro více informací o atributech uzlu Reflect. 

o Uzel BG Color bude připojen na vstup atributu Background uzlu Reflect. 

o Add Refraction: Před kliknutím na tlačítko wakra Add Refraction vyberte materiál, kterému chcete 
přidat atributy lomu světla refraction. Refraction zpŧsobí ohnutí paprsku světla při prŧchodu 
jedním transparentním materiálem na druhý; stupeņ lomu světla závisí na indexu lomu světla 
materiálu. Zapamatujte si, ţe lom světla funguje pouze u prŧhledných materiálŧ, proto musíte 
vybraný materiál učinit prŧhledným, aby se lom světla projevil. Klikněte na tlačítko Add Refraction. 
Pokud máte vybrán materiál, který je neprŧhledný, zobrazí se dialogové okno s dotazem, zda 
chcete materiál učinit prŧhledným a přidat lom světla refraction. Pro potvrzení klikněte na tlačítko 
Yes v tomto dialogu. Poser 7 přidá následující uzly: 

o Raytracingový uzel Refract bude připojen na vstup atributu Refraction_Color v kořenovém 
uzlu Material. Uzel Refract specifikuje barvu lomu světla při raytracingu. Viz “ Uzly raytracingu” 
na straně 230 pro více informací o atributech uzlu Refract. 

o Uzel BG Color bude připojen na vstup atributu Background uzlu Refract. 

Nastavte atribut Refraction_Value v kořenovém uzlu Material mezi nulu a jedničku, podle efektu 
lomu světla, který vidíte v renderovaném obraze. 

 POZNÁMKA 
LOM SVĚTLA REFRACTION VYŢADUJE RAYTRACING, PROTO SE UJISTĚTE, ŢE MÁTE 
RAYTRACING VYBRÁN BĚHEM RENDERU, ABY JSTE MOHLI EFEKT LOMU SVĚTLA VIDĚT. 
DOPORUČUJEME TAKÉ NASTAVIT POČET RAYTRACE BOUNCES NA NEJMÉNĚ DVA (NEBO 
VÍCE, POKUD MÁTE ZA PRŦHLEDNÝM MATERIÁLEM MATERIÁL SE ZRCADLOVÝM EFEKTEM). 

o Add Subsurface Scattering: Kliknutím na tlačítko wakra Add Subsurface Scattering budou 
všechna světla scény konfigurována k vytváření efektu podpovrchového rozptylování SubSurface 
Scattering. Po kliknutí na tlačítko Add Subsurface Scattering dojde k zobrazení dialogového 
okna s následující zprávou “The light(s): <lists the applicable lights> were set to produce 
Depth Map shadows.” Prosím poznačte si, ţe pro podpovrchové rozptylování budou všechna 
aktivní světla nastavena k produkování hlubokých stínŧ depth map shadows. Pokud kliknete na 
OK v tomto dialogu, Poser 7 připojí následující uzly: 

o Uzel Blinn specular bude připojen na vstup atributu Alternate_Specular v kořenovém uzlu 
Material. Viz “Blinn” na straně 230 pro více informací o atributech uzlu Blinn. 

o Uzel FastScatter bude připojen na vstup atributu Alternate_Diffuse v kořenovém uzlu 
Material. Viz “FastScatter” na straně 234 pro více informací o atributech uzlu FastScatter. 
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o Uzel Edge_Blend bude připojen na vstup uzlu FastScatter. Viz “Prolínání okrajů” na straně 
226 pro více informací o atributech uzlu prolínání okrajŧ Edge_Blend. 

o Nakonec, výstup uzlu Image_Map (který existuje před kliknutím na tlačítko Add Subsurface 
Scattering), bude propojen se vstupem atributu Inner_Color uzlu Edge_Blend. 

o Set Up Shadow Catcher: Kliknutím na tlačítko Set Up Shadow Catcher dojde ke zpřístupnění 
předvolby ShadowCatchOnly uzlu Poser Surface vybraného materiálu. Toto wakro přepne 
vybraný materiál do módu zachytávání stínŧ, coţ znamená, ţe objekt bude prŧhledný s vyjímkou 
míst, zastíněných jiným objektem, takţe bude zobrazen pouze stín. Příkladem pouţití tohoto wakra 
je vytvoření scény s figurou na rekvizitě schodŧ, kdy si přejete schody skrýt (pouţít pouze patřičně 
deformovaný stín figury) a figuru umístit před fotografii aktuálních schodŧ. Pro více informací  
o atributu ShadowCatchOnly a zachytávání stínŧ, navštivte téma “Kořenový uzel materiálu/ vlasů” 
na straně 221. 

o Set Up Toon Render: Wakro Set Up Toon Render konfiguruje Váš materiál tak, aby při renderu 
vypadal jako karikatura cartoon. Kliknutím na tlačítko dojde k otevření dialogového okna 
s dotazem, zda si přejete pouţít odlesky na površích karikatury. Pro pokračování klikněte na volbu 
No nebo Yes. Poser 7 připojí následující uzly: 

o Uzel Toon diffuse bude připojen na vstup atributu Alternate_Diffuse v kořenovém uzlu 
Material. Viz “Karikatura” na straně 229 pro více informací o atributech uzlu Toon. 

o Dvě doplņková spojení budou vytvořena mezi výstupem materiálového uzlu Image_Map  
a vstupy atributŧ LightColor a DarkColor uzlu Toon. 

o Pokud v iniciačním dialogu kliknete na Yes, uzel Glossy specular bude připojen na vstup 
atributu Alternate_Specular v kořenovém uzlu Material. Viz “Lesk” na straně 230 pro více 
informací o atributech uzlu Glossy. 

o Create Atmosphere: Za účelem shlédnutí efektu wakra Create Atmosphere, musíte mít něco na 
pozadí scény, například obrazovou plochu pozadí, doplņující figury nebo rekvizity. Potom vyberte 
příkaz Atmosphere z menu Object v horní části okna shaderu Shader. Kliknutím na tlačítko 
Create Atmosphere dojde k otevření dialogového okna Choose an Atmosphere. Vyberte typ 
atmosféry, kterou si přejete vytvořit z následující nabídky: Fog (mlha), Smoke (kouř), 
SmokeyRoom (zakouřená místnost), Depth_Cue (temná nálada). Poté klikněte na OK. Poser 7 
přidá příslušné uzly pro vytvoření vybrané atmosféry. Pokud chcete vědět více o některých 
přidaných uzlech, navštivte téma “Uzly místnosti materiálu” na straně 221. Vyrenderujte scénu pro 
shlédnutí efektŧ atmosféry. 

o Set Up Light Style: Wakro Set Up Light Style umoţņuje specifikovat styl osvětlení, které si přejete 
aplikovat jako zvláštní osvětlení particular light. Nejprve vyberte světlo, které si přejete 
konfigurovat z menu Object v horní části okna shaderu Shader. Následně klikněte na tlačítko Set 
Up Light Style. Dojde k zobrazení dialogového okna Select a light style s dotazem na výběr stylu 
osvětlení z následující nabídky: diffuse only (jen rozptýlené), specular only (jen odraţené), white 
only (jen bílé). Po dokončení výběru klikněte na OK. Dojde k zobrazení zprávy, která potvrdí, ţe 
zvolené světlo bylo nastaveno do specifikovaného stylu. V závislosti na zvoleném stylu osvětlení 
uvidíte následující efekty: 

o Pokud zvolíte diffuse only, atribut Diffuse v kořenovém uzlu Light bude nastaven do bílého 
odstínu a atribut Specular bude nastaven do černého odstínu. 

o Pokud zvolíte specular only, atribut Specular v kořenovém uzlu Light bude nastaven do 
bílého odstínu a atribut Diffuse bude nastaven do černého odstínu. 

o Pokud zvolíte white only, atributy Color, Diffuse a Specular v kořenovém uzlu Light budou 
nastaveny do bílého odstínu. 

o Set Up Ambient Occlusion: Kliknutím na tlačítko Set Up Ambient Occlusion bude vytvořen 
raytracingový uzel Ambient_Occlusion, jehoţ vstup bude napojen na vstupy atributŧ 
Diffuse_Value a Specular_Value v kořenovém uzlu Material. Viz téma “Pohlcování světla okolím” 
na straně 231 pro více informací o atributech uzlu Ambient_Occlusion. 

o IBL (Image Based Lighting): Wakro IBL pŧsobí pouze na světla, která máte před pouţitím tohoto 
wakra vybrány z menu Object v horní části okna shaderu Shader. Kliknutím na tlačítko IBL 
otevřete manaţer textury Texture Manager, který bude po Vás vyţadovat výběr textury pro uzel 
Image_Map. 
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Poser 7 umoţņuje propojení stromové struktury shaderu na libovolné úrovni sloţitosti s Vašim 
světlem na bázi obrazu Image Based Light; nicméně wakro IBL je nastaveno pro pouţití jednoho 
světla s jednou obrazovou mapou. Jakmile máte nastavenu obrazovou mapu pro světlo 
v manaţeru textury Texture Manager, klikněte na OK. Poser 7 připojí uzel Image_Map při pouţirí 
obrazové mapy na vstup atributu Color v kořenovém uzlu Light. Pro více informací o atributech 
uzlu Image_Map, navštivte téma “Obrazová mapa ” na straně 238. Pro informace o světlech na 
bázi obrazu Image Based Lighting navštivte téma “ Rozptýlená světla založená na obrazu” na 
straně 62. 

 POZNÁMKA 
PRO MAXIMALIZACI EFEKTU SVĚTLA ZALOŢENÉHO NA OBRAZU DOPORUČUJEME POUŢITÍ 
AMBIENT OCCLUSION (POHLCOVÁNÍ SVĚTLA UZAVŘENÝM POVRCHEM PRVKŦ). VIZ TÉMA 
“VLASTNOSTI SVĚTLA” NA STRANĚ 65 PRO INFORMACE O AKTIVACI AMBIENT OCCLUSION 
VYBRANÉHO SVĚTLA. 

o Remove Detached Nodes: Kliknutím na tlačítko Remove Detached Nodes budou odstraněny 
všechny uzly aktuálně vybrané materiálové skupiny, jejichţ výstupy nejsou propojeny alespoņ 
s jedním dalším uzlem. Toto wakro je obzvlášť uţitečné pro vyčištění sloţité stromové struktury 
shaderu, kde velké mnoţství uzlŧ komplikuje zobrazení nepřipojených uzlŧ, přítomných v okně 
shaderu Shader. 

 POZNÁMKA 
I KDYŢ JEDEN NEBO VÍCE UZLŦ JE PŘIPOJENO KE VSTUPŦM DANÉHO UZLU, POKUD NENÍ 
VÝSTUP TOHOTO UZLU PŘIPOJEN K DALŠÍMU UZLU, BUDE TAKÉ ODSTRANĚN POMOCÍ 
WAKRA REMOVE DETACHED NODES. 
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Kapitola 17: Místnost tváře  THE FACE ROOM (orig. 205) 

Přidání přesvědčivé uţivatelské tváře ke 3D objektu a vytvoření osobité hlavy mŧţe být extrémně 
sloţitý úkol, ale výkonná místnost tváře Face room Poseru 7 učiní tento proces v okamţiku. Během 
několika minut mŧţete vytvořit vzhled figury podobný Vám, některému z Vašich přátel nebo kohokoliv! 
To mŧţete provést načtením dvou obrázkŧ poţadované osoby, aplikováním uţivatelských textur, 
vymodelováním hlavy, nebo libovolnou kombinací těchto metod. 

 POZNÁMKA 
V ZÁKLADNÍM NASTAVENÍ SE PŘI VSTUPU DO MÍSTNOSTI TVÁŘE OTEVŘE HTML OKNO 
NÁPOVĚDY. TOTO OKNO OBSAHUJE DODATEČNÉ TIPY A TRIKY PRO DOSAŢENÍ 
OPTIMÁLNÍCH VÝSLEDKŦ. POKUD SI NEPŘEJETE TOTO OKNO ZOBRAZOVAT, ZVOLTE 
PROSÍM WINDOW>ROOM HELP. 

Místnost tváře Face room vytváří hlavy pro pouţití s následujícími figurami: Don, Judy, Will, Penny, 
James a Jessi. Vypadá následovně: 

 

Místnost tváře obsahuje následující prvky rozhraní včetně některých základních prvkŧ: 

o Photo Lineup (1): V prostoru Photo Lineup se načítají obrázky, které se přizpŧsobují za pouţití 
řady nástrojŧ. Aktivováním políčka Apply Shape dojde ke generování geometrie, odpovídající 
načteným fotografiím. Mapa textury a geometrie zaloţená na fotografiích je generována okamţitě. 

o Texture Variation (2): Záloţka Texture Variation umoţņuje aplikaci velkého mnoţství etnických  
a dalších nastavení za účelem modifikace aktuální mapy textury hlavy. 

o Face Sculpting window (3): Okno Face Sculpting zobrazuje náhled Vaší 3D hlavy včetně textur. 
Toto okno má v pravém horním rohu k dispozici ovladače Mini Camera. Mŧţete také pouţít nástroj 
na formování tváře Face Shaping Tool (viz téma “Nástroj na formování tváře” na straně 153) pro 
vymodelování tváře podle konkrétních poţadavkŧ. 

o Random Face button (4): Kliknutím na tlačítko Random Face bude vytvořena úplně náhodná tvář. 
Tato funkce vymaţe veškerou přechozí práci, kterou jste v místnosti tváře Face room vytvořili, 
proto funkci pouţívejte opatrně. Funkce Random Face je vhodným zpŧsobem vytvoření realisticky 
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vypadajícího charakteru za pomoci jednoho tlačítka. Klikněte na tlačítko tolikrát, aţ dosáhnete 
vzhled podle Vašeho přání! 

o Reset Face Room button (5): Kliknutím na tlačítko Reset Face dojde k obnovení základního tvaru 
hlavy a textury. Zároveņ dojde k vymazání veškeré přechozí práce, kterou jste v místnosti tváře 
Face room vytvořili, proto funkci pouţívejte opatrně. 

o Texture Preview window (6): Okno Texture Preview umoţņuje prohlíţení mapy textury hlavy 
během její editace a také umoţņuje načtení a uloţení textur pro pozdější pouţití. 

o Action buttons (7): Tlačítka Action slouţí pro aplikaci uţivatelské geometrie hlavy pro Vaše figury,  
vytvoření morph targetŧ nebo pro import map textur hlavy. 

o Face Shaping Tool palette (8): V paletě Face Shaping Tool mŧţete ovládat nástroj na formování 
tváře, který je ekvivalentem nástroje Morphing Tool (viz téma “Nástroj morphingu” na straně 74) 
pro místnost tváře Face room. You can modify heads by using the parameter dials and/or the tool 
in this room. 

Kaţdý z těchto prvkŧ bude podrobně popsán dále v této kapitole. Jak bylo zmíněno výše, je několik 
metod pro vytvoření uţivatelské hlavy: 

o Pouţitím dvou obrázkŧ pro vytvarování geometrie a vytvoření mapy textury. 

o Pouţitím nástroje na formování tváře Face Shaping pro vytvarování hlavy podle poţadavku. 

o Pouţitím záloţky Texture Variation pro rychlé a jednoduché vytvoření uţivatelské mapy textury. 

o Pouţitím funkce pro vytvoření náhodné tváře Random Face. 

Místnost tváře Face room umoţņuje při tvorbě hlavy pouţití jedné nebo všech těchto metod. Další 
funkčnost popíšeme v následujících částech. Nyní si projdeme pouţití obrázkŧ pro vytvoření 
uţivatelské hlavy. 

 POZNÁMKA 
POKUD SI BUDETE PŘÁT RESETOVAT MÍSTNOST TVÁŘE FACE ROOM DO JEJÍHO 
ZÁKLADNÍHO NASTAVENÍ, KLIKNĚTE NA TLAČÍTKO RESET FACE ROOM. TOTO VYMAŢE 
VŠECHNY NAČTENÉ OBRÁZKY, VYMAŢE ZMĚNY GEOMETRIE A MODIFIKACE TEXTURY, 
KTERÉ JSTE MĚLI DŘÍVE VYTVOŘENY. POUŢÍVEJTE TUTO FUNKCI OPATRNĚ! 
 

POUŢITÍ OBRÁZKŮ PRO VYTVOŘENÍ HLAVY   
USING IMAGES TO CREATE HEADS (orig.207) 

Vytvoření uţivatelské 3D hlavy z existujících obrázkŧ/fotografií (digitálních nebo skenovaných) 
vyţaduje následující kroky: 

1. Načtení obrázkŧ. 

2. Zarovnání obrázkŧ (pokud je třeba). 

3. Zarovnání geometrie podle obrázkŧ. 

4. Aplikace nového modelu Vaší fuguře. 

Obrázky, které jste pouţili pro tvorbu hlavy pouţijte také jako mapu textury, potom aplikujte 
geometrický model a texturu na hlavu. 

Jakmile máte tyto kroky dokončeny, mŧţete přejít k pouţití nástroje na formování tváře Face 
Shaping, nebo záloţky Texture Variation. Pokud si nepřejete pouţít vlastní obrázky, bez obav 
přeskočte dále a projděte si další metody uţivatelského přizpŧsobení hlavy. 
 

KROK 1: OBRÁZKY  STEP 1: IMAGES (orig.207) 

Vytvoření přizpŧsobené hlavy, která odpovídá reálné osobě, vyţaduje pouţití dvou obrázkŧ pro 
vytvoření mapy textury. Pojďme načíst nějaké obrázky a vytvořit uţivatelsky přizpŧsobenou hlavu! 

Následujte prosím tyto jednoduché pokyny pro dosaţení optimálních výsledkŧ: 

o Front image: Čelní obrázek front image by měl být přímým pohledem subjektu tváří na kameru, 
která by měla být ve výšce tváře subjektu. Obrázek by měl být vyfocen zblízka pro zachycení 
mnoţství detailŧ. Také osvětlení by mělo být nastaveno pro zachycení mnoţství detailŧ. Příliš 
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jasné osvětlení dá obrázku bledý vzhled, zatímco velmi tmavé osvětlení neukáţe některé detaily. 
Ústa osoby by měly být uzavřená a celkový výraz by pro nejlepší výsledek měl být neutrální. 

o Side image: Boční obrázek side image by měl být přímý boční pohled na subjekt s tváří otočenou 
o 90 stupņŧ vŧči kameře, která by měla být ve výšce tváře subjektu. Ostatní pokyny pro čelní 
obrázek platí obdobně i pro obrázek boční. V ideálním případě by čelní a boční obrázek měl být 
proveden ze stejné vzdálenosti. 

 

Obrázky výše jsou nejlepším příkladem ideálních obrázkŧ. Mŧţete také pouţít méně ideální obrázky, 
nebo dokonce neodpovídající obrázky, nicméně mŧţete tím získat nepředvídatelné výsledky. Kaţdý 
obrázek má vlastní zarovnávací nástroje, které pomohou s nastavením optimální pozice (viz 
následující krok). Samozřejmě, pokud chcete, mŧţete experimentovat a pobavit se! 

Místnost tváře Face room podporuje nejrozšířenější formáty obrázkŧ. 

 POZNÁMKA 
MUSÍTE IMPORTOVAT EXISTUJÍCÍ OBRÁZKY. POSER 7 NEMÁ ŢÁDNOU FUNKCI PRO 
VYTVOŘENÍ FOTOGRAFIÍ. OBRÁZKY MOHOU BÝT FOTOGRAFIEMI, PEROKRESBOU, MALBOU, 
APOD. MÍSTNOST TVÁŘE FACE ROOM AKCEPTUJE NEJROZŠÍŘENĚJŠÍ OBRAZOVÉ 
FORMÁTY. TEXTURY, GENEROVANÉ Z TĚCHTO OBRÁZKŦ MAJÍ ZÁKLADNÍ VELIKOST 512X512 
PIXELŦ. 
 

KROK 2: SEŘAZENÍ  STEP 2: THE LINEUP (orig.208) 

Začněte kliknutím na ikonu Load (viz dále) pro čelní nebo boční obrázek v prostoru Photo Lineup  
a vyhledejte obrázek, který si přejete pouţít. Pro kaţdý obrázek se Poser 7 zeptá na lokalizaci 
několika bodŧ na tváři. To pomŧţe se seřazením a přizpŧsobením základní 3D hlavy obrázkŧm, které 
pak mŧţete jen jemně doladit. Pro lokalizaci specifických bodŧ tváře u Vaší fotografie klikněte na 
pozici, která je zobrazena na vzorové tváři. 

Pro čelní obrázek budete dotázáni na 
lokalizaci vnějšího koutku pravého oka figury 
a levého koutku rtŧ, jak je zobrazeno dále: 

U bočního obrázku musíte lokalizovat špičku 
pravého ušního lalŧčku a špičku brady 
stejným zpŧsobem, jako u obrázku čelního. 

 POZNÁMKA 
BOČNÍ OBRÁZEK VYUŢÍVÁ OBRÁZEK 
PRAVÉ STRANY SUBJEKTU. POKUD 
MÁTE JEN OBRÁZEK LEVÉ STRANY 
SUBJEKTU, MŦŢETE KLIKNOUT NA 
IKONU FLIP PRO PŘEVRÁCENÍ 
OBRÁZKU.  

Jakmile máte načteno, obrázky budou 
zobrazeny v pracovním prostoru a také bude zobrazena 3D hlava a mapa textury. 
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Načtení obrázkŧ a lokalizace poţadovaných bodŧ umoţní Poseru 7 odvedení čisté práce s přibliţným 
rozloţením a tvarováním geometrie 
hlavy. Mŧţete se nicméně zapojit  
a učinit některá manuální nastavení 
pozice geometrie vzhledem  
k obrázku.  

Aby jste mohli toto provést, prostor 
Photo Lineup má pro oba dva 
obrázky následující nástroje: 

o Load: Kliknutím na ikonu Load 
dojde k otevření standardního 
OS dialogu, který umoţņuje 
procházení sloţek a výběr 
poţadovaného čelního obrázku. 
Jakmile máte obrázek načten, 
budete vybídnuti k tomu, aby jste 
lokalizovali rŧzné obličejové 
rysy. To pomŧţe Poseru 7 
přizpŧsobit 3D hlavu obrázkŧm, 
jak je popsáno výše. 

o Delete: Kliknutím na ikonu Delete vymaţete aktuálně načtený obrázek. 

o Zoom: Kliknutím na ikonu Zoom a taţením mŧţete přibliţovat a oddalovat aktuální obrázek, coţ 
umoţņuje preciznější srovnávání a tvarování geometrie hlavy. Klinutím na ikonu Zoom a taţením 
doprava nebo nahoru dojde k přiblíţení, zatímco taţením dolava nebo dolŧ dojde k oddálení. Tento 
nástroj jednoduše posouvá zorný úhel; nemá ţádný efekt na obrázky nebo geometrii. Nemŧţete se 
oddálit více, neţ je originální velikost obrázku.  

o Pan: Klinutím a taţením nástroje Pan mŧţete posouvat obrázek ve stejném směru s pohybem 
myši. Toto je zvlášť uţitečné, pokud se chcete přiblíţit na rŧzná místa obrázku. Čelní a boční 
obrázky mŧţete individuálně posouvat nahoru, dolŧ, doleva nebo doprava. Čelní obrázek bude 
posouván podle os X a Y (z boku na bok a nahoru-dolŧ) a boční obrázek bude posouván podle os 
Y a Z (nahoru-dolŧ a dopředu-dozadu). Tento nástroj jednoduše posouvá zorný úhel; nemá ţádný 
efekt na obrázky nebo geometrii. 

o Rotate Geometry: Nevhodné natočení fotografie mŧţe zpŧsobit nevyhovující výsledky seřazení. 
V ideálním případě by hlava neměla být vŧči kameře natočena. Nicméně mnoho fotografií 
zobrazuje hlavu mírně natočenou okolo osy X (nahoru a dolŧ), osy Y (vlevo nebo vpravo), nebo 
osy Z (nakloněná doleva nebo doprava). Místnost tváře Face room automaticky detekuje  
a kompenzuje některá natočení (okolo osy Z u čelního pohledu a okolo osy X u bočního pohledu), 
ale přesto mŧţe být nutné, pro dosaţení nejlepších výsledkŧ, provedení dodatečného manuálního 
nastavení: 

o Pro otočení okolo osy X (u čelního pohledu), klikněte a táhněte myší horizontálně, při 
současném stisknutí klávesy [SHIFT]. 

o Pro otočení okolo osy Y (u čelního pohledu), klikněte a táhněte myší horizontálně, při 
současném stisknutí klávesy [OPT]/[ALT]. 

o Pro otočení okolo osy Z (u čelního pohledu), klikněte a táhněte myší horizontálně, bez ţádného 
stisknutí klávesy. 

o Pro otočení okolo osy X (u bočního pohledu), klikněte a táhněte myší horizontálně, bez 
ţádného stisknutí klávesy. 

o Scale Geometry: Kliknutím a taţením nástroje Scale Geometry je moţné změnit velikost 
geometrie za účelem přizpŧsobení se obrázku. Tato funkce je uţitečná, pokud načtete obrázek(y), 
který je větší nebo menší, neţ obrys geometrie. Nástrojem mŧţete posouvat nahoru, dolŧ, doleva, 
nebo doprava. Tento nástroj mění velikost geometrie bez vlivu na obrázek nebo zorný úhel. 

o Pan Geometry: Kliknutím a taţením nástroje Pan Geometry je moţné posouvání geometrie. Tato 
funkce je uţitečná, pokud načtený obrázek(y) není zcela přizpŧsobem geometrii. U čelního obrázku 
bude geometrie posouvána podle os X a Y (z boku na bok a nahoru-dolŧ) a u bočního obrázku 
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podle os Y a Z (nahoru-dolŧ a dopředu-dozadu). Tento nástroj posouvá geometrií bez vlivu na 
obrázek nebo zorný úhel. 

Poser 7 udělá kus práce při odhadu, jak vytvořit hlavu podle obrázkŧ, nicméně pro dosaţení 
nejlepších výsledkŧ budete pravděpodobně muset hlavu jemně doladit. Hlava bude zobrazena 
s povrchem potaţeným obrázky, s červenými linkami zobrazujícími obličejové rysy a se zelenými 
ovládacími body. V tomto případě je hlava zobrazena trochu mimo střed, takţe mŧţe být vidět podklad 
i mapa textury. Jak toto napravit? Jednoduše: Vykonejte malou virtuální operaci. 
 

KROK 3: ÚPRAVA KYBERNETICKÉ TVÁŘE  STEP 3: CYBER FACE LIFTS (orig.210) 

Podívejte se na načtené obrázky, mŧţete vidět červené obrysové linky hlavy, vytvořené z obrázkŧ. 
Kaţdý hlavní prvek tváře (oči, nos, ústa, brada, apod.) má jeden nebo více ovládacích bodŧ, 
znázorněných jako zelené tečky. Všechno co musíte udělat, je přesunutí ovládacích bodŧ tak, aby 
jejich pozice odpovídala podkladním obrázkŧm. Umístěte ukazatel myši nad ovládací bod, který si 
přejete posunout. Kurzor se změní v závislosti na tom, jakým směrem mŧţete vybraný bod táhnout, 
nahoru, dolŧ doleva nebo doprava. Například střední bod nosu mŧţete posunout jen tak, neţ se 
dostane pod mŧstek nosu a dva boční body jen tak, neţ dosáhnou rohŧ nosních dírek, a tak podobně. 
Pokud ovládacími body pohybujete, mŧţete vidět, ţe hlava se více a více přizpŧsobuje figuře. Také 
mŧţete vidět linky, které indikují, jak moc se kaţdý ovládací bod posunul od své originální pozice. 
Pokud si přejete vzít zpět předchozí posun ovládacího bodu, jednoduše pouţijte příkaz 
[COMMAND]/[CTRL]+[Z] pro návrat ovládacího bodu do jeho předchozí pozice. 

Přesunout mŧţete také celou hlavu pomocí nástrojŧ Rotate Geometry, Scale Geometry a Pan 
Geometry, které byly popsány výše. Tyto nástroje posouvají obrysy hlavy a také pro přizpŧsobení 
mění geometrii hlavy. Pro posunutí obrázku bez vlivu na geometrii hlavy pouţijte nástroj Pan Image, 
který byl také popsán výše. Ten posune obrázkem nad geometrií. 

Pokud při posunu ovládacího bodu uděláte chybu, mŧţete stisknout klávesy [COMMAND]/[CTRL]+[Z] 
nebo zvolit příkaz Edit>Undo pro navrácení poslední změny zpět. 

 POZNÁMKA 
NAVŠTIVTE PROSÍM HTML OKNO NÁPOVĚDY MÍSTNOSTI TVÁŘE PRO DODATEČNÉ TIPY & 
TRIKY. PŘI ZÁKLADNÍM NASTAVENÍ 
SE OKNO NÁPOVĚDY ZOBRAZÍ PŘI 
VSTUPU DO MÍSTNOSTI TVÁŘE 
FACE ROOM. POKUD SE 
NEZOBRAZÍ, ZVOLTE PŘÍKAZ 
WINDOW>ROOM HELP PRO 
OTEVŘENÍ TOHOTO OKNA. 

Tady je výše uvedený příklad po tom, 
co byl přizpŧsobený: 

Pokud se podíváte na příklad, mŧţete 
vidět, ţe hlava odpovídá obrázkŧm 
mnohem více, neţ před úpravami. 3D 
hlava vypadá mnohem realističtěji  
a mapa textury je řádně srovnaná. 

 POZNÁMKA 
PRO POSUN A PŘIBLÍŢENÍ 
OBRÁZKŦ MŦŢETE POUŢÍT 
NÁSTROJ ZOOM, ČÍMŢ DOCÍLÍTE 
PRECIZNĚJŠÍ KONTROLU VÝSLEDKU.  
 

KROK 4: POUŢITÍ GEOMETRIE/TEXTURY   
STEP 4: APPLYING THE GEOMETRY/TEXTURE (orig.211) 

Mapa textury je tvořena automaticky během práce. Aktivujte zaškrtávací políčko Apply Shape pro 
pouţití Vašich obrázkŧ pro vytvoření uţivatelské hlavy, která se zobrazí v okně Face Sculpting. 
Geometrie hlavy se bude dynamicky obměņovat tak dlouho, dokud bude funkce Apply Shape aktivní. 
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 POZNÁMKA 
AKTIVOVÁNÍM POLÍČKA APPLY SHAPE DOJDE K VYMAZÁNÍ VEŠKERÉ PRÁCE, KTEROU JSTE 
PROVEDLI POMOCÍ NÁSTROJE TVAROVÁNÍ FACE SHAPING. POKUD SI PŘEJETE POUŢÍT 
KOMBINACI OBRÁZKŦ A TVAROVÁNÍ, UJISTĚTE SE, ŢE PRACUJETE S OBRÁZKY PŘED 
POUŢITÍM NÁSTROJE FACE SHAPING. TOTO NASTÁVÁ TAKÉ U TEXTUR; NAČTENÍM 
OBRÁZKŦ VYMAŢETE VEŠKEROU PRÁCI, KTEROU JSTE UČINILI V ZÁLOŢCE OBMĚNY 
TEXTURY TEXTURE VARIATION (VIZ DÁLE). 
 

TVORBA UŢIVATELSKÝCH TEXTUR  CREATING CUSTOM TEXTURES (orig.211) 

Místnost tváře Face room obsahuje záloţku obměny textury Texture Variation, která umoţņuje 
vytvoření uţivatelských textur hlavy od základu, nebo modifikaci textur existujících. Pro přístup do 
záloţky Texture Variation klikněte na záloţku Texture Variation v oblasti 2 místnosti tváře Face 
room. Tato záloţka umoţņuje: 

o Vytvoření nové textury od základu pomocí modifikace základní textury. 

o Modifikaci textury vytvořené načtením obrázkŧ, jak je popsáno výše. 

o Editaci načtené mapy textury (viz dále). 

 POZNÁMKA 
UJISTĚTE SE, ŢE NAČÍTÁTE/VYTVÁŘÍTE TEXTURY PŘED POUŢITÍM ZÁLOŢKY TEXTURE 
VARIATION, ABY NEDOŠLO K POZDĚJŠÍ ZTRÁTĚ VYTVOŘENÝCH ZMĚN. 

Záloţka Texture Variation pouţívá otočné ovladače parametrŧ, které fungují obdobně jako otočné 
ovladače v paletě parametrŧ Parameters, jejichţ funkce byla popsána v části “Paleta parametrů” na 
straně 77. Mŧţete pouţít menu Parameter Dial pro přístup k nastavení ovladače, reset ovladače, 
nebo otevření grafu Graph vybraného ovladače (popsáno v části “Použití grafů” na straně 96). 
Nicméně nastavení otočných ovladačŧ palety Texture Variation nemŧţete uloţit do paměti. Dostupné 
ovladače palety Texture Variation jsou: 

o Facial Color: Otočný ovladač barvy tváře Facial Color modifikuje barvu několika částí tváře včetně  
vousŧ Beard dark/light, očních víček Eye sockets light/dark, spodních řas Eyebrows lower 
light/dark a horních řas Eyebrows upper light/dark. 

o Ethnicity/Age & Gender: Otočný ovladač Ethnicity/Age/Gender generuje etnické, věkové a rodové 
vlastnosti jako je afričan less/more African, evropan less/more European, východní asiat 
less/more Southeast Asian, východní indián less/more East Indian, mladší/starší 
Younger/Older a muţ/ţena Male/Female. 

Pro modifikaci Vaší textury nebo základní textury jednoduše nastavte otočné ovladače. Vaše práce 
bude v reálném čase zobrazena v oknech Face Sculpting a Texture Preview. 

 POZNÁMKA 
TEXTURY VYTVOŘENÉ V MÍSTNOSTI TVÁŘE FACE ROOM JSOU VELIKOSTI 512X512 PIXELŦ. 
POKUD POUŢIJETE VĚTŠÍ ROZLIŠENÍ PODKLADNÍCH FOTOGRAFIÍ A BUDETE SI PŘÁT TOTO 
ROZLIŠENÍ POUŢÍT, ZVOLTE YES V DIALOGU, KTERÝ SE ZOBRAZÍ PO STISKU APPLY TO 
FIGURE. PRO POUŢITÍ VĚTŠÍCH MAP TEXTUR MŦŢETE IMPORTOVAT UŢIVATELSKÉ 
TEXTURY, KTERÉ NÁSLEDNĚ MODIFIKUJETE. 
 

NÁSTROJ NA FORMOVÁNÍ TVÁŘE  THE FACE SHAPING TOOL (orig.212) 

Nástroj na formování tváře Face Shaping Tool umoţņuje vizuálně tvarovat uţivatelskou hlavu 
pomocí výběru a posouvání vertexŧ. Místnost tváře Face room obsahuje širokou paletu editačních 
parametrŧ pro hlavu Poseru 7, které umoţņují vytvoření jakékoliv představitelné virtuální tváře. 
V základní nastavení je nástroj Face Shaping Tool aktivní kdykoliv se kurzor nachází uvnitř okna 
Face Sculpting. Stejně jako u nástroje Morphing (viz téma “Nástroj morphingu” na straně 74), 
mŧţete pouţít jakoukoliv kombinaci kliknutí a taţení morph targetŧ, anebo nastavení otočných 
ovladačŧ parametrŧ Face Shaping v paletě Face Shaping Tool. 
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Pro pouţití nástroje Face Shaping Tool: 

Klikněte na místo tváře, které si přejete upravit a táhněte myší. Dojde k vybrání vertexŧ nejblíţe 
k bodu kliknutí a k jejich posunu ve směru taţení myší. Mŧţete pouţít ovladače Mini Camera 
v pravém horním rohu okna Face Sculpting pro umístění hlavy do odpovídající pozice, ve které ji 
chcete mít před, během a po tvarování. Vertexy budou posunuty relativně k Vašemu zornému úhlu. 
Pokud se například budete dívat přímo do tváře, kliknutím a taţením bude deformace probíhat 
nahoru, dolŧ, doleva a doprava. Pokud se na hlavu díváte shora, taţením přesunete vertexy doleva, 
doprava, dopředu a dozadu. 

Nástroj Face Shaping Tool mŧţe měnit všechny vybrané parametry palety Face Shaping Tool. 
Označením zaškrtávacího políčka před otočným ovladačem se tento aktivuje pro pouţití s nástrojem  
a odznačením políčka nebude mít nástroj na specifikovaný parametr vliv. I kdyţ je parametr aktivován, 
mŧţe nebo nemusí být pouţitím nástroje ovlivněn. Například výběr vertexu na čele mŧţe ovlivnit 
obočí, ale nemusí mít vliv na ústa. Vyberte poţadovaný parametr(y), klikněte a táhněte jakýmkoliv 
vertexem na hlavě. 

Jakmile máte část hlavy tam, kde si ji přejete mít, mŧţete kliknout na tlačítko Pin pro zmrazení 
vybraných vertexŧ proti další manipulaci. Zmrazené vertexy se mohou posouvat v případě, pokud 
budete nastavovat další část postavy, nicméně zŧstávají ve svém aktuálním nastavení. 

Mŧţete pouţít klávey [COMMAND]/[CTRL]+[Z] pro navrácení změn specifických parametrŧ, které byly 
vytvořeny nástrojem Face Shaping Tool zpět. Pokud si přejete resetovat všechny morph targety na 
jejich základní hodnoty (0), mŧţete kliknout na tlačítko Clear Morphs. Pokud si přejete odstranit 
všechna zmrazení pins, jednoduše klikněte na tlačítko Clear Pin Points. Obě tlačítka se nacházejí  
v paletě Face Shaping Tool spolu s ostatními funkcemi (viz dále). 
 

PALETA NÁSTROJE NA FORMOVÁNÍ TVÁŘE   
THE FACE SHAPING TOOL PALETTE (orig.214) 

Nástroj na formování tváře Face Shaping Tool nastavuje parametry dostupné v paletě nástroje na 
formování tváře Face Shaping Tool, které pouţívají otočné ovladače parametrŧ fungující obdobně 
jako ovladače v paletě parametrŧ Parameters. Mŧţete pouţít menu Parameter Dial pro přístup 
k nastavení ovladače, reset ovladače, nebo otevření grafu Graph vybraného ovladače (popsáno  
v části “Použití grafů” na straně 96). Nicméně nastavení otočných ovladačŧ palety Face Shaping 
Tool nemŧţete uloţit do paměti. 

 POZNÁMKA 
TOTO JE ODLIŠNÉ OD TVORBY VÝRAZŦ TVÁŘE, PROTOŢE PRO VYTVOŘENÍ VÝRAZU TVÁŘE 
JEDNODUŠE APLIKUJETE MORPH TARGET NA AKTUÁLNÍ GEOMETRII HLAVY. 

Pokud formujete hlavu, mŧţete pouţít nástroj Face Shaping Tool, otočné ovladače v paletě Face 
Shaping Tool, nebo jakoukoliv kombinaci dle přání. Dostupné otočné ovladače parametrŧ palety 
Face Shaping Tool jsou: 
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o Facial Morphs: Skupina otočných ovladačŧ Facial Morphs obsahuje následující podskupiny  
a ovladače: 

o Brow Ridge: Ovladače obočí Brow Ridge jsou High/Low, Inner Up/Down, Outer Up/Down  
a Forward Axis Twist. 

o Cheekbones: Ovladače lícní kosti Cheekbones jsou High/Low, Shallow/Pronounced, 
Thin/Wide a Protrusion Asymmetry. 

o Cheeks: Ovladače líce Cheeks jsou Concave/Convex a Round/Gaunt. 

o Chin: Ovladače brady Chin jsou Forward/Back, Pronounced/Recessed, Retracted/Jutting, 
Shallow/Deep, Small/Large, Short/Tall, Thin/Wide, Chin Axis Twist, Forward Axis Shift  
a Transverse Shift. 

o Eyes: Ovladače očí Eyes jsou Up/Down, Small/Large, Tilt Inward/Outward, Together/Apart, 
Height Disparity a Transverse Shift. 

o Face: Ovladače tváře Face jsou Brow/Nose/Chin Ratio, Forehead/Sellion/Nose Ratio, 
Light/Heavy, Round/Gaunt, Thin/Wide, Coronal Bend, Coronal Shear a Vertical Axis 
Twist. 

o Forehead: Ovladače čela Forehead jsou Small/Large, Short/Tall, Tilt Forward/Back  
a Forward Axis Twist. 

o Jaw: Ovladače čelisti Jaw jsou Retracted/Jutting, Wide/Thin, Jaw-Neck Slope High/Low  
a Concave/Convex. 

o Mouth: Ovladače úst Mouth jsou Drawn/Pursed, Happy/Sad, High/Low, 
Protruding/Retracted, Tilt Up/Down, Underbite/Overbite, Mouth-Chin Distance 
Short/Long, Corners Transverse Shift a Twist and Shift. 

o Lips: Ovladače rtŧ Lips jsou Deflated/Inflated, Large/Small a Puckered/Retracted. 

o Nose: Ovladače nosu Nose jsou Coronal Shear, Transverse Shift, Up/Down, Flat/Pointed, 
Short/Long, Tilt Up/Down, Tip Transverse Shift, Transverse Shift a Vertical Axis Twist. 

o Nose Bridge: Ovladače nosního mŧstku Nose Bridge jsou Shallow/Deep, Short/Long  
a Transverse Shift. 

o Nose Sellion: Ovladače Nose Sellion jsou Up/Down, Shallow/Deep, Thin/Wide a Transverse 
Shift. 

o Nose Region: Ovladače Nose Region jsou Concave/Convex a Frontal Axes Twist. 

o Temples: Ovladač spánkŧ Temples je Thin/Wide. 

o Ears: Ovladače uší Ears jsou Up/Down, Back/Front, Short/Long, Thin/Wide, Vertical Shear 
a Forward Axis Shear. 

o Ethnicity, Age, and Gender: Ovladače Ethnicity/Age/Gender generují etnické, věkové a rodové 
rysy, jedná se o less/more African, less/more European, less/more Southeast Asian, 
less/more East Indian, Younger/Older a Male/Female. 

o Standard Figures>Poser 5: Ovladače Standard Figures>Poser 5 generují zjev jedné nebo více 
standardních figur Poseru 5, jedná se o Don, Judy, Will a Penny. 

Pro tvorbu/modifikaci hlavy jednoduše nastavte otočné ovladače, nebo pouţijte nástroj přímo na 
hlavu. Vaše práce bude v reálném čase zobrazena v okně Face Shaping Tool. 
 

KARIKATURY  CARICATURES (orig.215) 

Otočný ovladač Caricature umoţņuje vytvoření přehnaného vzhledu hlavy a tváře. Ovladač má meta 
efekt, coţ znamená, ţe umocņuje výsledek jiného tvarovacího nástroje. Zvětšováním hodnoty 
ovladače se zvyšuje účinek přehnání, a naopak: 

Základní hodnota je 0. Hodnota>0 aplikuje přehnání na hlavu a hodnota<0 ale větší neţ –1 aplikuje 
opak přehnání – zmenšení účinku. Hodnota –1 odpovídá základní hlavě. Pokud například vytváříte 
dlouhý nos pomocí jiného nástroje, hodnota 1 vytvoří velmi dlouhý nos, –1 vytvoří základní nos a –3 
vytvoří velmi krátký nos. 
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 POZNÁMKA 
KARIKATURA HODNOTY BLÍZKO –1 FUNGUJE JEKO CELKOVÉ ZMENŠENÍ ÚČINKU, NICMÉNĚ 
NĚKTERÉ NÁSTROJE (FACE SHAPING, RANDOM FACE, ATD.) MAJÍ MENŠÍ EFEKT VZHLEDEM 
K META EFEKTU OVLADAČE CARICATURE. 
 

POUŢITÍ MORPHŮ  USE MORPHS (orig.215) 

Databáze morphŧ místnosti tváře Face room obsahuje symetrické a  asymetrické targety. Tlačítka 
předvolby Use Morphs umoţņují výběr mezi následujícími poloţkami: 

o Both: Tato poloţka obsahuje všechny morph targety v databázi, dostupné pro interaktivní 
modelování tváře. Pokud kliknete na určitý bod tváře, Poser 7 vybere morphy ze symetrických 
nebo asymetrických setŧ morph targetŧ v zavislosti na tom, jaké morphy jsou pro zvolenou lokaci 
dostupné a u kterých předpokládá nejlepší výsledky. 

o Symmetry: Tato poloţka zpřístupní pouze sety symetrických morph targetŧ. 

o Asymmetry: Tato poloţka zpřístupní pouze sety asymetrických morph targetŧ. Přidání drobné 
asymetrie do tváře mŧţe často zvýšit míru realismu počítačem generované tváře, protoţe ţádná 
lidská tvář není zcela symetrická. 

 

NAČTENÍ/ULOŢENÍ/NÁHLED TEXTUR   
LOADING/SAVING/PREVIEWING TEXTURES (orig.216) 

Místnost tváře Face room načítá základní texturu Poseru 7, která je viditelná v okně náhledu textury 
Texture Preview. Okno náhledu textury zobrazuje náhled v reálném čase, přičemţ zpočátku se jedná 
o základní texturu hlavy, která se prŧběţně mění současně s načtením obrázkŧ nebo uţivatelským 
přizpŧsobením textury. Textury mŧţete také načítat a ukládat na pevný disk pro pozdější pouţití. Pro 
načtení textury klikněte na ikonu Load Texture na levé straně okna náhledu textury Texture Preview, 
které otevře okno Load Head Texture, umoţņující procházení souborových sloţek a nalezení 
souboru, který si přejete načíst. Načtenou texturu mŧţete modifikovat. 

Pro uloţení textury zobrazené v okně náhledu textury Texture Preview klikněte na ikonu Save 
Texture na pravé straně okna Texture Preview, která otevře standardní Save As dialog (viz téma 
“Uložit jako” na straně 185 pro informaci o dialogu Save As). 

Muţské figury Poseru 7 pouţívají odlišné souřadnice textury neţ figury ţenské a dětské. Pokud 
ukládáte textury, budete vyzváni k výběru, zda se jedná o texturu muţské figury. Zvolte Yes pokud se 
jedná o muţskou texturu, nebo No pro texturu ţenské nebo dětské figury. 
 

APLIKACE UŢIVATELSKÉ HLAVY/TEXTURY   
APPLYING CUSTOM HEADS/TEXTURES (orig.216) 

Jakmile máte dokončeny změny hlavy anebo textury, mŧţete vykonat následující akce: 

o Apply to Figure: Kliknutím na tlačítko Apply to Figure bude hlava z místnosti tváře Face room 
aplikována na aktuálně vybranou figuru ve scéně. Tato figura mŧţe být Don, Judy, James nebo 
Jessi, u kterých se hlava perfektně přizpŧsobí geometrii krku. 

o Apply Shape Only: Kliknutím na ovladač Apply Shape Only dojde k aplikaci tvaru hlavy na 
aktuálně vybranou figuru scény bez současné aplikace mapy textury. 

o Apply Texture Only: Kliknutím na ovladač Apply Texture Only dojde k aplikaci textury hlavy na 
aktuálně vybranou figuru scény bez současné aplikace tvaru hlavy. 

o Spawn Morph Target: Klinutím na tlačítko Spawn Morph Target uloţíte hlavu jako morph target. 
Prosím navštivte téma “Tvorba morph targetů” na straně 122 pro více informací o tvorbě morph 
targetŧ. 

o Import Figure Head Texture: Klinutím na tlačítko Import Figure Head Texture importujete texturu 
hlavy aktuálně vybrané figury, kterou mŧţete modifikovat, jak bylo popsáno v části o tvorbě textur 
výše. Importované textury si uchovávají originální velikost. Pokud například importujete texturu  
v rozlišení 1000x1000, všechny změny, které provedete v místnosti tváře Face room zachovají její 
velikost. Toto je dobrý zpŧsob pro tvorbu textur, které jsou větší neţ základní textura místnosti 
tváře o velikosti 512x512. 
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 POZNÁMKA 
POKUD APLIKUJETE JEDNU NEBO VÍCE HLAV DO SCÉNY, KTERÁ NEOBSAHUJE ŢÁDNOU 
FIGURU, HLAVA(Y) BUDE APLIKOVÁNA JAKO REKVIZITA. POKUD VAŠE SCÉNA OBSAHUJE 
VÍCE FIGUR, HLAVA BUDE APLIKOVÁNA NA AKTUÁLNĚ VYBRANOU FIGURU VIDITELNOU  
V MENU SELECT FIGURE. 

 POZNÁMKA 
PRO ODSTRANĚNÍ UŢIVATELSKÉ TEXTURY PO APLIKACI NA VAŠI FIGURU, VSTUPTE DO 
MÍSTNOSTI MATERIÁLU MATERIAL ROOM A ZVOLTE FACEROOMSKIN MATERIAL. ZDE NYNÍ 
MŦŢETE PODLE POTŘEBY NAHRADIT APLIKOVANOU TEXTURU JINOU, ODSTRANIT 
OBRAZOVOU MAPU, APOD. 
 

ULOŢENÍ TVÁŘE  SAVING FACES (orig.217) 

Pro uloţení tváře z místnosti tváře Face room musíte uloţit soubor formátu PZ3 obsahující 
aplikovanou hlavu. Také mŧţete vytvořit morph target. 
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Kapitola 18: Místnost vlasů  THE HAIR ROOM (orig. 218) 

Místnost vlasŧ Hair room Poseru umoţņuje vytvoření dynamických praménkových 3D vlasŧ pro Vaše 
figury nebo rekvizity. Vlasy mŧţete přidat kamkoliv si přejete, na libovolný objekt scény a také mŧţete 
přidat shadery do místnosti materiálu Material room (viz kapitola 16: “Místnost materiálu” na straně 
139) k vytvoření téměř jakéhokoliv vzhledu vlasŧ od světlé do tmavé, ale také k vytvoření mechu, 
lišejníku, trávy, apod. (stromová struktura shaderu je vytvořena pro kaţdou skupinu vlasŧ a je 
dostupná v místnosti materiálu Material room). Mŧţete dokonce aplikovat silová pole Force Fields 
(viz “Silová pole větru” na straně 113) pro vytvoření realistických efektŧ větru ve Vašich animacích! 

 POZNÁMKA 
VLASY OBSAHUJÍ VELKÉ MNOŢSTVÍ POLYGONŦ, KTERÉ VYŢADUJÍ ZNAČNÉ VÝPOČETNÍ 
ZDROJE. 

Místnost vlasŧ Hair room vypadá následovně: 

 

Kromě některých běţných nástrojŧ má místnost vlasŧ Hair room následující prvky uţivatelského 
rozhraní: 

o Hair Growth Groups Controls (1): Ovladače skupin rŧstu vlasŧ Hair Growth Groups umoţņuje 
vytváření, editaci a mazání rŧstových skupin vlasŧ. 

o Growth Controls (2): Ovladače rŧstu vlasŧ Growth Controls specifikují zpŧsob rŧstu vlasŧ 
v rŧstových skupinách. 

o Styling Controls (3): Jak název naznačuje, ovladače stylingu Styling Controls umoţņují 
nastavovat vzhled vlasŧ. 

o Dynamics Controls (4): Ovladače dynamiky Dynamics Controls umoţņují nastavení zpŧsobu, 
jakým se budou vlasy chovat během animace. 

Následující podsekce Vás provedou postupem tvorby praménkových vlasŧ. 
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 POZNÁMKA 
REKVIZITU TEMENE LEBKY SKULL-CAP S PŘEDEM NAROSTENÝMI A UPRAVENÝMI VLASY 
MŦŢETE NAJÍT V KATEGORII HAIR>STRAND-BASED HAIR UVNITŘ PALETY KNIHOVEN 
LIBRARY. 
 

KROK PRVNÍ: DEFINOVÁNÍ SKUPIN VLASŮ 
DEFINING HAIR GROUPS (orig.219) 

Jestli chcete umět pouţívat vytvořené vlasy na ostatních figurách, navštivte prosím téma “Přidání 
praménkových vlasů do palety knihoven” na straně 35 pro více informací před pokračováním dále. 
Prvním krokem při tvorbě praménkových vlasŧ je definování skupiny polygonŧ jako vlasové skupiny. 
Prostudujte prosím Poser 7 Tutorial Manual, “Groups” pro obecný popis skupin. Vlasová skupina je 
seskupení polygonŧ, které definují plochu, na které budou vlasy vyrŧstat. Skupinu definujte 
následovně: 

1. Vyberte objekt, který si přejete opatřit vlasy. 

2. Klikněte na tlačítko New Growth Group v prostoru 1 místnosti vlasŧ Hair room pro vytvoření nové 
skupiny pod základním názvem Hair_1. Následující vlasové skupiny budou číslovány vzestupně 
(Hair_2, apod.). Skupiny mŧţete přejmenovat zadáním nového 
jména do zobrazeného políčka New Growth Group Name. 
Klikněte na OK k pokračování nebo Cancel pro zrušení. 

3. Klikněte na tlačítko Edit Growth Group pro aktivování nástroje 
Grouping a pro otevření palety editoru skupin Group Editor. 
Ujistěte se, ţe máte vybránu správnou vlasovou skupinu před 
výběrem polygonŧ této skupiny. Prosím navštivte téma “Editor 
skupin” na straně 125 pro informace o pouţití nástroje skupin. 

4. Vyberte polygony, které si přejete vloţit do vlasové skupiny, 
kterou tvoříte. 

Mŧţete vytvořit tolik vlasových skupin, kolik si přejete, například 
vlasy hlavy, knírek, vousy, hrudník, záda, apod. 

 VAROVÁNÍ 
UJISTĚTE SE, ŢE MÁTE VYBRÁNU SPRÁVNOU VLASOVOU 
SKUPINU PŘED VÝBĚREM POLYGONŦ TÉTO SKUPINY!  
 

KROK DRUHÝ: VZRŮST VLASŮ  GROWING HAIR (orig.220) 

Jakmile máte vytvořeny rŧstové skupiny vlasŧ, dalším krokem je vzrŧst 
prŧvodních vlasŧ Guide Hairs. Jak název napovídá, prŧvodní vlasy 
ovlivņují zpŧsob rŧstu okolních vlasŧ. Pro vykonání tohoto kroku klikněte 
na tlačítko Grow Guide Hairs. Aktuálně vybraná vlasová skupina 
obroste prŧvodními vlasy: 

Prŧvodní vlasy formují vlasovou skupinu a zvyšují objem pomocí 
přepnutí do úplně rozmnoţené vlasové skupiny fully populated hair 
group (viz dále). Buď před nebo po vzrŧstu prŧvodních vlasŧ mŧţete 
nastavit některé hlavní parametry pro stanovení celkové formy vlasŧ. 
Jedná se o tyto parametry:  

o Hair Length: Parametr Hair Length stanovuje celkovou délku prŧvodních vlasŧ a následných 
rozmnoţených vlasŧ. Zmenšením tohoto parametru dojde ke zkrácení vlasŧ, a naopak. 

o Length Variance: Skutečné vlasy mají sklony částečně navzájem měnit svou délku. Parametr 
Length Variance umoţņuje nastavení rozdílu délek vlasŧ ve vybrané vlasové skupině. Hodnota 0 
znamená, ţe všechny prŧvodní vlasy jsou přesně stejně dlouhé, zatímco hodnota 1 vytvoří velký 
délkový rozdíl vlasŧ v jedné skupině. 

o Pull Back: Většina vlasŧ na lidské hlavě má tendenci  být česána nebo taţena dozadu podél hlavy. 
Parametr Pull Back definuje míru, jakou budou vlasy taţeny dozadu. Zvýšením této hodnoty 
budou prŧvodní vlasy taţeny dále dozadu a těsněji okolo hlavy. Negativní hodnoty táhnou vlasy 
dopředu směrem od povrchu hlavy. 
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o Pull Down: Stejně jako většina vlasŧ je taţena dozadu, také mŧţou viset dolŧ díky stylingu, 
gravitaci, nebo vlivem obou těchto faktorŧ. Parametr Pull Down definuje míru účinku těchto 
faktorŧ. Zvýšením hodnoty parametru budou vlasy taţeny dolŧ a těsněji okolo povrchu hlavy,  
a naopak. Negativní hodnota vytvoří anti-gravitační vlasy. 

Jakmile máte tento krok dokončen, vlasy budou umístěny a budou zhruba vytvarovány. 

 POZNÁMKA 
NEPLEŤTE SI PARAMETRY PULL BACK A PULL DOWN S NASTAVENÍM GRAVITACE NEBO JINÉ 
DYNAMIKY, KTEROU MŦŢETE NASTAVIT PO STYLINGU VLASŦ. TYTO PARAMETRY 
NASTAVUJÍ POUZE STARTOVNÍ POZICI VLASŦ. 
 

KROK TŘETÍ: STYLING VLASŮ  STYLING HAIR (orig.220) 

Nyní máte narosteny prŧvodní vlasy a nastaveny některé základní parametry určující vzhled vlasŧ, 
Váš další krok bude styling vlasŧ zpŧsobem, který si přejete. Toto mŧţete provést nastavením 
dostupných parametrŧ stylingu, anebo pouţitím nástroje na editaci vlasŧ Hair Edit. Nástroj na editaci 
vlasŧ mŧţete pouţív kdykoliv po narostení vlasŧ, přesto doporučujeme kompletně dokončit předchozí 
krok. 

 POZNÁMKA 
BĚHEM PRÁCE MŦŢETE ZAPÍNAT A VYPÍNAT FUNKCI ROZMNOŢENÍ VLASŦ SHOW 
POPULATED PRO SHLÉDNUTÍ PRŦBĚŢNÝCH VÝSLEDKŦ PRÁCE. 

Prosím nastudujte následující podsekci pro informace o pouţití nástroje na editaci vlasŧ Hair Edit. 
Parametry stylingu vlasŧ jsou následující: 

o Show Populated: Označením políčka Show Populated budou zobrazeny prŧvodní vlasy a také 
vlasy rozmnoţené. To Vám umoţní shlédnout přesný konečný vzhled vlasŧ, ale zároveņ mŧţe 
dojít ke sníţení obnovovací frekvence zobrazení. Nastavení tohoto parametru nemá vliv na 
mnoţství vlasŧ v konečném renderu. Ve finálním FireFly renderu budou vlasy zobrazeny vţdy 
rozmnoţené. 

o Hair Density: Parametr hustoty vlasŧ Hair Density nastavuje celkový počet vlasŧ ve skupině. 
Počet vlasŧ je zobrazen vedle názvu otočného ovladače. Zvýšením hodnoty dojde k vytvoření 
plnějších a bohatějších vlasŧ. Moţnost nastavení celkového počtu vlasŧ je silnou funkcí umoţņující 
vytvoření uţivatelských efektŧ, nicméně velký počet vlasŧ zpomaluje rendering a čas překreslení. 
Experimentováním s tímto počtem mŧţete dosáhnout optimální pokrytí bez nutnosti přidání 
velkého mnoţství vlasŧ. 

o Tip Width: Parametr Tip Width nastavuje tloušťku vlasŧ (prŧměr) na jejich koncích. Vlasy se 
obvykle zúţují postupně od kořene po špičku, takţe tato hodnota by měla být typicky menší, neţ 
hodnota parametru Root Width, viz dále. 

o Root Width: Parametr Root Width nastavuje tloušťku vlasŧ (prŧměr) u jejich kořenŧ. Vlasy se 
obvykle zúţují postupně od kořene po špičku, takţe tato hodnota by měla být typicky větší, neţ 
hodnota parametru Tip Width, viz výše. 

o Clumpiness: Parametr Clumpiness stanovuje tendenci vlasŧ vzájemně tvořit svazky. 

o Kink Strength: Parametr Kink Strength stanovuje míru, jakou se vlasy vlní/kroutí. Zvýšením této 
hodnoty docílíte vlnitější vlasy, a naopak. 

o Kink Scale: Parametr Kink Scale stanovuje velikost vln/kudrlin. Zvýšením této hodnoty docílíte 
větší vlny a kudrliny, a naopak. 

o Kink Delay: Parametr Kink Delay stanovuje vzdálenost od kořene vlasŧ, ve které se vlasy začínají 
vlnit/kroutit. Zvýšením této hodnoty se zvyšuje vzdálenost kudrlin od kořene vlasŧ, a naopak. 

o Verts Per Hair: Parametr Verts per hair nastavuje, kolik vertexových bodŧ se nachází v kaţdém 
pramenu vlasŧ. Zvýšením této hodnoty vytvoříte hladší, větší proud vlasŧ, ale zároveņ zvýšíte 
poţadavky na výpočetní výkon během renderu/překreslení scény. 

o Style Hairs: Klinutím na tlačítko Style Hairs vyberete nástroj na výběr vlasŧ Hair Select a otevřete 
paletu nástroje na styling vlasŧ Hair Style Tool (viz dále). 
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POUŢITÍ PALETY A NÁSTROJE NA EDITACI VLASŮ 
USING THE HAIR EDIT TOOL/PALETTE (orig.222) 

Nástroj pro výběr vlasŧ Hair Select je dostupný pouze 
v místnosti vlasŧ Hair room. Umoţņuje Vám přímou editaci 
prŧvodních vlasŧ a vytvořit téměř nekonečné mnoţství variant 
účesu. Nástroj mŧţete zpřístupnit buď jeho výběrem 
v editačních nástrojích Editing tools, nebo kliknutím na 
tlačítko Hair Select, jak bylo popsáno výše. Paleta nástroje na 
styling vlasŧ Hair Style Tool vypadá následovně: 

Pro přímou manipulaci prŧvodních vlasŧ máte k dispozici 
následující ovladače:  

o Add Hairs to Selection (1): Vyberte nástroj na výběr vlasŧ  
a poté klikněte a táhněte obdélník okolo prŧvodních vlasŧ, 
které si přejete dále upravovat. Nevybrané prŧvodní vlasy 
nebudou nástrojem na editaci vlasŧ Hair Edit dotčeny. 
Vybrané vlasy budou všechny ovlivněny rovnoměrně. 
Výběrem většího počtu vlasŧ mŧţete urychlit práci, nicméně mŧţete vybrat 
jen několik, nebo pouze jeden vlas pro precizní nastavení účesu. 

 POZNÁMKA 
PRO PŘESNĚJŠÍ OZNAČENÍ VLASŦ, KTERÉ MAJÍ BÝT VYBRÁNY, 
POUŢIJTE PŘEPÍNÁNÍ POHLEDU KAMER, NEBO POUŢIJTE NÁSTROJ LUPY 
PRO PŘIBLÍŢENÍ POHLEDU ZBLÍZKA.  

 POZNÁMKA 
RŦST VLASŦ JE ZALOŢEN NA POČTU POLYGONŦ MATEŘSKÉHO PARENT 
OBJEKTU. POKUD SI PŘEJETE PŘIDAT DETAILNÍ VLASOVOU SKUPINU NA 
NÍZKOPOLYGONOVOU REKVIZITU, NEBO ČÁST FIGURY S MALÝM POČTEM POLYGONŦ, 
MŦŢETE VYTVOŘIT REKVIZITU Z OBLASTI, KTEROU SI PŘEJETE POKRÝT VLASY, 
EXPORTOVAT TUTO REKVIZITU DO VAŠÍ OBLÍBENÉ 3D MODELOVACÍ APLIKACE PRO 
ROZDĚLENÍ POLYGONŦ, POTOM IMPORTOVAT REKVIZITU ZPĚT A APLIKOVAT JI TAM, KDE SI 
PŘEJETE. TOTO JE OBDOBNÁ MYŠLENKA JAKO APLIKACE POKRÝVEK HLAVY SKULLCAPS, 
PŘIČEMŢ NEJSTE LIMITOVÁNI HLAVOU. 

o Translate Hairs (2): Nástroj Translate Hairs posouvá vybrané vlasy vertikálně okolo, nebo 
postranně okolo os X a Y kamery v závislosti na zpŧsobu taţení myší. Posun se bude odehrávat 
podle os X, Y, a Z v závislosti na pozici kamery vzhledem k vlasŧm. 

o Curl Hairs (3): Nástroj Curl Hairs otáčí prŧvodní vlasy. Rotace vlasŧ probíhá ve třech dimenzích, 
coţ umoţņuje velmi rychlé dosaţení poţadovaného výsledku. Taţením kolmo na vlas dochází 
k jeho rotaci nahoru a dolŧ (relativně k úhlu pohledu). Taţením rovnoběţně s vlasem dochází 
k jeho rotaci dopředu a dozadu, opět relativně k úhlu pohledu. 

o Scale Hairs (4): Nástroj Scale Hairs umoţņuje měnit velikost vybraných vlasŧ podél os X a Y 
kamery. Osy vlasŧ, podle kterých budou ovlivněny, závisí na jejich pozici v závislosti na pozici 
kamery. Taţením směrem ke kořenu se zmenšuje velikost vlasu a naopak taţením od kořene se 
velikost zvětšuje. Taţením postranně se velikost mění ve dvou dimenzích a taţením vertikálně se 
velikost mění ve třetí dimenzi. Ovlivněné osy závisejí na aktuální pozici vybrané kamery. Pro 
změnu velikosti vybraného vlasu(ŧ) současně ve všech třech dimenzích, také mŧţete při pouţití 
tohoto nástroje stisknout a drţet klávesu [SHIFT]. 

o Remove Hairs from Selection (5): Výběrem nástroje Deselect Hairs, nebo jednoduchým stiskem 
klávesy [CTRL] a následným kliknutím a taţením obdélníku okolo prŧvodních vlasŧ, mŧţete tyto 
odstranit z výběru pro další styling. Nástroj Hair Edit neovlivní nevybrané prŧvodní vlasy. 

o Translate In/Out (6): Nástroj Translate Hairs In-Out posouvá vybrané vlasy podél Z osy kamery 
(tam a zpět). Tento posun mŧţe probíhat okolo os X, Y a Z vlasŧ. Taţením dolŧ přitáhnete vlasy 
směrem k Vám, a naopak. 

o Twist (7): Nástroj Twist Hairs kroutí vybrané vlasy okolo jejich vlastních os. 

V závislosti na editačních nástrojích má paleta následující ovladače: 
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o Constrain Length: Označením políčka Constrain Length donutíte všechny vybrané prŧvodní vlasy 
udrţovat jejich aktuální délku bez závislosti na tom, jaký editační nástroj u nich pouţijete. 
Odznačením tohoto políčka umoţníte změnu délky vlasŧ v závislosti na pouţití editačních nástrojŧ 
vlasŧ (například mŧţete pouţít nástroj Hair Translate pro prodlouţení některých prŧvodních vlasŧ 
za účelem vytvoření culíku). 

o Falloff: Posuvník Falloff nastavuje část vlasu, která bude stylingem ovlivněna. Posunutím jezdce 
vlevo umoţníte nástroji pŧsobit pouze v okolí špičky vlasu. Posunutím jezdce doprava umoţníte 
nástroji pŧsobit na větší délku vlasu. Po přesunutí jezdce zcela vpravo bude nástroj pŧsobit na celý 
vlas od kořene po špičku. 

o Lengthen: Otočením ovladače Lengthen doprava prodlouţíte vybrané prŧvodní vlasy, a naopak. 

o Clear Selection: Kliknutím na tlačítko Clear Selection dojde k odznačení všech vybraných 
prŧvodních vlasŧ. 

Pro opuštění tohoto nástroje buď klikněte na políčko Close v pravém horním rohu palety, nebo 
vyberte jiný editační nástroj Editing tool. 

 POZNÁMKA 
NÁSTROJE PRO EDITACI VLASŦ HAIR EDIT TOOLS NEOVLIVŅUJÍ FIGURY A REKVIZITY VE 
SCÉNĚ A EDITAČNÍ NÁSTROJE OKNA DOKUMENT DOCUMENT EDITING TOOLS NEOVLIVŅUJÍ 
VLASY. 
 

KROK ČTVRTÝ: NASTAVENÍ DYNAMIKY VLASŮ   
SETTING HAIR DYNAMICS (orig.223) 

Nyní máte vlasy narostené a nastaven jejich styl. Pojďme tedy přidat nějakou dynamiku pro nastavení, 
jak se budou vlasy chovat během animace: 

o Do Collisions: Označením políčka Do Collisions aktivujete detekci kolize aktuální vlasové skupiny, 
která zamezí prŧniku vlasŧ do jiných objektŧ scény (například dlouhé vlasy neproniknou do hlavy 
figury). Pro zajištění řádné funkce detekce kolize se ujistěte, ţe všechny části figury, které chcete 
ochránit proti prŧniku vlasŧ, mají označeno políčko Collision Detection v paletě vlastností 
Properties. 

o Gravity: Parametr Gravity nastavuje sílu gravitačního pole pŧsobícího na vlasy. 

o Spring Strength: Parametr Spring Strength stanovuje pruţnost vlasŧ. Zvýšením hodnoty se 
pruţnost vlasŧ zvyšuje. Gumička je dobrým příkladem objektu s vysokým stupněm pruţnosti. 

o Air Damping: Parametr Air Damping specifikuje odpor vlasŧ vŧči účinkŧm větru (tlumení účinku 
větru), který se projeví kdykoliv, kdyţ jsou vlasy pŧsobení větru vystaveny. Krátké vlasy mají niţší 
odpor neţ vlasy dlouhé. Nastavujte tento parametr opatrně, protoţe nadměrné hodnoty mohou 
zpŧsobit nepředvídatelné výsledky. 

o Spring Damping: Parametr Spring Damping ovládá elasticitu vlasŧ. 

o Bend Resistance: Parametr Bend Resistance nastavuje odpor vlasŧ vŧči jejich ohýbání a řasení. 

o Position Force: Parametr Position Force nutí vertexy vlasŧ k posunu ve směru podle choreografie. 
Zvýšením hodnoty parametr se sniţuje dynamika vlasŧ, a naopak. 

o Root Stiffness: Parametr Root Stiffness stanovuje, jak tuhé jsou vlasy v jejich kořenech. 

o Root Stiffness Falloff: Parametr Root Stiffness Falloff stanovuje, jak rychle se tuhost vlasŧ sniţuje 
ve směru od kořene po špičku vlasŧ. 

o Calculate Dynamics: Kliknutím na tlačítko Calculate Dynamics aplikuje aktuální nastavení 
dynamiky na vybranou vlasovou skupinu. Počet snímkŧ v klíčové animaci určuje délku kalkulace. 
Rozmnoţené vlasy nejsou během kalkulace zobrazeny. 

 
VLASTNOSTI & PARAMETRY VLASŮ   
HAIR PROPERTIES & PARAMETERS (orig.224) 

To access a hair object‟s parameters and properties, you must first select the desired hair object. 
Strand-based hair has the following properties and parameters: 



 

Strana 163 (celkem 289) 

 

VLASTNOSTI VLASŮ  HAIR PROPERTIES (orig.224) 

o Name: Políčko Name zobrazuje název objektu vlasŧ. V případě potřeby do tohoto políčka zadejte 
název nový. 

o Visible: Označením políčka Visible se nastaví viditelnost objektu vlasŧ ve scéně, a naopak. 
Neviditelné objekty nebudou zahrnuty do výpočtu renderu scény. Viz téma “Vlastnosti figur” na 
straně 75 pro informace o animaci vlastnosti Visible. 

o Visible in Raytracing: Označením políčka Visible in Raytracing učiníte objekt vlasŧ viditelný 
v odlescích, jako například postavy před zrcadlem. Při neoznačeném políčku se objekt vlasŧ 
v odlescích nezobrazí. 

o Bend: Označením políčka Bend umoţníte ohýbání objektu vlasŧ a naopak. Ohýbání je popisováno 
v části “Ohýbání částí těla” na straně 206. Pamatujte si, ţe volbou Display>Bend Body Parts je 
aktivováno ohýbání všech objektŧ scény a tato vlastnost se tedy uplatní pouze na aktuálně 
vybranou část postavy. 

o Casts Shadows: Označením políčka Casts Shadows bude vybraná rekvizita vrhat stín, který bude 
ve scéně viditelný. Při neoznačeném políčku nebude vybraný objekt vlasŧ vrhat ţádný stín.  

o Displacement Bounds: Vlastnost Displacement Bounds určuje hodnotu hranice vytlačení povrchu 
zvoleného objektu vlasŧ (zvýraznění plasticity povrchu). Prosím navštivte kapitolu 36: “Použití 
renderovacího nástroje FireFly” na straně 249 pro více informací o hranici vytlačení. 

o Recalculate Dynamics: Poloţka Recalculate Dynamics přepočítá dynamiku aktuálně vybraného 
objektu vlasŧ. 

o Shading Rate: Vlastnost Shading Rate umoţņuje specifikovat velikost mikropolygonŧ v pixelech, 
které vznikají dělením polygonŧ povrchu aktuálně vybraného objektu vlasŧ během renderu. Prosím 
navštivte kapitolu 36: “Použití renderovacího nástroje FireFly” na straně 249 pro více informací  
o vlastnosti Shading Rate. 

 

PARAMETRY VLASŮ  HAIR PARAMETERS (orig.225) 

Praménkové vlasy obsahují následující parametry: 

o Dynamics: Parametr Dynamics nastavuje míru, kterou se předem specifikovaná dynamika uplatní 
během animace. Nastavení hodnoty 1 znamená, ţe dynamika bude uplatněna v plné výši tak, jak 
byla nastavena. Hodnota 2 znamená, ţe dynamika bude uplatněna ve výši 200% oproti aktuálnímu 
nastavení, a tak podobně. Hodnota menší neţ 1 redukuje účinek dynamiky a negativní hodnoty 
vytvoří reverzní dynamiku. 

o XYZRotate: Otočné ovladače parametrŧ xRotate, yRotate a zRotate otáčejí objektem vlasŧ okolo 
příslušných os X, Y, nebo Z. 

o Scale: Otočný ovladač parametru Scale zvětšuje nebo zmenšuje vybranou objekt vlasŧ ve všech 
třech osách rovnoměrně. 

o XYZScale: Otočné ovladače parametrŧ xScale, yScale a zScale zvětšují nebo zmenšují vybraný 
objekt vlasŧ jen podél zvolené osy. 

o XYZTran: Otočné ovladače parametrŧ xTran, yTran a zTran posouvají objektem vlasŧ podél 
příslušných os. 

 

BARVY A MATERIÁLY VLASŮ  HAIR COLORS AND MATERIALS (orig.226) 

Kaţdý objekt praménkových vlasŧ ve scéně má vlastní stromovou strukturu shaderu, který je 
dostupný v místnosti materiálu Material room, umoţņující obarvení vlasŧ a přidání zajímavých efektŧ. 
Navštivte prosím kapitolu 16: “Místnost materiálu” na straně 139 pro více informací o místnosti 
materiálu Material room. Stejně jako u jiných objektŧ, mŧţete praménkové vlasy vybírat kliknutím 
v pracovním okně Document window, pouţitím menu Current Actor, apod. 
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ULOŢENÍ PRAMÉNKOVÝCH VLASŮ DO PALETY KNIHOVEN 
SAVING STRAND-BASED HAIR TO THE LIBRARY PALETTE (orig.226) 

Praménkové vlasy nemŧţete přímo ukládat do palety knihoven Library. Navštivte prosím téma 
“Přidání praménkových vlasů do palety knihoven” na straně 35 pro více informací. 
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Kapitola 19: Místnost oblečení  THE CLOTH ROOM (orig. 227) 

Místnost oblečení Cloth room umoţņuje vytvoření realistického oblečení, které se chová jako 
skutečná látka. Chcete figuru doplnit o šaty šité na mírŧ? Vytvořit ubrus? Co takhle létající koberec? 
Poser 7 usnadņuje u látky vytvoření úţasných efektŧ. Dokonce mŧţete pouţít silové pole Force Field 
pro vytvoření realistického efektu účinku větru! Místnost oblečení Cloth room vypadá následovně: 

 

V základním nastavení obsahuje místnost oblečení následující ovladací prvky: 

o Cloth Simulations (1): Skupina ovladačŧ Cloth Simulation umoţņuje vytvoření, nastavování  
a mazání simulátorŧ oblečení. 

o Cloth (2): Skupina ovladačŧ Cloth umoţņuje konverzi objektŧ na objekty dynamického oblečení  
a naopak a nastavení detekce kolize pro Vaše oblečení. 

o Cloth Groups (3): Skupina ovladačŧ Cloth Groups je prostor, ve kterém budete nastavovat 
dynamiku, choreografii, omezení a dekoraci skupin oblečení. 

o Dynamics Controls (4): Skupina ovladačŧ Dynamics Controls nastavuje parametry dynamiky. 

 POZNÁMKA 
NÁPOVĚDA MÍSTNOSTI OBLEČENÍ CLOTH ROOM HELP OBSAHUJE DOPLŅKOVÉ INFORMACE 
TÝKAJÍCÍ SE IMPORTU REKVIZIT PRO VYUŢITÍ JAKO OBLEČENÍ. 
 

PŘIZPŮSOBIVÉ VS. DYNAMICKÉ OBLEČENÍ  
CONFORMING VS. DYNAMIC CLOTH (orig.228) 

Jak uvádíme všude v této příručce, přizpŧsobivé oblečení je koncipováno jako figura Poseru, zatímco 
dynamické oblečení obsahuje rekvizity props včetně dynamiky a dalších aplikovaných vlastností pro 
simulaci oblečení. Poser 7 podporuje oba typy oblečení. 
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Dynamické oblečení přínáší neuvěřitelnou míru realismu do Vašich scén umoţněním pohybu objektŧ 
oblečení stejně jako v reálném ţivotě. Chcete překrýt stŧl ubrusem? Potáhnout nábytek? Umoţnit 
plynulý pohyb sukně při chŧzi postavy? Dynamické oblečení toto vše umoţní a ještě více. Nicméně 
dynamické oblečení bude vyţadovat více výpočetního výkonu oproti pouţití přizpŧsobivého oblečení. 

Poloţky jako ponoţky, bikiny, punčochy, apod. nevyţadují dynamiku, protoţe v reálném světě mají 
tyto typy oblečení tendenci být trvale přimknuty k postavě, coţ nevytváří prostor jejich samostatnému 
pohybu. Takţe pro tyto poloţky pouţívejte raději přizpŧsobivé oblečení, které vyţaduje méně 
výpočetního výkonu. 
 

KROK 1: VYTVOŘENÍ/NASTAVENÍ SIMULÁTORU OBLEČENÍ 
STEP 1: CREATE/SET UP A CLOTH SIMULATOR (orig.228) 

Prvním krokem při tvorbě dynamického oblečení je vytvoření a nastavení simulátoru oblečení. Ve 
scéně mŧţete mít tolik simulátorŧ, kolik si přejete, nicméně kaţdý simulátor klade nároky na výpočetní 
zdroje (RAM/CPU takty) a prodluţuje dobu renderu. 
 

VYTVOŘENÍ SIMULÁTORU  CREATING THE SIMULATOR (orig.228) 

Pro vytvoření simulátoru klikněte na tlačítko New Simulation 
ze skupiny ovladačŧ Cloth Simulation na obrazovce, čímţ 
dojde k otevření dialogového okna Simulator Settings: 

Dialogové okno Simulator Settings má následující 
předvolby: 

o Simulation Name: Poţadované pojmenování nového 
simulátoru zadejte do políčka Simulation Name. 
V základním nastavení jsou simulátory číslovány 
podle pořadí v jakém jsou vytvářeny, tedy Sim_1, Sim_2, 
atd. 

o Simulation Range: Buď mŧţete nastavit simulátor tak, aby běţel po dobu celé animace, nebo 
mŧţete vybrat úsek snímkŧ, během kterých bude simulátor aktivní zadáním poţadovaných čísel 
snímkŧ do políček Start Frame a End Frame. Větší mnoţství snímkŧ, ve kterých je simulátor 
aktivní, zvyšuje nároky na výpočetní výkon systému. Ve snímcích před startem simulace zŧstává 
objekt oblečení v základním tvaru. Ve snímcích za koncem simulace zŧstane objekt oblečení ve 
tvaru odpovídajícímu konci simulace a tento tvar si udrţí aţ do konce animace. Otočný ovladač 
Steps per frame navíc nastavuje počet výpočtových krokŧ v rámci jednoho snímku pro vyhlazení 
animace oblečení. Zvýšením této hodnoty zlepšíte výsledek simulace, ale zvýšíte také poţadavky 
na výpočetní výkon. 

o Additional Cloth Collision Options: Tato označovací políčka umoţņují zapínání a vypínání 
následujících předvoleb detekce kolize. V základu jsou kolize kalkulovány za pouţití vertexŧ 
oblečení a polygonŧ kolidujícího objektu. 

o Object Vertex against cloth polygon: Označením políčka Object Vertex against cloth polygon 
aktivujete provedení doplņkové kalkulace kolize za pouţití vertexŧ oblečení a polygonŧ 
kolidujícího objektu, která pomáhá eliminovat boule a díry, jeţ mohou vzniknout při kolizi 
objektu s oblečením. Tato fuknce zpomaluje simulaci. 

o Object Polygon against cloth polygon: Označením políčka Object Polygon against cloth 
polygon aktivujete provedení doplņkové kalkulace kolize za pouţití polygonŧ oblečení  
a polygonŧ kolidujícího objektu, která pomáhá eliminovat boule a díry, jeţ mohou vzniknout při 
kolizi objektu s oblečením. Tato fuknce zpomaluje simulaci. 

o Cloth self-collision: Označením políčka Cloth self collision umoţníte při simulaci detekci kolize 
polygonŧ oblečení navzájem, coţ zabrání například vzájemnému prŧniku částí látky kapuce 
nebo vlajky. Tato fuknce zpomaluje simulaci. 

o Cloth Draping: Předvolby Cloth Draping jsou: 

o Drape Frame: Hodnota Drape Frame umoţņuje nastavení počtu snímkŧ potřebného pro 
urovnání oblečení podle tvaru objektu. 
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o Calculate Drape: Kliknutím na tlačítko Calculate Drape aktivujete výpočet pokrytí oblečení přes 
objekt a uloţení tvaru pro simulaci. Kdyţ budete kalkulovat simulaci, uloţené nastavení pokrytí 
oblečení bude načteno před začátkem simulace oblečení, to znamená, ţe vytvarované oblečení 
je nastaveno do snímku 1 před začátkem simulace. 

Jakmile máte dokončeno nastavení předvoleb simulátoru, klikněte na tlačítko OK pro potvrzení  
a vytvoření simulátoru, nebo na tlačítko Cancel pro odchod bez vytvoření simulátoru. 

Skupiny ovladačŧ Cloth Simulation má ještě další dvě tlačítka: 

o Delete Simulation: Výsledky simulace jsou ukládány do souboru během výpočtu simulace, který 
Poser 7 automaticky ukládá pro úsporu času a výpočetních prostředkŧ. Kliknutím na tlačítko 
Delete Simulation vymaţete uloţený obsah. 

o Simulation Settings: Kliknutím na tlačítko Simulation Settings dojde k opakovanému otevření 
okna Simulation Settings, coţ umoţņuje provední úpravy nastavení simulátoru oblečení. 

 POZNÁMKA 

MYSLETE NA TO, ŢE SIMULÁTOR OBLEČENÍ JE JEN NÁSTAVBOU SUPLUJÍCÍ ZÁKLADNÍ 
CHOVÁNÍ REKVIZITY. MŦŢETE MÍT VÍCERO OBJEKTŦ OBLEČENÍ V KAŢDÉ SIMULACI, ANEBO 
VÍCERO SIMULACÍ V JEDNÉ SCÉNĚ POSERU 7. NICMÉNĚ KAŢDÝ OBJEKT OBLEČENÍ MŦŢE  
V JEDNU DOBU NÁLEŢET JEN DO JEDNÉ SIMULACE. ZVÝŠENÍM MNOŢSTVÍ SIMULACÍ VE 
SCÉNĚ MŦŢETE PŘIDAT NA KOMLEXNOSTI A ZAJÍMAVOSTI, ALE TAKÉ ZVÝŠÍTE POŢADAVKY 
NA VÝPOČETNÍ VÝKON. 

Šipka vpravo nahoře ve skupině ovladačŧ Cloth Simulation zobrazuje aktuálně vybraný simulátor. 
Kliknutím na tuto šipku otevřete rozbalovací menu, které umoţņuje výběr kteréhokoliv simulátoru 
scény pro modifikaci. 
 

KROK 2: OVLADAČE OBLEČENÍ 
STEP 2: CLOTH CONTROLS (orig.230) 

Nyní máme vytvořený simulátor a dalším krokem bude přidání objektŧ oblečení. Toto uděláme pomocí 
ovladačŧ Cloth (plocha 2 na obrázku obrazovky výše). 
 

VYTVOŘENÍ OBJEKTŮ OBLEČENÍ  CLOTHIFYING OBJECTS (orig.230) 

Pro přeměnu objektu na objekt dynamického oblečení jej vyberte a klikněte na tlačítko Clothify pro 
otevření okna Clothify, které zobrazí seznam objektŧ vhodných pro přeměnu na dynamické oblečení. 
Pouţijte rozbalovací menu Object to clothify k výběru poţadovaného objektu a klikněte na tlačítko 
Clothify pro vytvoření objektu oblečení, nebo na tlačítko Cancel pro odchod. 

Pro přeměnu objektu dynamického oblečení zpět na normální rekvizitu jej vyberte a klikněte na 
tlačítko Unclothify. Rekvizita se navrátí do stavu před změnou na objekt oblečení, nicméně si 
zachová vertexové skupiny a parametry dynamiky, coţ znamená, ţe mŧţete začínat s polotovarem při 
pozdějším opětovném vytvořením objektu oblečení z tohoto objektu. 

Z objektŧ oblečení mŧţete také vytvářet statické rekvizity a morph targety, jak je popsáno v části 
“Tvorba rekvizit a morph targetů” na straně 172. 
 

SPECIFIKACE KOLIZNÍCH OBJEKTŮ  SPECIFYING COLLISION OBJECTS (orig.230) 

Jakmile máte simulátor vytvořen, specifikovány základní 
parametry a vytvořeno dynamické oblečení, další částí 
procesu tvorby simulátoru je definování objektŧ, u kterých 
bude pouţita detekce kolize s oblečením (kolizní objekty). 
Kaţdý kolizní objekt se bude při kontaktu s látkou chovat  
v souladu se specifikovaným kolizním chováním. Bezkolizní 
objekty nebudou vyuţívat detekci kolize s objektem oblečení. 
Pro nastavení kolizního objektu klikněte na tlačítko Collide 
Against, které otevře okno Cloth Collision Objects: 

Okno Cloth Collision Objects obsahuje následující poloţky: 

o Add/Remove Collision Objects: Kliknutím na tlačítko Add/Remove otevřete okno Select Objects, 
které zobrazuje hierarchický seznam všech objektŧ scény včetně jednotlivých částí figur. 
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V základním nastavení jsou všechny objekty scény vybrány (vybrané objekty jsou označeny). 
Přidejte nebo odstraņte kolizní objekty pomocí označení/odznačení zaškrtávacích políček vedle 
kaţdého objektu zobrazeného seznamu a poté klikněte na tlačítko OK pro potvrzení volby, nebo na 
tlačítko Cancel pro zrušení volby. Přidané objekty se objeví v rozbalovacím menu Current 
Collision Object v okně Cloth Collision Objects. Kolizní vlastnosti pro kaţdý kolizní objekt 
mŧţete nastavit pomocí výběru objektu z rozbalovacího menu a následné specifikace 
poţadovaného nastavení. 

o Collision Offset: Parametr Collision Offset vymezuje vzdálenost mezi objektem oblečení  
a kolizním objektem, ve které se začíná detekce kolize počítat. Zvýšení této hodnoty mŧţe pomoci 
vyhnout se drobným kolizím, speciálně během animací, protoţe Poser 7 bude vyţadovat méně 
času pro výpočet aktuální kolize. Značné zvýšení této hodnoty však spotřebuje extra výpočetní 
výkon. Experimentem rychle najdete vlastní hodnotu nastavení pro kaţdou simulaci. Prosím 
navštivte téma “Odsazení & hloubka kolize” na straně 169 pro více informací. 

o Collision Depth: Parametr Collision Depth specifikuje, jak blízko musí objekt oblečení být vŧči 
koliznímu objektu, aby kolize nastala. Zvýšením této hodnoty zvýšíte vzdálenost, ve které budou 
oblečení a kolizní objekt kolidovat. Toto je uţitečné při tvorbě oblečení, protoţe oblečení mŧţe být 
udrţováno dále od figury. Zvýšením této vzdálenosti vytvoříte oblečení vypadající více staticky, ale 
vyhnete se prostupu částí postavy oblečením (například nohy skrze sukni). Experimentem rychle 
najdete vlastní hodnotu nastavení pro kaţdou simulaci. Prosím navštivte téma “Odsazení  
& hloubka kolize” na straně 169 pro více informací. 

o Static Friction: Parametr Static Friction nastavuje koeficient tření pro kolizní objekt. Je podobný 
parametru Dynamic Friction aţ na to, ţe toto je síla potřebná k tomu, aby přiměla nehybnou látku 
v kontaktu s tělesem k zahájení posunu. Například nylon na hladkém plastu má velmi malou 
hodnotu koeficientu tření, zatímco dţínovina na dřevě má hodnotu velkou. Označovací políčko 
Collision Friction (viz níţe) mŧţete pouţít pro zadání hodnot kolizních objektŧ nebo hodnot 
simulací. 

o Dynamic Friction: Parametr Dynamic Friction nastavuje koeficient tření pro kolizní objekt, pokud 
je tento v pohybu. Posun kusu látky napříč povrchem tělesa zpŧsobuje tření.  Posun hedvábí přes 
povrch oceli klade malý odpor, zatímco bavlna pohybující se přes kŧţi, hrubý brusný papír nebo 
přes surové dříví klade odpor vysoký. Označovací políčko Collision Friction (viz níţe) mŧţete 
pouţít pro zadání hodnot kolizních objektŧ nebo hodnot simulací. 

o Figure Collision Options: Předvolby Figure Collision Options umoţņují specifikovat, jak se bude 
aktuální objekt oblečení chovat při zakrývání/kolizi s figurou. Většina oděvŧ oblečených na figuře je 
vytvářena takovým zpŧsobem, aby padly cílové figuře, kdyţ je figura v standardní póze. Nicméně 
mnoho simulací obsahujících figury a oblečení nepouţívá na startu simulace figury v základní 
póze. Aby simulace probíhala správně, musíme simulovat proces tvarování oblečení: v určitých 
snímcích bude figura interpolovat přechod ze základní pózy do pózy startovní a tvarovací simulace 
přitom zajistí, aby ve startovním snímku oblečení figuře padlo: 

o Start Draping From Zero Pose: Označením políčka Start draping from zero pose se pouţívá, 
pokud vytváříme látku, která bude pouţita jako oblečení na figuře. Mŧţete například 
konvertovat přizpŧsobivé oblečení na objekty dynamického oblečení a vytvarovat je na figuru, 
počínaje základní pózou figury. Toto je uţitečné, pokud aplikujete dynamické oblečení na 
pózující figuru. 

o Ignore Head Collisions: Označením políčka Ignore head collisions nastavíte, ţe detekce 
kolize nebude aplikována při kolizi oblečení s hlavou figury. Toto je uţitečné v případech, kdy se 
oblečení nemŧţe za normálních okolností hlavy dotknout, například u sukní, kalhot, apod. 

o Ignore Hand Collisions: Označením políčka Ignore hand collisions nastavíte, ţe detekce 
kolize nebude aplikována při kolizi oblečení s rukama figury. 

o Ignore Feet Collisions: Označením políčka Ignore feet collisions nastavíte, ţe detekce kolize 
nebude aplikována při kolizi oblečení s nohama figury. 

 POZNÁMKA 
PŘIDÁNÍM KOLIZNÍCH OBJEKTŦ ZVÝŠÍTE NÁROKY NA VÝPOČETNÍ VÝKON PROŘEBNÝ  
K VÝPOČTU CHOVÁNÍ A DYNAMIKY OBLEČENÍ. MĚLI BYSTE TEDY POKUD MOŢNO 
SPECIFIKOVAT CO NEJMENŠÍ MNOŢSTVÍ POTŘEBNÝCH KOLIZNÍCH OBJEKTŦ. 
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Jakmile máte dokončeno nastavení kolizních objektŧ, klikněte na tlačítko OK pro potvrzení volby, 
nebo na tlačítko Cancel pro odchod bez nastavení kolizních objektŧ. 

Šipka vpravo nahoře ve skupině ovladačŧ Cloth zobrazuje aktuálně vybraný kolizní objekt. Kliknutím 
na tuto šipku otevřete rozbalovací menu, které umoţņuje výběr kteréhokoliv kolizního objektu scény 
pro modifikaci. 
 

ODSAZENÍ & HLOUBKA KOLIZE  COLLISION OFFSET & DEPTH (orig.233) 

Ovladače Collision depth a Collision offset jsou limitovány rozsahem od minima 0.1 cm po 
maximum 10 cm. 

Před nastavením těchto hodnot se ujistěte, ţe máte aktivovány poloţky Object vertex against cloth 
polygon a Object polygon against cloth polygon v dialogovém okně Simulator Settings (viz Krok 
1). Mŧţete také zkusit sníţit hodnotu Steps per frame ze základní 0.2 asi tak na 0.005. 

Reálný kus oblečení má dvě strany (rub & líc) a tloušťku. Prostorový model oblečení je tvořen 
polygony, které mají matematicky nulovou tloušťku. Ovladače Collision Depth a Collision Offset 
emulují tloušťku pomocí “vytlačení” oblečení dovnitř v závislosti na hodnotě Collision depth a vně 
v závislosti na hodnotě Collision offset. Tímto oblečení získává „tloušťku“ v součtu odsazení kolize + 
hloubky kolize. Kaţdý specifikovaný kolizní objekt kříţící se s tímto rozsahem bude povaţován za 
kolidující. 
 

KROK 3: SKUPINY OBLEČENÍ  STEP 3: CLOTH GROUPS (orig.234) 

Objekt, který je konvertován na oblečení, musí mít jednostranně napojené polygony bez trhlin. Jakmile 
máme vytvořen simulátor oblečení a objekt oblečení, dalším krokem je vytvoření skupin oblečení 
(skupin vertexŧ) uvnitř kaţdého objektu, které rozdělí objekt na oblasti (stejným zpŧsobem jako 
například rozdělení částí postavy na rŧzné materiálové skupiny). Výjimkou jsou ozdobné předměty 
jako knoflíky, spony pásku, atd., které mohou být samostatnými objekty (nepropojenými). Skupiny 
oblečení pouţívají vertexy namísto polygonŧ, to znamená, ţe paleta editoru skupin Group Editor 
pracuje v místnosti oblečení Cloth room ve vertexovém módu (jako protipól k polygonŧm). V místnosti 
oblečení Cloth room mŧţete konvertovat skupiny polygonŧ na vertexové skupiny pomocí kliknutí na 
na tlačítko Add Group, kterým otevřete rozbalovací seznam existujících skupin. Skupiny s názvy 
s příponou [P] jsou polygonové skupiny. Výběrem polygonové skupiny dojde k načtení všech vertexŧ 
náleţejících k dotčeným polygonŧm. Existují čtyři typy skupin, pouţitelné pro objekty oblečení: 

o Dynamic: Dynamické skupiny oblečení jsou simulovány pouţitím ovladačŧ Dynamics Controls 
(viz následující krok), které určují, jak se bude oblečení pohybovat, ohýbat, řasit, apod. za jeho 
pohybu (vlivem přitaţlivosti, síly větru, atd.), nebo pokud se bude pohybovat související 
figura/rekvizita (jako například balón pod kobercem nebo figura pod šaty). Mŧţete vytvářet 
vícenásobné dynamické skupiny pro kaţdý objekt oblečení a kaţdá dynamická skupina mŧţe 
obsahovat rŧzné nastavení dynamiky. Dynamické skupiny nemŧţete přímo animovat za pomoci 
normálního snímkování (keyframingu). V základním nastavení jsou objekty oblečení tvořeny 
s jednou základní dynamickou skupinou (_default_), zahrnující celý objekt. 

o Choreographed: Kaţdý objekt oblečení mŧţe mít jednu choreografickou skupinu. Tato skupina je 
automaticky vytvořena s prázdným obsahem při vytvoření objektu oblečení. Choreografické vertexy 
mohou následovat snímkový pohyb nebo mohou být vyřazeny ze simulace oblečení. 

o Constrained: Kaţdý objekt oblečení mŧţe mít jednu vázanou skupinu, která je automaticky 
vytvořena s prázdným obsahem při vytvoření objektu oblečení. Vázané vertexy jsou “přilepeny” 
k odpovídajícím polygonŧm povrchu podkladní figury. Toto činí vázené skupiny uţitečné pro 
komplexní části oblečení, které následují pohyb části postavy podkladní figury. Pokud například 
máte opasek na sukni, tento následuje pohyb bokŧ postavy. Pokud vertexy opasku neumístíte do 
vázané skupiny, simulátor oblečení mŧţe zpŧsobit pád oblečení (v závislosti na gravitaci) aţ do 
okamţiku, neţ dojde ke kontaktu sukně s postavou a pád se zastaví. Toto negarantuje, ţe opasek 
zŧstane umístěn správně okolo bokŧ. Pokud navíc opasek obsahuje komplexní geometrii, simulace 
bude probíhat pomalu. Svázání vertexŧ opasku udrţí opasek na bocích postavy a také zkracuje 
dobu simulace. 

o Decorations: Kaţdý objekt oblečení mŧţe mít dvě dekorativní skupiny (jednu “poddajnou” a jednu 
“nepoddajnou”). Tyto skupiny jsou automaticky vytvořeny s prázdným obsahem při vytvoření 
objektu oblečení. Tyto skupiny jsou animovány, pohybovány stejně jako podkladní oblečení se 
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pohybuje přes podkladní postavu. Dobrými kandidáty pro dekorativní vertexy jsou malé nebo tenké 
polygony, jako jsou kapsy, smyčky pásku, knoflíky, uzel na vázance, apod. Toto jsou obvyklé 
poloţky, které bývají umístěny na jiné skupině oblečení a mají jen pasivní pohyblivost, která buď 
následuje pohyb podkladní postavy, nebo jiné části oblečení. Kvŧli jejich malé velikosti nebo 
nepravidelnosti nemohou zpŧsobit problémy, pokud nenáleţí do základní skupiny. Dekorativní 
skupina obsahuje doplņky, které jsou geometricky separovány od modelu objektu oblečení. Jsou 
pro to dva dŧvody: 

o Pokud se dekorativní skupina dělí o vertexy s modelovou sítí oblečení, dekorativní vertexy 
nebudou simulovány. To zpŧsobí, ţe simulátor zachází s těmito oblastmi jako s hranicemi, coţ 
má za následek zvětšený pohyb těchto oblastí ve srovnání se sousedními částmi látky. 

o Připojené doplņky k modelové síti oblečení jsou často tvořeny komplexní sítí, kde jeden okraj je 
sdílen pomocí více neţ dvou polygonŧ. 

Dva typy dekorativních skupin jsou: 

o Soft: Objekty poddajné (soft) dekorativní skupiny se pohybují společně s podkladním oblečením 
a mohou se ohýbat stejně jako se ohýbá oblečení. Dobrým příkladem mŧţe být smyčka opasku. 

o Rigid: Objekty nepoddajné (rigid) dekorativní skupiny se pohybují společně s podkladním 
oblečením, ale neohýbají se. Dobrými příklady nepoddajné dekorace mohou být knoflíky nebo 
uzel na vázance. 

Pokud chcete aktuální objekt oblečení skládat z jednotlivých dynamických skupin, jste hotovi. 
Pokračujte krokem 4 (dále) pro nastavení dynamiky. Pokud si nicméně přejete vytvořit vícenásobné 
skupiny, mŧţete to udělat pomocí následujících tlačítek: 

o New Dynamic Group: Kliknutím na tlačítko New Dynamic Group otevřete okno New Dynamic 
Vertex Group Name. Zadejte název pro novou dynamickou skupinu a klikněte na tlačítko OK pro 
potvrzení nebo tlačítko Cancel pro zrušení. V základním nastavení se celý objet oblečení skládá 
z dynamické skupiny nazvané _default_. Všechny vertexy, které nejsou součástí ţádné další 
dynamické, vázané, choreografické nebo dekorativní skupiny, které jste vytvořili/editovali, zŧstavají 
v základní _default_ skupině. 

 POZNÁMKA 
PONĚVADŢ KAŢDÝ OBJEKT OBLEČENÍ MŦŢE OBSAHOVAT POUZE JEDNU 
CHOREOGRAFICKOU, VÁZANOU, ANEBO JEDNU PODDAJNOU & NEPODDAJNOU 
DEKORATIVNÍ SKUPINU, MŦŢETE DYNAMICKÝM SKUPINÁM POUZE ZADÁVAT JMÉNA. 

o Delete Dynamic Group: Kliknutím na tlačítko Delete Dynamic Group vymaţete aktuálně vybranou 
dynamickou skupinu. 

o Edit Dynamic Group: Kliknutím na tlačítko Edit Dynamic Group otevřete paletu editoru Group 
Editor, která umoţņuje přidávat nebo odstraņovat vertexy z aktuálně vybrané skupiny. Prosím 
navštivte téma “Editor skupin” na straně 125 pro informace o pouţití palety editoru skupin Group 
Editor. 

o Edit Choreographed Group: Kliknutím na tlačítko Edit Choreographed Group otevřete paletu 
editoru Group Editor, která umoţņuje přidávat nebo odstraņovat vertexy z aktuálně vybrané 
choreografické skupiny (_choreographed_). Prosím navštivte téma “Editor skupin” na straně 125 
pro informace o pouţití palety editoru skupin Group Editor. 

o Edit Constrained Group: Kliknutím na tlačítko Edit Constrained Group otevřete paletu editoru 
Group Editor, která umoţņuje přidávat nebo odstraņovat vertexy z aktuálně vybrané vázané 
skupiny (_constrained_). Prosím navštivte téma “Editor skupin” na straně 125 pro informace  
o pouţití palety editoru skupin Group Editor. 

o Edit Soft Decorative Group: Kliknutím na tlačítko Edit Soft Decorative Group otevřete paletu 
editoru Group Editor, která umoţņuje přidávat nebo odstraņovat vertexy z aktuálně vybrané 
poddajné dekorativní skupiny (_softDecorated_). Prosím navštivte téma “Editor skupin” na straně 
125 pro informace o pouţití palety editoru skupin Group Editor. 

o Edit Rigid Decorative Group: Kliknutím na tlačítko Edit Rigid Decorative Group otevřete paletu 
editoru Group Editor, která umoţņuje přidávat nebo odstraņovat vertexy z aktuálně vybrané 
nepoddajné dekorativní skupiny (_rigidDecorated_). Prosím navštivte téma “Editor skupin” na 
straně 125 pro informace o pouţití palety editoru skupin Group Editor. 
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Při práci se skupinami oblečení mějte na mysli následující: 

o Přidáním vertexŧ do aktuální skupiny dojde k jejich odebrání z jiných skupin. 

o Odstraněním vertexŧ ze základní default skupiny dojde k jejich přidání do skupiny choreografické. 

o Odstraněním vertexŧ z jakékoliv jiné skupiny dojde k jejich přidání do skupiny základní default. 

Šipka vpravo nahoře ve skupině ovladačŧ Dynamic Group zobrazuje aktuálně vybranou skupinu 
oblečení uvnitř aktuálně vybraného objektu oblečení. Kliknutím na tuto šipku otevřete rozbalovací 
menu, které umoţņuje výběr kterékoliv skupiny oblečení aktuálního objektu oblečení pro modifikaci. 
Pro práci na jiném objektu oblečení pouţijte rozbalovací menu nacházející se ve skupině ovladačŧ 
Cloth (krok 2). 
 

KROK 4: OVLADAČE DYNAMIKY OBLEČENÍ   
STEP 4: CLOTH DYNAMICS CONTROLS (orig.236) 

Jakmile máte vytvořeny a editovány skupiny oblečení, dalším krokem bude definování dynamických 
vlastností kaţdé dynamické skupiny aktuálně vybraného objektu oblečení. Dynamické vlastnosti 
určují, jakým zpŧsobem se budou dynamické skupiny pohybovat a chovat při výpočtu dynamiky. 
Ovladače dynamiky oblečení Cloth Dynamics Controls obsahují následující tlačítka: 

o Calculate Simulation: Kliknutím na tlačítko Calculate Simulation zahájíte výpočet všech simulací, 
včetně nastavení objektu, skupiny a dynamiky v aktuální simulaci a výpočet chování všech objektŧ 
oblečení v simulaci pro všechny specifikované snímky. Prosím podívejte se nahoru pro informace  
o specifikování snímkového rozsahu simulace oblečení. 

o Play Simulation: Kliknutím na tlačítko Play simulation dojde k přehrátí aktuálně vybrané simulace, 
které umoţņuje shlédnout chování oblečení v prŧběhu času. Pokud se Vám aktuální chování 
oblečení nelíbí, mŧţete provést úpravy nastavení místnosti oblečení Cloth room a vyzkoušet to 
znovu. 

o Clear Simulation: Kliknutím na tlačítko Clear Simulation dojde k vymazání všech uloţených dat 
aktuální simulace (jako jsou změny nastavení kolize, přidané/odstraněné objekty, editace skupin, 
změny nastavení ovladačŧ dynamiky, atd.), coţ umoţņuje specifikaci nové dynamiky a modifikace 
chování objektu oblečení. Pokud simulaci vyčistíte a spustíte přehrávání animace, uvidíte 
jednoduchou snímkovou animaci bez výpočtu simulace. 

Místnost oblečení Cloth room obsahuje následující ovladače dynamiky: 

o Fold Resistance: Parametr Fold Resistance specifikuje odpor proti mimorovinnému ohýbání 
(skládání). Zvýšením této hodnoty sníţíte schopnost oblečení ohýbat se. Měkké materiály jako 
hedvábí se ohýbají velmi snadno, a proto jim odpovídá nízká hodnota (1.0). V kontrastu na to se 
tvrdá kŧţe ohýbá špatně, a proto jí odpovídá vysoká hodnota nastavení parametru. 

o Shear Resistance: Parametr Shear Resistance nastavuje odpor oblečení proti rovinnému smyku 
nebo ohybu ze strany na stranu. Nízký odpor ve smyku dovoluje vytvářet trojúhelníky z látky 
(vznikají například při svěšení rohu pravoúhlého kusu látky) a zborcení látky směrem k sobě, proto 
je odpovídající hodnota do 50.0 nebo poblíţ. Vlna má nízký odpor ve smyku, zatímco kŧţe má 
hodnotu odporu vysokou. 

o Stretch Resistance: Parametr Stretch Resistance specifikuje odpor oblečení proti rovinnému 
ohybu (napínání). Mnoho oblečení je velmi odolných proti natahování, existují ale vyjímky jako 
nylon, který je velmi elastický. Základní hodnota 50.0 poskytuje docela docela velký odpor proti 
napínání, odpovídající bavlněným materiálŧm. Niţší hodnota mŧţe být vhodná pro napínavé 
materiály jako je Lycra. 

o Stretch Damping: Parametr Stretch Damping definuje vnitřní energetickou ztrátu (útlum), 
zpŧsobenou pohybem vláken látky navzájem proti sobě. Vyšší hodnota útlumu zpŧsobí, ţe 
oblečení ztrácí pohyb mnohem rychleji. Nadměrně vysoká hodnota vytvoří látku se vzhledem 
tekoucího sirupu a extrémně nízká hodnota mŧţe zpŧsobit nereálné chování látky. Hodnota od 
0.01 je vhodná pro většinu pouţití. 

o Cloth Density: Parametr Cloth Density definuje hmotnost na jednotku plochy – hustotu látky 
oblečení v gramech na centimetr čtvereční. Pokud si vezmete kus látky 1cm x 1cm a zváţíte jej, 
váha v gramech bude hodnotou pro nastavení tohoto parametru. Například hedvábí je velmi lehké, 
zatímco kŧţe je při srovnání velmi těţká. 
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o Cloth Self Friction: Parametr Cloth Self Friction nastavuje koeficient tření mezi jednou částí 
oblečení vŧči části druhé, nebo jak snadno se oblečení pohybuje samo po sobě. Vysoká hodnota 
zabrání oblečení pohybovat se po sobě. Například umělé hedvábí má velmi nízkou hodnotu odporu 
vzájemného tření, zatímco denim má hodnotu vysokou. 

o Static Friction: Parametr Static Friction nastavuje koeficient tření mezi oblečením a pevnými 
objekty. Toto je obdobou parametru Dynamic Friction kromě toho, ţe zde se jedná o sílu 
potřebnou pro uvedení stacionárního oblečení v kontaktu s pevným objektem do pohybu. Například 
nylon na povrchu hladkého plastu má velmi nízkou hodnotu statického tření, zatímco denim na 
dřevě má hodnotu vysokou. 

o Dynamic Friction: Parametr Dynamic Friction nastavuje koeficient tření mezi oblečením  
a pevnými objekty při pohybu oblečení. Posun kusu oblečení přes povrch tělesa vytváří tření. 
Hedvábí, pohybující se po kovovém povrchu má malý odpor, zatímco bavlna pohybující se po 
pokoţce, po brusném papíru nebo drsném dřevě má odpor vysoký. 

o Air Damping: Parametr Air Damping specifikuje odpor oblečení vŧči vzduchu při pohybu oblečení 
ve větru. Pevně tkaná látka má větší odpor neţ volně tkané materiály. Tento parametr nastavujte 
opatrně, protoţe nadměrné hodnoty zpŧsobí, ţe oblečení se chová nepředvídatelně. 

o Collision Friction: Označením políčka Collision Friction budou ignorovány parametry objektu 
oblečení Static Friction a Dynamic Friction, místo toho budou pouţity hodnoty stejných 
parametrŧ, které náleţí k vzájemným kolizím objektŧ. Ponecháním neoznačeného políčka budou 
aplikovány hodnoty nastavení dynamiky oblečení. 

o Reset: Kliknutím na tlačítko Reset dojde k resetování všech ovladačŧ dynamiky oblečení. 

Šipka vpravo nahoře ve skupině ovladačŧ Cloth Dynamic Controls zobrazuje aktuálně vybraný 
objekt oblečení. Pro změnu objektu oblečení pouţijte rozbalovací menu nacházející se ve skupině 
ovladačŧ Cloth (krok 2). 
 

PARAMETRY & VLASTNOSTI OBLEČENÍ  
CLOTH PARAMETERS & PROPERTIES (orig.238) 

Pro přístup k parametrŧm a vlastnostem objektu oblečení musíte nejdříve vybrat poţadovaný objekt 
oblečení. 

o Dynamické objekty oblečení mají stejné vlastnosti jako rekvizity (props). Prosím navštivte téma 
“Vlastnosti rekvizit” na straně 108 pro informace o vlastnostech rekvizit. 

o Dynamické oblečení má stejné parametry jako objekty praménkových vlasŧ. Prosím navštivte téma 
“Parametry vlasů” na straně 163 pro informace o parametrech objektŧ vlasŧ. 

 

ULOŢENÍ DYNAMICKÉHO OBLEČENÍ DO PALETY KNIHOVEN 
SAVING DYNAMIC CLOTH TO THE LIBRARY PALETTE (orig.238) 

Prosím navštivte téma “Přidání dynamického oblečení do palety knihoven” na straně 34 pro více 
informací o uloţení dynamického oblečení do palety knihoven Library. 
 

TVORBA REKVIZIT A MORPH TARGETŮ 
CREATING PROPS AND MORPH TARGETS (orig.239) 

Objekty oblečení mŧţete konvertovat na statické rekvizity nebo morph targety pro pouţití ve scénách, 
kde je poţadován vzhled oblečení bez poţadavku na jeho dynamiku. Pokud například vytváříte 
pomocí dynamického oblečení ubrus na stŧl, mŧţete pro pouţití v budoucích scénách dynamický 
objekt oblečení konvertovat na statickou rekvizitu. Pokud to uděláte, mŧţete později do scény načíst 
pouze nohy stolu, které jsou viditelné mezi podlahou a okrajem ubrusu, čímţ zachováte plný 
realismus při redukci celkového počtu polygonŧ scény. A co třeba duch, vytvořený pomocí prostěradla 
přehozeného přes postavu, konvertovaného na statickou rekvizitu, který mŧţe být schopen vytvoření 
pózy v místnosti nastavení Setup room? Moţnosti jsou skoro nekonečné! 

Pro vytvoření rekvizity: 

1. Vytvořte objekt oblečení jak je popsáno výše. 
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2. Pouţijte ovladače animace Animation controls k přesunu na poţadovaný snímek (tvar oblečení 
se mění kaţdým snímkem při přehrávání animace). 

3. Pouţijte nástroj Grouping k vytvoření nové rekvizity. Prosím navštivte téma “Editor skupin” na 
straně 125 pro informace o pouţití nástroje Grouping a palety editoru skupin Group Editor. 

Vytvořením rekvizity tímto zpŧsobem zachováte její tvar z doby jejího vytvoření, ale odstraníte tím 
všechny transformace (pozici, rotaci a měřítko). Pokud například smrštíte čtverec na obdélník, nová 
rekvizita bude vypadat jako čtverec deformovaný simulací oblečení. V tomto případě u nové rekvizity 
pouţijte opětovně transformace, které byly pŧvodně pouţity na originálním objektu oblečení, pro 
obnovené originálního vzhledu statické rekvizity. 

Pro vytvoření morph targetu následujte kroky 1 & 2 výše a potom vytvořte morph target stejně jako  
u jiné rekvizity/postavy, jak je popsáno v části “Tvorba a použití Morph Targetů” na straně 117. 
Následně mŧţete morph target aplikovat na rekvizitu. 

 POZNÁMKA 
MORPH TARGETY VYTVOŘENÉ TÍMTO ZPŦSOBEM FUNGUJÍ PŘESNĚ STEJNÝM ZPŦSOBEM 
JAKO OSTATNÍ MORPH TARGETY, TO ZNAMENÁ, ŢE ZTRÁCÍ VEŠKERÝ DYNAMICKÝ POHYB. 

Rekvizity oblečení mŧţete také exportovat podle libosti jako ostatní objekty scény. Exportované 
objekty oblečení přinášejí statické síťové objekty ve zvoleném exportním formátu. Toto mŧţete udělat 
po následování krokŧ 1 & 2 výše a následným exportem objektu tak, jak je popsáno v části “Export” na 
straně 190. 
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Kapitola 20: Místnost nastavení THE SETUP ROOM (orig. 240) 

Poser obsahuje grafickou místnost nastavení Setup room, která byla uvedena současně s vydáním 
doplņku Pro Pack pro Poser 4. Tato místnost umoţņuje vytvářet/modifikovat figury Poseru 
v kompletně grafickém prostředí. 
 

TEXTOVÁ VS. GRAFICKÁ TVORBA FIGUR 
TEXT-BASED VS. GRAPHICAL FIGURE CREATION (orig.240) 

Před vydáním doplņku Pro Pack pro Poser 4 pouţívali tvŧrci figur na textu zaloţenou metodu 
konvertování OBJ modelŧ, které byly přeskupovány do specificky pojmenovaných částí postavy. 
Poser 7 stále podporuje tuto metodu tvorby figur, nicméně grafická místnost nastavení Setup room 
mŧţe ušetřit 90% času pro tvorbu figury. 

Tvŧrci figur, kteří se přejí pouţít pro tvorbu figur Poseru textovou metodu, mohou nastudovat 
elektronický Poser 7 Tutorial Manual, který detailně popisuje textovou metodu tvorby figur. Tento 
dokument je ve formátu Adobe Acrobat (PDF) a je uloţen ve sloţce Documentation folder na 
distribučním Poser 7 DVD. 
 

O MÍSTNOSTI NASTAVENÍ  ABOUT THE SETUP ROOM (orig.240) 

Místnost nastavení Setup room je jednou z nejsilnějších funkcí Poseru 7. Umoţņuje modifikovat 
existující rekvizity a figury, nebo dokonce vytvářet vlastní pro pouţití v Poseru 7. Pouhý vzhled figury 
nemá ţádný vliv na to, jak budou fungovat uvnitř Poseru 7; stejně jako v reálném světě, artikulace  
a animace závisí na dvou faktorech: 

o Na základní kostře figury (nazývané kostěnou strukturou bone structure). Kostěná struktura 
určuje hierarchii a pozici kloubŧ joints. 

o Na zpŧsobu, jakým jsou polygony figury (hrubý ekvivalent kŧţe a svalstva) seskupeny a napojeny 
na kosti. 

 POZNÁMKA 
FIGURY NEMUSÍ BÝT ANTROPOMORFNÍ (VE TVARU LIDSKÉ BYTOSTI). 

Existují tři zpŧsoby tvorby figur: 

o pouţití souborŧ hierarchie v kombinaci s externím modelem 

o pouţití palety hierarchie pro kombinaci rekvizit společně do formy figury 

o importováním geometrie a pouţitím místnosti nastavení Setup room 

Místnost nastavení Setup room umoţņuje tvorbu kloubŧ, hierarchií, skupin a IK vazeb. 

 POZNÁMKA 
SETUP ROOM JE EXTRÉMNĚ MOCNÝ NÁSTROJ, KTERÝM MŦŢETE PERMANENTNĚ 
MODIFIKOVAT FIGURY, VČETNĚ TĚCH ORIGINÁLNÍCH, KTERÉ JSOU SOUČÁSTÍ INSTALACE 
POSERU 7. VŢDY SI FIGURY ULOŢTE DO PALETY KNIHOVEN LIBRARY KVŦLI OCHRANĚ 
PROTI NEÚMYSLNĚMU POŠKOZENÍ EXISTUJÍCÍCH FIGUR A PRO UMOŢNĚNÍ NÁVRATU  
K PŘEDCHOZÍMU NASTAVENÍ FIGUR V PŘÍPADĚ NUTNOSTI. TOTO VÁM TAKÉ POMŦŢE 
ORGANIZOVANÉ UDRŢOVÁNÍ FIGUR A JEJICH SNADNĚJŠÍ NALEZENÍ. 

 POZNÁMKA 
VYVARUJTE SE ZTRÁCENÍ VAŠÍ PRÁCE! UKLÁDEJTE SVOU PRÁCI ČASTO A EVENTUÁLNĚ DO 
RŦZNÝCH SOUBORŦ PRO PŘÍPAD NARAŢENÍ NA PROBLÉMY. 

 

POSTUP NASTAVENÍ FIGURY  THE FIGURE SETUP PROCESS (orig.241) 

Obecný postup tvorby/modifikace figury v místnosti nastavení Setup room je následující: 

1. Vytvořte geometrii Vaší nové figury v oblíbené 3D modelovací aplikaci a importujte ji jako rekvizitu 
za pouţití příkazu File>Import. Jakmile máte import kompletní, vstupte do místnosti nastavení 
Setup room. 
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2. Vytvořte anebo modifikujte kostěnou strukturu nebo kostru figury. Stejně jako reálná kostra, kostra 
figury zastává mnoţství dŧleţitých funkcí. Mŧţete importovat kostru z jiné figury, nebo vytvořit 
kostru figury od základu. 

3. Umístěte kostru a klouby tak, aby odpovídaly Vaší figuře. Tento krok je kritický pro zajištění, ţe 
figura se bude ohýbat přesně tak, jak je to moţné. 

4. “Umístěte maso na kosti” pomocí seskupení rŧzných částí postavy a přiřazením těchto skupin  
k odpovídajícím kostím. 

5. Jemně dolaďte klouby figury a vystupte z místnosti nastavení Setup room pro otestování nové 
figury a dokončení procesu tvorby/modifikace. 

6. Přiřaďte IK vazby za pouţití editoru hierarchie Hierarchy Editor, nastavte podporované IK úhly  
a limity kloubŧ a tyto informace uloţte. 

7. V případě potřeby znovu přenastavte klouby figury a hotovou figuru nakonec uloţte do palety 
knihoven Library. 

Skutečný proces obsahuje velký počet detailních krokŧ, které si vysvětlíme v této kapitole. 

 POZNÁMKA 
VYSTOUPENÍ Z MÍSTNOSTI NASTAVENÍ SETUP ROOM BĚHEM PROCESU TVORBY FIGURY 
MŦŢE ZAPŘÍČINIT ZTRÁTU POSLEDNÍCH ZMĚN. PROTO SE PŘI OPOUŠTĚNÍ MÍSTNOSTI 
NASTAVENÍ ZOBRAZÍ UPOZORNĚNÍ NA MOŢNOU ZTRÁTU DAT. 
 

UŢIVATELSKÉ ROZHRANÍ MÍSTNOSTI NASTAVENÍ 
THE SETUP ROOM INTERFACE (orig.242) 

Uţivatelské rozhraní místnosti nastavení Setup room bylo designováno tak, aby bylo virtuálně 
identické s místností póz Pose room a stejně tak funkční, i kdyţ s několika menšími změnami: 

o Nemŧţete nastavovat pózu figuře, kterou vytváříte v místnosti nastavení Setup room. Místo toho 
je v pracovním okně Document zobrazena struktura kostí figury (pokud nějaká existuje), která 
umoţņuje nastavení pozice kaţdé kosti. 

o Pokud se nacházíte v místnosti nastavení Setup room a načtete figuru z palety knihoven Library, 
dojde k načtení pouze systému kostí zvolené figury, který bude aplikován na aktuální objekt. 
Geometrie se mění při přepínání mezi místnostmi póz a nastavení. Zatímco v místnosti pózy Pose 
room se s kaţdou částí těla zachází jako se samostatným geometrickým objektem, v místnosti 
nastavení Setup room jsou všechny části těla sloučeny do jednoho objektu pro zjednodušení 
operací seskupování a spojování. Kliknutím na tlačítko Create New Figure v paletě knihoven 
Library načtete kostěnou strukturu vybrané figury  pro modifikaci a pouţití na figuře, kterou tvoříte 
nebo modifikujete. Pro načtení kostí mŧţete také na figuru poklikat. 

Další část vysvětlí proces nastavení figury v detailu. 
 

KROK 1: IMPORT/USPOŘÁDÁNÍ GEOMETRIE 
STEP 1: IMPORTING/ARRANGING GEOMETRIES (orig.242) 

Proces tvorby figury začíná vloţením rekvizit(y), ze kterých si přejete figuru sloţit. Toto udělejte 
přidáním rekvizit z palety knihoven Library anebo importem geometrických objektŧ (statických 
síťových objektŧ nebo rekvizit). Pokud pouţijete více neţ jednu rekvizitu, ujistěte se, ţe před 
zahájením konverzního procesu figury máte všechny rekvizity uspořádány na jejich konečných 
pozicich. Prosím navštivte téma “Import” na straně 186 pro informace o importu geometrie do Poseru 
7. 
 

KROK 2: NAČTENÍ ANEBO VYTVOŘENÍ KOSTĚNÉ STRUKTURY 
STEP 2: LOADING AND/OR CREATING BONE STRUCTURES (orig.242) 

Tato část popisuje, co je to kostěná struktura a co dělá a jak se vytváří/modifikuje kostěná struktura 
importované geometrie nebo figury. 
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O KOSTĚNÝCH STRUKTURÁCH  ABOUT BONE STRUCTURES (orig.242) 

Kaţdá figura Poseru 7 obsahuje hierarchii a informace o kloubech, které dohromady určují, jak se 
bude figura chovat při nastavování pózy. Místnost nastavení Setup room vyjadřuje tyto informace 
formou kostěné struktury, neboli kostry, která je určena kaţdé figuře. Kostry jsou rozhodujícími částmi 
figur, protoţe tyto definují kam a jak se bude figura ohýbat, stejně jako Vaše vlastní kosti definují jak  
a kam se mŧţete ohýbat. Kostry poskytují následující informace o kaţdé figuře: 

o Definice hierarchie figury: Kostra definuje mateřské vazby figury parent/child. Prosím nastudujte 
Poser 7 Tutorial Manual, téma “More 3D Elements: Hierarchy” pro informace o hierarchii uvnitř 
Poseru 7. 

o Pozice kloubů: Stejně jako Vaše vlastní kostra, figura se bude ohýbat pouze v kloubech, které se 
nacházejí na místech styku koncŧ kostí. 

o Limity pohybu figury: Určitě jste si vědomi, ţe kaţdý kloub Vašeho těla má za normálních okolností 
limitovaný rozsah pohybu. Například Váš loket se ohýbá pouze v jednom směru a po narovnání 
ruky se nemŧţe ohýbat dále, Vaše zápěstí se mŧţe pohybovat v libovolném směru uvnitř úzkého 
kuţele a tak podobně. Mŧţete definovat limity pro kterýkoliv kloub figury. Tyto limity zabraņují 
vytvoření nepřirozeně vyhlíţející pózy, kříţení jedné části figury s jinou, apod. 

o Rozlišení figury: Mnoho kostí koster Vašich 
figur má rŧzný stupeņ flexibility (rozlišení). 
Například figura Poser 2 Default Guy 
umoţņuje ohybání ramen, lokte a zápěstí, 
ale nemá pohyblivé prsty. V kontrastu na to 
figura Poser 4 Casual Man umoţņuje 
nastavit přesnou pozici kaţdéno prstu. 
Tento obrázek ukazuje pravou ruku figury 
Default Guy a podkladní kostěné struktury 
na straně levé a pravou ruku figury Casual Man včetně kostěné struktury na straně pravé. 
Všimněte si, ţe Default Guy má celu ruku definovánu pouze jdnou kostí, zatímco Casual Man má 
mnohem realističtější kostěnou strukturu spolu s dlaní a úplně členěné klouby prstŧ. 

 POZNÁMKA 
KOSTI JSOU ZOBRAZENY JAKO SVĚTLE ŠEDÉ TROJÚHELNÍKY SE ZÁKLADNOU SMĚŘUJÍCÍ  
K JEJICH NADŘAZENÉMU PARENTS PRVKU A SE ŠPIČKOU SMĚŘUJÍCÍ K PRVKU 
PODŘÍZENÉMU CHILDREN. VYBRANÉ KOSTI JSOU ZOBRAZENY ČERVENĚ. 
 

O TVORBĚ KOSTĚNÉHO SYSTÉMU  ABOUT CREATING A BONE SYSTEM (orig.243) 

Existují dva základní scénáře pro tvorbu a editaci kostěného systému: 

o Modifikace existující figury: Pokud při vstupu do místnosti nastavení Setup room máte načtenu 
nějakou figuru, dojde k automatickému načtení kostěného systému aktuální figury a oddělené části 
postavy budou sloučeny do jednoho objektu pro jednodušší manipulaci v místnosti nastavení. 

o Vytvoření nové figury: Do místnosti nastavení Setup room mŧţete vstoupit s vybranou 
geometrií (rekvizitou). Následně mŧţete načíst kostěnou strukturu z jiné existující figury 
pomocí výběru poţadované figury v paletě knihoven Library a kliknutím na tlačítko 
Change Figure. Nebo mŧţete pouţít nástroj Bone k vytvoření zcela individuálního kostěného 
systému. Tyto metody mŧţete také kombinovat pomocí načtení kostěné struktury a následného 
pouţití nástroje Bone k provedení modifikací. Nástroj Bone se objeví v pracovním 
prostoru místnosti nastavení Setup room mezi ostatními editačními nástroji Editing tools.  

Následující části popisují výběr kostěného systému pro Vaší geometrii a pouţití nástroje Bone. 
 

VÝBĚR VHODNÉ STRUKTURY  SELECTING THE PROPER STRUCTURE (orig.244) 

Nejrychlejším zpŧsobem definice kostěné struktury u nové figury je načtení kostěné struktury  
z jiné figury, která se co nejvíce podobá Vašemu aktuálnímu objektu. Například jednoduchá geometrie 
zobrazena dále nevyţaduje kostěnou strukturu s vysokým rozlišením, protoţe nemá články prstŧ  
a jiné detailní funkce. Pokud vytváříte figuru zvířete, měli byste nepochybně načíst kostěnou strukturu 
zvířecí figury. Základní myšlenkou je minimalizovat mnoţství práce, kterou musíte vykonat. 
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Na níţe uvedeném obrázku pozice kostí neodpovídá korespondujícím částem geometrie. Rozmístění 
kostí bude detailně popsáno dále a napraví tuto situaci. 
 

VKLÁDÁNÍ & MAZÁNÍ KOSTÍ   
INSERTING & DELETING BONES (orig.244) 

Nástroj Bone umoţņuje vytváření kostí, buď uvnitř existující 
kostěné struktury, nebo nově od základu. Pro vytvoření kosti 
klikněte na bod, kde chcete mít umístěn počátek kosti (base)  
a táhněte tam, kde chcete mít konec kosti (tip). Jemné doladění 
pozice a parametrŧ kosti mŧţete udělat později, tudíţ si 
nemusíte dělat starosti a být příliš moc perfektní. 

Nové kosti jsou vytvořeny jako podřízené children těch dříve 
vybraných nebo vytvořených kostí. Mŧţete vybrat dříve 
vyrobenou kost (nebo jakoukoliv kost kostry) a následně vloţit 

novou podřízenou kost pomocí jednoduchého kliknutí na 
kost, kterou si přejete pouţít jako nadřízenou parent a 
dále postupovat podle procedury z předchozího odstavce. 
Obrázek ukazuje novou kost vloţenou mezi boky (parent) 
a stehno (child). 

Pro vymazání kosti jednoduše kost vyberte a stiskněte 
klávesu [DEL]. 
 

NASTAVENÍ POZICE KOSTÍ 
POSITIONING THE BONES (orig.244) 

Nyní, kdyţ máte vytvořenu kostěnou strukturu odpovídající 
Vaší geometrii, dalším krokem bude 
srovnaní kostí s geometrií. Pokud 
nemáte kostěnou strukturu dokonale 
srovnánu s geometrií postavy, je 
pravděpodobné, ţe základní pozice kostí 
pokřiví geometrii postavy, jak je ukázáno 
na obrázku vpravo. Figura nalevo 
ilustruje efekt, který zpŧsobí kostěná 
struktura, která pozičně neodpovídá 
geometrii postavy, zatímco figura 
napravo demonstruje správné chování 
figury.  

Nastavovat pozici kostí mŧţete pomocí 
některé ze tří metod: 

o Výběrem jednoho z dostupných editačních nástrojŧ Editing tools (Rotate, Twist, Translate/Pull, 
Translate In/Out nebo Scale) a nastavení pozice pomocí myši. 

o Pouţitím palety editoru kloubŧ Joint Editor pro precizní nastavení pozice kloubŧ. 

o Pouţitím ovladače symetrie Symmetry (viz téma “Symetrie” na straně 197) pro nastavení pozice 
kostí na opačné straně figury. 

Při práci na nastavování pozice kostí Vaší geometrie budete pravděpodobně pouţívat kombinaci 
všech tří metod. V následujících částech budou detailně popsány všechny tyto metody. 
 

Pomocí myši  WITH THE MOUSE (orig.245) 

Pozici kostí mŧţete pomocí myši nastavovat jedním ze dvou zpŧsobŧ: 

o Výběrem poţadovaného editačního nástroje Editing tool a následným kliknutím na střed kosti 
pouţijete zvolený nástroj k modifikaci pozice vybrané kosti, současně se všemi podřízenými 
children prvky a s veškerým nastavením aktuální kosti a všech podřízených prvkŧ (včetně 
sférických zón prolnutí spherical falloff zones). Prosím navštivte téma “Sférické zóny prolnutí” na 
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straně 135 pro vysvětlení funkce sférických zón prolnutí. Toto je preferovaná metoda pro hrubé 
přizpŧsobení kostí ke geometrii. 

o Kliknutím do blízkosti počátku nebo konce zvolené kosti umoţníte přesun pouze 
vybraného koncového bodu kosti bez ohledu na vybraný editační nástroj 
Editing tool. Ukazatel myši se změní na kulaté okénko po výběru kosti  
a umístění ukazatele do blízkosti počátku nebo konce vybrané kosti, jak je 
zobrazeno vedle. 

Pokud editujete koncové body kostí, nastavení kloubŧ, stejně jako nastavení 
sférických zón prolnutí, nebudou přizpŧsobeny. Prosím navštivte téma “Sférické 
zóny prolnutí” na straně 135 pro vysvětlení funkce sférických zón prolnutí. Tato metoda je dobrá 
k provedení drobných nastavení po předchozím umístění kostí do blízkosti jejich finální pozice. 

 POZNÁMKA 
POKUD PRO NASTAVOVÁNÍ POZICE KOSTÍ POUŢÍVÁTE MYŠ, MĚLI BYSTE POUŢÍT JEDNU  
Z ORTOGRAFICKÝCH KAMER (LEFT, RIGHT, TOP, BOTTOM, FRONT, BACK) PRO ZAJIŠTĚNÍ 
JEJICH PŘESUNU JEDNU CHVÍLI POUZE V JEDNÉ ROVINĚ. ALTERNATIVNĚ MŦŢETE POUŢÍT 
ROZDĚLENÍ PRACOVNÍHO OKNA NA VÍCE ČÁSTÍ (POHLEDŦ) PRO NASTAVENÍ POZICE KOSTÍ 
VE 3D PROSTORU. 
 

Pomocí palety editoru kloubů  WITH THE JOINT EDITOR PALETTE (orig.246) 

Kromě (nebo namísto) pouţití myši k nastavení pozice kostí, mŧţete pouţít paletu editoru kloubŧ 
Joint Parameters a vybrat kost, kterou si přejete editovat. Prosím navštivte téma “Editor kloubů” na 
straně 132 pro kompletní informace o paletě editoru kloubŧ Joint Editor. 
 

Pouţitím symetrie  USING SYMMETRY (orig.246) 

V případě ţe importovaná geometrie vypadá symetricky, mŧţete drasticky omezit mnoţství času 
potřebného k nastavení pozice kostí tím, ţe nastavíte pozici kostí na jedné polovině geometrie  
a následně pouţijete nástroj Symmetry pro automatické nastavení pozice zbývajících kostí. Prosím 
navštivte téma “Symetrie” na straně 197 pro informace o pouţití nástroje symetrie Symmetry.  

 POZNÁMKA 
NÁSTROJ SYMMETRY FUNGUJE NEJLÉPE U RUKOU, NOHOU A U TRUPU FUNGUJE POUZE 
TEHDY, POKUD KOSTI V TÉTO ČÁSTI POSTAVY BUDOU POJMENOVÁNY A SESKUPENY TAK, 
ABY NÁLEŢELY KE SROVNATELNÝM ČÁSTEM GEOMETRIE. POKUD NAČTETE EXISTUJÍCÍ 
KOSTĚNOU STRUKTURU PRO POUŢITÍ S AKTUÁLNÍ GEOMETRIÍ, KOSTI BUDOU JIŢ 
POJMENOVÁNY ZA VÁS. 

Pokud zvolíte funkci symetrie, zobrazí se dialogové okno s dotazem, zda si přejete kopírovat také 
nastavení zón kloubŧ. Kliknutím na tlačítko Yes aplikujete symetrii na kostěnou strukturu. 
 

KROK 3: POJMENOVÁNÍ KOSTÍ  STEP 3: NAMING THE BONES (orig.246) 

Poklikáním na kost se otevře palety vlastností Properties: 

Paleta vlastností Properties umoţņuje modifikaci následujícího nastavení: 

o Internal Name: Interní pojmenování kostí mŧţete v místnosti nastavení Setup room modifikovat 
zadáním poţadovaného jména do políčka Internal Name. Poser 7 pouţívá interní pojmenování 
pro vyhledávání skupin polygonŧ s odpovídajícím pojmenováním. Nejlépe je začínat práci na 
tvorbě figury s existující kostěnou strukturou, protoţe budete začínat se sestavou kostí, které jiţ 
mají standardní interní pojmenování. Samozřejmě mŧţete vytvářet figury s uţivatelskýmí interními 
jmény a jmény skupin; nicméně proces tvorby bude mnohem sloţitější, protoţe budete muset 
trasovat interní jména a korespondující části kostry a geometrie. 

o Name: Do políčka Name mŧţete zadat poţadované externí pojmenování, které se pouţívá pro 
Vaše vlastní označení prvku. Mŧţete pouţít jakékoliv jméno, které si přejete. Toto mŧţe být 
uţitečné, pokud pracujete v odlišných jazycích. 

 POZNÁMKA 
VŠECHNY OSTATNÍ ZOBRAZENÉ POLOŢKY NEMAJÍ ŢÁDNÝ EFEKT NA KOSTI A MOHOU BÝT 
TEDY IGNOROVÁNY. 
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KROK 4: PŘIPOJENÍ KOSTÍ K ČÁSTEM GEOMETRIE 

STEP 4: ATTACHING BONES TO GEOMETRY PARTS (orig.247) 

V této části procesu tvorby postavy v místnosti nastavení Setup room budeme přidruţovat (skupiny) 
kostí s částmi geometrie, čímţ umoţníme geometrii ohýbání a pohyb. Je dŧleţité, abyste věnovali 
velkou péči prŧběhu tohoto kroku, aby se Vaše nová figura ohýbala správně. 

Vaše geometrie obsahuje velký počet polygonŧ, které společně tvoří její celkový tvar. V tomto bodě 
Poser 7 zná kostru včetně kloubŧ a hierarchické vazby parents a children. Zná, jaký má pohyb kosti 
vliv na prvky podřízené children a na prvky nadřízené parent, také zná, jak by se kaţdý kloub měl 
chovat. Poser 7 nicméně zatím neví, které polygony by se měly pohybovat při daném pohybu kostry. 
Po umoţnění ohybu geometrie musíte zkombinovat logické podskupiny polygonŧ tvořících geometrii  
a seskupit kaţdou podskupinu s odpovídající kostí. 

Měli byste být pečliví v tom, abyste se ujistili, ţe správné polygony jsou přiřazeny ke správným kostím, 
tj., ţepravé rameno se bude pohybovat tehdy, kdyţ se bude pohybovat pravá ramenní kost,  
a podobně. Je moţné přiřadit jakýkoliv polygon k jakékoliv kosti. Mŧţete například polygony z prostoru 
lýtka seskupit s kostí z krku. S nějakou kostí z kostry mŧţete dokonce seskupit náhodné roztroušené 
polygony z jakékoliv části geometrie. Zatímco si mŧţete přát toho zhotovit z experimentálních nebo 
uměleckých dŧvodŧ, tato příručka bude předpokládat, ţe se z geometrie a kostry pokoušíte vytvořit 
realistickou figuru. 

Nyní, kdyţ je kostra kompletní, je vhodné pohlíţet na kaţdou kost jako na část těla. Pro kaţdou 
takovou část těla, musí existovat identicky pojmenovaná skupina polygonŧ na geometrii. Kaţdý  
z kloubŧ přiměje seskupené polygony k tomu, aby se ohýbaly tam, kde se stýkají nadřazené parent  
a podřízení children skupiny. Poser 7 pozná, které polygony se mají ohýbat, pomocí porovnání 
interního pojmenování kosti, která je pohybována, s interním pojmenováním skupiny polygonŧ. 

 POZNÁMKA 
POKUD SESTAVUJETE V MÍSTNOSTI NASTAVENÍ SETUP ROOM EXISTUJÍCÍ FIGURU, 
POTŘEBNÉ SKUPINY POSTAVY BUDOU JIŢ EXISTOVAT A MOHOU BÝT JIŢ ŘÁDNĚ 
NASTAVENY. 

Pro tvorbu skupin zvolte nástroj Grouping, který otevře paletu editoru skupin Group Editor. 
 

POŢADAVKY  REQUIREMENTS (orig.247) 

Jak je vysvětleno v části “Import 3D objektů” na straně 188, importovaná geometrie nemŧţe mít 
překrývající se nebo duplicitní polygony a jestli jste vytvořili skupiny při tvorbě geometrie, polygony 
v geometrii nemohou v jeden čas náleţet do více neţ jedné skupiny. 

Místnost nastavení Setup room umoţņuje tvorbu figur z jedné geometrie rozdělené na skupiny 
polygonŧ. Toto je doporučovaná metoda. 
 

TVOŘENÍ SKUPIN  GROUPING (orig.248) 

Prosím navštivte téma “Editor skupin” na straně 125 pro informace o pouţití nástroje Grouping  
a palety editoru skupin Group Editor. 
 

KROK 5:  PŘIŘAZENÍ POŘADÍ ROTACE  
STEP 5: ASSIGNING ROTATION ORDERS (orig.248) 

Máte nastaveny pozice kostí a vytvořeny skupiny. Vaše dříve statická geometrie oţívá! Tento krok 
mŧţete udělat, pokud předtím vytvoříte a definujete klouby; nicméně zde v procesu tvorby figury 
mŧţete opustit místnost nastavení Setup room, abyste viděli, jak změny nastavení pořadí rotace 
ovlivní vzhled a pohyb figury. Prosím navštivte téma “Pořadí rotace” na straně 136 pro informace  
o nastavení pořadí rotace kloubŧ. 
 

KROK 6: DOLADĚNÍ KLOUBŮ  STEP 6: FINE-TUNING JOINTS (orig.248) 

V tuto chvíli se mŧţeme vrátit zpět a doladit některé klouby, abyste chování figury vytvořili přesně tak, 
jak si přejete. Toto uděláte nástrojem Bone anebo pomocí palety editoru kloubŧ Joint Editor, jak je 
popsáno v části “Editor kloubů” na straně 132. 
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Pamatujte na to, ţe ohyb v kloubu nastává pouze mezi objektem a jeho nadřazeným parent prvkem. 
Ohyb nemá vliv na podřízené prvky, nebo na vyšší nadřazené prvky v hierarchii. Mějte to určitě na 
mysli při nastavování kloubŧ. Kromě toho, pokud máte části postavy, které jsou symetrické zleva 
doprava a jsou pojmenovány podle konvencí na začátku s písmenem “r” pro pravou stranu postavy  
a “l” pro levou stranu postavy, mŧţete automaticky kopírovat zóny kloubŧ za pouţití příkazu symetrie, 
popsaného v části “Symetrie” na straně 197. Tímto mŧţete ušetřit čas a úsilí při nastavování kloubŧ  
a také zajistit, ţe jedna strana figury se bude chovat úplně stejně jako strana druhá. 
 

KROK 7: TESTOVÁNÍ VAŠÍ FIGURY  STEP 7: TESTING YOUR FIGURE (orig.248) 

V tomto momentě práce končí. Vrátíme se nyní do místnosti pózy Pose room a u nové figury 
nastavíme prŧběţnou chŧzi. Mŧţete pouţít vícenásobný pohled pomocí rozdělení pracovního okna  
a ovladačŧ kamery Camera controls tak, abyste figuru viděli ze všech úhlŧ a zjistili, zda je výsledek 
podle očekávání. Pokud bude nutné provést nějaká přenastavení, mŧţete se kdykoliv vrátit do 
místnosti nastavení Setup room a figuru dále zdokonalit. Gratulujeme: Vaše pouze statická rekvizita 
je nyní pohyblivou figurou Poseru 7! 
 

KROK 8: PŘIŘAZENÍ IK VAZEB  STEP 8: ASSIGNING IK CHAINS (orig.248) 

Abyste u nové figury mohli pouţívat inverzní kinematiku IK, budete muset vytvořit alespoņ jednu 
vazbu inverzní kinematiky pomocí editoru hierarchie Hierarchy Editor, jak je popsáno v části “Editor 
hierarchie” na straně 129. 

 POZNÁMKA 
HIERARCHII PARENT/CHILD VYTVÁŘÍTE U VAŠÍ FIGURY PŘI TVORBĚ A EDITACI KOSTĚNÉ 
STRUKTURY. EDITOR HIERARCHIE U VAŠÍ FIGURY PŘEDVEDE VŠECHNY JEJÍ FUNKCE. 
 

KROK 9: INVERZNÍ KINEMATIKA  STEP 9: INVERSE KINEMATICS (orig.249) 

Pokud si přejete přidat Vaší figuře IK schopnosti, musíte přidat IK svazky, jak je popsáno v části 
“Tvorba svazků IK ” na straně 131. 
 

KROK 10: NASTAVENÍ & ULOŢENÍ PODPOROVANÝCH IK ÚHLŮ 
STEP 10: SETTING & MEMORIZING FAVORED IK ANGLES (orig.249) 

Inverzní kinematika Poseru 7 pracuje na základě současné rotace částí postavy. U figury musí být 
nastaveny řádné IK úhly, aby inverzní kinematika pracovala předvídatelně. Nastavené hodnoty rotace 
kloubŧ pomáhají IK logice poznat, kterým směrem se budou některé klouby ohýbat a ovlivņovat funkci 
IK během pohybu figury. Nastavení a uloţení podporovaných IK úhlŧ je tedy dŧleţité. 

Před uloţením základních pozic všech částí postavy, byste měli vyzkoušet ohyb všech částí postavy 
spojených IK vazbami pro ověření jejich přirozeného směru ohybu. Například stojící postava má 
ohnuta stehna mírně dopředu a směrem ven od svislice a její holeně jsou ohnuty mírně dozadu  
a dovnitř. 

Pro nastavení podporovaných IK úhlŧ: 

1. Deaktivujte dotčené IK svazky. 

2. Nastavte pozici kaţdé části postavy ve svazku pomocí mírného ohnutí o několik stupņŧ ve směru, 
kterým se budou pohybovat při aplikaci IK. 

3. Uloţte nastavené úhly částí postavy, nebo celé figury pomocí příkazu Edit>Memorize>Element, 
nebo Edit>Memorize>Figure. 

4. Aktivujte dotčené IK svazky. 

Prosím navštivte téma “Inverzní kinematika (IK)” na straně 69 pro informace o funkci inverzní 
kinematiky Poseru 7. 
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KROK 11: NASTAVENÍ LIMITŮ KLOUBU   
STEP 11: SETTING JOINT LIMITS (orig.249) 

Jak určitě dobře víte, kaţdý kloub Vašeho těla má limity svého pohybu. Například nemŧţete ohnout 
Vaši ruku v lokti za bod, kdy je ruka napřímena. Dále není moţné, aby se některá část postavy vnořila 
do jiné části. Nemŧţete jednoduše prostrčit ruku hrudníkem. Poser 7 umoţņuje nastavení limitŧ 
kaţdého kloubu k napodobení přirozených limitŧ, které zabraņují vytvoření nepřirozených póz. Navíc 
mŧţete nastavit limity, ve kterých mŧţe být měněna velikost nebo zúţení části postavy a moţná  
i dalších poloţek v závislosti na části postavy. 

Pro nastavení limitŧ části postavy jednoduše tuto část vyberte a následně poklikejte na kterýkoliv 
otočný ovladač v paletě parametrŧ Parameters pro otevření dialogového okna Edit Parameter, ve 
kterém mŧţete nastavit limity zvoleného parametru. Prosím navštivte téma “ Editace otočných 
ovladačů parametrů ” na straně 78 pro informace o nastavení limitŧ parametrŧ. 
 

KROK 12: DOKONČENÍ NOVÉ FIGURY 
STEP 12: FINALIZING YOUR NEW FIGURE (orig.250) 

V tomto bodě máte vytvořenou a doladěnou novou figuru Poseru 7. Z technického hlediska je proces 
tvorby figury kompletní. Pokud si přejete, mŧţete přidat materiály a textury, provést dodatečné úpravy 
a cokoli co potřebujete k tomu, abyste povaţovali projekt za dokončený. 
 

KROK 13: UCHOVÁNÍ DO PAMĚTI A ULOŢENÍ NOVÉ FIGURY 
STEP 13: MEMORIZING AND SAVING YOUR NEW FIGURE (orig.250) 

Během tvorby figury je vhodné ji ukládat. V případě, ţe není ještě hotová, určitě ji uchovejte pomocí 
příkazu Edit>Memorize>Figure. Po dokončení ji určitě uloţte do palety knihoven Library. Figuru 
mŧţete uloţit do existující podkategorie, nebo si vytvořit vlastní. 
 

VYMAZÁNÍ DOČASNÝCH FIGUR  DELETING INTERIM FIGURES (orig.250) 
Pokud máte uloţené koncepty figur, jak je doporučeno během procesu tvorby figury, mŧţete tyto 
koncepty figur vymazat pro uvolnění místa na disku. Pro vymazání nějaké poloţky tuto vyberte 
z palety knihoven Library a klikněte na ikonu (-) ve spodní části palety. 
 

ŘEŠENÍ PROBLÉMŮ  TROUBLESHOOTING (orig.250) 

Pokud tvoříte novou figuru z existující figury, mohou se najít existující parametry, které nebudou 
s novou geometrií správně fungovat. Například morph targety pouţité u staré figury nezmění ţádným 
zpŧsobem novou geometrii. Tyto kanály mŧţete vymazat pomocí editoru hierarchie Hierarchy Editor 
označením políčka Show Parameters, výběrem parametrŧ určených ke smazání a stiskem klávesy 
[DEL]. 
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Kapitola 21: Místnost obsahu THE CONTENT ROOM (orig. 251) 
Vítejte do Content Paradise! Místnost obsahu Content room Poseru 7 zpřístupņuje Content 
Paradise, který je rozcestníkem k významných obchodŧm, nabízejícím mnoţství volného a placeného 
obsahu do Poseru 7. Potřebujete figury Poseru 7, rekvizity, textury, nebo něco jiného? Content 
Paradise Vás uspokojí. Download Manager Poseru 7 mŧţe automaticky nainstalovat většinu 
staţeného obsahu a přidat jej do palety knihoven Library. Není nutné manuální umísťování souborŧ 
do sloţek! 

Kliknutím na záloţku místnosti obsahu Content room v horní části pracovního prostoru Poseru 7 
dojde k otevření místnosti obsahu: 

 

Mimo Download Manager zpřístupņuje místnost obsahu Content room online Content Paradise 
webový server. Poser 7 pro Windows zobrazuje webové stránky přímo v pracovním prostoru Poseru 
7. Poser 7 pro Macintosh otevře automaticky nové okno v internetovém prohlíţeči a připojí se na 
Content Paradise. Funkce a uţivatelské rozhraní Content Paradise se mohou měnit. S ohledem na 
toto, bude popis v této příručce omezen na popis Download Manageru. 

Content Paradise obsahuje komplexní online nápovědu, která je dostupná kdekoliv v uţivatelském 
rozhraní pomocí kliknutí na odkaz Help. Prosím ujistěte se, ţe jste si přečetli všechny platné 
podmínky pouţití Terms of Service, včetně ochrany soukromí Privacy Policy. e frontier si vyhrazuje 
právo změnit tuto politiku kdykoliv bez předchozího upozornění. 
 

STAŢENÍ A INSTALOVÁNÍ OBSAHU 
DOWNLOADING AND INSTALLING CONTENT (orig.252) 

Po zakoupení obsahu a opuštění obchodu(ŧ), jej mŧţete stáhnout do Vašeho počítače. Ukazatel 
postupu Vás neustále informuje o stavu stahování. Následujte obrazovkové informace pro zahájení 
stahování. Jakmile je přenos dat kompletní, mŧţete zahájit proces instalace. Uţivatelé Macintoshe 
mohou jednoduše rozbalit staţené soubory a nainstalovat je podle potřeb. Uţivatelé Windows mohou 
pouţít auto-instalační funkci, jak je popsáno dále: 
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U kaţdého staţeného souboru, jakmile jsou data kompletně přeneseny, zobrazí se dialogové okno 
Install Options s následujícími poloţkami: 

o Install Path: Pokud kliknete na tlačítko Install, staţený obsah bude instalován do sloţky 
specifikované v políčku Install Path. V základním nastavení Poseru 7 je předvolena sloţka 
Downloads. Ke změně sloţky určené k instalaci obsahu zadejte odpovídající cestu do políčka 
Install Path, nebo klikněte na ikonu sloţky pro vyhledání poţadované lokace. Prosím navštivte 
kapitolu 5: “Knihovny Poseru 7” na straně 28 pro informace o knihovnách a o paletě knihoven 
Library. 

o Install: Kliknutím na tlačítko Install dojde k instalaci staţeného obsahu do sloţky specifikované  
v políčku Install Path. 

o Cancel: Kliknutím na tlačítko Cancel dojde k přerušení instalačního procesu. Staţený obsah 
zŧstane nenainstalován na místě, kam byl pŧvodně staţen. 

Pokud instalovaný soubor jiţ existuje, zobrazí se dialogové okno s dotazem na moţnost přepsání 
existujícího souboru. Klikněte na tlačítko No pro ponechání pŧvodního souboru, nebo na tlačítko Yes 
k pokračování procesu s přepsáním starého souboru. 

Jakmile je instalace kompletní, zobrazí se potvrzující dialog. Klikněte na tlačítko OK pro potvrzení 
úspěšné instalace staţeného obsahu. 

Pokud Poser 7 nemŧţe obsah rozpoznat, nebo jej instalovat (například nespustitelný soubor), zobrazí 
se dialogové okno Copy to Folder s následujícími poloţkami: 

o Copy Path: Pokud kliknete na tlačítko Copy, staţený obsah bude instalován do sloţky 
specifikované v políčku Copy Path. Pro změnu sloţky, do které má být obsah kopírován, zadejte 
odpovídající cestu do políčka Copy Path, nebo klikněte na ikonu sloţky pro vyhledání poţadované 
lokace. 

o Copy: Kliknutím na tlačítko Copy dojde ke kopírování staţeného obsahu do sloţky specifikované  
v políčku Copy Path. Následně mŧţete sami obsah manuálně instalovat. 

o Cancel: Kliknutím na tlačítko Cancel dojde k přerušení kopírovacího procesu. Staţený obsah 
zŧstane nenainstalován na místě, kam byl pŧvodně staţen. 

Kromě webové stránky Content Paradise obsahuje místnost obsahu Content room také dvě tlačítka: 
Reset Content Paradise a Install From Zip Archive. Tlačítko Reset Content Paradise Vás navrátí 
na domovskou stránku Content Paradise. Tlačítko Install From Zip Archive otevře dialogové okno 
Install Options, které je popsáno výše. 
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Kapitola 22: Průvodce projektem  PROJECT GUIDE (orig.254) 

VÝBĚR PROJEKTU  PROJECT SELECTION (orig.254) 

Po spuštění Poseru 7 Vám mŧţe být prezentováno dialogové okno Quick Start. Toto dialogové okno 
umoţņuje výběr projektu, který bude načten do palety prŧvodce projektem Project Guide uvnitř 
Poseru 7. A Projekt je interaktivním prŧvodcem pracovním postupem, který mŧţete pouţít pro vedení 
nebo podání referencí během výkonu specifické úkoly uvnitř Poseru 7. Klikněte na ikonu projektu, 
který si přejete vybrat, nebo na projekt z rozbalovacího menu, které nabízí další moţnosti. Jakmile 
máte projekt vybrán, klikněte na tlačítko OK pro uzavření dialogu a kompletní spuštění Poseru 7. 

 

Pokud byste chtěli načíst jiný projekt jakmile máte Poser 7 spuštěn, jednoduše zvolte příkaz 
Window>Quick Start pro otevření dialogového okna Quick Start a pro následnou změnu aktuálního 
projektu pomocí palety prŧvodce projektem Project Guide. 
 

PRŮVODCE PROJEKTEM  PROJECT GUIDE (orig.254) 

K prŧchodu projektem pouţívejte šipky v horní části palety prŧvodce projektem Project Guide. 
Klikněte na pravou šipku k postoupení o krok dopředu ve stránkách projektu, nebo na levou šipku pro 
krok zpět na předchozí stránku. Číslo aktuální stránky a její titulek jsou zobrazeny uprostřed mezi 
navigačními šipkami. Obsah stránek, stejně jako související akce aplikace Poser 7, budou specifické 
podle načteného projektu. 

 POZNÁMKA 

PROJEKTY POSERU 7 JSOU INTERAKTIVNÍMI PRŦVODCI PRACOVNÍM POSTUPEM, COŢ 
ZNAMENÁ, ŢE VY, JAKO UŢIVATEL, VYKONÁVÁTE ÚKOLY POPISOVANÉ BĚHEM PROJEKTŦ. 
NICMÉNĚ NĚKTERÉ PROJEKTY MOHOU OBSAHOVAT ÚKONY AUTOMATICKY PROVEDENÉ  
V POSERU 7, KTERÉ VÁM POMOHOU V NÁSLEDNÉM PROVEDENÍ POPISOVANÝCH PROCESŦ. 

Paleta prŧvodce projektem Project Guide funguje stejným zpŧsobem jako všechny palety uvnitř 
Poseru 7; jakmile jsou aktivovány, zŧstanou otevřené a přístupné. Mŧţete si zvolit práci společně 
s prŧvodcem projektem Project Guide ve Vašem vlastním tempu, buď postupovat skrze daný projekt 
metodicky, nebo se vracet do projektu přerušovaně během procesu Vaší vlastní práce. Jako takový je 
prŧvodce projektem Project Guide flexibilní nástroj, vytvořený pro seznámení se s rŧznorodostí 
pracovních stylŧ a potřeb. Pokud se rozhodnete paletu prŧvodce projektem Project Guide zavřít, 
jednoduše klikněte na ikonu pro uzavření v pravém horním rohu palety. Následně mŧţete paletu 
prŧvodce kdykoliv otevřít pomocí příkazu Window>Project Guide z hlavního menu Poseru 7. 
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Část 3 – LIŠTA MENU POSERU 7 

THE POSER 7 MENU BAR (orig.257) 

Kapitola 23: Menu souboru  THE FILE MENU (orig.258) 

Jak název napovídá, menu souboru File menu umoţņuje pracovat se soubory scén Poseru 7. 
 

NOVÝ  NEW (orig.258) 

Volbou File>New bude otevřena nová scéna Poseru 7. Pokud máte otevřenu předchozí scénu  
s neuloţenými změnami, zobrazí se varovný dialog. Dialog umoţņuje následující volby: 

o Výběrem Don’t Save bude otevřena nová scéna Poseru 7 bez uloţení změn předchozí scény. 
Všechny neuloţené změny budou ztraceny, proto pouţívejte tuto volbu opatrně! 

o Výběrem Cancel bude dialog uzavřen, stávající scéna Poseru 7 zŧstane otevřena. 

o Výběrem Save bude otevřeno standardní dialogové okno Save, které Vám umoţní uloţení 
stávající scény Poseru 7. Po uloţení stávající scény bude automaticky otevřena scéna nová. 

 

OTEVŘÍT  OPEN (orig.258) 

Volbou File>Open bude otevřeno standardní dialogové okno Open, které Vám umoţní přístup ke 
dříve uloţeným souborŧm scén Poseru 7. Budete vyzváni k uloţení dosud neuloţených změn 
stávající scény, pokud existují (viz výše). 
 

POSLEDNÍ SOUBORY  RECENT FILES (orig.258) 

Volbou File>Recent Files dojde k otevření rozbalovacího seznamu naposledy pouţitých souborŧ 
scén (formátŧ .pz3 nebo .pzz), které jste otevřeli v Poseru 7. 
 

ZAVŘÍT  CLOSE (orig.258) 

Volbou File>Close uzavřete stávající scénu Poseru 7, přičemţ aplikace Poseru 7 zŧstane v chodu. 
Budete vyzváni k uloţení dosud neuloţených změn stávající scény. 
 

ULOŢIT  SAVE (orig.258) 

Volbou File>Save uloţíte Vaši stávající scénu Poseru 7 při pouţití dříve specifikovaného pojmenování  
a lokalizace (umístění) souboru. Pokud scéna ještě nebyla dříve uloţena, Poser 7 otevře standardní 
Save As dialogové okno, které Vám umoţní pojmenování a uloţení aktuální scény Poseru 7 (viz 
dále). 
 

ULOŢIT JAKO  SAVE AS (orig.259) 

Volbou File>Save As uloţíte Vaši stávající scénu Poseru 7 s moţností výběru odlišného názvu 
souboru anebo místa uloţení. Tato funkce je uţitečná pro vytvoření odlišných verzí práce, které Vám 
umoţní návrat do některého z uloţených předchozích stavŧ práce, pokud nejste s následným 
postupem práce zcela spokojeni. Mŧţete například uloţit scénu myscene_1.pz3, potom uloţit novou 
verzi myscene_2.pz3, myscene_3.pz3, a tak dále. 
 

PODPORA KOMPRIMOVANÝCH SOUBORŮ   
COMPRESSED FILE SUPPORT (orig.259) 

Poser 7 umoţņuje uloţení figur/rekvizit/scén na hard disk v komprimovaném stavu. Pro aktivaci 
podpory komprimace souborŧ zvolte poloţku Edit>General Preferences, vyberte záloţku Library  
a označte políčko Use File Compression, jak je popsáno v části “Nastavení předvoleb aplikace” na 
straně 19. 
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NÁVRAT ZPĚT  REVERT (orig.259) 

Volbou File>Revert je moţné vráti zpět změny a znovu otevřít aktuální scénu v posledním uloţeném 
stavu. Toto je významný zpŧsob pro vzetí zpět posledních změn scény, nicméně bude ztraceno vše, 
co jste provedli ve Vaší scéně od jejího posledního uloţení. Doporučujeme proto časté ukládání scény 
a pokud se budete chtít vrátit k předchozí uloţené verzi scény, mŧţete si předem dále rozpracovanou 
verzi uloţit pod jiným jménem pouţitím příkazu Save As. Kliknutím na tlačítko Cancel se vrátíte do 
Poseru 7 a kliknutím na Revert bude aktuální scéna nahrazena poslední uloţenou verzí. 
 

IMPORT  IMPORT (orig.259) 

Volba File>Import umoţņuje přidání souborŧ Poseru 7 a ostatních souborŧ do Vaší scény. Mohou to 
být obrázky, videosoubory nebo rekvizity (které mohou být konvertovány na figury Poseru, jak je 
popsáno v kapitole 20: “Místnost nastavení” na straně 174). 
 

IMPORT VIDEOSOUBORŮ  IMPORTING MOVIES (orig.259) 

Pro import videosouborŧ zvolte poloţku File>Import>AVI Footage (Windows) nebo 
File>Import>Quick Time (Macintosh). Importovaný videosoubor mŧţete pouţít jako pozadí pro 
animaci Poseru 7. Mŧţete mít například scénu s dvěma osobami Poseru 7, které sedí ve vlaku  
a importovaný videosoubor vytvoří dojem ubíhající krajiny při pohybu vlaku. 

Pokud importujete videosoubor odlišné velikosti nebo poměru stran obrazu (šířka/výška) vŧči 
aktuánímu nastavení okna Document, budete dotázáni, zda si přejete změnit rozlišení podle okna 
Document. Volbou Yes dojde ke změně rozlišení importovaného videosouboru podle velikosti okna 
Document. Volbou No dojde k úpravě velikosti okna Document podle rozlišení videosouboru. V okně 
Document mohou vzniknout plochy, které nebudou pokryty importovaným videosouborem. Změnou 
poměru stran obrazu aspect ratio importovaného videosouboru je moţné předejít nechtěným 
artefaktŧm a deformacím ve scéně během renderu. e frontier proto doporučuje odpovídající úpravu 
velikosti okna Document nebo import videosouborŧ správné velikosti. 

 Obrázek 1: Správné přizpŧsobení                  Obrázek 2: Nesprávné přizpŧsobení 

Importované videosoubory mohou být spouštěny od prvního snímku animace Poseru 7. Pokud je 
animace delší neţ videosoubor, zŧstane videosoubor zapauzován na pozadí na svém posledním 
snímku. Jestliţe je animace kratší neţ videosoubor, zŧstane na konci animace zobrazen snímek 1-x 
importovaného videosouboru, kde x znamená počet snímkŧ animace Poseru 7. 

Pokud importujete videosoubor, měli byste vyzkoušet zpŧsob osvětlení scény v určitém souladu  
s pozadím tak, aby se vhodně míchaly dohromady. Prosím navštivte kapitolu 9: “Osvětlení” na straně 
61 pro více informací o osvětlení v Poseru 7. 
 

IMPORT OBRÁZKŮ NA POZADÍ  IMPORTING BACKGROUND PICTURES (orig.260) 

Mŧţete také importovat statické obrázky na pozadí. Pokud například vytváříte scénu s postavami 
Poseru 7 v pokoji s okny, mŧţete pouţít obrázek na pozadí pro simulaci výhledu z okna. Volbou 
File>Import> Background Picture dojde k otevření standardního Open dialogu, který Vám umoţní 
výběr formátu a umístění poţadovaného obrázku. Stejně jako při importu videosouboru, budete 
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dotázáni na provedení změny rozlišení obrázku podle okna Document s výsledkem stejným, jak bylo 
popsáno výše. Změnou poměru stran aspect ratio importovaného obrázku mŧţete předejít 
nechtěným artefaktŧm ve Vaší scéně během renderu a ve výsledku zamezit prázdným plochám po 
bocích okna Document (viz výše). Doporučujeme předem změnit velikost okna Document, nebo 
importování obrázkŧ odpovídající velikosti. Poser 7 podporuje import podkladních obrázkŧ  
v následujících formátech: SGI, BMP, DDS, EXR, GIF, HDR, JPG, PCD, PNG, PSD, TGA, TIFF  
a WBMP. 

Pokud importujete podkladní obrázek na pozadí, měli byste vyzkoušet zpŧsob osvětlení scény  
v určitém souladu s obrázkem pozadí tak, aby se vhodně míchaly dohromady. Prosím navštivte 
kapitolu 9: “Osvětlení” na straně 61 pro více informací o osvětlení v Poseru 7. 
 

IMPORT DOKUMENTŮ NEBO REKVIZIT POSERU 7 
IMPORTING POSER 7 DOCUMENTS OR PROPS (orig.261) 

Volbou File>Import>Poser Document/Prop mŧţete do Vaší scény importovat buď celé scény 
Poseru anebo rekvizity Poseru. Toto mŧţe být uţitečné pro vloţení rekvizit, které nejsou součástí Vaší 
palety knihoven Library v kategorii Props. Importované scény/rekvizity mohou být do scény vkládány 
kompletně s animacemi, morphingy, pózami, apod. Tato volba otevře standardní dialogové okno, 
umoţņující vyhledání poţadovaného souboru. Pouţijte rozbalovací menu Files of type k provedení 
výběru jednoho z následujících typŧ souborŧ Poseru: 

o Poser 1.0 file (*.POZ): Tato volba importuje scény Poseru 1.0. 

o Poser 2.0 file (*.PZR): Tato volba importuje scény Poseru 2.0. 

o Poser 3.0 & later (*.PZ3): Tato volba importuje scény Poseru 3.0 a pozdějších verzí. 

o Compressed Poser Files (*.PZZ): Tato volba importuje komprimované scény Poseru, uloţené v Pro 
Packu pro Poser 4, v Poseru 5 nebo v pozdějších verzích (viz téma “Různé předvolby” na straně 
21 pro více informací o podpoře komprimace souborŧ v Poseru 7). 

o Poser 3 prop library (*.PP2): Tato volba importuje soubory rekvizit Poseru. 
 

IMPORT KNIHOVEN POSERU 1.0  IMPORTING POSER 1.0 LIBRARIES (orig.261) 

Volbou File>Import>Poser 1.0 Library importujete knihovny Poseru 1. 
 

IMPORT ZVUKOVÉHO SOUBORU  IMPORTING SOUND (orig.261) 

Volby File>Import>LipSync Audio nebo File>Import>Sound umoţņují importovat WAV zvukové 
soubory, které mŧţete pouţít jako soundtrack pro Vaši animaci. Importovaný zvuk řeči nebo hudby 
bude přidán na začátek animace a bude přehrán vţdy během spuštění animace. Po výběru této volby 
bude zobrazen standardní Open dialog,  který Vám umoţní výběr názvu a umístění poţadovaného 
zvukového souboru. Pokud vyberete poloţku LipSync Audio, dojde k otevření designeru řeči Talk 
Designer s aktivovaným vybraným audio souborem. Prosím navštivte téma “Použití designeru řeči” 
na straně 101 pro informace o designeru řeči Talk Designer a o animacích artikulace rtŧ. Prosím 
navštivte téma “Editace zvuku” na straně 101 pro více informací o editaci zvuku pomocí Poseru 7. 
Prosím navštivte téma “Synchronizace zvuku a pohybu” na straně 101 pro více informací  
o zpracování importovaného zvukového souboru. 
 

IMPORT BVH  SOUBORŮ ZACHYCENÍ POHYBU 
IMPORTING BVH MOTION CAPTURE FILES (orig.262) 

Volba File>Import>BVH Motion Vám umoţní importovat soubory zachycení pohybu v populárním 
BVH formátu. Následně zobrazený standardní Import dialog Vám umoţní výběr poţadovaného 
umístění a jména souboru. 

Pro stanovení správné osy a měřítka BVH souboru prostudujte dokumentaci distributora. Distributoři 
jako Biovision nebo House of Moves tyto informace poskytují. Během importu mŧţete specifikovat, 
které prvky figury jsou vyrovnané podle osy X nebo Z. Srovnávání podle os je určováno během 
nahrávání souboru. Zvolení správné osy umoţní korektní pohyb figury. Začněte výběrem těla. 
Importujte BVH soubor a zvolte Z-Axis zarovnání a nastavení Scale Automatically. Některé prvky 
nemusí být rozpoznány, přesto dojde k nahrání BVH souboru. Pokud vznikne chyba, vraťte se na 
první snímek Frame 1 a znovu importujte soubor. Importované BVH snímky budou aplikovány na 
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aktuálně vybranou figuru a mohou být dále editovány jako kaţdé jiné klíčové snímky (viz téma 
“Editace klíčových snímků pomocí časové osy” na straně 91). 
 

IMPORT 3D OBJEKTŮ  IMPORTING 3D OBJECTS (orig.262) 

Poser 7 umoţņuje importovat soubory geometrie v následujících formátech: 

o 3D Studio Max (File>Import>3D Studio)  

o DXF (File>Import>DXF) 

o Wavefront OBJ (File>Import>Wavefront OBJ) 

o Lightwave 5/6 LWO files (File>Import>Lightwave…) 

Mnoho 3D modelovacích aplikací podporuje export do některého z výše uvedených formátŧ. Některé 
formáty, jako například Wavefront OBJ, umoţņují uloţení geometrie jako polygony nebo NURBS 
povrchy. Poser 7 akceptuje pouze geometrie uloţené jako polygony. 

Poser 7 dokáţe importovat vyhlazovací skupiny ve formátu Wavefront OBJ, které jsou definovány ve 
zdrojovém souboru. (Pokud nejsou vyhlazovací skupiny ve zdrojovém souboru definovány, nemohou 
být importovány.) Prosím navštivte kapitolu 15: “Vyhlazování povrchu” na straně 137 pro více 
informací o vyhlazovacích skupinách. Všimněte si, ţe zatímco Poser 7 nepodporuje 3DS Max styl 
definování vyhlazovacích skupin, ve výsledku se OBJ soubory exportované z 3DS Max obvykle 
zobrazí tak, jak je očekáváno, navzdory skutečnosti, ţe 3DS Max vyhlazovací skupiny nejsou načteny. 

Tipy & Triky  TIPS & TRICKS (orig.262) 

Pokud pouţijete oblíbenou 3D modelovací aplikaci 
pro vytvoření nové geometrie pro konverzi na 
figuru/rekvizitu Poseru, je dobré následovat tento 
postup pro zrychlení procesu tvorby figury a pro 
dosaţení lepšího konečného výsledku: 

o Ujistěte se, ţe nemáte duplicitní a překrývající 
se polygony. Duplicitní polygony vzniknou, 
pokud se dvě identické části geometrie 
nacházejí ve stejné pozici, například pokud 
omylem vloţíte jeden prvek geometrie dvakrát. 
Následující obrázek zobrazuje příklad 
duplicitních polygonŧ uvnitř 3D modelu:  

o Eliminujte překrývající se polygony, které 
mohou vzniknout při vloţení části geometrie 
dovnitř jiné geometrie. Následující obrázek 
ukazuje příklad překrývajících se polygonŧ  
v levé části (menší roura je částečně zasunuta 
do roury větší). Správný zpŧsob provedení 
geometrie je zobrazen na pravé straně (bez 
překrývajících se polygonŧ):  

o Poser 7 umoţņuje importovat geometrie jako 
jednotlivé soubory se skupinami uvnitř souboru, 
jako samostatné soubory, nebo jako jednotlivé 
soubory bez skupin. Doporučujeme Vám vytvářet 
geometrie jako jednotlivé soubory bez skupin, 
neboť Poser 7 obsahuje mocné nástroje pro 
vytváření skupin a  také proto, ţe některé formáty 
geometrií (jako je Wavefront OBJ) Vám dovolí 
přiřazení polygonŧ k více neţ jedné skupině 
najednou. Importování geometrií s polygony 
přiřazenými k více neţ jedné skupině najednou do 
Poseru 7 zpŧsobí duplikaci těchto polygonŧ  
a vznik nechtěných přídavných částí figury. 

o Pouţijte následující proceduru pro import 
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geometrie do Poseru 7: 

1. Začněte proces vytvořením síťového polygonového objektu v oblíbené 3D modelovací aplikaci. 
Pokud máte hotovo, importujte objekt do Poseru 7 volbou File>Import>format, kde format 
značí typ formátu souboru, který si přejete importovat (například OBJ). Zobrazí se standardní 
Open dialog, který Vám umoţní výběr odpovídajícího umístění a názvu souboru. 

2. Jakmile máte vybránu poţadovanou geometrii, zobrazí se dialog Prop Import Options. Ten 
obsahuje následující volby: 

o Centered: Volbou Centered bude importovaná geometrie umístěna do středu pracovního 
prostoru Poseru 7. 

o Place on floor: Pokud zvolíte Place on Floor, geometrie bude svou spodní částí srovnána  
s podlahou pracovního prostoru Poseru 7. 

o Percent of standard figure size: Volba Percent of standard figure size přizpŧsobí velikost 
geometrie relativně k velikosti standardní figury Poseru 7. Například nastavení měřítka na 
50% bude geometrie importována ve velikosti 50% standardní figury Poseru 7. Toto ve 
výsledku umoţņuje zachování správných proporcí jednotlivých částí scény. Pokud 
importujete DXF geometrie, Poser 7 povaţuje jednu DXF jednotku jako ekvivalent velikosti 
standardní figury Poseru 7, tj. okolo šesti stop. 

o Ofset: Zadáním numerických hodnot do jednoho nebo více Offset polí umoţníte posunutí 
geometrie do vybrané pozice pracovního prostoru Poseru 7. 

o Weld identical vertices: Pokud je zvolena poloţka Weld identical vertices dojde ke spojení 
identických bodŧ mezi geometriemi. 

o Make polygon normals consistent: Pokud soubor geometrie obsahuje vertexové normály, 
označením políčka Make polygon normals consistent učiníte polygonové normály 
shodnými s vertexovými normálami. 

o Flip normals: Poloţka Flip Normals obrátí všechny normály geometrie. 

o Flip U Texture Coordinates: Poloţka Flip U Texture Coordinates obrátí U souřadnice 
textury geometrie. 

o Flip V Texture Coordinates: Poloţka Flip V Texture Coordinates obrátí V souřadnice 
textury geometrie. 

Jakmile máte ukončen výběr poţadovaných poloţek, klikněte na tlačítko OK. 

3. Soubor geometrie je importován do 
Poseru 7. Čas potřebný pro import 
souboru geometrie závisí na faktorech 
jako je velikost souboru, počet polygonŧ 
nebo skupin, rychlost počítače, apod. 
Grafický indikátor zobrazuje prŧběh 
importu. Jakmile je import dokončen, 
importovaná geometrie se zobrazí 
v pracovním okně Poseru 7 Document.  

S importovanými geometriemi se zachází jako se 
statickými rekvizitami. Mŧţete je jako rekvizity 
přidat do palety knihoven Library, jak je popsáno 
v části “Údržba Vaší palety knihoven” na straně 
33 anebo mŧţete konvertovat rekvizity na 
polohovatelné Poser figury pouţitím místnosti 
nastavení Setup room (viz kapitola 20: “Místnost 
nastavení” na straně 174 pro instrukce o pouţití 
místnosti nastavení) nebo pomocí textové 
metody (podle electronického manuálu Poser 3 
Advanced Tips & Tricks, dostupného na Vašem 
Poser 7 DVD ve sloţce Documentation). 
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EXPORT  EXPORT (orig.265) 

Kromě podpory širokého rozsahu formátŧ importovaných souborŧ, Poser 7 podporuje mnoho formátŧ 
pro export, které umoţņují pouţití výstupu z Poseru 7 ve Vašich oblíbených 2D a 3D aplikacích. 
 

EXPORTOVÁNÍ OBRÁZKŮ  EXPORTING IMAGES (orig.265) 

Pro export obrázku zvolte poloţku File>Export>Image. Zobrazí se standardní Save As dialog, který 
Vám umoţní specifikovat poţadované jméno souboru a místo uloţení. Mimo to, mŧţete být vyzváni  
k výběru dalších specifických atributŧ obrázku (jako je kvalita exportu JPG). 

 POZNÁMKA 
POKUD CHCETE U POSERU 7 ULOŢIT TAKÉ ALPHA KANÁL PRO ZACHOVÁNÍ PRŦHLEDNOSTI 
EXPORTOVANÉHO OBRÁZKU, MUSÍTE EXPORTOVAT V NĚKTERÉM Z FORMÁTŦ PNG, TIFF, 
NEBO PSD. ALPHA KANÁL VYTVOŘÍ PRŦHLEDNÉ POZADÍ V PŘÍPADĚ, ŢE JE PRÁZDNÉ  
A UMOŢNÍ PRŦHLED SKRZE POZADÍ. TATO FUNKCE JE NEPOSTRADATELNÁ PRO TVORBU 
KOMPOZIC V APLIKACÍCH PRO EDITACI OBRÁZKŦ. 

Exportováním obrázku dojde k uloţení snímku aktuální scény tak, jak je právě zobrazena v okně 
Document. Proto, pokud se nacházíte v záloţce Preview pracovního okna Document, exportovaný 
obrázek bude snímkem aktuální scény zobrazené v záloţce Preview. Pokud se nacházíte v záloţce 
Render, exportovaný snímek bude renderovaným obrázkem aktuálně vybraným v menu Main Render 
v levé spodní části pracovního okna Document. 
 

EXPORTOVÁNÍ BVH POHYBOVÝCH SOUBORŮ   
EXPORTING BVH MOTION FILES (orig.265) 

Pro export BVH pohybového souboru: 

1. Vyberte figuru, kterou si přejete exportovat. 

2. Zvolte poloţku File>Export>BHV Motion. 

3. Zvolte Scale Automatically. Pokud exportovaný soubor vypadá nekorektně, znovu jej exportujte  
a přitom vypněte volbu Scale Automatically. 

Zobrazí se standardní Save dialog, který Vám umoţní specifikovat poţadované jméno souboru  
a místo uloţení. 
 

EXPORT PAINTER SKRIPTŮ  EXPORTING PAINTER SCRIPTS (orig.265) 

Kliknutím na tlačítko Export Painter Script v okně designeru skic Sketch Designer je moţné 
exportovat aktuální nastavení designeru skic Sketch Designer do programu Corel Painter (viz 
kapitola 38: “Renderovací nástroj Designer skic” na straně 259). Toto bylo testováno pro spolupráci  
s programem Painter 6 a předchozími verzemi, s pozdějšími verzemi mŧţe funkce spolupracovat,  
i kdyţ podpora není zajištěna. 
 

EXPORT 3D OBJEKTŮ  EXPORTING 3D OBJECTS (orig.266) 

Poser 7 umoţņuje export 3D objektŧ ve formátech RIB, 3DS, DXF, HAnim, OBJ, VRML, LWO a OBJ 
volbou poloţky File>Export>format, kde format je jeden z podporovaných exportních formátŧ. Pro 
export do 3D formátu: 

Zvolte poloţku File>Export>format. 

V dialogovém okně, které se zobrazí, zvolte odpovídající poloţku pro určení, zda bude expotrován 
jeden konkrétní snímek nebo animace. Pokud zvolíte export animace, zadejte číslo snímku začátku  
a konce animace a klikněte na tlačítko OK. 

V následujícím okně vyberte část(i), které se přejete exportovat a klikněre na tlačítko OK. 

Zobrazí se standardní Save As dialog, který Vám umoţní specifikovat poţadované jméno souboru  
a místo uloţení. 
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 POZNÁMKA 
POKUD SE SNAŢÍTE VYTVOŘIT CELOPOSTAVOVÝ FULL-BODY MORPH TARGET, 
NEPOUŢÍVEJTE VOLBU FILE>EXPORT>OBJ. MÍSTO TOHO POUŢIJTE POLOŢKU 
FIGURE>CREATE FULL BODY MORPH. 
 

EXPORT FLASH (SWF) SOUBORŮ  EXPORTING FLASH (SWF) FILES (orig.266) 

Flash je populární 2D formát nejběţněji pouţívaný pro animaci obsahu Webu. Soubory Poseru 7 
mŧţete exportovat do Flash formátu (soubor .swf) pomocí dialogového okna Make Movie a potom 
pouţít Flashovou aplikaci pro modifikaci exportovaného souboru. Flashové prezentace jsou normálně 
zobrazeny Web browserem za pouţití Adobe Flash plug-inu. 

Prosím navštivte kapitolu 39: “Rendering animací” na straně 262 pro více informací o Make Movie 
dialogu a téma “Předvolby Flash” na straně 264 pro více informací o nastavení předvoleb Flash 
exportu. 
 

SPUŠTĚNÍ PYTHON SKRIPTU  RUN PYTHON SCRIPT (orig.266) 

Volbou File>Run Python Script otevřete standardní Open dialog, umoţņující vyhledání 
poţadovaného PoserPython skriptu. Jakmile najdete poţadovaný skript, vyberte jej a klikněte na OK 
pro jeho spuštění. 
 

OPĚTOVNÉ SPUŠTĚNÍ PYTHONU  REINITIALIZE PYTHON (orig.266) 

Volbou File>Reinitialize Python dojde k opětovnému spuštění PoserPython skriptu. 
 

KONVERTOVÁNÍ SOUBORU HIERARCHIE  CONVERT HIER FILE (orig.267) 

Volbou File>Convert Hier File dojde k otevření standardního Open dialogu umoţņujícího nalezení  
a otevření Poser 3 Hierarchy souboru (*.phi). Pokud tento soubor neobsahuje chyby, tato funkce 
vytvoří soubor figury Poseru (*.cr2). Prosím navštivte téma “O souborech Poseru 7” na straně 276 pro 
více informací o souborech Poseru 7 a jejich funkcích. 

Soubory hierarchie jsou pouţívány pro vytvoření uţivatelských figur pouţitím textové metody (viz 
kapitola 20: “Místnost nastavení” na straně 174). Od uvedení grafické místnosti nastavení Setup 
room, tato stará metoda, i kdyţ zŧstává podporována, je daleko zdlouhavější a nutí Vás vše vytvářet 
únavně v textovém prostředí. Pokud si přejete vytvořit uţivatelskou figuru Poseru pouţitím této staré 
metody, prostudujte prosím Poser 3 Advanced Tips & Tricks Manual. Tento dokument v PDF formátu 
je uloţen na Vašem Poser 7 DVD ve sloţce Documentation. 
 

NASTAVENÍ TISKU / NASTAVENÍ STRÁNKY 
PRINT SETUP/PAGE SETUP (orig.267) 

Volbou File>Print Setup (Windows) nebo File>Page Setup (Macintosh) dojde k otevření 
standardního dialogového okna Print, umoţņujícího nastavení poţadované tiskárny a nastavení 
hlavních vlastností tisku. Prosím prohlédněte si Váš operační systém anebo dokumentaci Vaší 
tiskárny pro informace o nastavení předvoleb tiskárny. 
 

TISK  PRINT (orig.267) 

Volbou poloţky File>Print odešlete aktuální scénu na Vámi vybranou tiskárnu. Zobrazí se standardní 
Print dialog, který umoţní výběr poţadované tiskárny a nastavení hlavních tiskových předvoleb. 
Dokumenty Poseru 7 se vţdy tisknou v celostránkovém reţimu. Prosím prohlédněte si dokumentaci 
Vašeho operačního systému pro informace o nastavení předvoleb tisku. 
 

UKONČENÍ  EXIT (orig.267) 

Volbou File>Exit dojde k ukončení Poseru 7. Budete vyzváni k uloţení veškerých neuloţených změn. 
Poser 7 mŧţete také ukončit pomocí klávesové zkratky [COMMAND]/[CTRL]+[Q]. 

Tato poloţka menu je dostupná pouze ve verzi pro Windows. Ve verzi pro Macintosh je příkaz Quit 
umístěn v menu Application. 
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Kapitola 24: Menu editace  THE EDIT MENU (orig.268) 

Menu editace Edit menu umoţņuje provedení základních editačních funkcí a přístup k nastavení 
hlavních předvoleb aplikace Poseru 7. 
 

KROK ZPĚT  UNDO (orig.268) 

Volbou poloţky Edit>Undo bude vrácena o jeden krok zpět poslední změna aktuální scény. Příkaz 
mŧţete také provést stiskem kláves [COMMAND]/[CTRL]+[Z]. Undo lze aplikovat pouze na změny 
provedené uvnitř aktuální scény; příkaz nejde pouţít na provedené změny nastavení aplikace, změny 
obsahu knihoven Library, apod.  

Poser 7 podporuje vícestupņové Undo. Opakovaným pouţitím příkazu Edit>Undo mŧţete po krocích 
vracet zpět velké mnoţství provedených změn dokumentu, individuálně navrátit kaţdou změnu, nebo 
navrátit scénu do předchozího stavu. Některé operace uvniř Poseru 7 vyprázní paměť s uloţenými 
změnami Undo/Redo; přitom dojde k zobrazení varovného dialogu s dotazem na potvrzení akce, 
která bude mít za následek vymazání paměti. K vymazání paměti pro Undo/Redo dojde také 
ukončením souboru.  

Maximální mnoţství uloţených pracovních krokŧ pro funkci Undo mŧţete specifikovat. Prosím 
navštivte téma “Nastavení předvoleb aplikace” na straně 19 pro více informací. 

 POZNÁMKA 
MŦŢETE TAKÉ SPECIFIKOVAT, ZDA BUDE NEBO NEBUDE FUKCE UNDO APLIKOVÁNA NA 
ZMĚNY POHLEDŦ KAMER. OTEVŘETE PALETU VLASTNOSTÍ PROPERTIES AKTUÁLNĚ 
VYBRANÉ KAMERY A OZNAČTE POLÍČKO “REMEMBER CHANGES FOR UNDO” V PŘÍPADĚ, ŢE 
SI PŘEJETE FUNKCI UNDO APLIKOVAT TAKÉ NA ZMĚNY TÉTO KAMERY. ALTERNATIVNĚ, 
POKUD SI NEPŘEJETE, ABY BYLY ZMĚNY KAMER UKLÁDÁNY PRO VYUŢITÍ FUKCÍ UNDO, 
ODZNAČTE UVEDENÉ POLÍČKO U VŠECH POUŢÍVANÝCH KAMER. TOTO POLÍČKO JE  
V ZÁKLADNÍM NASTAVENÍ OZNAČENO. 
 

KROK DOPŘEDU  REDO (orig.268) 

Volbou příkazu Edit>Redo navrátíte poslední provedené kroky zpět Undo, takţe navrátíte scénu do 
předchozího stavu. Mŧţete také pouţít klávesovou zkratku [COMMAND]/[CTRL]+[SHIFT]+[Z]. Pro 
navrácení akce Redo zpět, jednoduše zvolte znovu příkaz Edit>Undo. 
 

VYJMOUT  CUT (orig.268) 

Volbou poloţky Edit>Cut dojde k vyjmutí vybraného elementu(ŧ) a jeho uloţení do systémové 
schránky pro pozdější pouţití (vloţení). Příkaz mŧţete také provést stiskem kláves 
[COMMAND]/[CTRL]+[X]. Příkaz mŧţete pouţít pro pózy a další funkce. 
 

KOPÍROVAT  COPY (orig.269) 

Volbou poloţky Edit>Copy dojde ke okopírování 
vybraného elementu(ŧ) a jeho uloţení do systémové 
schránky. Mŧţete kopírovat a vkládat elementy a 
pózy. Zde je například figura, jejíţ póza břicha byla 
kopírována do lokte: 

Pro kopírování a vloţení zformované části těla: 

1. Vytvarujte zvolenou část těla za pouţití nástroje 
podle přání. 

2. Vyberte zvolenou část těla (zdroj), potom zvolte 
funkci Edit>Copy nebo stiskněte klávesy 
[COMMAND]/ [CTRL]+[C]. 

3. Klikněte na vybranou část těla, na kterou si 
přejete aplikovat kopii (cíl) a zvolte Edit>Paste 
(viz následující podsekce). Dojde ke zkopírování 
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všech nastavení ze zdroje na cíl, včetně 
deformací. 

 

VLOŢIT  PASTE (orig.269) 

Volbou příkazu Edit>Paste, nebo stiskem kláves 
[COMMAND]/[CTRL]+[V], dojde ke vloţení poloţky 
ze systémové schránky do aktuální scény. Pokud 
vkládáte pózu, vyberte element, na který bude póza 
kopírována, potom pouţijte tuto funkci. 

 POZNÁMKA 
KOPÍROVÁNÍM A VLOŢENÍM PÓZY Z JEDNÉ 
STRANY FIGURY NA DRUHOU NEVZNIKNE 
ZRCADLOVÝ OBRAZ. DOJDE POUZE K 
APLIKACI STEJNÉ PÓZY. PRO ZRCADLOVÝ 
OBRAZ PÓZY, POUŢIJTE FUNKCI SYMETRIE 
SYMMETRY. 
 

KOPIE OBRÁZKU  COPY PICTURE (orig.269) 

Volbou Edit>Copy Picture bude proveden snímek scény, který mŧţe být vloţen do grafické aplikace, 
jako je Adobe Photoshop. Vaše scéna bude kopírována tak, jak je zobrazena v pracovním okně 
Document. 

 POZNÁMKA 
KOPÍROVÁNÍ A VKLÁDÁNÍ OBRÁZKŦ TÍMTO ZPŦSOBEM  NENI TOTÉŢ JAK RENDERING. 
PROSÍM NAVŠTIVTE ČÁST 9 PRO INFORMACE O RENDERINGU SCÉN POSERU. 
 

DUPLIKÁT  DUPLICATE (orig.270) 

Funkce Duplicate [jméno objektu] vytvoří přesnou kopii aktuálně vybrané figury nebo rekvizity ze 
scény. Duplikát objektu bude vloţen do pracovního okna Document do stejné pozice jako originál. 
Duplikát objektu bude také zobrazen v menu Select Figure nebo Current Actor v závislosti na tom, 
zda se jedná o figuru nebo rekvizitu a mŧţe být měněna jeho velikosti a pozice nezávisle na 
originálním objektu. 
 

OBNOVENÍ  RESTORE (orig.270) 

Potřebujete obnovit element scény do základního stavu? Zvolte funkci Edit>Restore pro otevření 
submenu umoţņujícího obnovení elementŧ scény, které budou kompletně obnoveny do jejich 
základního nastavení včetně pozice, měřítka, deformací, parametrŧ, materiálŧ, vzájemných vztahŧ 
parent/child, atd. Tato funkce je vyloţeně pro případy, kdy si přejete vše vrátit zpět a začít znova. 
Pouţívejte ji opatrně! Poloţky Restore submenu vypadají následovně: 

o Element: Volbou Edit>Restore>Element bude obnoven aktuální element do základního stavu. 
Elementem mŧţe být část těla, rekvizita, jedna kamera nebo jedno světlo. 

o Figure: Volbou Edit>Restore>Figure bude obnovena aktuální figura do základního stavu. 

o Lights: Volbou Edit>Restore>Lights budou obnovena všechna světla scény do základního stavu. 

o Camera: Volba Edit>Restore>Camera obnoví aktuální kameru scény do základního stavu. 

o All: Volbou Edit>Restore>All budou obnoveny všechny elementy scény do základního stavu. 
Pouţívejte tuto volbu opatrně! 

 

ZAPAMATOVÁNÍ  MEMORIZE (orig.270) 

Pokud pracujete, dospějete moţná do vhodného bodu pro zastavení. To, co jste dosud vytvořili se 
Vám líbí a později se nechcete vracet úplně do základního stavu Poseru 7 v případě, ţe bude nutné 
obnovení jednoho nebo více elementŧ (nebo dokonce celé scény). Není problém. Zvolte poloţku 
Edit>Memorize a následně element(y), které si přejete zapamatovat (seznam poloţek je stejný jako  
v submenu Restore výše). Tímto dojde v zásadě ke změně základního nastavení vybraných elementŧ 
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podle aktuálního stavu, coţ ale mŧţe být v některých případech neţádoucí. Staré základní nastavení 
elementu(ŧ) bude přepsáno nastavením novým. Pokud později zvolíte poloţku Edit>Restore, Vaše 
elementy budou obnoveny do posledně uloţeného nastavení. 

Zapamatování práce na bázi souboru, tím je míněno zapamatování nastavení v rámci konkrétního 
souboru, nemá vliv na nastavení dalších souborŧ Poseru 7 nebo poloţek palety knihoven Library. 
 

HLAVNÍ PŘEDVOLBY  GENERAL PREFERENCES (orig.271) 

Volbou poloţky Edit>General Preferences dojde k otevření dialogového okna General Preferences, 
umoţņujícího nastavení určitých souhrnných předvoleb Poseru 7. Prosím navštivte téma “Nastavení 
předvoleb aplikace” na straně 19 pro více informací o předvolbách dostupných pomocí tohoto 
dialogového okna. 
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Kapitola 25: Menu figury THE FIGURE MENU (orig.272) 

Menu figury Figure menu umoţņuje výběr několika vysokoúrovņových předvoleb pro figury/rekvizity. 
 

VÝŠKA FIGURY  FIGURE HEIGHT (orig.272) 

Poser 7 poskytuje několik výšek figury, které mohou být nastaveny pomocí poloţky Figure>Figure 
Height a výběrem jedné z osmi dostupných výšek. Výšky figury jsou měřeny na “hlavy”, tím je myšlen 
poměr velikosti hlavy k celkové výšce těla: 

o Baby: (nemluvně) 4 hlavy (kaţdá hlava je přibliţně 6 palcŧ vysoká) 

o Toddler: (batole) 5 hlav (kaţdá hlava je přibliţně 6,5 palcŧ vysoká)  

o Child: (dítě) 6 hlav (kaţdá hlava je přibliţně 7 palcŧ vysoká) 

o Juvenile: (nedospělý) 7 hlav (kaţdá hlava je přibliţně 7,5 palcŧ vysoká) 

o Adolescent: (dospívající) 7.5 hlav (kaţdá hlava je přibliţně 9 palcŧ vysoká)  

o Ideal Adult: (ideální dospělý) 8 hlav (kaţdá hlava je přibliţně 9 palcŧ vysoká) 

o Fashion Model: (módní model) 8.5 hlav (kaţdá hlava je přibliţně 9 palcŧ vysoká)   

o Heroic Model: (model hrdiny) 9 hlav (kaţdá hlava je přibliţně 9 palcŧ vysoká) 

Mŧţete vytvářet zajímavé efekty pomocí aplikace rozdílných nastavení výšky na rozdílné figury. 
 

NASTAVENÍ MATEŘSKÝCH VAZEB FIGURY  SET FIGURE PARENT (orig.272) 

Mŧţete připojit rekvizity k části těla, části těla k dalším částem, figury k rekvizitám, figury k figurám, 
kamery k částem těla, seznam pokračuje dále a dále. Nastavením mateřských vazeb dojde  
k vytvoření hierarchických vzájemných vztahŧ, jak je popsáno  
v materiálu Poser 7 Tutorial Manual: “Hierarchy”. Mŧţete přiřadit 
kompletní figury k dalším rŧzným prvkŧm scény. Pro nastavení 
mateřských vazeb figury: 

1. Vyberte figuru, u které chcete nastavit mateřskou vazbu 
(vytvořit z ní podřízený prvek child jiného objektu). 

2. Zvolte příkaz Figure>Set Figure Parent pro otevření 
dialogového okna Figure Parent: 

3. Vyberte poţadovaný nadřízený objekt parent a klikněte na 
tlačítko OK. Pro nastavení mateřské vazby rekvizity, kamery, 
atd., zvolte příkaz Object>Change Parent, jak je popsáno  
v části “Změna mateřských vazeb” na straně 201. 

 

PŘIZPŮSOBENÍ  CONFORM TO (orig.273) 

Volbou Figure>Conform To dojde k přizpŧsobení aktuálně vybrané části na míru vytvořeného oděvu 
k odpovídající figuře Poseru 7. Prosím navštivte téma “Přidání oblečení” na straně 37 pro více 
informací o přizpŧsobení přizpŧsobivého oblečení figuře. Prosím navštivte také některé z online 
diskuzních fór (vyjmenovaných v části “Ostatní fóra” na straně 13) pro více informací a pro návody na 
vytváření přizpŧsobivého oblečení. 
 

VYTVOŘENÍ MORPHINGU CELÉ POSTAVY  
CREATE FULL BODY MORPH (orig.273) 

Volbou Figure>Create Full Body Morph bude vytvořen morph target celé postavy pro aktuálně 
vybranou figuru. Prosím navštivte téma “Tvorba Full-Figure morph targetu” na straně 122 pro více 
informací o vytvoření morphingu celé postavy. 

 POZNÁMKA 
TOTO JE SPRÁVNÁ CESTA PRO VYTVOŘENÍ MORPHINGU CELÉ POSTAVY.  POUŢITÍ PŘÍKAZU 
FILE>EXPORT>OBJ  NEFUNGUJE. 
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POUŢITÍ INVERZNÍ KINEMATIKY  USE INVERSE KINEMATICS (orig.273) 

Inverzní kinematika přidá realismus do Vašich scén. Inverzní kinematiku (IK) mŧţete zapínat a vypínat 
u následujících končetin: 

o Levá noha Left Leg 

o Pravá noha Right Leg 

o Levá ruka Left Arm 

o Pravá ruka Right Arm 

Pro zapnutí nebo vypnutí IK u konkrétní končeny, zvolte Figure>Use Inverse Kinematics> 
končetina, kde končetina je jedna ze čtyř končetin. Zatrţené políčko vedle končetiny signalizuje, ţe IK 
je aktivní pro tuto končetinu, a naopak. Prosím navštivte téma “Inverzní kinematika (IK)” na straně 69 
pro více informací o inverzní kinematice. 
 

POUŢITÍ LIMITŮ  USE LIMITS (orig.274) 

Volbou Figure>Use Limits se zapínají a vypínají parametry limitŧ. Prosím navštivte téma “Editace 
otočných ovladačů parametrů” na straně 78 pro více informací o nastavení limitŧ otočných ovladačŧ 
parametrŧ. Figury obsaţené ve Vaší kopii Poseru 7 mají aplikovány realistické limity, tím je myšleno, 
ţe nemŧţete například ohýbat koleno dozadu. Limity nejsou aktivní pokud jsou vypnuty (nastaveno 
off). 
 

GENITÁLIE  GENITALIA (orig.274) 

Některé nahé modely muţŧ a ţen jsou anatomicky korektní. Volbou Figure>Genitalia je zapínáno 
nebo vypínáno zobrazení genitálií. 

 POZNÁMKA 
MNOHO FIGUR ŢEN NEMÁ VYMODELOVÁNY GENITÁLIE, MÍSTO TOHO SE AUTOŘI PRO 
VYTVOŘENÍ VZHLEDU GENITÁLIÍ SPOLÉHAJÍ NA POUŢÍTÍ TEXTUR/BUMP/PRŦHLEDNOSTI. 
VÝŠE UVEDENÁ FUNKCE FUNGUJE POUZE NA FIGURY S VYMODELOVANÝMI GENITÁLIEMI, 
KTERÉ MOHOU BÝT TOUTO FUNKCÍ NASTAVOVÁNY. PRO ODSTRANĚNÍ GENITÁLIÍ FIGURY 
ŢENY, KTERÁ NEMÁ VYMODELOVÁNY GENITÁLIE, MŦŢETE MODIFIKOVAT MAPU TEXTURY. 
FIGURY JUDY A JESSI MAJÍ GENITÁLIE VYMODELOVÁNY A  MOHOU BÝT TOUTO FUNKCÍ 
KONTROLOVÁNY. 

 POZNÁMKA 
RŦZNÉ FIGURY NABÍZEJÍ RŦZNÉ MECHANIZMY 
PRO PRÁCI S GENITÁLIEMI, ALE NE VŠECHNY 
MOHOU BÝT FUNKCÍ FIGURE>GENITALIA 
OVLÁDÁNY. NĚKTERÉ NOVĚJŠÍ FIGURY, JAKO JE 
G2 MUŢSKÁ FIGURA, OBSAHUJÍ GENITÁLIE, 
KTERÉ JSOU VYTVOŘENY JAKO SEPARÁTNÍ 
NASTAVITELNÉ FIGURY. 
 

AUTO BALANCE  AUTO BALANCE (orig.274) 

Funkce Auto Balance je cenným nástrojem pro pomoc 
k vytvoření realistických póz. Pokud je aktivována, 
Poser 7 vypočítává matematickou rovnováhu figury  
a udrţuje ji. V následujícím příkladu, je více váhy  
v bocích figury neţ v centrální části trupu. Pokud 
vytváříte pózu figury, Auto Balance nastavuje 
jednotlivé části těla pro udrţení originálního rozloţení 
váhy, výsledkem jsou více přirozené pózy bez nutnosti 
pouţití velkého počtu nastavení. Pro další ovlivnění 
rozloţení váhy a kompenzačních výpočtŧ mŧţete 
změnit pozici Center of Mass Control Object 
(červeně lemovaná koule) v základu figury. Tento 
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ovladatelný objekt je posunovatelný podle os X a Z na základní ploše. Posunutí Center of Mass 
Control Object také nastaví Center of Mass Indicator, který vypadá jako šrafovaná koule na ploše 
XZ (podlaze) pod figurou. Tento indikátor zobrazuje pozici, nad kterou je umístěno těţiště vypočítané 
z váhy částí těla a pozice Control Object. 

Pokud pouţijete funkci Auto Balance, postupujte v pohybu po malých krocích k dosaţení nejlepšího 
výsledku. Velké pohyby mohou vytvořit drastické výsledky. Pokud toto nastane, obnovte figuru tak, jak 
je popsáno v části “Obnovení” na straně 193. Pro dosaţení realistické pozice mŧţete během práce  
s funkcí Auto Balance také aktivovat limity pomocí volby Figure>Use Limits. 

Volbou Figure>Auto Balance zapínáte funkci Auto Balance pro vybranou figuru. Pokud je funkce 
aktivována, ovladače těţiště jsou viditelné na spodku figury a v menu se u předvolby objeví značka 
zatrţení. Opětovným spuštěním dojde k vymazání zatrţení a vypnutí funkce Auto Balance pro 
vybranou figuru. 
 

UZAMČENÍ FIGURY  LOCK FIGURE (orig.275) 

Volbou Figure>Lock Figure dojde k uzamčení figury v aktuální pozici. Nemŧţete měnit pózu nebo 
pohybovat uzamčenou figurou. Toto je významný zpŧsob ochrany Vaší práce v komplexních scénách 
v případech, pokud máte dokončené nastavení pózy figury a nechcete následně figurou pohnout. 
Pokud je aktuálně vybraná figura uzamčena zobrazí se v menu značka zaškrtnutí. Opětovným 
spuštěním fukce dojde k vymazání zatrţení a k odemčení figury. 
 

UZAMČENÍ ČÁSTÍ RUKY  LOCK HAND PARTS (orig.275) 

Volbou Figure>Lock Hand Parts dojde k uzamčení pozice vybrané ruky figury, zabraņujícímu 
následným nechtěným změnám její pozice při nastavování pozice zbývající části figury. Pro pouţití 
této funkce: 

1. Vyberte ruku určenou k uzamčení. 

2. Zvolte Figure>Lock Hand Parts. Ruka je nyní uzamčena. Tato funkce není dostupná pro všechny 
figury Poseru. 

Prosím navštivte téma “Pózování rukou” na straně 81 pro více informací o nastavování pozice rukou. 
 

PŘICHYTIT K PODLAZE  DROP TO FLOOR (orig.275) 

Mŧţete umístit figuru do jakékoliv pozice, například do středu výskoku. Mŧţete ponechat figuru ve 
vzduchu, nebo ji podle potřeby sníţit k zemi. Volbou Figure>Drop to Floor přichytíte nejniţší část 
vybrané figury nebo rekvizity do kontaktu s podlahou pracovního prostoru. Pro zobrazení podlahy 
navštivte téma “Základní rovina” na straně 207. 
 

SYMETRIE  SYMMETRY (orig.276) 

Funkce Symmetry umoţņuje kopírovat charakteristiky pózy z 
jedné strany postavy na druhou, coţ mŧţe ušetřit čas při 
vytváření scény v místnosti póz Pose room nebo pokud 
vytváříte uţivatelské figury za pouţití místnosti nastavení 
Setup room. Nastavte pózu ruky anebo nohy a pouţijte tento 
příkaz pro okamţitou aplikaci stejné pozice na opačnou 
stranu těla. Také mŧţete prohazovat úplné pozice postavy ze 
strany na stranu a srovnávat tak aktuálně vybrané části těla 
figury: 

Obrázek vpravo – figura před aplikací symetrie: 

Zvolením funkce Figure>Symmetry se otevírá menu 
Symmetry, které obsahuje následující předvolby pro 
aktuálně vybranou figuru: 

o Left to Right: Volbou Left to Right budou aplikovány pozice kostí z levé strany figury na pravou 
stranu. 
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o Right to Left: Volbou Right to Left budou aplikovány 
pozice kostí z pravé strany figury na levou stranu. 

Obrázek vpravo – figura po aplikaci symetrie: 

o Swap Right and Left: Volbou Swap Right and Left 
budou prohozeny pozice kostí mezi pravou a levou 
stranou figury. 

o Left Arm to Right Arm: Volbou Left Arm to Right Arm 
bude upravena pozice kostí pravé ruky stejně podle 
pozice ruky levé. 

o Right Arm to Left Arm: Volbou Right Arm to Left Arm 
bude upravena pozice kostí levé ruky stejně podle pozice 
ruky pravé. 

o Swap Right and Left Arms: Volbou Swap Right and Left 
Arms budou prohozeny pozice kostí rukou mezi pravou  
a levou stranou figury. 

o Left Leg to Right Leg: Volbou Left Leg to Right Leg 
bude upravena pozice kostí pravé nohy stejně podle 
pozice nohy levé.  

Obrázek vpravo – figura po aplikaci prohození Swap: 

o Right Leg to Left Leg: Volbou Right Leg to Left Leg 
bude upravena pozice kostí levé nohy stejně podle 
pozice nohy pravé. 

o Swap Right and Left Legs: Volbou Swap Right and Left 
Legs budou prohozeny pozice kostí nohou mezi pravou  
a levou stranou figury. 

o Straighten Torso: Volbou Straighten Torso srovnáte trup figury (boky, břicho, hrudník). 

Pokud vyberete funkci Symmetry, zobrazí se dialog s dotazem zda si přejete kopírovat také 
nastavení zón kloubŧ. Klikněte na Yes pro aplikaci symetrie na strukturu kostí, nebo na No pro 
zabránění okopírování nastavení zón kloubŧ. 

 POZNÁMKA 
SYMETRIE TAKÉ KOPÍRUJE NASTAVENÍ PRVKU (MORPH TARGETY, DEFORMACE, 
PARAMETRY, ATD.) Z JEDNÉ STRANY NA DRUHOU. POKUD MÁTE NAPŘÍKLAD ZMĚNĚNOU 
VELIKOST LEVÉ RUKY NA 200% A APLIKUJETE SYMETRII Z LEVÉ STRANY NA PRAVOU, 
DRUHÁ RUKA ZMĚNÍ ODPOVÍDAJÍCÍM ZPŦSOBEM SVOJI VELIKOST. NEPOUŢÍVEJTE TUTO 
FUNKCI, POKUD SI CHCETE ZACHOVAT ASYMETRICKÉ NASTAVENÍ FIGURY. 
 

VYMAZÁNÍ FIGURY  DELETE FIGURE (orig.277) 

Volbou Figure>Delete Figure dojde k vymazání aktuálně vybrané figury. Zobrazí se potvrzovací 
dialog. Klikněte na OK k provedení vymazání nebo na Cancel pro zrušení příkazu. Uţivatelé Windows 
mohou také figuru vymazat pomocí stisku klávesy [DEL]. 
 

SKRYTÍ FIGURY  HIDE FIGURE (orig.277) 

Volbou Figure>Hide Figure dojde ke skrytí aktuálně vybrané figury v případě, ţe máte více figur ve 
scéně. Tato funkce je uţitečná pokud pracujete s komplexními scénami, obzvláště pokud Vám figura 
zavazí ve výhledu. Figuru mŧţete také skrýt pomocí výběru části Body v rozbalovacím menu Select 
Element a odznačením políčka Visible v paletě vlastností Properties jak je popsáno v části “Paleta 
vlastností” na straně 75. 

 POZNÁMKA 
NA SKRYTÉ OBJEKTY NEAPLIKUJTE NASTAVENÍ IDENTIFIKACE KOLIZE. 
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ZOBRAZIT VŠECHNY FIGURY  SHOW ALL FIGURES (orig.277) 

Volbou Figure>Show All Figures zobrazíte všechny skryté figury ve scéně. Zviditelnit skryté figury 
mŧţete také označením políčka Visible v paletě vlastností Properties. Pokud jedna nebo více částí 
postavy jsou nastaveny jako neviditelné, tyto zŧstanou stále neviditelné i po zobrazení figury. 
 

VYTVOŘENÍ DRÁHY CHŮZE  CREATE WALK PATH (orig.277) 

Dráha chŧze je určena pro práci s nástrojem designeru chŧze Walk Designer (viz téma “Použití 
designeru chůze” na straně 98). Zatímco Walk Designer specifikuje zpŧsob 
chŧze figury, dráha chŧze specifikuje kudy figura pŧjde. Dráha chŧze je 
křivka, nakreslená v pracovním okně Document, která určuje figuře směr 
během jejího pohybu v pracovním prostoru Poseru 7. Vytvořte dráhu, 
nastavte zpŧsob chŧze a figura pŧjde po dráze od začátku do konce, na 
konci se zastaví. 

Pro vytvoření dráhy chŧze zvolte Figure>Create Walk Path. V pracovním 
prostoru Poseru 7 se zobrazí základní dráha. Doporučujeme přepnout na 
horní Top kameru a oddálit pohled pro lepší náhled na scénu a na dráhu 
chŧze, avšak mŧţete pracovat za pouţití jakékoliv jiné kamery. Následující 
obrázek znázorņuje základní dráhu chŧze:  

 POZNÁMKA 
DRÁHA CHŦZE MUSÍ BÝT VYTVOŘENA NA ZÁKLADNÍ PLOŠE. 
 

TVAROVÁNÍ ZATÁČEK   
SHAPING CURVES (orig.278) 

Umístění zatáček je definováno pomocí ovládacích bodŧ. Klikněte 
a táhněte ovládacím bodem pro vytvoření zatáčky dráhy chŧze 
podle libosti:  

Mŧţete změnit pozici začátku a konce dráhy chŧze pomocí 
přetaţení koncových ovladacích bodŧ. Mŧţete také měnit pozici 
kompletní dráhy chŧze pomocí výběru kruhu, který se zobrazí 
během přiblíţení kurzoru ke dráze chŧze a který funguje obdobně 
jako kruh figury Figure Ring popisovaný v části “Výběr částí 
postavy” na straně 71. 
 

PŘIDÁVÁNÍ A ODEBÍRÁNÍ 
OVLÁDACÍCH BODŮ 
ADDING AND REMOVING CONTROL POINTS (orig.278) 

Pro přidání kontrolního bodu jednoduše klikněte kdekoliv na 
čáru dráhy chŧze. Zobrazí se nový ovládací bod. Přidáním 
ovládacích bodŧ mŧţete detailně propracovat anebo 
prodlouţit dráhu chŧze:  

Pro smazání ovládacího bodu stlačte a podrţte klávesu 
[OPT]/[ALT] a současně klikněte na bod, který si přejete 
odstranit. 

Jakmile máte dokončenu dráhu chŧze, pouţijte designer chŧze Walk 
Designer pro nastavení zpŧsobu chŧze Vaší figury. Prosím navštivte 
téma “Použití designeru chůze” na straně 98 pro více informací o Walk 
Designeru. 

 POZNÁMKA 
PROTOŢE STEJNĚ JAKO V PŘÍRODĚ JE PRO DRÁHU CHŦZE 
POUŢÍVÁNA KŘIVKA, NENÍ MOŢNÉ VYTVOŘIT OSTŘE PRAVOŦHLÉ 
ZATOČENÍ. TAKOVÉ A DALŠÍ NÁHLÉ ZMĚNY SMĚRU VYTVOŘÍ VE 
VÝSLEDKU  NEPŘIROZENĚ VYHLÍŢEJÍCÍ CHŦZI. 
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 POZNÁMKA 
JAKMILE MÁTE VYTVOŘENU CHŦZI POMOCÍ WALK DESIGNERU, MŦŢETE DRÁHU CHŦZE 
VYMAZAT. FIGURA SE BUDE DÁLE POHYBOVAT TAK, JAKO BY DRÁHA CHŦZE BYLA STÁLE 
PŘÍTOMNA. 
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Kapitola 26: Menu objektu  THE OBJECT MENU (orig.279) 

Menu objektu Object menu umoţņuje manipulaci s objekty uvnitř scény. 
 

VLASTNOSTI  PROPERTIES (orig.279) 

Volbou Object>Properties otevřete paletu vlastností Properties pro aktuálně vybraný element scény. 
Prosím navštivte téma “Paleta vlastností” na straně 75 pro více informací o paletě Properties. 
 

UZAMČENÍ PRVKU  LOCK ACTOR (orig.279) 

Volbou Object>Lock Actor dojde k uzamčení aktuálně vybraného prvku scény (části těla, rekvizity, 
atd.). Pro uzamčení poţadovaného prvku jej nejdříve vyberte a potom zvolte Object>Lock Actor. 
Aktuálně vybraný prvek bude uzamčen, to znamená, ţe jím nemŧţe být pohybováno relativně vŧči 
jemu nadřazenému (mateřskému) prvku. Například pokud je loket ohnut 45 stupņŧ relativně vŧči 
nadloktí, bude zafixován v této pozici. Uzamčení prvkŧ je významný zpŧsob ochrany Vaší práce  
v případě, ţe jiţ máte perfektně nastavenou pózu figury. 

Pro odemčení uzamčeného prvku jej označte a zvolte Object>Lock Actor. Zobrazí se menu, ve 
kterém je označeno políčko, které znázorņuje, ţe vybraný prvek je uzamčený a opětovnou volbou 
funkce dojde k odznačení políčka a k odemčení prvku. 
 

ZMĚNA MATEŘSKÝCH VAZEB  CHANGE PARENT (orig.279) 

Mŧţete připojit rekvizity k částem těla, 
části těla k dalším částem, figury k 
rekvizitám, figury k figurám, kamery k 
částem těla a tak dále. Nastavením vazeb 
dojde k vytvoření hierarchických 
vzájemných vazeb, jak je popsáno v Poser 
7 Tutorial Manual: “Hierarchy”. Mŧţete 
dokonce určovat, zda se svázané rekvizity 
budou ohýbat spolu s jejich nadřazenými 
částmi těla. Některé předměty jako 
sluneční brýle, apod. by neměly být 
ohýbány. Oproti tomu jiné předměty, jako 
chrániče loktŧ by měly být ohýbány se 
svými nadřazenými částmi těla. Měli byste 
nastavit mateřské vazby rekvizit před 
nastavováním pózy figury, jinak mŧţe být 
těţké srovnání rekvizity, jakmile figura 
změní svou pózu (například meč v ruce 
bojovníka).   

Zde je příklad míče, svázaného mateřskou vazbou s pravou rukou figury:  

Mŧţete také svázat ţidli s boky figury a pohybovat jí v závislosti na pohybu 
figury: 

Moţnosti volby mateřských vazeb jsou prakticky neomezené. Například 
pokud vytvoříte mateřskou vazbu kamery s hlavou figury, mohou vzniknout 
zajímavé vizuální efekty. 

Pro nastavení mateřské vazby prvku:  

1. Vyberte prvek, který si přejete svázat (vytvořit podřízený child prvek 
jiného prvku). 

2. Podle potřeby pouţijte editační nástroje Editing tools, deformace 
anebo otočné ovladače parametrŧ pro nastavení pozice a tvaru prvku. 
Zajistěte správné umístění pomocí detailního náhledu (jako je Lit 
Wireframe), přiblíţení pohledu, nebo testu renderu. Také mŧţete 
aktivovat funkci detekce kolize Collision Detection pro zamezení 
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prolnutí vybraného prvku do nadřazeného parent prvku, nebo 
naopak. Prosím navštivte téma “Kolize” na straně 42 pro více 
informací o funkci detekce kolize Collision Detection. 

3. Zvolte Object>Change Parent (nebo klikněte na tlačítko Set 
Parent v paletě vlastností Properties) pro otevření dialogu 
Figure Parent: 

4. Vyberte poţadovaný nadřazený parent prvek (prvek, ke 
kterému bude aktuálně vybraný prvek připojen). 

5. Jesli chcete rekvizitu ohýbat společně s nadřazeným prvkem, 
označte políčko Inherit bends of parent (dědit ohyby po 
rodiči). 

6. Klikněte na tlačítko OK.  

 POZNÁMKA 
POKUD VYBERETE V OKNĚ HIERARCHIE POUZE JEDEN PRVEK, MŦŢETE POKLIKAT NA JEHO 
POLOŢKU PRO POTVRZENÍ VOLBY A NÁSLEDNĚ ZAVŘÍT OKNO. 

V představených příkladech jsme nastavili vazbu míče k nadřazenému parent prvku – pravé ruce 
figury a ţidli k bokŧm figury. Pro nastavení mateřských vazeb libovolné figury zvolte Figure>Set 
Figure Parent jak je popsáno v části “Nastavení mateřských vazeb figury” na straně 195. 
 

ZAMĚŘIT NA  POINT AT (orig.281) 

Mŧţete zaměřit části těla, kamery, rekvizity, světla, atd. na jiný prvek scény za pouţití příkazu Point 
At. Toho je moţné vyuţít v početných situacích, například pokud oči figury sledují pohybující se prvek,  
při udrţování kamery zaměřené na určitou akci, atd. Vŧči mateřským vazbám je toto odlišné tím, ţe 
nedochází k vytvoření ţádných hierarchických vztahŧ. Jeden prvek je jednoduše zaměřen na další.  
V kontrastu na to, hierarchicky svázané prvky udrţují přesnou pozici a orientaci ke svým nadřazeným 
parent prvkŧm. 

Pro zaměření prvku na jiný prvek: 

1. Vyberte prvek, který si přejete zaměřit na jiný prvek pouţitím 
rozbalovacího menu Select Item. 

2. Zvolte Object>Point At pro otevření dialogového okna se 
seznamem prvkŧ ve scéně. 

Vyberte prvek, určený jako cíl k zaměření a klikněte na OK.  
U prvku, který byl takto zaměřen na jiný objekt se objeví 
parametrický Point At ovladač v paletě parametrŧ Parameters. 
Nastavením hodnoty 1 bude prvek přímo zaměřen na vybraný cíl, 
nastavním hodnoty 0 bude prvek zaměřen do své základní polohy 
mimo cíl.  

 POZNÁMKA 
POKUD VYBERETE V OKNĚ HIERARCHIE POUZE JEDEN PRVEK, MŦŢETE POKLIKAT NA JEHO 
POLOŢKU PRO POTVRZENÍ VOLBY A NÁSLEDNĚ ZAVŘÍT OKNO. 

Pro vypnutí zaměření prvku: 

1. Vyberte zaměřený prvek. 

2. Zvolte Object>Point At. 

3. Stiskněte tlačítko None v zobrazeném dialogovém okně a klikněte na OK. 
 
 

NAHRAZENÍ ČÁSTI TĚLA REKVIZITOU   
REPLACE BODY PART WITH PROP (orig.282) 

Poser 7 umoţņuje nahrazení některé části těla rekvizitou, jako je například hák na pirátově ruce, nebo 
muchomŧrka místo hlavy muţe (obrázek dále). Tento příklad byl vytvořen pomocí importu modelu 
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muchomŧrky a následného nahrazení hlavy figury touto muchomŧrkou. 
Měli byste nahrazovat části těla rekvizitami ještě před nastavováním pózy 
figury tak, aby umístění rekvizity bylo snadnější. Pro nahrazení části těla 
rekvizitou: 

Přidejte nebo importujte poţadovanou rekvizitu.  

Nastavte pozici a deformaci rekvizity podle poţadovaného vyuţití pomocí 
editačních nástrojŧ Editing tools, deformátorŧ anebo otočných ovladačŧ 
parametrŧ. Ujistěte se, ţe rekvizita mírně přesahuje do těla postavy (ve 
většině případech) pro vyvarování se vzniku “trhliny” v místě, kde se 
postava setkává s rekvizitou. Moţná byste také mohli část těla, která má 
být nahrazena, zneviditelnit pouţitím palety vlastností Properties jak je 
popsáno v části “Paleta vlastností” na straně 75. 

Zvolte Object>Replace Body Part with Prop pro otevření dialogu Replace 
Part. 

Zvolte rekvizitu pro nahrazení pouţitím rozbalovacího menu Prop  
a klikněte na OK. Rekvizita si převezme jméno části postavy, kterou 
nahradila. 

Pokud nahrazená část postavy nevypadá dobře, zkuste vyřadit ohyb pomocí výběru nahrazené části 
postavy a odznačením políčka Bend v paletě vlastností Properties. Mŧţete také pouţít paletu editoru 
kloubŧ Joint Editor pro provedení úprav. Toto je pokročilá funkce a musí být pouţívána s opatrností. 
Prosím navštivte téma “Editor kloubŧ” na straně 183 pro více informací o pouţití palety editoru kloubŧ 
Joint Editor. Rekvizity obsahují vlastní materiálové skupiny (viz Poser 7 Tutorial Manual: “Multi/Sub-
object Materials”), to znamená ţe mŧţete pouţít stínování stejně jako u ostatních materiálových 
skupin ve scéně. 

 POZNÁMKA 
REKVIZITY NAHRAZUJÍCÍ  ČÁSTI POSTAVY, SI UDRŢUJÍ TAKOVOU SVOU POLOHU VŦČI 
POSTAVĚ, JAKOU MĚLY PŘED KONVERZÍ. OVĚŘTE SI JEŠTĚ PŘED PROVEDENÍM 
NAHRAZENÍ ČÁSTI POSTAVY UMÍSTĚNÍ REKVIZITY DO POŢADOVANÉ POLOHY. 
 

ZMĚNA FIGUR POMOCÍ NAHRAZENÍ GEOMETRIE  
CHANGING FIGURES WITH REPLACED GEOMETRY (orig.282) 

Pokud se pokoušíte změnit figuru, která má rekvizitu jako část těla, pomocí funkce Change v paletě 
knihoven Library, zbrazí se upozornění s dotazem, zda si přejete pouţít novou geometrii nahrazením 
staré: 

o Pro pouţití rekvizit, které nahrazují části těla, zvolte tlačítko Keep modified geometries. Pro 
pouţití rekvizit napojených na mateřské části nové figury, označte poloţku the Keeps props 
attached to figure. Klikněte na tlačítko OK jakmile jste hotovi. 

o Pro navrácení změn geometrie zpět a pro obnovení základní geometrie postavy jednoduše znovu 
nahrajte originální figuru z palety knihoven Library. 

 

NAČTENÍ MORPH TARGETU  LOAD MORPH TARGET (orig.283) 

Volba Object>Load Morph Target umoţņuje načtení (aplikaci) morph targetu pro aktuálně vybraný 
prvek. Prosím navštivte téma “Tvorba a použití morph targetů” na straně 117 pro více informací  
o morph targetech. 
 

ZPLOZENÍ MORPH TARGETU  SPAWN MORPH TARGET (orig.283) 

Volbou Object>Spawn Morph Target vytvoříte morph target z deformovaných objektŧ (částí těla, 
rekvizit) ve Vaší scéně. Budete dotázáni na pojmenování nového morph targetu a v paletě parametrŧ 
objektu Parameters se objeví otočný ovladač stejného jména. Prosím navštivte téma “Tvorba  
a použití morph targetů” na straně 117 pro více informací o morph targetech. 
 

VYTVOŘENÍ MAGNETU  CREATE MAGNET (orig.283) 

Volbou Object>Create Magnet vytvoříte deformaci pomocí magnetu. 
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Prosím navštivte téma “Magnety” na straně 111 pro více informací  
o magnetech.  
 

VYTVOŘENÍ VLNY  CREATE WAVE (orig.283) 

Volbou Object>Create Wave vytvoříte deformaci pomocí zvlnění. 

Prosím navštivte část “Vlnové deformátory” na straně 114 pro více 
informací o deformacích pomocí zvlnění.  
 

VYTVOŘENÍ SVĚTLA  CREATE LIGHT (orig.283) 

Volbou Object>Create Light vytvoříte nové světlo. Mŧţete specifikovat typ 
světla, který si přejete vytvořit, zvolením jedné z poloţek ze sub-menu Create 
Light. Typy světel k výběru jsou bodové Spot, nekonečné Infinite, 
všesměrové Point a zaloţené na obrázku IBL. Prosím navštivte kapitolu 9: 
“Osvětlení” na straně 61 pro více informací o světlech. 
 

VYTVOŘENÍ KAMERY  CREATE CAMERA (orig.283) 

Volbou Object>Create Camera vytvoříte novou kameru. Mŧţete specifikovat typ kamery, kterou si 
přejete vytvořit, pomocí zvolení poloţky Revolving nebo Dolly ze sub-menu Create Camera. Otočná 
revolving kamera rotuje okolo středu pracovního prostoru Poseru 7 bez ohledu na pozici objektŧ 
uvnitř scény. Pojízdná dolly kamera rotuje okolo vlastního středu a mŧţe se pohybovat okolo a mezi 
prvky scény. 
 

VYTVOŘENÍ DEFORMACE SILOU VĚTRU   
CREATE WIND FORCE (orig.284) 

Volbou Object>Create Force vytvoříte novou deformaci silou větrného pole.  

Prosím navštivte téma “Silová pole větru” na straně 113 pro více informací  
o silových polích větru.  
 

VYMAZÁNÍ OBJEKTU  DELETE OBJECT (orig.284) 

Volbou Object>Delete Object vymaţete aktuálně vybranou rekvizitu. Zobrazí se dialog pro potvrzení 
akce. Klikněte na tlačítko OK pro vymazání rekvizity, na tlačítko Cancel pro zrušení akce. 
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Kapitola 27: Menu zobrazení THE DISPLAY MENU (orig.285) 

Jak název napovídá, v menu zobrazení Display menu je moţné ovládat vzhled poloţek v pracovním 
prostoru Poseru 7, konkrétně uvnitř pracovního okna Document. 
 

POHLED KAMERY  CAMERA VIEW (orig.285) 

Volba Display>Camera View umoţņuje výběr pohledu jedné z kamer, dostupných ve Vaší scéně. 
Prosím navštivte kapitolu 8: “Kamery” na straně 53 pro více informací o kamerách. 
 

ZOBRAZENÍ NÁZVŮ KAMER  SHOW CAMERA NAMES (orig.285) 

Volbou Display>Show Camera Names dojde k zobrazení názvu aktuálně vybrané kamery v levém 
horním rohu okna náhledu scény v pracovním okně Document. Kliknutím opětovně na tuto volbu 
dojde k vypnutí této funkce. 
 

PRACOVNÍ SNÍMEK  PRODUCTION FRAME (orig.285) 

Volba Display>Production Frame umoţņuje specifikovat, který pracovní snímek bude zobrazen  
v okně náhledu scény v pracovním okně Document. Také mŧţete vybírat mezi poloţkami zobrazení 
pracovního snímku Image Output Size a Movie Output Size. Velikost pracovního snímku je určena 
poměrem vyplývajícím ze šířky a výšky výstupu. Viz téma “Rozměry renderu” na straně 47 a kapitola 
39: “Rendering animací” na straně 262 pro více informací o konfiguraci výstupních rozměrŧ obrázkŧ  
a animací. 
 

STYL DOKUMENTU  DOCUMENT STYLE (orig.285) 

Volba Display>Document Style umoţņuje výběr stylu zobrazení kompletní scény Poseru 7. Toho 
samého je moţné dosáhnout pouţitím ovladačŧ zobrazení Display controls. Prosím navštivte 
kapitolu 7: “Ovladače zobrazení” na straně 50 pro více informací o stylech zobrazení. 
 

STYL FIGURY  FIGURE STYLE (orig.285) 

Volba Display>Figure Style umoţņuje výběr stylu zobrazení aktuálně vybrané figury Poseru 7. Toho 
samého je moţné dosáhnout pouţitím ovladačŧ zobrazení Display controls. Prosím navštivte 
kapitolu 7: “Ovladače zobrazení” na straně 50 pro více informací o stylech zobrazení. 
 

STYL PRVKU  ELEMENT STYLE (orig.286) 

Volba Display>Element Style umoţņuje výběr stylu zobrazení aktuálně vybraného prvku scény. Toho 
samého je moţné dosáhnout pouţitím ovladačŧ zobrazení Display controls. Prosím navštivte 
kapitolu 7: “Ovladače zobrazení” na straně 50 pro více informací o stylech zobrazení. 
 

BLEDNUTÍ  DEPTH CUED (orig.286) 

Volba Display>Depth Cued zapíná a vypíná blednutí. 
Blednutí vytváří hloubku prostoru tím, ţe zesvětluje 
objekty, které se nacházejí dále od kamery. Pokud je 
funkce aktivní, objeví se značka zatrţení a naopak. 
Prosím navštivte téma “Blednutí a stíny” na straně 46 pro 
více informací o blednutí.  
 

SLEDOVÁNÍ CÍLE  TRACKING (orig.286) 

Volba Display>Tracking umoţņuje nastavení 
poţadovaného módu sledování pohybu cílového prvku. 
Prosím navštivte téma “Mód sledování cíle” na straně 45 
pro více informací o módech sledování cíle. 
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DEFORMÁTORY  DEFORMERS (orig.286) 

Jak název napovídá, deformátory (morph targety, parametry, silová pole a magnety) ovlivņují tvary 
figur a rekvizit ve Vaší scéně. Kaţdý typ deformátoru je probírán ve své sekci v této uţivatelské 
příručce. Volba Display>Deformers umoţņuje: 

o Zobrazení všech deformátorŧ (magnetŧ, zvlnění a silových polí) ve Vaší scéně (Display> 
Deformers>Show All). 

o Skrytí všech deformátorŧ ve Vaší scéně (Display>Deformers>Hide All). 

o Zobrazení jen aktuálně vybraných deformátorŧ (Display>Deformers>Show current selection 
only). 

U aktuálně vybraného módu zobrazení deformátorŧ se zobrazí značka zátrţítka. Mŧţete vybírat skryté 
deformátory pouţitím rozbalovacího menu Current Actor. Skrytím některých nebo všech deformátorŧ 
mŧţete zamezit případnému zmatku, zejména v komplexních scénách. 
 

STÍNY NA PODLAZE   
GROUND SHADOWS (orig.287) 

Volbou Display>Ground Shadows zobrazíte nebo 
skryjete stíny na podlaze, jak je znázorněno: 

Prosím navštivte téma “Blednutí a stíny” na straně 46 
pro více informací o stínech na podlaze.  
 

KRUH FIGURY  FIGURE CIRCLE (orig.287) 

Volba Display>Figure Circle umoţņuje zobrazení 
bílého kruhu okolo aktuálně vybrané figury ve scéně, 
který změní barvu na červenou po kliknutí kurzorem, coţ umoţņuje aktuální výběr kompletní figury. 
Prosím navštivte téma “Výběr částí postavy” na straně 71 pro více informací o kruhu figury Figure 
Circle. 
 

OHÝBÁNÍ ČÁSTÍ TĚLA  BEND BODY PARTS (orig.287) 

Volba Display>Bend Body Parts zapíná a vypíná ohýbání. Všechny 
části těla jsou samostatnými elementy (prvky). Pokud změníte jejich 
pozici, Poser 7 se snaţí udrţovat spojitost celého povrchu těla. Ruka 
by měla být hladce napojena na rameno, apod. Poser 7 dosahuje 
těchto hladkých přechodŧ pomocí ohýbání prvkŧ v místech napojení. 
Nicméně ohyby, které vypadají dobře mezi částmi těla, nemusí 
vyhovovat u figury vytvořené z rekvizit nebo u figury, jejíţ část těla 
byla nahrazena rekvizitou (jako například ruka piráta nahrazená 
hákem). Rendering obrázkŧ s vypnutým ohýbáním částí těla mŧţe 
zpŧsobit, ţe figury vypadají jako roztrţené, jak je zobrazeno vedle.  
 

BARVY POPŘEDÍ/POZADÍ  FOREGROUND/BACKGROUND COLOR (orig.287) 

Volba Display>Foreground Color nebo Display>Background Color umoţņuje specifikovat barvy 
popředí a pozadí pracovního okna Document. Totéţ mŧţete provést pomocí ovladačŧ Color, 
umístěných na spodním okraji pracovního okna Document. Prosím navštivte téma “Barvy” na straně 
46 pro objasnění barev popředí a pozadí. 
 

ZOBRAZENÍ OBRÁZKU NA POZADÍ  SHOW BACKGROUND PICTURE (orig.287) 

Pokud máte ve scéně obrázek na pozadí, který byl vloţen buď pomocí menu File (viz “Import obrázků 
na pozadí“ na straně 186), nebo pomocí vloţení aktuální figury / rekvizity na pozadí (viz dále), potom 
volbou Display>Show Background Picture přepínáte mezi zobrazením a skrytím tohoto obrázku. 
Prosím navštivte téma “Import video souborů” na straně 186 pro více informací o vloţení animace na 
pozadí Vaší Poser 7 scény. 
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ODSTRANĚNÍ OBRÁZKU Z POZADÍ  CLEAR BACKGROUND PICTURE (orig.288) 

Volbou Display>Clear Background Picture vymaţete aktuálně zobrazený obrázek z pozadí (pokud 
nějaký máte). 
 

VLOŢENÍ NA POZADÍ   
PASTE INTO BACKGROUND (orig.288) 

Mŧţete vloţit obrázek aktuálně vybrané figury/rekvizity na pozadí 
Vaší scény:  

K provedení tohoto, vyberte figuru/rekvizitu, jejíţ obrázek se přejete 
umístit na pozadí, potom zvolte Display>Paste Into Background. 
Pokud toto uděláte vícekrát, kaţdý následující obrázek nahradí ten 
předcházející. Toto platí také pro import samostatného 
obrázku/animace na pozadí. 
 

ZOBRAZENÍ ANIMACE NA POZADÍ  SHOW BACKGROUND FOOTAGE (orig.288) 

Volbou Display>Show Background Footage zobrazíte impotrovanou animaci na pozadí pracovního 
prostoru. 
 

ODSTRANĚNÍ ANIMACE Z POZADÍ   
CLEAR BACKGROUND FOOTAGE (orig.288) 

Volbou Display>Clear Background Footage odstraníte importovanou animaci  z Vaší scény. 
 

VODÍTKA  GUIDES (orig.288) 

Poser 7 přináší několik vodítek, které Vám pomáhají při nastavování póz figur. Vodítka jsou zvláště 
uţitečná k jednoduššímu dosaţení precizního vzhledu. Pro zobrazení vodítka zvolte poloţku 
Display>Guides a vyberte si vodítko, které si přejete zobrazit. Vybrané vodítko bude označeno 
zátrţítkem. Pro skrytí vodítka zvolte opět poloţku Display>Guides a vyberte vodítko, které si přejete 
skrýt. Skrytá vodítka nejsou označena zátrţítkem. Dostupná vodítka jsou: 
 

ZÁKLADNÍ ROVINA   
GROUND PLANE (orig.288) 

Základní rovina (podlaha) poskytuje bezprostřední kontrolu relativní pozice 
kamery v pracovním prostoru Poseru 7. Také pomáhá při zobrazení 
vertikální pozice elementŧ scény vŧči ostatním. Základní rovinu mŧţete 
zobrazit ve stejném stylu jako zbytek scény, nebo jí mŧţete dát vlastní styl 
zobrazení. 
 

DÉLKY HLAVY   
HEAD LENGTHS (orig.289) 

Toto vodítko vyjadřuje výšku figury. Mnoho lidí 
je vysokých zhruba sedm “hlav”, to znamená, 
ţe délka prŧměrné hlavy je 1/7 výšky osoby. 
Toto vodítko je uţitečné během provádění 
operací tvarování těla, jako je pouţití morph 
targetŧ.  
 

VZÁJEMNÝ POMĚR BOKŮ A RAMEN   
HIP-SHOULDER RELATIONSHIP (orig.289) 

Toto vodítko zobrazuje vzájemný poměr nastavení mezi horní a spodní 
částí těla figury. Pomáhá Vám zobrazit poměr při posunu ze strany na 
stranu, ohybu a rotace bokŧ, břicha a hrudníku. Toto je uţitečné 
zejména při editaci/prohlíţení figury pomocí rŧzných kamer. 
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ČÁRA HORIZONTU  HORIZON LINE (orig.289) 

Toto vodítko znázorņuje čáru horizontu pracovního prostoru Poseru 7. 
Mŧţete nastavovat pozici kamery jejím označením a zadáním pozice 
relativně vŧči čáře horizontu. Čára horizontu je také uţitečná během 
vytváření perspektívy mezi dvěmi nebo více figurami nebo elementy 
scény. Pokud například čára horizontu kříţí hrudník přední figury, 
nastavte všechny ostatní figury tak, aby čára horizontu kříţila jejich 
hrudníky stejným zpŧsobem. Toto zajistí, ţe všechny figury stojí na stejné 
horizontální rovině a přispěje k divákově pocitu, ţe všechny figury mají 
nohy na podlaze.  
 

ÚBĚŢNÉ ČÁRY  VANISHING LINES (orig.289) 

Úběţné čáry jsou uměleckou technikou pro vytvoření realistické 
perspektivy. V reálném ţivotě je mŧţete vidět, pokud stojíte na rohu dlouhé 
budovy a podíváte se podél zdi. Uvidíte, ţe střecha  
a základy se při pohledu do dáli sbíhají, aţ se eventuálně setkají. Tento 
fenomén je jednou z věcí, které dávají objektŧm v reálném i virtuálním 
světě zdání hloubky. 
 

PRŮVODCE OHNISKOVÉ VZDÁLENOSTI  
FOCUS DISTANCE GUIDE (orig.289) 

Ohnisková vzdálenost je vzdálenost, ve které jsou objekty zobrazeny 
v objektivu kamery. Tato vzdálenost je individuálně konfigurovatelná pro 
kaţdou kameru. Prŧvodce ohniskové vzdálenosti Focus Distance Guide zobrazuje, kde ve scéně 
ohnisková vzdálenost vybrané kamery končí, coţ pomáhá ve vizualizaci pozice rŧzných prvkŧ scény 
ve vztahu k ohniskové rovině. Pro více informací o ohniskové rovině a ohniskové vzdálenosti navštivte 
téma “Parametry kamery” na straně 57.  
 

VYKRESLENÍ NÁHLEDU  PREVIEW DRAWING (orig.290) 

Volba Preview Drawing umoţņuje specifikovat, zda si přejete pouţít OpenGL hardwarový rendering, 
nebo SreeD softwarový rendering pro zobrazení náhledu scény. Prosím navštivte téma “OpenGL 
hardwarová akcelerace” na straně 43 pro více informací o hardwarovém versus softwarovém 
renderingu. 
 

ODSTÍNY KARIKATURY  CARTOON TONES (orig.290) 

Volba Cartoon Tones umoţņuje výběr mezi následujícími předvolbami zobrazení náhledu scény: 
jeden One, dva Two, nebo tři odstíny tónování karikatury Three cartoon shading tones, tři odstíny 
včetně zvýraznění Three Tones Plus Highlights a jemné odstíny Smooth Toned. Tyto zpŧsoby 
tónování fungují speciálně v reţimu zobrazení karikatury Cartoon Display Style a jsou viditelné 
pouze kdyţ poloţka  Cartoon je vybrána v nastavení Document Style, Figure Style, nebo Element 
Style v menu Display. Všimněte si, ţe tyto styly jsou jen pro náhled scény a neměly by být 
zaměnovány se styly tónování finálního renderu. 
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Kapitola 28: Menu renderu THE RENDER MENU (orig.291) 

Menu renderu Render menu je určeno pro rendering stacionárních obrazŧ scény a umoţņuje přístup  
k nastavení renderu Poseru 7. 
 

RENDER  RENDER (orig.291) 

Volbou Render>Render vyrenderujete Vaši aktuální scénu za pouţití aktuálně vybraného renderu  
a aktuálního nastavení renderu. Prosím navštivte Část 5: “Rendering” na straně 243 pro více 
informací o Poser 4 a FireFly renderovacích enginech a o nastavení předvoleb renderu. 
 

RENDER VYBRANÉ PLOCHY  AREA RENDER (orig.291) 

Volbou Render>Area Render aktivujete funkci renderu vybrané plochy Area Render, která umoţņuje 
vybrat určitou oblast aktuální scény pro renderování, čímţ je moţné šetřit pracovní čas. Prosím 
navštivte téma “Render vybrané plochy” na straně 44 pro kompletní popis pouţití této funkce. 
 

RENDEROVÁNÍ SKICY  SKETCH STYLE RENDER (orig.291) 

Volbou Render>Sketch Style Render vyrenderujete skicu scény podle aktuálního nastavení 
designeru skicy Sketch Designer. Prosím navštivte kapitolu 38: “Renderovací nástroj Designér skic” 
na straně 259 pro více informací o práci s designerem skicy Sketch Designer. Jakmile máte jednou 
nastaveny předvolby, mŧţete kdykoliv během práce pouţít tento příkaz pro vytvoření renderu skicy 
scény. 
 

VYHLAZENÍ HRAN V PRACOVNÍM OKNĚ  ANTIALIAS DOCUMENT (orig.291) 

Volba Render>Antialias Document 
vyhladí kostrbaté hrany v pracovním okně 
Document pro účely zobrazení náhledu 
scény. Antialiasing je proces, při kterém 
dojde k převzorkování dat obrázku na 
objekty s vyhlazenými hranami  
a k zabránění zubatého vzhledu okolí hran. 
Následující obrázek zobrazuje test renderu 
bez vyhlazení (vlevo) a včetně vyhlazení 
(vpravo).  

Pouţití antialiasingu při renderování 
mŧţete specifikovat v nastavení renderu.  
Prosím navštivte kapitolu 35: “Dialogové okno nastavení renderu” na straně 243 pro více informací  
o specifikaci nastavení renderu. 
 

ROZMAZÁNÍ POHYBU V PRACOVNÍM OKNĚ   
MOTION BLUR DOCUMENT (orig.292) 

Jak nepochybně víte, rychle pohybující se objekty vypadají 
rozmazaně. Rozmazání zpŧsobuje skutečnost, ţe naše oči 
nedokáţí dostatečně rychle zaostřit objekt v jednotlivých lokacích. 
Funkce 3D Motion Blur umoţņuje Vašim animacím dodat iluzi 
pohybu, zvýšení dynamiky a úrovně realismu renderŧ. 

Prosím navštivte téma “Použití renderovacího nástroje FireFly” na 
straně 249 pro více informací o pouţití funkce 3D Motion Blur. 
Mŧţete také pro testovací účely rozmazat jediný snímek volbou 
Render>MotionBlur Document. 
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NASTAVENÍ RENDERU  RENDER SETTINGS (orig.292) 

Volbou Render>Render Settings dojde k otevření dialogového okna nastavení renderu Render 
Settings. Prosím navštivte kapitolu 35: “Dialogové okno nastavení renderu” na straně 243 pro více 
informací o dialogovém okně Render Settings. 
 

ROZMĚRY RENDERU  RENDER DIMENSIONS (orig.292) 

Volbou Render>Render Dimensions otevřete dialogové okno rozměrŧ renderu Render Dimensions, 
které obsahuje nastavení, kterými mŧţete specifikovat rozměry renderované plochy. Viz téma 
“Rozměry renderu” na straně 47 pro více informací o nastavení v dialogovém okně rozměrŧ renderu 
Render Dimensions. 
 

MATERIÁLY  MATERIALS (orig.292) 

Volbou Render>Materials dojde k otevření místnosti materiálu Material room. Prosím navštivte 
kapitolu 16: “Místnost materiálu” na straně 139 pro více informací o místnosti materiálu Material 
room. 
 

OPĚTOVNÉ NAČTENÍ TEXTUR  RELOAD TEXTURES (orig.292) 

Volbou Render>Reload Textures dojde k opětovnému načtení všech textur aktuálně zobrazeného 
náhledu scény do paměti. Toto umoţņuje jednoduchou aktualizaci náhledu scény v případě, kdy jste 
provedli změny aktuálně načtených textur v jiné aplikaci. 
 

OPĚTOVNÉ POUŢITÍ MAP STÍNŮ  REUSE SHADOW MAPS (orig.292) 

Pokud neprovedete mezi rendery ţádné změny v osvětlení, nebo v pozicích objektŧ, není nutné 
přepočítávání map stínŧ shadow maps Vaší scény, protoţe tyto se také nezměnily. Volbou 
Render>Reuse Shadow Maps umoţníte uloţení map stínŧ shadow maps, které byly vypočteny 
během předchozího renderu a jejich opětovné pouţití, které umoţní ušetřit čas dokončení kaţdého 
následujícího renderu. 
 

VYMAZÁNÍ MAP STÍNŮ  CLEAR SHADOW MAPS (orig.293) 

Volbou Render>Clear Shadow Maps přinutíte Poser 7 přepočítat mapy stínŧ shadow maps Vaší 
scény během následujícího renderu. Tuto volbu pouţijte, pokud jste provedli změny v osvětlení, nebo 
v pozicích objektŧ, které mohou mít vliv na změnu stínŧ Vaší scény (v případě předchozího pouţití 
funkce opětovného pouţití map stínŧ). 
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Kapitola 29: Menu animace THE ANIMATION MENU (orig.294) 

Menu animace Vám umoţņuje ovládání rŧzných aspektŧ animací Poseru 7. 
 

VYTVOŘENÍ FILMU  MAKE MOVIE (orig.294) 

Volba Animation>Make Movie otevírá okno pro tvorbu filmu Make movie. Prosím navštivte kapitolu 
39: “Rendering animací” na straně 262 pro více informací o renderingu animací v Poseru 7. 
 

ZMĚNA ČASOVÁNÍ ANIMACE  RETIME ANIMATION (orig.294) 

Volba Animation>Retime Animation umoţņuje nastavení časování Vašich animací. Prosím navštivte 
téma “Změna časování klíčových snímků” na straně 92 pro více informací. 
 

PŘEVZORKOVÁNÍ KLÍČOVÝCH SNÍMKŮ  RESAMPLE KEY FRAMES (orig.294) 

Volbou Animation>Resample Key Frames otevřete okno pro 
převzorkování klíčových snímkŧ Resample Keys, které umoţņuje 
zvýšení nebo sníţení počtu klíčových snímkŧ Vaší animace: 

Okno obsahuje následující poloţky: 

o Modify: Výběrem příslušného tlačítka zvolíte převzorkování 
klíčových snímkŧ pro aktuální prvek Current Element (rekvizitu, 
část těla, atd.), aktuální figuru Current Figure (kompletní figuru), 
nebo pro vše Everything (kompletní scénu). 

o Resample Method: Máte dvě předvolby pro převzorkování 
klíčových snímkŧ: 

o Automaticky: Výběrem tlačítka předvolby Analyze Curvature 
Poser 7 prozkoumá mnoţství pohybŧ (změn v čase) ve Vaší animaci a automaticky přiřadí nové 
klíčové snímky. 

o Manuálně: Výběrem tlačítka předvolby Make keyframe every a zadáním hodnoty v políčku 
Frames Poser 7 vytvoří klíčový snímek v rozpětí kaţdých X snímkŧ, kde X je hodnota zadaná 
do políčka.  

 

INTERPOLACE SMYČKY  LOOP INTERPOLATION (orig.294) 

Pokud Vaše animace obsahuje opakující se cykly (jako například chŧze), které přesně nenavazují 
(zpŧsobují trhavé pohyby mezi koncem jedné smyčky a začátkem následující), zapnutím funkce 
Animation>Loop Interpolation mŧţete animaci vyhladit. 
 

ČTYŘKOVÁ INTERPOLACE  QUATERNION INTERPOLATION (orig.295) 

Čtyřková interpolace je matematický vzorec, který mŧţe uhladit kostrbaté animace. Pokud Vaše 
animace po editaci klíčových smímkŧ a po dalším vynaloţeném úsilí o uhlazení ještě obsahuje zbytky 
trhavých pohybŧ, volba Animation>Quaternion Interpolation Vám moţná pomŧţe. Tato volba mŧţe 
být pouţita jako poslední východisko. 
 

PŘESKOČENÍ SNÍMKŮ  SKIP FRAMES (orig.295) 

Volbou Animation>Skip Frames zapnete nebo vypnete přeskakování snímkŧ. Tato funkce pomŧţe 
urychlit přehrávání animace. 
 

VYPNUTÍ ZVUKU  MUTE SOUND (orig.295) 

Volba Animation>Mute Sound umoţņuje vypnutí zvuku během přehrávání animace. Značka 
zaškrtnutí signalizuje, ţe vypnutí zvuku je aktivováno, a naopak. 
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VYMAZÁNÍ ZVUKU  CLEAR SOUND (orig.295) 

Volbou Animation>Clear Sound vymaţete zvuk, dříve importovaný do scény Poseru 7. 
 

PŘEHRÁNÍ FILMOVÉHO SOUBORU  PLAY MOVIE FILE (orig.295) 

Volba Animation>Play Movie File umoţņuje otevření filmového souboru pro přehrání uvnitř Poseru 
7. Zobrazí se standardní Open dialog pro vyhledání poţadovaného filmového souboru. 
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Kapitola 30: Menu okna THE WINDOW MENU (orig.296) 

Menu okna Window menu umoţņuje aktivovat a deaktivovat (zobrazit a skrýt) rŧzná okna a palety 
Poseru 7. Palety, které mŧţete zpřístupnit pomocí menu okna Window menu jsou následující: 
 
o Animation Palette: Volbou Window>Animation Palette otevřete paletu animace Animation 

palette. Prosím navštivte téma “Použití palety animace” na straně 87 pro více informací o paletě 
animace a o vytváření animací v Poseru 7. 

o Graph: Volbou Window>Graph otevřete paletu grafu Graph pro vybraný prvek Vaší scény. Prosím 
navštivte téma “O paletě grafu” na straně 96 pro více informací o pouţití grafu při vytváření animací 
v Poseru 7. 

o Libraries: Volbou Window>Libraries otevřete paletu knihoven Library. Prosím navštivte kapitolu 
5: “Knihovny Poseru 7” na straně 28 pro více informací o paletě knihoven Library. 

o Hierarchy Editor: Volbou Window>Hierarchy Editor otevřete paletu editoru hierarchie Hierarchy 
Editor. Prosím navštivte téma “Editor hierarchie” na straně 129 pro více informací o paletě editoru 
hierarchie Hierarchy Editor. 

o Joint Editor: Volbou Window>Joint Editor otevřete paletu editoru kloubŧ Joint Editor. Prosím 
navštivte téma “Editor kloubů” na straně 132 pro více informací o paletě editoru kloubŧ Joint 
Editor. 

o Sketch Designer: Volbou Window>Sketch Designer otevřete okno designeru skicy Sketch 
Designer. Prosím navštivte kapitolu 38: “Renderovací nástroj Designér skic” na straně 259 pro 
více informací o renderování pomocí designeru skicy Sketch Designer. 

o Walk Designer: Volbou Window>Walk Designer otevřete okno designeru chŧze Walk Designer. 
Prosím navštivte téma “Použití designeru chůze” na straně 98 pro více informací o okně designeru 
chŧze Walk Designer. 

o Python Scripts: Volbou Window>Python Scripts otevřete paletu skriptŧ Pythonu Python Scripts. 
Prosím navštivte téma “Paleta skriptů Pythonu” na straně 272 pro více informací o paletě skriptŧ 
Pythonu Python Scripts. 

o Room Help: Volbou Window>Room Help otevřete HTML okno s informacemi pro pomoc  
s pouţitím místností Poseru 7. 

o Camera Controls: Volbou Window>Camera Controls mŧţete přepínat mezi zobrazením a skrytím 
ovladačŧ kamery Camera controls. Značka zatrţení u této volby indikuje, ţe ovladače jsou 
zobrazeny a naopak. Prosím navštivte téma “Ovladače kamery” na straně 53 pro více informací  
o ovladačích kamery Camera controls. 

o Preview Styles: Volbou Window>Preview Styles mŧţete přepínat mezi zobrazením a skrytím 
ovladačŧ stylŧ zobrazení Display controls. Značka zatrţení u této volby indikuje, ţe ovladače jsou 
zobrazeny a naopak. Prosím navštivte kapitolu 7: “Ovladače zobrazení” na straně 50 pro více 
informací o ovladačích stylŧ zobrazení Display controls. 

o Editing Tools: Volbou Window>Editing Tools mŧţete přepínat mezi zobrazením a skrytím 
editačních nástrojŧ Editing tools. Značka zatrţení u této volby indikuje, ţe ovladače jsou 
zobrazeny a naopak. Prosím navštivte téma “Editační nástroje” na straně 71 pro více informací  
o editačních nástrojích Editing tools. 

o Light Controls: Volbou Window>Light Controls mŧţete přepínat mezi zobrazením a skrytím 
ovladačŧ osvětlení Light controls. Značka zatrţení u této volby indikuje, ţe ovladače jsou 
zobrazeny a naopak. Prosím navštivte kapitolu 9: “Osvětlení” na straně 61 pro více informací  
o ovladačích osvětlení Light controls. 

o Memory Dots: Volbou Window>Memory Dots mŧţete přepínat mezi zobrazením a skrytím 
paměťových tlačítek Memory dots. Značka zatrţení u této volby indikuje, ţe ovladače jsou 
zobrazeny a naopak. Prosím navštivte téma “Paměťová tlačítka” na straně 26 pro více informací  
o paměťových tlačítcích Memory dots. 

o Parameters Palette: Volbou Window>Parameters Palette mŧţete přepínat mezi zobrazením  
a skrytím palety parametrŧ Parameters. Značka zatrţení u této volby indikuje, ţe paleta je 
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zobrazena a naopak. Prosím navštivte téma “Paleta parametrů” na straně 77 pro více informací  
o paletě patametrŧ Parameters. 

o Animation Controls: Volbou Window>Animation Controls mŧţete přepínat mezi zobrazením  
a skrytím ovladačŧ animace Animation controls. Značka zatrţení u této volby indikuje, ţe 
ovladače jsou zobrazeny a naopak. Prosím navštivte téma “Použití ovladačů animace” na straně 
85 pro více informací o ovladačích animace Animation controls. 

o Show All Tools: Volbou Window>Show all Tools zobrazíte všechny nástroje pracovního prostoru 
Poseru 7. Prosím navštivte kapitolu 4: “Místnost pózy” na straně 23 pro přehled o nástrojích 
pracovního prostoru Poseru 7. 

o Hide All Tools: Volbou Window>Hide all Tools skryjete všechny nástroje pracovního prostoru 
Poseru 7. 

o Tool Titles: Volbou Window>Tool Titles mŧţete přepínat mezi zobrazením a skrytím titulkŧ nad 
zobrazenými nástroji. Značka zatrţení u této volby indikuje, ţe titulky jsou zobrazeny a naopak. 

o Document Window Size: Volbou Window>Document Windows Size otevřete dialogové okno Set 
Window Size, umoţņující změnu velikosti pracovního okna Document. Prosím navštivte téma 
“Pracovní okno Document” na straně 41 pro více informací o změně velikosti pracovního okna 
Document. 

o Quick Start: Volbou Window>Quick Start otevřete dialogové okno Quick Start, ve kterém mŧţete 
vybírat interaktivní projekt Project. 

o Project Guide: Volbou Window>Project Guide otevřete paletu prŧvodce projektem Project Guide 
se zobrazenými naposledy vybranými interaktivními projekty Project. 
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Kapitola 31: Menu skriptů THE SCRIPTS MENU (orig.299) 

Menu skriptŧ Scripts menu přináší hierarchický seznam skriptŧ PoserPythonu, dostupných pro 
pouţití uvnitř Poseru 7. Pokud Poser 7 spustíte poprvé, toto menu obsahuje seznam všech 
PoserPython skriptŧ, které byly instalovány společně s  Poserem 7. Máte moţnost umístit doplņkové 
skripty Pythonu do adresáře \Runtime\Python\PoserScripts\ScriptsMenu uvnitř instalace Poseru 7; 
všechny skripty umístěné do této sloţky budou přístupné uvnitř Poseru 7 z menu skriptŧ Scripts 
menu. 

Pro více informací o skriptech Pythonu pro for Poser 7, navštivte prosím část 6: “PoserPython” na 
straně 267. 



 

Strana 216 (celkem 289) 

Kapitola 32: Menu nápovědy  THE HELP MENU (orig.300) 

Menu nápovědy poskytuje pomoc během pouţívání Poseru 7. 
 

UŢIVATELSKÁ PŘÍRUČKA POSERU 7   
POSER 7 REFERENCE MANUAL (orig.300) 

Volbou Help>Poser Reference Manual otevřete uţivatelskou příručku Poser 7 Reference Manual ve 
formátu Adobe Acrobat (PDF). 
 

NÁPOVĚDA POSERPYTHONU  POSERPYTHON HELP (orig.300) 

Volbou Help>PoserPython Manual otevřete manuál PoserPython Methods Manual ve formátu Adobe 
Acrobat (PDF). Prosím navštivte část 6: “PoserPython” na straně 267 pro více informací  
o PoserPythonu. 
 

TUTORIAL MANUAL POSERU 7  POSER 7 TUTORIAL MANUAL (orig.300) 

Volbou Help>Poser Tutorial Manual otevřete Poser 7 Tutorial Manual od e frontieru ve formátu 
Adobe Acrobat (PDF). 
 

O POSERU 7  ABOUT POSER 7 (orig.300) 

Volba Help>About Poser zobrazí číslo verze a licenční informace Poseru 7. Tyto informace budete 
potřebovat při kontaktování technické podpory e frontier Technical Support. 

Tato poloţka menu je dostupná pouze pro Windows. Uţivatelé Macintoshe mají tyto informace 
dostupné skrze menu Application Poseru 7. 
 

CONTENT PARADISE  CONTENT PARADISE (orig.300) 

Submenu Help>Content Paradise obsahuje odkazy na informace o materiálu ze stránek Content 
Paradise. 
 

WEBOVÉ STRÁNKY E FRONTIERU  E FRONTIER WEB LINKS (orig.300) 

Volbou Help>e frontier Web Links otevřete webové stránky e frontieru, které obsahují mnoţství 
uţitečných informací o Poseru 7. 
 

OSTATNÍ WEBOVÉ STRÁNKY  OTHER WEB LINKS (orig.301) 

Volbou Help>Other Web Links otevřete výběr online webových stránek, které obsahují mnoţství 
uţitečných informací o Poseru 7. 
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Část 4 – MATERIÁLY 

MATERIALS (orig.303) 

Kapitola 33: Práce s uzly  WORKING WITH NODES (orig.304) 

Tato kapitola popisuje, jak vykonávat rŧzné operace s uzly v okně Shader místnosti materiálu 
Material room. Pro popis samotné místnosti materiálu Material room prosím navštivte kapitolu 16: 
“Místnost materiálu” na straně 139. 
 

O UZLECH  ABOUT NODES (orig.304) 

Uzel je základní stavební prvek pouţívaný ke konstrukce jednoduchých nebo komplexních shaderŧ 
shaders. Všechny uzly obsahují následující prvky, mimo popsaných: 

o Výstup (1): Po přijetí a zpracování všech 
vstupŧ včetně vlastních hodnot, prochází 
konečný výsledek výstupem Output 
s moţností propojení na vstup dalšího 
uzlu. Kořenové uzly tuto funkci nemají. 

o Jméno uzlu (2): Toto je pojmenování uzlu 
Node Name. Pokud budete mít dva nebo 
více uzlŧ se stejnými jmény, budou ke 
jménŧm doplněny číslice, například 
Clouds_2, Clouds_3 a tak dále. 

o Tlačítko pro zobrazení/skrytí hodnot (3): 
Kliknutím na tlačítko Values button se 
přepíná mezi zobrazením a skrytím 
hodnot uzlu (5). 

o Tlačítko pro zobrazení/skrytí náhledu (4): 
Kliknutím na tlačítko Preview button se 
přepíná mezi zobrazením a skrytím 
náhledu uzlu (8). Umoţnění náhledu dává 
velkou moţnost shlédnutí, jak kaţdý krok 
stromové struktury shaderu ovlivņuje 
konečný celkový vzhled, nicméně toto 
vyţaduje další výpočetní výkon. 

o Hodnoty uzlu (5): V této části jsou zobrazeny hodnoty Node Values, které mŧţete specifikovat pro 
jednotlivý uzel. 

o Hodnotový vstup (6): Hodnoty mŧţete buď přímo zadávat do uzlu, nebo připojit jeden nebo více 
uzlŧ na hodnotový vstup Value Input, určený k modifikaci vybrané hodnoty. 

o Přepínač animace (7): Kliknutím na ovladač Animation control zapínáte nebo vypínáte animaci 
zvolené hodnoty uzlu. 

o Náhled (8): Toto okno zobrazuje náhled Preview výstupu uzlu. 

 POZNÁMKA 
POKUD POUŢÍVÁTE OPENGL HARDWARE AKCELERACI, MŦŢETE VIDĚT VÝSLEDKY  
PROCESU SHADERU V ZÁLOŢCE S NÁHLEDEM PRACOVNÍHO OKNA DOCUMENT, COŢ DÁVÁ 
LEPŠÍ PŘEDSTAVU O TOM, JAK BUDE VAŠE RENDEROVANÁ SCÉNA VYPADAT. PRO VÍCE 
INFORMACÍ O NÁHLEDU PROCESU SHADERU navštivte prosím téma “Záložka náhled” na straně 
246. 
 

INTERAKCE UZLŮ  NODE INTERACTION (orig.305) 

Uzly mŧţete propojit s jinými uzly a tímto ovládat jeden vstup uzlu výstupem jiného uzlu. Tato 
interakce mezi uzly je srdcem funkčnosti místnosti materiálu Material room a přináší téměř 
nekonečnou flexibilitu. Interakce uzlŧ pracuje pomocí propojování hodnot nebo barev z jednoho uzlu 
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do dalšího. Neexistuje ţádný teoretický limit jak hluboko tato interakce mŧţe jít, nicméně dostupná 
paměť a rychlost procesoru sehrají roli v nastavení praktických limitŧ. 
 

ZÁKLADNÍ OPERACE S UZLY  BASIC NODE OPERATIONS (orig.305) 

Neţ pŧjdeme mnohem více do detailŧ, pojďme si vysvětlit, jak udělat několik základních operací za 
pouţití uzlŧ: 
 

VÝBĚR UZLŮ  SELECTING NODES (orig.305) 

Pro výběr uzlu jednoduše klikněte na kterékoliv volné místo uvnitř poţadovaného uzlu. Pro výběr více 
uzlŧ během výběru stiskněte a podrţte klávesu [SHIFT]. 
 

ROZBALENÍ/SBALENÍ UZLŮ  EXPANDING/COLLAPSING NODES (orig.305) 

Hodnoty uzlŧ mŧţete rozbalit či sbalit, nebo samostatně prohlíţet tak, jak je popsáno v předchzí části. 
 

POSUN UZLŮ  MOVING NODES (orig.305) 

Uzly mŧţete posouvat a aranţovat tak, aby se hodily Vašemu specifickému pracovnímu stylu. Pozice 
uzlŧ nemá ţádný vliv na funkci a vzhled shaderu. Pro posunutí uzlu nebo uzlŧ: 

1. Vyberte uzel(y), které si přejete posunout tak, jak je popsáno výše. 

2. Podrţte stisknuté tlačítko myši a táhněte uzlem(y) do poţadované pozice. Uvolněním tlačítka myši 
se posun dokončí. 

 

ZADÁNÍ HODNOT UZLŮ  ENTERING NODE VALUES (orig.305) 

Pro zadání hodnoty uzlu klikněte na poţadovanou hodnotu, čímţ otevřete malé okénko s vyplněnou 
stávající hodnotou a otočným ovladačem. Zde do tohoto políčka mŧţete zadat číselnou hodnotu, 
anebo mŧţete hodnotu nastavit myší za pomoci otočného ovladače. Mŧţete také propojit jeden nebo 
více uzlŧ s poţadovanou hodnotou (viz níţe), coţ vytvoří příslušné nastavení. 

Některé hodnoty uzlŧ obsahují rozbalovací menu. Tyto pouţívejte stejně jako kterékoliv jiné 
rozbalovací menu. Kliknutím na barevnou hodnotu uvnitř uzlu otevřete standardní barevný vzorník 
Color Picker, který mŧţete pouţít k rychlému výběru poţadované barvy. 
 

MENU PŘEDVOLEB  THE OPTIONS MENU (orig.306) 

Do menu předvoleb Options menu mŧţete vstoupit jedním ze čtyř zpŧsobŧ: 

o Kliknutím na šipku Options menu v pravém horním rohu okna shaderu Shader window. 

o Kliknutím některým tlačítkem myši na vstup uzlu. V závislosti na tlačítku myši mŧţe menu 
předvoleb Options menu obsahovat jen volbu pro vytvoření nového uzlu New node a mŧţe  
(v závislosti na vstupu) nabízet rychlý přístup k volbám připojení pro příslušné uzly k vybranému 
vstupu. 

o Kliknutím některým tlačítkem myši na výstup uzlu. 

o Kliknutím pravým tlačítkem myši kdekoliv do volného prostoru okna shaderu Shader window. 

Menu předvoleb Options menu obsahuje následující poloţky: 

o Disconnect: Volbou Disconnect dojde k odpojení aktuálního spojení mezi vstupem dotčeného uzlu 
a všemi prvky shaderu připojených na tento vstup. Tato poloţka se zobrazí při kliknutí na vstup 
uzlu, ke kterému je připojena jedna nebo více propojovacích linek. 

o New node: Výběrem poloţky New node vytvoříte nový uzel. Prosím nastudujte následující část pro 
více informací o tvorbě uzlŧ. 

o Cut selected nodes: Výběrem této poloţky umístíte kopii vybraného uzlu(ŧ) do paměťové schránky 
a originál uzlu vymaţete z okna shaderu Shader window včetně všech existujících propojení 
linkami mezi vymazaným uzlem a ostatními. Tato funkce zachovává všechny propojovací linky, 
které existují mezi kopírovanými uzly. 
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o Copy selected nodes: Výběrem této poloţky umístíte kopii vybraného uzlu(ŧ) do paměťové 
schránky bez vymazání originálu uzlu z okna shaderu Shader window a bez ovlivnění vzájemných 
vztahŧ s ostatními uzly. Tato funkce zachovává všechny propojovací linky, které existují mezi 
kopírovanými uzly, ale nezkopíruje linky mezi kopírovanými uzly a ostatními uzly. V souvislosti  
s příkazem Paste (viz níţe), toto je hlavní zpŧsob rozšiřování stromové struktury shaderu (nebo 
kterékoliv jeho části) ze shaderu do shaderu, coţ dovoluje šetřit čas opakovaným vyuţitím 
předchozí práce. 

o Paste: Volbou Paste umístíte kopii uzlu(ŧ) uloţeného v paměťové schránce do okna shaderu 
Shader window. 

o Delete selected nodes: Volbou Delete selected nodes vymaţete vybraný uzel(y). Všechny 
propojovací linky dotčených uzlŧ budou také vymazány, coţ znamená, ţe budete muset obnovit 
přerušená spojení. Prosím navštivte téma “Spojování uzlů” na straně 219 pro informace  
o spojování/rozpojování uzlŧ. 

o Apply selected: Volbou Apply to all... aplikujete vybrané uzly na všechny materiálové skupiny 
aktuálního objektu. Tato volba přepíše existující spojení dotčených materiálových skupin, ale 
nevymaţe ţádné uzly. 

o Select All: Volbou Select All vyberete všechny uzly Vašeho shaderu včetně kořenového uzlu. 

o Invert Selection: Volbou poloţky Invert Selection vyberete všechny dříve nevybrané uzly  
a z výběru vypustíte všechny dříve vybrané uzly. V podstatě tato funkce invertuje Váš předchozí 
výběr. 

 

TVORBA UZLŮ  CREATING NODES (orig.307) 

Tvorba doplņkových uzlŧ je prvním krokem vlastní stromové struktury shaderu (pamatujte si, ţe 
všechny shadery mají alespoņ kořenový uzel). Pro vytvoření uzlu otevřete menu předvoleb Options 
menu a zvolte poloţku New Node>Category>Subcategory>Node, která umoţní vytvoření nějakého 
typu vybraného uzlu v okně shaderu Shader window. Pokud otevřete Options menu kliknutím na 
vstup stávajícího uzlu, nový uzel se zobrazí jiţ s propojeným výstupem linkou na vstup aktuálního 
uzlu. Při otevření Options menu jakýmkoliv jiným zpŧsobem (viz výše), nový uzel nebude dosud 
propojen. 
 

SPOJOVÁNÍ UZLŮ  LINKING NODES (orig.307) 

Po vytvoření uzlu jej budete potřebovat propojit se vstupem jiného uzlu. Toto je moţné provést jedním 
ze tří zpŧsobŧ: 

o Přímé propojení: Klikněte na výstup uzlu, který si přejete spojit a táhněte kurzorem na vstup uzlu 
nebo shaderu, který si přejete propojit. Uvolněním tlačítka myši dojde k dokončení propojení linkou. 

o Přesunem existujícího propojení: Pro přesun propojení linkou z jednoho uzlu na jiný klikněte na na 
vstup, který si přejete odpojit a táhněte kurzor směrem od uzlu. Umístěte kurzor nad vstup uzlu, 
který si přejete propojit a uvolněte tlačítko myši. 

o Kliknutím a tažením: klikněte na vstup, který si přejete propojit k jinému uzlu a táhněte kurzorem. 
Zobrazí se kontaktní linka. Pokud uvolníte tlačítko myši, zobrazí se Options menu, které umoţńuje 
vytvoření nového uzlu, jehoţ výstup bude napojen na zvolený vstup aktuálního uzlu. 

Uzly mŧţete spojovat libovolně s mnoha dalšími uzly podle libosti a kaţdý výstup uzlu mŧţe být 
propojen s libovolným mnoţstvím vstupŧ jiných uzlŧ. 
 

ROZPOJOVÁNÍ UZLŮ  DE-LINKING NODES (orig.308) 

Pro přerušení spojení mezi dvěmi uzly klikněte na vstup, který chcete odpojit a zvolte poloţku 
Disconnect z Options menu. 
 

MAZÁNÍ UZLŮ  DELETING NODES (orig.308) 

Pro vymazání uzlu vyberte uzel, který si přejete zmazat a buď stisknete klávesu [DEL] nebo zvolíte 
příkaz Node>Delete. 
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ANIMACE UZLŮ  ANIMATING NODES (orig.308) 

Uzly mŧţete animovat pomocí kliknutí na přepínač Animation Toggle (ikona klíče) u atributu, který si 
přejete animovat. Pokud je animace aktivována, ikona je zobrazena zeleně. Pokud je animace 
deaktivována, ikona je nevybarvena. Kliknutím na přepínač Animation Toggle se otevře rozbalovací 
menu s následujícími poloţkami: 

o Animated: Výběrem poloţky Animation zapínáte a vypínáte animaci aktuálního atributu. Jakmile je 
animace aktivována, zobrazí se před touto poloţkou menu značka zátrţítka, a naopak. 

o Info: Kaţdý animovaný atribut má jednu nebo více poloţek Info v závislosti na typu atributu. 
Například číselný uzel bude mít jednu poloţku Info pro svou číselnou hodnotu, zatímco barevný 
uzel bude mít tři poloţky Info (po jedné pro červenou, zelenou a modrou barvu). Výběrem jedné 
z těchto poloţek mŧţete nastavit potřebnou hodnotu, maximální a minimální limity, název  
a citlivost. Tento dilalog je úplně stejný jako dialog pro editaci otočných ovladačŧ parametrŧ Edit 
Parameter Dial, který je popsán v části “ Editace otočných ovladačů parametrů ” na straně 78. 

o Graph: Pro kaţdou poloţku Info mŧţeme shlédnout funkci grafu Graph. Výběrem poloţky Graph 
dojde k otevření palety grafu Graph zvoleného kanálu. Prosím navštivte téma “Použití grafů” na 
straně 96 pro více informací o paletě grafu Graph. 

Jakmile je animace aktivována, mŧţete animovat hodnoty atributŧ pomocí kombinace následujících 
metod: 

o Keyframes: Přesuņte se na určitý snímek a nastavte hodnotu atributu, následně se přesuņte na jiný 
snímek a nastavte novou hodnotu atributu. 

o Graph Palette: Pro animaci uzlu pouţijte paletu grafu Graph. 

o Other nodes: Připojte další uzly pro ovládání změn atributu v prŧběhu času. 

Prosím navštivte kapitolu 11: “Animace pomocí Poseru 7” na straně 83 pro více informací o animacích 
uvnitř Poseru 7. 
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Kapitola 34: Uzly místnosti materiálu   
MATERIAL ROOM NODES (orig.309) 

Poser obsahuje následující uzly, které mohou být kombinovány a propojeny s kořenovými uzly, čímţ 
mŧţete vytvořit prakticky jakýkoliv shader, který Vás napadne. Uzly jsou rozděleny do několika skupin: 
Math, Lighting, Variables, 3D Textures a 2D Textures. Kaţdá skupina a její shadery jsou popsány 
v následujících částech: 
 

KOŘENOVÉ UZLY  ROOT NODES (orig.309) 

Jak jsme se dříve zmínili, všechny shadery obsahují kořenový uzel, který mŧţe být modifikován 
pomocí doplņkových uzlŧ. Přesto i samotný kořenový uzel je jiţ také kompletním shaderem. Místnost 
materiálu Material room má čtaři kořenové uzly: Material, Background, Light a Atmosphere. 
Pojďme si prohlédnout tyto uzly blíţe. 
 

KOŘENOVÝ UZEL NÁPOVĚDY  ROOT NODE HELP (orig.309) 

Některé atributy uzlu mají vedle sebe ikonu se symbolem otazníku (?). Kliknutím na tuto ikonu 
otevřete nápovědu tohoto kanálu. Tato nápověda je dostupná také při procházení nápovědy v okně 
místnosti materiálu Material room (dostupná po kliknutí na ikonu (?) v pravém horním okně shaderu 
Shader, nebo pomocí volby Window>Room Help, pokud jiţ stránky nápovědy nejsou v mistnosti 
materiálu Material room zobrazeny). 
 

KOŘENOVÝ UZEL MATERIÁLU/VLASŮ  ROOT MATERIAL/HAIR NODE (orig.309) 

Kořenové uzly materiálu Material a kořenové uzly vlasŧ Hair obsahují všechny atributy potřebné pro 
vytvoření kompletního shaderu pro téměř kaţdou materiálovou skupinu Vaší scény (figury, rekvizity, 
vlasy). Oby typy uzŧ obsahují následující atributy: 

o Diffuse Color: Atribut Diffuse_Color je povrchovou barvou, která násobí kaţdé světlo pŧsobící na 
objekt (podbarvuje povrch objektu). 

o Diffuse Value: Atribut Diffuse_Value definuje účinek difuzní barvy, kde 1=100%. 

o Specular Color: Atribut Specular_Color definuje barvu odraţeného světla od objektu. 

o Specular Value: Atribut Specular_Value definuje účinek barvy odraţeného světla od objektu, kde 
1=100%. 

o Highlight Size: Atribut Highlight_Size definuje mnoţství micro-políček na povrchu objektu. Micro-
políčka jsou malé nedokonalosti povrchu, které jsou pro lidské oči neviditelné, přesto ovlivņují 
zpŧsob odrazu světla mimo povrch objektu. Velmi hladké povrchy (jako je sklo) mají velmi málo 
nedokonalostí a proto produkují velmi ostré zrcadlové odrazy. Povrchy, jako je papír, mají velmi 
velký počet nedokonalostí a proto produkují měkčí zrcadlové odrazy. 

o Ambient Color: Atribut Ambient_Color definuje akumulované nepřímé obklopující osvětlení uvnitř 
scény. Toto je obvykle světlo odraţené od ostatních objektŧ nebo jinak rozptýlené pomocí prvkŧ, 
jako je atmosféra. 

o Ambient Value: Atribut Ambient_Value definuje účinek obklopující barvy, kde 1=100%. 

o Transparency: Atribut Transparency definuje prŧhlednost objektu, kde 1=plná prŧhlednost. 

o Transparency Edge: Atribut Transparency_Edge definuje prŧhlednost okrajŧ objektu. Například 
sklenice na svých okrajích vypadá neprŧhledně. 

o Transparency Falloff: Atribut Transparency_Falloff definuje, jak se prŧhlednost mění postupně 
směrem k okraji objektu. Menší hodnota vytvoří ostřejší okraj (kratší přechod) a naopak. 

o Translucence Color: Atribut Translucence_Color je barvou světla procházejícího skrze objekt. 

o Translucence Value: Atribut Translucence_Value definuje účinek prosvítající barvy, kde 1=100%. 

o Reflection Color: Atribut Reflection_Color umoţņuje specifikovat odráţející se (reflexní) barvu. 
Toto je dobrý vstup pro připojení dalších uzlŧ k ovládání odrazŧ. 

o Reflection Value: Atribut Reflection_Value definuje účinek reflexní barvy, kde 1=100%. 
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o Refraction Color: Atribut Refraction_Color definuje barvu světla lomeného pomocí aktuálního 
objektu. 

o Refraction Value: Atribut Refraction_Value definuje účinek lomové barvy světla, kde 1=100%. 

o Bump: Atribut Bump definuje velikost hrbolatosti materiálu (nedeformuje celkový tvar objetu). Viz 
Poser 7 Tutorial Manual: “Bump Maps” pro informace o hrbolatosti povrchu materiálu. 

o Displacement: Atribut Displacement definuje stupeņ vytlačení povrchu materiálu (částečně 
deformuje celkový tvar objektu). Viz Poser 7 Tutorial Manual: “Displacement Map” pro informace  
o vytlačení povrchu materiálu. 

o Alternate Diffuse: Atribut Alternate_Diffuse nabízí alternativní vstup pro povrchové difuzní světlo. 
Tento kanál pouţíveje pro praménkové vlasy a vţdy, kdyţ budete chtít pouţít uţivatelské difuzní 
(rozptýlené) osvětlení. 

o Alternate Specular: Atribut Alternate_Specular nabízí alternativní vstup pro odraţené světlo. 
Tento kanál pouţíveje pro praménkové vlasy a vţdy, kdyţ budete chtít pouţít uţivatelské osvětlení. 

o Reflection Lite Mult: Označením políčka Reflection_Lite_Mult znásobíte celkovou barvu pomocí 
mnoţství difuzního osvětlení pŧsobícího na kaţdý bod na povrchu objektu. Toto automaticky 
ztmaví odlesky na neosvětlených plochách. V základním nastavení je volba označena. 

o Reflection Kd Mult: Označením políčka Reflection_Kd_Mult automaticky natónujete barvu odrazu 
barevnou hodnotou povrchového rozptýleného světla. V základním nastavení je volba neoznačena. 

o Gradient Bump: Předchozí verze Poseru pouţívaly vlastní souborový formát map hrbolatosti bump 
maps (*.BUM). Pokud chcete pouţít tyto starší typy souborŧ v Poseru 7, připojte uzel s obrázkem 
mapy k atributu Gradient_Bump a načtěte poţadovaný soubor *.BUM do tohoto uzlu (viz 
“Obrazová mapa” na straně 238 pro informace o načtení obrázkŧ). Potom vyberte Poser 4 
Renderer v okně nastavení renderu Render Settings a označte políčko Ignore Shader Trees. 
Prosím navštivte kapitolu 37: “Použití renderovacího nástroje Poseru 4” na straně 257 pro více 
informací o renderovacím nástroji Poseru 4. Soubory *.BUM nemŧţete pouţít v renderovacím 
nástroji FireFly. 

o Shadow Catch Only: Označením políčka Shadow_Catch_Only umoţníte prŧhledným povrchŧm 
zachycovat stíny, coţ zabraņuje vzniku stínŧ na neprŧsvitném povrchu za nimi. Jinými slovy, tato 
volba bude nakládat s prŧhlednými povrchy jako s neprŧhlednými, ale pouze ve smyslu jejich 
interakce se stíny. Hlavní vyuţití této funkce mŧţe být, pokud si přejete renderovat pouze figuru  
a její stín; mŧţete nastavit u podlahy prŧhledný povrch a pomocí funkce Shadow_Catch_Only 
zobrazit stín figury na transparentní podlaze a takto ji renderovat (bez pozadí). Podlaha bude 
neviditelná s vyjimkou na ni vrţených stínŧ, takţe vše co budete ve scéně renderovat, bude figura 
a její stíny. 

o ToonID: V základním nastavení, volbou předvolby Toon Outline vytvoříte konturu, která se objeví 
okolo kaţdého samostatného materiálu na figuře nebo objektu. V závislosti na nastavení figury, 
toto mŧţe vést k vytvoření příliš mnoha obrysŧ (kontur). V takovém případě mŧţete nastavit Toon 
ID označení v kořenovém uzlu materiálu, které následně redukuje počet vykreslených kontur. 
Přiřazení stejných ID více materiálŧm zpŧsobí, ţe renderovací nástroj nebude vykreslovat 
vzájemné kontury mezi těmito materiály. 

o Normals_Forward: Označením políčka Normals_Forward bude povrch srovnán kolmo na pohled 
kamery (nebo kolmo na směr paprsku při raytracingu). Pouţívejte tuto volbu k tomu, abyste se 
vyhnuli zastiņujícím artefaktŧm na oboustraných polygonech. 

 POZNÁMKA 
ABYSTE MOHLI KOŘENOVÝ UZEL VIDĚT, MUSÍTE MÍT OBJEKT VLASŦ VYBRÁN. 
 

KOŘENOVÝ UZEL POZADÍ  ROOT BACKGROUND NODE (orig.312) 

Kořenový uzel pozadí Background obsahuje všechny atributy potřebné pro vytvoření kompletního 
shaderu pro pozadí Vaší scény a obsahuje tedy následující atributy: 

o Color: Atribut Color umoţņuje nastavit základní barvu pozadí. 

o Diffuse Color: Atribut Diffuse_Color je povrchovou barvou, která násobí kaţdé světlo pŧsobící na 
objekt (podbarvuje povrch objektu). 
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o Specular Color: Atribut Specular_Color definuje barvu odraţeného světla od pozadí. 

o Highlight Size: Atribut Highlight_Size definuje míru odleskŧ pozadí. 

o Bump: Atribut Bump definuje velikost hrbolatosti materiálu pozadí. 

 POZNÁMKA 
KONEČNÝ RENDER BUDE VŢDY ZOBRAZOVAT COKOLIV, CO JE NAPOJENO NA BAREVNÝ 
KANÁL KOŘENOVÉHO UZLU POZADÍ. NICMÉNĚ, POKUD SI PŘEJETE STEJNÝ OBRÁZEK NEBO 
BARVU ZOBRAZIT I V OKNĚ NÁHLEDU RENDERU, MUSÍTE JE TAKÉ PŘIPOJIT JAKO BG 
PICTURE NEBO BG MOVIE UZEL. 
 

KOŘENOVÝ UZEL SVĚTLA  ROOT LIGHT NODE (orig.312) 

Kořenový uzel světla Light bude zobrazen vţdy, kdyţ máte světlo vybráno. Kaţdé světlo ve Vaší 
scéně má vlasní kořenový uzel, který obsahuje následující atributy: 

o Color: Atribut Color umoţņuje nastavit základní barvu světla. 

o Intensity: Atribut Intensity definuje jas světla. 

o Angle Start: Atribut Angle_Start definuje počátek světelného kuţele (ve stupních) pro bodové 
světlo. 

o Angle End: Atribut Angle_End definuje konec světelného kuţele (ve stupních) pro bodové světlo. 

o Angle Expo: Atribut Angle_Expo definuje, jak světlo pohasíná směrem k okraji světelného kuţele 
(vytrácí se). 

o Diffuse: Atribut Diffuse umoţņuje vytvoření světla, které je pouţito pouze jako sloţka rozptýleného 
osvětlení scény. 

o Specular: Atribut Specular umoţņuje vytvoření světla, které je pouţito pouze jako sloţka 
odraţeného osvětlení scény. Pouze odraţené světlo mŧţete vytvořit tak, ţe nastavíte barvu  
v kanálu Specular na černou. Také mŧţete vytvořit negativní světelný zdroj (světelný zdroj, který 
ztmavuje nebo neguje určité barvy v oblasti scény osvětlené tímto světlem) pomocí nastavení 
hodnoty Specular na nulu a nastavení intenzity světla Intensity na -1. Dále mohou být kanály 
Color a Diffuse nastaveny na redukci určitých aspektŧ světla. 

o Image Resolution: Atribut Image Resolution specifikuje šířku a výšku sondy vzorku světla. Mŧţete 
nastavit libovolnou velikost světelné sondy a potom nastavte rozlišení tak, aby se hodilo Vašim 
potřebám. Nicméně vysoké rozlišení vyţaduje více procesorového času, zatímco při extrémně 
nízkém rozlišení dochází ke ztrátě kvality obrazu. 256 je rozumné základní rozlišení světelné sondy 
většiny obrazŧ. 

o IBL Contrast: Atribut IBL Contrast umoţņuje modifikovat úroveņ kontrastu sondy přicházejícího 
světla na bázi obrazu. Základní hodnota tohoto atributu 3 je určena pro pouţití nízko dynamických 
Low Dynamic Range (LDR) obrazŧ. Pro vysoce dynamické High Dynamic Range (HDR) obrazy 
je lépe nastavit hodnotu IBL Contrast na 1. 

 POZNÁMKA 
PRO ZOBRAZENÍ TOHOTO KOŘENOVÉHO UZLU MUSÍTE MÍT VYBRÁNO NĚJAKÉ SVĚTLO. 
 

KOŘENOVÝ UZEL ATMOSFÉRY  ROOT ATMOSPHERE NODE (orig.313) 

Kořenový uzel atmosféry Root Atmosphere obsahuje všechny atributy potřebné pro vytvoření efektŧ 
realistické atmosféry ve Vašich scénách, jako je mlha, opar, apod.: 

o DepthCue_On: Označením políčka DepthCue_On aktivujete blednutí depth cueing, které mění 
všechny barvy materiálu povrchu z jejich originálního odstínu do specifikované barvy blednutí 
depth cue color (viz níţe). Toto vytváří podobný efekt jako aktivace funkce Depth Cueing 
v pracovním okně Document, jak je popsáno v části “Blednutí a stíny” na straně 46. 

o Volume_On: Označením políčka Volume_On aktivujete volumetrické efekty (stíny vrţené do mlhy, 
kouře, apod.). Blednutí anebo volumetrické efekty mŧţete aktivovat individuálně. 

o DepthCue_Color: Atribut DepthCue_Color specifikuje barvu pouţitou pro aplikaci blednutí. 
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o DepthCue_StartDist: Atribut DepthCue_StartDist specifikuje vzdálenost od aktuální kamery, ve 
které začíná účinkovat efekt blednutí. Tato vzdálenost není nutně zobrazena ve vzdálenostních 
jednotkách Poseru 7. 

o DepthCue_EndDist: Atribut DepthCue_EndDist specifikuje vzdálenost od aktuální kamery, ve 
které končí účinek efektu blednutí. Tato vzdálenost není nutně zobrazena ve vzdálenostních 
jednotkách Poseru 7. 

o Volume_Color: Atribut Volume_Color specifikuje barvu volumetrického efektu. Tato barva násobí 
barvu světel ve Vaší scéně. Pro pouţití barev světel k vytvoření volumetrického efektu, nastavte 
tento atribut na bílý odstín. 

o Volume_Density: Atribut Volume_Density nastavuje účinek volumetrického efektu. Tento účinek je 
násobený atributem Atmosphere Strength kaţdého světla. Pokud je tento atribut nastaven na 1.0, 
zvolené světlo bude vytvářet atmosférický efekt odpovídající tomuto atributu a podobně. Prosím 
navštivte téma “Vlastnosti světla” na straně 65. 

o Volume_StepSize: Atribut Volume_StepSize specifikuje vzdálenost mezi renderovanými vzorky, 
které tvoří volumetrický efekt. Sníţením této hodnoty zvýšíte kvalitu, ale zvýšíte zároveņ 
poţadavky na výpočetní výkon. 

o Volume_Noise: Atribut Volume_Noise přidává náhodný faktor do vzorku, který mŧţe pomoct 
vyváţit efekt větších velikostí kroku (viz předchozí atribut). 

K atributŧm Color a Density mŧţete připojit další uzly pro vytvoření mnohem komplexnějších efektŧ. 

 
Obrázek 1: Render bez volumetrického 
efektu (bez mlhy). 

Obrázek 2: Render s volumetrickým 
efektem (s mlhou). 

 

 POZNÁMKA 
JASNÁ NEKONEČNÁ SVĚTLA MOHOU ELIMINOVAT ÚČINEK VOLUMETRICKÝCH EFEKTŦ  
V PŘÍPADĚ, ŢE NEPOUŢIJETE VELMI NÍZKOU HODNOTU DENSITY. VOLUMETRICKÉ EFEKTY 
BÝVAJÍ NEJLÉPE VYUŢÍVÁNY S BODOVÝMI SVĚTLY A PEČLIVĚ NASTAVENOU HODNOTOU 
DENSITY. KROMĚ TOHO, VOLUMETRICKÉ SVĚTELNÉ EFEKTY JSOU VIDITELNÉ POUZE  
U RENDEROVANÉHO OBJEKTU. NEJSOU VIDITELNÉ NAD PRÁZDNÝM POZADÍM, DOKONCE  
I KDYŢ JE VE SCÉNĚ DEFINOVÁN SHADER POZADÍ. ABY BYL VOLUMETRICKÝ SVĚTELNÝ 
EFEKT VIDITELNÝ, MUSÍ BÝT NA OBRAZOVCE PŘÍTOMEN ALESPOŅ JEDEN OBJEKT. 
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MATEMATICKÉ UZLY  MATH NODES (orig.314) 

Toto jsou matematické uzly obsaţené v Poseru 7. Pokud není stanoveno jinak, seznam atributŧ pro 
kaţdý uzel je vyjmenován odshoru dolŧ: 
 

MATEMATICKÉ FUNKCE  MATH FUNCTION (orig.315) 

Uzel matematických funkcí Math Function je vhodný pro matematicky spojované hodnoty, uzly  
a ostatní parametry a mŧţe být pouţit k vytvoření zákonitostí. Tento uzel má následující atributy: 

o Math Argument: Toto rozbalovací menu definuje pouţitou matematickou funkci. Dostupné poloţky 
jsou následující: 

o Add: Zvolením Add dostanete Value 1 plus Value 2. 

o Subtract: Zvolením Subtract dostanete Value 1 mínus Value 2. 

o Multiply: Zvolením Multiply dostanete Value 1 násobeno Value 2. 

o Divide: Zvolením Divide dostanete Value 1 děleno Value 2. 

o Sine: Zvolením Sin dostanete sinus Value 1. Value 2 je ignorovaná. 

o Cosine: Zvolením Cos dostanete kosinus Value 1. Value 2 je ignorovaná. 

o Tangent: Zvolením Tan dostanete tangens Value 1. Value 2 je ignorovaná. 

o Square Root: Zvolením Sqrt dostanete druhou odmocninu Value 1. Value 2 je ignorovaná. 

o Power: Zvolením Pow dostanete mocninu Value 1 na Value 2 (například 3
3
). 

o Exponential: Zvolením Exp dostanete e s mocnitelem Value 1, Value 2 je ignorovaná 
(například e

V1
). 

o Logarithm: Zvolením Log dostanete přirozený logaritmus Value 1, Value 2 je ignorovaná. 

o Modulus: Zvolením Mod dostanete modulus (zŧstatek) Value 1 děleno Value 2. 

o Absolute: Zvolením Abs dostanete absolutní hodnotu Value 1. Value 2 je ignorovaná. 

o Sign: Zvolením Sign dostanete –1 pokud je Value 1 menší neţ nula a 1 pokud je Value 1 větší 
nebo rovná nule. Value 2 je ignorovaná. 

o Minimum: Zvolením Min dostanete Value 1 pokud je Value 1 menší neţ Value 2, v opačném 
případě dostanete Value 2. 

o Maximum: Zvolením Max dostanete Value 1 pokud je Value 1 větší neţ Value 2, v opačném 
případě dostanete Value 2. 

o Clamp: Zvolením Clamp dostanete Value 1 pokud není Value 1 menší neţ 0 nebo větší neţ 1. 
Pokud je Value 1<0, dostanete 0. Pokud je Value 1>1, dostanete 1. Value 2 je ignorovaná. 

o Ceiling: Zvolením Ceil dostanete Value 1 zaokrouhlenou na následující vyšší celé číslo. Value 
2 je ignorovaná. 

o Floor: Zvolením Floor dostanete Value 1 zaokrouhlenou dolŧ na následující celé číslo. Value 2 
je ignorovaná. 

o Round: Zvolením Round dostanete Value 1 zaokrouhlenou na nejbliţší celé číslo. Value 2 je 
ignorovaná. 

o Step: Zvolením Step dostanete 1 pokud Value 1 je menší neţ Value 2 a 0, pokud Value 1 je 
větší nebo se rovná hodnotě Value 2. 

o Smooth Step: Zvolením Smoothstep dostanete Value 1 bikubicky vyhlazenou. Value 2 je 
ignorovaná. 

o Bias: Zvolením Bias nastavíte odchylku Value 1 od Value 2. 

o Gain: Zvolením Gain nastavíte zvýšení Value 1 0d Value 2. 

o Value 1: Hodnota Value_1 definuje první veličinu matematické rovnice. 

o Value 2: Hodnota Value_2 definuje druhou veličinu matematické rovnice. 
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MATEMATIKA BARVY  COLOR MATH (orig.316) 

Uzel matematiky barvy Color Math vykonává vybranou matematickou operaci se dvěma barvami. 
Tento uzel má následující atributy: 

o Math Argument: Podívejte se prosím na vysvětlení předchozího uzlu výše, který obsahuje stejný 
seznam matematických funkcí, dostupných v tomto rozbalovacím menu. 

o Value 1: Hodnota Value_1 definuje první veličinu barvy do matematické rovnice. 

o Value 2: Hodnota Value_2 definuje druhou veličinu barvy do matematické rovnice. 
 

SMĚŠOVAČ  BLENDER (orig.316) 

Uzel směšovače Blender prolíná dvě barvy za pouţití hodnoty atributu jako alfa kanál. Tento uzel má 
následující atributy: 

o Input 1: Atribut Input_1 definuje první barvu pro mísení. Kliknutím na tento atribut otevřete 
standardní barevný vzorník Color Picker. 

o Input 2: Atribut Input_2 definuje druhou barvu pro mísení. Kliknutím na tento atribut otevřete 
standardní barevný vzorník Color Picker. 

o Blending: Atribut Blending se pouţívá pro stanovení míry prolnutí barev. Spravné hodnoty jsou od 
0 (jen barva Input 1) do 1 (jen barva Input 2). 

 

PROSTÁ BARVA  SIMPLE COLOR (orig.316) 

Uzel prosté barvy Simple Color umoţņuje přístup do barevného vzorníku k provedení výběru barvy. 
Klinutím na barvu (atribut Color) otevřete barevný vzorník Poseru 7 Color Picker. Pro pouţití 
barevného vzorníku Vašeho operačního systému stiskněte klávesu [OPT]/[ALT] současně s kliknutím 
na barvu, nebo klikněte na červeno-zeleno-modré tlačítko v pravém horním rohu barevného vzorníku 
Poseru 7 Color Picker. 
 

BAREVNÝ PŘECHOD  COLOR RAMP (orig.317) 

Uzel barevného přechodu Color Ramp vezme čtyři barvy a vytvoří mapu barevného přechodu 
(gradientu) mezi nimi. Mŧţete připojit výstup jiného uzlu ve stupních šedi (turbulence, dřevo, apod.), 
který v tomto uzlu vytvoří zajímavé stacionární nebo animované efekty za pouţítí hodnot stupņŧ šedi, 
coţ vytvoří obarvenou verzi originálního černobílého obrazu. Tento uzel má následující atributy: 

o Color 1 through Color 4: Atributy Color_1 po Color_4 umoţņují zadání vstupních barev pro 
barevný přechod. Kliknutím na tyto atributy otevřete standardní barevný vzorník Color Picker. 

o Index: Atribut Index je hodnota ve stupních šedi, která je vyhledávána při tvorbě barevného 
přechodu. Toto je místo, kde napojíte Váš černobílý obrázek. 

 

UŢIVATELSKY DEFINOVANÝ  USER DEFINED (orig.317) 

Uţivatelsky definovaný uzel User Defined umoţņuje definování uţivatelské barvy. Atribut Color 
Mode (spodní) je rozbalovacím menu, které umoţņuje specifikaci poţadovaného barevného modelu. 
Mŧţete volit mezi RBG, HSV nebo HSL módy a zadávat odpovídající hodnoty do tří následujících 
políček, viz dále: 

o Top Field: Tento atribut umoţņuje zadání hodnoty červené Red (RGB) nebo odstínu Hue (HSV 
nebo HSL) od 0 do 1. 

o Middle Field: Tento atribut umoţņuje zadání hodnoty zelené Green (RGB) nebo sytosti Saturation 
(HSV nebo HSL) od 0 do 1. 

o Bottom Field: Tento atribut umoţņuje zadání hodnoty modré Blue (RGB) nebo světlosti Value 
(HSV) nebo jasu Lightness (HSL) od 0 do 1. 

 

PROLÍNÁNÍ OKRAJŮ  EDGE BLEND (orig.317) 

Uzel prolínání okrajŧ Edge Blend prolíná barevné uzly v závislosti na povrchu a úhlech kamery. Tento 
uzel obsahuje následující atributy: 
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o Inner Color: Atribut Inner Color definuje barvu povrchŧ natočených čelem směrem ke kameře. 
Kliknutím na tento atribut se otevře standardní barevný vzorník Color Picker. 

o Outer Color: Atribut Outer Color definuje barvu povrchŧ natočených čelem směrem od kamery. 
Kliknutím na tento atribut se otevře standardní barevný vzorník Color Picker. 

o Attenuation: Atribut Attenuation definuje výkonovou křivku pouţitou pro přechod mezi vnitřní inner 
a vnější outer barvou. 

 

SLOŢKA  COMPONENT (orig.317) 

Uzel sloţky Component je uţitečný pro extrakci červené, zelené nebo modré sloţky vstupní barvy. 
Tento uzel obsahuje následující atributy: 

o Component: Atribut Component specifikuje barevnou sloţku, která má být extrahována. 
0=červená, 1=zelená a 2=modrá. 

o Color: Atribut Color přináší vstup pro jiný uzel, jehoţ výstup bude zpracovaný podle nastavení 
atributu Component. 

o Point: Atribut Point přináší vstup pro bodový uzel, jehoţ výstup bude zpracovaný podle nastavení 
atributu Component. 

 

UZLY PROMĚNNÝCH VELIČIN  VARIABLE NODES (orig.318) 

Toto jsou uzly hodnot obsaţených v Poseru 7. Pokud není stanoveno jinak, seznam atributŧ pro kaţdý 
uzel je vyjmenován odshoru dolŧ: 
 

N  N (orig.318) 

Uzel N vrací normálu specifikovaného 
bodu. Tento uzel obsahuje následující 
atributy: 

o X: Atribut X je X souřadnicí 
normálového vektoru. 

o Y: Atribut Y je Y souřadnicí 
normálového vektoru. 

o Z: Atribut Z je Z souřadnicí 
normálového vektoru. 

 

P  P (orig.318) 

Uzel P definuje konkrétní bod  
v prostoru. Tento uzel obsahuje 
následující atributy: 

o X: Atribut X je souřadnicí X polohy 
bodu. 

o Y: Atribut Y je souřadnicí Y polohy 
bodu. 

o Z: Atribut Z je souřadnicí Z polohy 
bodu. 

Vizualizace směru povrchových normál 

ČÍSLO SNÍMKU  FRAME NUMBER (orig.319) 

Uzel Frame Number vrací číslo aktuálního snímku. Tento uzel nemá ţádné definovatelné atributy. 
 

U SOUŘADNICE TEXTURY  U TEXTURE COORDINATE (orig.319) 

Uzel U vrací S souřadnice plochy textury, jejíţ pixely budou aktuálně renderovány. Tento uzel nemá 
ţádné definovatelné atributy. 
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V SOUŘADNICE TEXTURY  V TEXTURE COORDINATE (orig.319) 

Uzel V vrací T souřadnice plochy textury, jejíţ pixely budou aktuálně renderovány. Tento uzel nemá 
ţádné definovatelné atributy. 
 

DU  DU (orig.319) 

Uzel dU definuje rychlost změny parametrŧ povrchu týkajících se aktuálního umístění pixelŧ 
v prostoru S. Písmeno „d‟ indikuje derivaci parametru „U‟. 
 

DV  DV (orig.319) 

Uzel dV definuje rychlost změny parametrŧ povrchu týkajících se aktuálního umístění pixelŧ 
v prostoru T. Písmeno „d‟ indikuje derivaci parametru „V‟. 
 

DPDV  DPDV (orig.319) 

Uzel dPdv reprezentuje obměny proměnné shaderu bodu povrchu. Jedná se o kolmý vektor 
k povrchové normále ve směru „V‟. Výslovně indikuje derivaci pozice povrchu podél směru „V‟. Tento 
uzel nemá ţádné definovatelné atributy. 
 

DPDU  DPDU (orig.319) 

Uzel dPdu reprezentuje obměny proměnné shaderu bodu povrchu. Jedná se o kolmý vektor 
k povrchové normále ve směru „U‟. Výslovně indikuje derivaci pozice povrchu podél směru „U‟. Tento 
uzel nemá ţádné definovatelné atributy. 
 

DNDV  DNDV (orig.319) 

Uzel dNdv reprezentuje derivaci normály povrchu ve směru „V‟. Jinými slovy, tento uzel definuje 
rychlost změny normály povrchu podél „V‟. 
 

DNDU  DNDU (orig.320) 

Uzel dNdu reprezentuje derivaci normály povrchu ve směru „U‟. Jinými slovy, tento uzel definuje 
rychlost změny normály povrchu podél „U‟. 
 

UZLY OSVĚTLENÍ  LIGHTING NODES (orig.320) 

Toto jsou uzly osvětlení, které obsahuje místnost materiálu Material room. Pokud není stanoveno 
jinak, seznam atributŧ pro kaţdý uzel je vyjmenován odshoru dolŧ. Poloţky menu Light menu 
obsahuje několik podmenu, které dále obsahují jeden nebo více uzlŧ. 
 

UZLY ROZPTÝLENÉHO SVĚTLA  DIFFUSE NODES (orig.320) 

Rozptýlení  DIFFUSE (orig.320) 

Uzel Diffuse umoţņuje pouţití standardního modelu rozptýleného světla. Tento uzel obsahuje 
následující atributy: 

o Diffuse_Color: Atribut Diffuse_Color specifikuje barvu rozptýleného světla. 

o Diffuse_Value: Atribut Diffuse_Value definuje intenzitu rozptýlené barvy, kde 1=100%. 
 

Jílové světlo  CLAY (orig.320) 

Uzel Clay aplikuje světelný model vzhledu jílu (s bílošedivým odstínem) na zvolený materiál. Tento 
uzel obsahuje následující atributy: 

o Color: Atribut Color specifikuje barvu jílu. Kliknutím na barvu se otevře barevný vzorník Color 
Picker. 

o Kd: Atribut Kd specifikuje intenzitu barvy, kde 1=100%. 

o Highlight Size: Atribut Highlight_Size definuje velikost odrazivosti světla. 
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Světelná sonda  PROBELIGHT (orig.320) 

Uzel ProbeLight vytváří mapy ozařující prostředí, které jsou 360 stupņovým světelným zdrojem 
obsaţeným uvnitř jednoduché obrazové mapy a aplikuje je na Váš materiál. Tento uzel obsahuje 
následující atributy, stejně jako devět součinitelŧ: 

o Exposure: Atribut Exposure specifikuje jas, nebo úroveņ expozice mapy ozáření. 

o Saturation: Atribut Saturation specifikuje míru sytosti barev uvnitř mapy ozáření. 

o SurfaceColor: Atribut SurfaceColor umoţņuje výběr barevného odstínu, kterým bude mapa 
ozáření násobena. Pro realističtější výsledky doporučujeme pouţít bílý odstín. 

 POZNÁMKA 
JESTLI JE VAŠIM ZÁMĚREM VYTVOŘENÍ SVĚTLA ZALOŢENÉHO NA OBRAZU, MŦŢETE TO 
UDĚLAT JEDNODUCHÝM PŘIDÁNÍM ROZPTÝLENÉHO SVĚTLA NA BÁZI OBRAZU IMAGE 
BASED LIGHT DO VAŠÍ SCÉNY POMOCÍ OVLADAČŦ OSVĚTLENÍ. Viz kapitola 9: “Osvětlení” na 
straně 61 pro více informací o přidání a konfiguraci světel. 
 

Karikatura  TOON (orig.321) 

Uzel Toon dává Vašemu materiálu vzhled karikatury. Tento uzel obsahuje následující atributy: 

o Light Color: Atribut LightColor specifikuje světlý odstín barvy. 

o Dark Color: Atribut DarkColor specifikuje tmavý odstín barvy. 

o Ink Color: Atribut InkColor specifikuje odstín barvy tuţe (obrysŧ karikatury). 

o Spread: Atribut Spread definuje ostrost/měkkost přechodŧ mezi barvami. 

o Line Width: Atribut LineWidth specifikuje tloušťku obrysŧ karikatury tuţí. 
 

UZLY ODRAZU SVĚTLA  SPECULAR NODES (orig.321) 

Uzly odrazu světla přinášejí rŧzné výpočtové modely odrazŧ světla od objektŧ. 
 

Anizotropní  ANISOTROPIC (orig.321) 

Uzel Anisotropic umoţņuje vytvoření odrazŧ nepravidelného tvaru. Tento uzel obsahuje následující 
atributy: 

o Specular Color: Atribut Specular_Color je barvou všech odrazŧ světla, které se objevují na 
povrchu objektu. Odrazy propŧjčují iluzi lesklého povrchu. Například kus dřeva nevytváří odrazy 
světla, zatímco kus leštěného kovu vytváří jeden nebo více zřetelných odrazŧ. Tato barva bývá 
většinou stejná, jakou má světlo přímo dopadající na dotčený povrch, ale nemusí tomu tak být. 

o Specular Value: Atribut Specular_Value definuje míru účinku barvy odrazu uvnitř shaderu. Vyšší 
hodnota účinnosti vytvoří větší, zřetelnější odrazy světla a naopak. 

o U Highlight Size: Atribut U_Highlight_Size definuje velikost odlesku ve směru U. 

o V Highlight Size: Atribut V_Highlight_Size definuje velikost odlesku ve směru V. 

o Xdir_X: Atribut Xdir_X nastavuje velikost reflexních odrazŧ relativně k ose X. 

o Xdir_Y: Atribut Xdir_Y nastavuje velikost reflexních odrazŧ relativně k ose Y. 

o Xdir_Z: Atribut Xdir_Z nastavuje velikost reflexních odrazŧ relativně k ose Z. 
 

Odraz  SPECULAR (orig.322) 

Uzel Specular definuje výpočtový model odleskŧ. Tento uzel obsahuje stejné atributy jako uzel 
Phong, který je popsán dále. 
 

Phong  PHONG (orig.322) 

Uzel Phong definuje výpočtový model odleskŧ. Tento uzel obsahuje následující atributy: 

o Specular Color: Atribut Specular_Color je barvou všech odrazŧ světla, které se objevují na 
povrchu objektu. Odrazy propŧjčují iluzi lesklého povrchu. Například kus dřeva nevytváří odrazy 
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světla, zatímco kus leštěného kovu vytváří jeden nebo více zřetelných odrazŧ. Tato barva bývá 
většinou stejná, jakou má světlo přímo dopadající na dotčený povrch, ale nemusí tomu tak být. 

o Specular Value: Atribut Specular_Value definuje míru účinku barvy odrazu uvnitř shaderu. Vyšší 
hodnota účinnosti vytvoří větší, zřetelnější odrazy světla a naopak. 

o Size: Atribut Size specifikuje velikost odlesku. 
 

Lesk  GLOSSY (orig.322) 

Uzel Glossy definuje výpočtový model odleskŧ. Tento uzel obsahuje následující atributy: 

o Specular Color: Atribut Specular_Color je barvou všech odrazŧ světla, které se objevují na 
povrchu objektu. Odrazy propŧjčují iluzi lesklého povrchu. Například kus dřeva nevytváří odrazy 
světla, zatímco kus leštěného kovu vytváří jeden nebo více zřetelných odrazŧ. Tato barva bývá 
většinou stejná, jakou má světlo přímo dopadající na dotčený povrch, ale nemusí tomu tak být. 

o Ks: Atribut Ks definuje intenzitu barvy odrazu, kde 1=100%. 

o Highlight Size: Atribut Highlight_Size definuje velikost odlesku. 

o Sharpness: Atribut Sharpness ostrost okrajŧ odlesku. 
 

Blinn  BLINN (orig.322) 

Uzel Blinn definuje výpočtový model odleskŧ. Tento uzel obsahuje následující atributy: 

o Specular Color: Atribut Specular_Color je barvou všech odrazŧ světla, které se objevují na 
povrchu objektu. Odrazy propŧjčují iluzi lesklého povrchu. Například kus dřeva nevytváří odrazy 
světla, zatímco kus leštěného kovu vytváří jeden nebo více zřetelných odrazŧ. Tato barva bývá 
většinou stejná, jakou má světlo přímo dopadající na dotčený povrch, ale nemusí tomu tak být. 

o Eccentricity: Vzorec Blinn modeluje mikroplošky povrchu (mikroskopické nedokonalosti) jako 
rotační elipsoidy. Atribut Eccentricity nastavuje velikost a odchylky nedokonalostí. Pouţijte 
hodnotu 0 pro velmi lesklé povrchy a hodnotu 1 pro matné povrchy s velkým rozptylem světla. 

o Specular Roll Off: Atribut SpecularRollOff nastavuje ostrost odleskŧ. 

o Reflectivity: Atribut Reflectivity nastavuje mnoţství světla, které je odráţeno zpět do očí. 
 

UZLY RAYTRACINGU  RAYTRACE NODES (orig.323) 

Pro pouţití uzlŧ raytracingu musíte raytracing aktivovat v dialogovém okně nastavení renderu Render 
Settings, jak je popsáno v kapitole 35: “Dialogové okno nastavení renderu” na straně 243. 
 

Odraz  REFLECT (orig.323) 

Uzel Reflect specifikuje odraz barvy při raytracingu. Tento uzel obsahuje následující atributy: 

o Background: Atribut Background vybírá barvu pozadí, která bude pouţita při raytracingu. 
Kliknutím na tento atribut dojde k otevření standardního barevného vzorníku Color Picker. 

o Quality: Atribut Quality nastavuje, jaké moţství paprskŧ je vytvořeno při zásahu povrchu. 
Zvýšením této hodnoty se zvyšuje realismus odrazŧ, ale zároveņ se zvyšují poţadavky na 
výpočetní prostředky. 

o Softness: Atribut Softness nastavuje náhodnost směrŧ odraţených paprskŧ. 

o RayBias: Atribut RayBias pomáhá zabránit falešným stínŧm a jiným artefaktŧm, které se mohou 
vyskytnout ve výsledku pouţití technik raytracingu ve spojení s přesazením map. RayBias 
srovnává startovní bod paprskŧ s geometrií povrchu, aby se vyhnul přesazení geometrie ve 
výpočtu raytracingu. Uvědomte si, ţe kdyţ bude nastavení RayBias velmi vysoké, stíny mohou 
putovat scénou. 

 

Lom  REFRACT (orig.323) 

Uzel Refract specifikuje lom barvy při raytracingu. Tento uzel obsahuje následující atributy: 
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o Background: Atribut Background vybírá barvu pozadí, která bude pouţita při raytracingu. 
Kliknutím na tento atribut dojde k otevření standardního barevného vzorníku Color Picker. 

o Index of Refraction: Atribut Index of Refraction určuje, jak moc se světlo ohýbá při prŧchodu skrze 
objekt. 

o Quality: Atribut Quality nastavuje, jaké moţství paprskŧ je vytvořeno při zásahu povrchu. 
Zvýšením této hodnoty se zvyšuje realismus odrazŧ, ale zároveņ se zvyšují poţadavky na 
výpočetní prostředky. 

o Softness: Atribut Softness určuje, jak ostré nebo rozptýlené bude lomené světlo po prŧchodu 
skrze objekt. 

o RayBias: Atribut RayBias pomáhá zabránit falešným stínŧm a jiným artefaktŧm, které se mohou 
vyskytnout ve výsledku pouţití technik raytracingu ve spojení s přesazením map. RayBias 
srovnává startovní bod paprskŧ s geometrií povrchu, aby se vyhnul přesazení geometrie ve 
výpočtu raytracingu. Uvědomte si, ţe kdyţ bude nastavení RayBias velmi vysoké, stíny mohou 
putovat scénou. 

 

Pohlcování světla okolím  AMBIENT OCCLUSION (orig.324) 

Uzel Ambient Occlusion pouţívá raytracing pro výpočet stupně, kterým ostatní objekty uvnitř scény 
pohlcují obklopující světlo svým povrchem v daném bodě. Povrchy s větším koeficientem pohltivosti 
budou renderovány jako tmavší, neţ povrchy s malou nebo ţádnou pohltivostí. Tento uzel obsahuje 
následující atributy: 

o Samples: Atribut Samples určuje mnoţství emitovaných paprskŧ. Příliš málo vzorkŧ (samples) 
vytvoří ve výsledku zrnitý vzhled tmavších ploch scény. Vyšší mnoţství vzorkŧ přinese vyšší kvalitu 
tmavých ploch, ale zároveņ prodlouţí dobu renderu. 

o MaxDist: Atribut MaxDist umoţņuje nastavení maximální vzdálenosti, kterou paprsky urazí ve 
scéně, čímţ omezí mnoţství shromaţďovaných dat. 

o RayBias: Atribut RayBias pomáhá zabránit falešným stínŧm a jiným artefaktŧm, které se mohou 
vyskytnout ve výsledku pouţití technik raytracingu ve spojení s přesazením map. RayBias 
srovnává startovní bod paprskŧ s geometrií povrchu, aby se vyhnul přesazení geometrie ve 
výpočtu raytracingu. Uvědomte si, ţe kdyţ bude nastavení RayBias velmi vysoké, stíny mohou 
putovat scénou. 

o Strength: Atribut Strength nastavuje stupeņ, kterým uzel Ambient Occlusion ztmaví pohltivé 
povrchy uvnitř scény. 

Obrázek 1 (vlevo): Bez Ambient Occlusion 
(hluboké stínování)  

Obrázek 2 (vpravo): S Ambient Occlusion 
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Vypuzení světla objektem GATHER (orig.325) 

Uzel Gather pouţívá raytracing ke shromaţďování informací o barvě a světle z povrchŧ uvnitř 
specifické plochy, které při kombinaci s nekonečným světelným zdrojem vytváří realistický “venkovní” 
světelný efekt. Tento efekt také přidává do renderované scény určitou emitaci barvy od objektŧ. 
Samplovací oblast vypuzení světla objektem Gather, nebo kuţel, je definována následujícícmi 
atributy: 

o Samples: Atribut Samples určuje mnoţství emitovaných paprskŧ vypuzeného světla objektem 
Gather. Vyšší hodnota poskytne realističtější výsledky, ale zpŧsobí delší dobu renderu. 

o MaxDist: Atribut MaxDist umoţņuje nastavení maximální vzdálenosti paprskŧ vypuzeného světla 
Gather směrem do scény, čili omezení mnoţství shromaţďovaných dat. 

o RayBias: Atribut RayBias pomáhá zabránit falešným stínŧm a jiným artefaktŧm, které se mohou 
vyskytnout ve výsledku pouţití technik raytracingu ve spojení s přesazením map. RayBias 
srovnává startovní bod paprskŧ Gather s geometrií povrchu, aby se vyhnul přesazení geometrie ve 
výpočtu raytracingu. Uvědomte si, ţe kdyţ bude nastavení RayBias velmi vysoké, stíny mohou 
putovat scénou. 

o Angle: Atribut Angle nastavuje úhel kuţelu, ve kterém budou paprsky vypuzeného světla Gather 
emitovány. Širší úhel vytvoří ve výsledku větší oblast a poţadavek na větší mnoţství dat. Větší 
mnoţství dat poskytne realističtější výsledky, ale zpŧsobí delší dobu renderu. 

Obrázek 1 (vpravo): Bez uzlu Gather 
(barva není emitována) 

Obrázek 2 (vlevo): S uzlem Gather 
(barva je emitována) 

 

Fresnel  FRESNEL (orig.325) 

Uzel Fresnel je pouţíván u povrchŧ které jsou současně světlolomné a reflexní (také známé jako 
dielektrikum). Takové povrchy inklinují více k odrazu, kdyţ úhel pozorovatele k povrchu je velký  
a k lomu světla, kdyţ úhel pozorovatele k povrchu je malý. Mnoho povrchŧ je transparentních 
(světlolomných) a zároveņ odráţejících. 

Pro pouţití uzlu Fresnel s uzlem povrchu, propojte jej s kanálem refraction_color uzlu povrchu. 
Nastavte nízkou hodnotu Diffuse a Transparency na 0. Uzel Fresnel obsahuje následující atributy: 

o Background: Atribut Background vybírá barvu pozadí, která bude pouţita při raytracingu. 
Kliknutím na tento atribut dojde k otevření standardního barevného vzorníku Color Picker. 
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o Index of Refraction: Atribut Index of Refraction určuje, jak moc se světlo ohýbá při prŧchodu skrze 
objekt. 

o Quality: Atribut Quality nastavuje, jaké moţství paprskŧ je vytvořeno při zásahu povrchu. 
Zvýšením této hodnoty se zvyšuje realismus odrazŧ, ale zároveņ se zvyšují poţadavky na 
výpočetní prostředky. 

o Softness: Atribut Softness určuje, jak ostré nebo rozptýlené bude lomené světlo po prŧchodu 
skrze objekt. 

 

UZLY MAP PROSTŘEDÍ  ENVIRONMENT MAP NODES (orig.326) 

Kulovité mapy  SPHERE MAP (orig.326) 

Uzel Sphere Map je uzel osvětlení vytvářející kulovité odrazy. Pro vytvoření kulovitých odrazŧ připojte 
tento uzel na vstup reflection materiálu (nebo jako atribut raytrace reflection módu barvy). Tento 
uzel obsahuje následující atributy: 

o Color: Atribut Color specifikuje barvu mapy. Kliknutím na barvu se otevře barevný vzorník Color 
Picker. 

o Rotation: Atribut Rotation specifikuje hodnoty rotace mapy okolo os X, Y a Z. 
 

SPECIÁLNÍ UZLY  SPECIAL NODES (orig.326) 

Pokoţka  SKIN (orig.326) 

Uzel Skin umoţņuje vytvoření realistické pokoţky. Tento uzel obsahuje následující atributy: 

o Skin Color: Atribut SkinColor specifikuje základní barvu pokoţky. Kliknutím na barvu se otevře 
barevný vzorník Color Picker. 

o Sheen Color: Atribut SheenColor je barvou všech odrazŧ světla, které se objevují na povrchu 
objektu. Odrazy propŧjčují iluzi lesklého povrchu. Například kus dřeva nevytváří odrazy světla, 
zatímco kus leštěného kovu vytváří jeden nebo více zřetelných odrazŧ. Tato barva bývá většinou 
stejná, jakou má světlo přímo dopadající na dotčený povrch, ale nemusí tomu tak být. 

o Ka: Atribut Ka nastavuje intenzitu obklopujícího světla ambient light, kde 1=100%. 

o Kd: Atribut Kd nastavuje intenzitu difuzního světla diffuse light, kde 1=100%. 

o Ks: Atribut Ks nastavuje intenzitu odraţeného světla specular light, kde 1=100%. 

o Thickness: Atribut Thickness nastavuje tloušťku nejvyšší, prŧsvitné vrstvy pokoţky. 

o ETA: Atribut ETA nastavuje hustotu nejvyšší, prŧsvitné vrstvy pokoţky. 
 

Samet  VELVET (orig.327) 

Uzel Velvet umoţņuje vytvoření povrchu se vzhledem realistické sametové látky. Tento uzel obsahuje 
následující atributy: 

o Velvet Color: Atribut Velvet_Color vybírá základní barvu. Kliknutím na atribut se otevře barevný 
vzorník Color Picker. 

o Velvet Sheen: Atribut Velvet_Sheen je barvou všech odrazŧ světla, které se objevují na povrchu 
objektu. Odrazy propŧjčují iluzi lesklého povrchu. Například kus dřeva nevytváří odrazy světla, 
zatímco kus leštěného kovu vytváří jeden nebo více zřetelných odrazŧ. Tato barva bývá většinou 
stejná, jakou má světlo přímo dopadající na dotčený povrch, ale nemusí tomu tak být. 

o Ka: Atribut Ka nastavuje intenzitu obklopujícího světla ambient light, kde 1=100%. 

o Kd: Atribut Kd nastavuje intenzitu difuzního světla diffuse light, kde 1=100%. 

o Ks: Atribut Ks nastavuje intenzitu odraţeného světla specular light, kde 1=100%. 

o Highlight Size: Atribut Highlight_Size nastavuje tloušťku nejvyšší, prŧsvitné vrstvy povrchu. 

o Edginess: Atribut Edginess nastavuje hustotu nejvyšší, prŧsvitné vrstvy povrchu. 
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Vlasy  HAIR (orig.327) 

Uzel Hair umoţņuje obarvení vlasŧ Vaší postavy. Tento uzel obsahuje následující atributy: 

o Root Color: Atribut Root_Color slouţí k volbě barvy kořínkŧ vlasŧ. Kliknutím na atribut se otevře 
barevný vzorník Color Picker. 

o Tip Color: Atribut Tip_Color slouţí k volbě barvy konečkŧ vlasŧ. Kliknutím na atribut se otevře 
barevný vzorník Color Picker. 

o Specular Color: Atribut Specular_Color slouţí k volbě barvy odleskŧ vlasŧ. Kliknutím na atribut se 
otevře barevný vzorník Color Picker. 

o Root Softness: Atribut Root_Softness nastavuje prŧhlednost kořínkŧ vlasŧ, coţ pomáhá ke 
splynutí vlasŧ s pokoţkou hlavy. 

 POZNÁMKA 
PRO VYTVOŘENÍ REALISTICKÉHO SHADERU VLASŦ PŘIPOJTE TENTO UZEL K ATRIBUTU 
ALTERNATE DIFFUSE KOŘENOVÉHO UZLU. 
 

FastScatter  FASTSCATTER (orig.328) 

Uzel FastScatter nabízí jednoduchou aplikaci efektu podpovrchového rozptylu SubSurface 
Scattering (SSS). SubSurface Scattering simuluje interakci světla prŧsvitným materiálem, pomocí 
níţ světlo ovlivņuje se do určité míry materiál pod povrchem. Výsledky výpočtu uzlu FastScatter se 
velmi přibliţuje reálnému podpovrchovému rozptylu SubSurface Scattering. Navíc má FastScatter 
výhodu v tom, ţe je několikrát rychlejší neţ tradiční SubSurface Scattering, protoţe nevyţaduje 
raytracing. Uzel FastScatter obsahuje následující atributy: 

o Color: Atribut Color umoţņuje specifikovat odstín barvy podpovrchového prostoru. 

o Attenuate: Atribut Attenuate specifikuje, ţe uzel FastScatter bude ignorovat světlo směřující 
z pohledu kamery a umoţní maximální účinek světla ve směru na kameru. Stupeņ účinku světla 
přicházejícího ze směrŧ mezi těmito dvěma body bude uváţen pomocí kalkulace uzlu FastScatter 
ve shodě s úhlem světla vŧči kameře. 

Obrázek 1 (vlevo): Bez FastScatter 
(bez SSS) 

Obrázek 2 (vpravo): Včetně 
FastScatter (včetně SSS) 
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UZLY 3D TEXTURY  3D TEXTURE NODES (orig.329) 

Toto jsou uzly barvy obsaţené v místnosti materiálu Material room. Pokud není stanoveno jinak, 
seznam atributŧ pro kaţdý uzel je vyjmenován odshoru dolŧ: 
 

SOUČET FRAKTÁLU  FRACTAL SUM (orig.329) 

Uzel Fractal Sum je funkcí fraktálu, která vrací hodnoty v rozpětí –1 a 1. Tento uzel obsahuje 
následující atributy: 

o X Index: Atribut x_index definuje pozici na ose X, ze které se vykresluje vzorek šumu. 

o Y Index: Atribut y_index definuje pozici na ose Y, ze které se vykresluje vzorek šumu. 

o Z Index: Atribut z_index definuje pozici na ose Z, ze které se vykresluje vzorek šumu. 

o Octaves: Atribut Octaves definuje počet opakování funkce fraktálu. Vyšší hodnoty vytvoří 
detailnější fraktály, ale mohou prodlouţit dobu renderu. 

o Bottom: Atribut Bottom nastavuje spodní barevnou vrstvu nebo podlahu. 

o Bias: Atribut Bias specifikuje, jak daleko se mohou vzorky posunout ve směru ke světelnému 
zdroji, aby se vyloučilo vlastní zastínění objektŧ. 

o Gain: Atribut Gain nastavuje rovnováhu mezi světlými a tmavými barvami. 
 

FBM  FBM (orig.329) 

Uzel FBM je multi-fraktálová funkce. Tento uzel obsahuje následující atributy: 

o Signed: Označením políčka Signed dojde ke vrácení hodnoty v rozsahu –1 do 1. Pokud není 
políčko označeno, hodnoty menší neţ 0 budou vráceny bez znaménka, například –25 bude 
vráceno jako 25. 

o Fractal Increment: Atribut Fractal_Increment nastavuje šum. Nízké hodnoty vytvoří hladší šumový 
gradient. 

o Frequency Gap: Atribut Frequency_Gap nastavuje velikost fraktálu. Větší hodnoty vytvoří větší 
fraktály. 

o Octaves: Atribut Octaves definuje počet opakování funkce fraktálu. Vyšší hodnoty vytvoří 
detailnější fraktály, ale mohou prodlouţit dobu renderu. 

o X Index: Atribut x_index definuje pozici na ose X, ze které se vykresluje vzorek šumu. 

o Y Index: Atribut y_index definuje pozici na ose Y, ze které se vykresluje vzorek šumu. 

o Z Index: Atribut z_index definuje pozici na ose Z, ze které se vykresluje vzorek šumu. 

o Bottom: Atribut Bottom nastavuje spodní barevnou vrstvu nebo podlahu. 

o Bias: Atribut Bias specifikuje, jak daleko se mohou vzorky posunout ve směru ke světelnému 
zdroji, aby se vyloučilo vlastní zastínění objektŧ. 

o Gain: Atribut Gain nastavuje rovnováhu mezi světlými a tmavými barvami. 

o Noise_Type: Atribut Noise_Type umoţņuje výběr mezi typem šumu Original Perlin a mezi 
rozšířenou definicí šumu Improved. 

 

TURBULENCE  TURBULENCE (orig.330) 

Uzel Turbulence je neoznačená funkce fraktálu. Tento uzel obsahuje následující atributy: 

o X Index: Atribut x_index definuje pozici na ose X, ze které se vykresluje vzorek šumu. 

o Y Index: Atribut y_index definuje pozici na ose Y, ze které se vykresluje vzorek šumu. 

o Z Index: Atribut z_index definuje pozici na ose Z, ze které se vykresluje vzorek šumu. 

o Octaves: Atribut Octaves definuje počet opakování funkce fraktálu. Vyšší hodnoty vytvoří 
detailnější fraktály, ale mohou prodlouţit dobu renderu. 

o Bottom: Atribut Bottom nastavuje spodní barevnou vrstvu nebo podlahu. 
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o Bias: Atribut Bias specifikuje, jak daleko se mohou vzorky posunout ve směru ke světelnému 
zdroji, aby se vyloučilo vlastní zastínění objektŧ. 

o Gain: Atribut Gain nastavuje rovnováhu mezi světlými a tmavými barvami. 

o Noise_Type: Atribut Noise_Type umoţņuje výběr mezi typem šumu Original Perlin a mezi 
rozšířenou definicí šumu Improved. 

 

MRAKY  CLOUDS (orig.330) 

Uzel Clouds simuluje vzory mrakŧ. Tento uzel obsahuje následující atributy: 

o Sky Color: Atribut Sky_Color definuje prostor za mraky. Kliknutím na atribut se otevře barevný 
vzorník Color Picker. 

o Cloud Color: Atribut Cloud_Color definuje mraky. Kliknutím na atribut se otevře barevný vzorník 
Color Picker. 

o Scale: Atribut Scale definuje velikost mrakŧ. 

o Complexity: Atribut Complexity definuje komplexnost tvarŧ mrakŧ. 

o Bottom: Atribut Bottom nastavuje spodní barevnou vrstvu nebo podlahu. 

o Bias: Atribut Bias specifikuje, jak daleko se mohou vzorky posunout ve směru ke světelnému 
zdroji, aby se vyloučilo vlastní zastínění objektŧ. 

o Gain: Atribut Gain nastavuje rovnováhu mezi světlými a tmavými barvami. 

o Global Coordinates: Rozbalovací menu Global_Coordinates pouţijte k volbě spuštění ON nebo 
vypnutí OFF. Pokud je spuštěno, textura je vypočítávána za pouţití celkového prostoru namísto 
prostoru objektu a naopak. Pokud je tato funkce spuštěna ve chvíli, kdy se objekt jakkoliv 
pohybuje, textura bude po renderu vypadat jako „sklouznutá“ skrze objekt. 

o Noise_Type: Atribut Noise_Type umoţņuje výběr mezi typem šumu Original Perlin a mezi 
rozšířenou definicí šumu Improved. 

 

MRAMOR  MARBLE (orig.331) 

Uzel Marble je 3D simulací mramoru a jiných vzorkŧ kamene. Tento uzel obsahuje následující 
atributy: 

o Base Color: Atribut Base_Color specifikuje základní barvu materiálu. Kliknutím na barvu se otevře 
barevný vzorník Color Picker. 

o Veins: Atribut Veins definuje barvu ţilkování. Kliknutím na barvu se otevře barevný vzorník Color 
Picker. 

o Scale: Atribut Scale definuje velikost ţilkování. 

o Turbulence: Atribut Turbulence definuje nízkofrekvenční nepravidelnost cihlového vzoru. 

o Global Coordinates: Rozbalovací menu Global_Coordinates pouţijte k volbě spuštění ON nebo 
vypnutí OFF. Pokud je spuštěno, textura je vypočítávána za pouţití celkového prostoru namísto 
prostoru objektu a naopak. Pokud je tato funkce spuštěna ve chvíli, kdy se objekt jakkoliv 
pohybuje, textura bude po renderu vypadat jako „sklouznutá“ skrze objekt. 

o Noise_Type: Atribut Noise_Type umoţņuje výběr mezi typem šumu Original Perlin a mezi 
rozšířenou definicí šumu Improved. 

 

ŠUM  NOISE (orig.331) 

Uzel Noise přidává náhodné efekty “šumu” nebo “sněţení”. Tento uzel obsahuje následující atributy: 

o X Index: Atribut x_index definuje pozici na ose X, ze které se vykresluje vzorek šumu. 

o Y Index: Atribut y_index definuje pozici na ose Y, ze které se vykresluje vzorek šumu. 

o Z Index: Atribut z_index definuje pozici na ose Z, ze které se vykresluje vzorek šumu. 

o Min: Atribut Min nastavuje minimální úroveņ šumu. 
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o Max: Atribut Max nastavuje maximální úroveņ šumu. 
 

BUŇKOVÉ STRUKTURY  CELLULAR (orig.332) 

Uzel Cellular se pouţívá ke tvorbě mozaiky nebo trojrozměrných dlaţdic. Tento uzel obsahuje 
následující atributy: 

o Color1: Atribut Color1 specifikuje barvu dlaţdice. 

o Intensity1: Atribut Intensity1 určuje stupeņ dominance mezi dlaţdicemi a rohy. 

o Color2: Atribut Color2 specifikuje barvu mezer mezi dlaţdicemi. 

o Intensity2: Atribut Intensity2 určuje stupeņ dominance mezi ploškami a rohy. 

o ScaleX: Atribut ScaleX nastavuje velikost dlaţdic podél osy X. 

o ScaleY: Atribut ScaleY nastavuje velikost dlaţdic podél osy Y. 

o ScaleZ: Atribut ScaleZ nastavuje velikost dlaţdic podél osy Z. 

o RandomColor: Aktivováním atributu RandomColor specifikujete, ţe barva kaţdé dlaţdice bude 
stanovena náhodně. 

o CellMode: Atribut CellMode určuje typ a tvar dlaţdic. Tento atribut obsahuje následující volby: 

o Mode 1: Tato volba vytvoří 3D dlaţdice. Mŧţete zvýšit hodnotu Intensity1 pro vytvoření 
markantnějších dlaţdic. 

o Mode 2: Tato volba zdŧrazņuje mezery mezi dlaţdicemi. Pro maximalizaci tohoto efektu 
nastavte hodnotu Intensity1 poměrně vysoko. 

o Mode 3: Tato volba vytvoří efekt pavoučí sítě. Atribut Color1 v tomto případě definuje barvu 
vláken sítě. Pro maximalizaci tohoto efektu nastavte hodnotu Intensity1 poměrně vysoko. 

o Mode 4: Tato volba je podobná té z Mode 3, ale obsahuje dodatečnou dimenzi. 

o Mode 5: Tato volba vytvoří buņky stylu rohoţe v případě, ţe atribut RandomColor je aktivován. 

o Jitter: Atribut Jitter nastavuje nepravidelnost velikostí dlaţdic. 

o Turbulence: Atribut Turbulence definuje nepravidelnost okrajŧ dlaţdic. 

o GlobalCoordinates: Pokud je atribut GlobalCoordinates aktivován, objekt bude pouţívat globální 
souřadnice. 

o Noise_Type: Atribut Noise_Type umoţņuje výběr mezi typem šumu Original Perlin a mezi 
rozšířenou definicí šumu Improved. 

 

ŢULA  GRANITE (orig.333) 

Uzel Granite je 3D simulací kropenaté textury ţuly. Tento uzel obsahuje následující atributy: 

o Base Color: Atribut Base_Color specifikuje základní barvu materiálu. Kliknutím na barvu se otevře 
barevný vzorník Color Picker. 

o Spot Color: Atribut Spot_Color barvu bodŧ. Kliknutím na barvu se otevře barevný vzorník Color 
Picker. 

o Scale: Atribut Scale definuje velikost kropenatosti (bodŧ). 

o Shades: Atribut Shades definuje počet odstínŧ pouţitých u textury mezi stanovenými barvami 
základu a bodŧ. 

o Balance: Atribut Balance definuje sklon k odstínu barvy základní nebo barvy bodu. Hodnoty blízko 
0 favorizují barvu bodu, zatímco hodnoty blízko 1 favorizují barvu základní. 

o Global Coordinates: Rozbalovací menu Global_Coordinates pouţijte k volbě spuštění ON nebo 
vypnutí OFF. Pokud je spuštěno, textura je vypočítávána za pouţití celkového prostoru namísto 
prostoru objektu a naopak. Pokud je tato funkce spuštěna ve chvíli, kdy se objekt jakkoliv 
pohybuje, textura bude po renderu vypadat jako „sklouznutá“ skrze objekt. 
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o Noise_Type: Atribut Noise_Type umoţņuje výběr mezi typem šumu Original Perlin a mezi 
rozšířenou definicí šumu Improved. 

 

DŘEVO  WOOD (orig.333) 

Uzel Wood vytváří 3D texturu, která simuluje dřevěný povrch. Tento uzel obsahuje následující 
atributy: 

o Light Color: Atribut Light_Wood definuje základní barvu dřeva. Kliknutím na barvu se otevře 
barevný vzorník Color Picker. 

o Dark Color: Atribut Dark_Wood definuje barvu vláken dřeva. Kliknutím na barvu se otevře barevný 
vzorník Color Picker. 

o Scale: Atribut Scale definuje velikost vláken dřeva. 

o Turbulence: Atribut Turbulence definuje velikost nepravidelnosti vlákem dřeva. 

o Global Coordinates: Rozbalovací menu Global_Coordinates pouţijte k volbě spuštění ON nebo 
vypnutí OFF. Pokud je spuštěno, textura je vypočítávána za pouţití celkového prostoru namísto 
prostoru objektu a naopak. Pokud je tato funkce spuštěna ve chvíli, kdy se objekt jakkoliv 
pohybuje, textura bude po renderu vypadat jako „sklouznutá“ skrze objekt. 

o Noise_Type: Atribut Noise_Type umoţņuje výběr mezi typem šumu Original Perlin a mezi 
rozšířenou definicí šumu Improved. 

 

BODY  SPOTS (orig.334) 

Uzel Spots se skládá ze 3D textury sestavené z nahodilých bodŧ. Tento uzel obsahuje následující 
atributy: 

o Base Color: Atribut Base_Color specifikuje základní barvu materiálu. Kliknutím na barvu se otevře 
barevný vzorník Color Picker. 

o Spot Color: Atribut Spot_Color barvu bodŧ. Kliknutím na barvu se otevře barevný vzorník Color 
Picker. 

o Spot Size: Atribut Spot_Size definuje velikost bodŧ. 

o Softness: Atribut Softness stanovuje přechod mezi základní barvou a barvou bodu. 

o Threshold: Atribut Threshold definuje sklon k odstínu barvy základní nebo barvy bodu. Hodnoty 
blízko 0 favorizují barvu základní, zatímco hodnoty blízko 1 favorizují barvu bodu. 

o Global Coordinates: Rozbalovací menu Global_Coordinates pouţijte k volbě spuštění ON nebo 
vypnutí OFF. Pokud je spuštěno, textura je vypočítávána za pouţití celkového prostoru namísto 
prostoru objektu a naopak. Pokud je tato funkce spuštěna ve chvíli, kdy se objekt jakkoliv 
pohybuje, textura bude po renderu vypadat jako „sklouznutá“ skrze objekt. 

o Noise_Type: Atribut Noise_Type umoţņuje výběr mezi typem šumu Original Perlin a mezi 
rozšířenou definicí šumu Improved. 

 

3D VLNY  WAVE3D (orig.334) 

Uzel Wave3D implementuje tří-dimenzionální sin / cos trigonometrickou funkci, která ve výsledku 
vytvoří efekt tří-dimenzionální vlny. 
 

UZLY 2D TEXTURY  2D TEXTURE NODES (orig.335) 

Toto jsou uzly barvy obsaţené v místnosti materiálu Material room. Pokud není stanoveno jinak, 
seznam atributŧ pro kaţdý uzel je vyjmenován odshoru dolŧ: 
 

OBRAZOVÁ MAPA  IMAGE MAP (orig.335) 

Uzel Image Map umoţņuje specifikovat obrázek, který bude pouţit jako mapa (texture, reflection, 
transparency, bump, displacement, atd.). Jakýkoliv obrázek mŧţete pouţít jako mapu. Pokud nicméně 
budete chtít pouţít mapu určenou pro specifickou figuru/rekvizitu, musíte pouţít obrázek, který byl 
vytvořen za tímto účelem. Prosím navštivte Poser 7 Tutorial Manual: “About Maps & Templates” pro 
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obecný popis map a Poser 7 Tutorial Manual: “Creating & Using 
Texture Maps” pro stručný popis tvorby map. Tento uzel 
obsahuje následující atributy: 

 POZNÁMKA 
NĚKTERÉ STARŠÍ SOUBORY POSERU OBSAHUJÍ BUMP 
MAPY VYTVOŘENÉ ZA POUŢITÍ VLASTNÍHO 
SOUBOROVÉHO FORMÁTU .BUM. MŦŢETE NAČÍST .BUM 
SOUBORY DO UZLŦ IMAGE MAP A POUŢÍT JE S POSER 4 
RENDERING ENGINEM. POKUD CHCETE TOTO PROVÉST, 
BUDETE MUSET AKTIVOVAT FUNKCI IGNORE SHADER 
TREES V DIALOGOVÉM OKNĚ RENDER SETTINGS. 

o Image Source: Zobrazuje aktuálně načtený obrázek. Kliknutím 
na atribut Image Source dojde k otevření dialogu Texture 
Manager. Pro načtení obrazové mapy buď zvolte cestu 
k souboru z rozbalovacího seznamu, nebo klikněte na tlačítko 
Browse pro otevření standardního Open dialogu a vyberte si 

obrázek, který chcete načíst. Náhled 
Vámi vybraného obrázku bude 
zobrazen v okně náhledu. Klikněte na 
OK pro potvrzení Vaší volby, nebo na 
Cancel pro zrušení volby. 

o U Scale: Atribut U_Scale nastavuje 
faktor měřítka U pro aplikaci mapy 
textury při pouţití UV nebo VU 
mapování. Při pouţití metody projekce 
mapy (viz dále), toto je jeden ze dvou 
atributŧ pouţitých pro definici velikosti 
prostoru mapy textury, která bude 
projektována na povrch. 

o V Scale: Atribut V_Scale nastavuje faktor měřítka V pro aplikaci mapy textury při pouţití UV nebo 
VU mapování. Při pouţití metody projekce mapy (viz dále), toto je jeden ze dvou atributŧ pouţitých 
pro definici velikosti prostoru mapy textury, která bude projektována na povrch. 

o U Offset: Atribut U_Offset definuje pozici U první dlaţdice textury v UV prostoru. Při pouţití metody 
projekce mapy (viz dále), toto je jeden ze dvou atributŧ pouţitých pro definici pozice levého horního 
rohu projekční „obrazovky“ v jednotkách souřadnicové sítě. 

o V Offset: Atribut V_Offset definuje pozici V první dlaţdice textury v UV prostoru. Při pouţití metody 
projekce mapy (viz dále), toto je jeden ze dvou atributŧ pouţitých pro definici pozice levého horního 
rohu projekční „obrazovky“ v jednotkách souřadnicové sítě. 

o Texture Coordinates: Rozbalovací menu Texture_Coordinates nabízí následující volby: 

o UV: Poloţka UV se chová jako gumová tapeta, která se mŧţe přetáhnout přes povrch objektu; 
obrazový soubor se vytváří tak, aby odpovídal nastavené pozici povrchu objektu, vznik nějaké 
deformace při roztahování mŧţe vypadat nepřirozeně. Toto je nejvíce všestranná mapovací 
metoda. 

o VU: Poloţka VU je identická s UV mapováním s tím rozdílem, ţe obrazová mapa je otočena  
o 90 stupņŧ. 

o XY: Poloţka XY pracije jako projektor diapozitivŧ, jehoţ „obrazovka“ je projektována na XY 
rovinu, jejíţ velikost a pozice je stanovena pomocí parametrŧ U_Scale, V_Scale, U_Offset a 
V_Offset. Všechny povrchy, které nejsou stejně orientovány s projekční rovinou, budou během 
renderu texturu deformovat. 

o XZ: Poloţka je stejná jako výše, ale pouţívá rovinu XZ. 

o ZY: Poloţka je stejná jako výše, ale pouţívá rovinu ZY. 

o Image Mapped: Rozbalovací menu Image_Mapped nabízí následující volby: 
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o None: Barva pozadí bude pouţita pro všechny části objektu, které nejsou překryty mapou 
textury. 

o Alpha: Barva pozadí bude pouţita pro všechny části objektu, které nejsou překryty mapou 
textury. Barva pozadí bude dále smíchána s mapou textury zaloţenou na alpha kanálu mapy 
textury. 

o Clamped: Okrajové pixely mapy textury jsou kopírovány za účelem pokrytí všech částí objektu, 
které nepokrývá mapa textury. 

o Tile: Mapa textury bude pouţita dlaţdicově pro zajištění celého pokrytí objektu. Dlaţdicové 
pokrytí je ovládáno pouţitím atributŧ Mirror U a Mirror V, viz dále. 

o Background: Atribut Background specifikuje barvu podkladu. Kliknutím na barvu se otevře 
barevný vzorník Color Picker. 

o Global Coordinates: Označením políčka Global_Coordinates přimějete projektovanou mapu 
pouţít globální souřadnice místo souřadnic lokálních. 

o Mirror U: Aktivováním funkce Mirror_U pomŧţete skrýt spáry mezi pláty textury při pouţití 
dlaţdicového pokrytí textur. 

o Mirror V: Aktivováním funkce Mirror_V pomŧţete skrýt spáry mezi pláty textury při pouţití 
dlaţdicového pokrytí textur. 

o Texture Strength: Atribut Texture_Strength definuje intenzitu mapy textury, kde 1=100%. 

o Filtering: Atribut Filtering umoţņuje výběr jedné ze tří funkcí pro filtrování vybrané obrazové mapy. 
Tyto funkce jsou: None – ţádné filtrování textury; Fast – vysokorychlostí filtrování rextury; Quality 
– vysoce kvalitní filtrování textury. 

 

DLAŢDICE  TILE (orig.337) 

Uzel Tile je 2D textura, která simuluje dlaţdicové vzory. Tento uzel obsahuje následující atributy: 

o Tile 1: Atribut Tile_1 definuje barvu první dlaţdice. Kliknutím na barvu se otevře barevný vzorník 
Color Picker. 

o Tile Shape 1: Rozbalovací menu Tile_Shape_1 definuje tvar první dlaţdice. Moţné volby jsou: 

o Rectangle: Výběrem Rectangular vytvoříte pravoúhlé dlaţdice. 

o Ellipsoid: Výběrem Ellipsoid vytvoříte eliptické dlaţdice. 

o Tile 2: Atribut Tile_2 definuje barvu druhé dlaţdice. Kliknutím na barvu se otevře barevný vzorník 
Color Picker. 

o Tile Shape 2: Rozbalovací menu Tile_Shape_2 definuje tvar druhé dlaţdice. Toto menu má stejné 
volby jako menu Tile_Shape_1, popsané výše. 

o Mortar Color: Atribut Mortar_Color definuje barvu malty ve spáře. Kliknutím na barvu se otevře 
barevný vzorník Color Picker. 

o Tile Width: Atribut Tile_Width definuje šířku dlaţdice. 

o Tile Height: Atribut Tile_Height definuje výšku dlaţdice. 

o Mortar Thickness: Atribut Mortar_Thickness stanovuje šířku spáry mezi dlaţdicemi. 

o Turbulence: Atribut Turbulence definuje nízkofrekvenční nepravidelnosti tvaru dlaţdic. 

o Softness: Atribut Softness definuje jak jemně dlaţdice splývá do malty spáry. 

o Noise: Atribut Noise vysokofrekvenční nepravidelnosti tvaru dlaţdic. 

o U Offset: Atribut U_Offset definuje pozici U první dlaţdice textury v UV prostoru. Při pouţití metody 
projekce mapy, toto je jeden ze dvou atributŧ pouţitých pro definici pozice levého horního rohu 
projekční „obrazovky“ v jednotkách souřadnicové sítě. 

o V Offset: Atribut V_Offset definuje pozici V první dlaţdice textury v UV prostoru. Při pouţití metody 
projekce mapy, toto je jeden ze dvou atributŧ pouţitých pro definici pozice levého horního rohu 
projekční „obrazovky“ v jednotkách souřadnicové sítě. 
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o Noise_Type: Atribut Noise_Type umoţņuje výběr mezi typem šumu Original Perlin a mezi 
rozšířenou definicí šumu Improved. 

 

CIHLA  BRICK (orig.338) 

Uzel Brick simuluje vzory cihelných nebo kamenných zdí. Tento uzel obsahuje následující atributy: 

o Brick Color: Atribut Brick_Color definuje barvu cihly. Kliknutím na barvu se otevře barevný vzorník 
Color Picker. 

o Mortar Color: Atribut Mortar_Color definuje barvu malty. Kliknutím na barvu se otevře barevný 
vzorník Color Picker. 

o Brick Width: Atribut Brick_Width stanovuje horizontální rozměr cihel. 

o Brick Height: Atribut Brick_Height stanovuje vertikální rozměr cihel. 

o Mortar Width: Atribut Mortar_Width stanovuje šířku spar mezi cihlami. 

o Turbulence: Atribut Turbulence definuje nízkofrekvenční nepravidelnosti tvaru cihel. 

o Softness: Atribut Softness definuje jak jemně cihla splývá do malty spáry. 

o Noise: Atribut Noise vysokofrekvenční nepravidelnosti tvaru cihel. 

o U Offset: Atribut U_Offset definuje pozici U první dlaţdice textury v UV prostoru. Při pouţití metody 
projekce mapy, toto je jeden ze dvou atributŧ pouţitých pro definici pozice levého horního rohu 
projekční „obrazovky“ v jednotkách souřadnicové sítě. 

o V Offset: Atribut V_Offset definuje pozici V první dlaţdice textury v UV prostoru. Při pouţití metody 
projekce mapy, toto je jeden ze dvou atributŧ pouţitých pro definici pozice levého horního rohu 
projekční „obrazovky“ v jednotkách souřadnicové sítě. 

o Noise_Type: Atribut Noise_Type umoţņuje výběr mezi typem šumu Original Perlin a mezi 
rozšířenou definicí šumu Improved. 

 

TEXTILNÍ VAZBA  WEAVE (orig.339) 

Uzel Weave vytváří efekty textilní vazby. Tento uzel obsahuje následující atributy: 

o Color 1: Atribut Color_1 definuje první barvu tkaniva. Kliknutím na atribut se otevře barevný 
vzorník Color Picker. 

o Color 2: Atribut Color_2 definuje druhou barvu tkaniva. Kliknutím na atribut se otevře barevný 
vzorník Color Picker. 

o Base Color: Atribut Base_Color definuje podkladní barvu na pozadí struktury tkaniva. Kliknutím na 
atribut se otevře barevný vzorník Color Picker. 

o U Scale: Atribut U_Scale definuje velikost textilní vazby ve směru U. 

o V Scale: Atribut V_Scale definuje velikost textilní vazby ve směru V. 

o Height: Atribut Height definuje výšku textilní vazby. 

o Bias: Atribut Bias nastavuje šikmý směr vazby. 

o Gain: Atribut Gain nastavuje hrubost vazby. 
 

FILM  MOVIE (orig.339) 

Uzel Movie umoţņuje přidání animací do materiálŧ. Tento uzel obsahuje následující atributy: 

o Video Source: Atribut Video_Source specifikuje cestu ke sloţce obsahující vybranou animaci. 

o U Scale: Atribut U_Scale definuje velikost animace ve směru U. 

o V Scale: Atribut V_Scale definuje velikost animace ve směru V. 

o U Offset: Atribut U_Offset definuje pozici U první dlaţdice textury v UV prostoru. Při pouţití metody 
projekce mapy, toto je jeden ze dvou atributŧ pouţitých pro definici pozice levého horního rohu 
projekční „obrazovky“ v jednotkách souřadnicové sítě. 
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o V Offset: Atribut V_Offset definuje pozici V první dlaţdice textury v UV prostoru. Při pouţití metody 
projekce mapy, toto je jeden ze dvou atributŧ pouţitých pro definici pozice levého horního rohu 
projekční „obrazovky“ v jednotkách souřadnicové sítě. 

o Texture Coordinates: Rozbalovací menu Texture_Coordinates nabízí následující volby: 

o UV: Poloţka UV se chová jako gumová tapeta, která se mŧţe přetáhnout přes povrch objektu; 
obrazový soubor se vytváří tak, aby odpovídal nastavené pozici povrchu objektu, vznik nějaké 
deformace při roztahování mŧţe vypadat nepřirozeně. Toto je nejvíce všestranná mapovací 
metoda. 

o VU: Poloţka VU je identická s UV mapováním s tím rozdílem, ţe obrazová mapa je otočena  
o 90 stupņŧ. 

o XY: Poloţka XY pracije jako projektor diapozitivŧ, jehoţ „obrazovka“ je projektována na XY 
rovinu, jejíţ velikost a pozice je stanovena pomocí parametrŧ U_Scale, V_Scale, U_Offset  
a V_Offset. Všechny povrchy, které nejsou stejně orientovány s projekční rovinou, budou 
během renderu texturu deformovat. 

o XZ: Poloţka je stejná jako výše, ale pouţívá rovinu XZ. 

o ZY: Poloţka je stejná jako výše, ale pouţívá rovinu ZY. 

o Image Mapped: Rozbalovací menu Image_Mapped nabízí následující volby: 

o None: Barva pozadí bude pouţita pro všechny části objektu, které nejsou překryty mapou 
textury. 

o Alpha: Barva pozadí bude pouţita pro všechny části objektu, které nejsou překryty mapou 
textury. Barva pozadí bude dále smíchána s mapou textury zaloţenou na alpha kanálu mapy 
textury. 

o Clamped: Okrajové pixely mapy textury jsou kopírovány za účelem pokrytí všech částí objektu, 
které nepokrývá mapa textury. 

o Tile: Mapa textury bude pouţita dlaţdicově pro zajištění celého pokrytí objektu. Dlaţdicové 
pokrytí je ovládáno pouţitím atributŧ Mirror U a Mirror V, viz dále. 

o Background: Atribut Background specifikuje barvu podkladu. Kliknutím na barvu se otevře 
barevný vzorník Color Picker. 

o Global Coordinates: Označením políčka Global_Coordinates přimějete projektovanou mapu 
pouţít globální souřadnice místo souřadnic lokálních. 

o Mirror U: Aktivováním funkce Mirror_U pomŧţete skrýt spáry mezi pláty textury při pouţití 
dlaţdicového pokrytí textur. 

o Mirror V: Aktivováním funkce Mirror_V pomŧţete skrýt spáry mezi pláty textury při pouţití 
dlaţdicového pokrytí textur. 

o Texture Strength: Atribut Texture_Strength definuje intenzitu mapy textury, kde 1=100%. 

o Frame Number: Atribut Frame Number funguje primárně jako vstup pro další uzly (jako jsou 
matematické a proměnné uzly) a pomocí tohoto uzlu je moţné ovládat časování animace. 

o Loop Movie: Označením políčka Loop Movie se aktivuje cyklické opakování animace. 
 

2D VLNY  WAVE2D (orig.341) 

Uzel Wave2D implementuje dvou-dimenzionální sin / cos trigonometrickou funkci, která ve výsledku 
vytvoří efekt dvou-dimenzionální vlny. 
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Část 5 – RENDERING 

RENDERING (orig.343) 

Kapitola 35: Dialogové okno nastavení renderu 
THE RENDER SETTINGS DIALOG (orig.344) 

Pro otevření dialogového okna nastavení renderu Render Settings pouţijte volbu Render>Render 
Settings. Dialogové okno vypadá následovně: 

 

Všimněte si , ţe  poloţky Render Settings a Movie Settings  jsou vytvořeny jako záloţky uvnitř 
jednoho dialogového okna, coţ umoţņuje snadné přepínání mezi nimi. Záloţka Render Settings 
obsahuje následující poloţky: 

 

RENDEROVACÍ NÁSTROJE   RENDER ENGINES (orig.344) 

Poser 7 umoţņuje renderovat stacionární a animované scény pomocí čtyř separátních renderovacích 
nástrojŧ. 

Nástroj, který si přejete pouţít, mŧţete vybrat kliknutím na odpovídající záloţku v dialogovém okně 
nastavení renderu Render Settings. Dostupné renderovací nástroje Poseru 7 jsou: 

o Renderovací nástroj FireFly: Tento renderovací nástroj podporuje vyuţití procesních shaderŧ, které 
obsahují mnohá nastavení, umoţņující přesnou definici poţadovaného vzhledu renderovaných 
obrazŧ/animací a jsou schopné tvorby opravdu dech beroucích výsledkŧ. Prosím navštivte kapitolu 
36: “Použití renderovacího nástroje FireFly” na straně 249 pro informace o pouţití FireFly 
rendereru. 
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o Renderovací nástroj Poseru 4: Pokud pracujete se scénami, které byly vytvořeny za pouţití 
předchozích verzí Poseru před Poserem 5, budete mít moţná potíţe s obnovením efektŧ renderu 
při pouţití renderovacího nástroje FireFly, zpŧsobenými odlišnostmi systému materiálu. Pro tyto 
případy mŧţete lépe uspět s pouţitím renderovacího nástroje Poseru 4. Prosím navštivte kapitolu 
37: “ Použití renderovacího nástroje Poseru 4” na straně 257 pro informace o pouţití rendereru 
Poseru 4. 

o Sketch Designer: Designér skic Sketch Designer simuluje mnoţství výtvarných technik za účelem 
renderu  scény ve formě malby nebo kresby. Prosím navštivte kapitolu 38: “Renderovací nástroj 
Designér skic ” na straně 259 pro informace o pouţití rendereru Sketch Designer. 

o Preview: Pokud si přejete renderovat kvalitní a ve vysokém rozlišení pohled na scénu ve stylu 
síťového modelu nebo siluety (případně jiného stylu zobrazení), zvolte si prosím renderovací 
nástroj náhled Preview. 

Pro nastavení vlastností okna náhledu scény mŧţete také zvolit záloţku Náhled Preview. 
 

ZÁLOŢKA FIREFLY: NASTAVENÍ KVALITY 
FIREFLY TAB: QUALITY SETTINGS (orig.345) 

Záloţka FireFly umoţņuje výběr mezi automatickým, nebo manuálním nastavením předvoleb 
renderu. Pro zobrazení odpovídajících ovladačŧ nastavení renderu pouţijte tlačítko předvolby Auto 
Settings, nebo Manual Settings. Všimněte si, ţe Auto a Manual nastavení jsou uloţena nezávisle, 
takţe změny provedené v jedné sestavě ovladačŧ nemají vliv na nastaveni ve druhé sestavě 
ovladačŧ. 

 
 
AUTOMATICKÉ  NASTAVENÍ  AUTO SETTINGS (orig.346) 

Kvalita Draft proti Final  DRAFT VS. FINAL QUALITY 

Sestava ovladačŧ automatického nastavení kvality Auto Settings obsahuje posuvník Render 
Quality, který pracuje v rozsahu od kvality konceptu Draft Quality (rychlejší render) po kvalitu finální 
Final Quality (pomalejší render). Pohybem posuvníku se automaticky mění hodnoty specifických 
parametrŧ nastavení renderu tak, jak je zobrazeno na grafu pod posuvníkem. Ta nastavení renderu, 
jako jsou Pixel Samples nebo Raytrace bounces, jejichţ účinek se mění v závislosti na 
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specifikované hodnotě, jsou zobrazena s pouţitím postupně zastíněného pruhu, kde světlejší barva 
reprezentuje menší hodnoty a tmavší barva hodnoty vyšší. Nastavení renderu jako jsou Cast 
Shadows a Raytracing jsou v renderu buď aktivována nebo neaktivní, takţe jejich nastavení je 
indikováno pouţitím pruhu se stejnoměrnou intenzitou barvy, který začíná v bodě aktivování poloţky 
nastavení. 

U volby kvality Draft Render nastavení renderu poskytuje rychlejší rendering scény v niţší kvalitě. 
Tuto volbu pouţívejte v případech, kdy potřebujete vytvořit render pro získání představy, jak bude 
scéna vypadat po dokončení. U volby kvality Final Render nastavení renderu poskytuje vysoce 
kvalitní rendery scény, které však vyţadují delší dobu renderingu. Tuto volbu pouţívejte pro vytvoření 
konečného výstupu. 
 

RUČNÍ NASTAVENÍ   MANUAL SETTINGS (orig.347) 

Volba ručního nastavení Manual Settings umoţņuje manuální nastavení specifických hodnot rŧzných 
předvoleb renderu, které jsou obsaţeny v renderovacím nástroji FireFly. Prosím navštivte kapitolu 36: 
“ Použití renderovacího nástroje FireFly” na straně 249 pro informace o nastavení FireFly rendereru. 
 

ZÁLOŢKA FIREFLY: NASTAVENÍ PŘEDVOLEB     
FIREFLY TAB: OPTIONS SETTINGS (orig.347) 

Renderovací nástroj FireFly nabízí rŧzné předvolby, které jsou pouţitelné bez ohledu na pouţití 
automatické Auto nebo ruční Manual metody nastavení kvality renderu. Mnohé z těchto předvoleb 
fungují jako efekty, které mŧţete přidat do Vašich renderŧ. Prosím navštivte kapitolu 36: “ Použití 
renderovacího nástroje FireFly” na straně 249 pro více informací o předvolbách FireFly rendereru. 
 

 POZNÁMKA 
PRO INFORMACI, JAKÝM ZPŦSOBEM NASTAVÍTE ROZLIŠENÍ A VELIKOST VAŠICH RENDERŦ, 
navštivte prosím téma “Rozměry renderu” na straně 47. 
 

ULOŢENÍ A NAČTENÍ NASTAVENÍ   SAVING AND LOADING PRESETS (orig.347) 

Nastavení předvoleb FireFly mŧţete uloţit a načíst, coţ umoţņují oba zpŧsoby nastavení kvality Auto 
a Manual, stejně jako nastavení poloţky FireFly. Jednoduše klikněte na odpovídající tlačítko  
u spodního okraje záloţky FireFly pro vyvolání funkce, kterou si přejete pouţít. Tlačítka Load Preset 
a Delete Preset zobrazí rozbalovací menu se seznamem předvoleb, které byly dodány s Vaší kopií 
Poseru 7, stejně jako všech dalších předvoleb, které mŧţete mít uloţeny. Všimněte si, ţe pokud 
provedete změny u uloţené předvolby, tyto změny nebudou uloţeny do té doby, neţ pouţijete tlačítko 
Save Preset pro jejich zaznamenání. Tlačítko Save Preset umoţņuje uloţení aktuálního nastavení 
FireFly rendereru pod názvem, který si mŧţete zvolit. Tlačítko Restore Defaults obnoví nastavení 
všech předvoleb FireFly rendereru do jejich základních hodnot. 
 

ZÁLOŢKA POSER 4: NASTAVENÍ KVALITY  
POSER 4 TAB: QUALITY SETTINGS (orig.347) 

Pro zachování výsledkŧ renderŧ, které byly generovány za pouţití předchozích verzí Poseru před 
verzí Poser 5, mŧţete pouţít renderovací nástroj Poser 4. Nastavení kvality nástroje Poser 4 je 
detailně popsáno v kapitole 37: “Použití renderovacího nástroje Poseru 4” na straně 257. 
 

ZÁLOŢKA POSER 4: NASTAVENÍ PŘEDVOLEB     
POSER 4 TAB: OPTIONS SETTINGS (orig.347) 

o Render Over: Tato předvolba specifikuje pozadí, které bude pouţito při renderu obrázkŧ. Označte 
odpovídající označovací tlačítko u předvolby, kterou si přejete vybrat. 

o Background Color: Výběrem předvolby Background Color bude obrázek/animace renderován 
přes nastavený barevný odstín podkladu pracovního okna Document. Prosím navštivte téma 
“Barvy” na straně 46 pro informace o změně barevného odstínu pracovního okna Document. 

o Black: Výběrem předvolby Black bude obrázek/animace renderován přes celoplošně černé pozadí. 
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o Background Picture: Výběrem předvolby Background Picture bude obrázek/animace renderován 
přes podkladní obrázek Vaší scény. Prosím navštivte téma “Import obrázků na pozadí” na straně 
186 pro informace u zpŧsobu importu obrázku na pozadí scény. 

o Current Background Shader: Výběrem předvolby Current Background Shader bude 
obrázek/animace renderován přes specifikovaný shader podkladu. Prosím navštivte téma 
“Kořenový uzel pozadí” na straně 222 pro informace o pouţití shaderŧ podkladu. 

 

ZÁLOŢKA SKICA   SKETCH TAB (orig.348) 

 

Záloţka Skica Sketch poskytuje náhledy miniatur deseti standardních předvolených stylŧ skicy 
Sketch. Pro výběr poţadované předvolby jednoduše klikněte na odpovídající miniaturu náhledu  
a následně klikněte na tlačítko Render Now pro vyrenderování obrázku za pouţití zvoleného 
nastavení. Alternativně mŧţete pouţít rozbalovací menu Sketch Preset pro výběr ze seznamu 
standardních předvolených stylŧ skicy a ostatních uţivatelem definovaných stylŧ, které byly dříve 
uloţeny pomocí designéru skic Sketch Designer. Pro jednoduchý přístup do designéru skic Sketch 
Designer pro jemné doladění nastavení stylu skicy, nebo pro vytvoření nového stylu, jednoduše 
klikněte na tlačítko Sketch Designer. Pro více informací o pouţití renderovacího nástroje Sketch 
Designer, navštivte prosím kapitolu 38: “ Renderovací nástroj Designér skic” na straně 259. 
 

ZÁLOŢKA NÁHLED   PREVIEW TAB (orig.349) 

Tato záloţka umoţņuje přizpŧsobení zobrazení náhledu scény v pracovním okně Document, za 
pouţití následujících předvoleb: 
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NASTAVENÍ NÁSTROJE ZOBRAZENÍ   DISPLAY ENGINE SETTINGS (orig.349) 

Vyberte odpovídající tlačítko předvolby pro pouţití buď softwarového renderingu náhledu SreeD, nebo 
OpenGL pro pouţití hardwarového renderingu zobrazení náhledu scény. Prosím navštivte téma 
“OpenGL hardwarová akcelerace” na straně 43 pro více informací o volbě OpenGL hardwarového 
renderingu v Poseru 7. Pokud zvolíte OpenGL, poloţka Accumulation Buffer nabízí hardwarovou 
akceleraci pro řadu funkcí v závislosti na slučitelnosti obrazŧ náhledu scény. Doporučujeme pouţití 
této hardwarové akcelerace tehdy, pokud ji Vaše grafická karta podporuje. Jestliţe nejste spokojeni 
s výsledkem renderu náhledu scény při pouţití hardwarové akcelerace, mŧţete si vybrat volbu 
softwarové akcelerace. 

Poser 7 podporuje pro zobrazení náhledu scény rozlišení textur aţ do 4096 x 4096. Rozlišení, které si 
přejete pouţít pro zobrazení náhledu scény v pracovním okně Document, mŧţete nastavit pomocí 
posuvníku Preview Texture Resolution. Tento posuvník nabízí rozsah rozlišení od 128 x 128 pixelŧ 
do 4096 x 4096 pixelŧ. 

 POZNÁMKA 
MAXIMÁLNÍ ROZLIŠENÍ TEXTUR NÁHLEDU SCÉNY, DOSTUPNÉ POMOCÍ POSUVNÍKU, MŦŢE 
BÝT NASTAVENO POUZE S OHLEDEM NA MAXIMÁLNÍ PODPOROVANÉ ROZLIŠENÍ DLE 
POUŢITÉHO HARDWARU. 
 
NÁHLED PROCESNÍCH SHADERŮ   PROCEDURAL SHADER PREVIEW (orig.350) 

Pokud pouţijete OpenGL hardwarový rendering, mŧţete si zvolit pro náhled scény také zobrazení 
efektŧ procesních shaderŧ, které máte v aktuální scéně obsaţené v případě, ţe to Váš systém 
podporuje. Jakmile vyberete OpenGL, Poser 7 automaticky vyzkouší, zda Váš systém bude 
podporovat výpočet efektŧ procesních shaderŧ v reálném čase. Následně Poser 7 uvnitř záloţky 
Preview zobrazí zprávu, zda Váš systém tuto funkci podporuje, nebo ne. Pokud nepouţíváte 
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OpenGL, Poser 7 zobrazí zprávu, ţe pouţití této funkce pro Váš systém nebylo ověřeno; jednoduše 
přepněte do OpenGL, abyste Poser 7 přiměli podporu otestovat. Náhled procesních shaderŧ je 
dostupný pro scény, které pouţívají maximálně pět světelných zdrojŧ. 

Náhled procesních shaderŧ mŧţete aktivovat označením políčka Enable Hardware Shading,  
a naopak. V základním nastavení je tato funkce deaktivována. Dodatečně mŧţete aktivovat 
optimalizaci shaderŧ označením políčka Optimize Simple Materials, a naopak. Pokud je 
optimalizace shaderŧ aktivována, shadery nebudou generovány u jednoduchých materiálŧ. 
Optimalizace je v základním nastavení aktivována. 

Výkon funkce náhledu procesních shaderŧ bude závislý na hardwaru Vašeho systému. Komplexní 
scény s velkým počtem shaderŧ mohou zpŧsobit pomalé zobrazení náhledu; pokud tedy pracujete 
s velkým počtem shaderŧ, tuto funkci raději deaktivujte. 

 POZNÁMKA 
FUNKCE NÁHLEDU PROCESNÍCH SHADERŦ NEPODPORUJE BUMP NEBO DISPLACEMENT 
MAPY. NAVÍC NEJSOU PODPOROVÁNY URČITÉ UZLY, JAKO JE AMBIENT OCCLUSION  
A DALŠÍ EFEKTY RAYTRACINGU, STEJNĚ JAKO NĚKTERÉ HODNOTY UZLŦ. 

 
ZOBRAZENÍ PRŮHLEDNOSTI   TRANSPARENCY DISPLAY (orig.350) 

Zobrazení prŧhlednosti Transparency Display mŧţete nastavit na aktuální hodnoty prŧhlednosti, 
nebo mŧţete specifikovat určitý limit prŧhlednosti, kliknutím na odpovídající tlačítko předvolby. 
Výběrem tlačítka Actual budou všechny plně prŧhledné povrchy v náhledu scény neviditelné. Pokud 
si přejete nějakým zpŧsobem indikovat tyto neviditelné povrchy v náhledu scény, mŧţete specifikovat 
určitý limit prŧhlednosti volbou tlačítka Limit to a zadáním procentuální hodnoty maximální 
prŧhlednosti. 

Ve finálním renderu scény budou transparentní poloţky vţdy renderovány za pouţití jejich vlastního 
nastavení prŧhlednosti. 
 

VOLBA STYLU   STYLE OPTIONS (orig.351) 

Pro zobrazení náhledu scény mŧţete také specifikovat několik voleb stylu Style Options, a to 
zadáním poţadovaných hodnot do odpovídajících políček. Tyto volby obsahují následující: 

o Outline Width: Poloţka Outline Width umoţņuje specifikovat, jak tlustá čára bude pouţita ve stylu 
zobrazení obrysu Outline. 

o Wireframe Line Width: Poloţka Wireframe Line Width umoţņuje specifikovat, jak tlustá čára bude 
pouţita ve stylu zobrazení síťového modelu Wireframe. 

o Cartoon Edge Line Width: Poloţka Cartoon Edge Line Width umoţņuje specifikovat, jak tlustá 
čára bude pouţita ve stylu zobrazení Toon Outline, který lze aktivovat pomocí nastavení renderu 
FireFly. 

Klikněte na tlačítko OK pro aplikaci Vašeho nastavení. 
 

NASTAVENÍ ANIMACE   MOVIE SETTINGS (orig.351) 

Okno pro nastavení animace mŧţete zpřístupnit přepnutím záloţky Movie Settings, která se nachází 
vedle záloţky Render Settings. Prosím navštivte kapitolu 39: “Rendering animací” na straně 262 pro 
více informací o nastavení animace. 
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Kapitola 36: Pouţití renderovacího nástroje FireFly    

USING THE FIREFLY RENDER ENGINE (orig.352) 
 
Tato kapitola popisuje technologické funkce a nastavení renderu FireFly: 
 

TECHNOLOGIE FIREFLY    FIREFLY TECHNOLOGY (orig.352) 

Renderovací nástroj FireFly obsahuje zástup výkonných technologií, z nichţ všechny pomáhají 
vytvářet krásné, realistické rendery v krátkém čase. Ty aspekty FireFly, které jsou konfigurovatelné, 
jsou popsány v další části. Následující funkce nejsou konfigurovatelné, ale jsou obsaţeny pro zlepšení 
výkonu a výsledkŧ FireFly: 

o High Dynamic Range (HDR) Image Support for IBL: Poser 7 podporuje High Dynamic Range 
(HDR) a Low Dynamic Range (LDR) obrazy pro pouţití u osvětlení Image Based Lighting (IBL). 
HDR obrazy jsou srovnatelné s analogovým fotografickým filmem s ohledem na mnoţství informací 
uloţených v obrazu. LDR světelné sondy se dají relativně snadno vytvořit za pouţití zrcadlové 
koule pro zachycení světelných informací v daném prostředí. Nicméně mnoţství zachycených 
informací je mnohem menší, neţ u HDR obrazu a proto je kvalita světelné sondy niţší. HDR 
světelná sonda má významně vyšší kvalitu, ale je mnohem sloţitější na výrobu. Pro více informací 
o osvětlení zaloţeném na obrazu Image Based Lighting a o světelných sondách, navštivte téma 
“Rozptýlená světla založená na obrazu (IBL)” na straně 62. 

o Occlusion Culling: FireFly během renderu ignoruje neviditelné prvky scény z dŧvodu zvýšení 
výkonu renderu. Occlusion culling stanovuje, které prvky scény mají viditelné dopady na scénu,  
a které prvky mohou být potlačeny (ignorovány). FireFly  spustí výpočet procesu odstraņování pro 
objekt a jeho stín v prŧběhu renderu aby zjistil, jestli kaţdý prvek scény a) je viditelný uvnitř scény 
a b) vrhá nějaké viditelné stíny. Occlusion culling nemŧţe být pouţit ve spojení s raytracingem, 
protoţe výpočet raytracingu zahrnuje všechny prvky scény bez ohledu na jejich viditelnost. 

 POZNÁMKA 
VIDITELNOST NEBO NEVIDITELNOST PRVKU SCÉNY S OHLEDEM NA OCCLUSION CULLING 
NENÍ TOTÉŢ JAKO NASTAVENÍ VIDITELNOSTI V PALETĚ VLASTNOSTÍ PROPERTIES TOHOTO 
PRVKU. POKUD JE NEOZNAČENA VLASTNOST VIDITELNOST VISIBILITY V PALETĚ 
VLASTNOSTÍ, NASTAVENÍ AKTUÁLNĚ SKRYJE OBJEKT VE SCÉNĚ, TAKŢE  OBJEKT NEBUDE 
ZAHRNUT DO VÝPOČTU ŢÁDNÉHO RENDERU, BEZ OHLEDU NA JEHO UMÍSTĚNÍ VE SCÉNĚ. 
VÝPOČET OCCLUSION CULLING JE APLIKOVÁN NA POLOŢKY, KTERÉ JSOU UVNITŘ SCÉNY 
OZNAČENY JAKO VIDITELNÉ, ALE JSOU VŦČI POHLEDU KAMERY SKRYTY JINÝMI OBJEKTY 
SCÉNY. 

o Texture Filtering: Texture filtering zlepšuje vzhled povrchŧ renderovaných při pouţití 2D 
obrazových map, coţ vytváří kvalitnější obrázky a zabraņuje schodovitosti hran a výskytu jiných 
artefaktŧ. Dlaţdicové ukládání textur Tiled Texture Loading pouţívá texture filtering pro zkrácení 
doby procesu. Texture filtering mŧţe být konfigurován pro individuální textury pomocí uzlu Image 
Map v místnosti materiálu Material room (viz téma “Obrazová mapa” na straně 238 pro více 
informací). 

 
Obrázek 1: Bez texture filteringu                                Obrázek 2: S texture filteringem 
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o Tiled Texture Loading: Během prvního renderu pomocí nástroje FireFly Poser 7 vygeneruje 
dočasné soubory z textur uvnitř scény na hard disk a následně k nim selektivně přistupuje 
v prŧběhu renderu. Poser 7 také vytvoří schránku v operační paměti, která obsahuje naposledy 
pouţité dlaţdice textur. Tiled texture loading nachází vyuţití i v jiných funkcích, jako je texture 
filtering za účelem sníţení doby procesu. V závislosti na systémových zdrojích mŧţete zvýšit 
velikost schránky v operační paměti pro omezení počtu poţadovaných přístupŧ na disk při načítání 
textur, protoţe tato funkce mŧţe pouţít velkou část diskového prostoru (potenciálně více neţ 1 
GB). Pro informace o zvýšení velikosti schránky v operační paměti navštivte téma “Předvolby 
renderu” na straně 20. 

o Multi-threaded Rendering: Funkce Multi-threaded Rendering vyuţívá výhody vyššího 
výpočetního výkonu víceprocesorových systému nebo systémŧ s vícejádrovými procesory, které 
jsou nyní k dispozici. Pouţitím této funkce mŧţete renderovací nástroj FireFly konfigurovat pro 
současné spuštění aţ čtyř výpočetních procesŧ, které ve výsledku u většiny renderŧ zkracují dobu 
jejich výpočtu.  Počet současně spuštěných procesŧ (threadŧ) mŧţete specifikovat v dialogovém 
okně General Preferences (viz téma “Předvolby renderu” na straně 20 pro více informací). 

o Rendering in a Separate Process: V základním nastavení Poser 7 spouští aplikaci a FireFly 
renderovací nástroj uvnitř jednoho procesu v CPU (procesoru). To znamená, ţe jak aplikace, tak 
renderovací nástroj sdílí maximum přiřaditelné paměti pro jeden proces. Rendering v separátním 
procesu znamená, ţe samotný renderovací nástroj má přístup ke stejné maximální přiřaditelné 
paměti pro jeden proces, coţ mŧţe přinášet významné výkonové výhody u velmi komplexních scén 
v závislosti na konfiguraci paměti konkrétního systému. Mimo to, rendering v separátním procesu 
poskytuje vyšší stabilitu kvŧli rozdělování úkolŧ na oddíly, coţ umoţņuje systému efektivněji 
pracovat s pamětí. Nicméně rendering v separátním procesu vyţaduje větší zdroje předem pro 
nastavení renderu. Proto, pokud vytváříte primárně jen rendery části scény nebo jednoduché malé 
rendery, doporučujeme tuto funkci nevyuţívat, protoţe předchozí příprava negativně ovlivní 
výkonový přínos této funkce. Naopak u velkých komplexních scén přináší rendering v separátním 
procesu rozhodně významné výhody. Tuto funkci mŧţete aktivovat či deaktivovat v dialogovém 
okně General Preferences (viz téma “Předvolby renderu” na straně 20 pro více informací). 

 

NASTAVENÍ KVALITY FIREFLY   FIREFLY QUALITY SETTINGS (orig.354) 

AUTOMATICKÉ  NASTAVENÍ   AUTO SETTINGS (orig.354) 

Pro popis automatického nastavení kvality renderovacího nástroje FireFly, navštivte prosím téma 
“Záložka Firefly: Nastavení kvality” na straně 244. 
 

MANUÁLNÍ NASTAVENÍ   MANUAL SETTINGS (orig.355) 

o Acquire From Auto: Kliknutím na tlačítko Acquire From Auto budou kopírovány parametry 
aktuálního automatického nastavení kvality Automatic Quality  do individuálních parametrŧ 
manuálního nastavení kvality Manual Quality. 

o Cast Shadows: Označením políčka Cast Shadows určíte renderovacímu nástroji, aby v rámci 
renderingu počítal také stíny. Individuální nastavení figury má niţší prioritu neţ nastavení základní. 
Například, pokud je figura ve scéně nastavena tak, aby nevrhala stíny, tak vrhat stíny nebude  
i kdyţ je poloţka Cast Shadows aktivována pro všechny objekty scény. Nicméně, pokud je políčko 
Cast Shadows neoznačeno, nebudou generovány ţádné stíny bez ohledu na individuální 
nastavení objektu. Aktivování této poloţky přidá realismu do Vašich renderŧ, ale prodlouţí dobu 
dokončení renderu. 

o Raytracing: Označením políčka Raytracing aktivujeme raytracing, a naopak. Aktivování 
raytracingu značně vylepšuje render, speciálně u zakřivených povrchŧ, stínŧ, odleskŧ a lomu 
světla. Nicméně také značně prodluţuje dobu renderingu. Raytracing emituje paprsky od kamery 
skrz kaţdý viditelný pixel okna renderu, také nazývaném „rovina pohledu“. Kaţdému pixelu je pak 
přiřazena barevná hodnota, která se vrací po prŧchodu emitovaného paprsku skrze něj, závisející 
na prŧsečíku paprsku s objektem scény. Pokud paprsek nemŧţe protnout ţádný objekt, barva 
pixelu bude nastavena podle barvy podkladu.  Pro zjištění, zda se prŧsečík nachází ve stínu, je 
emitován sekundární paprsek od prŧsečíku směrem ke kaţdému světelnému zdroji. Pokud 
sekundární paprsek (stínový paprsek) následně protíná objekt, je to dŧkazem toho, ţe se originální 
prŧsečík nachází ve stínu tohoto objektu. U odleskŧ, kdyţ sekundární paprsek protíná reflexní 
povrch, je zpětně vyslán nový paprsek s počátkem v bodě prŧsečíku a barevný odstín vracejícího 
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se paprsku je smíchaný s odstínem originální barvy prŧsečíku. Tento proces se nazývá „rekurzivní 
raytracing“, protoţe  odraţené paprsky mohou zplodit více odraţených paprskŧ, pokud vícekrát 
protínají reflexní objekty. Obrázky dále ukazují příklad raytracingu. Počet odrazŧ (bounces) mŧţete 
nastavit pomocí poloţky Raytrace bounces (viz dále). 

 

o Raytrace Bounces: Pokud je raytracing aktivován, poloţka Raytrace bounces specifikuje mnoţství 
odrazŧ “bounces” nebo rekurzí, které renderovací nástroj pouţije při vyuţití raytracingu. Počet 
odrazŧ mŧţete vybrat na základě počtu reflexních nebo lomivých povrchŧ, které se ve scéně 
vyskytují. Vyšší počet mŧţe přidat na realismu, pokud scéna umoţņuje sloţité výpočty raytracingu. 
Nicméně vysoký počet odrazŧ prodluţuje dobu renderu a u jednoduchých scénářŧ pak zvýšený 
počet odrazŧ zbytečně plýtvá výpočetním časem. 

o Irradiance Caching: Irradiance (expozice) definuje mnoţství světla měřitelného v daném bodu. 
Některé světelné uzly, jako je Ambient Occlusion, pouţívají raytracing pro stanovení hodnoty 
expozice pro kaţdý bod scény. Vyrovnávací paměť expozice Irradiance caching ukládá předchozí 
výpočty expozice a tato data pouţívá pro odhad hodnoty aktuální expozice. Tento proces urychluje 
výpočet Ambient Occlusion, zvláště tehdy mŧţe vyrovnávací paměť expozice poskytovat 
významné úspory času, kdyţ jsou nastaveny vysoké hodnoty kvality s poţadavkem na zamezení 
viditelných artefaktŧ. Kvalita vyrovnávací paměti expozice Irradiance Caching mŧţe být 
nastavena pomocí posuvníku. Nízké nastavení znamená niţší kvalitu: FireFly pouţívá více odhadŧ 
při výpočtu aktuální expozice, z čehoţ vyplývá zkrácení procesního času, avšak s niţší přesností. 
Vyšší nastavení odpovídá vyšší kvalitě: FireFly provádí více nových výpočtŧ aktuální hodnoty 
expozice, z čehoţ vyplývá prodlouţení procesního času, avšak s vyšší přesností. 
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Obrázek 1: Jeden odraz Raytrace Bounce                                    Obrázek 2: Tři odrazy Raytrace Bounces  

o Minimum Shading Rate: Hodnota Minimum Shading Rate stanovuje úroveņ, do které budou 
polygony objektu děleny na mikropolygony. Například hodnota Shading Rate 1 znamená, ţe 
polygony budou děleny na mikropolygony tak, ţe kaţdý zabere přibliţně jeden pixel renderovaného 
obrazu a hodnota 4 znamená, ţe kaţdý mikropolygon překryje přibliţně 4 pixely renderovaného 
obrazu. Hodnoty menší neţ 1 (například 0.2) vytvoří mikropolygony velikosti menší neţ jeden pixel. 
Mikropolygony uvnitř daného polygonu jsou identické velikosti, tvaru a plochy, pokud je to moţné. 
Během renderu renderovací nástroj rozdělí kaţdý polygon, vytvoří vzorek mikropolygonu a přiřadí 
zprŧměrovanou barvu mikropolygonŧ pixelu, který je renderován. Poţadovaný poměr zadejte do 
políčka Minimum Shading Rate, nebo nastavte posuvník na poţadovanou hodnotu. Zmenšením 
této hodnoty vytvoříte dokonalejší rendery, ale prodlouţíte dobu renderu. Uvedenou hodnotu 
mŧţete také nastavit na bázi objektu, pouţitím odpovídající palety vlastností objektu Properties. 
Nastavení této hodnoty v dialogovém okně Render Settings je aplikováno na celou scénu  
a potlačuje všechna nastavení na bázi objektu, která jsou niţší, neţ tato globální hodnota. Pokud 
má objekt nastaven vyšší poměr Shading Rate, Poser 7 během renderu tohoto objektu pouţije 
jeho hodnotu. 

 
Obrázek 1: Vysoká hodnota Minimum Shading Rate                    Obrázek 2: Nízká hodnota Minimum Shading Rate 
                   (chybějící detaily)                                                                          (všechny detaily viditelné) 

o Pixel Samples: Poměr XY vzorku pixelu nastavíte pomocí posuvníku Pixel Samples. Alternativně 
mŧţete kliknout na tečky po stranách posuvníku pro zvýšení (vpravo) nebo sníţení (vlevo) velikosti 
vzorku. Vzorkovací poměr pixelu stanovuje, kolik pixelŧ bude vzorkováno během výpočtu 
antialiasingu pro jeden pixel. Pokud například nastavíte hodnotu na 3, vytvoří se mříţka o rozměru 
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3-pixely na 3-pixely pro vzorkovaný pixel, který se nachází uprostřed. Během renderu renderovací 
nástroj zkoumá plochu 3x3 a poté stanoví barvu a ostatní hodnoty aktuálně renderovanému pixelu. 
Zvětšením této hodnoty vytvoříte dokonalejší rendery, ale drasticky prodlouţíte dobu renderu. 
Hodnota 3x3 je povaţována za dobrý standard. 

o Maximum Bucket Size: Bucket je plocha, která je renderována najednou. Poţadovanou hodnotu 
velikosti plochy zadejte do políčka Maximum Bucket Size. Například zadáním hodnoty 10 nebude 
najednou renderována plocha větší neţ 10-pixelŧ na 10-pixelŧ. Během renderu zpracovává 
renderovací nástroj takovou plochu najednou. Zvýšením Bucket Size se zvýší plocha, která bude 
renderována najednou, ale zvýší se také poţadavky na výpočetní výkon. Buďte obezřetní při 
zvyšování hodnoty plochy nad její základní velikost a sledujte výpočetní zdroje Vašeho systému. 
Všimněte si, ţe Poser 7 automaticky detekuje, zda specifikovaná velikost plochy Bucket Size 
nespotřebovává  nadměrné prostředky a v takových případech změní specifikovanou velikost 
plochy tím, ţe ji rozdělí na menší části. Menší velikost zpracovávané plochy vyţaduje méně RAM 
paměti, ale prodlouţí dobu renderu. 

o Minimum Displacement Bounds: Hodnota 
Minimum Displacement Bounds je 
měřena v jednotkách Poseru (které jsou 
specifikovány v dialogovém okně General 
Preferences) a určuje velikost posunutí 
(displacement), se kterou renderovací 
nástroj pracuje. Displacement mapping je 
renderovací technika, která přidává 
povrchŧm realistické boule a propadliny.  
V normálním případě bývalo vhodnější 
modelovat deformace povrchu přímo, nyní 
spíše mŧţete k editaci objektu pouţít mapy posunutí (šablony určené pro výpočet posunutí). 
Kromě toho, přidání některých detailŧ přímo do objektu mŧţe exponenciálně zvýšit mnoţství 
polygonŧ  a tím značně ovlivnit dobu renderu. Pokud nastavujete hodnotu Minimum 
Displacement Bounds, mějte na paměti, ţe mŧţe dojít k překročení hranice deformace plochy, 
zpŧsobené jejím posunutím. Jinými slovy, i kdyţ aktuální geometrie daného objektu mŧţe být 
obsaţena uvnitř aktuálně renderované deformace, objekt se mŧţe kříţit navzájem díky posunu 
jeho povrchu pomocí sousedících renderovaných nerovností. Jestliţe konkrétní posunutí 
překračuje hranici aktuálně renderované nerovnosti v některém bodu, vznikne díra nebo místní 
trhlina v dotčeném místě. Pro vyvarování se tohoto problému bere renderovací nástroj v úvahu 
rozsah překročení aktuální geometrie tehdy, pokud stanovuje, zda je objekt obsaţen uvnitř 
specifické plochy (bucket). Tento rozsah je specifikován pomocí hranice posunutí Displacement 
Bounds. Menší hranice pŧsobí na méně objektŧ uvnitř aktuální renderované plochy, a proto 
urychluje rendering, ale zvyšuje riziko kolizí geometrie podél hranice renderované nerovnosti. Větší 
hranice předchází kolizím, ale prodluţuje dobu renderu. Výše uvedené schéma ilustruje tuto 
koncepci. V tomto případě, špička pyramidy překračuje hranici nerovnosti a proto bude odříznuta  
a zaplátována. Poser 7 automaticky stanovuje hodnotu hranice posunutí vyhodnocením stromové 
struktury shaderŧ materiálŧ. Pokud je stromová struktura shaderŧ obzvlášť sloţitá, Poser 7 nemusí 
být schopen vypočíst odpovídající hodnotu. V takovém případě byste měli stanovit vyšší hodnotu  
v políčku Minimum Displacement Bounds. Tato se stane minimální hodnotou, která bude Poseru 
7 povolena pro pouţití ke stanovení hranice posunutí během renderu. 

 

NASTAVENÍ MOŢNOSTÍ FIREFLY   FIREFLY OPTIONS SETTINGS (orig.359) 

o Render Over: Tato poloţka specifikuje pozadí, které bude pouţito během renderu obrázkŧ nebo 
animací. Označte odpovídající tlačítko předvolby u moţnosti, kterou si přejete pouţít. 

o Background Color: Výběrem Background Color bude obrázek/animace renderován přes barvu 
pozadí pracovního okna Document. Prosím navštivte téma “Barvy” na straně 46 pro informace 
o změně barvy pracovního okna Document. 

o Black: Výběrem Black bude obrázek/animace renderován přes jednolitou černou barvu pozadí. 

o Background Picture:  Výběrem Background Picture bude obrázek/animace renderován přes 
obrázek na pozadí Vaší scény. Prosím navštivte téma “Import obrázků na pozadí” na straně 
186 pro více informací o importování obrázkŧ pozadí. 
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o Current Background Shader:  Výběrem Current Background Shader bude obrázek/animace 
renderován přes specifikovaný shader pozadí. Prosím navštivte téma “Kořenový uzel pozadí” 
na straně 222 pro informace o pouţití shaderŧ podkladu. 

o Shadow Only: Označením políčka Shadow Only určíte, ţe budou renderovány pouze stíny Vaší 
scény; vše ostatní ve scéně bude kompletně bílé. Tato funkce je velmi uţitečná při přípravě 
renderu, protoţe umoţņuje renderovat pouze stíny, čímţ umoţņuje jejich editaci nezávisle na 
zbytku scény. Následně mŧţete vyrenderované stíny pouţít v programu na editaci obrázkŧ a spojit 
je s obrázkem scény beze stínŧ. Toto nastavení má vyšší prioritu neţ všechna další nastavení 
renderu. 

o Smooth Polygons: Označením políčka Smooth Polygons aktivujete vyhlazování polygonŧ,  
a naopak. Pokud je funkce aktivována, renderovací nástroj pouţívá další dělení polygonŧ pro 
vyhlazení ostrých hran objektu. Pokud Vaše scéna obsahuje ostré hrany, které si nepřejete 
vyhladit, mŧţete tyto hranaté části specifikovat pomocí vytvoření skupin vyhlazování, nebo 
nastavením prahu ostrosti úhlu pro stanovení, které polygony budou vyhlazováním ovlivněny. 
Prosím navštivte kapitolu 15: “Vyhlazování povrchu” na straně 137 pro více informací o skupinách 
vyhlazování a nastavení prahu ostrosti úhlu polygonŧ. Pokud je třeba, mŧţe být tato funkce 
deaktivována u konkrétního objektu v jeho paletě vlastností Properties. 

  
Obrázek 1: Bez vyhlazování polygonů Smooth Polygons              Obrázek 2: S vyhlazováním polygonů Smooth Polygons 

o Remove Backfacing Polygons: Označením políčka Remove Backfacing Polygons definujete, ţe 
všechny polygony scény mimo pohled kamery nebudou brány během renderingu v úvahu. Které 
objekty nebudou brány v úvahu závisí na úhlu kamery a pozici/úhlu objektu(ŧ) scény ve vztahu ke 
kameře. Aktivováním této poloţky mŧţete značně urychlit dobu renderu, ale na úkor realismu, 
zejména pokud pouţíváte raytracing. Neoznačením políčka tuto funkci deaktivujete. 

o Use Displacement Maps: Označením políčka Use Displacement Maps aktivujete pouţití map 
posunutí v renderovaném výstupu. Prosím navštivte Poser 7 Tutorial Manual: “About Maps & 
Templates” pro obecný popis map, Poser 7 Tutorial Manual: “Displacement Map” pro popis map 
posunutí a kapitolu 16: “Místnost materiálu” na straně 139 pro informace o místnosti materiálu 
Material room (mapy jsou vkládány do uzlŧ, které jsou součástí shaderŧ). 

o Depth of Field: Rozšiřování prŧzoru objektivu kamery umoţņuje vytvoření efektu hloubky pole 
Depth of Field.  Dále umístěné objekty od ohniskové roviny vypadají více rozostřeny. Označovací 
políčko Depth of Field umoţņuje aktivovat nebo deaktivovat tento efekt během renderu scény. 
Prosím navštivte téma “Parametry kamery” na straně 57 pro informace o nastavení konfigurace 
hloubky pole Depth of Field. 

o 3D Motion Blur: Jak asi víte, rychle se pohybující objekty vypadají rozmazaně. Toto rozmazání je 
zpŧsobeno skutečností, ţe naše oči nejsou schopny dostatečně rychle obnovovat pohled na 
objekt, který déle nesetrvává v předchozí pozici. Funkce Poseru 7 Motion Blur dává Vašim 
animacím dojem pohybu, přináší zcela novou dynamiku a úroveņ realismu do renderŧ. Označením 
políčka 3D motion blur aktivujete rozmazávání pohybu během renderu scény. Pokud je tato 
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funkce aktivována, nastavení doby otevření a zavření uzávěrky kamery ovlivņuje velikost 
rozmazání. Prosím navštivte téma “Parametry kamery” na straně 57 pro více informací  
o parametrech uzávěrky Shutter Open a Shutter Close. 

 
Obrázek 1: Bez map posunutí Displacement Maps                       Obrázek 2: S mapami posunutí Displacement Maps 

o Toon Outline: Poloţka Toon Outline vyuţívá 
post-processing během procesu renderu pro 
vykreslení obrysu okrajŧ v obrázcích karikatur. 
Mŧţete vybírat z devíti stylŧ obrysového štětce. 
Doporučujeme  
u Vašich obrázkŧ pouţití uzlu Toon shader  
a nastavení vykreslování pomocí poloţky Toon 
Outline. Označením políčka Toon Outline je 
funkce aktivována. 

Toon Outline: 

o Post Filter Size: Post filter supersampling 
pixelŧ znamená, ţe se provedou vzorky barev 
pixelŧ na rŧzných místech uvnitř scény za 
účelem získání konečného odstínu pixelu.  
Provádí se z dŧvodu redukce nebo eliminace 
rŧzných forem schodovitosti (zubaté okraje) 
které mohou nastat za určitých okolností. 
Konečný odstín pixelu je váţeným prŧměrem 
supervzorkŧ. Zvýšením této hodnoty se 
zvětšuje plocha pouţitá pro supersampling, ale zvyšuje se doba renderingu a poţadované 
prostředky. Hodnotu mŧţete nastavit posunutím posuvníku Post Filter Size nebo kliknutím na 
body po stranách posuvníku pro zvýšení hodnoty (vpravo) nebo sníţení (vlevo). 

o Post Filter Type: Post filter pracuje s obrazem a modifikuje jej v závislosti na výpočtu specifických 
váţených algoritmŧ supervzorkŧ odebraných pro kaţdý pixel.  Konkrétní algoritmus pro stanovení 
relativní váhy vzorku závisí na typu filtru, který je moţné vybrat 
z rozbalovacího menu Post filter type. Moţnosti jsou následující: 

o Box: Filtr Box poskytuje odpovídající váhu všech vzorkŧ uvnitř 
vzorkované oblasti s prŧměrem rovným 
velikosti filtru pixelu. 

o Gaussian:  Filtr Gaussian poskytuje 
proměnnou úbytku váhy všech vzorkŧ uvnitř 
poloměru odpovídajícího polovině velikosti 
filtru pixelu, s maximální redukcí na váze 
nejdále od středu oblasti vzorkování. 
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o Sinc: Filtr Sinc pouţívá výpočet klesající sinusové 
křivky pro určení váhy vzorkŧ uvnitř poloměru 
přibliţně poloviny velikosti filtru pixelu. Efekt 
sinusoidy je podobný vlnám vyzařujícím z 
centrálního bodu, kde vzorky budou dány vahou 
podle jejich vzájemných poloh s ohledem na 
“vrcholy” a “dna” vln. 

Jakmile máto dokončeno zadání poţadovaných hodnot, klikněte na tlačítko OK pro jejich uchování. 
Nastavení renderu se ukládá současně s uloţením scény. Kliknutím na tlačítko Cancel dojde 
k uzavření dialogového okna Render Settings bez uloţení provedených změn. 

Pro vyrenderování scény ve formě stacionárního obrázku, pouţijte příkaz Render>Render, nebo 
klikněte na tlačítko Render Now v dialogovém okně Render Settings. 

Pro render animace, navštivte prosím kapitolu 39: “Rendering animací” na straně 262 pro více 
informací. 
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Kapitola 37: Pouţití renderovacího nástroje Poseru 4    

USING THE POSER 4 RENDER ENGINE (orig.364) 

 
Tato kapitola vysvětluje nastavení renderovacího nástroje Poseru 4: Renderovací nástroj Poseru 4 
podporuje mnoho uzlŧ shaderu místnosti materiálu Material room, s výjimkou určitých funkcí, jako je 
displacement, raytracing, 3D motion blur, atd. Tento nástroj podporuje souborový formát .BUM 
z dŧvodu zpětné kompatibility s některými staršími soubory Poseru. 

 

o Anti-alias: Označením políčka Anti-alias aktivujete anti-aliasing, který redukuje zubatý vzhled hran 
objektu v renderovaných obrázcích pomocí drobného rozmazání a vmísení hran objektu do pozadí 
obrázku. Neoznačením tohoto políčka funkci deaktivujete. 

o Use bump maps: Označením políčka Use Bump maps aktivujete zobrazení „map hrbolatosti“ 
Bump maps, které budou aplikovány na objekty/rekvizity scény ve výstupu renderu. Neoznačením 
tohoto políčka funkci deaktivujete. 

o Use texture maps: Označením políčka Use texture maps aktivuje zobrazení textur Textured 
maps, které budou aplikovány na objekty/rekvizity scény ve výstupu renderu. Neoznačením tohoto 
políčka funkci deaktivujete. 

o Cast Shadows: Označením políčka Cast Shadows určíte renderovacímu nástroji, aby v rámci 
renderingu počítal také stíny. Individuální nastavení figury má vyšší prioritu neţ toto nastavení 
základní. Například, pokud je figura ve scéně nastavena tak, aby nevrhala stíny, tak vrhat stíny 
budou všechny ostatní objekty scény, které budou pro vrhání stínŧ nastaveny. Aktivování této 
poloţky přidá realismu do Vašich renderŧ, ale prodlouţí dobu dokončení renderu. 

o Ignore Shader Trees: Označením poloţky Ignore Shader Trees přimějete renderovací nástroj 
Poser 4 ignorovat většinu uzlŧ shaderu s výjimkou obrazových map. Tato funkce je obsaţena 
z dŧvodu kompatibility se starším materiálem Poseru, který vyuţívá mapy hrbolatosti Bump maps 
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vytvořené v .BUM souborovém formátu. Aktivováním této funkce rozpojíte všechny uzly stromové 
struktury uzlŧ v místnosti materiálu Material room, coţ znamená, ţe je budete muset opětovně 
spojit. Prosím navštivte téma “Kořenový uzel materiálu/vlasů” na straně 221 pro informace  
o kořenové struktuře uzlŧ a téma “Obrazová mapa” na straně 238 pro informace o pouţití uzlŧ 
obrazové mapy. 

Jakmile máto dokončeno zadání poţadovaných hodnot, klikněte na tlačítko OK pro jejich uchování. 
Nastavení renderu se ukládá současně s uloţením scény. Kliknutím na tlačítko Cancel dojde 
k uzavření dialogového okna Render Settings bez uloţení provedených změn. 

Pro vyrenderování scény ve formě stacionárního obrázku, pouţijte příkaz Render>Render, nebo 
klikněte na tlačítko Render Now v dialogovém okně Render Settings, nebo pouţijte klávesovou 
zkratku [COMMAND]/[CTRL]+[R]. Pro render animace, navštivte prosím kapitolu 39: “Rendering 
animací” na straně 262 pro více informací. 
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Kapitola 38: Renderovací nástroj Designér skic 

 THE SKETCH DESIGNER RENDERER (orig.366) 

 
Designér skic Sketch Designer renderuje scény jako kresby ve formě skic za pouţití černobílých 
nebo barevných tahŧ štětcŧ, ve kterých mŧţete najít zalíbení. Simuluje pero, tuţku, pastelku, uhel, 
vodové barvy a maluje bez toho, abyste kdy museli vstoupit do umělecké školy! 

 

Rendery vytvořené designérem skic Sketch Designer mŧţete uloţit a pouţít při další práci. Sketch 
Designer umoţņuje také vytvoření úţasných animací, které vypadají jako rukou kreslený film. Pro 
docílení nejlepších výsledkŧ pouţívejte scény s mnoţstvím detailŧ (vlasy, oblečení, atd.)  
a dramatickým osvětlením. 

Pro přístup do designéru skic Sketch Designer, pouţijte příkaz Window>Sketch Designer. 
Alternativně mŧţete Sketch Designer zpřístupnit pomocí záloţky Sketch v dialogovém okně 
nastavení renderu Render Settings, která obsahuje také další nastavení renderu a animace. 
 

ZÁKLADNÍ PRVKY SKICY   SKETCH ELEMENTS (orig.367) 

Designér skic Sketch Designer rozeznává tři odlišné sekce uvnitř scény: 

o Objects: Po označení tlačítka předvolby Objects mŧţete definovat styl skicy pro objekty a figury 
Vaší scény. 

o Background: Po označení tlačítka předvolby Background mŧţete definovat styl skicy pro pozadí 
Vaší scény. 

o Edges: Po označení tlačítka předvolby Edges mŧţete definovat styl skicy pro okraje objektŧ a figur 
Vaší scény. 
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PŘEDVOLBY   PRESETS (orig.367) 

K výběru některého z dostupných předvolených stylŧ skicy mŧţete pouţít rozbalovací okno Presets 
v horní části okna náhledu. Také mŧţete pouţít posuvník a další poloţky nastavení pro vytvoření 
téměř nekonečného mnoţství variant stylŧ. 

Rozbalovací okno Presets umoţņuje také vytvoření a odstranění předvolených stylŧ skicy. Pro 
vytvoření předvolby nastavte styl skicy do poţadovaného vzhledu a následně pouţijte příkaz 
Presets>Create Preset. Zadejte název předvolby a klikněte na tlačítko OK. Nová předvolba bude 
zařazena do menu Presets. 

Pro vymazání předvolby vyberte poţadovanou poloţku, kterou si přejete vymazat z menu Presets  
a následně pouţijte příkaz Presets>Delete Preset. 

 UPOZORNĚNÍ 
POLOŢKA DELETE PRESET UMOŢŅUJE ODSTRANĚNÍ PŘEDVOLEB SKICY, KTERÉ BYLY 
DODÁNY SPOLEČNĚ S INSTALACÍ POSERU 7. JAKMILE JE VYMAŢETE, BUDETE MUSET PRO 
NAVRÁCENÍ PŘEDVOLEB SKICY DO TOVÁRNÍHO NASTAVENÍ REINSTALOVAT POSER 7. 

 

OZNAČOVACÍ POLÍČKA  CHECKBOXES (orig.367) 

Designér skic Sketch Designer má tři označovací políčka: 

o Over Black: Označením políčka Over Black  bude scéna renderována pomocí bílé kresby na 
černém pozadí. Pokud nebude políčko označeno, bude pouţita černá kresba na bílém pozadí. 

o Auto Density: Označením políčka Auto Density  bude hustota tahŧ štětce nastavena automaticky 
na základě aktuální scény, přičemţ bude ignorováno nastavení posuvníku Density (viz níţe). 
Pokud zŧstane políčko neoznačeno, hustota bude kalkulována podle nastavení posuvníku 
Density. 

o Colored Strokes: Označením políčka Colored Strokes budou skicy renderovány v barvě. Pokud 
zŧstane políčko neoznačeno, skicy budou renderovány černobíle. 

 

ŠTĚTCE  BRUSHES (orig.368) 

Designér skic Sketch Designer obsahuje několik předdefinovaných štětcŧ, které jsou dostupné přes 
rozbalovací menu Brushes. Pro maximální efekt se snaţte tyto štětce pouţívat s posuvníky Min 
Width a Max Width nastavenými na vyšší hodnoty. 
 

PARAMETRY SKICY   SKETCH PARAMETERS (orig.368) 

Designér skic Sketch Designer obsahuje následující parametry, nastavitelné pomocí posuvníkŧ. 
Pohybem posuvníku doprava se zvyšuje vybraná hodnota, a naopak. Tyto parametry přizpŧsobují 
mnoho charakteristik čar skicy. Vaše skica se překreslí pokaţdé, kdyţ provedete změnu některé 
hodnoty, coţ Vám umoţní ihned posoudit výsledek provedené změny. 

o Density:  Posuvník Density nastavuje hustotu tahŧ štětce skicy. 

o Line Length:  Posuvník Line Length nastavuje délku tahŧ štětce. 

o Min Width: Posuvník Min Width definuje šířku okrajŧ kaţdého tahu štětce, coţ ovlivņuje jas 
originálního obrazu. 

o Max Width: Posuvník Max Width definuje šířku středu kaţdého tahu štětce, coţ ovlivņuje jas 
originálního obrazu. 

o Lo Brightness: Posuvník Lo Brightness určuje pásmo stínování. Při nízkém nastavení budou tahy 
štětce vykresleny pouze ve tmavších částech scény. Pokud je deaktivována poloţka Over Black, 
nastavením tohoto ovladače na 0 dosáhnete nejlepší výsledky. 

o Hi Brightness: Posuvník Hi Brightness určuje pásmo stínování. Při nízkém nastavení budou tahy 
štětce vykresleny pouze ve tmavších částech scény. Pokud je aktivována poloţka Over Black, 
nastavením tohoto ovladače na 1 dosáhnete nejlepší výsledky. 

o Stroke Head:  Posuvník Stroke Head stanovuje velikost kuţelu hrotu štětce. 
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o Stroke Tail: Posuvník Stroke Tail stanovuje velikost kuţelu konce štětce. 

o Line Random: Posuvník Line Random ovládá náhodné tvarování tahŧ štětce. Vyšší nastavení má 
za následek více náhodně tvarovaných tahŧ štětce. 

o Color Random: Posuvník Color Random ovládá náhodné vybarvování tahŧ štětce. Vyšší 
nastavení má za následek tahy štětce s více náhodnými barvami. 

o Opacity:  Posuvník Opacity stanovuje prŧsvitnost čar. Niţší hodnoty vytvoří více transparentní tahy 
štětce. 

o Cross Hatch: Posuvník Cross Hatch nastavuje hustotu šrafování tahŧ štětce. 

o Total Angle: Posuvník Total Angle stanovuje celkové mnoţství úhlových změn, které mŧţe štětec 
provést před ukončením kresby. Vyšší hodnoty ztmavují obraz. Tuto hodnotu sniţte, pokud máte 
nastavenu niţší hodnotu hustoty  Density. 

o Color Cutoff: Posuvník Color Cutoff stanovuje přípustnou mezní hodnotu barevných změn tahŧ 
štětce. Tento posuvník pouţívejte v souladu s posuvníkem Total Angle. 

o Light 1, 2 a 3: Posuvníky Light 1, Light 2 a Light 3 stanovují úroveņ, ve kterém budou první tři 
světla scény ovlivņovat směr tahŧ štětce. Vyšší hodnoty ovlivní tahy štětce do směru zvoleného 
světla(světel). 

o BG Direction:  Posuvník BG Direction definuje směr tahŧ štětce na pozadí scény. 

o Auto Spacing:  Posuvník Auto Spacing nastavuje velikosti mezer mezi tahy štětce v případě, ţe 
funkce Auto Density je aktivována. 

o Color Blend: Posuvník Color Blend stanovuje mnoţství barevných odstínŧ pracovního okna 
Document, které budou pouţity pro vybarvení skicy. 

 

RENDERING SKIC   RENDERING SKETCHES (orig.369) 

Po dokončení nastavení skicy ji mŧţete renderovat v pracovním okně Document. Toto je uţitečné 
v případě, ţe si přejete exportovat animaci renderovanou pomocí nástroje Sketch Designer. Pro 
renderování v pracovním okně Document pouţijte příkaz Render>Sketch Style Render. 
 

EXPORT SKRIPTŮ DO PAINTERU   EXPORTING PAINTER SCRIPTS (orig.369) 

Kliknutím na tlačítko Export Painter Script v levém spodním rohu designéru skic Sketch Designer, 
vyexportujete aktuální nastavení designéru skic Sketch Designer do aplikace Corel Painter. Tato 
funkce byla testována pro spolupráci s verzí Painter 6 a předchozími verzemi a není podporována u 
novějších verzí, nicméně mŧţe fungovat i s nimi. 
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Kapitola 39: Rendering animací 

RENDERING ANIMATIONS (orig.366) 

 
Do okna Movie Settings mŧţete vstoupit pomocí příkazu Animation>Make Movie. Toto okno je také 
přístupné pomocí dialogového okna Render Settings. Okno nastavení animace Movie Settings 
vypadá následovně: 

 

Pro pouţití okna Movie Settings: 

1. Vyberte poţadovaný formát animace pomocí rozbalovacího menu Format. Dostupné poloţky jsou: 

o AVI (Windows)/QuickTime (Macintosh): Toto jsou základní video formáty pro 
Windows/Macintosh. Doporučujeme pouţívat tyto formáty pro vytvoření náhledu během tvorby 
animace, protoţe nabízejí nejrychlejší moţný přístup k renderovaným výsledkŧm. 

o Image Files: Tato poloţky vytvoří sekvenci obrázkŧ Image Sequence, coţ je série 
stacionárních obrázkŧ, jednoho pro kaţdý snímek animace. Pro maximální úroveņ výsledku  
a optimální kvalitu doporučujeme pouţít poloţku Image Files pro vyrenderování finální animace 
a poté pouţít nástroje kompozice pro editaci  a post-produkční práci. 

o Flash: Adobe Flash je populární formát animací umísťovaných na webové stránky. 

2. Jakmile máte video formát vybrán, klikněte na tlačítko Options (pokud je pouţitelné) pro nastavení 
doplņujících údajŧ tohoto formátu. Specifická nastavení palet Option pro video formáty AVI, 
Quicktime a Flash  budou detailně popsány dále v této kapitole. 

3. Pomocí rozbalovacího menu Renderer si vyberte typ renderovacího nástroje, který si pro vytvoření 
animace přejete pouţít. K výběru jsou renderovací nástroje FireFly, Poser 4, Sketch nebo Preview. 
Viz kapitola 36: “Použití renderovacího nástroje FireFly” na straně 249 pro více informací  
o nástroji FireFly, kapitola 37: “ Použití renderovacího nástroje Poseru 4” na straně 257 pro více 
informací o renderovacím nástroji Poseru 4 a kapitola 38: “ Renderovací nástroj Designér skic” na 
straně 259 pro více informací o renderovacím nástroji Sketch Designer. Renderovací nástroj 
Preview poskytuje rychlý render animace v niţší kvalitě. 
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4. Pomocí sekce Options mŧţete zpřístupnit následující poloţky pro AVI/Quicktime a obrazové 
soubory, označením odpovídajících políček: 

o Antialias: Antialiasing pro renderovací nástroj Preview pro zvýšení kvality renderŧ náhledu. 

o 2D Motion Blur: Tato funkce přináší realistické 2D efekty rozostření pohybu do obrázkŧ  
a animací renderovaných pomocí nástrojŧ FireFly, Poser 4 nebo Preview. Hodnotu Blur 
Amount pouţijte pro nastavení výsledného efektu této funkce. 

5. Specifikujte poţadované poloţky pro rozlišení exportu Resolution: 

o Frame Size: Vyberte poţadovanou velikost snímku v pixelech pomocí zadání šířky a výšky do 
políček Width a Height. Vybrané standardní velikosti snímku jsou: 160x120, 320x240  
a 640x480. 

o Constrain Aspect Ratio: Označením políčka Constrain Aspect Ratio bude zachován poměr 
stran animace (šířka ku výšce). Pokud například začínáte na velikosti 640x480 a 640 změníte 
na 1280, výška se automaticky přepočítá na 960. Neoznačené políčko tuto funkci deaktivuje. 
Větší velikosti snímkŧ značně prodluţují dobu renderu a zaberou mnohem více prostoru na 
pevném disku. 

o Quick-Scale Resolution: Rozbalovací menu Quick-Scale nabízí rychlý přístup ke třem odlišným 
předvolbám měřítka renderu: Full Size (plná velikost), Half Size (poloviční velikost) a Quarter 
Size (čtvrtinová velikost). Všimněte si, ţe tato funkce nezmění hodnotu Frame Size, ale spíše 
je nástrojem pro usnadnění rychlého náhledu renderu, protoţe menší měřítka velikosti renderu 
zkracují čas jeho výpočtu. 

Výstupní formát snímku závisí na poměru, vycházejícím z výšky a šířky výstupu. Obrazový snímek 
mŧţete zobrazit v prostoru náhledu scény v pracovním okně Document pomocí volby 
Display>Production Frame z hlavního menu. 

6. Specifikujte nastavení časové osy Time Span: 

o Range: Do políček Start a End zadejte číslo počátečního a koncového snímku pro úsek Vaší 
animace, který si přejete renderovat. Tato funkce je uţitečná v případě, pokud si přejete uloţit 
jen část z celkové animace. Pokud například vytváříte 60-ti snímkovou animaci, mŧţete třeba 
uloţit 15-ti snímkový videosoubor od 35. snímku po konec animace. 

o Increment: Klikněte na příslušné tlačítko předvolby Increment (výtěţek) pro specifikování, kolik 
snímkŧ bude zahrnuto do renderu výstupního video souboru. Moţnosti jsou následující: 

o All Frames: Kliknutím na tlačítko All Frames budou renderovány všechny snímky 
specifikovaného rozsahu Range, podle definovaného základního obnovovacího kmitočtu 
video souboru. 

o Frame Rate: Kliknutím na tlačítko předvolby obnovovacího kmitočtu Frame Rate (počet 
snímkŧ za sekundu) nebude pouţit základní obnovovací kmitočet, ale nově specifikovaný 
kmitočet vlastní. Pokud si přejete nastavit obnovovací kmitočet odlišně od základního 
nastavení dokumentu (například niţší kmitočet je obecně doporučován u Flash formátu), 
zadejte poţadovanou číselnou hodnotu kmitočtu do tohoto políčka. Vyšší čísla dávají 
plynulejší animace, avšak prodluţují dobu renderu a vyţadují více místa na pevném disku. 
Prosím navštivte téma “Obnovovací kmitočet” na straně 87 pro přehled o běţných 
obnovovacích kmitočtech. 

o Every Nth Frame: Kliknutím na toto tlačítko umoţníte provedení renderu jen několika snímkŧ 
animace (kaţdý N-tý) pro případy rychlého náhledu. Například rendering kaţdého druhého 
snímku zabere poloviční čas oproti renderu celé animace, a tak podobně. Specifikujte 
poţadovanou hodnotu “N” do tohoto políčka. 

7. Klikněte na tlačítko Make Movie pro otevření dialogového okna Save Movie, které umoţņuje výběr 
poţadované sloţky pro uloţení a následně klikněte na tlačítko Save pro uloţení nové animace do 
vybrané sloţky. Render animace zabere nějakou dobu v závislosti na velikosti scény, nastavení 
animace a počítači, takţe buďte trpěliví. 
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PŘEDVOLBY AVI   AVI OPTIONS (orig.372) 

Kliknutím na tlačítko AVI Options dojde k otevření dialogového okna nastavení systému video 
komprese Video Compression. Dialogové okno obsahuje následující poloţky: 

o Select Codec: Kodek komprese, který si přejete pouţít, vyberte pomocí rozbalovacího menu 
Codec. Všimněte si, ţe některé kodeky nabízí doplņková nastavení konfigurace. Klikněte na 
tlačítko Configure, pokud je u zvoleného kodeku dostupné, pro nastavení poţadované 
konfigurace. 

 POZNÁMKA 
NĚKTERÉ KODEKY MOHOU VYŢADOVAT PRO SPRÁVNOU FUNKCI DODRŢENÍ SPECIFICKÉHO 
POMĚRU STRAN OBRAZU. 

V závislosti na výběru kodeku mohou být dostupné následující poloţky: 

o Compression Quality: Posuvník Compression Quality nastavte na poţadovanou úroveņ, od 1 
do 100. Vyšší kvalita komprese si vyţádá delší dobu pro generování a více systémových zdrojŧ 
pro výpočet. 

o Keyframe Frequency: Tato poloţka specifikuje, jak často AVI nastaví klíčový snímek ve 
výsledném video souboru. Nepleťte si tuto poloţku s frekvencí klíčových snímkŧ aktuální 
animace v Poseru 7. 

o Data Rate: Touto poloţkou mŧţete specifikovat maximální datový tok během zpracování videa 
v kB za sekundu. 

 

PŘEDVOLBY QUICKTIME   QUICKTIME OPTIONS (orig.373) 

Kliknutím na tlačítko QuickTime Options dojde k otevření dialogového okna nastavení systému video 
komprese Compression Settings. Dialogové okno obsahuje následující poloţky: 

o Select Codec: Kodek komprese, který si přejete pouţít, vyberte pomocí rozbalovacího menu 
Codec. Všimněte si, ţe některé kodeky nabízí doplņková nastavení konfigurace, jak je uvedeno 
dále. 

 POZNÁMKA 
NĚKTERÉ KODEKY MOHOU VYŢADOVAT PRO SPRÁVNOU FUNKCI DODRŢENÍ SPECIFICKÉHO 
POMĚRU STRAN OBRAZU. 

o Color Depth: Pomocí rozbalovacího menu Color Depth si vyberte poţadovanou barevnou 
hloubku obrazu v bitech. 

o Compression Quality: Posuvník Compression Quality nastavte na poţadovanou úroveņ, od 1 
do 100. Vyšší kvalita komprese si vyţádá delší dobu pro generování a více systémových zdrojŧ 
pro výpočet. 

o Frame Rate: Zadejte počet snímkŧ za sekundu, se kterými si přejete video spustit. 

V závislosti na výběru kodeku mohou být dostupné následující poloţky: 

o Keyframe Frequency: Tato poloţka specifikuje, jak často QuickTime nastaví klíčový snímek ve 
výsledném video souboru. Nepleťte si tuto poloţku s frekvencí klíčových snímkŧ aktuální 
animace v Poseru 7. 

o Data Rate: Touto poloţkou mŧţete specifikovat maximální datový tok během zpracování videa 
v kB za sekundu. 

 

PŘEDVOLBY FLASH   FLASH OPTIONS (orig.374) 

Kliknutím na tlačítko Flash Options dojde k otevření dialogového okna Flash Settings: 

Pro export video souborŧ formátu Adobe Flash jsou dostupné následující poloţky nastavení: 

o Overlap Colors: Označením políčka Overlap Colors přimějete Adobe Flash k převzetí barvy, 
která je pouţita nejčastěji a tvoří siluetu celého objektu (jako je figura nebo rekvizita). 
Následující barva je umístěna nahoru přes první, a tak dále, kde kaţdá vrstva barvy obsahuje 
vrstvy nad sebou. Výběrem této poloţky vytvoříte větší soubory, ale také zvýšíte kvalitu 
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finálního souboru. Deaktivováním této poloţky 
zablokujete, aby se rŧzné barvy navzájem překrývaly, 
coţ mŧţe zpŧsobit zobrazení objektu jako rozbitého,  
s nespojitým povrchem. 

o Draw Outer Lines: Označením políčka Draw Outer 
Lines vykreslíte okraj kolem celé siluety. 

o Draw Inner Lines: Označením políčka Draw Inner Lines 
vykreslíte okraj kolem kaţdé barevné vrstvy. 

o Line Width: Do políčka Line Width zadejte poţadovanou 
šířku čáry (v pixelech). 

o Number of colors: Do políčka Number of colors zadejte 
poţadovaný počet barev. Všimněte si, ţe přidávání 
barev zvýší velikost souboru a prodlouţí dobu stahování 
souboru pro lidi, kteří si soubor prohlíţejí na webu. Čtyři 
barvy jsou optimální pro většinu případŧ, ačkoli moţné 
maximum je 253. 

o Color Quantization: Kvantování barev Quantization je 
proces výběru specifikovaného počtu barev, které budou 
nejlépe reprezentovat figuru Poseru 7. Mŧţete vybírat 
mezi Auto nebo Custom kvantováním barev. V kaţdém 
případě bude výběr barev uloţen současně se souborem 
projektu. 

o Auto Quantization: Označte odpovídající tlačítko předvolby, pokud si přejete provést 
kvantování napříč všemi snímky All Frames, nebo pouze podle určitého snímku Specified 
Frame. 

o All Frames: Tato funkce mŧţe být uţitečná v situaci, pokud si přejete kvantování barev 
aplikovat pro kaţdý snímek; pokud například pouţíváte animaci materiálŧ. 

o Specified Frame: Pokud zvolíte moţnost Specified Frame, zadejte do políčka Specified 
Frame číslo snímku, u kterého si přejete kvantování barev pouţít. 

o Custom Quantization: Uţivatelské barvy mŧţete vybírat pomocí kliknutí do okének s náhledy 
barev, čímţ zpřístupníte barevný vzorník Poseru 7. Počet dostupných okének náhledu barvy 
závisí na nastavení počtu barev Number of Colors (viz výše). Umístěním kurzoru myši nad 
kterékoliv okénko náhledu barvy zobrazí RGB barevné hodnoty této barvy v pravém horním 
rohu okna Custom Color. Kliknutím na tlačítko AutoGenerate Colors se obnoví základní 
hodnoty uţivatelských barev. 

 POZNÁMKA 
PRO OPTIMÁLNÍ VÝSLEDKY EXPORTU DO FLASH FORMÁTU, POUŢIJTE PŘI TVORBĚ SCÉNY 
ZOBRAZENÍ NÁHLEDU VE STYLU CARTOON. 
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Kapitola 40: Tipy & Triky     TIPS & TRICKS (orig.376) 

 
Tato kapitola obsahuje několik tipŧ a trikŧ pro vylepšení stacionárních a animovaných renderŧ: 

o Experimentujte s nízkým nastavením renderu a postupně je zvyšujte, aţ dosáhnete 
poţadovaného výsledku.  Tímto budete renderovat scénu za pouţití optimálního vyváţení mezi 
kvalitou a rychlostí. Malé webové animace umoţņují sníţení kvality renderu, zatímco díla 
výtvarného umění budou vyţadovat velmi vysoká nastavení. 

o Stacionární a animované rendery pouţívají aktuálně vybranou kameru. Ujistěte se, ţe máte 
zvolenu poţadovanou kameru před spuštěním renderingu, obzvlášť tehdy, kdy je pohyb kamery 
součástí animace. 

o V základním nastavení Poser 7 renderuje za pouţití stylu zobrazení Texture Shaded. 

o Nastavení renderu Draft a Production pouţívejte pro úsporu času během práce a pro 
vytvoření vysoce realistických výstupŧ. 

o Navštivte prosím Poser 7 Tutorial Manual ve sloţce Tutorials instalace Poseru 7 pro více tipŧ 
na vylepšení renderu. 

o Pokud nebudete vyţadovat dynamické efekty, pouţívejte vlasy na bázi rekvizity (prop-based 
hair) a přizpŧsobivé oblečení na bázi figury (figure-based clothing), namísto praménkových 
vlasŧ (strand-based hair) a dynamického oblečení (dynamic cloth).  Tímto uspoříte výpočetní 
prostředky. 
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Část 6 – PoserPython 

POSERPYTHON (orig.377) 

 

Kapitola 41: O PoserPythonu     ABOUT POSERPYTHON (orig.378) 

 
Tato část vysvětluje základy Pythonu a popisuje některé uţivatelské metody PoserPythonu, včetně 
popisu funkce, vytvoření syntaxe a příkladŧ pouţití. Pochopení souvislostí metod a zápisŧ 
PoserPythonu si vyţaduje určitou úroveņ základních znalostí a zákulisních vysvětlení. 

Všimněte si, ţe tato kapitola předpokládá, ţe máte přinejmenším základní úroveņ znalostí tvorby 
jazyka Python. I kdyţ popisuje některé základní koncepty Pythonu proto, aby doplnila srozumitelnost  
a souvislost, tato kapitola není určena pro výuku Pythonu. Existuje mnoţství kvalitních zdrojŧ 
informací určených k výuce Pythonu a mnoho z nich je volně dostupných. Prosím navštivte téma 
“Další důležité zdroje” na straně 14 pro seznam několika doporučených zdrojŧ informací o Pythonu. 

Python (pojmenován po Monty Python‟s Flying Circus) je vysokoúrovņový interpretovaný skriptovací 
jazyk orientovaný na objekt, který byl poprvé vydán v roce 1989 panem Guido van Rossum a poprvé 
vypuštěn jako volně dostupný software po intenzivním testování v roce 1991. Jedná se o extrémně 
výkonný a lehce naučitelný jazyk, který virtuálně funguje na všech platformách, a který mŧţe být 
značně uţivatelsky přizpŧsobován a modifikován pro běh s ostatními aplikacemi (jako je Poser 7)  
a programovacími jazyky. Protoţe se jedná o volně dostupný software, Python je volně pouţitelný  
a mŧţe být distribuovaný bezplatně. Pythonovo začlenění počtu vysokoúrovņových typŧ dat, stejně 
jako dynamické psaní, jej činí uţivatelsky jednoduchým a umoţņujícím provedením práce beze 
zmatku v implementaci, běţném u nízkoúrovņových jazykŧ. 

PoserPython je zákaznicky přizpŧsobená implementace překladače Pythonu obsahující mnoţství 
příkazŧ, které se nenacházejí ve standardním vydání Pythonu. Tato zákaznická úprava integruje 
Python do Poseru 7 a poskytuje rozsáhlý seznam lehce naučitelných příkazŧ, které mohou značně 
redukovat dobu, strávenou vykonáváním opakovaných úloh v Poseru 7. 

Jednou z nejlepších vlastností PoserPythonu je, ţe nemusíte být programátory, abyste si začali uţívat 
jeho výhod. Poser 7 obsahuje několik uţitečných vzorových skriptŧ, které mohou být spuštěny 
kliknutím na příslušné tlačítko. Vŧbec nemusíte znát zdrojový kód a přitom kaţdý z Vašich přátel Vás 
označí za programátora! Tím je řečeno, ţe další výbornou vlastností PoserPythonu je, ţe mŧţete “mít 
pod čepicí” a psát skripty k provedení prakticky čehokoliv. PoserPython poskytuje virtuálně plnou 
kontrolu nad dokumenty Poseru 7 včetně figur, rekvizit, světel, kamer, scén, apod. a jejich stavebních 
prvkŧ a parametrŧ. Jak vidíte, PoserPython přináší prospěch stejnou měrou začátečníkŧm i expertŧm! 

PoserPython obsahuje také rozšíření Numerical Python, které se automaticky načítá se startem 
Poseru 7. Toto rozšíření pouţívá mnoţství geometrických metod pro rychlou manipulaci s vertexy, pro 
nastavení a informace o polygonech. Pro více informací prosím navštivte webové stránky 
http://www.python.org/topics/scicomp/numpy.html. 
 

PROČ PYTHON?   WHY PYTHON? (orig.379) 

Začlenění podpory skriptovacího jazyka do Poseru 7 přináší uţivatelŧm nebývalou sílu a flexibilitu pro 
automatizaci a přizpŧsobení zkušeností s Poserem 7 a pro uvolnění tvŧrčích schopností  
a produktivity. Kombinace jednoduchosti, síly, rozšiřitelnosti a volně dostupných distribučních práv 
dělají Python stále více populárním programovacím jazykem a jasnou volbou pro integraci s Poserem 
7. Přidání PoserPythonu umoţņuje pokročilým uţivatelŧm Poseru 7 prakticky nekonečnou kontrolu  
a flexibilitu: Několik řádek kódu Pythonu mŧţe rychle automatizovat proces, který by jinak zabral 
hodiny ruční práce. Protoţe Python pracuje zcela uvnitř Poseru 7, musíte ke tvorbě skriptŧ Pythonu 
pouţít pouze externí aplikaci, například Váš oblíbený textový editor. 
 

VAROVÁNÍ   A WORD OF WARNING (orig.379) 

Neomezená kontrola je dvousečnou zbraní. Na jednu stranu přináší uţivatelŧm přímý přístup k jejich 
tvorbě a základním datŧm. Na druhou stranu je nemoţné předvídat kaţdý myslitelný skript 
PoserPythonu. Kvŧli neomezeným pravomocím, které skripty poskytují, je moţné nešťastnou náhodou 
či úmyslně zničit některá data, snad kromě samotného Poseru 7. My v e frontieru jsme se všemoţně 
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snaţili o vytvoření takových “bezpečných ” metod manipulace s útrobami Poseru 7 a ve většině 
případech chyba Pythonu zpŧsobila, ţe překladač vyhodil námitku a zablokoval vykonání skriptu. 
Nicméně mějte na mysli, ţe Python je kompletní programovací jazyk navrţený pro daleko širší pouţití, 
neţ jen v Poseru 7. Jedná se o silný nástroj a stejně jako všechny nástroje, musí se pouţívat opatrně. 
Jestliţe nejste obeznámeni se základy Pythonu, dŧrazně doporučujeme, abyste absolvovali určitý 
výcvik a zkušenosti s Pythonem získávali pomalu a opatrně, abyste si uţili hladkého  
a bezproblémového prŧběhu osvojování znalostí. 
 

SEZNAM TYPŮ & METOD POSERPYTHONU    
POSERPYTHON TYPES & METHODS LISTING (orig.379) 

PoserPython obsahuje stovky uţivatelských metod a e frontier prŧběţně aktualizuje seznam všech 
dostupných metod. Prosím navštivte PoserPython Methods Manual, který obsahuje a organizuje 
seznam všech dostupných metod PoserPythonu pro Poser 7. Je uloţen v PDF formátu na DVD  
s Poserem 7 a je také přístupný přímo z Poseru 7 pomocí příkazu Help>PoserPython Manual. 
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Kapitola 42: Základy konceptů PoserPythonu     

BASIC POSERPYTHON CONCEPTS (orig.380) 
 
Tato kapitola popisuje některé základní koncepty PoserPythonu k tomu, aby byly vysvětleny 
souvislosti. 
 

JAK JE PYTHON INTEGROVÁN DO POSERU 7     
HOW PYTHON INTEGRATES WITH POSER 7 (orig.380) 

Existují dva základní typy programovacích jazykŧ: 

o Compiled (kompilovaný): Speciální program zvaný kompilátor čte kód napsaný programátorem, 
překládá jej do formy čitelné pro počítač a vytváří spustitelný program, který mŧţe běţet 
samostatně na kaţdé podporované počítačové platformě. Jazyky, jako je C++, náleţí do této 
kategorie. 

o Interpreted (interpretovaný): Interpretované programovací jazyky poţadují zvláštní program 
nazvaný překladač k tomu, aby kód napsaný programátorem běţel. Překladač čte příkazy 
nalezené v kódu a vykonává je od počátku do konce bez překládání originálního kódu. Stinnou 
stránkou interpretovaných jazykŧ je, ţe musí pouţívat překladač a kód nemŧţe být nikdy 
spuštěn jako samostatný program.  Nicméně výhodou je, ţe pokud programátor provede změnu 
kódu, uvidí výsledek velmi rychle bez nutnosti čekání na kompilaci kódu. Dodatky, změny  
v textu a vymazání probíhají rychle a jednoduše. 

PoserPython obsahuje standardní překladač Pythonu který byl rozšířen k tomu, aby rozpoznal  
a vykonal příkazy, které nejsou obsaţeny ve standardním jazyku Python. PoserPython skripty, 
napsané pomocí uzpŧsobených příkazŧ, pracují pouze s verzemi Poser ProPack a následujícími (5  
a výše). Nicméně mŧţete převádět data sem tam mezi Poserem 7 a jinými Python skripty, 
programovacími jazyky a aplikacemi. 

Standardní aplikace Poseru 7 obsahuje mnoţství dat o kaţdé poloţce (figuře, scéně, světlu, kameře, 
rekvizitě, atd.), které se nacházejí v dané scéně. Tyto parametry mŧţete nastavovat pomocí myši  
a prvkŧ uţivatelského rozhraní, jako jsou menu, tlačítka, otočné ovladače, atd. Nicméně nemŧţete 
s daty pracovat přímo. To napomáhá snadnějšímu uţívání Poseru 7, ale má to určitá omezení. 
Nemáte například moţnost automatizování opakovaných úkolŧ či záznamu sloţité série úkonŧ pro 
pozdější pouţití. PoserPython tato omezení obchází. 

PoserPython odhaluje mnoho surových dat Poseru 7. Pouţitím skriptŧ Pythonu mŧţete extrahovat 
data z Poseru 7, manipulovat s nimi a opětovně je do Poseru 7 vkládat. V podstatě mŧţete Poser 7 
programovat, aby dělal to co chcete a přitom nejste nadále omezeni uţivatelským rozhraním Poseru 7 
a jeho zabudovanými funkcemi. 
 

ZÁKLADNÍ STRUKTURA PYTHONU   BASIC PYTHON STRUCTURE (orig.381) 

Python je programovací jazyk orientovaný na objekt. Objekt je virtuální věc, která slučuje 
strukturovaná data a metody, kterými mŧţe být s daty manipulováno. Metoda je procedura pro 
manipulaci dat a parametr definuje jak je metoda uskutečněna. Zjednodušenou, ale efektní obdobou 
je základní gramatika: Objekt mŧţe být srovnáván s podstatným jménem, metoda se slovesem  
a parametr s přídavným jménem či příslovcem. Vezměte například v úvahu následující: 

automobil = továrna.výroba(vozidloXL) 

V tomto případě, proměnná automobil je výsledkem objektu továrna, na který pŧsobila metoda výroba, 
modifikovaná parametrem vozidloXL (pro vytvoření určitého modelu). Jednoduše řečeno, existence 
automobilu a všeho ostatního, týkajícího se automobilu, závisí na továrně uzpŧsobené pro výrobu 
automobilu dané specifikace a modelu. Uvaţte, jak se hodnota proměnné automobil mŧţe lišit  
v následujících příkladech: 

o automobil = mechanik.oprava(kabina, převodovka) 
o automobil = autovrakoviště.náhrada(vozidloXL) 
o automobil = zloděj.odcizit() 

V prvním případě proměnná automobil prochází modifikací metodou mechanické opravy a výsledkem 
je fungující automobil. Poslední případ neobsahuje ţádný parametr. V tomto případě zloděj 



 

Strana 270 (celkem 289) 

automobilu nemusí brát ţádný externí vstup k tomu, aby se rozhodl, který automobil ukradne. Ještě 
jednou, objekt je definován uspořádaným souborem dat, metoda je to, co objekt dělá, a nějaký 
parametr charakterizuje, jak je metoda vykonána. 

Automobil mŧţe obsahovat buď data, nebo reference, nebo odkazy na data. Prosím nastuduje některý 
z mnoha zdrojŧ Pythonu (jako jsou ty, popsané v části “Další důležité zdroje” na straně 14) pro 
dŧkladnou diskusi o proměnných versus neměnných typech. Data mohou být prakticky čímkoliv, 
včetně písmen, číslic, souborŧ, atd. Jakmile začnete myslet na data ve formě objektŧ a zacházení  
s objekty, zjistíte, ţe je to daleko snadnější a rychlejší pro psaní skriptŧ Pythonu. 
 

UKÁZKA SKRIPTU PYTHONU   SAMPLE PYTHON SCRIPT (orig.382) 

Tato část dává krátký příklad, jak mŧţe skript Pythonu vypadat. Pro tento příklad si pojďme říci, ţe 
máme otevřenu scénu Poseru 7, která se skládá z figury s jiţ vybraným jejím levým předloktím. Toto 
předloktí se nazývá činitel (actor). Činitel je nějakým prvkem scény Poseru 7 (část postavy, rekvizita, 
apod.) a tato příručka pouţívá dvě podmínky proměnných. Řekněme, ţe chceme nastavit X měřítko 
na 88 procent. 

scene = Poser.Scene() 
actor = Scene.CurrentActor() 
parm = actor.ParameterByCode(Poser.ParmCodeXSCALE) 
parm.SetValue(88) 

Podívejme se na výše uvedený skript podrobněji: 

Skript začíná určením proměnné nazvané scene, která odkazuje na aktuální scénu Poseru 7. Tato 
scéna obsahuje více činitelŧ. Připomeņme si, ţe levé předloktí figury máme jiţ vybráno, takţe vše, co 
skript potřebuje udělat, je poţadavek na aktuální prvek (činitel) scény pro definici činitele parametru. 
Dále, proměnná parm obsahuje odkaz na specifikovaný parametr levého předloktí, v tomto případě 
parametr XSCALE. Kód parametru (ParmCode) doplņuje jednoduše zapamatovatelné slovo pro 
označení poţadovaného parametru. Nakonec, hodnota parametru činitele, ke kterému se odkazuje, 
se přestaví na 88, coţ zpŧsobí, ţe levé předloktí se smrští na 88% jeho normální velikosti ve směru 
osy X. 
 

PSANÍ SKRIPTŮ PYTHONU    WRITING PYTHON SCRIPTS (orig.382) 

Pro psaní skriptŧ Pythonu mŧţete pouţít Váš oblíbený textový editor. Alternativně mŧţete pro psaní 
skriptŧ pouţít některé z grafických rozhraní Pythonu, jako je Tkinter pro Windows. 
 

SYNTAXE SLOŢKY   FOLDER SYNTAX (orig.382) 

Python, jakoţ i jiné jazyky, pouţívá určité speciální znaky, před kterými je uváděn symbol, jemuţ ve 
stylu Windows odpovídá obrácené lomítko. Dva následující příklady jsou \t ([TAB]) a \n (new line). 
Takţe, následující zápis ve Windows 

C:\folder\test.txt 

je v Pythonu interpretován jako 

C:[TAB]folder[TAB]text.txt nebo C:foldertest.txt 

Pokud chcete uvedený příklad zapsat správně, musíte pouţít dvojité obrácené lomítko (\\), které 
označuje sloţku. Správný zápis výše uvedeného příkladu bude vypadat následovně: 

C:\\folder\\test.txt 

Takto mŧţe být správně interpretován jako označení specifické cesty k určité sloţce. 

Alternativně mŧţete pouţít formát Macintosh, který pro označení sloţky pouţívá symbol dvojtečky, viz 
následující: 

:folder:test.txt 
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SPUŠTĚNÍ SKRIPTU   RUNNING YOUR SCRIPT (orig.383) 

Váš skript mŧţete přímo spustit pomocí menu, nebo palety Scripts Poseru 7. Obojí jsou popsány 
v následující kapitole.  
 

PRO DALŠÍ INFORMACE   FOR FURTHER INFORMATION (orig.383) 

Předcházející informace byly velmi letmým pohledem do Pythonu a rozšíření PoserPython. Jestli  
v současné době Python neznáte, měli byste studovat a dozvědět se více. Díky nabídce síly  
a flexibility tohoto rozhraní, by si Python rozvíjení odborných znalostí zaslouţil. 
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Kapitola 43: Spouštění skriptů PoserPythonu     

RUNNING POSERPYTHON SCRIPTS (orig.384) 

Poser obsahuje jednoduché grafické uţivatelské rozhraní, které umoţņuje spouštět skripty Pythonu 
pomocí stisku tlačítka. Paletu skriptŧ Python Scripts mŧţete upravovat a navíc mŧţete skripty Pythonu 
spouštět přímo. 
 

PALETA SKRIPTŮ PYTHONU    
THE PYTHON SCRIPTS PALETTE (orig.384) 

Paletu skriptŧ Python Scripts otevřete uvnitř Poseru 7 příkazem 
Window>Python Scripts. 

 POZNÁMKA 
KLIKNUTÍM NA NĚKTERÉ Z TLAČÍTEK ZOBRAZÍTE PODMENU 
TLAČÍTEK UVNITŘ PALETY PYTHON SCRIPTS. TOTO JE POUZE 
JEDEN PŘÍKLAD, JAK MOHOU BÝT SKRIPTY PYTHONU POUŢITY 
PRO UŢIVATELSKÉ PŘIZPŦSOBENÍ POSERU 7. MŦŢETE PSÁT 
SKRIPTY, KTERÉ OTEVÍRAJÍ TLAČÍTKOVÁ MENU A PODMENU. 
POKUD JSTE ZVĚDAVÍ, MŦŢETE OTEVŘÍT NĚKTERÉ 
Z EXISTUJÍCÍCH SKRIPTŦ PODMENU, ABYSTE ZJISTILI, JAK BYLY 
VYTVOŘENY. 
 

POUŢITÍ TLAČÍTEK SKRIPTŮ   USING THE SCRIPT BUTTONS (orig.384) 

Pro spuštění skriptu jednoduše stiskněte odpovídající tlačítko a skript se automaticky vykoná. 
 

PŘIDĚLENÍ TLAČÍTEK UVNITŘ KONZOLY    
ASSIGNING BUTTONS WITHIN THE CONSOLE (orig.384) 

Nepřidělená tlačítka nejsou pojmenována. Značka vynechání (...) označuje dostupnost nepřidělených 
tlačítek. Pro přidělení skriptu pod tlačítko jednoduše stiskněte toto tlačítko a lokalizujte poţadovaný 
skript (.py soubor) pouţitím standardního prŧzkumníka operačního systému. Jakmile máte 
poţadovaný skript lokalizován, označte jej a stiskněte Open. 
 

EDITACE SKRIPTŮ UVNITŘ KONZOLY   EDITING SCRIPTS WITHIN THE CONSOLE (orig.384) 

Skripty, obsaţené v paletě Python Scripts Poseru 7, mŧţete editovat pomocí stisku a podrţení 
klávesy [CTRL] současně s kliknutím na tlačítko, ke kterému je poţadovaný skript přidělen. Tímto 
dojde k otevření skriptu pomocí základního textového editoru operačního systému, který umoţní 
jednoduchou editaci. Změny uloţte zpŧsobem, který odpovídá pouţitému editoru. Pomocí dialogového 
okna General Preferences mŧţete pro pouţití k tomuto účelu zvolit také jiný editor. Dialogové okno je 
přístupné volbou Edit>General Preferences, jak je popsáno v části “Nastavení předvoleb aplikace” 
na straně 19. 
 

ODSTRANĚNÍ PŘIDĚLENÍ/OBNOVENÍ PŘIDĚLENÍ TLAČÍTEK UVNITŘ KONZOLY   
UNASSIGNING/REASSIGNING BUTTONS WITHIN THE CONSOLE (orig.385) 

Pro změnu přidělení tlačítka pomocí nahrazení jiným skriptem Pythonu, musíte nejdříve vymazat 
aktuální přidělení skriptu a následně přidělit skript nový. To mŧţete udělat pomocí stisku a podrţení 
klávesy [OPT]/[ALT] současně s kliknutím na tlačítko, u kterého si přejete odstranit přidělení. Pokud si 
přejete přidělit nový skript k právě uvolněnému tlačítku, postupujte návodu výše. 
 

PŘÍMÉ SPUŠTĚNÍ SKRIPTŮ PYTHONU    
RUNNING PYTHON SCRIPTS DIRECTLY (orig.385) 

Paleta skriptŧ Poseru 7 Python Scripts obsahuje často pouţívané skripty pro jednodušší pouţití. 
Nicméně mŧţete spustit jakýkoliv skript, který si přejete, pomocí příkazu File>Run Python Skript, 
který otevře standardní navigační okno operačního systému. Poţadovaný skript vyhledejte pomocí 
procházení adresářŧ a sloţek, následně stiskněte tlačítko Open pro spuštění skriptu. 
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Alternativně mŧţete ke skriptŧm přistupovat přímo z menu skriptŧ Scripts Poseru 7. Viz kapitola 31: 
“Menu skriptů” na straně 215 pro více informací o tomto menu. 
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Část 7 – Dodatky 

APPENDICES (orig.387) 

 

Dodatek A:  Technická podpora  TECHNICAL SUPPORT (orig.388) 

 
Tvrdě jsme pracovali na zabezpečení, aby silnými rysy Poseru 7 byla jednoduchost pouţití  
a dostupnost pro uţivatele, provozující široké spektrum typŧ počítačŧ. Nicméně mohou nastat 
okamţiky, kdy budete potřebovat technickou podporu. e frontier s potěšením nabízí bezplatnou 
technickou podporu registrovaným uţivatelŧm našich produktŧ.  Pro poskytnutí technické podpory 
navštivte prosím naše webové stránky na http://www.e-frontier.com/go/support a projděte si 
nejčastější dotazy týkající se produktu FAQs. 

Prosím pouţijte moţnosti podle následujícího seznamu před kontaktováním technické podpory 
Technical Support: 

o Poser 7 Reference Manual: Tato referenční příručka odpovídá na většinu otázek týkajících se 
Poseru 7. Před kontaktováním technické podpory si prosím dŧkladně přečtěte příslušné sekce této 
příručky. 

o FAQ: Prosím prostudujte nejčastější dotazy týkající se produktu FAQs na výše uvedené URL. 

o Poser 7 Tutorial Manual: Tento Tutorial Manual přináší instrukce krok za krokem pro základní  
a pokročilé úlohy v Poseru 7. Pokud máte dotaz typu „Jak udělám toto…?“, mŧţete zde najít 
odpověď. 

o Ostatní fóra: Pokud je Váš dotaz více umělecký neţ technický, vyzkoušejte některé z velkých 
online fór týkajících se Poseru, kde se umělci scházejí. Prosím navštivte téma “Ostatní fóra” na 
straně 13 pro odkazy na několik online fór. 

Stále nemáte odpověď na svou otázku? Prosím kontaktujte technickou podporu Technical Support 
kliknutím na odkaz http://www.e-frontier.com/go/support na stránce produktového FAQ (Frequently 
Asked Questions) a zde vyplņte formulář online podpory. Pokud kontaktujete technickou podporu, 
vyplņte formulář tak úplně, jak je to moţné a poskytněte co nejvíce informací o problému. To nám 
pomŧţe vyřešit Vaši záleţitost rychleji. Jakmile máte formulář odeslán, zástupce technické podpory 
Vás bude kontaktovat co nejdříve, jak to bude moţné. Na ţádosti podpory je odpovídáno pomocí 
emailu v pořadí, v jakém byly přijaty. Online podpora je bezplatná pro všechny registrované uţivatele 
Poseru 7. Uţivatelé Poseru 7 jsou dŧrazně upozorněni na nutnost registrace po instalaci aplikace na 
http://www.e-frontier.com/go/register. 

Také telefonická podpora je bezplatná pro všechny registrované uţivatele. Před kontaktováním 
telefonické podpory vyzkoušejte prosím zdroje informací popsané výše. Telefonická podpora je 
určena pro řešení kritických technických problémŧ. Nejsme schopni odpovědět na otázky týkající se 
projektu. Telefonní číslo technické podpory je uvedeno na naší webové stránce http://www.e-
frontier.com/go/company/contactus.  Podpora na telefonu je dostupná od 10 hodin do 16 hodin (U.S. 
Pacifického času). Pokud budete volat v jinou dobu, nebo pokud náš zástupce nebude schopen 
odpovědět přímo během hovoru, budete vyzváni k zanechání zprávy a my Vám zpětně co nejdříve 
zavoláme (obvykle během dvou pracovních dní). Během volání buďte prosím u počítače se 
spuštěným Poserem 7. 

Za účelem poskytnutí podpory budeme poţadovat následující informace: 

o Vaše jméno 
o Emailovou adresu 
o Telefonní číslo (včetně případných mezinárodních předvoleb) 
o Váš aktuální operační systém 
o Specifikaci Vašeho počítače (CPU, RAM, hard disk, video karta, atd.) 
o Sériové číslo Poseru 7 
o Detailní popis problému 

Tyto informace nám pomohou nalézt a vyřešit Váš problém. Tyto informace poţadujeme k tomu, 
abychom poskytli technickou podporu a nejsme schopni odpovídat na neúplné a nevhodně 
formulované dotazy. 

http://www.e-frontier.com/go/company/contactus
http://www.e-frontier.com/go/company/contactus
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Pro mezinárodní podporu kontaktujte prosím místního distributora. e frontier udrţuje seznam svých 
mezinárodních distributorŧ na stránkách http://www.e-frontier.com. 

 POZNÁMKA 
E FRONTIER SI VYHRAZUJE PRÁVO PRO ZMĚNU PRAVIDEL TECHNICKÉ PODPORY 
KDYKOLIV BEZ PŘEDCHOZÍHO UPOZORNĚNÍ. 
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Dodatek B: Struktura souborů Poseru 7    

POSER 7 FILE STRUCTURE (orig.390) 

Tento dodatek popisuje některé základy systému souborŧ Poseru 7. 
 

O SOUBORECH POSERU 7    ABOUT POSER 7 FILES (orig.390) 

Někteří pokročilí uţivatelé Poseru 7 získávají dodatečnou kontrolu nad svou prací přímou editací 
zdrojových souborŧ místo, nebo navíc k pouţívání aplikace Poser 7. Tato příručka poskytuje detailní 
popis formátŧ souborŧ Poseru 7, včetně syntaxe, návrhu a příkazŧ/parametrŧ obsaţených v kaţdém 
typu souboru. 

Poser 7 pouţívá samostatné soubory pro kaţdou figuru, rekvizitu, světlo a kameru, stejně jako další 
soubory pro zvláštní detaily figury (tvář, ruce, atd.). Tyto soubory se obvykle nacházejí v Runtime 
sloţce Poseru 7. Instalátor Poseru 7 vytvoří automaticky sloţky a do nich na správná místa vloţí 
soubory. Zatímco kaţdý typ souboru Poseru 7 má samostatnou příponu a účel, kaţdý z typŧ souborŧ 
popisovaných v této příručce (s výjimkou OBJ a ne-nativních formátŧ Poseru 7) vychází ze stejného 
základního formátu a pouţívá jednu nebo více podskupin celkové struktury příkazŧ/parametrŧ Poseru 
7. 

 POZNÁMKA 
PROSÍM NASTUDUJTE LICENČNÍ USTANOVENÍ POSERU 7 PRO KONCOVÉHO UŢIVATELE 
(EULA) V PRVNÍ ČÁSTI TÉTO PŘÍRUČKY PRO INFORMACE, TÝKAJÍCÍ SE LEGÁLNÍHO 
POUŢÍVÁNÍ FORMÁTU A STRUKTURY SOUBORŦ POSERU 7. 
 

VAROVÁNÍ   A WORD OF WARNING (orig.390) 

Přímá editace souborŧ umoţņuje absolutní ovládnutí tvorby v Poseru 7 a pomáhá k dosáhnutí 
velkolepých výsledkŧ. Přímá editace souborŧ nicméně mŧţe přinést problémy končící havárií 
aplikačního souboru Poseru 7, zkaţením editovaného souboru a moţnou ztrátou dat. 

e frontier poskytuje tyto informace záměrně pouze pro potřeby pokročilých uţivatelŧ Poseru 7. Přímá 
editace souborŧ Poseru 7 se výslovně nedoporučuje a není podporována. Prosím nekontaktujte 
technickou podporu e frontieru s problémy, které se týkají editace souborŧ. Jakékoliv úpravy souborŧ 
Poseru 7 děláte pouze na vlastní riziko. 

Tento dodatek přináší některé rady s ohledem na neplatné hodnoty a chybné zacházení, nicméně 
není moţné podchytit všechny zpŧsoby, kterými mŧţete soubory editovat a jaký bude mít tato editace 
vliv na aplikaci nebo data Poseru 7. 
 

EDITACE SOUBORŮ   EDITING FILES (orig.392) 

Nativní soubory Poseru 7 mŧţete editovat pouţitím jednoduchého textového editoru, jako je 
Poznámkový blok (Windows) nebo Simpletext (Macintosh). Navíc někteří uţivatelé mají vytvořeny 
uţitečné aplikace, které při editaci dat Poseru 7 pomáhají. Prosím spojte se s online 3D komunitou 
uţivatelŧ pro pomoc s vyhledáním a objasněním těchto aplikací. 

Soubory Poseru 7 obsahují formulované popisy a instrukce psané v kódu, který mŧţe Poser 7 číst. 
Stejně jako jiný počítačový program, kaţdý prvek souboru Poseru 7 musí být ve správném formátu, 
musí pouţívat správné hodnoty a musí se nacházet na správném místě v souboru. Soubory Poseru 7 
mohou být velké a sloţité, není tedy vhodné je modifikovat v případě, ţe nemáte dobrou představu  
o jejich funkci. 

Všechny nativní soubory Poseru 7 mají podobnou strukturu, nicméně kaţdý typ souboru má odlišnou 
příponu názvu souboru a odlišné umístění v knihovně (popsáno dále). Nejjednodušší soubory Poseru 
7 mají rekvizity, světla a kamery, zatímco velmi sloţité soubory (CR2 a PZ3) popisují figury a scény 
Poseru 7. 

Mělo by být jen zřídka nezbytné modifikovat nativní soubory Poseru 7 mimo Poser 7, s dŧleţitou 
výjimkou, kterou jsou CR2 soubory. Pokud editujete jakýkoliv soubor Poseru 7, ujistěte se, ţe máte 
originál zálohován a pracujete s jeho kopií. Toto Vás ochrání před ztrátou dat v případě, ţe uděláte 
něco špatně. Měli byste také během práce opakovaně soubory ukládat, pro moţnost jednoduchého 
navrácení do pŧvodního stavu bez ztráty veškeré provedené práce. 
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TYPY SOUBORŮ POSERU 7   POSER 7 FILE TYPES (orig.392) 

Existuje devět typŧ nativních souborŧ asociovaných s Poserem 7: 

o Prop : Tento typ souboru obsahuje informace o zdroji geometrie rekvizity, materiálech, texturách  
a jiných mapách, atd. Soubory rekvizit mají příponu PP2. Soubory magnetŧ jsou soubory rekvizit,  
u kterých vystupují přednastavené magnety jako rekvizity. Soubory rekvizit Props jsou často 
dodávány jako PP2 soubory se začleněnými informacemi o geometrii OBJ. Mohou také obsahovat 
vloţené soubory textur a bump map. 

o Camera : Soubory kamer obsahují informace o kamerách včetně umístění, směrování, ohniskové 
vzdálenosti, atd. Pouţívají příponu CM2. 

o Light: Tyto soubory obsahují informace o světlech, včetně jejich typu, pozici, barvě a jiných 
atributech. Soubory světel mají příponu LT2. 

o Hair: Soubory vlasŧ obsahují informace o rekvizitách vlasŧ a jsou podobné se soubory rekvizit. 
Tyto typy souborŧ mají příponu HR2. Soubory vlasŧ mohou mít současně začleněnu geometrii 
(jako opak samostatného souboru OBJ). 

o Face: Soubory tváře obsahují informace odpovídající artikulaci a deformacím tváře, za účelem 
vytvoření poţadovaného výrazu a mají příponu FC2. 

o Hands: Stejně jako soubory tváře, obsahují soubory rukou  informace odpovídající artikulaci rukou 
do poţadované pozice nebo gesta. Soubory rukou mají příponu HD2. 

o Pose: Soubory pózy obsahují informace potřebné k definici poţadované pózy celé postavy, která 
mŧţe obsahovat informace o tváři a rukou. Soubory pózy mají příponu PZ2. 

o Character: Soubory postavy obsahují všechny informace o postavě Poseru 7, včetně odkazu na 
geometrii, paletu morph targetŧ Joint Editor, materiály, základní pózu, atd. Tyto soubory mají 
příponu CR2. 

o Scene: Tyto soubory jsou tím, co vytvoříte při tvorbě scény Poseru 7 po zvolení uloţení File>Save, 
s výjimkou animace Poseru 7. Tyto soubory obsahují všechny informace, které mŧţete najít u výše 
popisovaných typŧ souborŧ, plus detaily o video souboru, pozadí, renderingu, nastavení animace, 
světel, kamer, figur a ostatní. Soubory scény Poseru 7 mají příponu PZ3.  Jejich struktura je 
podobná struktuře souborŧ CR2. 

o Material Collections: Kolekce materiálŧ Material Collection je plně integrovaný formát souborŧ, 
který ukládá skupiny materiálŧ jedné figury pro přístup pomocí palety knihoven Library. Soubory 
kolekcí materiálŧ mají příponu MC6/MCZ. 

o External Binary Morph Targets: Poser 7 ukládá morph targety do formátu externího binárního 
souboru, který obsahuje pouze morph targety samostatné figury nebo scény. Tyto soubory mají 
příponu PMD. 

 

HIERARCHIE SOUBORŮ   FILE HIERARCHY (orig.393) 

Pro čistě koncepční účely je uţitečné pohlíţet na rŧzné souborové formáty Poseru 7 jako zapadající 
do určité hierarchie, kde některé soubory obsahují části informací, které jsou obsaţeny v souborech 
jiných typŧ. Zatímco kaţdý soubor Poseru 7 obsahuje informace unikátní danému formátu, některé 
typy souborŧ jsou virtuálně identické svou strukturou. Například informace rukou a tváře jsou součástí 
pózy, která spolu s vlasy tvoří část postavy, která je spolu s dalšími informacemi součástí scény. 
 

SVAZKY SOUBORŮ   FILE FAMILIES (orig.393) 

Je také uţitečné pohlíţet na soubory Poseru 7 s ohledem na typy informací, které obsahují. Pouze pro 
koncepční účely mohou být soubory Poseru 7 seskupeny do následujících svazkŧ: 

o Face, Hands, Pose 
o Hair, Prop 
o Camera, Light 
o Character 
o Pose 
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ZÁKLADNÍ UMÍSTĚNÍ SOUBORŮ POSERU 7    
POSER 7 DEFAULT FILE LOCATIONS (orig.394) 

V seznamu níţe si všimněte, ţe tento seznam poskytuje standardní umístění souborŧ Poseru 7 podle 
typu. Pokud si stáhnete jakékoliv soubory Poseru 7, ujistěte se, ţe je ukládáte na jejich správná místa. 
Umístění souborŧ je zcela zásadní pro soubory, které náleţí do sloţky Runtime: Geometries. 
Soubory náleţející do knihoven Library jsou více flexibilní. V následujícím seznamu, výraz  
v závorkách znamená , ţe podadresář či jméno závisí na figuře. Mŧţete vytvářet vlastní podadresáře 
a soubory mezi podadresáři knihoven přesouvat. V tomto případě bude umístění souboru paletou 
knihoven Library v Poseru 7 reflektováno. Grafické soubory (textury, bump mapy, atd.) mŧţete umístit 
kdekoliv, neboť Poser 7 umoţņuje specifikovat jejich pozici. Následující seznam přináší umístění 
všech souborŧ vzhledem ke sloţce Poser 7: Runtime: 

o OBJ (geometrie figury): Geometries\(název figury) 

o RSR (malý soubor, grafický náhled pouze pro Windows): libraries\character\(kategorie)\(název 
charakteru) 

o RSR (velký soubor, Mac a Windows – Binární OBJ): Stejné umístění jako asociovaný soubor 
geometrie 

o PZ3 (scéna Poseru): jakékoliv (uţivatelem zvolené místo) 

o CM2 (kamera): libraries\camera\Camera Sets 

o CR2 (charakter): libraries\character\(kategorie)\(název charakteru) 

o FC2 (tvář): libraries\faces\(kategorie) 

o HR2 (vlasy): libraries\hair\(kategorie) 

o HD2 (ruce): libraries\hand\(kategorie) 

o LT2 (světlo): libraries\light\Light Sets 

o PZ2 (póza): libraries\pose\(kategorie) 

o PP2 (rekvizita): libraries\props\(kategorie) 

o MT5 (shader): libraries\material\(kategorie) 

o TIF, BMP, BUM, JPG (textury, bump mapy, atd.): textures\ (kategorie)\(podkategorie). Doplņkové 
obrázky mŧţete ukládat do libovolných sloţek podle přání. 

o PZS (odkazy na web): Web links\(kategorie) 

o MC6/MCZ (kolekce materiálů): libraries\material\(kategorie) 

o PMD (morph targety): Tyto soubory jsou vytvořeny současně s CR2 (jakmile je figura uloţena do 
knihovny Library), dále současně s PP2 (jakmile je uloţena rekvizita), nebo současně s PZ3 
(pokud byl soubor scény s morph targety vytvořen v předchozích verzích Poseru, nebo pokud byl 
morph nastaven u figury nebo rekvizity aţ poté, co byly vloţeny do scény). 

 POZNÁMKA 
UŢIVATELÉ, KTEŘÍ STAHUJÍ CHARAKTERY NEBO OSTATNÍ SOUBORY POSERU 7 MUSÍ 
NĚKTERÉ, NEBO VŠECHNY SOUBORY MANUÁLNĚ UMÍSTIT NA JEJICH SPRÁVNÁ MÍSTA. 
PROSÍM POUŢIJTE VÝŠE UVEDENÝ SEZNAM PRO OVĚŘENÍ SPRÁVNÉHO UMÍSTĚNÍ 
SOUBORŦ. 

Soubory, obsahující informace o předvolbách, Poser 7 ukládá do základní sloţky uţivatele na 
systémovém disku. Tyto informace o předvolbách obsahují: paměťová tlačítka Memory dots, 
nastavení knihoven Library, nastavení uţivatelského rozhraní Poseru 7 UI a Poser.ini soubor. Ve 
Windows jsou tyto soubory s předvolbami uloţeny na následujícím místě: <Disk s instalovanými 
Windows>:\Documents and Settings\<UserName>\Application Data\Poser 7\. V Macintosh OS X, 
jsou tyto soubory uloţeny na následujícím místě: /Users/<UserName>/Library/Preferences/Poser 
7/. 
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UMÍSTĚNÍ STAŢENÝCH SOUBORŮ POSERU 7    
POSER 7 DOWNLOADED FILE LOCATIONS (orig.395) 

V základním nastavení Poser 7 umísťuje staţený obsah (získaný pouţitím místnosti obsahu Content 
room) do knihovny Download. Prosím navštivte kapitolu 5: “Knihovny Poseru 7” na straně 28 pro více 
informací o knihovnách Poseru 7. 
 

OSTATNÍ TYPY SOUBORŮ POSERU 7   OTHER POSER 7 FILE TYPES (orig.395) 
Někteří uţivatelé se mohou setkat se soubory PHI a PCF. Předchozí verze Poseru pouţívaly PHI pro 
vykonávání funkcí, které jsou nyní uskutečněny pomocí editoru hierarchie/místnosti nastavení Setup 
room (Pro Pack & pozdější). PHI soubory nebyly přímo obsaţené uvnitř OBJ souborŧ, ale byly 
umístěny vedle OBJ souborŧ. PCF jsou pouţívány v aplikaci nazvané Objaction Mover a jsou mimo 
dosah tohoto dokumentu. 
 

OBVYKLÉ POUŢITÍ OBJEKTŮ POSERU 7    
COMMONLY USED POSER 7 OBJECTS (orig.395) 

Morph targety a charaktery jsou obvykle pouţívány a prodávány mnoţstvím uţivatelŧ a ostatních 
distributorŧ. Tato část nabízí jejich krátký popis. 
 

MORPH TARGETY   MORPH TARGETS (orig.395) 

Morph targety jsou dodávány jako soubory OBJ, které mŧţete importovat do Poseru 7 za účelem 
pouţití na části figury. Soubor CR2 figury morph targety ovládá a zobrazuje pro kaţdý morph target 
otočný ovladač při aktivování odpovídající části postavy. Například otočný ovladač morphingu hlavy 
bude zobrazen při aktivování hlavy figury. Tato uţivatelská příručka definuje a popisuje morph targety 
v části “Tvorba a použití morph targetů” na straně 117. 
 

CHARAKTERY & OBLEČENÍ   CHARACTERS & CLOTHING (orig.396) 

Charaktery mohou být modifikacemi síťových modelŧ dodávaných s Poserem 7, nebo mohou 
obsahovat zcela nové síťové modely OBJ. Charaktery zaloţené na dříve existujících modelech jsou 
obvykle CR2, textury a bump soubory. Také kaţdý kus přizpŧsobivého oblečení pouţívá CR2 
soubory, aby mohlo být pohyblivé, je oblečení podobné postavě; proto se oblečení stahuje obdobně 
jako charaktery. 
 

ZÁKLADNÍ SYNTAXE SOUBORU   BASIC FILE SYNTAX (orig.396) 

Jak mŧţete studiem tohoto dokumentu vidět, kaţdý soubor typu Poseru 7 pouţívá stejnou základní 
syntaxi (skladbu). 
 

TABELÁTORY   TABS (orig.396) 

Pouţití tabelátorŧ (odsazení textu) uvnitř souborŧ Poseru 7 je většinou bezvýznamné, nicméně 
objasņuje strukturu souboru, jako je: 

section 1 
child 1 
grandchild 
grandchild n 
child n 

section n 
 

ZÁVORKY & SEKCE SOUBORU   BRACKETS & FILE SECTIONS (orig.396) 

Kaţdý soubor Poseru 7 se otevírá a zavírá pomocí závorek ({}), stejně jako kaţdá sekce uvnitř 
souboru Poseru 7. Hlavní sekce souboru popisuje verzi souboru, umístění a název výchozího souboru 
OBJ (pokud nějaký existuje) a vlastnosti souboru. Jedna z hlavních sekcí souboru (Channels) 
obsahuje pozici, velikost, textury, morph targety a ostatní vlastnosti. Poser 7 automaticky hodnoty 
modifikuje a podle potřeby přidává zápisy. 

Jak je napsáno výše, závorky označují začátek a konec sekcí souboru. Levá závorka označuje 
začátek kaţdé sekce, zatímco pravá závorka označuje konec sekce: 
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{ začíná 
} končí 

Například: 

{ 
sekce A 
} 
 

Vloţené závorky  NESTED BRACKETS (orig.397) 

Jak je vysvětleno výše, pouţitím závorek mŧţeme vymezit kaţdou sekci a podsekci soboru, jak je 
zobrazeno dále: 

{ 
sekce A 
{ 
sekce B 
} 
} 
 

PARAMETRY   PARAMETERS (orig.397) 

Parametry a ostatní poloţky uvnitř sekce závorky pro oddělení nevyţadují. Například: 

{ 
sekce A 
 parametr 1 
 parametr n 
 { 
 sekce B 
 příkaz 1 
 parametr 1 
 parametr n 
 příkaz 2 
 parametr 1 
 parametr n 
 } 
} 
 

KOMENTÁŘE   COMMENTS (orig.398) 

Do souborŧ Poseru 7 mŧţete vkládat komentáře podle následujícího příkladu: 

{ 
číslo 4.01 
Tento text je komentář do souboru CR2. 
} 
 

POSER 7 & OBJ SOUBORY   POSER 7 & OBJ FILES (orig.398) 

Sloţka Geometries obsahuje několik desítek podsloţek pojmenovaných podle figur Poseru. Kaţdá 
z těchto podsloţek obsahuje soubory OBJ, z nichţ kaţdý je síťovým modelem (mesh), například 
sadou polygonŧ uspořádaných tak, aby tvořily poţadovaný tvar objektu. Tyto polygony jsou umístěny 
do rŧzných skupin, které definují dŧleţité části síťového modelu (jako jsou části postavy, taky známé 
jako prvky actors). V závislosti na práci s Poserem 7, tyto skupiny musí mít specifické pojmenování, 
jako jsou boky hip, břicho abdomen, atd. Skupiny Poseru 7 nevyţadují takové specifické obecné 
zásady pojmenování; figury vytvořené pomocí místnosti nastavení Setup room mohou mít skupiny 
pojmenované například jako Kost_1. 

Samotné soubory OBJ neobsahují dostatek informací, umoţņujících Poseru 7 aplikovat všechny 
vlastnosti síťového modelu objektu. Z toho dŧvodu je nutná přítomnost CR2 a dalších souborŧ, které 
doplņkové informace dodávají. Soubory Poseru 7 mohou obsahovat začleněné informace, které se 
normálně nacházejí uvnitř souboru OBJ. Proto mnoho staţených rekvizit soubor OBJ neobsahuje. 
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Některé nativní soubory Poseru 7 se obyčejně odkazují na základní soubor geometrie OBJ, který je 
také v textovém formátu. Nativní soubory Poseru 7 popisují parametry ovladatelné pomocí Poseru 7, 
jako jsou velikost, pozice, textury, atd. Jeden soubor OBJ mŧţe mít více neţ jeden soubor Poseru 7, 
který se na něj odkazuje. K tomuto dochází například tehdy, pokud modifikujete rekvizitu, character, 
atd., a ta je umístěna do knihovny Library pod odlišným jménem a/nebo umístěním. 

Soubory charakteru (CR2) obsahují specifické detaily, jako je velikost, pozice, póza, textury, proporce, 
atd., a také nastavení otočných ovladačŧ, které mění tvar figury. V normálním případě, jeden soubor 
CR2 upravuje jedinou figuru. Pomocí kombinace informací o síťovém modelu OBJ s detaily CR2, 
Poser 7 mŧţe vytvářet uţivatelsky upravené figury. 

Některé soubory Poseru 7 (pózy, tváře, ruce, atd.) fungují pomocí modifikace samotného souboru 
CR2. Pózy, tváře a ruce jsou vţdy popsány uvnitř CR2, nicméně aplikace dat obsaţených v jednom 
z těchto souborŧ změní odpovídající hodnoty uvnitř samotného CR2 souboru. Tyto aplikované změny 
CR2 jsou uloţeny do souboru scény Poseru 7 (PZ3). Pokud uţivatel ukládá modifikovaný charakter do 
knihovny Library, modifikované informace budou zapsány do nového souboru CR2. 

PZ3 soubory jsou dost podobné souborŧm CR2 a umoţņují změnu koncovky PZ3 daného souboru 
scény na CR2,  čímţ vytvoříte nový kompletní charakter s připojenými rekvizitami, vlasy, atd. 
 

ZÁVISLÉ PARAMETRY   DEPENDENT PARAMETERS (orig.399) 

Pomocí Poseru 7 mŧţete nastavovat víceúrovņové parametry, nazývané jako závislé parametry 
dependent parameters, které umoţņují modifikaci více parametrŧ a morph targetŧ pomocí jednoho 
otočného ovladače parametrŧ. Příkladem tohoto typu závislého parametru mŧţe být kompletní 
sortiment druhŧ břicha, který lze vytvořit pomocí hodnoty nastavení otočného ovladače břicha belly: 

o -1.0  břicho podváhy 

o -0.5  mírně zapadlé břicho 

o 0.0  pravidelné břicho 

o 0.5  mírně vyčnívající břicho 

o 1.0  značně vyčnívající břicho 

o 2.0  pivní břicho 

Tento rozsah typŧ břicha byl dosaţen spoluprací několika morph targetŧ a hodnot parametrŧ 
v kaţdém z klíčových bodŧ, v závislosti na nastavení otočného ovladače parametru. Takţe, závislé 
parametry jsou daleko více silné v rozsahu modifikací, které mohou zahrnovat, neţ samostatný morph 
target nebo parametr. 

Následující vzorek kódu ilustruje sestavení závislého parametru. Tento kód je příkladem kanálu 
targetGeom v souboru CR2. Výsledný závislý parametr bude zobrazen jako otočný ovladač 
parametru morph targetu s názvem “bump3”. 

targetGeom bump3 
{ 
name bump3 
 initValue 0 
 hidden 0 
 forceLimits 1 
 min -100000 
 max 100000 
 trackingScale 0.02 
 keys 
 { 
 static 0 
 k 0 0 
 } 
 interpStyleLocked 0 
 numbDeltas 261 
 useBinaryMorph 1 
 blendType 0 
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 valueOpKey 
 Figure 1 
 bone_1:1 
 Custom_Morph 
 beginValueKeys 
 valueKey 0.5 0 
 valueKey 0.75 1 
 valueKey 1 0 
 endValueKeys 
} 

Konec tohoto vzorku definuje některé zajímavé vztahy s ohledem na “bump3” závislý parametr. 
Klíčové slovo “valueOpKey” identifikuje sekci, která definuje, ţe tento parametr mŧţe být ovládán 
pomocí otočného ovladače Custom_Morph prvku bone_1 specifikované figury. Sekce “ValueKeys” 
definuje, jak moc bude závislý parametr “bump3” ovlivněn: 

o Pokud se Custom_Morph rovná 0.5, bude hodnota bump3 zvýšena o 0. 

o Pokud Custom_Morph dosáhne 0.75, bude hodnota bump3 zvýšena o 1. 

o Jakmile se Custom_Morph rovná 1, hodnota bump3 bude opět zvýšena o 0. 

Hodnoty mezi těmito body budou stanoveny pomocí interpolace. 

V dalším příkladu se podívejme na parametr rotateX prvku (v tomto případě bone_2:1, který není 
zjevný z kódu vzorku níţe). Výsledný otočný ovladač závislého parametru je nazván "xRotate". 

rotateX xRotate 
{ 
name xrot 
 initValue 0 
 hidden 0 
 forceLimits 0 
 min -100000 
 max 100000 
 trackingScale 1 
 keys 
 { 
 static 0 
 k 0 0 
 } 
 interpStyleLocked 0 
 valueOpKey 
 Figure 1 
 bone_1:1 
 Custom_Morph 
 beginValueKeys 
 valueKey 0.25 0 
 valueKey 0.75 45 
 valueKey 1 0 
 valueKey 1.25 -45 
 valueKey 1.5 0 
 endValueKeys 
} 

Stejně jako předchozí příklad, sekce “valueOpKey” definuje otočný ovladač Custom_Morph pro 
prvek bone_1:1 specifikované figury, který mŧţe tento parametr ovládat. Hodnota “valueKey” spáruje 
zvýšení rotace ve stupních pro xRotate do určité hodnoty parametru Custom_Morph. 
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INDEX 

Obsah byl ponechán v angličtině, odkazy na stránky platí pro anglický originál příručky. Orientačně je 
moţné vyhledávat podle odkazŧ na pŧvodní umístění u nadpisŧ jednotlivých částí překladu příručky. 
 
Symbols 
2D Texture Nodes 335 
3D Objects 262 
3D Texture Nodes 329 
A 
About 10 
 Animations 114 
 Bone Structures 242 
 Creating a Bone Systém 243 
 Joint Attributes 183 
 Library Palette Categories 41 
 Nodes 304 
 PoserPython 378 
 Props 145 
 Setup Room 240 
Accessing Camera Properties & Parameters 75 
Accessing Different Content Libraries 38 
Adaptive Bucket Size 25, 358 
Adding  
 Clothing from the Library 50 
 Custom Morph Targets 171 
 Hair from the Library 51 
 Items to the Library 44 
 Manual Method 48 
 Poser 5 Download Manager 48 
 Keyframes 126 
 Libraries 38 
 New Item 49 
 Props 52 
Adding Items to the Library Palette 
 Manual Method 46 
Ambient Occlusion 90, 324 
Animals Posing 112 
Animating 
 Lights 93 
 Nodes 308 
 On/Off 73 
 with Poser 114 
Animation 
 Advanced Techniques 143 
 Controls 36 
 Layers 128 
 Lip Syncing 140 
 Non-Linear 128 
 On/Off 75 
 Palette Options 123 
 Sets 131 
 Tools 115 
Animation Menu 294 
Anisotropic 321 
Applying 
 Animation Sets to Figures 133 
 Custom Heads/Textures 216 
 Walks 138 
Area Render 58, 65 

Assigning 
 IK Chains 248 
 Rotation Orders 248 
Attaching Bones to Geometry Parts 247 
Auto Balance 274 
Auto-Group 176 
B 
Basic File Syntax 396 
Basic Node Operations 305 
Basic PoserPython Concepts 380 
Basic Python Structure 381 
Blend& Tweak Styles 137 
Blender node 316 
Blinn 322 
Body Part Properties 104 
Bone Properties 246 
Bone Structures 242 
Brackets & File Sections 396 
Brick node 338 
Brushes 368 
C 
Camera 
 Controls 32 
 Dots 35, 81 
 Name 74 
 Parameters 76 
 Plane Controls 74 
 Properties 75 
Cameras 70 
 Auxiliary 71 

Changing 72 
Controls 70 
Dolly 71 
Face 71 
Left and Right Hand 71 
Locking 80 
Main 71 
Plane Controls 74 
Pointing 80 
Posing 71 
Positioning 73 
Select Camera Control 73 

Caricatures 215 
Cartoon Shading 60 
Cellular node 332 
Chain Break 101 
Characters & Clothing 396 
Checkboxes 367 
Choosing a Category 39 
Choosing a Subcategory 40 
Clear Shadow Maps 55 
Cloth Controls 230 
Cloth Dynamics Controls 236 
Cloth Groups 234 
Cloth Parameters 238 
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Cloth Properties 238 
Cloth Room 227 
Cloth Simulator Creation 228 
Clothifying Objects 230 
Clothing 147 
 Conforming 147 
 Adding 147 
Clouds node 330 
Collision Detection 55 
Color 101 
Color Math node 316 
Color Ramp node 317 
Colors 62 
Comments 398 
Commonly Used Poser 
Objects 395 
Component node 317 
Compressed File Support 259 
Conform To 273 
Conforming Clothing 147 
Content Collections 52 
Content Room 251 
Controls 

Animation 36 
Camera 32 
Cloth 230 
Cloth Dynamics 236 
Display 33 
Light 31 

Convert Hier File 267 
Copying Joint Settings 189 
Copying Keyframes 127 
Crease Angle 190 
Creating 

Animation Sets 132 
Bone System 243 
Cloth Simulator 228 
Custom Morph Targets 172 
Custom Textures 211 
Full Figure Morph 
Targets 169 
Groups 177 
IK Chains 182 
Magnet Deformers 153 
Morph Targets 162, 239 
Props 239 
Wave Deformers 159 

Creating Nodes 307 
Creating Realistic Motion 144 
D 
Default File Locations 394 
Defining Hair Groups 219 
Deformers 153 
Deleting 

Items from the Library 48 
Morph Targets 172 
Nodes 308 
Props 148 

Deleting Nodes 308 
De-Linking Nodes 308 

Dependent Parameter 399 
Depth Cueing and Shadows 61 
Depth of Field 76, 361 
Diffuse Image Based Lights 83 
Diffuse Nodes 320 
Direct Manipulation 102 
Disabling Camera Pointing 80 
Display Controls 33, 67 
Display Menu 285 
Display Units 27 
DNDU node 320 
DNDV node 319 
Document Window 33, 54 

Changing Cameras Within a Pane 59 
Colors 62 
Context Menu 59 
Mini Camera Controls 59 
Options Menu 54 
Pane Layouts 60 
Preview Tab 56 
Quick-Scale 64 
Render Tab 63 
Rendering 59, 65 
Size 56 
Title 54 
Tracking Mode 60 

Documentation 6 
Dolly Cameras 71 
Dots Camera 81 
Downloaded File Locations 395 
DPDU node 319 
DPDV node 319 
Draft vs. Production Options 346 
DU node 319 
DV node 319 
E 
Edge Blend node 317 
Edit Menu 268 
Editing 

Animation Sets 132 
Figures and Props 152 
Graph 134 
Groups 177 
Joint Attributes 185 
Keyframes 126 
Sound 140 

Editing Tools 32, 98 
Chain Break 101 
Color 101 
Direct Manipulation 102 
Grouping 101 
Morph Putty 102 
Rotate 99 
Scale 100 
Taper 100 
Translate In/Out 100 
Translate/Pull 100 
Twist 99 
Using 97 
View Magnifier 101 
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Editors 
Group Editor 173 
Hierarchy Editor 178 
Joint Editor 183 

Elements 125 
End User License Agreement 12 
Entering Node Values 305 
Environment Map Nodes 326 
Exit 267 
Expanding/Collapsing Nodes 305 
Export 265 
 Images 54 
Exporting 

3D Objects 266 
BVH Motion Files 265 
Flash Files 266 
Images 265 
Painter Scripts 265 

Eyes Posing 111 
F 
Face Camera 71 
Face Parameters 110 
Face Room 205 
Face Shaping Tool 212 
Faces Posing 110 
Faces & Phonemes 110 
FastScatter 328 
FBM node 329 
Figure 

Conform To 273 
Height 272 
Lock 275 
Parent 272 
Properties 103 

Figure Editors 173 
Figure Menu 272 
Figure Setup Process 241 
Figures Editing 152 
File „Families‟ 393 
File Hierarchy 393 
File Menu 258 
File Syntax 396 
File Types 392 
Files Flash SWF 266 
Fine-Tuning Joints 248 
FireFly Render Engine 352 
Flash 266 
Flash Settings 374 
Flyaround View 73 
Focal 76 
Focal Length Control 74 
Folder Syntax 382 
Force Fields 157 

Parameters 158 
Properties 157 

Fractal Sum node 329 
Frame Indicator 122 
Frame Number node 319 
Frame Rate 121 
Full Body Morph 273 

G 
Gather 325 
General Posing Principles 94 
Genitalia 274 
Geometries, Importing & Arranging 242 
Glossy 322 
Granite node 333 
Group Editor 173 
Grouping 101 
Grouping Tool 173 
Groups 

Cloth 234 
Hair 219 

Growing Hair 220 
H 
Hair 146 

Colors and Materials 226 
Defining Groups 219 
Growing 220 
Parameters 225 
Prop-Based 146 
Properties 224 
Setting Dynamics 223 
Styling 220 

Hair Room 218 
Hands Posing 111 
Hardware Acceleration 57, 349 
Help 8 
About 9 

Poser 5 Help 9 
Tutorials 9 
Help Menu 300 

Hierarchal Relationships 181 
Hierarchy Branches 180 
Hierarchy Editor 178 
How Python Integrates with Poser 380 
I 
IK See Inverse Kinematics 
IK Chains 248 
Image Based Lights 83 
Image Map node 335 
Import 259 
Importing 

3D Objects 262 
Background Pictures 260 
BVH Motion Capture Files 262 
Geometries 242 
Poser 1.0 Libraries 261 
Poser Documents or Props 261 
Props 148 
Sound 261 

Importing Movies 259 
Infinite Lights 83 
Installation 12 
Installing Poser 20 
Intensity 93 
Interpolation 116 
Interpolation Controls 124 
Inverse Kinematics 95, 117, 273 

Enabling/Disabling 96 
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Understanding 95 
J 
Joint Attributes 183 
 Editing 185 
Joint Editor 183 
 Rotation Orders 188 
 Spherical Falloff Zones 188 
Joints Fine-Tuning 248 
K 
Keyframe Controls 120 
Keyframes and Timing 143 
L 
Library 37 

Accessing Different 
Content 38 
Adding 38 
Adding Items 44 
Collections 52 
Creating a New Subcategory 44 
Deleting Items 48 
Maintaining 44 
Material Collection 42, 43, 47 
Palette Categories 41 
Props 148 
Removing 39 
Switching 38 
Using Objects 49 

Library Palette 35, 37 
Camera 43 
Expressions 42 
Figures 41 
Hair 43 
Hands 43 
Lights 43 
Material 43 
Poses 41 
Props 43 

Light Controls 31 
Light Indicators  

Infinite 87 
Point 88 
Spotlight 88 
Using 87 

Lighting 82 
Adjusting Light Intensity 84 
Aiming 85 
Ambient Occlusion 90 
Animating 93 
Color 85 
Creating 84 
Delete 85 
Parameters 91 
Properties 89 
Selecting 84 
Shadow 91 
Types 83 

Diffuse Image Based Lights 83 
Infinite Lights 83 
Point Lights 83 
Spotlights 83 

Lighting Nodes 320 
Limiting Motion 96 
Linking Nodes 307 
Lip Syncing 140 
Loading 
 Figure Types 137 

Light Sets 93 
Textures 215 
Walks 137 

Loading Textures 216 
Lock Figure 275 
Locking Cameras 80 
Long/Complex Animations 144 
M 
Magnet Zone Falloff Graph 156 
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